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L’outil libre d’animation 
et de graphisme 3D
Logiciel libre de référence pour le  
 gra phisme et l’animation 3D, tant sous
MS-Windows et Linux que sous Mac OS X,
Blender 2.46 défie les ténors du  domaine
XSI, 3ds Max, Maya, ZBrush… Grâce à son
 interface intelligente et contextuelle,
il permet à l’artiste d’allier pro ductivité
et créativité. Très ouvert, il met à sa
 disposition de nombreux  moteurs de
rendu photoréalistes et  s’intègre, par sa
richesse et sa flexibilité, à la panoplie des
outils de  travail quotidiens du graphiste
professionnel.

Pour que l’informatique
soit un outil

et non un ennemi !

Libérez vos images et animations 3D !

�Modélisez de façon puissante les objets, les composants 
mécaniques, les formes organiques

�Maîtrisez la modélisation polygonale et les outils de sculpture 
interactive

� Simulez et animez des personnages, fluides et corps souples 
(vêtements, fourrure, chevelure…) que vous pouvez sculpter et coiffer

�Habillez-les par des matériaux et des textures peintes 
ou photographiées

� Jonglez avec l’éditeur de nœuds pour concevoir des shaders
complexes et créer des effets spéciaux

� Éclairez vos scènes avec réalisme et effectuez le rendu grâce 
aux meilleurs moteurs libres (interne, Yafaray, Sunflow, LuxRender)

� Profitez de l’un des meilleurs systèmes de particules dotés 
d’intelligence artificielle (boids) pour simuler des comportements
(bancs de poissons, proie et prédateur, éclaboussures…)

�Montez vos animations directement dans Blender

� Importez depuis des applications et exportez vers d’autres formats
image, vidéo ou moteurs de jeux (3D Studio, Collada, LightWave, XSI,
DirectX, VRML, Doom 3, Quake 3, PNG, JPEG, TARGA, AVI…)

En annexe : Raccourcis clavier • Indices de réfraction • Les scripts Python •
Webographie • Licence GPL.
Sur le DVD-Rom offert avec cet ouvrage : Blender 2.46 pour MS-Windows, Linux
et Mac OS X, avec Python 2.5.2.  Inclus : Les exercices corrigés • Plug-ins de Texture et
Séquence • Matériaux et textures prêts à l’emploi • Les films Elephants Dream et Big
Buck Bunny (formats .avi, .mov et .ogg) • De nombreux bonus.

Configuration minimale : MS-Windows 98, Me, NT, 2000, XP, Vista, Linux, Mac OS. Processeur
450 Mhz, 256 Mo de RAM, carte graphique avec accélération OpenGL, 20 Mo d’espace disque.

La série Blender 2.4x est le fruit des développements nécessaires à la réalisation des films
d’animation Elephants Dream et Big Buck Bunny (proposés librement sur le DVD-Rom
d’accompagnement).

À qui s’adresse cet ouvrage ?

■ Amateurs d’images de synthèse ou d’animation 3D,
sous MS-Windows, Linux et Mac OS X.

■ Utilisateurs de 3ds Max, Maya, ZBrush qui souhaitent
retrouver en gratuit et libre des outils de création 3D
avancés.

pour Linux, Windows 
et Mac OS X

Blender 2.46 
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Utilisateur de Blender depuis près de dix ans,
Olivier Saraja est l’un des animateurs  
de la communauté du graphisme libre –  
en particulier sous Linux – et l’auteur de
nombreux didacticiels pour Blender, POV-
Ray, KPovModeler ou Art of Illusion. Il a
contribué à la documentation officielle 
et aux Release Logs de Blender et œuvre
pour en faciliter l’accès au plus grand
nombre, dans les communautés françaises et
 anglophones.
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N°12390, 2e édition, à paraître 2008, 232 pages.

OpenOffice.org 2 Writer. 
S. Gautier, avec la contribution de G. Veyssière. 
N°11668, 2005, 248 pages.

SPIP 1.9. Créer son site avec des outils libres. 
M.-M. Maudet. A.-L. Quatravaux, D. Quatravaux., avec la contribution de 
Perline. 
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Mozilla Thunderbird. Le mail sûr et sans spam. 
D. Garance, A.-L. et  D. Quatravaux. 
N°11609, 2005, 300 pages avec CD-Rom.

Firefox.  Retrouvez votre efficacité sur le Web ! 
T. Trubacz, préface de T. Nitot. 
N°11604, 2005, 250 pages.

OpenOffice.org 2 Calc. 
S. Gautier, avec la contribution de J.-M. Thomas. 
N°11667, 2006, 220 pages.

Collection « Poche Accès libre »

Wikipédia. Comprendre et participer. 
S. Blondeel. 
N°11941, 2006, 168 pages .

Le peer-to-peer.  
F. Le Fessant. 
N°11731, 2006, 168 pages. 

Créer son blog en 5 minutes. 
C. Béchet. 
N°11730, 2006, 132 pages.

Les podcasts. Écouter, s’abonner et créer. 
F. Dumesnil.  
N°11724, 2006, 168 pages.

Collection « Connectez-moi ! » 

Partage et publication… Quel mode d’emploi pour ces nouveaux usages de l’Internet ?
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Je dédie ce livre à la mémoire de mon père, un homme bon, droit et généreux,
parti trop tôt, un vendredi 25 avril 2003, sans avoir eu la chance de con-
naître sa petite-fille. Papa, je t’aime.

Je dédie également ce livre à toute la communauté des utilisateurs de Blender, à
qui je donne rendez-vous sur http://www.linuxgraphic.org. Service après-vente
assuré ! Merci de m’avoir aidé à porter encore plus haut cet ouvrage, j’espère
qu’il continuera à se bonifier avec le temps...

Enfin, je me joins à toute l ’équipe Eyrolles (Muriel, Sophie, Éliza) pour
dédier ce livre à Jean-Marie Thomas, disparu peu avant la parution de la
première édition de cet ouvrage.
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Préface
à la première édition (2006)

Il s’est écoulé trois ans et demi depuis que Blender a été publié en tant
que logiciel libre sur Internet, et je peux dire que c’est certainement la
meilleure chose qui soit jamais arrivée à Blender ! Non seulement
Blender s’est attiré des centaines de développeurs actifs dans le monde
entier, mais le nombre de ses utilisateurs ne cesse de croître rapidement,
au point que nous avons renoncé à les comptabiliser. Ce que nous savons
avec certitude, c’est que Blender a été téléchargé plus de deux millions de
fois en 2005, et que les perspectives de croissance pour 2006 sont encore
meilleures.

Le développement de Blender a récemment été dopé par le « Orange
Open Movie Project », qui a donné naissance à un film tout en 3D de
dix minutes, nommé Elephants Dream. Ce film aura été publié un peu
avant ce livre, aussi j’espère qu’il pourra inspirer chaque lecteur dans son
apprentissage de Blender.

Bien que je n’aie encore jamais rencontré Olivier en personne, nous
avons eu des contacts réguliers par courriels tout au long des cinq der-
nières années. C’est, depuis le début, un auteur et un utilisateur de
Blender expérimenté, et je suis donc très fier qu’il se soit décidé à ras-
sembler ses connaissances dans un livre, afin de les partager avec tout le
monde... Enfin, je veux dire avec cette partie du monde qui lit et parle le
français, bien sûr !

J’ai toujours été très impressionné par la qualité artistique des images
produites par les utilisateurs de la communauté française. Les artistes
français font preuve d’une imagination très riche, excellant en particulier
dans leur capacité à conter une histoire entière avec une seule modeste
image. C’est probablement lié à leur très riche culture de la bande des-
sinée, dont je suis un très grand amateur !
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J’espère que tout le monde aura beaucoup de plaisir à lire ce livre, à
apprendre comment transformer une idée ou traduire un fantasme en
une animation ou un graphisme saisissant. En tant qu’auteur originel de
ce logiciel, je sais que son apprentissage n’est pas toujours facile, mais
soyez assurés que nous faisons de notre mieux pour vous préparer un
workflow optimal afin de débrider votre créativité, et que Blender
deviendra pour vous une seconde nature, en très peu de temps !

Amsterdam, mars 2006,

Ton Roosendaal
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Historique de Blender
L’ancêtre de Blender est né en 1988 au sein du studio d’animation hollan-
dais NeoGeo (l’une des plus grandes sociétés d’animation 3D des Pays-
Bas, primée en 1993 et 1995 par l’European Corporate Video Awards),
société dont Ton Roosendaal fut l’un des cofondateurs. Suite à une intensi-
fication des besoins internes, le logiciel fut entièrement réécrit et devint la
suite de modélisation et d’animation 3D connue sous le nom de Blender.

En 1998, Ton Roosendaal fonda une nouvelle entité baptisée Not A
Number (NaN) dont l’objectif était de développer et de commercialiser
Blender : l’ambition était d’offrir un outil compact, multi-plates-formes,
professionnel et gratuit, à destination d’un public très large, la société
devant vivre de la vente de produits commerciaux et de services. Blender
fit sensation au salon Siggraph de 1999, s’attirant l’attention du public
comme de la presse et confirmant son potentiel hors du commun.

En suscitant le même engouement lors du Siggraph de 2000, NaN réussit
à réunir près de 4 500 000 euros de financement, qui lui permirent de
porter ses effectifs à 50 salariés, aux Pays-Bas, au Japon et aux États-Unis.
Au cours de l’été de la même année, la version 2.0 de Blender, intégrant un
moteur de jeu, sortait et, à la fin de l’année, Blender pouvait revendiquer
plus de 250 000 utilisateurs enregistrés. Après une réduction d’effectif due
à la frilosité du marché et la recherche de nouveaux investisseurs, NaN
sortait fin 2001 une mouture commerciale de son logiciel, Blender
Publisher, visant le marché émergeant du contenu interactif pour les sites
web, basés sur la 3D. Malheureusement, en raison de ventes décevantes et
d’un climat économique de plus en plus difficile, les nouveaux investisseurs
décidèrent de mettre un terme aux activités de NaN, signant également
celui du développement de Blender.

Introduction

3DS MAX, MAYA   Portabilité

3ds max n’est disponible que sur plates-formes
Windows. Pour sa part, Maya a été porté sous
Linux afin de satisfaire aux besoins des studios
Dreamworks. Blender, en revanche, est disponible
sur à peu près toutes les plates-formes existantes,
y compris sur les PDA !
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Reprendre une nouvelle société avec une base suffisante de développeurs
salariés n’étant économiquement pas envisageable, Ton décida de créer la
Blender Foundation, fondation à but non lucratif, pour ne pas abandonner
la communauté enthousiaste d’utilisateurs et de clients qui pleuraient la
disparition de Blender. En juillet 2002, Ton parvint à convaincre les inves-
tisseurs de NaN de libérer les sources de Blender, moyennant finances, et
lança auprès de la communauté une vaste collecte de fonds devant rap-
porter les 100 000 euros qui permettraient de racheter les droits de pro-
priété intellectuelle et le code source de Blender aux investisseurs. À la
surprise générale, il suffit de seulement sept semaines à la communauté
pour amasser cette somme considérable. Officiellement, c’est le dimanche
13 octobre 2002 que Blender fut libéré ; son code source fut alors placé
sous la GNU General Public License.

Depuis, le développement de Blender continue, poussé par des volon-
taires dévoués dispersés sur la planète entière, et toujours mené par le
créateur initial de Blender, Ton Roosendaal.
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Scène tirée du film Elephants Dream, du Studio Orange | © 2006, Blender Foundation/Netherlands Media Art Institute 
 www.elephantsdream.org | Creative Commons Attribution-NonCommercial-NoDerivs 2.5
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Ce livre possède un format un peu particulier, situé quelque part entre le
manuel d’utilisation et le recueil de didacticiels. Il vise à présenter de façon
synthétique à peu près tout ce qu’il est possible de réaliser avec Blender,
mais aussi à guider pas à pas ceux que les images de synthèse peuvent
effrayer, mais voudraient malgré tout tenter leur chance. Malheureusement,
il n’a pas été possible de tout mettre, référencer et présenter – Blender est
un logiciel tellement riche en possibilités ! Aussi parfois, des choix doulou-
reux ont été effectués avant de figer le contenu d’un chapitre.

Pendant de longues années, j’ai écrit des didacticiels sur l’usage de
Blender (et d’autres logiciels libres d’images de synthèse) et j’ai même eu
l’occasion de collaborer avec l’équipe de rédaction de la documentation
officielle. En effet, la liste des fonctionnalités nouvelles de Blender
s’allongeant très vite, les auteurs habituels n’arrivaient pas à écrire la
documentation ; il aurait fallu un temps certain pour que le retard soit
rattrapé sans la bonne volonté d’une poignée de volontaires. Nous
savions que la documentation resterait un chantier perpétuel, mais c’était
manifestement le prix à payer si l’on désirait soutenir un outil en cons-
tante évolution. L’écriture de La 3D libre avec Blender avait donc lente-
ment mûri en moi, mais il fallut une rencontre opportune et la sortie du
livre Gimp 2 efficace de Cédric Gémy (également aux éditions Eyrolles)
pour concrétiser ce projet latent.

Depuis, la première et la deuxième éditions ont fait leur bonhomme de
chemin, très favorablement accueillies par la communauté francophone des
utilisateurs de Blender, et j’ai appris avec fierté (et soulagement !), à travers
vos nombreux et chaleureux courriels, que mes modestes connaissances,
accumulées au fil de plusieurs années d’écriture de didacticiels, d’articles et

Avant-propos

3DS MAX, MAYA   Vitesse de développement

Le développement de 3ds max est réputé très lent,
certains bogues, datant de quatre versions anté-
rieures, n’étant toujours pas corrigés. En revanche,
dans le passé, le développement de Maya a été
plutôt rapide, mais depuis son rachat par Autodesk
(l’éditeur de 3ds max), il convient de s’accorder le
temps de juger. Pour sa part, depuis que le code
source de Blender a été racheté par la commu-
nauté et que le logiciel est devenu libre, le déve-
loppement de Blender a été si rapide que
maintenir à jour la documentation est plus qu’une
gageure.
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de bouts de documentation, avaient pu aider à rendre abordable un logiciel
réputé (à grand tort) comme difficile d’accès. C’est donc naturellement que,
porté par ce succès et cet accueil fantastique, cet ouvrage refait son appari-
tion dans une troisième édition, augmentée et enrichie, pour tenir compte
tant des progrès de Blender que de sa richesse en perpétuelle expansion.

À qui s’adresse ce livre ?
Blender a été développé en tant qu’outil de production d’animations 3D.
Il a donc avant tout un usage professionnel et productif. Il est d’ailleurs
étonnant de constater comme Blender devient particulièrement pro-
ductif lorsque l’on a maîtrisé son fonctionnement général.

Blender a également les artistes à l’esprit, en étant très éloigné des outils
de conception ou de dessin assisté par ordinateur, précis mais arides, et
ne favorisant pas la créativité personnelle. Au contraire, l’interface de
Blender est vivante, souvent fluctuante même, et semble accompagner
l’utilisateur dans ses travaux, lui permettant de se recentrer sur sa liberté
artistique, plutôt que sur la rigueur nécessaire à un réalisme excessif.

> Vous êtes un curieux ou un débutant
Vous n’avez jamais créé d’images de synthèse, et ces mots mêmes vous
paraissent mystérieux ou insurmontables ? Vous trouverez dans cet
ouvrage une excellente introduction à l’imagerie 3D et, au terme de sa
lecture, vous vous sentirez à l’aise et capable de mener, sur la seule base
de votre créativité, vos premiers projets.

> Vous êtes déjà un utilisateur confirmé de Blender
Le développement de Blender va vite, très vite, et souvent, les nou-
veautés ne sont documentées qu’en anglais. Si vous vous sentez dépassé
par le déluge de nouveautés de chaque nouvelle version, ou si vous êtes
fâché avec la langue anglaise, alors cet ouvrage est également fait pour
vous : il reprend toutes les principales fonctionnalités de Blender (des
plus anciennes aux plus récentes) en les démystifiant ou en leur appor-
tant un éclairage particulier. Vous apprécierez alors les cas pratiques, que
vous décortiquerez jusqu’à les maîtriser, qui parsèment le livre.

> Vous êtes un artiste 3D chevronné
Blender mûrit chaque jour. De plus en plus d’artistes accomplis s’y inté-
ressent ou se tournent vers lui. Outre l’avantage d’être gratuit et de béné-
ficier d’un développement dynamique, il s’efforce de se doter des outils
qui font la force des grandes applications commerciales, pour un coût...
nul ! Mais ce qui fait plaisir à lire, ce sont les commentaires d’artistes

Vous êtes familier d’un autre grand 
logiciel commercial ?

Il serait illusoire d’établir des ponts permanents
entre les divers logiciels commerciaux du marché et
Blender, mais vous trouverez tout au long de cet
ouvrage des apartés expliquant les principales diffé-
rences ou similitudes entres les fonctions de Blender
et celles, par exemple, de 3ds max et Maya.
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confirmés qui s’étonnent de voir, par exemple, dans les forums de
CGTalk (http://forums.cgsociety.org/), des images réalisées avec Blender, en
affirmant « [qu’ils ne savaient pas] que Blender était capable de faire
ça ! ». L’autre point de satisfaction, c’est de constater que certains ont
intégré Blender dans leur workflow, que ce soit pour le dépliage UV, ou
la simulation des fluides, par exemple, sans honte d’utiliser un logiciel
« gratuit », là où des confrères dépensent des centaines ou des milliers de
dollars pour aider leur créativité à s’exprimer. Si vous êtes un artiste 3D
confirmé et que vous vous demandez si Blender peut vous aider dans
votre démarche artistique ou professionnelle, ce livre est fait pour vous :
il brosse dans ses grandes lignes la liste des fonctionnalités et capacités
de Blender, en les rapprochant autant que possible de ce qui se fait avec
3ds max ou Maya, afin de faciliter la transition.

Blender est gratuit... vraiment ?
Oui, vraiment. Vous pouvez le copier à l’envi, le distribuer librement à tous
vos amis, collègues et connaissances. Vous pouvez l’installer sur autant de
postes que souhaité. Vous n’avez aucune limitation, ni sur son usage, ni sur
celui des œuvres réalisées avec lui. Et dans le cas où vous vous sentiriez l’âme
d’un développeur, vous pouvez même plonger votre nez dans les sources du
logiciel, voir comment fonctionnent ses arcanes internes ou détailler les
algorithmes employés : c’est la magie du monde Open Source. Blender est à
l’imagerie 3D ce que Gimp est à l’imagerie 2D : un formidable outil de
créativité, riche, puissant, fonctionnel et... totalement gratuit !

D’autres logiciels commerciaux reposent sur quantités de greffons, plug-
ins et extensions, la plupart coûteux et difficiles d’accès, pour produire
des résultats d’une qualité dépendant grandement de la compétence de
l’utilisateur, malgré leur prix. Blender bénéficie pour sa part d’une com-
munauté de développeurs très actifs, et dispose d’une solide base de
scripts Python qui enrichissent ses capacités naturelles. S’il lui manque
une fonctionnalité, il est certain qu’elle est véritablement inutile, ou
qu’elle sera intégrée dans une très prochaine version officielle !

Il est désormais temps de clore ce chapitre, et de vous plonger dans la
lecture de ce livre qui restera pour longtemps, je l’espère, votre livre de
chevet !

Toulouse, juin 2008,

Olivier Saraja

3DS MAX   Langage de script

Le langage de script de 3ds max lui est propre et
est assez similaire au langage C. De son côté,
Blender utilise un langage très répandu, Python,
qui se révèle puissant et flexible. S’il est très pro-
ductif, son implémentation incomplète et qui
manque parfois de cohérence peut engendrer
quelques frustrations.
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chapitre 1

Splash Screen de Blender 2.46
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Installation de Blender

Blender est une suite complète de modélisation, d’animation, 
de rendu, et même de montage vidéo parfaitement autonome, 
bien que ce logiciel n’occupe sur le disque qu’une place très 
modeste, une dizaine de Mo pour la plupart des versions. 
Aussi simple à installer que compact, il est possible d’étendre 
ses possibilités grâce à l’usage de Python, pour le scripting, 
ainsi que différents moteurs de rendu avancés, non fournis et 
non couverts par cet ouvrage.

SOMMAIRE

B Installation de Blender

B Guides pour l’installation 
de Python

MOTS-CLÉS

B Installation
B Blender
B Python
B Pythonpath
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Quel que soit votre système d’exploitation de prédilection (Windows,
GNU/Linux, Mac Os X), l’installation de Blender ne présente aucune
difficulté, et ce logiciel fonctionnera directement, sans configuration
particulière de votre part. Il est toutefois possible de lui adjoindre le lan-
gage de programmation Python. Il s’agit d’un langage de programma-
tion interprété, qui permet d’étendre les capacités de Blender en termes
de modélisation, d’animation ou de gestion de scènes complexes, grâce
au scripting. Ce chapitre propose de vous accompagner dans l’installation
de Blender, mais aussi de vous guider dans celle de Python.

Les principales étapes sont reprises ci-après, avec des explications un peu
plus détaillées pour l’utilisateur de Windows, parfois moins à l’aise avec
les outils informatiques.

Installation sous Windows
Deux versions de Blender sont disponibles au téléchargement. La première
est un fichier autoextractible, dont l’assistant vous guidera pas à pas à travers
toutes les étapes de l’installation. C’est la version que nous présenterons ici.

1 Téléchargez le fichier http://download.blender.org/release/
Blender2.46/blender-2.46-windows.exe sur le site officiel de
Blender (http://www.blender.org/download/get-blender) ou alors récu-
pérez-le sur le DVD-Rom accompagnant ce livre. Naviguez jusqu’à
l’emplacement où le fichier a été enregistré, et double-cliquez dessus
pour lancer l’installation.

2 Le premier écran présente la licence du logiciel. Vous devez impérati-
vement l’accepter si vous souhaitez installer Blender, en cliquant sur
le bouton I Agree.

3 L’écran suivant présente les composants à installer ainsi que les actions
à entreprendre : création d’un raccourci dans le menu Démarrer, ajout
d’une icône Blender sur le bureau pour un démarrage encore plus
rapide, et association automatique des fichiers d’extension .blend à
Blender. Par défaut, toutes sont précochées. Une fois vos décisions
prises, appuyez sur le bouton Next pour passer à l’écran suivant.

PRÉREQUIS   Microsoft Visual C++ 2005 Redistributable Package (x86)

Si votre système n’est pas à jour, Blender peut ne pas fonctionner dès le
démarrage. Pour résoudre ce problème, il vous suffit alors d’installer la
mise à jour officielle disponible à l’adresse suivante :
Bhttp://www.microsoft.com/downloads/details.aspx?familyid=32BC1BEE-A3F9-

4C13-9C99-220B62A191EE&displaylang=en

Autres systèmes

Il existe également des déclinaisons de Blender
pour d’autres systèmes. Parmi ceux-ci, nous retrou-
vons FreeBSD, Irix et Solaris. Référez-vous à la
documentation officielle de Blender pour les ins-
tructions d’installation spécifiques.

Note importante pour les utilisateurs 
de puces graphiques Intel intégrées 

à la carte-mère

Certaines opérations graphiques (comme l’action
sur les menus ou l’usage de la fonction Border
Select) ne sont pas visibles en raison d’un bogue
du driver des puces graphiques Intel intégrées à la
carte-mère.
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Figure 1–1
Écran d’accueil de l’installateur de Blender

Figure 1–2
Licence d’utilisation de Blender

Figure 1–3
Composants à installer 
et options supplémentaires
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4 Sélectionnez le répertoire d’installation de Blender et appuyez sur
Next pour installer Blender.

5 L’étape suivante consiste à déterminer l’emplacement ou seront
stockés les fichiers de données de l’utilisateur. Appuyez simplement
sur Next.

L’installateur copiera alors tous les fichiers nécessaires aux endroits
appropriés pour une installation irréprochable.

6 Appuyez sur Finish lorsque l’installation est terminée, et Blender se
lancera automatiquement.

Figure 1–4
Choix du dossier d’installation de Blender

Figure 1–5
Choix de l’emplacement

des données de l’utilisateur

PRÉREQUIS   Microsoft Installer 2.0

Les machines équipées de Windows XP supportent
automatiquement MSI, mais certains logiciels (ou
suites logicielles) comme Word ou Office distri-
buent déjà MSI. Toutefois, si en double-cliquant
sur le fichier .msi de Python, vous ne parvenez
pas à l’installer, vous pouvez toujours télécharger
MSI sur le site officiel de Microsoft  :
B http://www.microsoft.com
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Figure 1–6 L’installation est très rapide, tant Blender est compact.

Figure 1–7
Écran final de l’installation de Blender

Installer Python pour Windows

L’installation de Python sous Windows n’est pas obligatoire pour uti-
liser Blender, qui se suffit à lui-même. Python est toutefois nécessaire
à l’usage de certains scripts que l’on trouve sur Internet.
Vous trouverez sur le DVD-Rom accompagnant cet ouvrage, dans le
répertoire /install les fichiers appropriés.
Sous Windows, vous double-cliquerez sur l’un des fichiers Python avec
une extension .msi pour l’installer automatiquement, en vous laissant
guider pas à pas par l’assistant. Lorsque ce sera fait, il ne vous restera
plus qu’à définir convenablement la variable système relative à Python.
Pour ce faire, cliquez sur le menu Démarrer, sélectionnez Tous les
Programmes, puis Python 2.5 et enfin Python (command line).
Tapez successivement import sys puis print sys.path. Python
vous informe alors des chemins qui lui sont propres. Par exemple :
['', 'C:\\WINDOWS\\system32\\python25.zip',
 'C:\\Python25\\DLLs','C:\\Python25\\lib',

 'C:\\Python25\\lib\\plat-win',
 'C:\\Python25\\lib\\lib-tk','C:\\Python25',
 'C:\\Python25\\lib\\site-packages']
Cliquez sur le bouton Démarrer, ouvrez le Panneau de Configura-
tion, cliquez sur Basculer vers l’affichage classique, puis double-cli-
quez sur Système. Passez dans l’onglet Avancé et tout en bas de la
fenêtre, cliquez sur le bouton Variables d’environnement. Dans la
partie inférieure se trouvent les Variables système. Pour celles-ci, cli-
quez sur le bouton Nouveau.
Dans la boîte de dialogue qui apparaît, saisissez 'PYTHONPATH'
(sans les apostrophes) dans le champ Nom de la variable. Dans le
champ Valeur de la variable, saisissez les chemins obtenus à
l’étape 5, mais en ignorant les crochets, en remplaçant les double
barres obliques '\\' par de simples barres '\', en séparant les che-
mins par des points virgules ';&apos; et en omettant le chemin vide
' '. Blender est désormais capable d’utiliser les modules préfabriqués
de Python pour ses propres scripts.
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Installation sous GNU/Linux
Plusieurs versions de Blender sont disponibles pour les systèmes GNU/
Linux. Il existe en effet une version de Blender compilée pour fonc-
tionner avec un Python de la série 2.4.x et une autre pour fonctionner
avec la série 2.5.x. Les distributions GNU/Linux récentes proposent
pour la plupart Python 2.5.x ; ce sera donc très certainement cette ver-
sion que vous installerez.

Certaines distributions GNU/Linux proposent des paquetages précom-
pilés de Blender, parfaitement intégrés au système ; toutefois, les ver-
sions proposées sont parfois en retard d’une ou deux versions par rapport
aux versions officielles. La plupart du temps, vous aurez donc recours
aux fichiers binaires proposés sur le site officiel, également disponibles
sur le DVD-Rom d’accompagnement de cet ouvrage. Sélectionnez la
version qui vous convient le mieux en fonction de la version de Python
de votre système (2.4.x ou 2.5.x) et téléchargez-la. Par exemple : 
http://download.blender.org/release/Blender2.46/blender-2.46-linux-glibc236-py25-
i386.tar.bz2 pour la version compatible avec Python 2.5.x. Ensuite, suivez
la procédure suivante :

Installation de Python pour Linux

Vous ne trouverez pas Python pour Linux dans le répertoire /install du DVD-Rom. En
effet, toutes les distributions Linux proposent Python en standard, nous vous invitons donc
à installer la version livrée avec la vôtre.
L’installation en elle-même ne devrait donc pas poser de problème si vous passez par le
gestionnaire de paquetages de votre distribution. Toutefois, au terme de celle-ci, Python
n’est pas tout à fait utilisable par Blender : il vous reste à configurer le chemin vers Python.
Pour cela, lancez une console et tapez-y la commande python. Vous êtes désormais dans
l’environnement interprété de Python. Tapez successivement import sys puis print
sys.path. Python vous informe alors des chemins qui lui sont propres. Par exemple :
['', '/usr/lib/python25.zip', '/usr/lib/python2.5',
 '/usr/lib/python2.5/plat-linux2', '/usr/lib/python2.5/lib-tk', 
 '/usr/lib/python2.5/lib-dynload', '/usr/lib/python2.5/site-packages']
Il ne vous reste maintenant plus qu’à ouvrir le fichier caché .bashrc situé à la racine de
votre répertoire utilisateur (/home/olivier) et y ajouter la ligne suivante, tout à la fin
du fichier :
export PYTHONPATH=/usr/lib/python25.zip:/usr/lib/python2.5:
 /usr/lib/python2.5/plat-linux2:/usr/lib/python2.5/lib-tk:
 /usr/lib/python2.5/lib-dynload:/usr/lib/python2.5/site-packages
Vous noterez que cet ajout correspond à la sortie de la commande print sys.path
dans l’environnement Python : les crochets et les apostrophes ont été supprimés, et
chaque chemin exporté dans la variable PYTHONPATH est séparé du suivant par deux
points ':'. Blender est désormais capable d’utiliser les modules préfabriqués de Python
pour ses propres scripts.

Blender et OpenGL

Blender utilise OpenGL pour tous les tracés à
l’écran des fenêtres 3D jusqu’aux menus et aux
boutons. Une carte graphique autorisant l’accélé-
ration 3D matérielle vous permettra donc une utili-
sation optimale de Blender. Les moins bien nantis
ne seront toutefois pénalisés que pour les scènes
les plus complexes. Lors du rendu, tout le monde
sera à égalité, à la puissance du processeur et à la
quantité de mémoire RAM près.

Blender refuse de démarrer

Vérifiez-en les raisons dans une console. Il est pro-
bable que vous deviez installer un paquetage
nommé libstdc++5. Une recherche dans les
paquets .rpm ou .deb de votre distribution
favorite devrait vous permettre de trouver celui-ci.
Dans le cas contraire, effectuez une recherche sur
l’Internet : les distributions sont trop nombreuses
pour que nous puissions mettre à disposition sur le
DVD-Rom d’installation les fichiers appropriés.

Support FFMPG pour Linux et Windows

Les versions GNU/Linux et Windows de Blender
sont compilées avec FFMPEG, une suite logicielle
qui lui donne accès à un grand nombre de formats
vidéo de façon native. Les versions pour les autres
plates-formes en seront équipées ultérieurement,
lorsque des problèmes de dépendance logicielle
auront été résolues (sans doute pour la prochaine
version de Blender).
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1 Ouvrez une console.
2 Décompressez l’archive : tar jxvf
http://download.blender.org/release/Blender2.46/blender-2.46-
linux-glibc236-py25-i386.tar.bz2

Pour lancer Blender, il suffit de poursuivre avec les étapes suivantes :

3 Allez dans le dossier créé : 
cd blender-2.46-linux-glibc236-py25-i386

4 Tapez ./blender

En fonction de votre gestionnaire de fenêtres, vous pouvez créer une
icône sur votre bureau pour lancer Blender d’un simple clic de souris.

Installation sous Mac OS X
Il existe principalement deux versions de Blender pour Mac OS X : une
pour les machines PowerPC, une autre pour celles dotées d’une architec-
ture Intel. Par défaut, vous n’aurez pas besoin d’installer Python, comme
c’est le cas pour Windows et GNU/Linux : Python 2.3 est déjà présent
sous Mac OS X 10.3, Python 2.4 sous Mac OS X 10.4 et Python 2.5
sous Mac OS X 10.5. Tous les scripts officiels fonctionnent bien évi-
demment aussi bien avec n’importe quelle version de Python.

Vous téléchargerez sur le site officiel de Blender les fichiers binaires con-
formes à votre architecture matérielle : http://download.blender.org/release/
Blender2.46/blender-2.46-OSX-10.3-py2.3-powerpc.dmg pour PowerPC et http://
download.blender.org/release/Blender2.46/blender-2.46-OSX-10.4-py2.3-intel.zip
pour Intel. Ces mêmes fichiers sont disponibles sur le DVD-Rom
d’accompagnement.

Figure 1–8
Les fichiers sont sur le bureau, 
prêts à être installés.
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Pour installer l’une ou l’autre version, naviguez jusqu’à l’emplacement où
le fichier a été enregistré, et double-cliquez dessus. Une fois ouvert le
fichier .zip du PowerPC, vous pourrez déplacer le dossier obtenu à
l’endroit de votre choix.

De même, une fois le fichier .dmg ouvert, vous pourrez copier les fichiers
dans un nouveau dossier à l’emplacement voulu, puis éjecter l’image disque.

Dans les deux cas, Blender est installé et prêt à l’emploi.

Figure 1–9
Le contenu de l’archive .zip du PowerPC

Figure 1–10
Le contenu de l’image disque .dmg

de la version Intel

Astuces pour la version Mac OS X 
de Blender

Vous trouverez dans le répertoire d’installation un
fichier nommé OSX tips.rtf qui propose de
nombreux trucs et astuces pour la version
Mac OS X de Blender.
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chapitre 2

Scène tirée du film Elephants Dream, du Studio Orange | © 2006, Blender Foundation/Netherlands Media Art Institute 
 www.elephantsdream.org | Creative Commons Attribution-NonCommercial-NoDerivs 2.5
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Prise en main de Blender

Même si elle a été rationalisée au fil des années, l’interface 
particulière de Blender reste bien spécifique dans sa catégorie. 
Ce chapitre va vous présenter les principaux éléments cachés 
ou visibles de son interface, et vous aider à l’adapter 
à vos besoins. Dans ce chapitre, vous découvrirez simplement 
et pas à pas les éléments qui contribuent à l’interface 
de Blender, et comment vous en servir. Vous découvrirez 
en particulier les différentes vues, leur manipulation, 
l’utilisation des raccourcis clavier et surtout celle de la souris.

SOMMAIRE

B Découverte de l’interface

B Actions fondamentales

MOTS-CLÉS

B Types de vues
B Raccourcis clavier
B Utilisation de la souris
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L’interface de Blender est remarquable et unique à plus d’un titre. Elle
peut paraître complexe et déroutante au premier abord, mais elle se
révèle extrêmement simple et productive par la suite. Simple, car une
fois familiarisé avec la logique de l’organisation des données et des bou-
tons de Blender dans un menu (les matériaux, par exemple), on se rend
compte que ces données et ces boutons existent et fonctionnent selon la
même logique dans d’autres menus. Par exemple, on remarque rapide-
ment que la création d’un nouveau Shader, Texture ou World repose
chaque fois sur un même principe. De même, dans un autre registre,
l’édition d’un maillage dans la vue 3D, l’édition d’une courbe IPO dans
la vue d’animation, ou le dépliage d’une carte UV dans une vue image
reposent sur les mêmes principes, et les manipulations possibles sont
étonnamment semblables. Et ainsi de suite pour la plupart des menus,
démontrant la robustesse et la consistance de l’interface.

L’interface de Blender est également qualifiée de productive car tout est
pensé pour vous simplifier les manipulations et, surtout, vous faire
gagner du temps. Les commandes se veulent immédiatement accessi-
bles, de plusieurs façons différentes, satisfaisant ainsi probablement votre
approche particulière de la modélisation ou de l’animation, selon que
vous soyez, par exemple, un adepte des raccourcis clavier, des icônes ou
de l’usage des menus. Depuis les premières versions, les raccourcis cla-
vier et les combinaisons de touches ont occupé dans Blender une place
prépondérante, voire incontournable, permettant de réaliser très rapide-
ment des actions particulièrement complexes par une simple succession
de raccourcis clavier. Malheureusement, mémoriser la trentaine de com-
binaisons absolument essentielles a largement contribué à forger la répu-
tation de Blender, dont on parlait, il y a quelques années, comme d’un
logiciel complexe et difficile à maîtriser, surtout pour les débutants, qui
parfois n’arrivaient à rien en tirer !

Depuis, les choses ont évolué, car les développeurs de Blender ont pris
en compte les récriminations de leurs utilisateurs, et se sont efforcés
d’améliorer l’ergonomie de l’interface au travers d’icônes, de menus et
sous-menus, et enfin de boutons organisés de façon rationnelle (et par-
fois un peu trop proche de certains modèles commerciaux concurrents),
tout en préservant la multiplicité des raccourcis clavier qui en ont fait
toute la force.

La règle à retenir absolument

La règle d’or de Blender n’a jamais changé, en plu-
sieurs années d’existence, si vous souhaitez en
tirer le meilleur parti : « Une main sur le clavier,
une main sur la souris ».
En effet, la plupart des raccourcis clavier peuvent
être effectués d’une seule main, et appellent une
action en retour à la souris. En gardant cette règle
en mémoire à chaque instant de votre travail avec
Blender, vous constaterez que votre souris fera
considérablement moins d’aller-retour entre les
boutons, les menus et les autres recoins de l’inter-
face graphique, pour se concentrer sur la seule
chose qui doit vraiment retenir votre attention : la
scène sur laquelle vous travaillez. Vous économi-
serez du temps, vous vous fatiguerez moins, vous
serez plus efficace et plus productif.
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Découverte de l’interface graphique
L’illustration qui suit présente l’interface de Blender, lors de son premier
démarrage. Dans son état actuel (nous verrons en effet très prochaine-
ment comment personnaliser cet affichage), nous pouvons identifier
trois zones distinctes.
• La barre principale : elle est située tout en haut de l’écran, juste sous

la barre de titre du logiciel. Sur sa droite se trouve la barre d’informa-
tion, qui donne à tout moment des statistiques utiles sur le contenu
de la scène et la quantité de mémoire utilisée par celle-ci. Nous le
verrons plus tard, il s’agit en fait d’une vue entière, mais dissimulée.

• La vue principale : elle est actuellement occupée par une vue 3D,
avec au pied de celle-ci les menus et les boîtes à outils disponibles
pour ce type de vue.

• La fenêtre des boutons : il s’agit de la zone réservée à l’interface gra-
phique permettant de paramétrer les objets de Blender ; au sommet
de celle-ci se trouvent les icônes qui permettent d’organiser les bou-
tons par familles. Il s’agit en fait d’une vue à part entière.

Si vous survolez une vue avec la souris, l’en-tête de cette vue s’éclaircit
légèrement afin de vous prévenir qu’il s’agit de la vue active. Les rac-
courcis clavier que vous pourriez utiliser ne vont affecter que la vue active.
En d’autres termes, pour utiliser un raccourci clavier censé affecter le con-
tenu de la vue 3D, le pointeur de la souris devra se trouver dans celle-ci.

Figure 2–1
L’interface de Blender, lors de son démarrage

Blender et les en-têtes

Les en-têtes sont les barres de menus qui se
situent soit en haut, soit en bas d’une vue. Ils pré-
sentent des menus, des icônes et des fonctions qui
sont souvent propres au type de vue. Vous noterez
que l’on continuera d’appeler « en-têtes » les
barres de menus même si elles se trouvent au
« pied » de la vue.
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Vous noterez que chaque en-tête commence par une icône qui permet de
déterminer le type de vue à afficher dans la vue en question. En cliquant
dessus, un menu déroulant apparaît pour vous permettre de choisir le
contenu affiché par la vue.

Il est évident que nous ne pourrons pas faire le tour complet et exhaustif de
toutes les entrées de menu, ou de tous les boutons des différents panneaux.
Nous allons, en revanche, tâcher d’aller à l’essentiel et vous permettre d’être
rapidement productif, en répondant aux interrogations les plus courantes.
Cela ne voudra pas dire que les éléments passés sous silence sont inutiles,
mais simplement qu’il est moins urgent d’apprendre à les maîtriser.

Le menu principal
La petite flèche (orientée soit vers le bas, soit vers la droite) permet de
masquer ou d’afficher le menu général. Lorsqu’il est masqué, les statisti-
ques de la scène sont visibles dans leur intégralité. Dans le cas contraire,
elles peuvent être tronquées, en fonction de la résolution de votre écran.

Le menu File permet de réaliser des opérations très courantes sur les
fichiers. En particulier, nous noterons les fonctions suivantes :
• New : supprime la scène courante et la remplace par la scène par

défaut ;
• Open... : permet d’ouvrir une scène existante ;
• Save : sauvegarde la scène avec le nom de fichier courant ;
• Save as... : sauvegarde la scène sous un nouveau nom ;
• Append... : importe un élément précis d’une scène existante (dispo-

nible sur l’un de vos périphériques) vers la scène courante ;

Raccourcis universels

Certains raccourcis clavier sont disponibles quelle
que soit la position du curseur de la souris, à
l’exception (pour certains) de l’éditeur de texte. Par
exemple :
• combinaison de touches [Ctrl]+[Q] – quit :

quitter Blender ;
• combinaison de touches [Ctrl]+[X] : réinitia-

liser la scène courante à la scène par défaut ;
• touche [F1] : ouvrir un fichier ;
• touche [F2] : sauvegarder un fichier ;
• touche [F3] : sauvegarder une image rendue ;
• touche [F12] : lancer le rendu de la scène.

Figure 2–2
Les types de vues disponibles à l’affichage
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• External Data : ce sous-menu offre plusieurs options afin de faciliter
les échanges de fichiers entre utilisateurs de Blender ; parmi les plus
importantes :
– Pack into Blend : enregistre les textures et les images en même

temps que la scène ;
– Unpack into Files : il s’agit de l’opération inverse, permettant

d’extraire les textures et les images de la scène ;
– Make All Paths Relative et Make All Paths Absolute : ces fonctions

sont utiles pour le transfert de fichiers d’un répertoire à l’autre du
même ordinateur, dans le cas où les fonctions de packing ne sont
pas utilisées.

Le menu Add permet d’insérer dans la scène des objets de différentes
natures ; certains sont « matériels », dans le sens où ils apparaîtront sur
l’image finale, comme les types Mesh, Surface et Meta, d’autres sont en
revanche « immatériels » comme les types Empty, Camera et Lamp.
• Mesh : insère un maillage de géométrie prédéfinie, comme un cube,

une sphère, un cône et quelques autres encore.
• Curve : permet d’insérer des courbes de Bézier ou des NURBS (voir

Courbes et objets textes, dans le chapitre 4), ainsi que des chemins
d’animation.

• Surface : insère des primitives de modélisation surfaciques, comme le
tube, la sphère ou le tore, mais aussi et surtout l’élément de surface.

• Meta : insère des primitives qui ont la propriété de s’agglomérer les
unes aux autres comme de la glaise ou du mercure. Plusieurs formes
sont disponibles parmi lesquelles la sphère, le cylindre, le cube et
l’ellipsoïde.

• Text : permet d’insérer un texte en 3D.
• Empty : objet vide mais disposant malgré tout d’un centre, d’une loca-

lisation, d’une échelle et d’une orientation. Il s’agit en fait d’un com-
pagnon indispensable de bien des animations !

• Group : permet de dupliquer à la position du curseur le contenu d’un
groupe préexistant.

• Camera : indispensable à toute scène, la caméra permet de définir
l’angle de vue du rendu.

• Lamp : presque aussi indispensable que la caméra, la lampe permet
d’éclairer votre scène.

• Armature : insère le premier os d’un squelette d’animation.
• Lattice : il s’agit d’une cage de déformation, utile pour animer simple-

ment des formes simples ou déformer facilement des formes com-
plexes.

ASTUCE   Les fonctions Screenshot

Vous trouverez dans le menu File deux options
intéressantes, autant pour les auteurs de docu-
mentation ou de didacticiels, que pour les simples
usagers, à la recherche d’aide dans les forums des
diverses communautés utilisatrices de Blender,
pour exposer plus facilement ses soucis :
• Screenshot Subwindow, combinaison de

touches [Ctrl]+[F3], qui permet de faire une
copie de la vue active, en-tête compris ;

• Screenshot All, combinaison de touches
[Ctrl]+[Maj]+[F3], qui permet de faire une
copie d’écran complète de la fenêtre de
Blender.

LE SAVIEZ-VOUS ?   Suzanne et la théière

La tête de singe que l’on obtient en choisissant
Add>Mesh>Monkey s’appelle Suzanne, et est
devenue la mascotte de Blender. Elle est à Blender
ce que la théière est à 3ds max : un terrain d’expé-
rimentation pour paramètres ou fonctionnalités
exotiques !
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Le menu Render centralise des fonctions de rendu, autrement disponi-
bles dans certains panneaux de la fenêtre des boutons et/ou au travers de
raccourcis clavier. Un passage par la fenêtre des boutons est cependant
presque indispensable pour régler les paramètres de rendu. Parmi les
options de ce menu, nous retiendrons plus particulièrement :
• Render Current Frame : rendu de l’image courante, selon les paramè-

tres prédéfinis dans les boutons de rendu. Correspond au raccourci
clavier [F12] ;

• Render Animation : lance le rendu de l’animation entière, selon les
paramètres indiqués dans les boutons de rendu ;

• Bake Render Meshes : permet de sauvegarder certaines passes de rendu
directement dans les textures des objets sélectionnés ;

• Show Render Buffer : permet d’afficher la dernière image rendue. Cor-
respond au raccourci clavier [F11] ;

• Play Back Rendered Animation : rejoue sous forme d’animation les
images rendues individuellement grâce à l’option Render Animation ;

• Render Settings : donne un accès direct aux boutons de rendu. Corres-
pond au raccourci clavier [F10].

Le menu Help, enfin, propose de l’aide à l’utilisateur, au travers de scripts
Python qui vont lancer le navigateur par défaut de votre système pour
accéder à des ressources particulièrement intéressantes de l’Internet. Il
est à noter que ces ressources sont en anglais, des traductions existant
parfois pour certaines d’entre elles, mais pas en accès direct. Vous retrou-
verez, en particulier, la documentation de Blender et des didacticiels
pour vous aider à maîtriser certaines fonctionnalités.
• Hotkey and Mouse Action Reference : il s’agit d’une aide qui résume

tous les raccourcis clavier et le fonctionnement de la souris dans
Blender. Il s’agit d’une référence quasi-indispensable pour qui sou-
haite utiliser Blender au maximum de ses possibilités, dans le strict
respect de la règle d’or de Blender (voir l’aparté La règle à retenir abso-
lument). Le contenu de cette aide est repris intégralement dans
l’annexe A de cet ouvrage.

• Scripts Help Browser : Blender propose par défaut un certain nombre
de scripts Python particulièrement utiles, qui ne sont pas forcément
documentés par ailleurs. Cette option vous permet donc de choisir un
script, selon la catégorie à laquelle il appartient, et d’en afficher les
instructions d’utilisation. Malheureusement, cette aide est en anglais.

La barre d’information affiche diverses informations sur Blender et la
scène active. Des menus déroulants permettent d’ailleurs de changer de
scène, dans le cas où vous en auriez défini plusieurs. La première infor-
mation disponible, sur fond généralement coloré, indique le numéro de
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version de Blender. Viennent ensuite d’autres informations. Elles diffè-
rent légèrement selon si l’objet est en cours d’édition ou non.

Hors du mode Edit :
• Ve : indique le nombre de sommets (constituant les maillages) pré-

sents dans la scène ;
• Fa : indique le nombre de faces (constituant les maillages) présents

dans la scène ;
• Ob : indique le nombre d’objets présents dans la scène (lampes com-

prises), puis le nombre d’objets sélectionnés, séparés par un tiret ;
• La : indique le nombre de lampes présentes dans la scène ;
• Mem : indique la consommation instantanée de mémoire et, entre

parenthèses, le pic de consommation observé lors de la séance ;
• Time : indique le temps de rendu de la dernière image ;
• [nom] : indique le nom de l’objet actuellement sélectionné.

En mode Edit, certaines informations apparaissent avec des variantes
utiles, propres à l’objet édité :
• Ve : le premier nombre indique le nombre de sommets sélectionnés,

et le second, le nombre de sommets total de l’objet ;
• Ed : le premier nombre indique le nombre d’arêtes sélectionnées, et le

second, le nombre d’arêtes total de l’objet ;
• Fa : le premier nombre indique le nombre de faces sélectionnées, et le

second, le nombre de faces total de l’objet.

BON À SAVOIR   Blender en français ?

L’interface de Blender peut être affichée en français plutôt qu’en anglais. Pour ce faire, dans
une vue User Preferences, cliquez sur le bouton Language & Font et activez le bouton
International Fonts. Dans le menu déroulant, choisissez la langue française puis activez les
boutons Tooltips, Buttons et Toolbox pour afficher respectivement en français les bulles
d’aide, les boutons et les boîtes à outils.

Figure 2–3

Tout au long de ce livre, nous préférons nous en tenir à la version anglaise, à cause principale-
ment du nom des boutons qui demeurent en version originale dans la plupart des didacticiels
disponibles sur l’Internet. Pour faciliter l’apprentissage autonome de Blender, il nous paraît
donc plus pertinent de travailler avec l’interface originale. En revanche, les bulles d’aide
(Tooltips) gagneront certainement à être affichées en français.
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À noter la bordure inférieure de la barre principale : en tirant dessus
(bouton gauche de la souris lorsque le curseur se transforme en double-
flèche) vers le bas, vous mettez à jour une vue cachée, qui est par défaut
la vue des préférences de l’utilisateur (User Preferences). Nous reviendrons
sur celle-ci plus tard.

La vue principale
Par défaut, il s’agit d’une vue 3D, mais cela peut être tout autre type de vue,
en fonction du choix opéré par l’utilisateur, en cliquant sur l’icône tout à
gauche de l’en-tête. Comme la barre de menus principale, celle-ci propose
en permanence l’icône permettant de changer le type de vue, un menu qui
s’adapte de façon contextuelle au type de vue, et une série d’icônes, égale-
ment différentes d’un type de vue à l’autre. À noter que seul l’en-tête d’une
vue de type User Preferences propose des statistiques sur la scène.

Les différents types de vue possibles sont les suivants, de haut en bas
dans le menu :
• Scripts Window : cette vue permet d’exécuter des scripts livrés en stan-

dard avec Blender, afin d’automatiser certaines opérations complexes
ou d’importer/exporter dans divers formats. Pour choisir un script à
lancer, passez par le menu Scripts, choisissez une catégorie (attention,
certaines sont vides à ce jour) et enfin un script. Rappelez-vous l’exis-
tence de l’entrée Scripts Help Browser du menu Help, dans le menu
principal, pour découvrir l’usage de tel ou tel script ;

• File Browser : cette vue permet de naviguer dans le système de fichiers
de votre ordinateur. Dans la liste de fichiers, les lignes blanches sym-
bolisent des répertoires, et les lignes noires des fichiers. Les fichiers
précédés d’un carré jaune sable indiquent des fichiers natifs de
Blender. Cette vue ne peut véritablement servir à des opérations sur
fichiers que lorsqu’elle est appelée au travers de fonctions comme
Open (touche [F1]) ou Save As... (touche [F2]) ;

• Image Browser : cette vue permet de naviguer dans le système de
fichiers de votre ordinateur, et de prévisualiser sous forme de
vignettes les images disponibles dans les différents répertoires ;

• Node Editor : cette vue permet de disposer des boîtes de fonction et de les
relier entre elles suivant les effets que vous souhaitez obtenir. Vous cons-
tituez ainsi un réseau, dont les boîtes sont les nœuds. Il existe bien sûr
des nœuds de différents types, offrant des possibilités quasi illimitées ;

• Buttons Window : cette vue offre la possibilité d’afficher les boutons per-
mettant d’utiliser ou de paramétrer les objets créés dans Blender. Les
boutons sont regroupés par panneaux et onglets dans des catégories
cohérentes, symbolisées par les icônes placées dans l’en-tête de la vue ;

Les types de vue à découvrir rapidement

Tous les types de vue sont bien évidemment utiles,
mais certaines sont utilisées plus fréquemment que
d’autres, et pour accélérer votre apprentissage de
Blender, autant vous y intéresser le plus tôt possible.
Vous utiliserez de façon transparente le File
Browser à chaque fois que vous voudrez charger
ou sauvegarder un projet ou une image ; 3D view
et Buttons Windows vous accompagneront
chaque jour ; Ipo Curve Editor et Video
Sequence Editor seront mis en oeuvre en même
temps que vos premières animations. Par la suite,
vous gagnerez du temps grâce à l’Outliner, qui
sera utile à vos projets les plus importants, et User
Preferences, qui vous permettra de démarrer
directement avec votre configuration préférée de
Blender. Enfin, le Node Editor vous permettra de
tirer partie des dernières avancées de Blender dans
la création de shaders très souples et de compo-
siting video.
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• Outliner : cette vue permet d’afficher sous forme de logigramme (par
défaut) ou d’arborescence (View>Show Outliner) les éléments consti-
tuant la scène, en respectant la hiérarchie de celle-ci. Ainsi, l’élément
Scene est parent d’un objet Cube, lui-même parent d’un maillage,
lui-même parent d’un Material, lui-même parent d’une Texture et
ainsi de suite pour tous les objets de la scène. Il est possible de déve-
lopper ou masquer tout ou partie d’une branche de l’arborescence en
cliquant sur les petits triangles en face de chaque entrée ;

• User Preferences : cette vue permet de définir, pour la scène courante,
les préférences de l’utilisateur, dans différents domaines. Les catégo-
ries disponibles sont, par exemple, les chemins par défaut dans les-
quels Blender va aller chercher les textures, les scripts, ou
l’enregistrement des rendus ou des animations ;

• Text Editor : cette vue offre un petit éditeur de texte embarqué dans
Blender, qui autorise la coloration syntaxique, l’indentation automa-
tique, et autres raffinements du même type. Lorsque vous écrivez un
script Python pour Blender, vous passerez soit par un éditeur externe de
votre choix (avant d’importer le script dans Blender), soit par cette vue ;

• Audio Window : cette vue permet d’afficher sous forme d’ondes les
sons enregistrés au format WAV, employées dans le moteur de jeu ;

• Timeline : cette vue permet de contrôler finement la façon dont une
animation est jouée, autorisant jusqu’à l’édition de clés ou de paramè-
tres matériau pendant l’animation même. L’animation peut bien sûr
être jouée au ralenti, et des marqueurs peuvent être posés pour
accéder plus rapidement à des séquences nécessitant un contrôle plus
fin de l’animation ;

• Video Sequence Editor : cette vue permet de composer une animation
complète à partir de scènes rendues par Blender, de vidéos importées,
ou même simplement de séquences d’images fixes. Le séquenceur
propose des effets très avancés, comme des transitions plus ou moins
sophistiquées, ou des effets spéciaux conçus pour renforcer le réa-
lisme de vos images (fixes comme animées), comme le flou focal ou
l’éblouissement. La versatilité de cet éditeur est l’un des plus grands
atouts de Blender ;

• UV/Image Editor : cette vue permet de contrôler le dépliage d’un maillage
pour le faire correspondre à une image existante ou non. La puissance
des outils de dépliage de Blender est l’un de ses plus grands atouts ;

• NLA Editor : cet éditeur permet de contrôler l’animation d’armatures
(dans le cas d’animation sous forme de squelette de personnages, par
exemple) ou les clés de déformation relative des maillages (pour l’ani-
mation des expressions du visage d’un personnage, par exemple) de
tous les objets en spécifiant l’enchaînement de leurs positions clés ;
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• Action Editor : cette vue permet de visualiser les positions clé d’une
armature ou des clés de déformation relative d’un maillage ;

• IpoCurve Editor : cette vue permet de définir certains paramètres d’un
objet (que ce soit des propriétés de matériau, de position, de rotation,
etc.) en fonction du temps, à l’aide de courbes de variation aux profils
aisément paramétrables (courbes de Bézier, segments, etc.). C’est un
outil très simple qui permet la réalisation d’animations complexes ;

• 3D View : cette vue permet de visualiser les objets d’une scène, ainsi que
de les éditer individuellement. C’est la vue par défaut de Blender, à
laquelle nous attacherons une attention particulière dans ce chapitre.

La fenêtre des boutons
Avec la vue 3D standard, il s’agit du plus important type de vue de
Blender. C’est là qu’il est possible de paramétrer la totalité des fonction-
nalités de Blender, et même si quelques possibilités et fonctionnalités
peuvent être reprises par certaines icônes ou certains menus, la fenêtre
des boutons est résolument incontournable.

Comme toute autre vue, la fenêtre des boutons est accompagnée d’un
en-tête. Il est particulier dans le sens où l’action sur l’une ou l’autre des
icônes va modifier la catégorie de boutons affichés. Les six premiers
boutons sont les suivants (certains présentent des sous-catégories) :
• Logic (touche [F4]) : ces boutons permettent de définir des senseurs,

des contrôleurs et des actionneurs logiques, dans le cadre de jeux
vidéo créés à l’intérieur même de Blender ;

• Script : ces boutons permettent de lier des scripts Python à des objets
à l’intérieur de Blender, et de les activer selon plusieurs scénarios ;

• Shading (touche [F5]) : ces boutons permettent de déterminer les pro-
priétés visuelles des objets, des lampes et de l’environnement. En
particulier, en cliquant sur cette icône, vous accédez à des sous-caté-
gories de boutons :
– Lamp buttons : permettent de déterminer le type de lampe et les

propriétés d’illumination des sources de lumière de vos scènes ;
– Material buttons : il s’agit des boutons par défaut lorsque vous accédez

au menu Shading. Ils permettent de contrôler les paramètres généraux
d’un matériau du point de vue du moteur de rendu, mais aussi de gérer
les textures qui lui sont rattachées, comme la pigmentation, la transpa-
rence sélective ou la simulation de défauts de surface ;

– Texture buttons (touche [F6]) : les textures peuvent être procédurales
(c’est-à-dire découlant de fonctions mathématiques pouvant produire
des motifs utiles ou intéressants) ou picturales (c’est-à-dire basées sur
des images ou des photos obtenues grâce à des logiciels tiers) ;

À DÉCOUVRIR RAPIDEMENT   
La fenêtre des boutons

Les Material et Texture buttons sont indispen-
sables à maîtriser pour donner une apparence cré-
dible ou intéressante à vos objets ; dans le même
ordre d’idée, les Lamp buttons vous permettront
de produire des éclairages satisfaisants. Le
menu Editing, pour sa part, vous permettra de
modéliser des objets complexes ou de modifier des
objets existants. Les Render buttons, enfin, vous
permettront de régler les options et d’effectuer le
rendu de vos scènes.
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– Radiosity buttons : la radiosité est une technique d’illumination réa-
liste, surtout utilisée en démonstration architecturale, où la lumi-
nosité met en valeur les espaces ;

– World buttons : ces boutons permettent de donner à vos images des
arrière-plans intéressants, du simple dégradé à l’image photogra-
phique, de mettre en place des étoiles ou des effets de brume, ou
encore de simuler une illumination globale grâce à la méthode dite
de l’occlusion ambiante.

• Object (touche [F7]) : ces boutons permettent de gérer des options
d’animation liées aux objets, en vous offrant trois sous-catégories :
– Object buttons : permettent de gérer des options d’animation le

long de chemins, ainsi que la duplication d’objets, les options
d’affichage des objets, leur distribution dans les calques, ou encore
les contraintes relatives aux objets ;

– Physic buttons : ces boutons permettent de gérer les champs physi-
ques (vent, vortex, champs de force) ou le système de collision,
mais aussi les différents systèmes de simulation de Blender, comme
l’animation des corps souples (simulation de gelées et d’objets élas-
tiques), de simulation des fluides ou des tissus (Cloth).

– Particle buttons : ces boutons permettent de créer des systèmes de
particules, animées ou statiques, pratiques pour la végétation ou les
fourrures.

• Editing (touche [F9]) : ce menu regroupe des panneaux variables selon
que vous soyez en mode Edit ou non. Les panneaux disponibles vous
permettent d’assigner les sommets de vos maillages à des groupes ou
des matériaux, de déterminer le centre de votre objet, d’invoquer en
mode Edit des outils de modélisation, d’ajouter des modificateurs de
maillage (opérations booléennes, lissage surfacique, miroir...) ou des
contrôleurs de forme (Shapes) ;

• Scene (touche [F10]) : ces boutons permettent de déterminer l’envi-
ronnement de rendu, d’animation, ou de gestion des sons dans
Blender, au travers de trois sous-catégories :
– Render buttons : ce sont les boutons par défaut, présentés en plu-

sieurs panneaux et onglets, permettant de définir les chemins de
sortie des images ou des animations, l’ajout de bruit à vos images, ou
encore le tracé de contours pour le rendu « toon » ; de gérer le rendu
de l’image en définissant les options de rendu, l’anticrénelage, ou
encore le choix du moteur de rendu (moteur interne ou YafRay) ; de
définir et de lancer le calcul d’une animation, ainsi que de rejouer
celle-ci avant écriture sous forme de fichier vidéo ; de définir le
format d’image ( JPEG, PNG, AVI...), ses dimensions, et les cou-
leurs (noir et blanc, couleur, gestion de la transparence) ;
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– Sequencer buttons : ces panneaux permettent de contrôler les effets
du Video Sequence Editor ;

– Anim/Playback buttons : permettent une gestion plus fine des
options liées à l’animation ;

– Sound block buttons : ces boutons permettent de choisir des fichiers
sons, de les jouer et de les rééchantillonner.

Personnaliser l’interface
Nous avons déjà vu qu’il est possible de changer une vue en n’importe
quel autre type de vue. Mais souvent, vous souhaiterez également per-
sonnaliser votre espace de travail, pour l’adapter à vos habitudes, vos pré-
férences, mais aussi à votre matériel, comme la résolution de votre écran.

Agencement des vues à l’écran
Cliquez sur n’importe quelle bordure entre deux vues avec le bouton cen-
tral de la souris. Un menu contextuel apparaît avec trois options :

• Split Area : cette option permet de couper en deux l’une des deux vues
séparées par la bordure sur laquelle l’opération est réalisée. Une ligne
de séparation apparaît sur le pointeur de la souris : vous pouvez la
déplacer de gauche à droite (ligne de séparation verticale après clic
sur une bordure horizontale) ou de haut en bas (ligne de séparation
horizontale après clic sur une bordure verticale), d’un côté ou de
l’autre de la bordure. Un clic gauche permet de valider la séparation,
tandis qu’un clic milieu bascule entre le mode séparation verticale ou
horizontale. Enfin, un clic droit permet d’annuler l’opération ;

• Join Area : cette option permet de fusionner les deux vues séparées par
la bordure sur laquelle l’opération est réalisée. Si plusieurs vues ris-
quent d’être affectées par l’opération de fusion, celle-ci est automati-
quement annulée ;

ASTUCE  Évaluation d’expressions dans les boutons

En utilisant le bouton gauche de la souris pour éditer au clavier la valeur d’un bouton de
Blender, plutôt que de saisir un nombre, vous pouvez saisir une expression mathématique
que Blender se chargera d’interpréter. Pour cela, il faut impérativement que l’expression
saisie commence par un dièse #. Par exemple #1*3, donnera pour résultat la valeur 3. En
revanche, #2/4 donnera 0.000 au lieu de 0.500 car si vous souhaitez obtenir une valeur
décimale, il faut qu’au moins l’une des valeurs de l’expression présente au moins un chiffre
décimal. Ainsi, #2.0/4 donnera bien 0.500, la valeur précédemment recherchée.

Figure 2–4

LE SAVIEZ VOUS ?  
Spécifier une valeur précise

L’interface de Blender présente de très nombreux
boutons, permettant assez souvent de spécifier
une valeur numérique, soit grâce à de petites flè-
ches, soit grâce à un curseur. Vous pouvez utiliser
le bouton gauche de la souris pour cliquer sur la
valeur courante du bouton, ce qui édite celle-ci et
vous permet d’entrer au clavier la valeur précisé-
ment souhaitée.

Émulation du troisième 
bouton de la souris

Dans la vue User preferences, observez les bou-
tons relatifs à la catégorie View & Controls. Ils
permettent entre autres choses de personnaliser le
comportement de la souris, et en particulier,
d’activer le bouton Emulate 3 Button mouse
(c’est normalement le cas par défaut). Une fois
ceci fait, vous pouvez émuler le bouton central
de la souris en cliquant simultanément sur les
boutons gauche et droit de votre souris.
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• No Header : cette option masque l’en-tête relatif à la vue. En cliquant
à nouveau avec le bouton central sur une bordure de la vue sans en-
tête, il est possible de faire réapparaître celui-ci en choisissant
l’option Add Header.

Sauvegarde des préférences
Si vous avez mis en place un agencement de vues qui vous satisfait, vous
pouvez l’enregistrer une fois pour toutes en appuyant simplement sur la
combinaison de touches [Ctrl]+[U]. Blender affichera une demande de
confirmation :

Vous pouvez également passer par le menu File>Save Default Settings.
Notez toutefois que si vous avez modifié la scène par défaut (activation
de certains boutons dans la fenêtre des boutons, ajout de lampes, d’objets
ou de caméras dans la vue 3D, etc.), toutes ces modifications seront éga-
lement sauvegardées, vous permettant ainsi de personnaliser jusqu’à la
scène de démarrage par défaut.

Pour revenir à la scène par défaut de Blender, il suffit de restaurer la con-
figuration d’origine. Cela est possible grâce au menu File>Load Factory
Settings, qui vous propose de tout effacer ; vous n’avez qu’à confirmer.

La vue 3D
Il s’agit de la vue dans laquelle vous réaliserez, normalement, le plus
d’opérations lors de l’usage de Blender. Une attention particulière lui est
donc apportée, mais la plupart des vues disposent de petits raffinements
plus ou moins dissimulés ou documentés.

Naviguer dans l’espace
Il ne s’agit pas ici de déplacer les objets dans la vue, mais bien de se
déplacer dans la vue, ou plus exactement de modifier son point de vue.
La souris nous permet plusieurs actions :
• Bouton central : en cliquant et en maintenant appuyé le bouton central

de la souris, la vue se met à tourner selon les déplacements de la
souris ;

Figure 2–6

Figure 2–7

ASTUCE   Déplacer l’en-tête

En cliquant sur un en-tête avec le bouton droit
de la souris, vous pouvez choisir entre trois options
pour la disposition de celui-ci : en haut de la vue
(Top), en bas de la vue (Bottom) et pas d’en-tête
(No Header).

Figure 2–5

Vue active

Les opérations qui suivent ne fonctionnent que
dans la vue active. À noter que la vue active est
toujours celle dans laquelle se trouve le pointeur
de la souris.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 200834

• Touche [Maj] et bouton central : appuyez sur la touche [Maj], puis cli-
quez et maintenez le bouton central de la souris, pour translater la vue
selon les déplacements de la souris ;

• Touche [Ctrl] et bouton central : appuyez sur la touche [Ctrl], puis cli-
quez et maintenez le bouton central de la souris, pour zoomer ou dé-
zoomer dans la vue 3D.

Affichage de la scène
Blender propose des vues prédéfinies, dont l’usage facilite souvent la
visualisation et/ou la mise en place ou la modélisation des objets. Ces
vues sont accessibles grâce aux touches du pavé numérique.
• Touche [7] : permet d’afficher la « vue de dessus » de la scène.
• Touche [1] : permet d’afficher la « vue de face » de la scène.
• Touche [3] : permet d’afficher la « vue de côté » de la scène.
• Touche [0] : permet d’afficher le point de vue de la caméra active.

À noter que le fait d’appuyer sur la touche [5] du pavé numérique permet de
basculer alternativement du mode d’affichage perspective et orthogonal.

En d’autres occasions, vous souhaiterez n’afficher à l’écran que l’objet sur
lequel vous travaillez. Pour ce faire, sélectionnez l’objet en cliquant
dessus avec le bouton droit de la souris, et appuyez sur la touche [/] du
pavé numérique. Répétez l’opération pour réafficher la scène entière.

Par défaut, la scène est affichée en mode fil de fer, mais parfois, ce mode
ne permet pas une bonne visualisation. En appuyant sur la touche [Z], la
vue filaire est remplacée par une vue ombrée, qui donne une meilleure
vision de la scène, en affichant les objets « pleins » et de la couleur cor-
respondant au Material de l’objet.

En fait, une icône de l’en-tête de la vue 3D permet de modifier l’affi-
chage de la vue 3D, en offrant plusieurs modes :

• BoundingBox : tous les objets sont remplacés par des cubes fil de fer englo-
bant au plus juste le volume réel de l’objet. Surtout utile pour les configu-
rations très peu musclées qui ont du mal à afficher les objets complexes ;

• WireFrame : il s’agit du mode de visualisation standard en fil de fer,
permettant de bien juger des volumes respectifs. Cependant, cer-

Figure 2–8
Les différents modes d’affichage

dans la vue 3D

ASTUCE   Perdu dans l’espace ?

Si vous vous perdez, pour trop avoir zoomé ou
avoir translaté la vue, appuyez tout simplement
sur la touche [.] du pavé numérique : la vue est
automatiquement déplacée et zoomée pour appa-
raître entièrement au centre de la vue 3D.

ASTUCE   Changer la caméra active

Si vous n’avez qu’une caméra dans votre scène, en
appuyant sur la touche [0] du pavé numérique,
vous affichez toujours la scène selon le point de
vue de la caméra. Si vous avez plusieurs caméras
dans votre scène, vous pouvez définir la caméra
active en sélectionnant celle-ci, et en appuyant sur
la combinaison de touches [Ctrl]+[0]. Désormais,
à chaque fois que vous changerez de vue, en
appuyant sur la touche [0] du pavé numérique,
vous afficherez la scène du point de vue de la nou-
velle caméra active.
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taines vues peuvent devenir confuses, dans la mesure où il est parfois
difficile de déterminer les objets de premier plan et d’arrière-plan, par
exemple, surtout en mode orthogonal. C’est une méthode d’affichage
économique en puissance de calcul ;

• Solid (ou touche [Z]) : cette méthode d’affichage consomme un peu plus
de puissance de calcul mais permet d’ombrer (et de rendre opaques !) les
objets de votre scène, afin de rendre plus aisée la visualisation ;

• Shaded (ou combinaison de touches [Maj]+[Z]) : dans ce mode d’affi-
chage, l’ombrage des objets prend en compte l’éclairage réel de la
scène, ce qui consomme encore un peu plus de puissance de calcul ;

• Textured (ou combinaison de touches [Alt]+[Z]) : les textures UV (et seu-
lement celles-ci, car cela ne fonctionne pas avec les textures procédurales
ou les textures classiques) de vos objets apparaissent dans la vue 3D.

Bases fondamentales
Depuis son lancement, Blender a conservé quelques particularités qui peuvent
paraître déroutantes, même si maintenant, toutes les opérations « occultes »
d’antan sont accessibles par les en-têtes des divers types de vues. Nous allons
toutefois revenir sur quelques manipulations critiques et essentielles.

Ajout d’un objet dans la scène
Nous avons déjà parlé du sous-menu Add du menu principal. Pour
ajouter une nouvelle lampe, par exemple, nous pouvons jouer de la
souris, et dans le menu principal, en haut de la vue, cliquer sur Add, puis
sur Lamp et à nouveau sur Lamp. Mais il est souvent plus productif
d’appuyer sur la touche [Espace] dont la fonction est justement d’appeler
le menu spécial Add. L’objet ainsi ajouté sera inséré dans la scène à la
position indiquée par le curseur 3D.

ASTUCE   Utilisez les écrans 
prédéfinis de Blender

Plutôt que de retoucher sans arrêt l’interface de
Blender, vous pouvez faire appel à l’un des agen-
cements de vues préréglés de Blender. Dans la
barre de menus principale se trouve un bouton
intitulé SCR:2-Model. En cliquant sur l’ascenseur
devant celui-ci, vous affichez les différents types
d’interfaces prédéfinis (1 – Animation, 2 –
Model, 3 – Material, 4 – Sequence, 5 –
Scripting). Vous pouvez bien sûr sauvegarder

votre propre modèle courant en choisissant ADD
NEW. Dans les exercices de cet ouvrage, nous
retoucherons les écrans manuellement afin de
nous familiariser avec leurs possibilités.

Figure 2–9 Les écrans prédéfinis de Blender

Blender et le curseur 3D

Pour définir une nouvelle position du curseur 3D
dans la scène, il suffit de cliquer à l’endroit de
votre choix avec le bouton gauche de la souris.
L’usage de la combinaison de touches [Maj]+[S]
appelle une vue dont deux options peuvent vous
intéresser à cette étape :
• Cursor>Grid : permet de positionner le cur-

seur exactement sur l’intersection de la grille la
plus proche du point cliqué ;

• Cursor>Selection : positionne le curseur sur
le centre de l’objet actuellement sélectionné.

Figure 2–10
Le menu Add, accessible depuis 
le menu ou la touche [Espace]



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 200836

Édition d’un maillage
Si vous sélectionnez un objet (qu’il soit de type Mesh, Curve, Meta, Sur-
face ou même Lattice) et que vous appuyez sur la touche [Tab] (ou choi-
sissez Edit mode dans le menu déroulant de l’en-tête de la vue 3D), vous
entrez dans un mode spécial d’édition, qui vous permettra de sélec-
tionner individuellement ou en groupe des sommets (Mesh), des points
de contrôle (Curve) ou des méta-éléments (Meta) et leurs zones
d’influence, par exemple.

Dans l’image qui suit, nous avons sélectionné le cube de la scène par
défaut de Blender, et sommes entrés en mode Edit grâce à la touche [Tab]
pour sélectionner les sommets de la face supérieure.

Pour sortir de ce mode, il suffit d’appuyer une nouvelle fois sur [Tab] ou
de choisir Object Mode dans le menu déroulant de l’en-tête de la vue 3D.

Objet sélectionné, objet actif
De nombreuses fonctions de Blender opèrent sur des objets sélectionnés.
Pour sélectionner un objet, cliquez dessus avec le bouton droit de la souris.
Dans la vue 3D, l’objet sélectionné apparaît en rose. Vous pouvez ajouter
d’autres objets à la sélection, en maintenant la touche [Maj] pressée lorsque
vous utilisez le bouton droit de la souris. Le dernier objet ajouté à la sélec-

Figure 2–11
Dans l’en-tête de la vue 3D, le menu déroulant

permet de basculer entre les modes Edit
et Object (entre autres).

Figure 2–12
Les sommets sélectionnés apparaissent

en jaune, tandis que les sommets
non sélectionnés restent en rose.
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tion est l’objet actif, et apparaît d’un rose légèrement plus clair que les
autres. Si vous appuyez maintenant sur la touche [Tab], c’est cet objet qui
sera édité, mais Blender conserve en mémoire la totalité de la sélection.

Si vous n’avez pas sélectionné les objets dans un ordre particulier, vous
pouvez définir l’un des objets sélectionné comme l’objet actif en mainte-
nant la touche [Maj] pressée et en utilisant le bouton droit de la souris
pour le désigner.

Pour retirer un objet de la sélection, maintenez la touche [Maj] et cliquez
sur l’objet à retirer avec le bouton droit de la souris une première fois, puis
une seconde fois pour le désélectionner effectivement. Si vous recliquez
une troisième fois dessus, il est à nouveau ajouté à la sélection.

Les calques
Blender permet de gérer jusqu’à vingt calques. Un calque est considéré
actif si le bouton correspondant est enfoncé. Vous utiliserez le bouton
gauche de la souris pour activer un calque. En maintenant pressée la
touche [Maj], vous pouvez ajouter ou retirer à la « sélection » des calques
actifs supplémentaires.

Les éléments contenus par un calque inactif ne sont pas visibles dans la
vue 3D, et ne seront pas pris en compte au moment du rendu.

Par défaut, lorsque vous ajoutez un objet à votre scène, il apparaît dans le
premier calque actif disponible. Mais vous pouvez affecter n’importe
quel objet à n’importe quel calque de deux façons.
• Avec l’objet sélectionné, utilisez la touche [M] pour faire apparaître un

gestionnaire de calques flottant. Avec le bouton gauche de la souris,

Figure 2–13
Un objet Cone et un objet Monkey sont sélectionnés et apparaissent en rose, 
tandis qu’un objet Plane, extérieur à la sélection, apparaît en noir ; l’objet actif 
est le Monkey : son rose est plus clair que celui du Cone.

Figure 2–14
Le gestionnaire de calques : seul le premier calque est actif et visible.
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sélectionnez le calque de destination. En maintenant la touche [Maj]
enfoncée, vous affectez l’objet à plusieurs calques à la fois !

• Avec l’objet sélectionné, rendez-vous dans le panneau Draw des
Object buttons, dans le menu Object, touche [F7].

Sauvegarder votre travail
Cela peut paraître trivial, mais les débutants échouent parfois à accom-
plir cette opération. Pour sauvegarder votre travail, passez par le menu

Gestion de groupes d’objets

Il est possible de créer des groupes d’objets. Par exemple, sélectionnez
deux objets et utilisez la combinaison de touches [Ctrl]+[G]. Une boîte
flottante apparaît pour vous proposer d’ajouter la sélection à un groupe
existant (Add to existing Group), d’ajouter la sélection à un nouveau groupe
(Add to New Group), ou de retirer la sélection à tous les groupes existants
(Remove from all Groups). Un objet appartenant à un groupe est surligné
en vert. Si vous utilisez la combinaison de touches [Alt]+[Maj]+bouton droit
de la souris, vous sélectionnez tous les objets du groupe.
Dans le panneau Object and Links des Object buttons du menu Object,
touche [F7], vous trouverez un bouton Add to Group, avec la liste de tous
les groupes auxquels l’objet appartient. À partir de ce même panneau,
vous pouvez, si vous le souhaitez, renommer les différents groupes en
éditant le nom des groupes d’appartenance.
Enfin, au travers du menu Add>Group, vous pouvez insérer, à la position
du curseur, un duplicata d’un groupe déjà existant.
Les groupes offrent quelques avantages dans la gestion de certaines
fonctionnalités de Blender.
• Champs de force et déflexion : dans l’onglet Particle Motion d’un émet-

teur de particules, vous pouvez indiquer dans le champ GR: le nom
d’un groupe ; les objets de ce groupe seront les seuls pris en compte
s’ils ont des propriétés de force ou de déflexion (Fields and Deflection).

• Sources de lumière : dans l’onglet Shaders d’un objet en particulier, vous
pouvez indiquer dans le champ GR: le nom d’un groupe ; les lampes
de ce groupe seront les seules prises en compte pour le calcul de
l’éclairage de l’objet en question.

• Duplication de groupes : dans le panneau Anim Settings d’un objet de
type Empty, vous pouvez indiquer dans le champ GR: le nom d’un
groupe, et activer le bouton DupliGroup ; les objets du groupe seront
dupliqués et disposés relativement à la position de l’objet Empty.

Les groupes apparaissent désormais dans la structure du fichier .blend
(un répertoire /Group est désormais accessible au travers des naviga-
teurs de fichiers, combinaison de touches [Maj]+[F1] ou [Maj]+[F4], ainsi
que dans les vues de type Outliner). Grâce à la fonction Append, combi-
naison de touches [Maj]+[F1], vous pouvez donc importer un groupe
existant (avec tous les objets correspondants) dans votre scène en choi-
sissant simplement le groupe en question dans le répertoire /Group de
votre fichier .blend.
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principal : File >Save As... ou appuyez simplement sur la touche [F2]. Cela
a pour effet de transformer la vue active en vue de type File Browser, para-
métrée en écriture.

Sur la première ligne se trouve le chemin de sauvegarde du fichier. Vous
pouvez naviguer dans votre système de plusieurs façons : pour remonter
dans l’arborescence de votre système, double-cliquez sur la ligne blanche
comportant les deux points « .. » ou cliquez une fois sur le bouton P en
tête de la première ligne. Pour descendre dans l’arborescence, double-
cliquez sur un répertoire, apparaissant en blanc dans la liste des fichiers.
Les fichiers apparaissent en noir dans la liste ; les fichiers blend existants
sont précédés d’un petit carré de couleur ocre.

Sur la deuxième ligne se trouve un champ vierge où vous pouvez saisir le
nom du fichier choisi. N’oubliez pas d’ajouter l’extension .blend propre
à Blender, le logiciel ne le fera pas à votre place. Appuyez sur la
touche [Entrée] pour valider la saisie.

Une fois ceci fait, vous pouvez valider la sauvegarde soit en appuyant une
seconde fois sur la touche [Entrée], soit en cliquant sur le bouton Save File.

À noter la présence d’un bouton ascenseur en tête de la seconde ligne : il
affiche tous les chemins déjà visités lors de la session Blender en cours,
ce qui peut faciliter l’accès à certains répertoires récurrents.

Charger votre travail
Vous pouvez bien évidemment rappeler un travail précédemment sauve-
gardé. Pour ce faire, soit vous passez par le menu principal : File>Open...,
soit vous appuyez sur la touche [F1]. Dans les deux cas, la vue active se
transforme en File Browser, comme précédemment, paramétrée en lecture.

Naviguez dans l’arborescence de votre système comme précédemment,
et sélectionnez un fichier blend (son nom sera forcément précédé d’un
petit carré de couleur ocre). Appuyez sur la touche [Entrée] pour valider
votre choix, ou bien appuyez sur le bouton Open File de la première ligne
du File Browser.

Figure 2–15
Le File Browser, ouvert en mode écriture
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Prenez garde à cette opération : si vous n’avez pas sauvegardé votre pré-
cédent travail, il sera supprimé de la mémoire sans préavis de la part de
Blender.

Effectuer le rendu d’une image
Si vous appuyez sur la touche [F10], vous affichez instantanément les
paramètres de rendu de votre scène. Pour effectuer le rendu de celle-ci
(c’est-à-dire calculer et afficher l’image finale), il vous faut cliquer sur le
bouton Render du panneau Render, appuyer sur la touche [F12], ou passer
par le menu principal : Render>Render Current Frame.

À noter que si vous obtenez un écran noir, plusieurs problèmes seront à
étudier et élucider :
• votre caméra est à l’intérieur d’un objet obscur : l’image résultante est

forcément noire ;
• il n’y a pas de lampe définie dans votre scène : l’image résultante est

forcément noire ;

ASTUCE   La fonction Append

Un fichier blend est en fait un ensemble de blocs de données parfaite-
ment délimités et organisés. Pour établir une analogie, on pourrait dire
qu’il s’agit d’une archive .zip ou tar.gz. Si on pouvait y entrer, on trou-
verait des répertoires :
• Camera
• Lamp
• Material
• Mesh
• Object
• Scene
• Text
• Texture
• World.
Chacun de ces répertoires contient les blocs de données présents dans
votre scène. Par exemple, votre objet, qui est une sphère rouge, est con-
situé d’un Mesh, d’un Material et éventuellement d’une Texture. Vous
pouvez utiliser la fonction Append, combinaison de touches [Maj]+[F1],
ou dans la barre de menus principale : Files>Append...) pour importer
dans votre scène courante le Material d’une autre scène en ouvrant le
fichier blend comme s’il s’agissait d’un répertoire, puis en ouvrant le
répertoire Material, et en choisissant enfin le Material de votre choix.
Vous pouvez également choisir d’importer à la fois le Mesh, le Material et
la Texture de votre sphère rouge en une seule fois, mais en sélectionnant
dans le répertoire Object le nom de l’objet en question.
C’est en fait la seule façon de copier un objet depuis un projet plus
ancien vers votre projet courant.
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• il n’y a pas de caméra active dans votre scène : l’image n’est même pas
calculée.

L’image calculée (ou en cours de calcul) apparaît dans une fenêtre flot-
tante. Vous pouvez interrompre le rendu en appuyant sur la
touche [Echap], et l’effacer en fermant simplement sa fenêtre.

Enregistrer une image rendue
Vous venez d’effectuer le rendu de votre première scène ? Félicitations, il
est temps de sauvegarder cette image. Pour y parvenir, vous pouvez
appuyer sur la touche [F3] ou passer par le menu principal : File>Save
Image... Dans les deux cas, la vue active se transforme en File Browser.
Pour sauvegarder l’image, procédez exactement comme si vous sauvegar-
diez votre fichier de travail, sauf que vous spécifierez une extension à
votre fichier conforme aux options du panneau Format des Render Set-
tings. Par défaut, le format sera du JPEG avec une qualité de 90 %.

Figure 2–16
Les options de format permettent de définir 
les dimensions, le format et la qualité 
de l’image enregistrée.

ASTUCE  
Masquer/afficher la fenêtre de rendu

En appuyant successivement sur la touche [F11],
vous pouvez afficher ou masquer la fenêtre de
rendu.

ASTUCE   Enregistrer 
une image sur fond transparent

Idéal pour les webmasters qui produisent des
logos ou boutons en 3D grâce à Blender, vous
pouvez effectuer le rendu de votre scène et faire
en sorte que l’arrière-plan de l’image (le World)
soit transparent. Pour y parvenir, deux
contraintes :
• le format choisi de l’image doit supporter la

transparence, PNG et TARGA, par exemple ;
• vous devez activer le bouton RGBA dans le

panneau Format des paramètres de rendu.
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chapitre 3

Splash !, © 2005 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Premier projet avec Blender

Ce chapitre a pour objet de poser les bases fondamentales de la 
modélisation et de la création de matériaux, en laissant pour 
l’instant de côté la mise en lumière et les réglages relatifs au 
rendu. L’objectif va être ici de modéliser une simple carafe au 
travers de fonctions usuelles, mais surtout, en faisant un usage 
intensif des raccourcis clavier qui font toute la force de 
Blender. Nous apprendrons ainsi à déplacer, faire tourner ou 
redimensionner des sélections, à déplacer les points pivots pour 
ces opérations, ou encore à sélectionner des faces, des arêtes ou 
des sommets. Côté matériau, nous allons débuter directement 
par la création du verre, un exercice qui vient très tôt dans la 
carrière de tout artiste numérique qui se respecte, mais qui 
pose également de singuliers problèmes de réalisme. Nous 
verrons également comment tirer profit du moteur de rendu en 
raytracing pour surmonter ces difficultés.

SOMMAIRE

BModélisation d’une carafe

B Définition d’un matériau 
transparent

MOTS-CLÉS

BModélisation
BMaillage
B Sommets
B Édition
BMatériau
B Shader
B Verre
B Transparence
B Réflexion
B Raytracing
B Spin
B PET
B Extrude
B Pivot
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Préparation de l’espace de travail
Commencez par lancer Blender. Nous allons préparer notre espace de
travail de façon à être le plus efficace possible. Avec le bouton central de
la souris, cliquez sur le bord séparant la vue 3D principale de la fenêtre
des boutons. Choisissez Split Area et coupez la vue 3D en deux parties à
peu près égales. De la même façon, toujours avec le bouton central de la
souris, cliquez maintenant sur le bord séparant les deux vues 3D, choi-
sissez à nouveau Split Area, et coupez en deux parties à peu près égales la
vue de droite. Déplacez le curseur de la souris dans la grande vue de
gauche, et appuyez sur la touche [1] du pavé numérique : ce sera désor-
mais notre vue de face. Déplacez le curseur de la souris dans la vue en
haut à droite, et appuyez sur la touche [7] du pavé numérique : ce sera
désormais notre vue de dessus. Enfin, déplacez le curseur dans la vue en
bas à droite et appuyez sur la touche [0] du pavé numérique : ce sera la
vue depuis la caméra.

Si cet agencement vous convient, vous pouvez le sauvegarder pour en faire
votre scène de démarrage par défaut, en utilisant la combinaison de touches
[Ctrl]+[U], et en validant la question posée par Blender : Save user defaults.

Nous allons maintenant supprimer le cube par défaut. Sélectionnez-le en
cliquant dessus, dans n’importe quelle vue 3D, à l’aide du bouton droit de
la souris : le cube apparaît désormais surligné en rose clair. Pour le sup-
primer, allez dans le menu Object et choisissez Delete, ou plus rapide-

Figure 3–1
Les vues 3D, après réaménagement

de l’espace de travail (les autres vues
n’ont pas été modifiées)
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ment, appuyez sur la touche [X]. Blender vous demande si vous
souhaitez effacer les objets sélectionnés : Erase selected object(s) ?
Appuyez sur la touche [Entrée] pour valider.

Modélisation de la carafe
La première partie de ce chapitre va consister à vous guider pas à pas
dans la modélisation d’une carafe. Ce type d’objet est très pédagogique,
car il est suffisamment simple pour vous permettre d’arriver au bout, ce
qui est motivant, mais également suffisamment riche pour appliquer
plusieurs outils très utiles, ce qui est intéressant. Vous aurez aussi la satis-
faction d’apprendre plusieurs astuces.

Tracé du profil de la carafe
Placez le curseur de la souris dans la vue de face (la plus grande des vues
3D, à gauche). Appuyez sur la combinaison de touches [Ctrl]+[flèche vers
le haut] : la vue 3D occupe désormais tout l’espace disponible ! Pas de
panique, pour revenir à l’espace de travail précédemment défini, il suffit
d’appuyer sur la combinaison de touches [Ctrl]+[flèche vers le bas].

Le curseur est normalement au centre de la vue. Si ce n’est pas le cas, cli-
quez avec le bouton gauche de la souris au centre de la scène, symbolisé
par une barre verticale bleue et une barre horizontale rouge. Appuyez
alors sur la combinaison de touches [Maj]+[S] et à la demande de
Blender, choisissez l’option Cursor>Grid. Le curseur est désormais par-
faitement aligné sur la grille, dans cette vue.

Pour tracer le profil de notre carafe, nous allons commencer par insérer
un objet de type Plane (plan) au centre de notre scène. Pour ce faire, dans
la barre principale, cliquez sur Add, puis Mesh et enfin Plane. Si vous sou-
haitez respecter la règle d’or de Blender (une main sur le clavier, une
autre sur la souris), appuyez sur la touche [Espace] d’une main, puis de
l’autre, choisissez Mesh, puis Plane dans les menus déroulants.

Vous pouvez obtenir cet espace de travail en allant chercher le
fichier exercice-ch03.01.blend sur le DVD-Rom d’accompagnement
dans le répertoire /exercices. Il contient quelques éléments supplémen-
taires placés sur le deuxième calque. Pour les masquer, afin qu’ils ne vous
gênent pas dans votre exercice de modélisation, décochez le deuxième
calque (au milieu de l’en-tête de la plus grande vue 3D) de sorte à ce que
les boutons de calque ressemblent à l’illustration ci-dessous.
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Un plan a effectivement été ajouté. Trois remarques peuvent être faites à
ce propos.
1 Le plan apparaît automatiquement en mode Edit, comme tout objet

ajouté au travers du menu Add.
2 Tous les sommets le composant apparaissent en jaune, indiquant

qu’ils sont tous sélectionnés.
3 La face reliant les sommets sélectionnés apparaît en rose plutôt qu’en

gris, indiquant qu’elle est également active.

Nous allons tout déselectionner. Pour ce faire, dans le menu Select, choi-
sissez Select/Deselect All. Pour être plus efficace et plus rapide, utilisez le
raccourci clavier correspondant, la touche [A]. Tous les sommets appa-
raissent désormais en rose, indiquant qu’ils sont désélectionnés, et la face
reliant les sommets devient grise.

Nous allons maintenant sélectionner tous les sommets, à l’exception du
sommet inférieur gauche. Pour ce faire, plusieurs méthodes s’offrent à nous.
1 Sélectionnez le sommet supérieur gauche en cliquant dessus avec le

bouton droit de la souris (il apparaît désormais en jaune) ; maintenez
alors pressée la touche [Maj] et utilisez à nouveau le bouton droit de la
souris pour ajouter les sommets supérieur droit et inférieur droit à la
sélection courante.

2 Dans le menu Select, choisissez Border Select, ou plus directement,
utilisez le raccourci clavier [B]. Le curseur de la souris se modifie
légèrement, et en utilisant le bouton gauche de la souris, vous pouvez

Figure 3–2
En modélisation polygonale,

le point de départ est souvent le plan.

ASTUCE   Modifier l’affichage 
d’une vue 3D au clavier

Les touches du pavé numérique portant des flè-
ches de direction peuvent également servir à
modifier l’affichage d’une vue 3D. Par exemple, les
touches [2], [8], [4] et [6] permettent de faire
tourner le point de vue respectivement vers le
haut, vers le bas, vers la droite et vers la gauche. Si
vous maintenez la touche [Ctrl] ou la
touche [Maj] pressée, les mêmes touches servent
à translater le point de vue vers le haut, vers le
bas, vers la gauche et vers la droite. Enfin, les
touches [+] et [-] du pavé numérique permettent
de zoomer en avant ou en arrière à volonté.
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cliquer-glisser pour dessiner un cadre autour des deux sommets
supérieurs ; lorsque vous relâchez la souris, les deux sommets enca-
drés sont sélectionnés et apparaissent en jaune. Répétez l’opération
pour encadrer le sommet inférieur droit seul.

À noter que vous pouvez déselectionner exactement de la même façon
(soit en cliquant directement sur un sommet avec le bouton droit, soit en
encadrant le(s) sommet(s) à déselectionner grâce au bouton droit), mais
en maintenant pressée la touche [Maj].

Pour effacer les trois sommets sélectionnés choisissez Mesh puis Delete
dans le menu, ou, plus simplement, appuyez sur la touche [X]. Une boîte
de dialogue apparaît, Blender nous demandant ce que nous souhaitons
effacer au sein de la sélection.

Choisissez Vertices pour effacer les sommets sélectionnés ; les arêtes liées
à ces sommets disparaissent alors, de même que la face qui reliait tous les
sommets, ne laissant plus que le sommet inférieur gauche d’origine.

Sélectionnez-le, soit en cliquant dessus avec le bouton droit de la souris,
soit en utilisant la touche [A] pour tous les sélectionner (il n’y en a de
toute façon qu’un seul : celui qui nous intéresse). Nous allons le ramener
au centre de notre scène, grâce à la combinaison de touches [Maj]+[S]
que nous avons déjà vu. Toutefois, cette fois-ci, nous allons choisir
l’option Selection>Cursor.

Le premier point de notre profil est désormais au centre de la scène. Il
est théoriquement sélectionné ; si ce n’est pas le cas, cliquez dessus avec
le bouton droit de la souris pour y remédier.

Maintenant, nous allons ajouter d’autres sommets à la sélection cou-
rante, à partir du dernier point sélectionné : en maintenant appuyée la

Figure 3–3
La suppression sélective

Figure 3–4
Les options de « magnétisation »

ASTUCE   Activer et désactiver l’option 3D 
Transform Manipulator

Par défaut, l’option 3D Transform Manipu-
lator est activée. Il s’agit de l’icône représentant
une main, au centre, dans l’en-tête de la vue 3D.

Figure 3–5

Cliquez sur cette icône pour la désactiver, ou utilisez
le raccourci clavier [Ctrl]+[Espace] pour l’activer
ou la désactiver au rythme de vos besoins. Le mani-
pulateur qui apparaît à l’écran peut vous compli-
quer la tâche lorsque vous êtes en mode Edit ou, au
contraire, se révéler pratique et utile en mode
Object. En particulier, il est redoutable en mode
Pose des armatures, avec le mode Local d’orienta-
tion de transformation ([Alt]+[Espace]).
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touche [Ctrl], cliquez avec le bouton gauche de la souris sur la position du
prochain sommet, et ainsi de suite. Constituez ainsi le profil de votre
carafe, de sorte à ce qu’il ressemble à peu près à la figure suivante.

Ne paniquez pas si vous ne placez pas vos points exactement là où vous
l’auriez souhaité. Pour corriger les imperfections, vous avez deux options.
1 Vous pouvez annuler la dernière opération (en particulier l’insertion

du sommet supplémentaire) en appuyant sur la touche [U] (pour
Undo, ou défaire/annuler en français). L’annulation ne fonctionne
toutefois que pour l’objet en cours d’édition.

2 Vous pouvez sélectionner un sommet mal placé (il apparaît alors en
jaune ; faites attention à ce qu’aucun autre sommet ne soit sélectionné,
au besoin sélectionnez et déselectionnez tous les sommets grâce à la
touche [A]), et appuyez sur la touche [G] (pour Grab, soit attraper/
déplacer en français) ; la sélection suit désormais le mouvement de la
souris, mais alternativement, vous pouvez utiliser les touches de direc-
tion du clavier (pas du pavé numérique !) pour déplacer la sélection.

Vous pouvez maintenant quitter le mode Edit, en appuyant sur la
touche [Tab], et retourner à l’affichage standard de Blender, avec toutes
les vues 3D et la fenêtre des boutons, telles que nous les avons laissées,
grâce à la combinaison de touches [Ctrl]+[flèche vers le bas] du clavier,
avec bien sûr le pointeur de la souris dans la vue 3D qui occupe l’essen-
tiel de l’écran.

Annulation d’une opération

La touche [U] ne fonctionne qu’en mode Edit. En
mode Object (ou n’importe quel autre mode)
vous pouvez faire usage de la combinaison de
touches [Ctrl]+[Z] (méthode commune à de très
nombreux logiciels, toutes plates-formes confon-
dues) pour annuler la dernière opération.

Figure 3–6
Par ajouts successifs de sommets, nous obte-

nons la courbe de notre objet.

Créer des faces à partir de sommets

Cela n’est pas rigoureusement nécessaire dans
notre cas, mais vous pouvez, si vous le souhaitez,
sélectionnez les faces par groupe de trois ou
quatre (préférez effectuer la sélection de sorte
qu’aucun des triangles ou quadrilatères ne soit
trop écrasé ou distendu, autant que possible), et
appuyez sur la touche [F]. Une face réunit alors les
sommets sélectionnés, ajoutant au passage les
arêtes nécessaires.
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Transformer le profil en objet
Nous avons maintenant notre profil en deux dimensions. Tout ce qu’il nous
reste à faire, c’est de faire tourner ce profil sur lui-même, pour générer l’objet
qui servira de base à notre carafe. Entrez en mode Edit de l’objet, grâce à la
touche [Tab], et sélectionnez tous les sommets grâce à la touche [A] (si vous
aviez un ou plusieurs points sélectionnés à la fin de l’étape précédente, une
première pression sur la touche [A] déselectionnera ces sommets-ci, puis une
seconde pression sélectionnera la totalité des sommets).

Maintenant, cliquez sur l’icône Editing, ou appelez la fenêtre des boutons
correspondante grâce à la touche [F9]. Si vous êtes bien en mode Edit, un
panneau intitulé Mesh Tools figure dans les boutons disponibles.

Ce panneau regroupe divers outils de modélisation très classiques. Parmi
ceux-ci se trouve un outil nommé Spin. Pour notre part, nous souhaitons
transformer notre profil en un objet totalement circulaire ; nous saisirons
donc une valeur de 360 dans le champ Degr. Ensuite, nous souhaitons
une circonférence relativement lisse ; nous spécifierons donc une valeur
de Steps modérément élevée, par exemple : 20.

Maintenant, cliquez sur le fameux bouton Spin. Le curseur de la souris se
transforme pour afficher un point d’interrogation, invitant l’utilisateur à
choisir la vue dans laquelle l’opération doit avoir lieu. S’agissant d’un
profil, si nous voulons le voir se transformer en objet circulaire, il nous
faut sélectionner la vue de dessus (normalement en haut à droite, si vous
avez respecté l’agencement des vues suggéré).

L’objet vient de prendre soudainement corps sous nos yeux, Blender
s’étant automatiquement occupé de la génération des arêtes et des faces
intermédiaires entre les profils clonés et pivotés. Vous noterez que seuls
les sommets correspondant au profil initial sont sélectionnés, au terme
de l’opération. Si nous regardons les statistiques, dans la barre de menus

Figure 3–7
Le panneau consacré aux outils 
affectant le maillage

PRATIQUE   Modifier un champ numérique

Blender tolère plusieurs méthodes pour modifier
un champ numérique. Tout d’abord, à la souris.
Remarquez qu’un champ numérique a souvent des
petites flèches pointant vers la gauche et vers la
droite de la valeur numérique. En cliquant
(bouton gauche) au centre et en décalant la
souris vers la droite (sans relâcher le bouton de
souris), vous augmentez la valeur ; vers la gauche,
vous la diminuez.
Vous pouvez également cliquer directement sur la
valeur numérique. Un curseur rouge apparaît, et
vous pouvez alors supprimer la valeur existante
(touches [BackSpace] ou [Suppr]) et taper la
valeur de remplacement. Alternativement, la com-
binaison de touches [Maj]+[BackSpace]
permet d’effacer d’un coup la valeur numérique.
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principale, nous remarquerons la catégorie Ve: 12-252. Notre profil
comporte douze points (c’est effectivement le premier des deux nombres
séparés par un tiret). Nous avons spécifié que le profil subirait une rota-
tion en 20 étapes. Théoriquement, nous devrions avoir un total de
240 sommets (20 fois 12). Or, nous en avons au total 252, soit 12 de
trop. C’est dû au fait que le dernier profil mis en rotation s’est superposé
au profil initial. Nous avons donc des sommets coïncidents occupant le
même espace. Au moment du rendu, cela se traduira par une arête vive
sur un profil autrement lisse. Il n’est pas pratique de chercher à éliminer
un à un les points coïncidents. Le plus simple est à nouveau de s’en
remettre aux outils de Blender. Toujours en mode Edit, appuyez sur la
touche [A] deux fois afin de sélectionner tous les sommets de l’objet ; ils
apparaissent désormais en jaune, et toutes les faces correspondantes en
rose. Toujours dans le panneau Mesh Tools, repérez le bouton Rem Dou-
bles et cliquez dessus (ne touchez pas à la valeur par défaut Limit: 0.001
qui nous convient très bien). Blender vous informe qu’il a supprimé
50 points coïncidents (Removed: 50) ce qui est bon signe, puisque nous
savions qu’il y en avait. Mais pourquoi 50 ? Tout simplement parce que
les deux points extrêmes du profil, situés sur l’axe Z de révolution, ont
également été dupliqués 20 fois. Sortez puis entrez à nouveau en mode
edition (en appuyant deux fois consécutives sur la touche [Tab]) pour
mettre à jour les statistiques : Ve: 202-202.

Vous pouvez maintenant quitter le mode Edit (touche [Tab]).

Améliorer l’aspect de la carafe
Nous allons maintenant nous attacher à donner une meilleure allure au
corps de notre carafe. Pour y parvenir, nous allons intervenir à deux
niveaux.
• Au niveau de l’affichage : il existe une astuce consistant à « lisser »

l’ombrage des facettes, de sorte que l’on ait l’illusion d’une surface
sans facettes. Il s’agit de la fonction Set Smooth.

Figure 3–8
Après vingt rotations successives du profil,

notre objet gagne en volume.
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• Au niveau du maillage : le profil aurait pu être composé d’un plus
grand nombre de points, et la rotation de celui-ci se découper en un
plus grand nombre d’étapes, de sorte que les facettes auraient été plus
petites et, donc, l’objet plus lisse. Il existe un algorithme qui sous-
divise le maillage de base en le lissant, de façon virtuelle, de sorte que
le maillage d’origine est préservé. Il s’agit du modificateur Subsurf.

L’usage de ces deux astuces conduit à des maillages plus lisses tout en
épargnant les efforts de l’utilisateur de Blender. Leur mise en œuvre se
réalise au travers de la fenêtre des boutons Editing (touche [F9]).

Lissage de l’ombrage des facettes
Le bouton Set Smooth se trouve dans le panneau Link and Materials. En
cliquant dessus, l’ombrage de la carafe est immédiatement affecté et sug-
gère une surface parfaitement lisse. À noter toutefois que la géométrie
de la carafe n’est pas altérée : si vous regardez les « bords » de la carafe
par rapport à l’arrière-plan, vous constaterez que les segments la consti-
tuant sont toujours très visibles.

Différence entre Catmull-Clark et Simple Subdiv

Les deux méthodes sont proposées comme option lorsque vous mettez en œuvre le modificateur
Subsurf. Simple Subdiv va conserver la géométrie d’origine, et simplement diviser régulière-
ment le maillage d’origine un certain nombre de fois. Par exemple, utiliser Simple Subdiv, avec
Levels égal à 1 sur un cube, aura pour résultat le même cube dont chaque face sera constituée
de quatre sous-facettes. Catmull-Clark, pour sa part, va non seulement diviser le maillage
d’origine, mais, en plus, le lisser. Pour reprendre l’exemple précédent, l’utilisation de Catmull-
Clark avec Levels égal à 1 va produire une sorte de boule à facettes. Dernière (importante) dif-
férence entre les deux méthodes : Catmull-Clark est immédiatement effective à l’écran, inte-
ractivement et en temps réel. Simple Subdiv, pour sa part, nécessite que vous cliquiez sur le
bouton Apply du modificateur, hors du mode Edit, pour que la subdivision ait lieu.

ASTUCE  Set Smooth 
sur des groupes de facettes seulement

En mode Edit (touche [Tab]), sélectionnez les
facettes de votre choix, et appuyez sur le bouton
Set Smooth. Quittez le mode Edit : l’ombrage des
seules facettes sélectionnées a été lissé ; les facettes
sont clairement visibles en dehors de la sélection. Le
bouton Set Solid fonctionne à l’inverse de Set
Smooth : il révèle les facettes.

Figure 3–9 Une ligne de facettes sur deux 
est soumise au bouton Set Smooth, 

l’autre à Set Solid.

Figure 3–10
Notre carafe est toute en facettes, 
mais grâce au bouton Set Smooth, 
elle paraît beaucoup plus lisse.
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Lissage de la géométrie de la carafe
Nous allons maintenant découvrir une fonctionnalité quasi magique de
Blender : les modificateurs. Les modificateurs permettent de modifier
« à la volée » la géométrie de vos objets afin d’en changer l’aspect, mais
de façon réversible : la géométrie d’origine est la seule véritablement
stockée dans le fichier. Le résultat du modificateur est interprété à
chaque opération ou chargement.

En particulier, nous allons nous intéresser au modificateur Subsurf, qui
permet de remplacer le maillage grossier de la carafe par un maillage plus
dense, aux courbes plus harmonieuses. Dans la fenêtre des boutons,
recherchez l’onglet Modifiers, cliquez dessus s’il n’est pas au premier plan,
et découvrez le bouton Add Modifier. Dans le menu déroulant qui appa-
raît lorsque vous cliquez dessus, choisissez Subsurf.

Nous allons laisser tels quels tous les paramètres par défaut, mais préci-
sons tout simplement que Catmull-Clark est la méthode de subdivision de
surfaces, que Levels est le niveau de lissage dans la vue 3D, et que Render
Levels est le niveau de lissage au moment du rendu. Bien évidemment,
plus ce chiffre est élevé, plus le lissage est important, mais plus le modi-
ficateur consommera de la mémoire et ralentira le temps de rendu (et
même d’affichage dans les vues 3D).

ASTUCE   Rendre permanent un modificateur

En cliquant sur le bouton Apply associé au modi-
ficateur, sa géométrie est figée telle quelle, et rem-
place dans la mémoire de Blender la géométrie
d’origine.

Figure 3–11
Ajout d’un modificateur de type Subsurf

Figure 3–12
Notre carafe, avant et après

l’activation du modificateur Subsurf
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Modifier le profil
Si vous n’êtes pas tout à fait satisfait des proportions de votre carafe, rien
n’est perdu. Par exemple, nous allons rétrécir la partie supérieure de la
carafe, pour lui donner un peu plus de style. Dans la vue de face, et en
mode Edit (touche [Tab]), utilisez l’outil de sélection Select>Border Select,
ou plus simplement la touche [B], pour tracer une boîte (bouton gauche
de la souris) autour de la deuxième ligne de sommets depuis le haut de la
carafe. Attention, pensez à désactiver le Backface-Culling (voir aparté ci-
contre À savoir : le Backface-Culling), sinon seuls les sommets du premier
plan seront sélectionnés. Puis, appuyez sur la touche [S] (pour Size, taille
ou dimension, en français) pour les redimensionner. Dès que vous aurez
appuyé sur la touche [S], le mouvement de la souris va fixer l’agrandisse-
ment ou le rétrécissement de la sélection.

Pour notre part, nous allons appuyer sur la touche [Ctrl] tout au long du
déplacement de la souris, afin que l’augmentation ou la diminution des
dimensions se fasse par incréments réglés, plutôt que par valeurs libres.
Observez l’en-tête de la vue pendant cette opération, elle affichera des valeurs
« rondes » de Size X, Size Y et Size Z, qui indiquent respectivement le fac-
teur de « redimensionnement » appliqué à la sélection dans les trois axes de
notre repère. Une fois obtenue la forme souhaitée pour la carafe, appuyez sur
touche [Entrée] pour valider la transformation géométrique.

Vous pouvez alors appuyer sur la touche [A] pour déselectionner tous les
sommets qui le sont. Ne quittez toutefois pas le mode Edit, nous allons
encore transformer notre maillage.

À SAVOIR   Le Backface-Culling

Il s’agit d’une méthode d’affichage dans la vue 3D
qui permet de totalement masquer les arêtes, som-
mets et faces en arrière-plan, par les faces qui se
situent en premier plan. Cela permet d’observer
plus facilement la topologie (le maillage) de vos
objets, et de n’autoriser les sélections que sur les
faces en avant. Ainsi, lorsque le Backface-Cul-
ling est actif, les sélections grâce à la
fonction Border Select (touche [B]) n’affectent
pas les faces masquées.
Pour l’activer ou la désactiver, cliquez sur l’icône
représentant un cube, avant-dernier bouton, dans
l’en-tête de la vue 3D.

Figure 3–13

Figure 3–14
Le col de la carafe est redimensionné.

ASTUCE   Contraindre une modification 
selon un axe déterminé

Lorsque vous appuyez sur les touches [G], [R] ou
[S] pour déplacer, faire tourner ou redimensionner
un objet, vous pouvez enchaîner avec les
touches [X], [Y] ou [Z] pour contraindre la modi-
fication selon l’axe correspondant. Par exemple, en
vue de de face, si vous appuyez sur la touche [G],
puis [Z], la sélection ne sera déplacée que selon la
direction de l’axe Z.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 200854

Le bec verseur
Nous allons maintenant ajouter un bec verseur à notre carafe. Nous
aurions plusieurs solutions pour y parvenir, mais celle choisie est un peu
plus pédagogique que les autres. Jusqu’à présent, les opérations de redi-
mensionnement ou de rotation utilisaient comme pivot le centre géomé-
trique de la sélection. Cette option est matérialisée par l’icône Median
Point, dans l’en-tête de la vue 3D.

Avec ce type de pivot actif, le centre de la rotation ou du redimensionne-
ment sera un point immatériel correspondant au centre de gravité de la
sélection. Il s’agit du comportement par défaut, mais d’autres options exis-
tent. Parmi celles-ci, la possibilité d’utiliser le curseur 3D comme centre de
rotation. Dans l’en-tête de la vue de face, choisissez l’option 3D Cursor.

Puis, positionnez le curseur (bouton gauche de la souris) à peu près au niveau
du « cou » de la carafe. En utilisant la combinaison de touches [Maj]+[S],
forcez le positionnement du curseur à une intersection de la grille en choisis-
sant l’option Cursor>Grid lorsque Blender vous le demandera.

Maintenant, nous allons utiliser un outil à la fois simple et puissant de
Blender : le Proportional Editing Tool (PET, ou outil d’édition propor-

Figure 3–15
Median Point, le pivot par défaut

Figure 3–16
La nouvelle position du curseur 3D
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tionnelle, en français). Le principe en est simple : lorsque l’outil est actif,
si vous avez un maillage d’une certaine densité et que vous déplacez un
sommet, Blender va déplacer proportionnellement tous les sommets
situés dans le rayon d’effet de l’outil. Bien évidemment, les sommets à
l’extérieur du rayon d’effet ne sont pas affectés, et à l’intérieur de celui-
ci, plus le sommet sera proche du sommet déplacé, plus il sera déplacé à
son tour, selon une règle proportionnelle, carrée, sphérique ou autre.

Pour activer cet outil, soit vous cliquez sur l’icône approprié de l’en-tête,
soit vous utilisez le raccourci clavier [O], soit vous passez par le
menu Mesh et cliquez sur Proportional Editing. Dans les trois cas, Blender
vous propose plusieurs options (celle par défaut, que nous conserverons,
est tout simplement le mode On).

La loi qui gère le déplacement des sommets dans le rayon d’effet de
l’outil est appelée le Falloff ; par défaut, la loi sélectionnée est le Smooth
Falloff, mais vous pouvez la changer, soit en cliquant sur l’icône appro-
priée (qui apparaît lorsque vous activez l’outil), et en choisissant dans le
menu déroulant, soit en passant par le menu Mesh, et en cliquant sur Pro-
portional Falloff. Enfin, le rayon d’effet de l’outil est symbolisé à l’écran
par un cercle. Vous pouvez augmenter son rayon en utilisant la molette
de votre souris.

Pour notre carafe, activez l’outil d’édition proportionnelle grâce à la
touche [O] et conservez l’icône Smooth Falloff par défaut qui devient dis-
ponible. Dans la vue de dessus (celle en haut à gauche, si vous avez res-
pecté l’agencement des vues), appuyez sur la touche [B] pour activer
l’outil Border Select que nous avons déjà vu ; des lignes verticales et hori-
zontales apparaissent pour vous guider dans la création de la boîte de
sélection. Sans rien sélectionner, appuyez une seconde fois sur [B] : les

Figure 3–17
Activation de l’outil d’édition proportionnelle

Figure 3–18
Réglages possibles du Falloff

Un mode d’édition intelligent : 
Connected

L’outil d’édition proportionnelle tient compte des
connexions éventuelles entre la sélection et les
sommets voisins. Lorsque l’option Connected est
active, seuls les sommets situés dans l’aire d’effet
et reliés à la sélection sont affectés.

Quelques combinaisons de touches 
pour régler le rayon d’effet

Les combinaisons de touches [Alt]+[+] et
[Alt]+[-] du pavé numérique, ou plus simplement
les touches [PageUp] et [PageDown] permet-
tent également de changer le rayon d’effet de la
fonction PET.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 200856

lignes sont remplacées par un cercle, dont vous pouvez régler le rayon
grâce aux touches [+] et [-] du pavé numérique, ou la molette de la souris.
Comme nous allons faire une sélection assez fine, appuyez quelques fois
sur la touche [-] pour diminuer sensiblement la taille du cercle d’effet, et
sur la vue de dessus, sélectionnez les deux points situés sur la ligne hori-
zontale et correspondant au sommet de la carafe.

Si la sélection vous convient, validez à l’aide du bouton droit de la souris.
Maintenant, revenez dans la vue de face. Nous avons désormais tout ce
qu’il nous faut : un centre de rotation défini comme étant le curseur 3D,
et une sélection de points prêts à être mis en rotation. Il ne nous manque
plus, en fait, qu’à réaliser la rotation ! Cela se fait au moyen de la
touche [R] (pour Rotate, faire tourner, en français). Le rayon d’effet est
certes assez grand, mais ne vous laissez pas impressionner : déplacez le
curseur de la souris, et observez la valeur en bas de la vue 3D, elle
indique en temps réel l’angle de rotation de la sélection.

Maintenez appuyée la touche [Ctrl], et déplacez la souris jusqu’à obtenir
un angle de -35.00°, mais ne validez pas encore. Lâchez délicatement la
souris (pour ne pas la bouger), puis la touche [Ctrl], et utilisez mainte-
nant les touches [PageUp] et [PageDown] pour régler le rayon d’effet de
l’outil d’édition proportionnelle jusqu’à obtenir la forme souhaitée. Vous
pouvez maintenant valider la rotation grâce à la touche [Entrée].

Appuyez sur la touche [A] pour désélectionner tous les points qui le sont,
mais ne quittez pas encore le mode Edit : il nous reste encore un acces-
soire important à donner à notre carafe !

Figure 3–19
Sélection des points à faire tourner

autour du curseur 3D

ASTUCE   Utiliser des valeurs réglées

Lorsque vous transformez un objet, il est difficile
d’être très précis à la souris, et de contrôler la
portée de cette modification, surtout si vous
« visez » des valeurs rondes ou précises. En main-
tenant la touche [Ctrl] pressée pendant le mouve-
ment de la souris, vous contraignez la
transformation à des multiples d’une unité entière
pour les opérations de déplacement (touche [G]),
de 5° pour les opérations de rotation (touche [R]),
ou d’un facteur multiplicatif de 0.1 pour les opéra-
tions de redimensionnement (touche [S]).

Figure 3–20
Angle de rotation lisible en temps réel
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Ajout de l’anse
Les outils de modélisation de Blender étant variés et versatiles, nous dis-
posons, ici aussi, pour ajouter une anse à la carafe, de nombreuses
méthodes. Nous en choisirons bien sûr une qui nous permettra de
découvrir des facettes intéressantes de Blender.

Dans un premier temps, cliquez sur l’icône présentant un cube dans l’en-
tête, afin de réactiver le Backface-Culling. Désormais, lorsque vous utili-
serez l’outil de sélection Border Select, la sélection ne portera que sur les
faces, arêtes et sommets visibles du premier plan. Ensuite, si vous avez
quitté le menu Editing, retournez-y grâce à l’icône appropriée ou grâce à
la touche [F9]. Dans l’onglet Modifiers, le modificateur Subsurf doit être
actif ; passez la valeur de Levels à 2, afin que le tracé à l’écran corresponde
bien au tracé du rendu. Enfoncez le bouton Optimal Draw ; à droite du
nom du modificateur se trouve une série d’icônes, un petit bouton de
type radio, et des curseurs pointant vers le haut et le bas. Cliquez sur le
bouton radio pour l’activer : l’apparence de votre carafe dans la vue 3D
prend immédiatement une autre allure !

Figure 3–21
La carafe est désormais presque complète.

Mode de sélection

Par défaut, lorsque vous utilisez un outil de sélec-
tion, ce sont des sommets que vous sélectionnez.
Mais dans certains cas, il est plus intéressant
d’appliquer certains outils (comme Extrude) à des
arêtes ou des faces, plutôt qu’à des sommets. Dans
l’en-tête, vous pouvez spécifier aisément le mode
de sélection courant. Dans l’illustration qui suit, le
bouton avec les quatre petits points active la
sélection de sommets, la barre inclinée active la
sélection d’arêtes, et enfin, le triangle avec le point
central active la sélection de faces.

Figure 3–22

À noter que si vous maintenez la touche [Maj]
pressée pendant que vous choisissez un mode de
sélection, il devient possible de mélanger les
modes de sélection !

Figure 3–23
Le modificateur Subsurf 
et l’option Optimal Draw en action
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Placez-vous dans la grande vue 3D à gauche (qui contient actuellement
la vue de face) et basculez-la en vue de côté, grâce à la touche [3] du pavé
numérique. Puis, dans l’en-tête, activez le mode de sélection de faces.

Dans la vue nouvellement transformée en vue de côté droit, activez
l’outil Border Select cylindrique en appuyant deux fois consécutives sur la
touche [B]. Diminuez le rayon du cercle de sélection grâce à la
touche [PageDown] ou à la molette de la souris, puis sélectionnez les deux
faces centrales de la deuxième rangée de faces.

Revenez en vue de face grâce à la touche [1]. Nous allons construire une
anse à notre carafe, en extrudant celle-ci à partir de notre sélection. Dans
le menu Mesh, choisissez Extrude, ou appuyez sur la touche [E]. Blender
affiche alors un menu pour vous demander la méthode d’extrusion ;
choisissez Region (la proposition par défaut) en cliquant dessus ou en
appuyant sur la touche [Entrée].

Déplacez un peu la face extrudée vers le haut, mais pas trop, et validez
avec le bouton gauche de la souris.

Figure 3–24
Le triangle avec un point central est le bouton

permettant d’activer le mode « sélection de faces ».

LE SAVIEZ-VOUS ?  

Si les touches [7], [1] et [3] affichent respective-
ment les vues de dessus, de face et de côté droit,
les touches [Ctrl]+[7], [Ctrl]+[1] et [Ctrl]+[3]
affichent pour leur part les vues de dessous, de
derrière et de côté gauche.

Figure 3–25
Sélection des deux faces à partir

desquelles l’anse va être tirée

Figure 3–26
La boîte de dialogue de la fonction d’extrusion
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Les modes d’extrusion

Il existe jusqu’à quatre modes d’extrusion, en fonction du mode de sélection.
Region : l’extrusion se fait suivant la « normale moyenne » à la sélection.
Individual Faces : l’extrusion se fait, face par face, selon la normale propre à chaque face.
Only Edges : pareil que précédemment, sauf que seules les arêtes sont extrudées.
Only vertices : pareil que précédemment, sauf que seuls les sommets sont extrudés.

Figure 3–27 Illustration de 3 modes d’extrusion ; 
respectivement : Region, Individual Faces, Only Edges

Figure 3–28
Première étape d’extrusion
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Comme pivot des transformations, choisissez l’icône Median Point puis,
dans la vue de dessus, appuyez sur la touche [S] pour diminuer la section
de la sélection. Validez avec le bouton gauche de la souris, ou appuyez sur
la touche [Entrée].

De retour dans la vue de face, extrudez à deux reprises la sélection grâce à
la touche [E], en validant à chaque fois. Placez le curseur 3D au niveau de
la rangée précédente, et dans l’en-tête, choisissez comme pivot 3D Cursor.

Appuyez sur la touche [R] et imprimez aux dernières faces créées une
légère rotation, et validez avec le bouton gauche ou la touche [Entrée].
Ensuite, répétez l’opération plusieurs fois : [E] pour extruder, [Entrée]
pour valider, bouton gauche pour repositionner le curseur 3D au niveau
des faces créées lors de l’étape précédente, [R] pour faire tourner légère-
ment la sélection, et [Entrée] pour valider. Au bout de quelques manipu-
lations, vous aurez une anse acceptable. Utilisez la touche [A] pour
déselectionner tout ce qui l’est.

Figure 3–29
Redimensionnement de l’excroissance

Figure 3–30
Par extrusions successives, l’anse se dessine.
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Si vous regardez de plus près dans la vue de dessus, vous remarquerez
que l’épaisseur de l’anse y est plus faible que sa largeur dans la vue de
face. Nous allons y remédier simplement, si vous l’estimez nécessaire.
Désactivez à nouveau le Backface-Culling en cliquant sur l’icône appro-
priée de l’en-tête. Dans la vue de face, utilisez l’outil Border Select circu-
laire (deux fois la touche [B]) pour sélectionner toutes les faces de l’anse,
jusqu’à sa base exclue.

Dans la vue de dessus (au besoin, utilisez la combinaison de
touches [Ctrl]+[flèche vers le haut] pour maximiser la vue, puis
[Ctrl]+[flèche vers le bas] pour restaurer les vues habituelles), changez le
pivot en Median Point en cliquant sur l’icône appropriée de l’en-tête, et
appuyez sur la touche [S] pour commencer le redimensionnement. Pendant
celui-ci, appuyez sur la touche [Y] pour forcer le changement selon l’axe Y
de la scène : une barre verticale apparaît à l’écran, pour vous indiquer que
vous êtes en train de contraindre la transformation selon un axe particulier.

Figure 3–31
L’anse enfin complète

ASTUCE   Actions suivant l’extrusion

En phase d’extrusion, vous pouvez à tout moment
appuyer sur les touches [G], [R] ou [S] de sorte à
appliquer la transformation de votre choix aux
faces, sommets ou arêtes en cours d’extrusion.

Figure 3–32
Sélection de toutes les faces constituant l’anse
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Lorsque vous êtes satisfait de l’épaisseur de votre anse, cliquez sur le
bouton gauche ou sur la touche [Entrée] pour valider.

Vous avez fini de modéliser votre carafe ! Nous allons effectuer un rapide
rendu, afin de voir à quoi ressemble notre scène. Mais avant, activez le
deuxième calque, en maintenant pressée la touche [Maj], puis cliquez à
l’aide du bouton gauche de la souris sur le deuxième bouton de calque, de
sorte à ce que les boutons de calque, au milieu de l’en-tête de la plus
grande vue 3D, ressemblent à l’illustration de la figure 3-34.

Si vous avez travaillé sur la base du fichier exercice-ch03.01-
depart.blend fourni sur le DVD-Rom d’accompagnement, il vous suffit
d’appuyer sur la touche [F12] pour obtenir le premier rendu suivant, qui
vous récompense chaleureusement de vos premiers efforts.

Figure 3–33
Redimensionnement de l’anse

dans la direction Y

Figure 3–34
Les deux premiers calques sont actifs.

Usage des calques

Blender vous permet de ranger les objets de votre
scène jusque dans vingt calques différents. En
mode Object, sélectionnez un objet et appuyez
sur la touche [M]. Le gestionnaire de calques
apparaît à l’écran. D’un clic du bouton gauche
de la souris, sélectionnez le calque sur lequel
l’objet doit être envoyé.
Vous pouvez également passer par le
menu Object (touche [F7]) et dans les Object
buttons, choisir à l’aide du bouton gauche de
la souris le calque sur lequel doit figurer l’objet.
À noter que, dans les deux cas, vous pouvez envoyer
un objet sur plusieurs calques à la fois : maintenez
alors la touche [Maj] pressée, puis cliquez avec le
bouton gauche sur les calques souhaités.

Figure 3–35
Notre travail de modélisation enfin achevé !
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Création de votre premier matériau : le verre
Après avoir modélisé une carafe, nous allons nous attacher à comprendre
comment la mettre en « couleurs », c’est-à-dire lui donner les propriétés
visuelles qui vont permettre à notre cerveau de l’identifier comme étant
constituée de verre.

Création d’un nouveau matériau
Avec le bouton droit de la souris, sélectionnez la carafe, puis affichez la
fenêtre des boutons relatives au shading grâce à la touche [F5]. Normale-
ment, les Material buttons s’affichent automatiquement, conformément à
l’illustration qui suit.

Le panneau de gauche, Preview, nous permettra de prévisualiser les maté-
riaux en cours d’édition. Aucun matériau n’étant pour l’instant associé à la
carafe, il est donc compréhensible qu’il soit vide. Le panneau suivant,
Material, est également plutôt vide, mais contient un bouton Add New : en
cliquant dessus, vous créez un nouveau matériau, dont tous les paramètres
ont les valeurs par défaut, et évoquent une sorte de plastique gris assez peu
intéressant. Vous noterez que, par défaut, il s’appelle Material. Cliquez
sur le champ MA:Material, effacez le nom présent, puis remplacez-le par
quelque chose de plus explicite, comme Verre.

Nous n’allons pas tarder à voir comment changer la couleur de notre
matériau, mais dans un premier temps, intéressons-nous au panneau de
prévisualisation, qui nous montre un carré d’un gris peu engageant.
Repérez le bouton représentant une sphère jaune, et cliquez dessus ;
Blender affiche désormais une grosse boule grise qui occupe l’essentiel
du panneau. Cliquez également sur le dernier bouton (un cercle gris)
pour activer l’anticrénelage et lisser la prévisualisation.

Vous pouvez soit démarrer sur la base de votre propre carafe, soit
charger le fichier exercice-ch03.01-final.blend présent dans le
répertoire /exercices du DVD-Rom d’accompagnement.

Figure 3–36 L’objet est pour l’instant vierge de tout matériau.

Options du panneau de prévisualisation

Sur le côté droit du panneau de prévisualisation se
trouve une série de boutons rangés verticalement :
• le premier (carré rouge, par défaut) permet de

réaliser un essai d’affichage du matériau en
cours d’édition sur un plan ; 

• le second (petite sphère jaune) l’affiche sur une
sphère ; 

• le troisième (cube gris) l’affiche sur un cube ; 
• le quatrième (petite tête de singe rouge)

l’affiche sur une primitive complexe en forme
de tête de singe ; 

• le cinquième l’affiche sur des mèches (utile
pour les particules statiques) ; 

• le sixième (une autre sphère jaune) l’affiche sur
une grosse sphère. 

Toutes les primitives sont munies d’un environne-
ment à refléter, à l’exception de la deuxième
sphère jaune, qui présente un simple « ciel »
comme environnement. Choisir une forme évo-
quant au plus près celle de l’objet en cours d’édi-
tion est souvent utile pour mieux juger de l’allure
du matériau.
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Changement de la couleur
L’onglet Material présente toute une série de boutons et de curseurs qui
peuvent vous paraître intimidants, mais les choses sont relativement
simples à utiliser au début. Pour changer la couleur du matériau, il suffit
de changer la valeur des trois composantes de couleur rouge, vert et bleu
qui, par mélange, donneront la couleur finale voulue. Ces composantes
sont représentées par les curseurs R (Red, rouge), G (Green, vert) et B
(Blue, bleu). Par exemple, pour obtenir un léger vert d’eau (idéal pour
notre matériau), nous allons spécifier les composantes suivantes :
R 0.700, G 0.950, B 0.700.

Ajouter de la transparence
Le panneau de prévisualisation est désormais mis à jour, mais nous n’en
avons pas encore fini : nous souhaitons créer un matériau transparent. Il
existe encore un curseur gérant le taux de transparence du matériau, et
dont la composante porte le nom A (Alpha). Plus la valeur est basse, plus
le matériau est transparent. Avec A 0.00, l’objet est totalement invisible ;
avec A 1.00, il est totalement opaque. Pour notre matériau de verre, nous
choisirons une valeur très faible, mais non nulle. Par exemple, A 0.03 et
nous activerons l’option ZTransp dans le panneau Links and Pipeline.

Vous pouvez si vous le souhaitez effectuer un rendu de la scène
(touche [F12]) pour observer votre matériau de verre dans un environne-
ment « réel » plutôt que dans un panneau de prévisualisation. Le résultat
vous paraîtra des plus surprenants : la carafe est tout simplement bleue et
ne présente absolument pas, par transparence, l’arrière-plan prévu !

Figure 3–37
La prévisualisation en temps réel de votre

matériau sur une primitive de votre choix :
plan, sphère, cube, tête de singe, mèches

(strands), sphère avec un ciel

ASTUCE   Spécifier la couleur

Vous avez plusieurs options pour modifier la cou-
leur de votre matériau.
• Utiliser les curseurs : vous pouvez, avec le

bouton gauche de la souris, déplacer indivi-
duellement chaque curseur.

• Saisir les valeurs numériques : en cliquant
avec le bouton gauche sur la valeur du
bouton, vous pouvez l’éditer à l’aide du clavier.

• Utiliser l’éditeur de couleurs : en cliquant
sur les nuanciers à gauche des boutons Col,
Spe et Mir, vous pouvez appeler un outil gra-
phique d’édition des couleurs qui vous per-
mettra de choisir directement la couleur
souhaitée.

Figure 3–38 Le sélecteur de couleurs intégré 
à Blender

Figure 3–39
L’option ZTransp configurée

dans les Material Buttons
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Les modes de transparence

Blender permet de travailler selon trois modes distincts de transparence.
• Transparence Alpha : la couleur du matériau est mélangée à celle du World dans les proportions suggérées par la valeur Alpha du matériau. C’est

le comportement par défaut, et c’est ce qui se passe ici : si vous cliquez sur le bouton appelant les World buttons, vous verrez dans le panneau de
prévisualisation que le « monde » est de couleur bleue.

Figure 3–40 La « transparence » ne révèle que le World de la scène plutôt que l’arrière-plan.

• Transparence Z : au moment du rendu, plutôt que de mélanger la couleur de l’objet à celle du World, Blender va la mélanger avec celle de
l’arrière-plan. Pour ce faire, consultez le panneau Links and Pipeline et activez le bouton ZTransp.

Figure 3–41 Cet effet de transparence évoque plus un objet pratiquement invisible qu’un matériau transparent.

• Transparence et raytracing : non seulement, au moment du rendu, Blender va mélanger la couleur de l’objet avec celle des objets en arrière-plan,
mais en plus, des options vont permettre d’activer la distorsion des objets observés au travers du verre. Dans l’onglet Mirror Transp repérez puis
activez le bouton Ray Transp.

Figure 3–42 Grâce au raytracing, la transparence tient compte de la distorsion de la lumière au travers du verre, pour un résultat plus réaliste.
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Ne vous inquiétez pas : il y a une explication logique à votre déception. Il
existe plusieurs modes de transparence gérés par Blender, mais pour notre
exemple, nous allons choisir la méthode de transparence avec raytracing.
Pour cela, activez le bouton Ray Transp dans l’onglet Mirror Transp, spécifiez
un IOR de 1.55 pour notre matériau de verre, ainsi qu’un Depth de 10 (atten-
tion, il y a deux champs Depth, l’un concernant les propriétés de Ray Mirror,
et placé dans la colonne correspondante, et un autre pour les propriétés Ray
Transp, également placé dans la colonne correspondante). Pour faire bonne
mesure, nous donnerons également une petite valeur au paramètre Filt (pour
Filter, filtre) : 0.050. Les paramètres Limit et Falloff (relatifs à la transmissi-
vité du matériau) seront laissés à leur valeurs par défaut.

Choix des shaders
Nous pourrions nous en arrêter là, le résultat étant satisfaisant, mais il
est possible d’améliorer encore un peu le réalisme du matériau, en spéci-
fiant et en réglant les shaders du matériau. Blender propose en effet
divers modèles de shaders. Les Diffuse shaders affectent uniquement la
couleur de base du matériau, tandis que les Specular shaders affectent
l’intensité et l’étendue des taches spéculaires (les reflets lumineux à la
surface d’objets vernis, par exemple).

Le choix entre les différents modèles de shaders est effectué dans
l’onglet Shaders, qui partage le même panneau que l’onglet Mirror Transp.

Figure 3–43
Les propriétés de transparence du verre

Remarque : les ombres des objets transparents

Si nous avons maintenant un matériau de verre correct, force est de
constater que l’ombre projetée sur le mur (et les autres objets) n’est
guère réaliste : les ombres des objets sont généralement aussi translu-
cides que les objets sont transparents. Ici, en revanche, les ombres sont
pleines et solides, comme si elles étaient projetées par des objets totale-
ment opaques. Pour corriger cela, il faut activer le bouton TraShadow
dans le panneau Shaders des objets recevant les ombres transparentes.

LE SAVIEZ-VOUS ?  

Le moteur de rendu OpenGL qui permet l’affichage
ombré dans les vues 3D utilise le célèbre ombrage
de Gouraud, qui permet d’éclairer la surface des
objets sans recourir à un calcul systématique de
l’illumination de chaque pixel, ce qui grèverait
sérieusement les performances de votre ordinateur.
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La première ligne permet de définir le Diffuse shader, la seconde déter-
mine le Specular shader. Nous allons dans cet exercice totalement ignorer
les autres boutons et curseurs existants. Cliquez sur le menu déroulant
présentant actuellement l’option Lambert, et choisissez Oren-Nayar en
lieu et place, comme nouveau Diffuse shader. Le matériau étant transpa-
rent, il paraît logique qu’il ne reflète que peu de lumière, et donc que sa
valeur de Ref soit faible. Qui plus est, il s’agit d’un matériau naturelle-
ment lisse, donc sa valeur de Rough devrait également être faible : en
conséquence, diminuez la valeur de Ref à 0.10, et Rough à 0.05.

Passons maintenant au Specular shader. Nous allons conserver le shader Cook-
Torr présenté par défaut dans le menu déroulant. Comme nous souhaitons que
les reflets lumineux soient prononcés, nous augmenterons la valeur Spec ; de
même, nous souhaitons que les taches lumineuses soient très « dures » sur les
bords, nous augmenterons donc la valeur Hard : en conséquence, nous utilise-
rons une valeur de Spec égale à 1.25 et une valeur de Hard égale à 85.

Rendre le matériau réflectif
Nous pouvons encore affiner le matériau de verre en lui donnant quelques
propriétés réflectives, de sorte que l’environnement de la carafe soit visible
dans les reflets du verre. Pour cela, nous allons retourner dans l’onglet Mirror
Transp, et activer le bouton Ray Mirror. Le seul paramètre que nous change-
rons sera Ray Mir, et nous lui donnerons une faible valeur, comme 0.10.

Vous trouverez sur le DVD-Rom d’accompagnement le fichier
exercice-ch03.02-final.blend dans le répertoire /exercices.

Figure 3–44
Les options de shaders par défaut

Figure 3–45
Nos shaders Diffuse et Specular

Au sujet des options de raytracing

Dès lors que vous activez des options de shading
ou d’éclairage propres au raytracing, il vous faut
explicitement activer celui-ci dans les options de
rendu. Dans le menu Scene, touche F10], activez
le bouton Ray dans le panneau Render.

Figure 3–46
Les propriétés de réflexion du verre
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chapitre 4

Seiko Chronograph, © 2004 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Techniques de modélisation

L’art de la modélisation est un genre à part dans l’imagerie de 
synthèse. De bons modèles sont nécessaires pour inspirer 
réalisme, atmosphère ou émotions. Ce chapitre vous présente 
les outils que Blender met à votre disposition pour remplir 
cette fonction. Blender est parfaitement à l’aise avec la 
modélisation polygonale, et fournit dans ce domaine de 
nombreux outils qui vont de l’utile à l’indispensable. Il permet, 
malgré tout, de modéliser à l’aide de courbes, de surfaces 
mathématiques (Bézier ou NURBS), ou encore de méta-
éléments qui fonctionnent un peu à la façon de gouttes de 
mercure qui s’agglomèrent selon vos souhaits. Ce chapitre 
n’aura pas la prétention de vous apprendre à modéliser ; pour 
cela, il vous faudra écumer les forums d’utilisateurs, étudier les 
maillages de leurs modèles lorsqu’ils les mettront à disposition 
ou en montreront une vue en mode fil de fer, suivre de 
nombreux didacticiels... Il n’y a pas de secret, car même avec 
un document vous expliquant pas à pas comment modéliser, 
par exemple, un corps humain de façon réaliste, il vous faudra 
retrousser les manches. Ce chapitre a pour seule ambition de 
vous donner les outils pour y arriver, de vous concentrer sur la 
finalité plutôt que sur le moyen.

SOMMAIRE

B Polygones, NURBS, 
méta-éléments

B Courbes, objets textes, 
modificateurs

MOTS-CLÉS

B Sommets
B Facettes
B Arêtes
B Courbes
B Bézier
B NURBS
B Primitives
B Subsurf
B Booléens
B Boucles d’arêtes
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Modélisation polygonale
La modélisation polygonale est un très vaste sujet, Blender étant doté de
nombreux outils dans ce domaine. Le contenu de ce chapitre n’est mal-
heureusement qu’un aperçu de ce qui est possible, l’expérience et une
bonne connaissance du logiciel permettant souvent d’obtenir des résul-
tats quasi similaires par divers moyens, plus ou moins complexes.

Les primitives
Blender propose un certain nombre de primitives prêtes à l’emploi. Les
associer permet de construire des objets simples, ou de s’en servir comme
base à des objets plus complexes. Pour ajouter une nouvelle primitive, il
faut passer par le menu Add de la barre principale, ou par la boîte à outils
([Espace]>Add>Mesh), puis choisir la primitive à insérer. La nouvelle pri-
mitive est automatiquement en mode Edit lors de son insertion, tous ses
sommets étant sélectionnés. Certaines primitives possèdent des paramè-
tres qu’il faut au préalable définir avant qu’elles ne soient affichées.
• Plane : insère un objet de type plan. Cette primitive est souvent le point

de départ de toute modélisation, l’utilisateur supprimant tous les som-
mets sauf un, et ajoutant des sommets ([Ctrl]+bouton gauche de la
souris) en construisant des faces au fur et à mesure (touche [F] avec au
moins trois sommets sélectionnés). Cet objet n’a pas d’épaisseur.

• Cube : insère un objet de type cube. Cette primitive est souvent le
point de départ des modélisations à base d’extrusion, où l’utilisateur
décrit d’abord des formes simples avant de détailler celles-ci à l’aide
des outils couteau (touche [K]) et extrusion (touche [E]).

ASTUCE   Appel de la boîte à outils

Outre passer par le menu Add, vous pouvez
recourir à l’une des trois méthodes suivantes pour
appeler la boîte à outils de Blender :
• touche [Espace] ;
• combinaison de touches [Maj]+[A] ;
• pression continue sur le bouton gauche de la

souris.

Figure 4–1
Un objet de type plan

Figure 4–2
Un objet de type cube
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• Circle : insère un simple cercle. À l’appel de cette primitive, Blender
demande le nombre de sommets (Vertices) devant constituer le cercle ;
un minimum de trois sommets est bien sûr nécessaire pour constituer
un profil clos. Les sommets sont reliés les uns aux autres par des arêtes,
mais par aucune face. De plus, l’objet n’a aucune épaisseur. En consé-
quence, il n’apparaît normalement pas lors des rendus, et n’est souvent
que le point de départ de modélisations plus complexes. Vous pouvez
également spécifier le rayon (Radius) du cercle. Enfin, l’option Fill
permet de clore la surface, transformant le cercle en disque.

• UVsphere : insère un objet de type sphère. Cette primitive est consti-
tuée de facettes quadrangulaires ; la résolution de la sphère (le
nombre de facettes la constituant) est déterminée interactivement par
les paramètres Segments et Rings, lors de l’appel de cette primitive.
Vous pouvez également spécifier le rayon (Radius) de la sphère.

• Icosphere : insère également un objet de type sphère, toutefois consti-
tuée de facettes triangulaires ; augmenter le nombre de subdivision
permet d’augmenter la résolution de l’icosphère. Icosphere produit des
résultats très proches d’UVsphere mais avec un maillage plus écono-
mique en sommets pour une précision en surface à peu près équiva-
lente. Vous pouvez également spécifier le rayon (Radius) de la sphère.

Figure 4–3
Un objet de type cercle

Figure 4–4
Un objet de type sphère

3DS MAX   Primitive Géosphère

Dans 3ds max, il est possible de créer des
géosphères : sphères à base de trigones. Il existe
trois bases géodésiques (déploiement du maillage)
de type :
• tetra ;
• octa ;
• icosa.
Le type icosa est l’équivalent de l’icosphère dans
Blender.
Si l’on regarde le sommet de la géosphère, on
remarque que celle-ci est composée de trois tran-
ches pour le type tetra, quatre pour l’octa et cinq
pour l’icosa.
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• Cylinder : insère un objet de type cylindre. Cette primitive a une base
circulaire, qui se définit de la même façon que pour la primitive Circle,
grâce aux paramètres Vertices et Radius. Elle possède toutefois un para-
mètre supplémentaire, la longueur du cylindre (Depth), ainsi que la
possibilité de fermer ses extrémités par des facettes (option Cap Ends).

• Cone : insère un objet de type cône, de base circulaire ; il est défini
exactement de la même façon que la primitive Cylinder, excepté qu’il n’y
a qu’une seule extrémité, qui peut ou non être close par des facettes
(option Cap Ends). Le cône pourrait être un cylindre dont tous les som-
mets de la face supérieure auraient été fondus en un point central.

Figure 4–5
Un objet de de type icosphere

La primitive Tube

Elle n’existe plus dans Blender ; pour créer un
maillage de type tube, ajoutez un maillage de type
Cylinder et désactivez l’option Cap Ends : le
cylindre qui sera affiché ne sera pas fermé à ses
extrémités.

Figure 4–6
Un objet de type cylindre

3DS MAX   Primitive Pyramide

Elle n’a pas d’équivalent sous Blender mais peut
facilement être simulée par un cône dont le
nombre de Vertices est fixé à 4.

Figure 4–7
Un objet de type cône
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• Grid : insère un objet de type grille. Il pourrait s’agir d’un objet de
type plan dont la résolution serait déterminée individuellement dans
ses directions locales X et Y.

• Monkey : insère un objet de type tête de singe. En fait, ce modèle a un
prénom, Suzanne, et se trouve être la mascotte du logiciel Blender.
On ne compte pas le nombre de nouvelles fonctionnalités de Blender
testées sur la pauvre Suzanne à chaque innovation logicielle.

• Empty Mesh : insère un objet vide, doté d’une origine et d’un système
de coordonées locales. Fonctionnant à l’identique d’un simple Empty,
il offre la possibilité supplémentaire d’être matérialisé sous forme de
différentes primitives (cône, sphère, cube, cercle) ou de systèmes
d’axes (axes simples, flèche seule, flèches).

• Torus : insère un objet de type tore. Il s’agit en fait d’un cylindre (de
rayon égal à Minor Radius, et composé d’un nombre de segments égal
à Minor Segments) courbe rebouclant sur lui-même, au terme d’une
trajectoire circulaire (de rayon égal à Major Radius, et composée d’un
nombre de segments égal à Major Segments).

Figure 4–8
Un objet de type grille

Figure 4–9
Le modèle Suzanne, mascotte de Blender

Figure 4–10
Un objet de type tore
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Les outils de modélisation de base
Ce sont des fonctions qui seront fréquemment invoquées par l’utilisateur
débutant, et qui lui donneront déjà une certaine autonomie par rapport à
la simple utilisation des primitives abordées jusqu’à présent.

Joindre deux maillages
Il arrivera fréquemment que vous construisiez des ensembles de formes à
l’aide de primitives, et que vous désiriez à la fin (ou à n’importe quel
moment du processus de modélisation) joindre les différents objets dis-
tincts au sein d’un même objet. Pour cela, vous sélectionnerez un pre-
mier objet avec le bouton droit de la souris, puis en maintenant la
touche [Maj] pressée, vous ajouterez d’autres objets à la sélection, tou-
jours avec le bouton droit de la souris. La combinaison de touches
[Ctrl]+[ J] ([ J] pour Join, joindre) vous permet de rassembler tous ces
objets en un seul ; en mode Edit, vous remarquerez que la nouvelle entité
sera constituée des maillages de chacun des objets, chacun demeurant
distinct. L’objet résultant portera le nom du dernier objet ajouté à la
sélection, et son centre sera le centre de ce même dernier objet.

ASTUCE  Déplacer les centres des objets

Suite à diverses opérations de fusion ou de séparation de maillages, vos objets peuvent se
retrouver avec des centres éloignés du centre géométrique théorique du maillage, ou simple-
ment de l’endroit où vous auriez pu souhaiter le placer. Dans le panneau Mesh du
menu Editing, vous trouverez trois boutons qui, hors du mode Edit, vous permettront de
positionner différemment le centre de l’objet.
• Centre : si le centre est éloigné du centre géométrique théorique de l’objet, le maillage de

l’objet est déplacé de sorte à ce que son centre géométrique corresponde avec le centre
distant. C’est le maillage qui est déplacé, et non le centre !

• Centre New : si le centre est éloigné du centre géométrique théorique de l’objet, le centre
distant est déplacé pour correspondre avec le centre géométrique de l’objet. Cette fois,
c’est le centre qui est déplacé, et non l’objet.

• Centre Cursor : quelles que soient les positions du centre géométrique théorique ou du
centre effectif, la position du centre est redéfinie pour qu’elle coïncide avec la position du
curseur 3D.

Figure 4–11 Le panneau Mesh et les boutons de positionnement du centre d’un objet

ASTUCE  
Sélectionner les sommets liés entre eux

Comme nous venons de le voir, vous pouvez
ajouter à un maillage des groupes de sommets qui
ne sont pas forcément liés entre eux. Pour des
maillages complexes, il devient alors très difficile,
à un moment donné, de sélectionner un même
groupe de sommets uniquement grâce à la boîte
de sélection invoquée par la touche [B]. En
mode Edit, lorsqu’aucun sommet n’est sélec-
tionné, vous pouvez toutefois amener le curseur de
la souris à proximité d’un sommet en particulier, et
utiliser la touche [L] (pour Linked, liés). Si vous
êtes suffisamment proche (un message « Error:
Nothing indicated » étant retourné par
Blender, dans le cas contraire), le sommet en ques-
tion ainsi que tous les sommets qui lui sont liés par
des arêtes sont automatiquement sélectionnés.
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Séparer un maillage pour former deux objets distincts
Il s’agit bien évidemment de l’opération inverse de la précédente. En
mode Edit, sélectionnez un groupe de sommets par la méthode de votre
choix (sélection directe avec le bouton droit de la souris, boîte de sélec-
tion avec la touche [B], sélection des sommets liés avec la touche [L],
etc.), appuyez sur la touche [P] et choisissez l’option Selected. La sélec-
tion est alors séparée du maillage en cours d’édition. Le nouvel objet
séparé conserve le même centre que l’objet d’origine, et prend un nom
dérivé du précédent (par exemple, OB:Voiture devient OB:Voiture.001).

La fonction Separate admet trois options :
• Selected : sépare la sélection courante de sommets du maillage en

cours d’édition ;
• All Loose Parts : un objet peut être constitué de plusieurs maillages qui

ne sont pas reliés entre eux par des arêtes ou des facettes ; cette option
permet de les séparer automatiquement ;

• By Material : lorsqu’un même objet s’est vu attribué plusieurs maté-
riaux grâce aux indices matériau (voir chapitre 5, Maîtriser les maté-
riaux de Blender), cette fonction permet de créer des maillages
distincts pour chaque indice matériau.

Extrusion
L’opération d’extrusion se réalise en mode Edit, sur une facette unique,
ou sur un groupe de facettes. Elle consiste à générer un volume allongé
pour donner une forme tridimensionnelle à la facette d’origine.

L’opération d’extrusion est commandée par la touche [E] ou par le
menu Mesh>Extrude. Il existe plusieurs modes d’extrusion, comme en
témoigne la boîte de dialogue qui apparaît lorsque l’opération est lancée.
Les options disponibles dépendent de la sélection et du mode de sélec-
tion (Vertex select mode, Edge select mode et Face select mode).

Figure 4–12
Le menu de la fonction Separate, touche [P]

3DS MAX   Modificateurs Extrusion et Tour

Extrusion et Tour ne se présentent pas sous forme
de modificateurs dans Blender, mais sous forme
d’outils de modélisation. Il en résulte que le
maillage, une fois généré par les fonctions
Extrude ou Spin de Blender, ne peut être redéfini
interactivement.

Figure 4–13
À gauche, un simple plan de forme irrégulière, 
et à droite, le volume généré par extrusion du plan
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• Region : il s’agit du mode d’extrusion par défaut. La sélection est
extrudée le long de la normale moyenne du groupe de facettes. Les sur-
faces aux extrémités du volume extrudé sont rigoureusement identiques.

Figure 4–14
La boîte de dialogue de la fonction d’extrusion

ASTUCE   Les outils de sélection basés sur la dureté ou la planéité des arêtes

Deux outils existent pour faciliter la vie des modeleurs lorsqu’ils réa-
lisent des modèles techniques et/ou mécaniques. Ils fonctionnent par
comparaison des angles formés par les arêtes ou les facettes adja-
centes.
Le premier outil (Select Sharp Edges) permet de sélectionner les arêtes
qui forment des angles vifs, l’angle limite pouvant être fixé par l’utilisa-
teur. Il s’utilise en mode de sélection des sommets ou des arêtes, et est
appelé grâce à la combinaison de touches [Ctrl]+[Alt]+[Maj]+[S]. Il
sélectionne automatiquement toutes les arêtes répondant au critère
angulaire ; aucune sélection initiale n’est donc nécessaire. Par exemple,
en mode Edge Select, cet outil appliqué à un cylindre standard, va
retourner l’angle vif formé entre le corps cylindrique et les deux faces
planes.

Figure 4–16
Sélection des arêtes en mode Edge Select

Le second outil (Select Linked Flat Faces) permet de sélectionner
l’ensemble des facettes qui forment des angles très faibles les unes par
rapport aux autres, l’angle limite pouvant également être fixé par l’uti-
lisateur. Il s’utilise uniquement en mode de sélection des facettes, et est
appelé grâce à la combinaison de touches [Ctrl]+[Alt]+[Maj]+[F]. Il
sélectionne automatiquement toutes les arêtes répondant au critère
angulaire, le test étant toutefois réalisé par rapport à une facette de
référence, qui devra donc être sélectionnée au préalable. Par exemple,
en mode Face Select, cet outil appliqué à un cylindre standard, avec
une des facettes constituant l’enveloppe cylindrique sélectionnée, va
retourner le corps du cylindre entier.

Figure 4–17
Sélection des facettes en mode Face Select

Figure 4–15
Exemple d’extrusion d’un

 groupe de facettes en mode Region
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• Individual Faces : chaque face est extrudée selon sa propre normale. Il
en résulte que chaque facette engendre son propre volume extrudé.

• Only Edges : identique au mode Region, à ceci près que le volume
généré n’est pas clos par une facette, mais reste ouvert.

Figure 4–18
Exemple d’extrusion d’un groupe de facettes 
en mode Individual Faces (facettes individuelles)

Figure 4–19
Exemple d’extrusion d’un groupe de facettes 
en mode Only Edges (arêtes seulement)

ASTUCE  Shrink et Fatten

Littéralement, il s’agit des fonctions diminuer et grossir. C’est un mode de transformation
cousin tenant à la fois de l’outil d’extrusion et de celui de redimensionnement. En utilisant la
combinaison de touches [Alt]+[S], vous activez le mode Shrink/Fatten ; la sélection est
alors redimensionnée proportionnellement à sa distance par rapport au centre de l’objet. Si
vous déplacez le curseur de la souris vers le centre, la sélection sera diminuée ; si vous l’éloi-
gnez, elle sera grossie. Le bouton gauche de la souris ou la touche [Entrée] valide l’action,
tandis que le bouton droit ou la touche [Echap] l’annulent.

Figure 4–20 La fonction Shrink (à gauche) et Fatten (à droite) produisent des résultats 
voisins de l’extrusion, mais avec une augmentation ou une diminution de la surface de 
la seconde extrémité

ASTUCE   L’outil pousser/tirer (Push/Pull)

Cet outil fonctionne en mode Edit, sur une sélec-
tion de points de contrôle. En utilisant la combi-
naison de touches [Maj]+[P], vous pouvez forcer
le redimensionnement de la sélection. À la diffé-
rence, toutefois, de la touche [S] qui redimen-
sionne la sélection de façon homothétique, Push/
Pull dilate celle-ci plus que ne la redimensionne,
en déplaçant tous les points de contrôle de la
même distance par rapport au barycentre de la
sélection.
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• Only Vertices : identique au mode Only Edges, à ceci près que seuls les
sommets et les arêtes sont générés, pas les facettes.

Objets de révolution : fonction Spin
La fonction Spin permet de générer un objet de révolution en trois
dimensions par rotation d’un groupe de facettes en deux dimensions.

En mode Edit, dans le menu Editing, touche [F9], un nouveau
panneau Mesh Tools fait son apparition. Il contient de nombreux outils
de modélisation. Avec tous les sommets d’un profil clos sélectionnés,
vous pouvez spécifier l’angle sur lequel sera projeté le profil grâce au
paramètre Degr (par défaut 90° ; pour un objet de révolution complet,
choisissez 360°), et en combien d’étapes (chaque étape représentera un
segment de rotation) grâce au paramètre Steps (par défaut 9 ; augmentez
ce nombre pour améliorer la résolution de l’objet de révolution).

Au moment de cliquer sur le bouton Spin, le curseur de la souris se trans-
formera en une sorte de point d’interrogation. Blender attend en fait que
vous cliquiez dans la vue 3D, définissant ainsi le plan de rotation du
futur objet de révolution. À noter que le centre de rotation sera le cur-

Figure 4–21

Figure 4–23 Au premier plan, un profil qui sert à construire, par rotations successives, 
l’objet de révolution qui se trouve à l’arrière-plan.

BON À SAVOIR  Sommets en double

Lorsque vous commandez une opération Spin sur
360°, le dernier profil créé coïncide avec le profil
d’origine. Lors du rendu ou dans la vue ombrée, un
mauvais ombrage des facettes peut être constaté
en raison de la mauvaise interprétation des nor-
males, en particulier lorsque le modificateur Sub-
surf est actif. La solution consiste à :

1. sélectionner tous les sommets de l’objet de
révolution et supprimer les sommets en double
grâce au bouton Rem Doubles du
panneau Mesh Tools ;

2. recalculer les normales de l’objet, grâce à la
combinaison de touches [Ctrl]+[N].

ASTUCE   Outil de sélection par chemin

Cet outil nécessite d’avoir deux sommets quelcon-
ques sélectionnés au sein d’un même maillage, et
d’être appelé par la touche [W] en choisissant
l’option Path Select. L’outil va alors évaluer
toutes les arêtes partant et arrivant à ces deux
sommets pour déterminer le chemin d’arêtes le
plus court. Deux méthodes d’évaluation sont
proposées : la première calcule la distance phy-
sique la plus courte, la seconde calcule la distance
la plus courte du point de vue topologique. Dans
les deux cas, le chemin calculé se transforme en
sélection.

Figure 4–22 Le panneau Mesh Tools
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seur 3D. Pour créer un objet typique, il vous faudra donc, par exemple,
bâtir votre profil dans la vue de face ou de côté (touches [1] ou [3] du
pavé numérique), positionner le curseur 3D sur l’axe de rotation dans la
vue de dessus (touche [7] du pavé numérique), et après avoir cliqué sur le
bouton Spin, indiquer la vue de dessus.

Profils hélicoïdaux : fonction Screw
Cette fonction est un dérivé de la fonction Spin, car en plus de faire
tourner un profil, elle le translate d’une certaine distance à chaque tour
réalisé. Il s’agit de la fonction idéale pour réaliser un filetage ou un
simple ressort. En mode Edit, dans une vue orthogonale (touches [1], [3]
ou [7]) vous ajouterez :
• un profil : il s’agira de la forme qui tournera autour de l’axe de

révolution ;
• un segment : il a une importance cruciale, et peut ne comporter que

deux points reliés par une arête. Sa longueur (projetée sur l’axe ver-
tical de la vue) définit tout simplement le « pas » de translation du
profil à chaque tour ;

• un centre de rotation : celui-ci est défini par le curseur 3D, comme
précédemment.

Comme précédemment, le bouton numérique Steps indique la résolution
de l’objet de révolution sur un tour. Pour sa part, le bouton
numérique Turns indique le nombre de tour que doit faire le profil tout
en étant translaté selon la direction indiquée par le segment.

Comme pour la fonction Spin, au moment d’activer la fonction Screw, le
pointeur de la souris se transformera en un point d’interrogation pour
demander à l’utilisateur dans quelle vue 3D l’opération doit être réalisée.

ATTENTION   Soyez procédurier !

Pour l’emploi de la fonction Spin, il convient
d’être méthodique et procédurier. Lancez la
commande dans une vue non orthogonale (une
vue autre que [1], [3] ou [7]) peut donner à
votre objet des angles étranges ; de même, une
mauvaise position du curseur 3D peut entraîner
un trou à l’intérieur de votre objet de révolution
(c’est souvent un but recherché) ou, au con-
traire, des faces occupant le même espace (ce
qui ne présentera jamais de bons résultats lors
du rendu ni même dans les vues ombrées).

Figure 4–24
Un profil et un segment définissent 
la forme de révolution et le pas de translation.
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Duplication procédurale d’objets : fonctions DupliVerts et 
DupliFaces
Il s’agit à la fois d’une méthode de modélisation et d’une technique pour
cloner un grand nombre d’objets selon un arrangement particulier. Le
principe est relativement simple : vous spécifiez deux objets et l’un deux
sera dupliqué répétitivement à la surface de l’autre ; un clone pourra être
placé à chaque sommet de l’objet de base (fonction DupliVerts) ou au
centre de chacune de ses facettes (fonction DupliFaces).

La technique de base, en bref

Démarrez une nouvelle session de Blender (combinaison de
touches [Ctrl]+[X] pour réinitialiser à la scène par défaut), et supprimez
le cube central (sélection grâce au bouton droit de la souris, puis

ATTENTION  Surface générée par la rotation du segment

De par sa conception, cette fonction implique que le segment définissant à la fois le pas de
translation et le taux de changement de section de l’objet de révolution est lui aussi transformé
par la fonction. Supprimer cette surface en supprimant un à un les sommets, arêtes ou facettes
pourrait se révéler extrêmement fastidieux sans la touche [L] : désélectionnez dans un premier
temps tout sommet éventuellement sélectionné grâce à la touche [A] ; amenez ensuite le cur-
seur de la souris au-dessus de la surface à supprimer, mais n’utilisez aucun bouton. Appuyez
sur la touche [L] : tous les sommets liés entre eux à proximité immédiate de la souris sont
sélectionnés d’un coup. Vous pouvez maintenant les supprimer grâce à la touche [X].

ASTUCE  Objets à section variable

À noter que le segment peut ne pas être vertical, auquel cas son angle par rapport à la verti-
cale indique le taux d’augmentation ou de diminution de la section de l’objet de révolution à
chaque tour.

Figure 4–25
Un segment non vertical entraînera une variation de la section de l’objet de révolution.

3DS MAX   Objet composé Dispersion

La fonction DupliVerts est à ce jour la plus
proche de l’objet composé Dispersion de
3ds max, avec les limitations suivantes : Dupli-
Verts duplique systématiquement la géométrie de
l’objet source aux sommets de l’objet dit de distri-
bution. Il n’y a pas de possibilité de faire varier les
positions, les échelles ou les rotations de chaque
instance dupliquée, mais de telles possibilités
seront prochainement ajoutées au travers d’un
nouveau modificateur : Array. À noter que la
fonction DupliFaces permet de dimensionner
l’instance en fonction des dimensions de la facette
où elle apparaît.



4 
– 

Te
ch

ni
qu

es
 d

e 
m

od
él

isa
tio

n

© Groupe Eyrolles, 2008 81

touche [X]). Insérez à la place un objet grille ([Espace]>Add>Mesh>Grid)
de résolution X res: 4 et Y res: 4. Éventuellement, redimensionnez-le
(touche [S]) à votre convenance, et quittez le mode Edit (touche [Tab])
pour ne plus ajouter à ce maillage.

Maintenant, ajoutez un objet de type cône ([Espace]>Add>Mesh>Cone)
et choisissez Vertices: 4, pour obtenir une petite pyramide. Redimen-
sionnez-la (touche [S]) de sorte que la pyramide soit de faible dimension
par rapport à l’objet grille. Toujours en mode Edit, avec tous les sommets
de la pyramide sélectionnés, déplacez la pyramide et positionnez-la à la
surface de l’objet grille, au centre de celui-ci. Quittez le mode Edit
(touche [Tab]).

Ensuite, sélectionnez la pyramide (bouton droit de la souris), et ajoutez la
grille à la sélection (touche [Maj] pressée, utilisez à nouveau le bouton
droit). Établissez un lien de parenté entre les deux objets grâce à la com-
binaison de touches [Ctrl]+[P].

Maintenant, sélectionnez seulement la grille (bouton droit) et rendez-
vous dans le panneau Anim settings du menu Object, touche [F7]. Activez
l’option DupliVerts pour dupliquer la pyramide sur la surface de la grille.
Si vous effectuez un rendu, vous constaterez que tant l’objet de base que
l’objet d’origine à dupliquer n’apparaîtront pas sur l’image finale, bien
qu’ils demeurent présents dans la vue 3D.

Figure 4–26
La pyramide centrale devra être dupliquée 
à tous les sommets de la grille plane.

Figure 4–27
Le panneau Anim Settings

BON À SAVOIR   Ce qu’il faut savoir pour 
maîtriser les DupliVerts

Pour garantir un bon contrôle de l’orientation des
duplicatas à la surface de l’objet servant de base, il
convient de s’assurer que leurs systèmes d’axes
locaux (qu’il est possible d’afficher, individuellement,
grâce au bouton Axis du panneau Draw, Object
buttons, menu Object [F7]) sont orientés de la
même façon. La méthode la plus simple et la plus
rapide d’y parvenir consiste à utiliser la combinaison
de touches [Ctrl]+[A] pour appliquer l’échelle et la
rotation à l’objet.
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Option Rot des objets dupliqués

Vous pouvez tout aussi bien utiliser les objets dupliqués sur un objet sphé-
rique ou même plus complexe. Toutefois, la pyramide sera placée en l’état,
toujours verticale, conduisant à un effet visuel peut-être disgracieux.

Il est toutefois possible d’activer l’option Rot qui permet de réorienter
l’axe vertical de l’objet pour suivre la normale des facettes adjacentes au
sommet de duplication. Le résultat paraîtra ou non satisfaisant, en fonc-
tion de la forme de l’objet dupliqué, mais dans le cas d’une pyramide
avec un axe prépondérant, ce n’est certainement pas le cas.

Figure 4–28
Les pyramides ont été dupliquées

à chaque sommet de la grille, mais le modèle
d’origine ainsi que l’objet servant de base
n’apparaissent pas au rendu sur fond noir.

Figure 4–29
Duplication de pyramides sur une sphère

Figure 4–30
L’option Rot appliquée à la duplication

de pyramides sur une sphère
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Heureusement, il est possible de déterminer la direction d’orientation de
chaque axe. Par exemple, dans le panneau Anim settings, avec l’objet à
dupliquer sélectionné, activez les boutons TrackZ et UpZ pour obtenir
une jolie masse d’armes.

Vous pouvez modifier l’orientation de l’instance dupliquée, qui est nor-
malement alignée à la normale de l’objet de base au sommet concerné.
Souvent, expérimenter rapidement les différentes possibilités est plus
rapide que d’essayer de comprendre quel axe de l’instance doit être aligné
sur la normale à la surface de base au sommet considéré. Mais dans notre
cas, avec Track-X orienté sur Up Z, on se retrouve avec une masse d’armes
dont les piques sont... dirigées vers l’intérieur !

La fonction DupliFaces

Son fonctionnement est très similaire à celui de DupliVerts, la principale
différence étant qu’au lieu d’être placées à chaque sommet, les instances
apparaissent au centre de chaque facette de l’objet servant de base.
L’option Scale permet alors de dimensionner l’instance pour qu’elle
occupe au mieux la facette, s’ajustant à ses dimensions. Vous pouvez bien
sûr contrôler cette mise à l’échelle en redimensionnant manuellement
l’objet d’origine jusqu’à obtenir les proportions souhaitées.

Figure 4–31
L’orientation des pyramides dupliquées 
a été révisée grâce aux boutons TrackXYZ 
et UpXYZ du panneau Anim Settings.

Figure 4–32
La densité de l’objet de base a été un 
peu révisée à la baisse pour mieux 
montrer les pyramides orientées 
vers le cœur de la sphère grâce 
au bouton Track-Z.

ASTUCE   Transformer les clones 
en vrais objets

Si vous modifiez la forme de l’objet servant de
base, en particulier en déplaçant, ajoutant ou sup-
primant des facettes ou des sommets, les clones
seront redistribués en conséquence. De même, si
vous éditez la forme de l’objet d’origine, les modi-
fications seront répercutées sur tous les clones.
Vous pouvez soit conserver cette duplication pro-
cédurale, soit la rendre effective en transformant
chaque clone individuel en un objet à part entière.
Pour cela, vous sélectionnerez l’objet servant de
base à la distribution des clones et utiliserez la
combinaison de touches [Maj]+[Ctrl]+[A] pour
les rendre « réels ».
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Déformation procédurale de maillages : fonction Noise
Cette fonction permet de récupérer des informations stockées dans une
texture pour déformer, en proportions, un maillage existant. Une texture
en dégradés de gris est nécessaire ; les pixels noirs ou sombres indiquent
l’absence de déformation, ou un faible niveau ; les pixels blancs ou clairs
indiquent une déformation maximale, ou très élevée.

Cette fonctionnalité est souvent utilisée pour la création rapide de terrains
pour des scènes d’extérieur. Par exemple, l’image suivante, ch04-noise-
texture.png, présente sur le DVD-Rom dans le répertoire /exercices,

peut être utilisée pour obtenir le paysage suivant :

Figure 4–33
Les instances de sphères apparaissent

au centre des facettes de la grille ; avec
l’option Scale, elles sont automatiquement

redimensionnées proportionnellement
aux dimensions de chaque facette.

BON À SAVOIR   
Application de la fonction Noise

Celle-ci ne fonctionne que dans la direction Z. Si
vous avez besoin de déplacer la géométrie dans
les autres directions (voire toutes à la fois), pré-
férez l’usage du canal de texture Disp : la géomé-
trie réelle de l’objet ne sera pas déplacée, mais elle
le sera au moment du rendu.

Figure 4–34
Exemple de texture en dégradés de gris...

Figure 4–35
... et le paysage résultant obtenu !
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Pour obtenir un résultat identique, démarrez une nouvelle session (combi-
naison de touches [Ctrl]+[X]), sélectionnez (bouton droit de la souris) et
supprimez (touche [X]) le cube par défaut. À la place, insérez un plan
([Espace]>Add>Mesh>Plane) que vous diviserez plusieurs fois (en
mode Edit, avec tous les sommets sélectionnés, touche [W], choisissez Sub-
divide Multi et choisissez une valeur de 20, ou bien utilisez une grille de
résolution ResX:20 et ResY:20). Quittez le mode Edit et affichez les Mate-
rial buttons du menu Shading, touche [F5]. Cliquez sur Add New dans le
panneau Material pour ajouter un nouveau matériau, mais vous n’avez
besoin de modifier aucun paramètre pour utiliser la fonction Noise. Allez
ensuite dans les Texture buttons (touche [F5] pour faire défiler les diffé-
rentes collections de boutons), et cliquez sur le bouton Add New du
panneau Texture. Choisissez Image en guise de Texture Type puis, en cli-
quant sur le bouton Load Image du panneau Image, sélectionnez la texture
ch04-noise-texture.png présente sur le DVD-Rom. Passez ensuite dans
le menu Editing (touche [F9]) et en mode Edit (touche [Tab]). Repérez le
panneau Mesh Tools, et surtout le bouton Noise. Dans une vue 3D, faites
tourner la vue (touches [2], [4], [6] ou [8] du pavé numérique) ou passez en
vue de caméra (touche [0] du pavé numérique), en prenant soin d’activer la
vue ombrée (touche [Z]). Cliquez ensuite plusieurs fois sur le
bouton Noise, et observez comme le maillage se déforme, pour que les pics
et les vallées correspondent au plus près aux informations en noir et blanc
données par la texture. Quittez le mode Edit (touche [Tab]) et redimen-
sionnez votre décor (touche [S]).

Outil d’édition proportionnelle : PET
L’outil d’édition proportionnelle vous permet de modifier harmonieuse-
ment un maillage en ne déplaçant qu’un seul sommet à la fois ; le sommet
déplacé agira comme un aimant, et attirera dans son déplacement les som-
mets voisins, la force d’attraction diminuant avec la distance.

L’outil d’édition proportionnelle (Proportional Editing Tool, ou PET) ne
s’active qu’en mode Edit, soit grâce à la touche [O], soit en passant par le
menu de la vue 3D, Mesh>Proportional Editing, soit encore en utilisant
l’icône appropriée de l’en-tête de la vue 3D. La taille de la zone affectée
est visible en mode Edit, au cours d’une transformation (déplacement
[G], rotation [R] ou mise à l’échelle [S], par exemple), et est matérialisée
par un cercle en pointillés ; augmenter le rayon d’effet revient à aug-
menter la « force d’attraction » du sommet (ou du groupe de sommets)
déplacé(s). Les touches [PageSup] et [PageInf ] du clavier permettent res-
pectivement d’augmenter ou de diminuer le rayon d’effet. De même,
vous pouvez utiliser la molette de votre souris (si elle en est équipée) pour

ATTENTION   Taille de la texture

Votre texture a une dimension égale à une unité
de Blender de côté. Si vous redimensionnez
votre décor avant d’appliquer la fonction Noise,
prenez garde à le faire en dehors du mode Edit.
Si vous êtes encore en mode Edit et que vous
redimensionnez les sommets, arêtes et facettes,
la texture ne changera pas de taille, mais aura
probablement été répétée autant de fois que
nécessaire dans les deux directions de l’objet. Il
en résulte que les reliefs transmis par la texture
se répèteront très visiblement, et que la profon-
deur des sommets et des vallées du décor sera
amoindrie.

BON À SAVOIR   Mode Connected de l’outil 
d’édition proportionnelle

Outre l’activation (On) ou la désactivation (Off)
de l’outil, il existe un mode Connected. Grâce à
lui, l’effet proportionnel n’agit que sur les som-
mets liés, par une chaîne quelconque d’arêtes, au
sommet déplacé. En bref, lors de son déplacement,
un sommet ne peut entraîner avec lui que les som-
mets qui lui sont associés lors de l’usage, par
exemple, de la sélection au moyen de la
touche [L].

Figure 4–36 Activation de l’outil d’édition 
proportionnelle par l’en-tête de la vue
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modifier le rayon d’effet, ou les combinaisons de touches [Alt]+[+] ou
[Alt]+[-] du pavé numérique.

Vous noterez que la force d’attraction est décroissante à mesure que le
point affecté est éloigné du sommet (ou du groupe de sommets)
déplacé(s). Par défaut, la décroissance est linéaire, mais il y a divers
modes d’atténuation (Falloff).

Sur les illustrations qui suivent, le sommet central d’une grille est
déplacé grâce à la touche [G] ; le mode d’atténuation est alors aisément
mis en évidence. Les différents modes disponibles rendent cet outil par-
ticulièrement approprié à la modélisation de paysages.
• Constant : il n’y a en fait aucune atténuation ; tous les sommets dans

la zone d’effet subissent la même transformation. Idéal pour la créa-
tion de plateaux cylindriques.

• Random : l’atténuation dans la zone d’effet est totalement aléatoire.
Idéal pour la création de surfaces irrégulières.

• Linear : l’atténuation de la transformation est proportionnelle à la dis-
tance. Idéal pour la création de surfaces régulières.

Figure 4–37
Les différents modes d’atténuation de l’effet

3DS MAX   Sélection douce

Le PET est à Blender ce que la Sélection douce est
à 3ds max, à ceci près que la Sélection douce
permet un réglage fin de l’atténuation. Il manque
toutefois à l’outil de 3ds max les différents modes
d’atténuation prédéfinis du PET de Blender.

Figure 4–38
Atténuation constante (Constant)

Figure 4–39
Atténuation aléatoire (Random)

Figure 4–40
Atténuation linéaire (Linear)
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• Sharp : l’atténuation de la transformation est particulièrement rapide,
les sommets lointains n’étant pratiquement pas affectés. Idéal pour la
création de reliefs accidentés.

• Root : l’atténuation de l’effet est particulièrement lente, suivant une
loi quadratique (root, racine), permettant d’affecter significativement
même les sommets en limite de la zone d’effet. Idéal pour la création
de collines.

• Sphere : l’atténuation agit comme précédemment, mais suivant une
loi cubique.

• Smooth : l’atténuation est un peu plus amortie que pour le
mode Linear, mais plus abrupte que pour le mode Root. Idéal pour la
création de vallées.

Outil d’accrochage (Transform Snap)
Lorsque l’outil d’accrochage est actif, les transformations (déplacement
[G] et rotation [R], mais aussi certaines fonctions comme l’extrusion [E])
appliquées à la sélection peuvent être contraintes de diverses façons. Ce
mode s’active en mode Edit, soit grâce à l’icône appropriée dans l’en-tête
de la vue 3D, soit grâce à la combinaison de touches [Maj]+[Tab].

Cet outil fonctionne lorsque vous maintenez enfoncée la touche [Ctrl] ; dans
ce cas, lorsque vous déplacez votre sélection en direction d’un sommet quel-

Figure 4–41
Atténuation brutale (Sharp)

Figure 4–42
Atténuation amortie (Root)

Figure 4–43
Atténuation sphérique (Sphere)

Figure 4–44
Atténuation douce (Smooth)

Figure 4–45 Les différents 
mode d’accrochage du mode Snap

ASTUCE   Accrochage des sommets 
sur un objet tiers!

Grâce à cet outil, Blender permet non seulement
d’accrocher un sommet à un autre sommet du
maillage en cours d’édition, mais également de
l’accrocher aux sommets de n’importe quel autre
objet. Il vous suffit de sélectionner les deux objets
en question, le maillage à éditer étant la sélection
active (rose plus clair). Entrez en mode Edit[Tab]
et saisissez un sommet. Avec la touche [Ctrl]
pressée, déplacez-le [G] vers l’autre objet (qui est
toujours en mode Object) : Blender vous propose
alors d’accrocher la sélection au sommet le plus
proche du pointeur de la souris en indiquant celui-
ci grâce à un petit cercle blanc !
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conque du modèle en cours d’édition, celui-ci est encerclé de blanc dès que
le curseur de la souris est suffisamment près du sommet visé. La sélection
s’accroche alors à ce sommet, suivant le mode sélectionné. Si la position vous
convient, vous pouvez alors la valider avec la touche [Entrée] ou grâce au
bouton gauche de la souris (le bouton droit annule la manipulation).

Cette fonction est donc très utile lors d’opérations de modélisation
nécessitant un placement précis de sommets les uns par rapport aux
autres, comme lors de la modélisation d’éléments mécaniques ou archi-
tecturaux. Elle est toutefois tout autant utile lorsque vous avez modélisé
séparément différents éléments organiques (une main, une oreille, etc.)
et que vous cherchez à les attacher précisément (au bras, à la tête, etc.).

Le mode Transform Snap admet quatre modes de fonctionnement :
• Closest : dans ce mode, la sélection sera accrochée au sommet de des-

tination par son sommet le plus proche de celui-ci, en fonction du
mouvement de transformation effectué (fonctionne avec [G] et [R]) ;

• Active : comme précédemment, mis à part que la sélection sera accro-
chée au sommet de destination par son sommet actif (c’est-à-dire le
dernier sélectionné, dans le cas d’une sélection multiple de sommets) ;

• Median : dans ce mode, la sélection sera accrochée au sommet de destina-
tion par son barycentre (centre géométrique) (fonctionne avec [G] et [R]) ;

• Center : ce mode semble fonctionner de la même façon que le
mode Median, mais la différence est très subtile, car le type de point

Figure 4–46
Avec le mode Closest, la sélection

est accrochée au sommet de destination
par le sommet le plus proche au cours

de la transformation.

Figure 4–47
Avec le mode Median, la sélection

est accrochée au sommet de destination
par son centre géométrique.
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pivot a son importance. Positionnez le curseur 3D à un endroit particu-
lier par rapport à la sélection ; dans l’en-tête de la vue 3D, choisissez le
mode d’accrochage Center ; choisissez également 3D Cursor comme
pivot de transformation ; la sélection sera accrochée au sommet de des-
tination relativement à la position initiale du curseur 3D. Si, en plus,
vous positionnez le curseur 3D sur un sommet particulier (combi-
naison de touches [Maj]+[S]), la sélection sera déplacée de manière à
faire coïncider ce sommet avec le sommet de destination, pratiquement
comme dans le mode Closest (fonctionne avec [G] seulement).

Il est également possible d’utiliser les contraintes de transformation (par
exemple, touche [G] pour initier un déplacement, puis touche [X] pour
contraindre celui-ci dans la direction X seulement) pour limiter l’accro-
chage dans une direction particulière.

Outils de modélisation avancés
Les outils qui vont être présentés ici permettent d’effectuer des manipu-
lations intéressantes au niveau des arêtes, des sommets ou des facettes.
Elles sont surtout réservées aux utilisateurs confirmés de Blender, ainsi
qu’à tous ceux qui se sentent suffisamment motivés pour se lancer dans
de véritables travaux de modélisation.

Bases de la modélisation polygonale : ajouter des sommets
Cette opération est parfaitement à la portée d’un utilisateur débutant,
mais a été glissée dans les outils de modélisation avancés pour des rai-
sons de consistance.

Si vous souhaitez créer un nouveau maillage de toutes pièces, sélec-
tionnez le cube par défaut de la scène, et passez en mode Edit
(touche [Tab]). Sélectionnez tous les points de contrôle (touche [A]) et
effacez-les (touche [X]). Votre objet est vierge de tout maillage, mais
existe toujours. En maintenant la touche [Ctrl] pressée, créez un premier
point avec le bouton gauche de la souris. Si vous cliquez à nouveau

Figure 4–48
Avec le mode Closest et 3D Cursor comme 
point pivot de transformation, il devient 
possible d’accrocher la sélection par un point 
arbitraire et immatériel ne correspondant 
ni à un sommet, ni au centre géométrique.

BLENDER   Support des Ngons

Il s’agit d’une fonctionnalité que Blender ne pré-
sente pas, au contraire d’autres logiciels commer-
ciaux. Parce que cela est considéré comme une
limitation majeure par certains utilisateurs, les
Fgons (fake gons) ont été implémentés, pour la
compenser un tant soit peu. Il est également ques-
tion de les inclure véritablement dans une pro-
chaine version.
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ailleurs avec le bouton gauche, toujours en maintenant la touche [Ctrl]
pressée, vous ajoutez un second point, relié au précédent par une arête.

Bases de la modélisation polygonale : fonction Fill
Cette fonction est particulièrement versatile, et a plusieurs usages.

Si vous avez dessiné un profil ouvert à l’aide de sommets reliés entre eux
par des arêtes, vous pouvez sélectionner le premier et le dernier sommet,
et utiliser cette fonction (touche [F]) pour fermer le profil en ajoutant
l’arête manquante.

Vous pouvez également sélectionner trois sommets quelconques, et uti-
liser cette fonction (touche [F], à nouveau), pour créer une facette trian-
gulaire à partir des trois sommets. Cela fonctionne aussi pour la création
de facettes quadrangulaires à partir de quatre sommets.

Enfin, dernière possibilité intéressante de cette fonction : si vous avez
constitué un réseau d’arêtes, plutôt que de les fermer individuellement
par des facettes, sélectionnez-les toutes, et la touche [F] (option Auto)
constituera automatiquement toutes les facettes triangulaires ou qua-
drangulaires qu’il lui sera possible.

Figure 4–49
Exemple de modélisation polygonale,

© 2005 Adrien Lourdelle,
http://adrien.3dvf.com

Figure 4–50
Le menu Make Faces 
accessible par la touche [F]

ASTUCE   Création de Fgons

Certains utilisateurs ayant réclamé à corps et à cris
le support des Ngons (polygones à n côtés) dans
Blender, et la communauté étant fortement divisée
sur l’intérêt du sujet, les développeurs ont ajouté
la possibilité de sélectionner plusieurs facettes et
de créer un « faux Ngon » en appuyant sur la
touche [F]. Il s’agit bien sûr d’un faux polygone,
dans le sens où Blender ne sait véritablement
gérer que des quadrangles ou des triangles, et que
les arêtes internes au Fgon sont simplement mas-
quées. Certains utilisateurs trouvent cette fonc-
tionnalité absolument indispensable pour la
production de maillages de toute beauté, tandis
que les autres trouvent cet ajout cosmétique pure-
ment inutile.

ASTUCE  Skin Faces/Edge-Loops

Cette fonction permet de créer la géométrie man-
quante à la jonction entre deux boucles (que ce
soient des boucles de faces ou des boucles
d’arêtes). Idéalement, les deux boucles doivent
avoir le même nombre de sommets pour l’établis-
sement de la jonction, mais cela n’est pas obliga-
toire, l’outil étant suffisamment souple pour
s’accommoder d’écarts importants : des menus
supplémentaires apparaissent alors pour vous
demander comment gérer la fonction.



4 
– 

Te
ch

ni
qu

es
 d

e 
m

od
él

isa
tio

n

© Groupe Eyrolles, 2008 91

Bases de la modélisation polygonale : le menu spécial
Ce menu est accessible en mode Edit lorsque vous appuyez sur la
touche [W]. Il offre alors plusieurs options qui peuvent interagir avec vos
maillages, certaines étant accessibles par ailleurs (dans les panneaux de
certains menus, ou dans les en-têtes de certaines vues), et ayant été
regroupées dans ce menu par souci de convivialité. Les principales
options sont décrites ci-dessous.
• Subdivide : toutes les arêtes sélectionnées sont subdivisées en leur

centre.

• Subdivide Multi : toutes les arêtes sélectionnées sont subdivisées un
certain nombre de fois ; une fenêtre apparaît alors pour demander à
l’utilisateur le nombre de coupes (Number of Cuts) souhaitées. Par
exemple, deux coupes partageront une arête en trois segments.

• Subdivide Multi Fractal : identique à Subdivide Multi, sauf qu’une
fenêtre supplémentaire apparaît pour demander le pourcentage de
perturbation fractale ; en effet, le maillage ainsi produit sera déplacé
aléatoirement, sommet par sommet, dans une direction ou l’autre, ce
qui est idéal pour la génération de terrains irréguliers.

Figure 4–51
À droite, le cube 
après une simple subdivision

Figure 4–52
À droite, le cube après 
une subdivision à 4 coupes

Figure 4–53
À droite, le cube après subdivision à 4 coupes 
et déplacement fractal des sommets
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• Subdivide Smooth : identique à Subdivide Multi, sauf qu’une fenêtre
supplémentaire apparaît pour demander le taux de lissage du maillage
obtenu ; le lissage du maillage obtenu aura pour effet d’atténuer ses
creux et reliefs.

• Merge : cette fonction fusionne en un seul sommet tous les sommets
sélectionnés ; une fenêtre apparaît pour demander à l’utilisateur si la
fusion doit avoir lieu au centre théorique de la sélection (At Center) ou
sur la position du curseur 3D (At Cursor).

• Remove Doubles : cette fonction recherche dans la sélection de som-
mets tous ceux qui sont à une distance inférieure ou égale à 0.001
unités de Blender l’un de l’autre (cette valeur peut être réglée, en
mode Edit, dans le panneau Mesh Tools, menu Editing, touche [F9],
grâce au bouton numérique Limit), et supprime les sommets répon-
dant à ce critère. Ce traitement est souvent nécessaire après une opé-
ration d’extrusion ou de duplication avortée involontairement par
l’utilisateur ; les sommets excédentaires se manifestent souvent, dans
la vue 3D (mode ombré, touche [Z]) ou au cours du rendu, par des
artefacts dans le lissage des surfaces.

• Hide et Reveal : ces deux options permettent respectivement de mas-
quer la sélection, ou au contraire de la rendre à nouveau visible ; cette
opération est souvent utile lorsque l’utilisateur travaille sur un
maillage complexe, et qu’il veut n’afficher que la zone qui l’intéresse.
À noter que certains outils, comme l’outil d’édition proportionnelle,
n’ont aucune influence sur les facettes masquées. Les combinaisons
de touches [H] et [Alt]+[H] activent ces deux fonctions en mode Edit,
que l’on retrouve également dans le panneau Mesh Tools 1 du
menu Editing, touche [F9].

• Select Swap : permet d’inverser la sélection du maillage en cours.

Figure 4–54
À droite, le cube après subdivision simple

et adoucissement des angles

Figure 4–55
Les trois sommets du côté au premier plan ont

été fusionnés en un seul sommet central.
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• Flip Normals : les normales d’un maillage pointent en principe toutes
vers l’extérieur ou vers l’intérieur de celui-ci. Dans certains cas
(radiosité, par exemple), vous souhaiterez pouvoir inverser la direc-
tion des normales ; ce bouton vous le permet.

• Smooth : cette fonction permet de lisser la sélection de votre
maillage ; ses creux et ses bosses vont s’atténuer, et le maillage sem-
blera légèrement diminuer de volume. Par exemple, si vous partez
d’un cube subdivisé plusieurs fois, en appliquant cette fonction à plu-
sieurs reprises, vous allez obtenir un objet aux bords très arrondis.

• Bevel : cette fonction permet d’ajouter un chanfrein aux arêtes sélec-
tionnées de votre maillage (un script Python, Bevel Center, permet de
spécifier un rayon de congé, à la place d’un simple chanfrein) ; de
façon interactive, en déplaçant la souris (bouton gauche ou
touche [Entrée] pour valider, bouton droit ou touche [Echap] pour
annuler), vous spécifiez la largeur du chanfrein. Avant de valider,
vous pouvez également utiliser le bouton central pour basculer du
mode normal (chanfrein appliqué aux arêtes sélectionnées) au mode
sommets (chanfrein appliqué aux sommets).

• Set Smooth et Set Solid : vos maillages sont constitués de facettes ; lors
du rendu, les facettes seront clairement apparentes. En sélectionnant
un groupes de facettes (ou la totalité d’entre elles) et en utilisant la
fonction Set Smooth, le rendu donnera l’illusion que la surface de
l’objet est parfaitement progressive, au lieu d’être constituée de
facettes. Au contraire, Set Solid préserve l’aspect à facettes de l’objet.

Figure 4–56
À droite, le cube après plusieurs 
applications de la fonction Smooth

Figure 4–57
Sur un simple cube (à gauche), la fonction 
Bevel appliquée aux arêtes (au centre) 
ou aux sommets (à droite)

Figure 4–58
La moitié supérieure du cylindre est en 
Set Smooth, l’autre moitié en Set Solid.
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Travailler avec les boucles
Les boucles sont soit une suite continue d’arêtes qui démarrent et termi-
nent sur le même sommet, soit une suite continue de facettes qui démar-
rent et terminent sur la même arête. Dans le premier cas, il s’agit d’une
boucle d’arêtes, dans le second, d’une boucle de facettes.

Outil de transformation de sélection de boucle en région

Lorsqu’une boucle d’arêtes, ou une succession d’arêtes, est sélectionnée, délimitant une
région finie, l’option Loop to Region du menu Edge Specials, combinaison de
touches [Ctrl]+[E] (en mode Edit) permet d’afficher la sélection de toutes les facettes com-
prises à l’intérieur de ces frontières virtuelles.

Figure 4–59

Vous pouvez créer des frontières complexes grâce aux sélections multiples (touche [Maj]) de
boucles ou d’arêtes. Si vous définissez une sous-région enclose dans une plus grande région, les
facettes de la sous-région seront soustraites aux facettes de la grande région lors de l’usage de
l’outil Loop to Region. Vous pouvez ainsi multiplier à loisir les frontières, créant autant de
régions et de sous-régions que souhaité, ainsi qu’en témoignent les illustrations suivantes.

Figure 4–60

À noter l’existence de l’outil Region to Loop, qui fait exactement l’inverse de l’outil Loop to
Region : il transforme en boucles des groupes de facettes sélectionnées, n’en retenant que les
arêtes constituant la frontière de la région.

3DS MAX   Transformation de sélection

Dans 3ds max, la sélection en cours dans l’un des
modes (sommet, arête, facette...) n’affecte pas la
sélection dans les autres modes de sélection.
Il est donc nécessaire de passer par le menu con-
textuel (bouton droit) puis de sélectionner con-
vert to face, convert to vertex ou convert to
edge.
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Sélection de boucles d’arêtes ou de facettes

Il est possible de sélectionner une boucle d’arêtes en utilisant la combi-
naison de touches [Alt]+bouton droit de la souris sur une arête particu-
lière. De même, la sélection d’une boucle de facettes s’effectue en
utilisant la combinaison de touches [Ctrl]+[Alt]+ bouton droit de la souris.

Comme avec toute sélection dans Blender, il est possible d’ajouter à la
sélection d’autres boucles (d’arêtes ou de facettes) en maintenant pressée
la touche [Maj].

Couper une boucle de facettes

Il s’agit d’une fonction très intéressante, qui permet d’ajouter une boucle
d’arêtes au sein d’une boucle de facettes, ce qui revient à séparer en deux
(ou plus) la boucle de facettes. L’insertion de nouvelles boucles est une
technique communément utilisée en phase de modélisation pour ajouter
des détails en un endroit précis, principalement lors de la modélisation
d’objets organiques.

Pour couper une boucle de facettes, vous passerez par l’une des deux
méthodes suivantes :
• touche [K] pour appeler le menu Loop/Cut ;
• combinaison de touches [Ctrl]+[R] pour lancer directement l’outil

Loop Cut.

Dans les deux cas, une boucle d’arêtes couleur magenta apparaît pour
indiquer la boucle de facettes qui sera coupée ; vous pouvez alors sélec-
tionner une boucle d’arêtes à un endroit ou l’autre de votre modèle, plus
exactement en positionnant le curseur de votre souris sur une arête à
séparer, en validant la boucle de facettes choisies avec le bouton gauche
de la souris ou la touche [Entrée] (vous pouvez annuler l’action grâce au
bouton droit ou la touche [Echap]).

Après validation, Blender se place en mode interactif, vous autorisant à
positionner précisément la boucle d’arêtes ; ainsi, vous n’êtes pas obligé
de séparer une boucle de facettes en son milieu, mais à l’endroit de votre
choix, le long d’une arête transversale (en vert) à la future boucle.

Figure 4–61
À gauche, sélection d’une boucle d’arêtes, 
et à droite, sélection d’une boucle de facettes

ASTUCE   Insérer de multiples boucles

À noter que vous pouvez utiliser la molette de
votre souris ou directement saisir au clavier le
nombre de boucles d’arêtes que vous souhaitez
insérer.

ASTUCE   Supprimer une boucle d’arêtes

Il vous est possible de supprimer une boucle
d’arêtes, à condition qu’elle soit elle-même enca-
drée par deux boucles d’arêtes. Pour cela, sélec-
tionnez la boucle d’arêtes à supprimer grâce à la
combinaison de touches [Alt]+bouton droit et
appuyez sur la touche [X] ou la touche [Suppr]
pour appeler le menu Erase : choisissez alors
Edge Loop dans la liste.
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Pendant cette phase interactive, vous pouvez positionner à la souris la
nouvelle boucle d’arêtes. En bas à gauche de la vue 3D, vous pouvez
visualiser la position de la future boucle par rapport à l’arête de
référence : 0 correspond au milieu de l’arête, -1 à une extrémité, et +1 à
l’autre. En maintenant la touche [Ctrl] pressée, l’arête se positionnera
selon un pas grossier ; pour un placement plus fin, pressez la
touche [Maj].

Opérations spéciales sur les arêtes

Outils couteau (Knife)

L’outil couteau est un autre moyen d’ajouter des détails à un modèle. Il
ne fonctionne toutefois que sur un ensemble de facettes sélectionnées.
En appuyant sur la touche [K], un menu flottant apparaît vous deman-
dant quel type de coupure réaliser. Le curseur de la souris se change alors
en un petit couteau.

Figure 4–62
La ligne magenta indique

la boucle d’arêtes à diviser.

Figure 4–63
La boucle jaune positionne la future boucle

par rapport à l’arête verte.

Figure 4–64
La barre d’en-tête renseigne l’utilisateur 

sur la position de la coupe.

Figure 4–65
Le menu Loop/Cut



4 
– 

Te
ch

ni
qu

es
 d

e 
m

od
él

isa
tio

n

© Groupe Eyrolles, 2008 97

• Knife (Exact) : le couteau est utilisé pour insérer des sommets aux
endroits exacts où sa trajectoire coupe une arête sélectionnée ; seule la
première intersection est prise en compte.

• Knife (Midpoints) : le couteau est utilisé pour insérer des sommets au
milieu des arêtes traversées.

• Knife (Multicut) : le couteau est utilisé pour insérer le nombre de som-
mets déterminés au milieu des arêtes traversées (une boîte de dia-
logue flottante apparaît pour déterminer le nombre de coupures).

Bien sûr, l’outil couteau peut traverser un nombre indéfini d’arêtes dis-
tinctes, mais un seul comportement (Exact, Midpoint, Multicut) est retenu
pour chacune de ces arêtes.

Rotation d’arêtes

Vous pouvez faire tourner une arête sur elle-même, soit dans le sens des
aiguilles d’une montre (CW), soit dans le sens inverse (CCW), sans
modifier la géométrie générale de votre modèle. Normalement, si vous
faites tourner une arête, elle conserve sa longueur, et donc, modifie la
forme de votre modèle. Dans ce cas particulier, la forme extérieure du

Figure 4–66

ASTUCE   Couper à travers un sommet

Si vous appuyez sur la touche [Ctrl] pendant que
vous dessinez la ligne de coupure, le couteau
devient aimanté et son tracé passe automatique-
ment par la position exacte du sommet le plus
proche. Lorsque la touche n’est pas pressée,
l’outil Knife conserve son comportement habituel.

Figure 4–67
Respectivement, la trajectoire du couteau, 
puis les résultats en mode Exact, 
Midpoint et Multicut
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modèle ne change pas ; c’est la longueur de l’arête qui se modifie en
fonction de son angle de rotation.

Pour accéder à cette fonction, sélectionnez l’arête à faire tourner et uti-
lisez la combinaison de touches [Ctrl]+[E] pour afficher le menu spécial
des arêtes. Choisissez ensuite Rotate Edge CW ou Rotate Edge CCW. Vous
validerez la nouvelle position de l’arête grâce au bouton gauche de la
souris (ou à la touche [Entrée]).

Glissement d’arêtes

Dans le même ordre d’idée que la rotation d’arêtes, il va s’agir de faire
glisser la position de l’arête sans modifier la forme extérieure du modèle :
c’est la longueur des arêtes liées à celle en cours d’édition qui variera
pour préserver la forme extérieure du modèle.

Pour accéder à cette fonction, sélectionnez l’arête à faire glisser et utilisez
la combinaison de touches [Ctrl]+[E] pour afficher le menu spécial des
arêtes. Choisissez ensuite Edge Slide pour faire glisser l’arête sélectionnée
le long de l’arête verte de référence. Vous validerez la nouvelle position
de l’arête grâce au bouton gauche de la souris (ou à la touche [Entrée]).

Figure 4–68
Le menu Edge Specials

BON À SAVOIR   Les arêtes attenantes

Blender ajoute autant de sommets, d’arêtes et de
faces que nécessaire pour préserver la géométrie
existante, avant l’usage de la fonction Rotate
Edge. Par exemple, sur la figure 4–69, nous
voyons clairement, en comparant le cube d’origine
à gauche et le cube après une opération de rota-
tion CCW à droite, que l’arête a pivoté, mais que
les arêtes horizontales anciennement contiguës à
celle-ci n’ont pas bougé.

Figure 4–69
À gauche, le modèle original, au centre,

rotation de l’arête dans le sens CW , et enfin,
à droite, rotation de l’arête dans le sens CCW

Figure 4–70
À gauche, le modèle original, au centre,

avec l’arête en cours de glissement,
et à droite, l’arête après glissement
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Déchirer un maillage

Il est possible de déchirer un maillage très simplement. En mode Edit,
sélectionnez un sommet, et appuyez sur la touche [V]. Vous êtes désor-
mais dans un mode interactif, et le sommet sélectionné est déplacé à la
souris (validation de la position grâce au bouton gauche ou à la
touche [Entrée]), laissant un trou dans le maillage.

Vous pouvez également sélectionner un ou plusieurs sommets contigus à
la fois, et même des arêtes contiguës.

Les espaces ainsi créés peuvent servir d’ouverture (manches, bouches,
paupières) ou être par la suite remplis grâce à de nouvelles facettes pour
former des rides ou des plis.

Maillages multirésolution
Les maillages multirésolution permettent de stocker différents niveaux
de subdivision, tout en garantissant que chaque niveau soit éditable, et
que les modifications apportées à un niveau soient communiquées aussi
bien aux niveaux inférieurs que supérieurs de résolution. Quelques avan-
tages parmi les plus évidents :
• possibilité de travailler (mise en place d’armatures, mise au point

d’animations, etc.) sur un modèle de faible résolution dans la vue 3D
sans ralentissement excessif et d’effectuer des rendus avec des
maillages de haute (voire très haute) résolution avec tous les détails
qui y ont été intégrés ;

• correction aisée de la forme générale d’un maillage sur une version
basse résolution par action sur quelques sommets seulement, plutôt que
par modifications laborieuses (à coups d’outils de sélection et d’outils
d’édition proportionnelle) sur des quantités massives de sommets.

Une limitation importante à saisir est qu’il n’est pas possible d’ajouter à
la géométrie des formes. On peut seulement les éditer et les subdiviser.
Cela veut dire que, à un niveau de résolution donné, il est impossible
d’ajouter ou de supprimer des sommets, arêtes ou facettes.

Les maillages multirésolution sont particulièrement utiles lorsqu’ils sont
employés conjointement à l’outil de sculpture 3D, le Sculpt mode. Il est

Figure 4–71
Déchirure du maillage en un sommet précis
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possible d’activer la multirésolution d’un maillage grâce au bouton Add
Multires du panneau Multires du menu Editing [F9].

• Apply Multires : applique le niveau de résolution actuel au maillage, tout
en supprimant tous les autres niveaux, supérieurs comme inférieurs.

• Add Level : accroît d’un niveau le niveau de résolution du maillage. Ce
nouveau niveau devient le niveau courant de résolution. Il est possible
de choisir le type de subdivision conduisant à ce nouveau niveau :
Catmull-Clark ou Simple Subdiv., exactement comme avec le modifica-
teur Subsurf.

Dès qu’au moins un niveau de résolution a été ajouté, d’autres boutons
apparaissent pour permettre à l’utilisateur de gérer les différents niveaux
de résolution.
• Del Lower, Del Higher : supprime tous les niveaux de résolution infé-

rieurs (Del Lower) ou supérieurs (Del Higher) au niveau courant.
• Level : détermine le niveau de résolution courant, visible et éditable

dans la vue 3D.
• Edges : affiche les arêtes du maillage conformément au niveau de

résolution précisé, ce qui permet d’afficher la topologie du maillage
sans que la vue soit encombrée par un trop grand nombre d’arêtes
pour les hauts niveaux de subdivision.

Le deux dernières options sont relatives au rendu de l’objet multi-
résolution :
• Pin : impose le niveau d’effet des modificateurs à appliquer à l’objet

au moment du rendu ;
• Render : définit le niveau de subdivision à prendre en compte au

moment du rendu.

Enfin, vous noterez que la carte UV et les informations comme les seams
(coutures de dépliage) et les creases (dureté des arêtes) ne peuvent être
stockées qu’au premier niveau de subdivision. De plus, les Shape Keys
(formes clé d’animation) ne peuvent pas être utilisées avec un maillage
multirésolution.

Figure 4–72
Le panneau Multires, après activation

de la fonction, et après ajout
d’un premier niveau de subdivision
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Retopologie
La retopologie est une méthode permettant de construire un nouveau
maillage sur les bases de la surface d’autres objets qui peuvent être aussi
bien des maillages que des métaballes ou encore des surfaces NURBS.
L’emploi de la retopologie peut répondre à divers besoins :
• conversion manuelle d’un objet procédural (métaballes) ou mathéma-

tique (NURBS) en un maillage ;
• reconstruction d’un maillage mal modélisé en vue de permettre sa

bonne déformation lors des animations ou d’un simple nettoyage ;
• aide à la modélisation d’éléments devant s’ajuster finement aux

formes d’un autre objet (modélisation de vêtements ou de parures,
par exemple).

La retopologie est une technique qui peut nécessiter de solides bases de
modélisation pour en tirer un meilleur parti que la modélisation tradi-
tionnelle, en particulier lorsque l’objectif est de reproduire un objet exis-
tant tout en optimisant le maillage ou en le rendant propre à l’animation
à l’aide d’armatures, par exemple.

Lorsque vous entrez en mode Edit ([Tab]), l’onglet Mesh du menu Editing
[F9] présente un bouton Retopo. Si vous l’activez, une paire de boutons
supplémentaires apparaît.
• Retopo : active/désactive le mode de retopologie.
• Paint : active/désactive les outils de peinture de polygone, permettant

de dessiner des lignes dans la vue 3D.
• Retopo All : déplace les sommets sélectionnés sur la surface de l’objet

modèle.

Retopologie par modélisation
La méthode pour effectuer une retopologie est simple, mais atypique :
affichez votre modèle (ou la portion du modèle qui vous intéresse) et
ajoutez un nouvel objet Mesh (peu importe lequel ; par exemple, un plan :
Add>Mesh>Plane). Tout en restant en mode Edit, assurez-vous que tous

Figure 4–73
Les options Retopo du panneau Mesh

BON À SAVOIR   La retopologie 
et la complexité des objets modèles

La retopologie fonctionne sur la base du tampon
de profondeur de la vue 3D active ; l’objet modèle
aura beau être complexe, il n’affectera en rien la
vivacité des outils de retopologie.
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les sommets sont bien sélectionnés (touche [A], une à deux fois, si néces-
saire) puis, supprimez-les (touche [X]). Oui, vous avez bien lu, il faut les
supprimer mais rester en mode Edit : enclenchez le bouton Retopo du
panneau Mesh, puis ajoutez un premier sommet avec la combinaison de
touches [Ctrl]+bouton gauche de la souris, puis un autre, etc. Vous êtes
désormais dans un cadre de modélisation polygonale classique, à l’excep-
tion que tous les sommets ajoutés seront « déposés » à la surface de l’objet
modèle.

Tant que le bouton Retopo est actif, les opérations affectant les sommets
(déplacement, touche [G], rotation, touche [R] et redimensionnement,
touche [S]) les maintiendront sur la surface de l’objet modèle. L’ajout de
nouveaux sommets a lieu avec la combinaison de touches [Ctrl]+bouton
gauche, une arête étant automatiquement créée entre le nouveau sommet
et le dernier sommet sélectionné, et positionnée sur la surface de l’objet
modèle. Il en est de même si la technique d’extrusion (touche [E]) est
employée pour construire le nouveau maillage.

Retopologie par peinture des polygones
Le mode Paint n’est disponible que lorsque l’objet en cours de création
est de type Mesh (les objets de type Curve ou Surface ne peuvent donc en
bénéficier). Il permet de dessiner des traits à main levée, des segments de
droite ou des ellipses, les traits résultants étant bien sûr automatique-
ment positionnés à la surface du modèle ; un sommet est positionné à
chaque intersection de deux traits, et l’usage de la touche [Entrée] permet
de générer les triangles ou les quadrangles correspondant à ce qui a été
peint. Si le polygone formé par les traits se croisant comprend plus de 4
côtés, la facette n’est pas créée, Blender n’acceptant que des triangles ou
des quadrangles. L’utilisateur doit alors recourir aux outils traditionnels
de modélisation polygonale pour compléter les facettes manquantes.

Les outils de peinture disponibles sont relativement primitifs :
• Pen : permet de tracer des traits à main levée ; il est possible d’activer

l’option Hotspot, qui permet à l’outil Pen de détecter l’extrémité d’un
autre trait de type Pen, et de démarrer directement à partir de celui-ci.
Si une extrémité est détectée à proximité du pointeur de la souris, elle
est automatiquement encerclée ;

Figure 4–74
Les différents types de trait

du mode Paint de la fonction Retopo

ASTUCE   Retopologie avec des courbes ?

Le bouton Retopo est également disponible en
mode édition pour des objets de type Curves ou
Surfaces (Add>Curves>... ou Add>Sur-
faces>...). Il apparaît alors dans le
panneau Curve Tools1.

ASTUCE   L’option X-ray

Si vous avez du mal à visualiser le nouveau
maillage parce qu’il se confond avec le modèle, ou
parce que certaines facettes passent totalement
ou partiellement sous sa surface, vous trouverez
avantage à activer le bouton X-ray
(panneau Draw, Object buttons, menu Object,
touche [F7]).
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• Line : permet de tracer un segment de droite ; le paramètre LineDiv
permet de déterminer le nombre de subdivisions du segment, une
valeur importante lui permettant de se conformer plus facilement à
un modèle complexe ;

• Ellipse : permet de tracer une ellipse ; le paramètre EllDiv détermine le
nombre de segments constituant l’ellipse ; trois segments produisent
un triangle, quatre un carré, et ainsi de suite, un nombre élevé ten-
dant à produire une ellipse parfaitement continue.

Exemple simple d’usage de la fonction de retopologie
Il n’est pas nécessaire d’avoir à rebâtir un maillage entier pour trouver
des applications utiles au quotidien de la fonction Retopo. Un exemple
simple est la modélisation de vêtements ou de parures pour des person-
nages, comme le montre l’exercice suivant : lancez une nouvelle session
de Blender, ou réinitialisez la scène courante (combinaison de
touches [Alt]+[X]). Supprimez (touche [X]) le cube par défaut, rem-
placez-le par la tête de Suzanne (Add>Mesh>Monkey) et quittez le
mode Edit (touche [Tab]). Zoomez dans la vue et faites-la pivoter pour
avoir une bonne vision du front de Suzanne. Idéalement, ajoutez un
modificateur de type Subsurf (panneau Modifiers, Add Modifier>Subsurf)
et lissez l’ombrage des facettes (bouton Set Smooth du panneau Link and
Materials), le tout dans le menu Editing, touche [F9]. L’objectif va être
simple : ajouter un serre-tête à Suzanne.

Ajoutez maintenant un maillage quelconque (Add>Mesh>Plane) et tant
que tous les sommets sont sélectionnés, supprimez-les (touche [X]) pour
obtenir un objet vierge, mais toujours en mode Edit (ne touchez donc pas
à [Tab] !). Activez ensuite le bouton Retopo, puis le bouton Paint. Dans
l’en-tête de la vue 3D, sélectionnez l’outil de dessin à main levée, Pen.

ASTUCE  Bouclage des lignes

La touche [C] permet de déterminer si le trait cou-
rant (qu’il soit obtenu par les outils Pen, Line ou
Ellipse) boucle sur lui-même ou non. Par exemple,
tracez une forme non close avec l’outil Pen, et
appuyez sur la touche [C] pour la clore.

Figure 4–75
Notre objet modèle est en place, 
il ne reste plus qu’à esquisser un serre-tête.
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Dessinez un bandeau grâce à deux lignes vaguement horizontales (sui-
vant quand même la courbure de la tête) que vous quadrillez de lignes
verticales, relativement rapprochées.

Validez la création des polygones grâce à la touche [Entrée] et observez le
maillage qui a été créé par le mode Retopo : à chaque intersection de
ligne, un sommet à été positionné, et les facettes créées à partir de
chacun des sommets. Dans le menu Object, touche [F7], activez
l’option X-ray dans le panneau Draw pour mieux visualiser l’ébauche de
serre-tête, puis revenez dans le menu Editing, touche [F9]. Dans
l’onglet Modifiers, ajoutez un modificateur de type miroir (Add Modi-
fier>Mirror) qui, par défaut, devrait convenir à vos besoins si vous avez
suivi les instructions pas à pas (ajustez tout de même la valeur Merge
Limit à 0.1000 environ).

Malheureusement, le serre-tête ne couvre pas la tempe, nous allons donc le
prolonger un peu : en sélectionnant la dernière arête (ou les deux sommets

Figure 4–76
L’outil Pen permet de dessiner à main levée

la topologie du futur serre-tête en plaçant
un sommet à chaque intersection.

Figure 4–77
Le serre-tête commence à se dessiner, en
suivant la courbure du crâne de Suzanne.
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la constituant), en vue de côté opposée (combinaison de touches [Maj]+[3]
du pavé numérique), extrudez cette arête grâce à la touche [E], à deux ou
trois reprises, en choisissant l’option Only Edges (attention, le bouton X-ray
peut être trompeur et provoquer l’ajout des arêtes du mauvais côté de la
tête, d’où l’usage de la vue de côté opposée, combinaison de
touches [Maj]+[3], au lieu de la vue de côté classique, touche [3]).

Nous allons maintenant donner de l’épaisseur au serre-tête grâce à un
script d’aide à la modélisation : sélectionnez tous les sommets formant la
base du bandeau (touche [A]) et, dans l’en-tête de la vue 3D, choisissez
Mesh>Scripts>Solidify Selection ; vous pouvez accepter les paramètres par
défaut, ou jouer avec si vous le souhaitez.

Nous avons dans cet exercice réalisé quelque chose de grossier, certes,
mais très facilement. Les polygones peints ont automatiquement été
ajustés à la surface de l’objet en modèle ; de même pour les facettes qui
ont été ajoutées par extrusion. La même technique fondamentale peut
être appliquée pour habiller un personnage (pantalon, ceinture, bracelet,
montre, collier, etc.), peaufiner un décor (route goudronnée, etc.) ou tout
autre travail nécessitant de démarrer avec des polygones épousant les
formes d’un autre objet.

Figure 4–78
Les bases du serre-tête sont désormais 
en place, ajustées au plus près 
du crâne de Suzanne.

Figure 4–79
Et voilà, Suzanne est désormais 
parée d’un serre-tête rudimentaire.
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Opérations booléennes
Par le biais des opérations booléennes, il est possible de considérer les
maillages comme des volumes et, à ce titre, de réaliser des opérations
élémentaires entre ces volumes. Les opérations booléennes disponibles
sont les suivantes :
• union – les volumes sont ajoutés les uns aux autres ;
• intersection – seuls les volumes communs aux différents objets sont

conservés ;
• différence – l’un des volumes est soustrait au second.

Dans Blender, une opération booléenne ne peut être employée que sur
deux objets à la fois. Autant que possible, ils ne doivent pas avoir de faces
coplanaires, ce qui risquerait d’entraîner l’échec de l’opération. Sélec-
tionnez un objet (bouton droit de la souris), puis ajoutez un second objet à
la sélection (touche [Maj] pressée, bouton droit de la souris). Appuyez sur
la touche [W] pour appeler le menu des opérations booléennes.

Quelle que soit l’opération utilisée, le résultat sera présenté sous forme
d’un maillage totalement indépendant des maillages d’origine ; les objets
résultants et d’origine se superposeront donc, mais vous pouvez sélec-
tionner les objets d’origine et les expédier un à un sur un calque invisible
(touche [M], sélectionnez un calque inactif, puis appuyez sur la
touche [Entrée] ou cliquez sur le bouton OK).

Considérons une scène très simple, constituée d’une sphère noire et d’un
cube blanc.

• Union : avec cette opération, les deux maillages sont fondus en un
seul, en ne conservant que les facettes constituant l’enveloppe exté-
rieure. Les sommets, arêtes et faces en surplus à l’intérieur des deux
volumes sont supprimés.

Figure 4–80
Le menu des opérations booléennes

ASTUCE   En cas de faces coplanaires

Si vous cherchez à appliquer une opération boo-
léenne sur deux objets dont une ou plusieurs faces
sont coplanaires, l’opération se soldera par un
échec. Généralement, faire pivoter l’un des deux
objets d’un angle très faible pour rompre le carac-
tère coplanaire suffit pour que l’opération soit un
succès à la seconde tentative.

Figure 4–81
Les objets d’origine

de nos opérations booléennes
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• Difference : pour cette opération, l’ordre de sélection a une impor-
tance, car l’objet actif (le dernier sélectionné) sera soustrait au pre-
mier objet sélectionné. Vous noterez que la surface résultante
commune aux deux anciens objets hérite de la couleur de l’objet qui
se soustrait.

• Intersection : pour cette opération, seul le volume commun aux deux
objets est retenu comme résultat de l’opération booléenne.

Figure 4–82
Le résultat d’une opération Union

Figure 4–83
Sélection du cube, puis de la sphère : 
la sphère se soustrait au cube.

Figure 4–84
Sélection de la sphère, puis du cube : 
le cube se soustrait à la sphère.

Figure 4–85
Intersection de la sphère et du cube
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Si les opérations booléennes semblent être particulièrement utiles, elles
sont surtout le fruit de la facilité, en ce sens que l’algorithme de généra-
tion des facettes, formant les volumes calculés, doit être optimisé. À ce
jour, les maillages résultants des opérations booléennes sont tout sauf
propres. Souvent, un grand nombre de facettes inutiles peuvent même
être générées, nécessitant soit le nettoyage « manuel » du modèle, soit
l’usage du modificateur de décimation.

Sculpture en 3D
Le mode Sculpt est une méthode de modélisation très différente de ce
qui a été présenté jusqu’à présent. Plutôt que d’éditer les sommets, arêtes
et facettes individuels d’un maillage, l’utilisateur fait usage de pinceaux
et de brosses pour manipuler la surface de l’objet. Quelques informations
de base sur ce mode particulier :
• l’ajout ou la suppression de nouveaux sommets, arêtes ou facettes

n’est pas permise ;
• l’usage des brosses est particulièrement adapté au travail avec des

maillages très denses ;
• le mode Sculpt est surtout adapté au façonnage de formes organiques

et courbes, plutôt qu’à celui de surfaces plus mécaniques, planes,
régulières ou dotées d’arêtes vives.

Le mode Sculpt fonctionne particulièrement bien conjointement aux
maillages multirésolutions avec un niveau de subdivision élevé. La possi-
bilité de naviguer d’un niveau de résolution à l’autre permet de sculpter
rapidement et facilement la forme générale du maillage à de faibles
niveaux de résolution, et de donner d’incroyables détails à leur surface
aux niveaux de résolution les plus élevés.

Pour activer le mode Sculpt, il suffit de changer le mode dans l’en-tête de
la vue 3D de votre choix. Trois nouveaux onglets (Sculpt, Brush et Tex-
ture) font alors leur apparition aux côtés du panneau Multires, dans le
menu Editing, touche [F9].

REMARQUE  Normales des volumes lors des opérations booléennes

Il est très important, pour obtenir des résultats prévisibles et satisfaisants, que toutes les nor-
males des volumes impliqués dans des opérations booléennes pointent, de façon consistante,
de préférence vers l’extérieur. En mode Edit, dans le panneau Mesh Tools 1 du
menu Editing, touche [F9], se trouve un bouton Draw Faces ; en l’activant, chaque face de
votre objet se voit assigner un petit vecteur décrivant la normale, et pointant vers l’intérieur
ou vers l’extérieur. S’ils ne pointent pas toujours dans la même direction, vous pouvez forcer
Blender à les recalculer de façon homogène grâce à la combinaison de touches [Ctrl]+[N].
Enfin, dans le panneau Mesh Tools se trouve un bouton Flip Normals, qui vous permet
d’inverser les normales de l’extérieur vers l’intérieur, et réciproquement.

Figure 4–86 Le passage au mode 
de sculpture se fait en un clic de souris.
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Le panneau Sculpt est divisé en trois parties : Brush, pour déterminer le
type d’outil de sculpture à employer ; Shape, pour en déterminer les pro-
priétés et caractéristiques ; et enfin Symmetry pour en déterminer le
mode d’application sur la surface.

Dans la vue 3D, lorsque le mode Sculpt est activé, le curseur de la souris
change de forme et est entouré d’un cercle dont la dimension peut être
déterminée grâce au paramètre Size. Le principe est simple : en mainte-
nant enfoncé le bouton gauche de la souris, déplacez le curseur pour que
la surface balayée soit déformée par la brosse. Il faut que la brosse soit en
mouvement pour affecter la surface : maintenir le curseur immobile au-
dessus de la même position tout en maintenant le bouton gauche appuyé
n’affecte la surface que si l’option Airbrush est active.

Les outils de sculpture
Les outils sont au nombre de sept et permettent des effets variés ; il
suffit de déplacer la brosse en maintenant enfoncé le bouton gauche de la
souris et de déplacer le curseur : la géométrie change.
• Draw : dessine un relief aux pentes douces sur la surface. Parfait pour

ajouter des collines à un paysage, ou des bosses à une peau.

Figure 4–87
Le panneau Sculpt

Figure 4–88 La taille de la brosse est matérialisée.

ASTUCE   Masquer une partie de l’objet

Le mode sculpture est redoutable avec des
maillages très denses, comme ceux que l’on
obtient en multirésolution à des niveaux élevés. En
conséquence, vous pouvez observer un ralentisse-
ment de votre ordinateur lors de la manipulation
de tels objets (rotation du point de vue ou zoom
dans la vue 3D).
En mode Sculpt, utilisez la combinaison de
touches [Maj]+[Ctrl]+bouton gauche pour
masquer l’intégralité de l’objet à l’exception de la
portion encadrée par la souris ; alternativement, uti-
lisez la combinaison de touches [Maj]+[Ctrl]+
bouton droit pour ne masquer que la portion
encadrée par la souris. La combinaison de
touches [Alt]+[H] permet de restaurer la visibilité
de toutes les portions masquées.

BON À SAVOIR  
Quelques options du menu Sculpt

Lorsque vous êtes en mode Sculpt, l’en-tête de la
vue 3D présente un menu Sculpt. En particulier, il
est possible d’y spécifier si la taille de la brosse
doit être matérialisée (Display Brush) ou de ne
rafraîchir que les surfaces balayées par la brosse
plutôt que la totalité du modèle (Partial
Redraw) si vous avez des soucis de performance
(sur certaines cartes graphiques, l’activer peut
engendrer des ralentissements : à n’utiliser que si
vous en avez vraiment besoin). Le sous-
menu Input Devices vous permet de régler le
comportement de vos périphériques d’entrée. Plus
précisément, si vous possédez une tablette gra-
phique, les options Tablet Size Adjust et Tablet
Strength Adjust permettent de relier la sensibi-
lité à la pression du stylet à la taille (Size) et/ou la
force (Strength) de la brosse.
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• Smooth : adoucit la surface du maillage, atténuant les aspérités.
Permet d’éroder les angles vifs d’un paysage, ou de lisser des rides
trop marquées sur une peau.

• Pinch : aspire les sommets (ou les repousse) vers le centre de la brosse,
permettant de pincer la surface. Permet de resserrer les parois d’un
canyon, les rides d’un visage ou les lèvres d’une personne.

• Inflate : repousse les sommets dans la direction de la normale à la sur-
face. Permet de creuser des cratères, ou de provoquer des éruptions de
verrues sur une peau.

• Grab : sélectionne un groupe de sommets et les déplace en même
temps que la brosse. Permet de sculpter directement la forme géné-
rale d’un relief ou d’un visage.

• Layer : permet de sculpter un plateau dont la hauteur est limitée. Pra-
tique pour délimiter une route ou un plateau.

• Flatten : permet d’aplatir les sommets sous la brosse jusqu’à obtenir
une surface plane.

La forme de la brosse peut évidemment être paramétrée. Toutes les
brosses ne possèdent pas toutes les mêmes réglages. Certaines en ont
moins que d’autres.
• Add, Sub : détermine si la brosse attire la matière, ou la repousse, per-

mettant de façonner des aspérités ou des cavités.
• Airbrush : actionne la modification continue du terrain lorsque le

bouton gauche de la souris est maintenu enfoncé, que le curseur de la
souris soit déplacé ou non.

• Size : définit la taille de la brosse par rapport à la vue 3D. En consé-
quence, si vous zoomez en avant ou en arrière de la vue 3D, la taille
relative de la brosse semble augmenter ou diminuer proportionnelle-
ment, par rapport à la surface sculptée.

• Strength : détermine la force de répulsion ou d’attraction de la brosse
sur la surface balayée.

Enfin, les boutons X, Y et Z de la section Symmetry permettent d’appli-
quer les coups de brosse symétriquement aux axes sélectionnés, ce qui
peut être très utile lorsque vous sculptez des modèles symétriques,
comme un visage ou une créature. Pour les détails, qui ne devront proba-
blement pas être repris de façon symétrique, ainsi que pour des sculp-
tures volontairement asymétriques, il suffit à l’utilisateur de décocher les
boutons activés pour revenir à un comportement normal des outils.

Personnaliser les brosses
Il est possible de personnaliser les brosses, afin qu’elles prennent des
formes spécifiques et permettent de sculpter de façon très pointue cer-
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taines surfaces. Blender permet de travailler à deux niveaux : l’aire d’effet
de la brosse et son rendu.

Paramétrer l’aire d’effet

Il est possible de contrôler l’effet de la brosse grâce à une courbe qui
permet de définir interactivement son influence sur la surface et
d’obtenir ainsi des formes plus ou moins originales. Les points existants
se déplacent directement avec le bouton gauche de la souris (cliquer-
glisser), et il est possible de créer des points supplémentaires (bouton
gauche sur la courbe) ou d’en supprimer (petite icône de suppression en
forme de X, juste au-dessus de l’éditeur de courbe).

• Curve : définit la transition entre la zone affectée et la surface non
affectée. Par défaut, l’option Curve est active et la transition déter-
minée par la courbe de l’onglet Brush ; désactivée, la transition est de
type Spherefalloff mais cela n’est pas paramétrable différemment. Le
bouton Reset permet bien évidemment de rétablir la courbe de transi-
tion par défaut.

• Space : définit un espacement minimal (en pixels, le résultat étant
alors variable en fonction de la taille d’affichage ou du zoom de la vue
3D) entre deux zones affectées par la brosse lors de la même opéra-
tion (bouton gauche et déplacement, jusqu’à ce que le bouton soit
relâché). Cela permet de répéter des motifs à intervalles réguliers
lorsque cela est nécessaire.

Figure 4–89
Exemple de transition douce de l’aire d’effet sur la brosse 
par défaut, et une brosse spéciale à laquelle a été attribuée une 
texture procédurale Clouds, pour un rendu de la surface très 
différent !

Figure 4–90
L’éditeur de courbes qui pilote 
l’aire d’effet d’une brosse



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008112

• View : définit la vue vers laquelle la brosse est tirée lorsque le bouton
gauche de la souris est pressé.

• Anchored : lorsque cette option est active, le centre de la brosse ne suit
pas les mouvements de la souris, mais reste ancré sur sa position ini-
tiale, le mouvement de la souris définissant alors l’amplitude de la
déformation appliquée par la brosse.

Le rendu de la brosse

La brosse par défaut affecte uniformément la surface dans l’aire d’effet,
mais en associant une texture à une brosse (onglet Texture), vous person-
nalisez celle-ci et lui permettez de sculpter de façon irrégulière l’objet,
reproduisant les motifs de la texture sur sa surface. Les brosses acceptent
divers types de texture ; elles peuvent être procédurales, ou être des
images bitmap (voir chapitre 5).

Pour créer une nouvelle brosse personnalisée, cliquez sur un canal dispo-
nible en-dessous de la brosse nommée Default. Appuyez sur le bouton Add
New qui fait son apparition, avec de nouvelles options, en prenant soin de
la renommer de façon pertinente (champ TE:) afin de vous y retrouver si
vous créez plusieurs brosses personnalisées. Appuyez sur la touche [F6]
pour afficher les Texture buttons et, dans le panneau Preview, choisissez
Brush. Un onglet Texture fait son apparition, avec la texture créée dans
l’onglet Brush. Utilisez le menu déroulant Texture Type et choisissez Image
si vous souhaitez utiliser une image bitmap pour personnaliser la brosse,
ou l’une des nombreuses textures procédurales proposées.

Une fois une nouvelle texture ajoutée, l’onglet présente de nouvelles
options qui permettent de régler plus finement le comportement de cette
brosse personnalisée.

Figure 4–91
Les mêmes brosses que précédemment,

mais avec une transition beaucoup
 plus abrupte de la brosse !

Figure 4–92
Les options liées à l’usage de textures pour la

personnalisation de brosses
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• Drag : la texture suit la brosse, comme si elle était tirée par celle-ci.
Utilisez des points alignés en guise de texture, et vous creuserez la
matière comme si l’outil était un peigne ou un râteau.

• Tile : les coordonnées de la texture sont positionnées par rapport à la
vue 3D et non plus par rapport à la brosse. Cette option vous permet
de carreler la surface de l’objet sculpté avec la texture utilisée (un peu
comme l’option Repeat du panneau Map Image des Texture buttons
lorsqu’une texture de type Image est employée). À utiliser en particu-
lier avec des textures (bitmap ou procédurales) qui sont jointives.

• 3D : les textures procédurales peuvent être définies en 3D. Cette
option permet d’en tirer parti et d’avoir un positionnement de la tex-
ture par rapport aux sommets de l’objet sculpté plutôt que par rapport
aux coordonnées de la brosse.

• Angle : détermine l’angle optionnel de rotation de la texture dans son
plan propre.

• Rake : lorsque cette option est activée, la brosse se comporte comme
un rateau ou un peigne dans le sable ; cela veut dire que les sillons
tracés changent d’orientation pour suivre le mouvement du curseur
de la souris. Associée à une texture de type Wood (option Bands),
cette fonction est très utile pour sculpter des poils ou de la fourrure !

Modéliser un paysage grâce au mode Sculpt
Il s’agit en fait d’un excellent exercice permettant d’appréhender très
rapidement le mode Sculpt, procurant toutes les bases indispensables à la
sculpture de projets plus conséquents, comme un visage ou une créature.

Ouvrez une nouvelle session de Blender, ou réinitialisez la scène courante
(combinaison de touches [Ctrl]+[X]). Supprimez le cube par défaut
(touche [X]), ajoutez un objet de type Grid (Add>Mesh>Grid) et acceptez les
résolutions X et Y proposées (res: 32). Quittez le mode Edit (touche [Tab]),
appuyez sur la touche [S] et, en maintenant la touche [Ctrl] enfoncée, redi-
mensionnez l’objet Grid jusqu’à ce qu’il atteigne six fois sa taille précédente.
Faites pivoter la vue 3D pour voir le plan en légère perspective.

Nous allons commencer à façonner les caractéristiques générales de
notre paysage. Activez le mode Sculpt et affichez l’onglet Sculpt. Choi-
sissez l’outil Draw (Add, Size 50, Strength 25) et ajoutez quelques reliefs
vallonnés à votre paysage. Grâce à l’outil Inflate (Sub, Size 20,
Strength 85), dessinez un lit de rivière ; l’outil Pinch (Add, Size 50,
Strength 25) vous permettra d’en resserrer les bords. Grâce à l’outil Grab
(Size 50), accentuez un peu le relief d’un côté de la rivière, par grosses
touches, puis rendez-le un petit peu plus accidenté (Size 20) un peu par-
tout, par petites touches.
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La topologie générale ayant été définie, nous allons nous intéresser aux
détails. Dans le panneau Multires, activez la multirésolution grâce au
bouton Add Multires, puis appuyez sur Add Level (vous êtes désormais au
niveau 2). Dans le panneau Texture, choisissez un canal vide, ajoutez une
nouvelle texture (Add New) de type Clouds (touche [F6], bouton Brush,
Texture type : Clouds) puis revenez dans le menu Editing (touche [F9]).
S’agissant d’une police procédurale, activez l’option 3D. Sélectionnez
l’outil Draw (Add, Airbrush, Size 100, Strength 5) et balayez légèrement
toute la surface de la carte, en évitant le lit de rivière, pour rendre le ter-
rain un peu plus accidenté encore. Dans le panneau Multires, cliquez sur
Add Level (vous êtes désormais au niveau 3) et répétez l’opération précé-
dente avec le même outil Draw. Ajoutez un nouveau niveau de résolution
(Add Level, niveau 4) et toujours avec l’outil Draw (Add, Airbrush, Size 50,
Strength 5), ajoutez ici ou là un peu plus de détails, plus localisés. La sur-
face devrait désormais ressembler à une peau d’orange. Ajoutez mainte-
nant une nouvelle brosse (touche [F6], bouton Brush, Texture type :
DistortedNoise) et ajoutez un peu partout des détails, toujours avec
l’outil Draw; éventuellement, ajoutez une dernière brosse (touche [F6],
bouton Brush, Texture type : Noise) pour disposer de nombreux petits rocs
et cailloux.

Figure 4–93
Les principales caractéristiques

sont sculptées à de faibles
niveaux de subdivision.
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Dans le panneau Texture, sélectionnez à nouveau la brosse Clouds et dans
le panneau Sculpt, sélectionnez Grab (Size 75) ; par petites touches,
rehaussez encore le niveau de relief. Le terrain est désormais très chao-
tique, mais il ne vous reste qu’à renforcer l’effet d’érosion grâce à
l’outil Inflate (Sub, Airbrush, Size 25, Strength 5) en déplaçant la brosse
entre les reliefs proéminents, et/ou en resserrant les lèvres de ces mêmes
ravines grâce à l’outil Pinch (Add, Size 10, Strength 25).

Courbes et objets textes
De même que les méta-éléments, les courbes et les surfaces sont des
outils de modélisation hautement mathématiques. Ils ont l’avantage de
pouvoir décrire des surfaces courbes, éventuellement complexes, avec
peu de points de contrôle (ou « sommets », pour respecter l’analogie avec
la modélisation polygonale).

Blender propose de travailler avec deux types de courbes distinctes : les
courbes de Bézier et les NURBS (Non Uniform Rational B-Splines). Cha-
cune fonctionne sur la base de points de contrôle permettant de façonner
la courbe, mais chacune se conforme à ses propres lois. Les NURBS
(courbes ou surfaces) ne seront toutefois pas abordées dans cet ouvrage.

Figure 4–94
Les détails du terrain sont 
progressivement introduits.

Figure 4–95
La texture même du terrain 
est suggérée aux niveaux de 
subdivision les plus élevés.

BON À SAVOIR   L’avenir des NURBS

Si elles sont parfaitement fonctionnelles à ce jour
dans Blender, tant les surfaces que les courbes
NURBS devraient faire l’objet d’une refonte totale
dans le cadre d’une prochaine version de Blender.
Elles ne sont pas abordées dans cet ouvrage en
raison du retard pris par rapport à la modélisation
polygonale, au profit des courbes de Bézier, étu-
diées un peu plus en profondeur.
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Les courbes de Bézier
L’ajout d’une courbe de Bézier à une scène se fait soit en utilisant le
menu Add de la barre de menus principale, soit en appuyant sur la
touche [Espace] pour faire apparaître la boîte à outils. Dans les deux cas,
il faut alors suivre le chemin Add>Curve>Bezier curve, qui insérera l’objet
à la position du curseur.

Les poignées
Une courbe de Bézier est constituée de groupes de trois points de contrôle,
qui forment une poignée de manipulation. En déplaçant ou en faisant
tourner ces poignées, il vous est possible de modifier la forme de la courbe.

Il y a quatre types de poignées.
• Poignées libres (noires) : chaque portion de poignée est indépendante.

La touche [H] permet de basculer de poignées libres en poignées alignées.

• Poignées alignées (roses) : les portions de la poignée sont toujours par-
faitement alignées. La touche [H] permet de basculer de poignées ali-
gnées en poignées libres.

• Poignées vectorielles (vertes) : chaque segment de la poignée pointe,
soit vers la poignée précédente, soit vers la poignée suivante. La
touche [V] permet d’activer ce mode de comportement. Déplacer un
point de la poignée transforme celle-ci en poignée libre.

BON À SAVOIR   Et les courbes IPO ?

Dans le chapitre 7, Techniques d’animation
fondamentales, il est fait un usage intensif des
courbes dans les vues de type IPO. Il est important
de savoir que leur manipulation suit strictement
les mêmes règles que celles présentées dans ce
chapitre consacré à la modélisation.

ASTUCE  
Transformations affectant les poignées

En sélectionnant le point central de la poignée, la
touche [G] permet de déplacer celle-ci, la touche
[R] de la faire tourner autour du point central, et la
touche [S] de redimensionner la portion de courbe.

Figure 4–96
Poignées libres

Figure 4–97
Poignées alignées

Figure 4–98
Poignées vectorielles
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• Poignées automatiques (jaunes) : la longueur et la direction de ces poi-
gnées sont déterminées automatiquement. La combinaison de
touches [Maj]+[H] permet d’activer ce mode. Déplacer un point de la
poignée transforme celle-ci en poignée alignée.

Opérations sur les courbes
En mode Edit, il vous est possible de rajouter des « segments » à votre
courbe de Bézier : avec l’une des poignées d’extrémité sélectionnée,
appuyez sur la touche [Ctrl] et cliquez, avec le bouton gauche de la souris,
à l’endroit où vous souhaitez voir apparaître une nouvelle poignée.

Avec deux poignées consécutives sélectionnées, vous pouvez créer une
poignée intermédiaire grâce à la touche [W]. Cette nouvelle poignée
s’alignera automatiquement de façon à être tangente à la courbe de
Bézier existante, ne perturbant en rien l’influence des deux poignées
d’origine.

En mode Edit, vous pouvez ajouter autant de courbes de Bézier que
souhaité ; même si elles sont discontinues, elles formeront une courbe
unique, au final. Mais à tout moment du mode Edit, vous pouvez joindre
deux courbes distinctes : sélectionnez les deux extrémités à joindre, et
utilisez la touche [F] (voir figure 4–103).

Figure 4–99
Poignées automatiques

Figure 4–100
Ajout d’un segment 
à une portion de courbe

Figure 4–102
Subdivision d’une 
portion de courbe

ASTUCE   Passage de la courbe 2D en 3D

Par défaut, la courbe de Bézier créée est en 2D.
Dans le panneau Curve and Surface du menu
Editing, touche [F9], se trouve un bouton 3D à
activer. Outre la possibilité d’éditer les poignées
dans les autres vues, la courbe est parée de petits
traits perpendiculaires, signalant qu’il s’agit désor-
mais d’une courbe en trois dimensions.

Figure 4–101 Édition d’une 
courbe de Bézier en 3 dimensions
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Quel que soit le profil de votre courbe de Bézier, vous souhaiterez peut-
être le fermer à un moment ou à un autre. Sélectionnez alors au moins
une poignée du profil à clore et appuyez sur la touche [C] ; vous pouvez
rouvrir le profil en appuyant à nouveau sur la touche [C].

Enfin, la touche [X] vous permet de supprimer une poignée ; la courbe
n’est pas rompue pour autant, car la courbe de Bézier est redessinée pour
se conformer aux poignées restantes.

Figure 4–103
Fusion de deux

courbes distinctes
en mode Edit

Figure 4–104
Clôture d’une courbe

Figure 4–105
Suppression d’une poignée

ASTUCE  Résolution de la courbe de Bézier

Il est possible de régler la résolution de la courbe dans le panneau Curve and Surface du
menu Editing, touche [F9]. Il suffit de modifier la valeur du bouton numérique DefResolU :
plus les valeurs sont élevées plus les courbes sont lisses.
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Les surfaces de Bézier
Il ne s’agit pas à proprement parler d’un type d’élément (comme peuvent
l’être les maillages, les méta-éléments ou les NURBS), mais plutôt d’un
dérivé des courbes de Bézier. En effet, il s’agit de surfaces encloses par
des courbes de Bézier. Pour en créer une, il suffit donc d’ajouter une
courbe de Bézier, Add>Curve>Bezier curve, et une fois le profil général
souhaité obtenu, de le clore, grâce à la touche [C]. Plus rapidement, il
vous est possible d’insérer un cercle de Bézier à la position du curseur,
Add>Curve>Bezier circle, et ensuite de subdiviser celui-ci (touche [W])
soit entièrement, soit par portions.

Si vous vous placez en mode ombré (touche [Z]) plutôt qu’en mode fil de
fer, vous noterez que Blender détermine automatiquement si la surface
est interne ou externe au profil clos.

Là où les choses deviennent intéressantes, c’est qu’en mode Edit, pour la
même surface de Bézier, vous pouvez insérer, à l’intérieur de la première
courbe, d’autres courbes de Bézier, également closes : Blender va auto-
matiquement reconnaître les surfaces closes, et soustraire les surfaces
encloses à la plus grande surface. Par exemple, une petite courbe de type
Bezier Circle à l’intérieur d’une courbe close découpera celle-ci.

MAYA   Les NURBS

Les NURBS de Maya sont excellentes et très bien
supportées, rendant la modélisation de formes
organiques très facile. Blender est clairement à la
traîne sur le sujet, même s’il implémente déjà les
NURBS, et ce domaine est en cours de réécriture
complète, sur la base d’un ancien projet nommé
Nurbana ; celui-ci visait à donner à Blender des
outils de modélisation par les NURBS très avancés
et très puissants.

Figure 4–106
Exemple de surfaces de Bézier 
obtenues à partir de courbes closes

Figure 4–107
Interaction de multiples courbes closes 
au sein du même objet

APPROFONDIR   Le panneau Curve Tools

Ce panneau n’est accessible dans le menu
Editing, touche [F9], que lorsque votre objet
Curve ou NURB est en mode Edit.
Le groupe de boutons Convert permet de trans-
former la sélection soit en polygones (bouton
Poly), soit en poignées de Bézier (bouton Bezier),
soit en points NURBS (bouton Nurb).
Les autres boutons permettent de définir la résolu-
tion et le poids de chaque point de contrôle
NURBS sur la surface ou la courbe NURBS générée.
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Prévoir si une surface sera creuse ou pleine est assez simple : il « suffit »
de compter le nombre de surfaces se chevauchant en un point donné : si
le nombre de surfaces est impair, la surface est pleine et donc visible ; s’il
est pair, la surface est creuse et invisible. Cela est particulièrement fla-
grant lorsque deux surfaces se chevauchent mais qu’aucune n’englobe
totalement l’autre, comme sur l’illustration suivante.

Quelques options propres aux surfaces
Prêtons maintenant attention au panneau Curve and Surfaces dans le
menu Editing, touche [F9]. Il contient différentes options relatives tant
aux courbes qu’aux surfaces, qu’elles soient de Bézier ou NURBS.

• Extrude : ce champ numérique permet d’extruder (toujours perpendi-
culairement à la surface) le profil sur une longueur égale à la valeur
saisie, en unités de Blender.

Figure 4–108
Surfaces closes se chevauchant

Figure 4–109
Le panneau Curve and Surface

Figure 4–110
Notre profil extrudé grâce

à la fonction Extrude
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• Bevel Depth : ce champ numérique permet de déterminer la profon-
deur (en unités de Blender) du chanfrein affectant tous les bords de
l’objet extrudé.

• Bev Resol : ce champ numérique détermine la résolution du chanfrein
appliqué à l’objet extrudé. Avec une valeur nulle, il s’agit d’un véri-
table chanfrein ; pour des valeurs supérieures, il s’agit d’arrondis de
plus en plus fins.

Extrusion le long d’un chemin
L’un des usages les plus courants de la courbe de Bézier consiste à s’en
servir comme chemin pour une opération d’extrusion. Deux courbes dis-
tinctes sont alors nécessaires : la première sera le chemin d’extrusion, la
seconde sera le profil extrudé.

Supposons que nous voulions modéliser un élément de décoration en fer
forgé. Nous mettrons en place, en premier lieu, le chemin en deux
dimensions, à la position du curseur : Add>Curve>Bezier Curve. Nous
façonnons celle-ci de sorte à ce qu’elle ressemble finalement à l’illustra-
tion suivante, à l’aide de nombreuses poignées libres :

Figure 4–111
L’objet extrudé est désormais chanfreiné.

Figure 4–112
Le chanfrein est désormais arrondi, 
grâce à Bev Resol.

3DS MAX  
Extrusion de formes le long d’un chemin

3ds max admet immédiatement plusieurs courbes
splines comme sections transversales de l’objet
extrudé, extrudant la forme en interpolant sa sec-
tion en fonction des splines transversales. Blender
a un comportement différent, dans le sens où une
courbe sert de chemin, une autre courbe (le
BevOb) sert de section transversale uniforme, et
une troisième courbe (le TaperOb) décrit les
éventuelles variations d’échelle de la section. Mais
la où 3ds max interpolera des sections aux formes
variables entre elles, Blender sera cantonné à un
profil unique (dans le cadre des extrusions
seulement : ce n’est pas le cas avec la modélisa-
tion par Dupli Frames ou par les NURBS (non cou-
verts par cet ouvrage).
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Cliquez ailleurs avec le bouton gauche de la souris pour relocaliser le cur-
seur hors de la première courbe ; ajoutez ensuite, à cette nouvelle posi-
tion, une deuxième courbe : Add>Curve>Bezier circle. Tant qu’elle est en
mode Edit, nous en profitons pour la subdiviser deux fois (touche [W],
Subdivide). Sélectionnez ensuite une poignée sur deux, en cliquant sur le
point de contrôle central de chacune (bouton droit de la souris), et en
maintenant la touche [Maj] enfoncée, passée la première sélection.
Appuyez enfin sur la touche [S] pour activer la mise à échelle interactive
de la sélection, jusqu’à obtenir le profil de l’illustration suivante, que vous
devez valider avec le bouton gauche de la souris ou la touche [Entrée].

Nous pouvons maintenant quitter le mode Edit, mais la deuxième courbe
n’est pas du tout à l’échelle souhaitée par rapport au chemin. La
touche [S] nous permet alors de redimensionner cette courbe. Nous
noterons que Blender a automatiquement nommé celle-ci CurveCircle
(son nom est visible dans le menu Editing, touche [F9], dans le
panneau Link and Materials, dans le champ OB:).

Sélectionnez maintenant la première courbe. Dans le panneau Curve and
Surface, repérez le champ BevOb:. Saisissez-y le nom exact de la seconde
courbe, en prenant soin de respecter les majuscules et minuscules :
BevOb: CurveCircle.

Figure 4–113
Le chemin d’extrusion, une simple clé de sol

Figure 4–114
Le profil à extruder

ASTUCE   Masquer le BevOb

L’objet qui sert de profil d’extrusion sera visible
lors du rendu. Il conviendra donc de le déplacer
dans un endroit où il ne sera pas visible. Ce peut
être hors du champ de la caméra, sur un autre
calque, ou à l’intérieur d’un autre objet, plus gros.
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Le profil est alors immédiatement extrudé le long du chemin défini par
la première courbe. Vous pouvez passer en mode ombré (touche [Z])
pour mieux visualiser le résultat, et éditer indifféremment l’une et l’autre
des deux courbes : le résultat final sera affiché à l’écran en temps réel.

Courbes de variation (Taper Curves)
Grâce à ces courbes, il est possible de faire varier la largeur du profil le
long de son chemin d’extrusion. L’objet extrudé est donc défini, au final,
à l’aide de trois courbes :
• le chemin (Path) ;
• le profil (Bevel Object) ;
• la courbe de variation (Taper Curve).

Cette courbe de variation va jouer le rôle d’un facteur d’échelle pour la
dimension du profil. Pour obtenir les effets escomptés, il est important
de la définir correctement. À cette fin, nous retiendrons les règles
suivantes :
• la courbe est représentée horizontalement ;
• la longueur (dans son axe X local) qu’elle balaie est proportionnelle à

la longueur du chemin ;

Figure 4–115
Résultat de l’extrusion le long du chemin

Figure 4–116
Notre objet, tel que défini par le Path (OB: Chemin) 
et son Bevel Object (OB: Profil)
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• son centre (le point rose) définit l’altitude zéro de la courbe (dans son
axe Y local).

L’altitude égale à une unité correspond à la dimension d’origine du
profil. Si le point local de la courbe se situe à une altitude supérieure à
l’unité, le profil à l’endroit correspondant du chemin sera agrandi
proportionnellement ; si le point local se trouve à une altitude inférieure
à l’unité, le profil sera diminué proportionnellement, jusqu’à devenir
inexistant si le point est d’altitude nulle. Enfin, les altitudes négatives
« inversent » le haut et le bas de l’objet extrudé.

Par exemple, la courbe de variation de l’illustration précédente donne
l’objet extrudé suivant :

Figure 4–117
Exemple de Taper Curve, dont une partie

est négative (altitude inférieure à celle
du centre de l’objet)

ASTUCE   Longueur de la Taper Curve

Sa longueur n’a pas d’importance : sa première
poignée coïncide avec la première poignée du
chemin, et sa dernière poignée avec la dernière
poignée du chemin, l’influence des poignées inter-
médiaires étant interpolée sur le chemin par rap-
port à leur position sur la Taper Curve. Vous
pouvez donc avoir une Taper Curve d’une unité
de Blender de long, affectant sur toute sa longueur
un objet dont le Path fait plusieurs dizaines
d’unités de long. Les variations entre deux poi-
gnées sont bien sûr interpolées.

Figure 4–118
Influence de la Taper Curve sur l’objet

extrudé : notez que pour les altitudes négati-
ves, le haut et le bas du profil sont inversés.

ASTUCE   Définition du chemin

Si vous avez une Taper Curve avec de nombreuses variations, mais que
l’objet extrudé ne semble prendre en considération que quelques-unes
de ces variations (ou pire, seulement le point de départ et le point
final !), ne cherchez pas la résolution de votre problème au niveau de la
Taper Curve : il faut que la courbe représentant votre Path soit constituée
de suffisamment de points de contrôle pour permettre de restituer la
« richesse » des variations de la Taper Curve.
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Pour désigner une courbe donnée comme étant la Taper Curve d’un objet
extrudé, il suffit de spécifier son nom (attention à la casse : les minus-
cules et les majuscules comptent) dans le champ TaperOb du panneau
Curve and Surface, dans le menu Editing, touche [F9].

Les objets textes
Les objets textes sont apparentés aux courbes et aux surfaces. À ce titre,
il est possible de régler leur apparence au travers du panneau Curve and
Surface. Pour ajouter un nouvel objet texte à la position du curseur, uti-
lisez le menu Add ou appelez la boîte à outils de Blender, grâce à la
touche [Espace], et choisissez ensuite Add>Text.

Vous êtes automatiquement en mode Edit, et il vous est donc possible de
changer le texte, exactement comme sous un traitement de texte sim-
plifié. Le curseur noir indique la position de saisie. Vous pouvez utiliser
les flèches directionnelles, les touches d’effacement, les raccourcis clavier
habituels pour copier, couper ou coller, et bien sûr toutes les touches
alphanumériques du clavier. La touche [Entrée] renvoie le texte à la ligne
suivante, mais toujours au sein du même objet texte.

Ce qui est surtout intéressant, c’est qu’il est très facile de donner à ces
objets textes un volume grâce aux paramètres Extrude et Bevel Depth, ce
qui peut être particulièrement utile pour la création de logos.

Figure 4–119
Le champ TaperOb 
du panneau Curve and Surface

Figure 4–121
Ajout d’un objet texte

Figure 4–122
Un texte en 3D en 
quelques clics seulement

3DS MAX   Création de texte

L’utilisateur de 3ds max sera ravi de découvrir
dans Blender des fonctions de mise en forme des
textes un peu plus riches que dans son logiciel
fétiche, avec notamment la possibilité dans
Blender de créer des cadres de texte. Pour le reste,
dans l’esprit, tout est très similaire.

ASTUCE  Caractères spéciaux

Lorsque votre texte est en mode Edit, un onglet
Char partage le même panneau que Font. Vous y
trouvez une table de caractères ; le fait de cliquer
sur un caractère insère celui-ci dans votre texte, à
la position du curseur.

Figure 4–120 L’onglet Char

Les boutons U (Up) et D (Down) permettent de
faire défiler la table de caractères respectivement
vers le haut et le bas. En cliquant sur le
bouton Unicode Table, vous pouvez changer de
table d’encodage.

ASTUCE   Convertir le texte 
en courbes ou en maillage

Il est possible de convertir vos objets textes en
courbes ; sélectionnez le texte à convertir, puis uti-
lisez la combinaison de touches [Alt]+[C]. Le
texte aura été converti en courbes. Utilisez à nou-
veau la combinaison de touches [Alt]+[C] pour
le convertir, cette fois, en maillage. À chaque fois,
une boîte de dialogue apparaîtra pour vous
demander confirmation de l’action : appuyez sim-
plement sur la touche [Entrée] pour la valider.
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Pour ce type d’objet, un nouveau panneau Font est disponible, et permet
de gérer l’apparence au niveau du texte lui-même.

Les principales fonctions disponibles sont les suivantes.
• Load : ce bouton permet de changer la police utilisée.
• Insert Text : plutôt que de saisir votre texte vous-même, sélectionnez,

grâce à ce bouton, un fichier contenant le texte de votre choix.
• U, B et i : respectivement Underlined, Bold et Italic, permettant d’uti-

liser les versions soulignée, grasse et italique de la police utilisée, si
elles sont disponibles.

• Left, Center, Right : permet de cadrer le texte respectivement à gauche,
au centre ou à droite, par rapport au centre de l’objet.

Les méta-éléments
Les méta-éléments sont des entités procédurales, définies à la volée par
l’ordinateur, en fonction de leur géométrie d’origine et de forces interactives,
que l’on pourrait qualifier de magnétiques. En fait, nous pourrions comparer
les méta-éléments à des volumes de mercure, qui s’assemblent les uns les
autres en s’absorbant partiellement. Dans l’illustration ci-dessous, lorsque les
deux métaballes sont éloignées, elles conservent leur géométrie d’origine.

Figure 4–123
Le panneau Font

ASTUCE   
Drapper un texte le long d’une courbe

Il est possible d’obliger le texte à s’ajuster à la
courbure d’un objet de type Curve. Pour cela, il
suffit d’insérer dans le champ TextOnCurve le
nom OB: de la courbe à suivre.

Figure 4–124 Le texte suit la courbe 
nommée Curve.

3DS MAX   Les maillages liquides

Les méta-éléments sont l’équivalent sous Blender
des maillages liquides de 3ds max, mais la mise en
œuvre est largement différente. Pour reproduire la
création d’un maillage liquide à partir d’une géo-
métrie, il faudrait, dans Blender, utiliser la fonction
DupliVerts pour reproduire une métaballe à
chaque sommet de l’objet. De même, pour repro-
duire la création d’un maillage liquide à partir de
systèmes de particules, il faudrait créer, dans
Blender, une liaison parent/enfant entre la méta-
balle et l’émetteur de particules.

Figure 4–125
Deux métaballes sur un damier...
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Mais, à mesure qu’elles se rapprochent, des forces « magnétiques » vont
« aspirer » les volumes l’un vers l’autre, jusqu’à fusion ou absorption ; ce n’est
toutefois pas une simulation de fluides, les volumes ne s’ajoutant pas.

Insérer un méta-élément dans vos scènes
L’ajout d’un méta-élément dans une scène, à la position du curseur, se
fait simplement en appuyant sur la touche [Espace], ou en passant par le
menu de la barre principale, puis en choisissant Add>Meta>Meta Ball, par
exemple. L’élément choisi apparaît alors, en mode Edit, avec, de l’inté-
rieur vers l’extérieur :
• un maillage ayant la forme générale de l’élément choisi ; si le méta-

élément se trouve dans la zone d’effet d’un autre méta-élément, son
maillage peut ne plus ressembler à l’élément de base choisi ;

Figure 4–126
Les métaballes s’agglutinent, puis se 
séparent ! Le tout est géré par une procédure.

ASTUCE  Des méta-éléments variés à votre service

Des méta-éléments de différentes formes existent, permettant de faciliter la création de
formes sophistiquées.

1. Meta Ball : balle ;
2. Meta Tube : cylindre ;
3. Meta Plane : plan ;
4. Meta Ellipsoid : ellipsoïde ;
5. Meta Cube : cube.
Ainsi, la création d’une poire pourra se limiter à la composition de deux méta-éléments : une
balle et un tube.

Figure 4–127 Une poire formée de deux méta-éléments : une balle et un tube
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• un premier cercle de couleur verte, qui définit la portée de l’action
éventuelle de l’élément sur les autres méta-éléments environnants ;

• un dernier cercle en rose, qui permet de sélectionner l’élément et le
manipuler normalement grâce aux touches de transformation ([G],
[R] et [S] en particulier).

Comportement général des méta-éléments
Dans le menu Editing, touche [F9], un nouveau panneau MetaBall fait son
apparition lorsqu’un méta-élément est l’objet actif de la scène. Il permet
de définir le comportement général des méta-éléments.
• Wiresize : il s’agit de la résolution du maillage représentant l’élément

dans la vue 3D.
• Rendersize : c’est la résolution du méta-élément au moment du rendu.
• Threshold : cette valeur définit dans quelle mesure le méta-élément

influence les autres méta-éléments à proximité.

Ces paramètres sont valables pour tous les méta-éléments d’un même
groupe. Ils peuvent donc changer d’un méta-objet à l’autre, mais restent
identiques pour tous les méta-éléments faisant partie du groupe actif.

Comportement individuel des méta-éléments
Lorsqu’un méta-élément est en mode Edit, un panneau supplémentaire
fait son apparition dans le menu Editing, touche [F9]. Il se nomme Meta-
Ball tools et permet de contrôler le comportement du méta-élément en
cours d’édition.

Figure 4–128
Une métaballe en mode Edit, dans la vue 3D

Figure 4–129
Le panneau MetaBall
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Son principal paramètre est le bouton numérique Stiffness, qui permet de
régler plus finement l’influence propre du méta-élément, là où Threshold
fixe une valeur de base commune à tous les méta-éléments du groupe.

En fonction du type d’élément, des curseurs supplémentaires dx, dy et dz
peuvent apparaître pour régler plus finement les dimensions du méta-
élément : dx pour une métaballe ; dx et dy pour un métaplan ; et enfin dx,
dy et dz pour un méta-ellipsoïde et un métacube.

Outils spéciaux de modélisation : 
les modificateurs
Les modificateurs sont des fonctions qui vont altérer (de façon réver-
sible) vos maillages ou vos objets. Il est avantageux de les utiliser en ce
sens qu’ils sont organisés sous forme d’une pile de modificateurs, et que
leur ordre dans la pile peut influencer le résultat des autres modifica-
teurs, et donc conduire à des effets intéressants.

Tous les objets ont, dans le menu Editing, touche [F9], un panneau
Modifiers. Le bouton Add Modifier permet d’afficher une liste déroulante

ASTUCE   Créer des groupes de méta-éléments

Vous ne souhaitez pas que tous vos méta-éléments interfèrent les uns avec les autres ; de
même, certains pourront avoir un Threshold et un Rendersize donnés, et d’autres des
valeurs différentes. Cela est possible à condition de créer des méta-objets. Reprenons
l’exemple de la poire, constituée d’une métaballe et d’un métacylindre. Dans le menu Editing,
touche [F9], panneau Link and Materials, donnez au premier objet inséré (par exemple, la
métaballe) le nom Poire dans le champ OB:. Puis, déclinez ce nom pour tous les méta-élé-
ments faisant partie du même méta-objet. Par exemple, le métacylindre se nommerait OB:
Poire.001, un éventuel troisième méta-élément OB: Poire.002, et ainsi de suite.
Ainsi, les paramètres du panneau MetaBall restent propres au méta-objet actif. Si vous créez
un second méta-objet dont le premier objet a été nommé OB: Banane, le second OB:
Banane.001 et ainsi de suite, non seulement le méta-objet Poire et le méta-objet
Banane auraient dans le panneau MetaBall des paramètres totalement distincts, mais en
plus les méta-éléments de l’un n’influenceront pas les méta-éléments de l’autre.

Figure 4–130
Le panneau MetaBall tools

ASTUCES   Influence négative et 
désactivation d’un méta-élément

Le bouton Negative, au lieu d’aspirer un méta-élé-
ment voisin, aura pour effet de le repousser. En
revanche, le bouton Hide masquera complètement
le méta-élément, suspendant provisoirement son
influence sur les autres méta-éléments du groupe.

3DS MAX, MAYA   Les modificateurs

La pile des modificateurs de 3ds max est un élé-
ment central de modélisation, qui se révèle très
riche et très complète. Pour sa part, Maya fait
usage d’un arbre plutôt que d’une pile, ce qui peut
parfois rendre la navigation dans les modificateurs
confuse. Blender implémente également une pile
de modificateurs, qui tendra à s’enrichir avec le
temps, mais elle se révèle déjà simple et pratique à
l’usage.
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des modificateurs disponibles. La plupart seront étudiés dans le
chapitre 7, Techniques d’animation fondamentales, car ils ont plus particu-
lièrement un intérêt dans le cadre d’animations.

Le modificateur subdivision de surfaces (Subsurf)
Il est parfois difficile de modéliser des surfaces organiques, aux multiples
courbures ou potentiellement complexes. Grâce à la subdivision de sur-
faces, il est possible d’utiliser un algorithme spécialisé pour afficher un
maillage de plus grande résolution et plus progressif, à la place du
maillage d’origine. Dans ce cadre, le maillage d’origine devient une sorte
de cage de contrôle de la surface de subdivision.

Par exemple, l’image qui suit montre le résultat de l’application de l’algo-
rithme de subdivision de surfaces sur le cube par défaut : un maillage de
résolution plus élevée et aux courbures progressives s’inscrit dans le
maillage d’origine.

Il est possible de déterminer le niveau de subdivision des surfaces : plus
celui-ci sera élevé, plus la surface inscrite dans le maillage d’origine sera
dense et progressive. Par exemple, l’image qui suit présente le même
maillage que précédemment, mais avec un niveau de subdivision de 2, au
lieu de 1 précédemment.

MAYA  Le mode Proxy et subdivision de surfaces

Le mode Proxy est très similaire au Subsurf de Blender, dans le sens où il permet de subdi-
viser uniformément le modèle entier, mais sans pouvoir appliquer de Crease (gestion de la
dureté des arêtes). Maya possède toutefois son propre système de subdivision de surfaces,
avec trois niveaux de Crease : none, medium, full. Si le modificateur Subsurf de Blender
semble plus abouti, le système de subdivision de surfaces de Maya supporte une subdivision
partielle du maillage, ce qui permet d’obtenir des maillages plus denses localement. De plus,
dans Blender, il est impératif de déterminer le niveau de subdivision à afficher au rendu, ce qui
n’est pas le cas avec Maya.

3DS MAX   Modificateur Liss.Maillage

Le modificateur Liss.Maillage de 3ds max est très
similaire au modificateur Subsurf de Blender, à
ceci près que pour ce dernier, le modificateur
s’applique systématiquement à l’objet entier,
tandis que sous 3ds max, il est possible de ne
l’appliquer qu’à un groupe de facettes. Mais en
réglant à 1.000 le niveau Crease des arêtes à
exclure du modificateur, il est possible d’obtenir
assez aisément le même type de comportement,
avec en complément la possibilité de choisir des
valeurs intermédiaires indiquant une influence par-
tielle du modificateur sur les arêtes.

Figure 4–131
Exemple d’un cube avec

subdivision des surfaces de niveau 1
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Le niveau de subdivision se règle indépendamment pour l’affichage dans
la vue 3D et pour le rendu : en effet, un niveau de subdivision élevé,
appliqué à un maillage déjà complexe, peut conduire à une brusque
dégradation des performances d’affichage et de réponse de votre
machine. Le niveau de subdivision dans la vue 3D est piloté par le
bouton numérique Levels ; au cours du rendu, il est piloté par le
bouton Render Levels.

Figure 4–132
Exemple d’un cube avec 
subdivision des surfaces de niveau 2

ASTUCE   Régler la dureté des arêtes

Il est possible, en mode Edit, de régler individuellement la susceptibilité de chaque arête au
modificateur Subsurf. Par exemple, dans le cas du cube par défaut, sélectionnez toutes les
arêtes formant la face inférieure du cube, et utilisez la combinaison de touches [Maj]+[E]
pour régler interactivement, à la souris, la dureté de l’arête, en faisant varier la valeur Crease
de 0.000 (le modificateur Subsurf s’applique pleinement aux arêtes) à 1.000 (le modifica-
teur ne s’y applique pas du tout). L’objet passe alors de la forme de sphère inscrite dans le
cube par défaut à celle d’ogive, mais vous pouvez bien sûr choisir une valeur intermédiaire et
valider celle-ci grâce au bouton gauche de la souris ou à la touche [Entrée]. Éventuelle-
ment, vous pouvez afficher le panneau flottant des propriétés de l’objet en appuyant sur la
touche [N] et en spécifiant manuellement une valeur Crease (ou Median Crease si plu-
sieurs arêtes sont sélectionnées).

Figure 4–133 Seules les arêtes inférieures du cube ont été rendues insensibles au 
modificateur Subsurf.

ASTUCE  Éditer la surface de subdivision

Pour éditer l’objet subdivisé, vous pouvez soit
éditer la cage de contrôle, ou faire appel à une
fonctionnalité très puissante de Blender : éditer
directement l’objet subdivisé ! Pour cela (et pour
un meilleur contrôle du résultat) activez l’option
Optimal Draw (cela est toutefois optionnel).
Ensuite, actionnez le bouton radio juste à gauche
des boutons ascenseur du modificateur.

Dans la vue 3D, vous pouvez maintenant éditer
sommets, arêtes et faces de la surface de subdivi-
sion, comme s’il s’agissait d’un maillage normal !
La cage de contrôle, temporairement désactivée,
se mettra à jour automatiquement.

Figure 4–134
Le modificateur Subsurf
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Le modificateur miroir (Mirror)
Ce modificateur vous permet de modéliser des objets symétriques (sim-
ples ou complexes) sans avoir à répéter les mêmes opérations, parfois fas-
tidieuses, pour chaque côté. Ainsi, vous n’avez plus à vous concentrer
que sur un seul côté de votre maillage, Blender se chargeant de com-
pléter l’autre côté à votre place.

Les paramètres de ce modificateur sont à la fois simples et pratiques,
vous permettant de choisir le sens de symétrie : dans la direction X, la
direction Y ou la direction Z. Blender se charge également de fusionner
les sommets occupant le même espace, avec une tolérance déterminée
par le bouton numérique Merge Limit : une valeur faible ne fusionnera
probablement que les sommets réellement coïncidents, des valeurs plus
élevées fusionneront des sommets proches mais distincts.

Figure 4–135
Le panneau du modificateur Mirror

ASTUCE  
Rompre la symétrie de votre modèle

En particulier pour les modèles organiques, une
parfaite symétrie pourra paraître surnaturelle et
donc manquer de réalisme. Vous souhaiterez donc
certainement pouvoir éditer les deux côtés du
modèle pour induire des dissymétries et donc
rendre celui-ci plus naturel. Cette opération n’est
recommandée que lorsque le modèle de base sera
entièrement terminé. Il vous restera alors à
appuyer sur le bouton Apply, pour que votre
demi-modèle symétrique se transforme en un
modèle entier, totalement éditable, des deux côtés,
de façon indépendante.

Figure 4–136
Une création d’objets siamois facilitée par le

modificateur Mirror suivant X
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Le modificateur décimation (Decimate)
Comme son nom le suggère, avec ce modificateur, il va effectivement
s’agir de décimer (temporairement) les sommets de vos modèles ! En
effet, dans certains cas (par exemple, des modèles situés loin en arrière-
plan de votre scène générale) vous souhaiterez n’effectuer le rendu que
d’objets « allégés » en faces et en sommets, pour des raisons d’occupation
de mémoire ou de temps de rendu trop longs. Ce type d’option vous
intéressera probablement lorsque vous chercherez à dupliquer dans votre
scène des modèles très détaillés, comme des personnages ou des arbres,
lorsque vous souhaiterez mettre en scène des foules ou des forêts, par
exemple. Grâce à ce modificateur, vous serez donc en mesure d’abaisser
le niveau de détail de vos modèles (par réduction du nombre de poly-
gones) en fonction de leur position dans la scène.

À nouveau, ce modificateur est très simple à mettre en œuvre, puisqu’il
ne dispose que d’un paramètre unique, Ratio, qui indique la proportion
de facettes à afficher : 1.000 correspond à la totalité, 0.500 à la moitié,
etc. Pour vous aider à juger de la portée de la décimation, le nombre de
facettes de l’objet courant est affiché (968 pour le modèle Suzanne).

Le modificateur booléen (Boolean)
Ce modificateur permet de réaliser des opérations booléennes de façon inte-
ractive, plutôt que d’en inscrire le résultat de façon définitive, au niveau du
maillage. Il est réévalué à chaque frame d’une animation (voir chapitre 7,
Techniques d’animation fondamentales), ce qui autorise des effets intéressants.

REMARQUE   Cadre d’utilisation 
du modificateur décimation

Ce modificateur s’utilise hors du mode Edit.
Comme il s’applique interactivement, si vous
éditez un objet dont le modificateur Decimate est
actif, le maillage qui apparaîtra sera celui du
modèle d’origine, et non celui du modèle décimé.
Si vous devez vraiment éditer le modèle décimé,
appliquez de façon permanente la décimation à
votre modèle grâce au bouton Apply.

Figure 4–137
Réduction du nombre de polygones de moitié 
grâce au modificateur Decimate (décimation)

Figure 4–138
Le panneau du modificateur Decimate
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Par exemple, déplacer un « trou » au sein d’une pièce se fera grâce à l’anima-
tion d’un cylindre, dont le nom sera reporté dans le champ Ob: du
panneau Modifiers, et après avoir spécifié une opération de type Difference.

Comme pour une opération booléenne standard, l’objet pris en compte
pour générer le trou sera visible lors du rendu, à moins de le rendre invi-
sible, soit grâce à sa valeur Alpha (onglet Material, Material buttons,
menu Shading, touche [F5]), soit en le déplaçant sur un calque invisible
(grâce à la touche [M], hors du mode Edit).

Le modificateur arrangement (Array)
Ce modificateur permet de créer des rangées de clones de l’objet de base,
la position de chaque copie étant dérivée de celle du clone précédent.

Le décalage entre deux copies peut être spécifié de deux façons
différentes : avec l’option Constant Offset, le décalage est spécifié par rap-
port aux coordonnées de l’objet d’origine, tandis que pour
l’option Relative Offset, le décalage est spécifié par rapport aux coordon-
nées de l’objet cloné précédent. Il est bien sûr possible de spécifier des
décalages dans les trois directions principales X, Y et Z, voire de combiner
des décalages constants ou relatifs.

Un menu déroulant permet de déterminer la « longueur » de la rangée,
en fonction de l’option retenue. Fixed Length permet de spécifier la lon-
gueur (en unités de Blender) maximale de la rangée, Blender se char-
geant de calculer le nombre d’instances qu’il est possible d’insérer sur

Figure 4–139
Le panneau du modificateur Boolean

Figure 4–140
Le panneau du modificateur Array
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cette longueur. Fixed Count, pour sa part, permet de spécifier le nombre
d’instances souhaitées, Blender déterminant alors la longueur résultante
de la rangée. Enfin, le fonctionnement Fit to Curve Length est identique à
Fixed Length, à ceci près que c’est la longueur d’une courbe (nommée
dans le champ Ob: approprié) qui est prise en considération.

Le bouton Merge permet de fondre les points de contrôle adjacents des
différentes instances, s’ils sont suffisamment proches, ce qui est déter-
miné par la valeur du paramètre Limit.

L’option Object Offset, enfin, est particulièrement puissante et autorise
des raffinements intéressants : elle permet de transmettre les transfor-
mations (position, rotation, et échelle) d’un objet (nommé dans le
champ Ob: approprié) d’un clone à l’autre, en plus des décalages habi-

Figure 4–141
Pour l’option Constant Offset, le centre 
de chaque nouvelle instance est déterminé 
par décalages successifs par rapport au centre 
de l’objet d’origine (de haut en bas : 
X = 0.50, X = 1.00 et X = 2.00).

Figure 4–142
Pour l’option Relative Offset, le centre 
de chaque nouvelle instance est déterminé 
par un décalage par rapport au centre 
de l’objet précédent (de haut en bas : 
X = 0.50, X = 1.00 et X = 2.00).
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tuels, ce qui permet de transmettre ainsi un incrément de dimension ou
de rotation aux instances consécutives.

Le modificateur déplacement (Displace)
Ce modificateur permet de déformer la surface (suffisamment subdivisée)
d’un objet conformément à l’interprétation de l’intensité d’une texture. La
déformation peut être orientée dans une direction particulière, appliquée
selon la normale à l’objet, ou chaque canal de couleur de la texture peut

Figure 4–143
Exemple d’usage avec Fixed Count égal à 7,

aucun décalage, ni relatif, ni constant.

Figure 4–144
En décalant l’Object Offset (l’Empty),

toutes les instances se décalent d’autant,
dans les mêmes directions.

Figure 4–145
Bien sûr, si l’on fait également tourner

l’Object Offset, l’incrément de rotation est
également transmis à chacune des instances.
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être affecté à une direction de déformation privilégiée. Malgré leur appa-
rente pluralité, les contrôles de ce modificateur sont simples.

Pour le faire fonctionner, il suffit de spécifier dans le champ Texture le
nom d’une texture existante dans la scène ; il est nécessaire de respecter
strictement l’orthographe et surtout la casse de la texture, mais celle-ci
peut aussi bien être une image bitmap qu’une texture procédurale. Le
menu déroulant Normal précise en fait la direction de déplacement (X, Y
ou Z déplace la surface dans la direction proposée seulement ; RGB → XYZ
décompose la texture en fonction de ces couleurs, l’intensité de la cou-
leur R indiquant la valeur du déplacement dans la direction X, et de
même avec les couleurs G et B, et les directions Y et Z ; Normal indique
que le déplacement est effectué dans la direction de la normale à la
facette). Le menu déroulant Local, quant à lui, indique quel système de
coordonnées prendre pour effectuer le déplacement (Local prend en
compte les coordonnées de l’objet pour origine, Global prend celles abso-
lues de la scène ; Object permet de déterminer un autre objet comme
étant l’origine, un champ Ob: apparaissant pour spécifier celui-ci ; UV
prend strictement les coordonnées de l’objet s’il a été déplié, un champ
apparaissant pour sélection de l’UV Layer à prendre en considération).

Enfin, le paramètre Strength permet de régler la force du déplacement,
tandis que Midlevel permet de déterminer la valeur de l’intensité de la
texture correspondant à un déplacement nul. Par exemple, pour une tex-
ture procédurale variant du noir (intensité 0.000) au blanc (intensité
1.000), un Midlevel 0.500 définit la couleur grise à 50 % comme étant
l’intensité de déplacement nul. Les portions plus claires de la texture
indiquent une élévation (déplacement positif ) tandis que celles qui sont
plus sombres suggèrent une cuvette (déplacement négatif ).

Figure 4–146
Le panneau du modificateur Displace

Figure 4–147
Exemple d’une image appliquée 
en tant que modificateur de déplacement 
sur un maillage finement subdivisé
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Le modificateur séparation aux arêtes (EdgeSplit)
Blender permet d’interpoler l’ombrage des facettes à la surface des
maillages de façon à simuler leur lissage ; cela est possible grâce à la
fonction Set Smooth (appliquée à l’objet entier en mode Object, ou à une
sélection de facettes en mode Edit), panneau Links and Material, menu
Editing, touche [F9]. La fonction Set Solid fait l’inverse : l’ombrage n’est
pas interpolé, et révèle parfaitement les facettes modélisées. Il y a égale-
ment la fonction Auto Smooth (panneau Mesh, menu Editing) qui permet
de lisser ou non l’apparence de la surface en fonction de l’angle
(paramètre Degr) formé entre les normales de deux facettes consécutives.

ASTUCE   Peindre des terrains dans Blender

Blender vous permet de peindre des images directement dans le
mode Texture Paint, avec des outils appropriés proches de ceux offerts
par le logiciel Gimp. Vous pouvez donc créer une texture de type Image
appelant l’image peinte par vos soins, et vous en servir avec le modifica-
teur Displace pour générer ainsi des décors fantastiques. Le résultat n’est
toutefois pas aussi immédiat qu’avec le mode Sculpt, puisqu’il est néces-
saire, après chaque modification à l’image, afin de faire apparaître les
résultats dans la vue 3D, d’effectuer les opérations suivantes :
• sauvegarder l’image peinte (UV/Image Editor, Image>Save) ;
• recharger la texture modifiée dans Blender ([F6], panneau Image,

bouton Reload) ;
• désactiver/réactiver le modificateur Displace ([F9], onglet Modifiers,

icône Enable modifier during interactive display du modificateur Displace).
En revanche, s’il est moins convivial de sculpter des terrains de cette
façon, cet outil préserve tous les avantages d’un modificateur : il peut
être placé avant ou après tout autre modificateur dans la pile, il est
paramétrable, et peut être facilement animé (par exemple, à l’aide de
textures procédurales).

BON À SAVOIR  
Ombrage lisse et surfaces lissées

Les fonctions Set Solid, Set Smooth, Auto
Smooth et le modificateur EdgeSplit permettent
de lisser l’ombrage des facettes : la géométrie de
l’objet n’est en rien altérée. Le modificateur Sub-
surf, en revanche, subdivise le maillage tout en le
lissant ; plus le maillage sera subdivisé finement,
plus on aura l’illusion d’un ombrage parfaitement
lissé. La première méthode est un simple effet
d’optique n’affectant pas le maillage de l’objet,
tandis que la seconde affine effectivement celui-ci.
Ce sont donc deux approches totalement distinctes
qu’il convient de ne pas confondre, d’autant qu’elles
sont souvent mises en œuvre en même temps.

Figure 4–148
À gauche, une pièce mécanique, dont toutes

les arêtes sont vives ; à droite, la même pièce,
mais pour laquelle la surface entière a été

lissée : aucune arête vive ne semble subsister.
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Le modificateur EdgeSplit permet de marquer des arêtes comme vives
dans le lissage de la fonction Set Smooth, et donc de contrôler finement le
lissage des surfaces. Il fonctionne de deux façons différentes, qui peuvent
être mises en œuvre en même temps.

• From Edge Angle : cette option permet de contrôler le lissage des sur-
faces exactement de la même façon que la fonction Auto Smooth. Le
paramètre Split Angle permet de définir l’angle limite formé par deux
surfaces à partir duquel l’arête les séparant restera vive : avec un angle
de 0°, toutes les arêtes seront vives ; avec un angle de 180°, aucune
arête ne sera vive.

• From Marked As Sharp : cette option permet de spécifier comme vives
uniquement les arêtes qui auront été marquées comme telles ; pour
marquer une arête comme vive, en mode Edit, sélectionnez-la et uti-
lisez la combinaison de touches [Ctrl]+[E] pour appeler le menu spé-
cial des arêtes, et choisissez Mark Sharp (ou Mark Smooth pour
annuler un tel marquage sur une arête spécifique).

Bien évidemment, rien n’empêche d’employer ces deux méthodes en
même temps.

Le modificateur EdgeSplit sera avantageusement mis en œuvre dans le
cadre de la représentation d’objets mécaniques usinés (tournage, frai-
sage, etc.) présentant des parties parfaitement lisses et de nombreuses
arêtes vives.

Figure 4–149
Le panneau du modificateur EdgeSplit

Figure 4–150
À gauche, on peut voir sur le maillage 
les arêtes marquées comme vives (en jaune), 
tandis qu’à droite on observe le résultat 
du lissage correspondant.
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Le modificateur lissage (Smooth)
Autant le modificateur Subsurf permet d’obtenir un effet de lissage d’un
modèle en le subdivisant, autant ce modificateur-ci opère en adoucissant les
angles formés par les arêtes, mais sans ajouter de géométrie. En fait, il est
possible d’obtenir le même résultat sur les sommets sélectionnés en
mode Edit, grâce au bouton Smooth du panneau Mesh Tools (menu Editing,
touche [F9]) ou grâce à la touche [W] qui appelle le menu Specials. Mais le
modificateur lissage va plus loin, car il affecte la totalité du maillage en
mode Object (à moins qu’un groupe de sommets n’ait été défini et spécifié
dans le champ VGroup, auquel cas il n’opère que sur le groupe) tout en offrant
la possibilité de contrôler l’intensité de l’effet, ainsi que le nombre d’itérations.

Le paramètre Factor permet de déterminer l’intensité du lissage. Plus
celle-ci est importante, plus le maillage s’accommode et semble rétrécir à
mesure que les facettes s’agencent de façon à adoucir les angles. Il est
intéressant de noter que Factor peut également être négatif, ce qui peut
produire des résultats intéressants en soi !

Le paramètre Repeat détermine le nombre de fois consécutives où l’opé-
ration de lissage est appliquée au maillage. Enfin, les boutons X, Y et Z
permettent de contraindre le lissage dans certaines directions seulement.

Figure 4–151
Le panneau du modificateur Smooth

Figure 4–152
Avec un Factor égal à 1.000,

le maillage paraît plus lisse
mais semble s’être affiné.
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Le modificateur projection (Cast)
Ce modificateur permet d’altérer les coordonnées des sommets d’un
maillage afin de les projeter selon trois formes prédéterminées : cube,
cylindre ou sphère. Ce modificateur n’est pas sans rappeler la fonction To
Sphere cachée dans le panneau Mesh Tools du menu Editing, touche [F9],
lorsque le maillage est en mode Edit, à l’exception qu’il s’agit ici d’un
modificateur, plus finement paramétrable, réversible, et qui autorise la
transformation en d’autres formes que la sphère.

Le menu déroulant permet de choisir la forme de projection : Cuboid,
Cylinder et Sphere. Le modificateur peut être contraint à ne fonctionner
que dans un axe privilégié (X, Y ou Z) ; par défaut, le maillage entier est
affecté, mais il est possible de spécifier un groupe de sommets, grâce au
paramètre VGroup, sur lequel le modificateur agira. Optionnellement,
vous pouvez spécifier un objet tiers, grâce au champ Ob:, dont la position
définira le centre de l’effet.

Bien évidemment, Factor détermine l’intensité de l’effet, mais il est bon
de savoir que le modificateur accepte des valeurs négatives, pouvant être
intéressantes dans le cadre de caricatures si vous avez des maillages réa-
listes sous la main.

Figure 4–153
Après plusieurs itérations, 
la pauvre Suzanne est certes plus lisse, 
mais tellement méconnaissable !

Figure 4–154
Le panneau du modificateur Cast
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Le paramètre Radius définit la distance (depuis le centre de l’effet, en
unités de Blender) sur laquelle les sommets du maillage sont affectés par
le modificateur ; une valeur nulle suggère que tous les sommets sont
affectés. Si le bouton From radius est désactivé, vous pouvez spécifier une
valeur Size, en unités de Blender. Par exemple, Size: 1.000 aura tendance à
produire une sphère de rayon égal à une unité de Blender si l’intensité de
l’effet Factor vaut également un.

Le modificateur chanfrein (Bevel)
Nous avons déjà vu la fonction Bevel qui permet de chanfreiner les arêtes
ou les sommets sélectionnés d’un maillage. Le modificateur Bevel fonc-
tionne de façon assez similaire mais procédurale, comme tous les autres
modificateurs, ce qui permet de l’animer.

Figure 4–155
Exemple d’usage du modificateur Cast,

pour une transformation en sphère,
avec des valeurs Factor respectivement

égales à -1.000, 0.000 et 1.000

Figure 4–156
Le panneau du modificateur Bevel
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Dans son usage le plus simple (Limit using: None), un chanfrein de largeur
égale au paramètre Width est appliqué à toutes les arêtes (ou à tous les
sommets si l’option Only Vertices est active). L’option Limit using: Angle
permet d’appliquer le modificateur seulement aux arêtes suffisamment
vives ; lorsqu’elle est sélectionnée, un paramètre Angle apparaît pour spé-
cifier la valeur au-delà de laquelle le chanfrein sera appliqué.

L’option Limit using: BevWeight est plus complexe, mais offre une plus
grande versatilité. Après avoir ajouté le modificateur Bevel au maillage,
activez le bouton BevWeight et, en mode Edit, sélectionnez les arêtes que
vous souhaitez chanfreiner (mode Sélection d’arêtes). Utilisez la combi-
naison [Ctrl]+[Maj]+[E] pour spécifier l’influence du chanfrein sur l’arête.
Les options Min, Average et Max permettent de déterminer de quelle
manière la largeur du chanfrein est interpolée entre des arêtes avec des
influences de valeurs différentes :
• Min : l’influence de l’arête la plus vive sera prise en compte lorsque le

chanfrein est calculé à un sommet ;
• Average : l’influence moyenne des arêtes est prise en compte lorsque

le chanfrein est calculé à un sommet ;
• Max : l’influence la plus élevée est prise en compte lorsque le chan-

frein est calculé à un sommet.

L’avantage du modificateur par rapport à la fonction Bevel de modélisa-
tion (menu Specials appelé grâce à la touche [W]) est qu’il est possible, en
mode BevWeight, d’avoir un chanfrein de largeur variable le long d’une
arête, en fonction de l’influence donnée aux arêtes voisines.

Figure 4–157
Les arêtes horizontales ont un poids de 0.2, tandis que
l’arête verticale a un poids de 1.0. En mode BevWeight Max, 
la largeur entière du chanfrein s’applique à l’arête verticale, 
tandis que le chanfrein croît progressivement 
de sa valeur propre au maximum de l’arête verticale.
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chapitre 5

Venice Morning, © 2005 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Maîtriser les matériaux 
de Blender

Au même titre que la modélisation, de mauvais matériaux 
ou de mauvaises textures peuvent ruiner la plus belle 
des scènes 3D. Ce chapitre met à votre disposition divers 
outils qui permettront de donner à vos scènes les couleurs 
qu’elles méritent.

Un objet est visible lorsqu’il est illuminé par une source 
de lumière. Ce que nous percevons avec nos yeux (ou au travers 
de la caméra) est la lumière reflétée par l’objet. La quantité 
de lumière réfléchie, ainsi que sa longueur d’onde locale, 
déterminent la couleur perçue et plus généralement 
les propriétés visuelles du matériau de l’objet. Celles-ci 
sont nombreuses, et ce chapitre s’attachera à les présenter 
de façon ordonnée.

SOMMAIRE

BMatériaux

B Textures

B Dépliage UV

MOTS-CLÉS

BMatériau
B Reflets
B Réfraction
BMaterial Node Editor
B Texture image
B Texture vidéo
B Texture procédurale
B Dépliage UV
B LSCM Unwrap
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Le matériau
Lorsque vous ajoutez un nouvel objet à votre scène, aucun matériau ne
lui est attribué, et il convient donc de lui en ajouter un. Ayant sélec-
tionné l’objet, affichez les Material buttons du menu Shading en appuyant
plusieurs fois sur la touche [F5]. Deux panneaux s’affichent : le premier,
Preview est totalement vide, aucun matériau n’étant pour l’instant défini.
Le second, Links and Pipeline, se contente de vous proposer un sélecteur
de matériaux, un bouton Add New et un bouton Nodes permettant
d’activer les nœuds matériaux pour l’objet en cours de sélection. En cli-
quant sur le sélecteur, une liste déroulante avec tous les matériaux actuel-
lement disponibles dans votre scène apparaît, vous permettant de
réutiliser celui de votre choix. Le bouton Add New permet, comme son
nom l’indique, de créer un nouveau matériau. La fonction du
bouton Nodes sera expliquée en fin de chapitre.

Figure 5–1
Le panneau Links and Pipeline, avant 

l’attribution d’un matériau à l’objet courant

BON À SAVOIR   Organisation des Material buttons

Outre le panneau Preview qui propose différents modes de prévisua-
lisation, plusieurs panneaux répondent à des besoins spécifiques. En
particulier :
• Links and Pipeline est un panneau qui permet d’associer le bloc

de données matériau à un bloc de données maillage ou objet,
mais surtout d’activer un ou plusieurs pipelines de rendu, parmi
lesquels Halo, ZTransp, Full Osa, Wire, Strands, ZInvert,
Radio, OnlyCast, Traceable et Shadbuf.

• Material est un panneau allégé et qui se recentre sur les pro-
priétés relatives au matériau même, en définissant les couleurs
R,G,B et A des couleurs Col, Spe et Mir. Ce panneau permet
aussi d’activer des options relatives à l’illumination (Shadeless),
aux textures UV (Texface) et à la peinture sur sommets (VCol
Light et VCol Paint).

• Shaders est un panneau qui permet de définir les algorithmes
d’ombrage des surfaces (shader diffus) ou des reflets spéculaires
(shaders spéculaires), chacun avec des propriétés qui leur sont pro-
pres, en fonction des types choisis. D’autres propriétés peuvent égale-
ment être réglées ici : TransLu, Amb ou encore Emit. Plusieurs
options discrètes mais importantes sont également accessibles depuis
ce panneau : la simulation de matériaux anisotropes (Tangent), ou
l’activation des cartes normales dans l’espace tangent (NMap TS).

• Mirror Transp permet de déterminer les propriétés du matériau
devant être prises en compte lors du lancer de rayons (raytra-
cing) pour le calcul de reflets à la surface de l’objet ou déterminer
la transparence de celui-ci.

• SSS (SubSurface Scattering) contrôle l’effet de dispersion sub-
surfacique qui permet de simuler des matériaux tendant vers la
translucidité comme le marbre ou la porcelaine pour les minéraux,
la cire, les feuilles de plantes ou la peau humaine pour les maté-
riaux organiques, ou encore le lait pour les liquides.

Figure 5–2 Les panneaux des Material buttons



5 
– 

M
aî

tr
ise

r l
es

 m
at

ér
ia

ux
 d

e 
Bl

en
de

r

© Groupe Eyrolles, 2008 147

Cliquez sur le bouton Add New : non seulement des options supplémen-
taires apparaissent pour l’onglet Links and Pipeline, mais le panneau Preview
affiche une prévisualisation du matériau (créé avec les paramètres par défaut
de Blender) ainsi que de nouveaux panneaux et onglets.

L’onglet Material présente désormais de nombreuses options. Sa princi-
pale mission est de définir les trois couleurs fondamentales de votre objet.
• Col : il s’agit de la couleur de base de l’objet, sa couleur diffuse, celle

qui est vue lorsque l’objet est parfaitement éclairé ; à noter que cette
couleur peut ultérieurement être substituée par une texture procédu-
rale, une texture image, ou même le vertex painting (peinture sur
sommets). C’est également la couleur qu’aura votre objet dans une
vue 3D lorsque l’ombrage est activé (touche [Z]).

• Spe : il s’agit de la couleur de la tache spéculaire de l’objet ; la tache
spéculaire est ce reflet lumineux qui apparaît à la surface d’un objet
un minimum brillant, trahissant souvent la position d’une source
d’éclairage. Généralement, les taches spéculaires sont blanches, mais
elles peuvent être colorées, par exemple pour le métal.

• Mir : il s’agit de la couleur de réflexion de l’objet. Par exemple, pour un
objet réfléchissant son environnement (à la manière d’un miroir plus ou
moins poli), cette couleur pourra être blanche pour une réflexion par-
faitement conforme à l’original (cas du chrome), plus ou moins teintée
de jaune (or), d’orangé (cuivre) ou de gris (aluminium ou argent).

Pour définir l’une de ces trois couleurs, cliquez sur le bouton la symboli-
sant. Les trois curseurs R, G, B permettent d’en définir respectivement les
composantes Red (R, rouge), Green (G, vert) et Blue (B, bleu). Contraire-
ment à nombre d’autres applications graphiques, codant ces valeurs de 0
à 255, Blender code celles-ci de 0.00 à 1.00. Cette habitude déroutante
de prime abord fonctionne assez bien a posteriori, et reste homogène
avec le codage de tous les autres paramètres de Blender.

À gauche de chaque bouton, la couleur résultante peut être prévisualisée.
En cliquant sur cet espace de prévisualisation, vous affichez un nuancier
qui vous permet de choisir une couleur autrement qu’en spécifiant des
valeurs pour chaque composante.

Figure 5–3 Dès que le matériau est créé, la liste des options s’allonge considérablement !

ASTUCE  Modes de prévisualisation

Il est possible de prévisualiser les matériaux de
façon plus rigoureuse en choisissant l’une ou
l’autre des options du panneau Preview. Les sha-
ders les plus complexes (en particulier ceux
obtenus avec l’éditeur nodal) seront mis en valeur
par l’option Monkey, tandis que les systèmes de
particules statiques trouveront également un
mode approprié avec l’option Hair Strands. Vous
noterez enfin la dernière option permettant
d’appliquer le suréchantillonnage évitant le cré-
nelage (OSA) au panneau de prévisualisation.

Figure 5–4 Le panneau Preview 
et ses options de prévisualisation

3DS MAX   Peinture sur sommets

Alors qu’il s’agit d’un modificateur dans 3ds max, la
peinture sur sommets dans Blender est un outil
d’édition (voir la section La peinture sur som-
mets dans ce même chapitre). Dans 3ds max, vous
disposez d’une palette de fonctions pour appliquer
et gérer la couleur sur les sommets, mais surtout, la
possibilité de gérer celle-ci sur 99 canaux, là où
Blender n’en propose à ce jour qu’un seul.
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Il y a également un quatrième curseur, nommé A pour Alpha, qui déter-
mine l’opacité de l’objet. Avec une valeur égale à 1.00, l’objet sera totale-
ment opaque, mais avec une valeur de 0.00, il sera totalement transparent,
c’est-à-dire potentiellement invisible. Mais Blender traite la transparence
d’un objet de trois façons distinctes, dont il sera rediscuté plus tard.

Tout au long de ce chapitre, à chaque fois qu’il sera possible d’appuyer
une explication par un rendu, nous ferons appel à la même scène de
démonstration. Il s’agit simplement d’un objet constitué d’un cube et
d’une sphère, dans un environnement constitué de murs et d’un sol à
damiers. Cette scène est éclairée par trois lampes, mais celles-ci pourront
être activées ou désactivées selon les besoins, avec une forte incidence sur
l’éclairage de l’objet principal.

Quelques options du panneau Links and Pipeline
Le panneau Links and Pipeline présente une section Render Pipeline qui
spécifie les effets spéciaux de rendu.
• Wire : lorsque la scène est rendue, l’objet apparaît sous forme de fil de

fer révélant ainsi les arêtes et les sommets de l’objet.
• Full OSA : normalement, l’anti-crénelage (voir chapitre 9, Le rendu

avec Blender) ne s’applique qu’au contour des objets ; en activant ce
bouton, il s’appliquera également aux frontières des ombres et aux

Figure 5–5
Le nuancier de Blender

LE SAVIEZ-VOUS ?   Le matériau 
par défaut de Blender

Théoriquement, si aucun matériau n’est défini pour
un objet, ce dernier est incapable de réfléchir la
lumière, et apparaît donc comme une silhouette
noire totalement insensible à la luminosité de la
scène. Pour éviter ce désagrément, Blender habille
automatiquement tout objet qui en est dépourvu
d’un matériau par défaut, aisément reconnaissable :
un gris évoquant vaguement l’aspect du plastique.
Donc, même si vous ne spécifiez pas de matériau à
votre objet, il apparaîtra malgré tout sur vos rendus.

Figure 5–6
La scène qui va servir de base à nos tests
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contours des objets dans les reflets. Bien sûr, les calculs supplémen-
taires pénaliseront les temps de rendu.

• Only Cast : l’objet projettera des ombres, mais restera invisible au
rendu.

Quelques options du panneau Material
Le panneau Material présente plusieurs options à activer. Les plus cou-
ramment utilisées sont expliquées ici.
• VCol Light : cette option permet de prendre en compte les couleurs

issues de la peinture sur sommets (vertex painting) comme informa-
tions d’éclairage. À activer absolument si vous voulez jouer avec le
moteur de radiosité (voir l’aparté Le saviez-vous ? La radiosité précal-
culée au chapitre 6, Techniques d’illumination).

• VCol Paint : cette option permet de prendre en compte les couleurs
issues de la peinture sur sommets comme information de couleur de
base, supplantant ainsi la couleur de base définie dans l’onglet Material.

• Tex Face : cette option permet de prendre en compte une image UV
en remplacement de la couleur de base définie dans l’onglet Material
(voir la section Le dépliage UV dans ce même chapitre).

• Shadeless : cette option assure que l’objet soit toujours parfaitement
illuminé, quel que soit l’éclairage de la scène. Ainsi, la couleur
observée est toujours la couleur diffuse du matériau, sans tenir
compte d’éventuels ombrages.

• No Mist : cette option permet à l’objet d’être pleinement visible,
même si un brouillard doit normalement l’occulter, partiellement ou
totalement.

• Env : cette option permet à l’objet d’être totalement transparent et
révéler le World d’arrière-plan (voir la section Blender et la transparence).

Le shading
Nous avons jusqu’à présent défini la couleur de base du matériau (la cou-
leur diffuse) mais nous n’avons pas encore spécifié comment celle-ci
répond à une source d’illumination. C’est le propos de l’onglet Shaders.
Celui-ci présente en particulier des ascenseurs, correspondant respecti-
vement au shader diffus et au shader spéculaire. Chaque shader a ses pro-
pres spécificités.

3DS MAX, XSI, MAYA   Textures nodales

Blender présente la possibilité de composer des
matériaux et des textures en utilisant un éditeur
nodal, mais il sera pour quelques temps encore,
très en retrait des possibilités des applications
commerciales dans le même domaine. Il faudra
donc attendre encore un peu pour voir quelque
chose de réellement époustouflant, mais l’on peut
déjà se réjouir de savoir que l’éditeur nodal propo-
sera également des fonctions intéressantes pour la
création d’images composites.

Figure 5–7
Le panneau Shaders
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Shaders diffus
Ce sont des shaders qui déterminent la façon dont la lumière est reflétée
par le matériau ; le comportement peut en effet différer dans la mesure
où certains matériaux absorbent plus la lumière que d’autres et que
l’angle incident entre le rayon de lumière et la normale à l’objet peut éga-
lement influer.
• Lambert : il s’agit du shader par défaut de Blender. Son paramètre Ref

(qu’il partage avec tous les autres shaders) détermine la quantité de
lumière reflétée, et donc perçue par un observateur. De faibles valeurs
conduisent à des matériaux sombres ; des valeurs élevées à des maté-
riaux clairs.

• Oren-Nayar : ce shader permet de faire varier la réflexion de la lumière
en tenant compte de la rugosité en surface du matériau ; une matière
poreuse ou rugueuse aura tendance à renvoyer moins de lumière, au
contraire d’un matériau poli ou parfaitement lisse (verre, miroir). Il
admet un paramètre supplémentaire témoignant de la rugosité du
matériau : Rough. Ce paramètre ne vous dispense toutefois pas de
modéliser ou d’utiliser une texture pour simuler véritablement la
rugosité de surface.

• Minnaert : ce shader est une variante de Lambert. Grâce à un
paramètre Dark supplémentaire, il éclaircit ou assombrit les surfaces en
tenant compte de la normale locale à l’objet, de l’angle du rayon lumi-
neux et de l’angle d’observation. Une valeur égale à 1.000 correspond

3DS MAX   Les shaders

Pour l’essentiel, les shaders de Blender sont assez proches de ceux proposés par 3ds max :
Blinn, Oren-Nayar, Phong, par exemple. D’autres sont assez similaires, comme Minnaert
qui peut se rapprocher de Strauss dans la gamme d’effets. Ombrage Translucide n’a pas
d’équivalent direct mais un paramètre Translucidity existe dans le panneau Shaders de
Blender. À noter enfin, Anisotrope peut être simulé grâce au type de texture
procédurale Radial Blend ou tout simplement l’option Tangent V de l’onglet Shaders.

Figure 5–8
Lambert, le shader par défaut de Blender,

avec une valeur Ref faible à gauche
et élevée à droite

BON À SAVOIR   L’option Cubic

Si vous avez plusieurs lampes dans votre scène, il
se peut que des bandes ombrées apparaissent à la
surface de vos objets, marquant les frontières nor-
males d’éclairage de chaque lampe individuelle. Si
ce phénomène est le plus souvent discret, il est
particulièrement visible à la surface de primitives
simples (UVsphere, par exemple). L’option
Cubic du panneau Shaders assure des transi-
tions plus douces en interpolant les valeurs dif-
fuses des points à la surface des objets.
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exactement au modèle de Lambert. Mais des valeurs de Dark supé-
rieures assombriront les silhouettes des objets, leur donnant une appa-
rence plus métallique et mettant en valeur les spéculaires ; au contraire,
des valeurs de Dark inférieures à 1.000 éclairciront ces mêmes sil-
houettes, aidant à simuler des matériaux comme la soie ou le velours.

• Fresnel : ce shader utilise le même algorithme que pour la détermina-
tion de l’effet Fresnel dans le cadre de reflets ou de transparence. Il
affecte principalement l’illumination des contours opposés aux
sources lumineuses, et est piloté par deux paramètres : Fresnel et Fac,
le premier définissant l’intensité de l’effet, le second la proportion
suivant laquelle le shading de l’objet est affecté. Le shader Fresnel est
utile pour illuminer les surfaces sombres des objets.

Figure 5–9
Le shader Oren-Nayar avec une rugosité 
élevée à gauche, et très faible à droite

Figure 5–10
Deux tests du shader Minaert, avec la même 
valeur de Ref : à gauche, une valeur Dark 
faible et à droite, une valeur Dark élevée

Figure 5–11
À gauche, un test du shader Lambert
et, à droite, le même avec le shader Fresnel ; 
l’illumination diffuse affecte surtout les facet-
tes ayant un angle d’incidence très ouvert 
entre la direction d’éclairage et la normale 
à la facette.
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Shaders spéculaires
Les taches spéculaires sont les reflets lumineux que l’on peut observer à
la surface des objets soumis à un éclairage vif. Les shaders qui suivent
vont régler le comportement de ces rehauts lumineux.
• CookTorr : il s’agit du shader spéculaire par défaut de Blender. Le

paramètre Spec détermine l’intensité du rehaut spéculaire ; plus la
valeur sera élevée, plus le rehaut sera visible à la surface de l’objet,
indiquant un objet brillant. Le paramètre Hard indique la dureté du
rehaut à sa frontière : une valeur basse indiquera une frontière très
floue, et donc un rehaut très étendu.

• Phong : il s’agit d’un modèle très proche de CookTorr, sauf qu’il est un
peu plus adapté à la simulation des spéculaires de matériaux plasti-
ques. Il possède les deux mêmes paramètres Spec et Hard.

• Blinn : ce shader spéculaire est à utiliser conjointement avec le shader
diffus Oren-Nayar. Il met en œuvre un paramètre supplémentaire Refr
qui indique l’indice de réfraction du matériau. Vous trouverez en
annexe C les indices de réfraction d’un certain nombre de matériaux,
mais il faut comprendre que ce paramètre n’intervient pas du tout dans
la réfraction de la lumière au travers d’objets transparents. Il s’agit là du
travail du moteur de rendu et en particulier du lanceur de rayons.

• WardIso : à l’instar de Phong, ce shader est particulièrement approprié
au rendu de rehauts spéculaires sur matériaux plastiques mais plus
spécialement sur ceux qui sont brillants.

Figure 5–12 De gauche à droite, des valeurs moyennes de Spec et de Hard, 
puis une valeur de Spec plus élevée, puis des valeurs de Spec et Hard élevées

LE SAVIEZ-VOUS ?   Réflexion diffuse 
et réflexion spéculaire

L’intensité de la couleur diffuse est déterminée en
fonction de l’angle entre la normale à l’objet au
point considéré et la direction de la lumière qui
rebondit à sa surface (l’angle d’observation ne
joue aucun rôle) : plus l’angle sera ouvert, moins
l’intensité sera importante et le point considéré
sera donc assombri. Au contraire, plus l’angle sera
fermé et plus l’intensité sera élevée, et le point
considéré éclairci.
La réflexion spéculaire est au contraire dépen-
dante de l’angle d’observation, puisque l’intensité
du rehaut spéculaire est à son maximum lorsque la
réflexion sur la face observée pointe vers la source
lumineuse.
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Figure 5–13
Comparatif entre les shaders Phong à gauche 
et WardIso à droite, les deux étant dédiés 
à des matériaux plastiques

Le rendu Tangent

Un bouton supplémentaire, Tangent V dans l’onglet Shaders, permet d’ignorer les normales
à la surface lors du rendu, pour les remplacer par le vecteur de la direction de la facette, adop-
tant ainsi un shading de type anisotrope. Ce type de shader convient parfaitement à la simula-
tion de métal brossé, tourné ou fraisé, pour lequel les marques d’usinage provoquent des
petites crevasses qui vont orienter les reflets spéculaires. À noter qu’il est préférable de réa-
liser le dépliage UV de l’objet pour que le shader puisse interpréter la direction tangente
(Blender est toutefois capable de dériver cette information d’une texture Orco, si elle est dis-
ponible, auquel cas la tangente s’alignera toujours sur l’axe Z), et que cela ne fonctionnera
pas pour les objets de type Curve ou Surface, bien que des améliorations seront probable-
ment apportées sur ce dernier point dans le futur.

Figure 5–14 Exemple de métal brossé, par Claas Kuhnen, http://www.ckbrd.de 
illustration tirée des Release Logs de Blender 2.42
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Autres paramètres liés aux shaders

La translucidité (TransLu)
Il s’agit d’un phénomène surtout lié aux objets dont les parois sont très
fines, comme les membranes, certains vêtements, les abat-jour et autres.
Grâce à cette propriété, lorsqu’une lumière est placée derrière (ou à l’inté-
rieur de) l’objet, celui-ci laisse passer une part de la luminosité. À noter,
pour que la lumière puisse éclairer au-delà de l’objet, il est nécessaire que
l’objet translucide ait un minimum de transparence (paramètre Alpha (A)
dans l’onglet Material) et que tous les objets susceptibles d’être éclairés
aient leur bouton optionnel TraShadow activé dans l’onglet Shaders.

L’émittance (Emit)
Ce paramètre détermine la quantité de lumière émise par l’objet, le ren-
dant plus ou moins visible même en l’absence de lampe, comme s’il lui-
sait d’une lumière propre.

Attention, l’objet ne peut éclairer une scène au travers de ce paramètre
qu’au cours du rendu d’une solution de radiosité (voir chapitre 6, Techni-
ques d’illumination). Attention, encore, car même de petites valeurs du
paramètre Emit ont alors tendance à saturer la luminosité de l’objet.

Figure 5–15 Une lampe et une cage en fer 
sont placées à l’intérieur du cube et de la 

sphère, mettant en évidence leur translucidité.

Figure 5–16
Le paramètre Emit rend l’objet distinguable

même en l’absence de lumière.

Figure 5–17
Luminosité saturée avec

un paramètre Emit de faible valeur
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Les rampes de couleur
Certains matériaux peuvent présenter des variations de couleur plus ou
moins marquées en fonction de la luminosité reçue ou de l’angle incident
d’un rayon de lumière. Si le shader Minnaert prend partiellement en compte
ce type de phénomène, les rampes de couleur (Ramp colors) ont été dévelop-
pées pour répondre à ce type de problématique. En cliquant sur l’onglet
Ramps, vous accédez à de nouvelles options vous permettant de régler une
rampe de couleur, soit pour la couleur diffuse du matériau (option Show Col
Ramp), soit pour la couleur de son spéculaire (option Show Spec Ramp).
L’activation de la rampe se fait au travers du bouton Colorband. Apparaît
alors une bande de couleur, transparente à son extrémité gauche (curseur
n° 0) et bleue à son extrémité droite (curseur n° 1).

Il est possible d’ajouter des curseurs à la position de votre choix sur la
bande (petit bouton Add et détermination de la position grâce au
curseur Pos). Un curseur est représenté par une barre verticale sur la
rampe, qui peut être sélectionnée grâce au bouton gauche de la souris. La
combinaison de touches [Ctrl] et bouton gauche permet d’ajouter d’autres
curseurs à l’endroit où vous aurez cliqué. À chaque curseur peuvent être
associées les valeurs habituelles R, G, B et A. Si A est actif, la rampe laisse
apparaître la couleur de base du matériau (ou sa texture éventuelle) sous sa
propre couleur. Le petit bouton Del permet de supprimer le curseur actif ;
celui-ci peut être sélectionné grâce au bouton numérique Cur. Par défaut,
le gradient entre deux curseurs est linéaire (petit bouton L activé). Le fonc-
tionnement de la rampe au moment du rendu est défini par trois options
supplémentaires : Input, Method et Factor. À noter que Input permet de
déterminer si la rampe ne prend en compte que le shading de base du
matériau (option Shader), ou si elle tient également compte de l’énergie
d’éclairage également reçue (option Energy), entre autres possibilités.

Le rendu Toon
Des shaders tant diffus que spéculaires permettent de s’éloigner des
autres shaders, basés sur des modèles réalistes, afin d’obtenir des rendus
pour lesquels les frontières ombre-lumière sont très marquées, comme
dans les bandes dessinées ou les dessins animés. Ce sont les shaders Toon.
Ils ont, dans l’onglet Shaders, des paramètres supplémentaires qui leur
sont propres, permettant de régler, pour le shader diffus, la taille de la
zone éclairée et la dureté de la frontière et, pour le shader spéculaire, la
taille de la tache spéculaire ainsi que la dureté de sa frontière. Le tracé des
silhouettes est le fait d’un post-traitement et non pas d’un quelconque
shader. Pour activer le tracé des contours, il faut vous rendre dans les
Render buttons du menu Scene (touche [F10]) ; là, dans l’onglet Output,

3DS MAX   Rampe dégradée

Il s’agit d’une texture 2D qui permet de créer des
effets très variés au moyen de nombreuses cou-
leurs, textures et fusion, au choix de l’utilisateur.
Les Ramp colors de Blender en sont l’équivalent,
bien qu’elles ne permettent que de créer des effets
à base de couleurs.

ASTUCE   Solutions au problème 
« Terminator »

Lorsque la forme de l’objet génère des ombres sur
lui-même, il arrive qu’à la frontière entre zone
éclairée et zone sombre, la transition soit abrupte
et en forme d’escalier. Ce phénomène est bien
connu par les artistes 3D sous le nom de Termi-
nator problem.
Le bouton Bias de l’onglet Shaders permet de
résoudre ce problème : il suffit simplement de
l’activer. Mais pour certains types de shaders
diffus utilisant des options « extrêmes », comme
Fresnel ou Tangent, il ne suffit pas. Le bouton
glissière S Bias (dans l’onglet Shaders) a été
ajouté pour permettre de mieux contrôler la transi-
tion entre zones ombrées et zones éclairées sur les
objets qui bénéficient de ces shaders.

3DS MAX   Rendu Toon

3ds max ne propose pas le rendu Toon par défaut.
Il vous faut passer par un moteur de rendu tiers,
comme Final Render ou Vray. Le module Final Toon
de Final Render est particulièrement efficace, com-
paré à celui de Vray. Blender, en revanche, offre la
possibilité de réaliser des rendus Toon très facile-
ment (voir la section Le rendu Toon dans ce
même chapitre).
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activez le bouton Edge. En cliquant sur Edge Settings, vous invoquez une
fenêtre qui permet de régler plus précisément l’effet.

Il vous y sera possible de déterminer l’intensité de l’effet (Eint) ce qui
revient plus ou ou moins à définir l’épaisseur du trait, ainsi qu’à stipuler
la couleur des traits.

Le rendu de halos
Vous pouvez activer l’option Halo dans la liste des options du
panneau Links and Pipeline. Ce faisant, les faces de l’objet ne seront plus
rendues, mais chaque sommet sera remplacé par un petit halo lumineux,
montrant ainsi une constellation ordonnée de lumières. Attention, ces
halos ne sont pas en mesure d’éclairer la scène, ils sont ajoutés à l’image
finale à titre de post-traitement.

Par défaut, un halo est une petite sphère lumineuse aux frontières
diffuses ; sa taille est déterminée par le paramètre HaloSize, et la dureté
de ses contours (qui lui donne un effet de transparence) par le
paramètre Hard. Le curseur Add permet de déterminer la proportion
selon laquelle les couleurs du halo sont ajoutées aux couleurs de l’arrière-
plan, plutôt que simplement mélangées à celles-ci. Les options Rings
(anneaux), Lines (lignes), Star (étoile) sont autant d’options changeant

Figure 5–18 Panneau de réglage du rendu Toon Figure 5–19 Exemple de rendu Toon

3DS MAX   Rendu de halos

3ds max permet de créer des effets de halo de deux
façons distinctes : par ajout d’un effet dans la scène
même, auquel cas l’effet sera également visible
dans les reflets et la réfraction de la lumière au
moment du rendu ; par post-traitement de l’image,
après le rendu. Blender n’est à ce jour capable que
de cette seconde méthode (voir la section Le
rendu de halos dans ce même chapitre).

Figure 5–20
Le panneau Shaders lorsque

l’option Halo est active



5 
– 

M
aî

tr
ise

r l
es

 m
at

ér
ia

ux
 d

e 
Bl

en
de

r

© Groupe Eyrolles, 2008 157

l’apparence du halo. Halo Tex permet d’adjoindre une texture au halo,
tandis que Halo Puno utilise la normale au sommet pour déterminer les
dimensions du halo. L’option Flares appelle à son tour de nouvelles
options, permettant de simuler les éclats de lumière colorés que l’on
obtient en filmant le soleil ou une autre source intense de lumière.

Les halos sont pratiquement incontournables lorsqu’il s’agit de simuler
des flammes, de la fumée, des étincelles ou d’autres phénomènes de ce
type grâce aux systèmes de particules (voir le chapitre 7, Techniques
d’animation fondamentales). À ce titre, le paramètre Alpha (A) du
panneau Material peut aider à donner à vos halos une substance encore
plus éthérée, et en cas de soucis au moment du rendu, vous pouvez
essayer avec l’Unified Renderer (option de rendu présente dans le
panneau Format des Render buttons du menu Scene, touche [F10]). Enfin,
l’option Soft leur confère une apparence plus volumétrique, en particulier
lorsqu’ils interceptent d’autres objets.

La peinture sur sommets
Il s’agit d’un mode spécial qui vous permet de peindre des couleurs directe-
ment sur votre objet, dans la vue 3D. Tout d’abord, avec l’objet sélectionné,
bien entendu, activez l’option VCol Paint dans l’onglet Material. Dans le
sélecteur de mode, choisissez Vertex Paint. Un nuancier apparaît aussitôt
dans la vue 3D, et le curseur de la souris se change en petit pinceau.

Dans le menu Editing (touche [F9]) un panneau Paint a fait son appari-
tion. Vous pouvez en faire usage pour régler la taille du pinceau, définir
son opacité, le mode de mélange des couleurs, etc. Vous noterez en par-
ticulier l’existence du bouton Set VertCol qui permet d’attribuer à tous les
sommets la couleur courante, ce qui sera utile pour définir une couleur
de base à partir de laquelle élaborer votre peinture.

Ce type de coloration reste grossière, à moins de peindre sur un maillage
finement subdivisé ; c’est la condition à la possibilité de peindre des
détails de petite dimension ! C’est pourquoi vous préférerez générale-
ment déplier votre objet et peindre une véritable texture, soit grâce au
mode Texture Paint, soit grâce à un logiciel externe tel que Gimp.

Figure 5–23
Le panneau Paint

Figure 5–21 Exemple de rendu de halo

Figure 5–22 Sélection du mode 
Vertex Paint, soit peinture sur sommets
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La peinture sur sommets est toutefois une technique attractive car elle
rend des services que l’on imagine pas forcément au premier abord :
• avec l’option VCol Light active, elle permet de corriger l’illumination

de votre modèle ou, plus subtil, de simuler un effet de SSS ;
• avec l’option VCol Paint, elle permet de corriger la tonalité ou les

nuances d’objets recevant déjà une texture en projection.

Reflets et transparence
Le réalisme d’une scène repose souvent sur de petits détails que l’on voit
sans forcément les enregistrer tous les jours : un petit objet réfléchissant
dans lequel on pourrait s’observer si l’on s’en donnait la peine ; un verre
transparent, au travers duquel on observe un environnement déformé
par l’épaisseur et la courbure du matériau. Même s’il est possible de
construire des scènes entières sans reflets ou éléments transparents, ce
sont des « accessoires de rendu » très couramment mis à contribution.

Figure 5–26
Exemple de réalisation

de peinture sur sommets

BON À SAVOIR   Qu’est-ce que le raytracing ?

Le raytracing est une méthode de rendu à part, qui consiste, pour chaque point de l’image
finale, à lancer un certain nombre de rayons depuis la caméra. Lorsqu’une surface est inter-
ceptée, un certain nombre d’autres rayons sont lancés, tout d’abord en direction de chaque
lampe, pour voir si le rayon atteint la lampe (le point rendu est alors illuminé) ou non (il est
dans une zone d’ombre). Si la surface est réflective, un nouveau rayon est lancé selon la nor-
male à l’objet pour récupérer la couleur de son environnement. Si la surface est transparente,
un nouveau rayon est lancé pour déterminer la couleur du premier objet situé immédiatement
derrière lui (éventuellement, le rayon sera dévié en fonction de l’indice de réfraction du maté-
riau). Plusieurs objets voisins peuvent se réfléchir les uns les autres ; plusieurs objets transpa-
rents peuvent être disposés les uns derrière les autres ; plusieurs lampes peuvent éclairer le
même sujet. Plus votre scène contiendra de tels éléments, plus le moteur de rendu lancera de
rayons, et plus le temps de rendu sera long. Le moteur de rendu interne à Blender est hybride ;
cela veut dire qu’il utilise la méthode du scanline pour tous les points de l’image, et n’utilise
la méthode du raytracing que lorsqu’il y est explicitement invité.

ASTUCE   Mise en place de calques 
pour la peinture sur sommets

Il est possible d’attribuer à un maillage plusieurs
calques distincts pour la peinture sur sommets.
Cela permet, par exemple, d’avoir un calque pour
colorer le maillage et un calque pour stocker le
résultat d’une simulation de radiosité.

Figure 5–24 Le panneau Mesh

Les contrôles sont placés dans le menu Editing,
touche [F9], dans le panneau Mesh. La rubrique
Vertex Color contient un bouton New qui
permet d’ajouter de nouveaux calques : le bouton
bleu-vert détermine le calque actif, le bouton avec
la croix permet de le supprimer. Le calque actif est
affiché dans la vue 3D et disponible pour édition.

Figure 5–25
L’onglet Mirror Transp
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L’onglet Mirror Transp met à votre disposition quelques contrôles pour
agir sur la réflectivité et/ou la transparence de vos objets. Pour fonc-
tionner de façon optimale, ils font appel au raytracing. Il s’agit d’une
option sous forme de bouton Ray à activer dans le panneau Render des
Render buttons, dans le menu Scene (touche [F10]).

Les options de réflectivité
Un objet ne peut être réflectif que si l’option Ray Mirror est active. En ce
cas, la valeur du curseur RayMir détermine l’importance que prend le
reflet à la surface de l’objet : une valeur de 0.00 indique qu’aucun reflet
n’est visible, tandis qu’une valeur de 1.00 suggère une réflectivité par-
faite, comparable à celle d’un miroir ou d’un objet chromé. Dans le cas

BON À SAVOIR   L’échantillonnage Quasi Monte-Carlo

Blender se sert des méthodes de Monte-Carlo pour « échantillonner »
l’environnement d’un point donné. Cela signifie qu’à partir de ce
point, il va lancer un certain nombre de rayons pour savoir, par
exemple :
• si le point est occlus par des objets environnants (occlusion

ambiante) ;
• si le point est dans une zone d’ombre ou de lumière pure, ou dans

une zone d’ombre transitoire (ombres douces) ;
• si le point reflète ou réfracte telle ou telle couleur (réflexions ou

réfractions floues).
Le nombre de rayons lancés à partir d’un point donné correspond le
plus souvent au paramètre Samples de la fonction nécessitant cette
échantillonnage.
Selon les méthodes de Monte-Carlo, l’échantillonnage (densité et direc-
tion des rayons) est purement aléatoire, ce qui peut conduire à une dis-
tribution peu optimale : des points
peuvent être pris trop près les uns des
autres ou, au contraire, des espaces
trop importants peuvent ruiner la qua-
lité finale de l’échantillonnage. Pour
pallier cette difficulté, il existe des
méthodes semi-aléatoires (appelées
« Quasi Monte-Carlo ») pour favoriser
une meilleure distribution des rayons.
Parmi ces méthodes figurent :
• Constant QMC (ou séquen-

çage de Hammersley) : les
échantillons sont régulièrement
espacés et produisent un résultat
très constant ;

• Adaptive QMC (ou séquençage de Halton) : les échantillons
sont pris les uns après les autres en fonction des besoins, en com-
plétant les besoins là où ils se font sentir.

Là où le nombre d’échantillons spécifiés est systématiquement con-
sommé avec la méthode Constant QMC, seuls les échantillons réel-
lement nécessaires sont prélevés par la méthode Adaptive QMC, ce
qui autorise parfois des gains significatifs de temps de calcul (le para-
mètre Threshold est alors le critère d’arrêt de l’échantillonnage).
Malheureusement, ils sont moins régulièrement espacés et il y a des
cas où l’échantillonnage, par la méthode Constant QMC, produira
de meilleurs résultats, en des temps de calcul équivalents.
L’échantillonnage adaptatif est systématiquement utilisé pour le calcul
des réflexions et réfractions floues. Pour les ombres douces et l’occlu-
sion ambiante, il est possible de choisir entre Constant QMC et
Adaptive QMC.

Figure 5–27 Illustration de la densité et de la distribution des points pour les méthodes 
de Monte-Carlo (à gauche, totalement aléatoire), Adaptive QMC (au centre, répartition 

s’adaptant d’elle-même) et Constant QMC (à droite, répartition semi-aléatoire très régulière)
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où plusieurs objets sont susceptibles de se refléter les uns les autres, il
convient de limiter le nombre de rebonds qu’effectuera un rayon lors de
la détermination du reflet ; cette limite est définie par le paramètre Depth
(profondeur de réflexion).

La couleur de base de l’objet peut teinter la couleur des reflets ; il suffit
de spécifier pour le paramètre Mir (dans l’onglet Material) la couleur en
question.

Les réflexions floues
Les réflexions à la surface des objets ne sont toutefois pas toujours
nettes, généralement à cause de la légère granularité ou porosité des
matériaux. En effet, seuls les matériaux les plus lisses offrent une parfaite
netteté des reflets. Les matériaux plus rugueux, même s’ils sont brillants,
présentent des reflets plus flous comme, par exemple, les bois vernis ou
les carrelages, en fonction de l’esthétique recherchée. À noter que cette
perte de netteté est d’autant plus importante que la distance est grande
entre l’objet brillant et le point reflété.

• Gloss : ce paramètre définit la brillance du reflet. Une valeur de 1.000
correspond à un reflet parfait, et des valeurs progressivement infé-
rieures introduisent un phénomène de flou de plus en plus marqué.

Figure 5–29
Le sujet de la scène

est paré de ses reflets.

Figure 5–28
Exemple d’usage de l’option Ray Mirror

LE SAVIEZ-VOUS ?  
L’effet Fresnel des matériaux réflectifs

Il s’agit d’un effet d’optique qui est très courant dans
notre environnement pour peu que l’on y prête
attention. À cause de cet effet, un objet n’est réflectif
que lorsque l’angle incident entre la normale à
l’objet et l’angle d’observation atteint une certaine
valeur ; cette valeur est symbolisée par le paramètre
Fresnel, la transition entre zones reflétées et non
reflétées étant assurée par le paramètre Fac.

Figure 5–30
Exemple de matériaux dont les reflets sont

flous. À gauche, une valeur Gloss de 0.85 et à
droite, une valeur de 0.75 : il n’est pas néces-

saire d’avoir des valeurs très basses pour obte-
nir des reflets déjà très flous !
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• Aniso : définit la forme du point reflété. Avec une valeur de 0.000, il
est parfaitement circulaire, tandis qu’avec 1.000, il est totalement
étiré dans la direction de la tangente. Cela permet de simuler des sha-
ders réflectifs anisotropiques, par exemple.

• Samples : définit le nombre d’échantillons lancés depuis le point
réflectif pour déterminer sa couleur moyenne finale. Plus le nombre
d’échantillons est important, plus le temps de rendu augmente.

• Threshold : il s’agit du seuil pour l’échantillonnage adaptatif. Si un
échantillon contribue moins à la couleur du point que la valeur indiquée
(exprimée en pourcentage), l’échantillonnage est interrompu afin d’éco-
nomiser du temps de calcul. Des valeurs très basses permettent d’obtenir
des reflets très fidèles, mais au prix d’un temps de rendu plus long.

• Max Dist : il s’agit de la distance maximale que les rayons d’échan-
tillonnage sont autorisés à parcourir. Au-delà de celle-ci, le rayon se
voit attribuer la couleur de fondu spécifiée ci-après.

• Ray end Fade-out : ce menu déroulant détermine la couleur prise par
un rayon s’il parcourt une distance plus longue que le paramètre Max
Dist. Avec Fade to Sky Color (à utiliser de préférence dans les scènes
d’extérieur), le point prendra la couleur du ciel (composante
Horizon : HoR, HoG, HoB) ; avec Fade to Material Color (option plus
appropriée aux scènes d’intérieur), il prendra au contraire la couleur
propre du matériau (probablement un mélange de Col et de Mir, en
fonction de la valeur RayMir).

Les options de transparence
Un objet n’est transparent que si sa valeur Alpha (A) est différente de
1.00 : une valeur proche de 0.00 indique un objet presque invisible et
une valeur égale à 1.00 un objet totalement opaque. Activez l’option Ray
Transp pour tirer parti d’une transparence calculée en raytracing. La
valeur IOR correspond à l’indice de réfraction du matériau (vous trou-
verez une liste complète d’indices de réfraction courants en annexe), et
Depth détermine le nombre de surfaces transparentes qu’un rayon doit
traverser. Si vous rencontrez des taches noires dans vos matériaux trans-
parents, ou si vous avez beaucoup d’objets transparents les uns derrière
les autres dans votre scène, n’hésitez pas à augmenter ce paramètre.

Figure 5–31
Exemple d’utilisation 
des options de réflexion floue

Figure 5–32
Exemple d’usage de l’option Ray Transp
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La valeur Filter permet de teinter dans la masse le matériau transparent,
plutôt que de laisser la couleur de l’objet se mélanger à celle de son
arrière-plan. Par exemple, une bouteille de vin verte teintera de vert les
objets de l’arrière-plan. En quelque sorte, Filter est aux objets transpa-
rents ce que la couleur Mir est aux objets réfléchissants.

Blender et la transparence
Blender supporte trois types de transparence, le choix entre ceux-ci étant
affaire de compromis.
• La transparence Alpha : la couleur de l’objet est mélangée à la couleur

du World de façon inversement proportionnelle à la valeur Alpha. Cette
méthode est rarement réaliste, mais c’est la plus simple et la plus rapide
à calculer. C’est celle employée par défaut par le moteur de rendu.

• La transparence Ztransp : la couleur de l’objet est mélangée à la cou-
leur de son arrière-plan de façon inversement proportionnelle à la
valeur Alpha. Cette méthode est un peu moins rapide, et reste réaliste
tant que le matériau ne doit pas provoquer la réfraction de la lumière
(les objets en arrière-plan ne seront jamais déformés au travers du
matériau). Pour employer cette méthode, activez l’option ZTransp
dans l’onglet Links and Pipeline.

Figure 5–34
En vert bouteille, notre sujet

produit un bel effet...

BON À SAVOIR   La transmissivité des matériaux transparents

Blender prend en compte la transmissivité des matériaux, ce qui implique qu’un rayon de
lumière traversant un objet transparent est progressivement filtré, tendant à renforcer l’aspect
compact des objets épais. De même, la « densité » de son ombre sera affectée par cette pro-
priété, si le bouton TraShadow est actif. Deux nouveaux paramètres font leur apparition
dans l’onglet Mirror Transp pour utiliser cette fonctionnalité :
• Limit définit la profondeur limite de transmissivité ; une valeur de 0.0 désactive la trans-

missivité, une valeur de 100.0 étant le maximum (ainsi que la valeur recommandée) ;
• Falloff détermine la progression de l’effet, une valeur de 1.0 indiquant une progression

linéaire. Avec une valeur de 2.0, par exemple, la visibilité au travers du matériau va être
troublée plus rapidement, et avec une valeur inférieure à 1.0, l’effet sera si subtil qu’il
sera difficile à observer.

L’effet Fresnel des matériaux 
transparents

Il fonctionne de la même façon que pour les objets
réflectifs, à l’exception que l’objet devient opaque
lorsque l’angle incident entre la normale à la surface
et l’angle d’observation atteint une certaine valeur.

3DS MAX   Matériau multi-objet
et sous-objet

Ce matériau de 3ds max permet d’affecter différents
matériaux au niveau des sous-objets de la géomé-
trie à mettre en couleurs. Son usage est équivalent
en termes de résultats à celui des indices de maté-
riau de Blender lorsqu’il s’agit, par exemple,
d’affecter un matériau différent par face d’un cube.

Figure 5–33
Exemple d’utilisation des options 

de filtrage et de transmissivité
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• La transparence Ray Transp : la couleur de l’objet est mélangée à la cou-
leur de son arrière-plan de façon inversement proportionnelle à la
valeur Alpha, l’image observée au travers du matériau étant éventuelle-
ment déformée par son indice de réfraction. C’est la méthode la plus
réaliste, mais malheureusement aussi la plus longue à calculer. Pour
l’employer, activez l’option Ray Transp dans l’onglet Mirror Transp.

La réfraction floue
Si vous avez tout assimilé concernant les réflexions floues, vous n’aurez
aucune difficulté à comprendre ce dont il s’agit ici : la réfraction floue
permet de simuler la pureté cristalline du matériau transparent. Idéale-
ment, il est parfaitement homogène mais, concrètement, il contient
peut-être des microbulles ou des défauts cristallins qui rendent floues les
images observées au travers de celui-ci.

Les paramètres ne sont guère différents de ceux des réflexions floues.
• Samples : définit le nombre d’échantillons lancés depuis le point trans-

parent pour déterminer sa couleur moyenne finale. Plus le nombre
d’échantillons est important, plus le temps de rendu augmente.

• Threshold : il s’agit du seuil pour l’échantillonnage adaptatif. Si un
échantillon contribue moins à la couleur du point que la valeur indiquée
(exprimée en pourcentage), l’échantillonnage est interrompu afin d’éco-
nomiser du temps de calcul. Des valeurs très basses permettent d’obtenir
une transparence plus fidèle, mais au prix d’un temps de rendu plus long.

La dispersion subsurfacique (SSS)
Il existe plusieurs méthodes pour simuler la dispersion subsurfacique : le
vertex painting en est une, les nœuds matériaux en sont une deuxième, et
il existe même des scripts Python alliant une ou plusieurs de ces

Figure 5–35
Exemple de matériaux dont la transparence 
est floue. À gauche, une valeur Gloss de 0.90 
et à droite, une valeur de 0.85 : à nouveau, 
il n’est pas nécessaire d’avoir des valeurs très 
basses pour obtenir des résultats très flous !

Figure 5–36
Exemple d’utilisation 

des options de réfraction floue
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méthodes. Mais Blender propose également un algorithme de shading
permettant d’en simuler les effets, de façon relativement réaliste mais
surtout rapide.

La dispersion subsurfacique est un phénomène lumineux que l’on peut
observer pour certains matériaux comme la cire, la peau humaine, le marbre
ou encore certains liquides comme le lait. En fait, les rayons de lumière
venant illuminer un tel matériau ne se contentent pas d’être réfléchis par
celui-ci : une partie des rayons passent à travers les couches supérieures du
matériau et se diffusent à travers celui-ci avant de le quitter à un endroit
autre que le point d’illumination directe. Le résultat est une apparence plus
douce, comme si la lumière était rendue floue à la surface du matériau.

La technique est presque simple : elle consiste à établir une carte d’illu-
mination à la surface d’un tel matériau, et de rendre celle-ci plus ou
moins fortement floue tout en filtrant les composantes représentatives
de la couleur interne du matériau.

L’onglet SSS
Le panneau SSS rassemble bien évidemment tous les paramètres néces-
saires à la simulation d’un effet de dispersion subsurfacique. Celle-ci
peut être simplement obtenue en activant l’option Subsurface Scattering,
et en choisissant dans le menu déroulant l’un des nombreux matériaux
prédéfinis qui sont disponibles :
• Custom : il s’agit de l’option par défaut, où l’on attend de l’utilisateur

qu’il paramètre seul l’effet souhaité ;
• Liquides : Whole Milk (lait entier), Skim Milk (lait écrémé) ;
• Peaux : Skin 1 et 2 (peaux humaines plus ou moins hâlées), Chicken

(poulet) ;
• Fruits et légumes : Potato (pomme de terre), Apple (pomme) ;
• Minéraux : Marble (marbre) ;
• Culinaires : Ketchup, Cream (crème).

Bien sûr, ces matériaux prédéfinis ne vous conviendront que rarement
directement. Mais souvent, ce sont d’excellentes bases pour le dévelop-
pement de matériaux personnalisés (Custom), puisqu’il vous suffira de
partir d’un modèle existant et de le modifier légèrement pour obtenir le
résultat souhaité. Par exemple, pour simuler du jade, vous partirez sur la
base de Marble, puis vous modifierez la couleur de dispersion ainsi que sa
composante Radius G.

L’effet SSS va être piloté par plusieurs grandeurs, le plus souvent liées.
• La couleur de dispersion : pour la changer, il faut cliquer sur la bande

de couleur, et le nuancier de Blender fera son apparition.
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• Radius R, G et B : il s’agit de la distance à travers laquelle la lumière va se
disperser dans la matière, ou plus simplement de l’intensité du flou
affectant la carte de lumière. Ce qui est intéressant, c’est qu’il est pos-
sible de spécifier indépendamment la dispersion d’une couleur au travers
de la matière. Par exemple, si vous observez une lampe torche à travers
vos doigts, ceux-ci seront illuminés en rouge : le paramètre Radius R
devra être sensiblement dominant par rapport aux autres.

• IOR : ce paramètre représente l’indice de réfraction, la densité du
matériau. Vous trouverez en annexe C une liste des indices de réfrac-
tion les plus courants, mais n’hésitez pas à enfreindre ces valeurs pour
obtenir le résultat visuel recherché : Blender est avant tout un outil
d’expression artistique.

Les paramètres qui suivent sont propres à la simulation plus qu’à la défi-
nition du matériau. Ils seront généralement identiques pour tous les
objets de votre scène faisant appel à la dispersion subsurfacique, par
souci de cohérence, bien que vous soyez libre de briser celle-ci.
• Scale : les paramètres Radius R, G et B spécifiant la distance de disper-

sion au travers d’un corps, il est nécessaire de donner à Blender une
notion de l’échelle de vos objets.
– Scale 1.000: une unité de Blender égale à un millimètre ;
– Scale 0.100: une unité de Blender égale à un centimètre ;
– Scale 0.010: une unité de Blender égale à un décimètre ;
– Scale 0.001: une unité de Blender égale à un mètre.

• Error : permet de contrôler l’échantillonnage de la lumière à la surface
des objets. Des valeurs élevées permettent une simulation rapide mais
imprécise et pouvant présenter des artefacts. La valeur par défaut,
0.050, devrait donner de bons résultats dans un temps raisonnable
pour un maillage de densité raisonnable. En cours de mise au point,
augmentez cette valeur à 1.000 pour prévisualiser l’effet obtenu, avant
de la ramener à un niveau normal pour les rendus finaux.

Figure 5–37
L’onglet SSS
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L’ambition de ces quelques autres paramètres est de vous aider à con-
trôler le phénomène de dispersion et vous permettre d’atteindre les
résultats souhaités. Souvent, une observation attentive de votre environ-
nement vous mettra sur la voie.
• Col : détermine dans quelle mesure la couleur de dispersion spécifiée

influe sur la couleur de l’objet ; même avec une valeur nulle, cette cou-
leur conservera une part d’influence dans le phénomène de dispersion.

• Tex : détermine dans quelle mesure la texture de l’objet sortira floue
de l’opération ; avec de faibles valeurs, les textures resteront suffisam-
ment nettes pour préserver les détails des textures de visages, par
exemple, que vous auriez peintes avec application.

• Front : facteur d’amplification/atténuation du phénomène de disper-
sion frontale.

• Back : facteur d’amplification/atténuation du phénomène de disper-
sion arrière ; particulièrement utile pour renforcer l’effet de disper-
sion sur un sujet principalement éclairé en contre-jour, par l’arrière.
Typiquement, il s’agit à nouveau du cas où vous saisiriez une lampe
torche dans votre main et observeriez l’illumination rouge à travers
vos doigts.

Figure 5–38
Exemple de figurines en jade,

avec un éclairage rasant
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Des problèmes avec vos matériaux SSS
La dispersion subsurfacique est une technologie encore jeune dans
Blender. Dans un premier temps, le moteur de rendu fait une première
passe au cours de laquelle il enregistre la carte d’illumination de l’objet
avec un matériau SSS. Il est donc tout à fait normal qu’au début du
rendu (la première passe) vous observiez l’apparition d’une image
étrange, avant que le rendu en lui-même ne débute. Mais qu’en est-il des
autres soucis potentiels ?
• Les ombres à l’arrière de mes matériaux SSS sont étranges.

Cause : les lampes en Shadow Buffering par la méthode Irregular ne
produisent pas de bons résultats sur l’arrière des matériaux SSS.
Solution : évitez d’éclairer vos scènes avec des spots en Irregular
Shadow Buffering si vous avez des matériaux SSS.

• La dispersion par l’arrière de votre objet semble chamboulée.
Cause : les normales de votre maillage présentent des problèmes ; elles
doivent être orientées de façon consistante, vers l’extérieur de l’objet.
Solution : en mode Edit, la combinaison de touches [Ctrl]+[N] permet
de recalculer les normales, et le bouton Flip Normals du panneau Mesh
Tools, menu Editing (touche [F9]), permet de les inverser si nécessaire.

• Dans les reflets, la dispersion des objets n’a pas l’air cohérente.
Cause : un matériau SSS observé indirectement (reflet d’un miroir,
réfraction du verre, etc.) peut paraître incorrect si l’objet correspon-
dant n’est pas dans le champ de la caméra.
Solution : modifiez le point de vue de la scène pour ramener le maté-
riau SSS dans le champ de la caméra.

• La dispersion par l’arrière semble manquante !
Cause : pour la simulation, seuls les échantillons de l’avant et de
l’arrière du matériau (depuis le point de vue de la caméra) sont pris en
compte, afin de limiter l’usage de la mémoire et de s’affranchir de
toute géométrie interne.
Solution : évitez les chevauchements d’objets.

Exemple de mise en œuvre du SSS
Ouvrez le fichier exercice-ch05.01-depart.blend contenu dans le réper-
toire /exercices du DVD-Rom. Il contient une scène prédéfinie dont le
sujet principal est Suzanne, la tête de singe. Derrière elle se trouve une
source de lumière, rasante, au niveau du sol, qui devra produire (c’est
l’objectif ) un effet de dispersion arrière. Il y a également une source de
lumière frontale, pour que la scène ne soit pas pleinement en contre-jour.
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Suzanne est déjà sélectionnée. Dans le panneau Links and Pipeline des Mate-
rial buttons, menu Shading (touche [F5]), cliquez sur le bouton Add New et
renommez le bouton MA: Material en MA: Jade_SSS, par exemple. C’est ce
type de matériau que nous allons essayer de simuler. Dans l’onglet Material,
cliquez sur la couleur Col pour afficher le nuancier, ou utilisez les curseurs
pour donner une teinte verte au matériau, par exemple : R 0.690, G 0.810 et
B 0.570. Dans l’onglet SSS, activez le bouton Subsurface Scattering et choi-
sissez Marble dans le menu déroulant. Cliquez sur la couleur de dispersion et
donnez-lui la même couleur que la couleur de base du jade : pour ce maté-
riau, la couleur interne est la même que la couleur externe. Les paramètres
Radius R, Radius G et Radius B conviennent bien à du marbre, sauf que dans
notre cas, nous souhaiterions que la dispersion de la couleur verte soit plus
importante que pour les autres composantes. Commencez par inverser sim-
plement les valeurs Radius R et Radius G. Utilisez une valeur Error égale à
1.000 pour avoir des prévisualisations rapides de l’effet.

Appuyez maintenant sur la touche [F12] pour un premier rendu : la carte
d’illumination est rendue en premier, puis l’image en elle-même, inté-
grant l’effet de SSS sur les trois figurines. On sent déjà assez bien l’effet
sur la figurine du premier plan, mais l’éclairage étant situé juste derrière
cette tête, la couleur de son oreille devrait être un peu plus évanescente.
Nous allons renforcer sa translucidité grâce au paramètre Back que nous
allons porter à 3.000, tout en multipliant par deux la dispersion de la
couleur verte à travers le modèle : Radius G 17.02. Faites un nouveau
rendu : s’il vous satisfait, effectuez le rendu final, en diminuant Error à
0.050 pour avoir une simulation plus fidèle.

Dans les Render buttons, menu Scene (touche [F10]), activez l’OSA avec
une valeur de 16 et spécifiez une pleine échelle de 100 % pour l’image
finale dans le panneau Render ; puis, activez le bouton Do Sequence dans

Figure 5–39
Prévisualisation de l’effet : avec Error 1.000, 
on voit des artefacts au niveau de l’oreille de 
la Suzanne du premier plan.
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le panneau Anim (un effet Glow est prédéfini dans l’éditeur de séquences)
et effectuez le rendu final, touche [F12].

Vous noterez que nous n’avons pas touché à la valeur Scale 0.10 par
défaut, les expérimentations visuelles ayant conduit aux résultats sou-
haités. Le paramètre Scale aurait mérité un peu plus d’attention
toutefois : en imaginant que notre figurine principale fait une vingtaine
de centimètres de haut et qu’elle a été modélisée sur à peu près deux
unités de Blender, il aurait fallu choisir un Scale de 0.010 pour être cohé-
rent, et régler ensuite Radius G et Back pour que l’effet visuel recherché
soit atteint. Mais, Blender, c’est aussi cela : la liberté artistique !

Vous trouverez le résultat corrigé de cet exercice dans le
fichier exercice-ch05.01-final.blend.

Les indices de matériaux
Blender vous offre la possibilité d’attribuer plusieurs matériaux distincts
à un même objet, jusqu’à concurrence de 16 matériaux au maximum. En
fait, chaque facette du maillage peut être individuellement assignée à
l’un des 16 matériaux possibles. La plupart des opérations se déroulent
dans le panneau Link and Materials du menu Editing (touche [F9]), au
niveau du groupe de boutons nommé Material.

Le curseur Mat indique, à gauche, le nombre d’indices matériaux disponi-
bles pour cet objet et, à droite, l’indice actif. Cliquez sur New pour ajouter
un indice matériau, mais pour l’instant, toutes les facettes sont unique-
ment attribuées au premier indice. Passez en mode édition de l’objet, et
sélectionnez les faces devant appartenir au deuxième indice matériau.
Prenez garde à ce que le bouton Mat indique (à droite) le deuxième indice
comme indice courant, puis utilisez le bouton Assign pour lui attribuer les
faces sélectionnées. Le bouton Select ajoute à la sélection en cours toutes
les faces assignées à l’indice matériau courant. De même, le bouton Dese-
lect enlève à la sélection en cours les faces assignées à l’indice courant.
Enfin, le bouton Delete supprime l’indice matériau courant.

Dans le panneau Links and Pipeline du menu Shading (touche [F5]), vous
retrouvez le bouton Mat et vous pouvez sélectionner le matériau de l’indice
courant de la même façon. Vous pouvez alors attribuer à l’indice le maté-
riau de votre choix grâce au sélecteur de matériau, ou en ajouter un nou-
veau. Attention, lorsque vous créez de nouveaux indices, Blender attribue
automatiquement au nouvel indice le matériau actif précédent. Dans
l’onglet Links and Pipeline, vous vous retrouverez donc avec le même maté-
riau pour les deux indices, il ne faudra donc pas vous mélanger.

Figure 5–40 Les faces assignées à l’indice 
matériau n°2 sont sélectionnées.
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Enfin, par défaut, les rehauts spéculaires sur un objet transparent sont
totalement opaques, ce qui sied très bien à des matériaux comme le
verre. Pour d’autres matériaux, ou pour satisfaire des besoins artistiques,
vous aurez parfois besoin de rendre les rehauts spéculaires plus ou moins
transparents. Cela sera simplement possible en diminuant la valeur du
curseur Spec Tra de l’onglet Mirror Transp.

Vous pouvez retrouver le fichier source de cet exemple dans le
répertoire /exercices du DVD-Rom sous le nom exercice-ch05.02-
final.blend.

Les textures
Dans Blender, il est possible de distinguer deux types de textures : les tex-
tures à base d’images et les textures procédurales. À un même matériau, il
est possible d’associer jusqu’à 10 textures différentes (onglet Texture),
chaque texture pouvant être plaquée sur l’objet suivant des règles précises
(onglet Map Input), ou affecter un ou plusieurs canaux (Map To).

• L’onglet Texture présente dix champs vides. Pour ajouter une texture,
choisissez un champ libre et cliquez sur le bouton Add New. Une nou-
velle texture vierge fait son apparition, et vous pouvez la renommer
dans le champ TE:. Deux autres onglets sont présentés, Map Input et
Map To. Utilisez la touche [F6] pour aller dans les Texture buttons du
menu Shading, et définissez le type de texture grâce au menu
déroulant Texture Type.

• L’onglet Map Input permet de définir la façon dont la texture sera pla-
quée sur l’objet. En particulier, vous pouvez définir le centre de la tex-
ture comme coïncidant avec le centre de l’objet (option Orco), ou utiliser
les coordonnées UV de l’objet pour le placement de la texture
(option UV). Si vous utilisez une texture de type Image, vous pouvez
définir la méthode de projection : plane, cubique, cylindrique ou sphé-
rique. Les boutons numériques ofsX, ofsY et ofsZ permettent de décaler
le centre de la texture dans les trois directions. Enfin, les boutons

Figure 5–41 Un premier matériau 
d’apparence métallique, un second basé 

sur une texture Marble assignée au canal Disp

Figure 5–42
Les onglets relatifs à la

gestion des textures dans
les Material buttons
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numériques sizeX, sizeY et sizeZ permettent de redimensionner la texture
dans les trois directions. Attention, il s’agit d’un multiplicateur d’occur-
rence et non pas d’un facteur d’échelle : dans le même espace, sizeX =
sizeY = sizeZ = 2 feront apparaître deux fois la texture (les détails
apparaîtront donc deux fois plus petits). De même, sizeX = sizeY =
sizeZ = 0,5 feront apparaître seulement la moitié de la texture sur le
même espace (les détails apparaîtront donc deux fois plus grands).

• L’onglet Map To permet de définir le canal affecté par la texture. En par-
ticulier, nous noterons les canaux Col (les informations de la texture ser-
vent à colorer la surface de l’objet) et Nor (les informations de la texture
servent à bosseler la surface de l’objet), qui sont les plus utilisés. Lors de
l’usage de textures procédurales, à moins d’utiliser l’option Colorband de
la texture (Texture buttons, onglet Colors), il est possible de définir ici la
couleur qui sera opposée à la couleur de base du matériau.

Les canaux de texture
À l’exception des canaux Col, Csp et Cmir, il suffit, la plupart du temps,
d’avoir une texture en dégradés de gris pour fonctionner avec les canaux ;
un point noir indique une influence nulle de la texture, un point blanc une
influence maximale, et des dégradés de gris une influence comprise entre
les deux extrêmes, proportionnelle à la part de noir et de blanc. Pour les tex-
tures de type Image, le type de projection (onglet Map Input) est essentiel et
conditionnera fortement le résultat final. Pour vos propres expérimenta-
tions, vous trouverez la scène de base pour les images suivantes dans le
fichier exercice-ch05.03.blend du répertoire /exercices du DVD-Rom.

Les principaux canaux sont décrits et illustrés ici.
• Col : les couleurs de l’image sont plaquées sur l’objet, en remplace-

ment de la couleur Col de l’onglet Material. Le curseur Col et le Blen-
ding Mode (par défaut Mix) permettent de doser l’effet de ce canal
(voir figure 5–44).

• Csp et Cmir : les couleurs de l’image permettent de faire respectivement
varier les couleurs Spe et Mir de l’onglet Material. Le curseur Col et le
Blending Mode (par défaut Mix) permettent de doser l’effet de ces canaux.

• Nor, Disp : ces canaux affectent l’aspect de surface de l’objet, en défi-
nissant le bosselage de celui-ci. Les parties sombres de la texture défi-
niront les « creux » de la surface et les parties claires les « bosses » de
celle-ci. À noter que, pour le canal Nor, ce bosselage est purement
visuel, et ne modifie en rien la géométrie de l’objet. Au contraire, le
canal Disp va effectivement déplacer (au moment du rendu) la géo-
métrie de l’objet ; il conviendra alors d’avoir un maillage suffisam-
ment subdivisé pour que le déplacement soit satisfaisant. Les effets
sont respectivement contrôlés par les curseurs Nor et Disp.

Figure 5–43 Une image en noir et blanc 
qui va être utilisée dans différents canaux 

de texture

Figure 5–44 Mise en œuvre du canal Col
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• Ref : ce canal affecte la réflectivité de l’objet, et réfléchira plus ou moins la
lumière en fonction du degradé de gris de la texture ; il sera donc plus
clair quand la texture sera elle-même claire, et plus sombre lorsqu’elle
sera elle-même sombre. L’effet sera contrôlé par le curseur DVar.

• RayMir : la surface de l’objet réfléchira plus ou moins parfaitement
son environnement dans les zones claires de la texture, à concurrence
de la valeur Ray Mir de l’onglet Ray Transp. L’effet sera contrôlé par le
curseur DVar (astuce : essayez RayMir à 0 et DVar à 1, puis inversez les
valeurs)(voir figure 5–46).

• Alpha : la surface de l’objet sera transparente là où la texture sera
sombre, et opaque lorsqu’elle sera claire. La transparence sera à con-
currence de la valeur Alpha (A) définie dans l’onglet Material, et l’effet
est contrôlé par le curseur Var. Dans la plupart des cas, activer
ZTransp ou RayTransp se révélera utile.

• TransLu : la surface de l’objet sera translucide là où la texture sera
sombre, et opaque lorsqu’elle sera claire. La translucidité n’est con-
trôlée par aucun curseur : un point noir de la texture correspond à une
translucidité maximale, et un point blanc à une translucidité nulle.

À noter que certains canaux peuvent être inversés. Ils admettent alors
trois états : activés (bouton enfoncé), désactivés (bouton relâché),
inversés (bouton activé mais texte en jaune).

Figure 5–45
Mise en œuvre des canaux

Nor (gauche) et Disp (droite)

Figure 5–46
Mise en œuvre du canal RayMir

Figure 5–47
Mise en œuvre des canaux

Alpha (gauche) et TransLu (droite)
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Les textures de type Image
Dans les Texture buttons, dans le menu déroulant Texture Type, choisissez
Image. Un nouveau panneau intitulé Image apparaît. Cliquez sur le
bouton Load Image, choisissez une image sur votre disque dur et validez.
L’image apparaît dans l’onglet de prévisualisation.

Par défaut, les boutons MipMap et InterPol du panneau Map Image sont
activés. Le curseur numérique Filter permet de filtrer l’image : des valeurs
supérieures à 1.000 conduiront au placage sur l’objet d’une version floue
de l’image, des valeurs inférieures produiront un tracé plus net.

Figure 5–48 Les panneaux relatifs à une texture de type Image

BON À SAVOIR   Les images et la transparence

Si l’image utilisée supporte la transparence (par exemple, le format
PNG) et que certaines zones de celle-ci sont transparentes, il est possible
de préciser à Blender de tenir compte de cette transparence en activant
le bouton UseAlpha. Au rendu, les zones transparentes révéleront donc
la couleur de base du matériau de l’objet.
Si l’image utilisée ne supporte pas la transparence, il est possible de
forcer Blender à considérer l’intensité de la couleur comme critère de
transparence : les couleurs sombres seront transparentes, tandis que les
couleurs claires seront opaques ! Pour cela, il vous faudra cocher
l’option CalcAlpha.
Que votre image supporte ou non la transparence, vous pouvez utiliser
le bouton NegAlpha pour inverser les informations de transparence com-
muniquées par l’image.

BON À SAVOIR   Influence de la méthode de filtrage sur l’antialiasage des textures

Il arrivera que vos textures soient floues, alors que vous les préféreriez parfaitement nettes.
Cela est dû au fait que la méthode de filtrage (Gauss, panneau Render des Render but-
tons, menu Scene, touche [F10]) tend à trop les échantillonner. L’usage d’une autre
méthode, comme Box ou CatRom (utilisez le bouton sélecteur) donnera des résultats plus
nets et de meilleure tenue. En particulier, CatRom est la méthode employée par Ren-
derman, le moteur de rendu des studios Pixar pour leurs longs métrages d’animation.
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À moins d’utiliser le dépliage UV, il est important de préciser à Blender la
façon dont l’image devra être projetée sur l’objet. Blender supporte à ce
jour quatre types de projections, que l’on retrouve dans l’onglet Map Input.
• Projection plane (Flat) : la texture est comme une image de film pro-

jetée sur un mur ou sur une toile depuis un projecteur, sauf que le
projecteur est strictement vertical (projection dans la direction
+/- Z). Si l’objet recevant la texture est plus ou moins courbe, la tex-
ture présentera des distorsions importantes.

• Projection cubique (Cube) : la texture est projetée comme ci-avant,
mais dans les six directions à la fois (+/- X, +/- Y et +/-  Z).

• Projection cylindrique (Tube) : l’image est projetée de façon à
« enrouler » verticalement l’objet recevant la texture. Seules les faces
orientées perpendiculairement à la direction +/- Z ne sont pas
habillées convenablement.

• Projection sphérique (Sphere) : la texture est projetée uniformément
dans toutes les directions à la fois, de façon à ce qu’elle enveloppe
complètement l’objet. Si l’objet recevant la texture n’est pas lui-même
sphérique, la texture pourra présenter des distorsions plus ou moins
importantes.

BON À SAVOIR  Extension de l’image

Si jamais la taille d’une image finie n’est pas suffisante pour couvrir un
objet en entier, il est possible de définir le comportement de la texture.
• Extend : la couleur des bords de l’image est projetée à l’infini pour

compléter la couverture de l’objet.
• Clip : au-delà des bords de l’image, l’image est considérée comme

étant transparente, laissant apparaître le matériau de base dans la
zone non couverte. Idéal pour la création d’étiquettes ou d’autocol-
lants à la surface de vos objets.

• Repeat : l’image est répétée indéfiniment dans les directions de
projection ; idéal pour la répétition d’un même motif sur la surface
d’un objet.

• Checker : l’image est répétée indéfiniment mais sous la forme d’un
motif de type damier. Si l’option Odd est activée, l’image est affichée
une case sur deux, laissant voir la couleur du matériau de base
lorsqu’elle n’est pas affichée. Si l’option Even est activée, l’image est
affichée à chaque case, ce qui conduit à un résultat similaire à Repeat
si Mortar est égale à 0.00. Mortar permet de régler l’espace (en unités
de Blender) entre deux images, cet espace révélant la couleur de base
du matériau.

3DS MAX   Matériau Fusion

Le matériau Fusion dans 3ds max permet de com-
biner deux définitions de matériaux et utilise un
masque définissant le pourcentage de fusion. Blender
fournit des résultats similaires, mais limités à la com-
binaison de textures, grâce à la fonction Stencil (voir
la section L’usage des masques dans ce même
chapitre).

BON À SAVOIR  Les formats d’image 
supportés par Blender

Les formats d’image supportés sont BMP, JPG,
PNG et TGA, mais d’autres formats sont partielle-
ment supportés (comme le format PSD natif de
Photoshop). Vous ne pourrez utiliser que ces for-
mats-là en guise de texture pour vos objets.

Figure 5–49 Les quatre types de projection 
de l’onglet Map Input

3DS MAX   Les types de projections

De 3ds max à Blender, les noms de types de pro-
jections (ou mapping) changent quelque peu :
Planaire correspond à Flat ; Cylindrique à
Tube ; Sphérique à Sphere ; Boîte à Cube. Les
options Couvercle et Emballage n’ont toutefois
pas d’équivalent. L’option Face est très facile à
reproduire : dans le panneau Map Input de
Blender, choisissez simplement UV pour repro-
duire l’image sur chaque facette de votre maillage.
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Figure 5–50
Les différents types 
de projections dans Blender :
Flat, Cube, Tube et Sphere

BON À SAVOIR   Charger une vidéo à la place d’une image

Cette option se révèle pratique dans le cadre de textures animées ; si
vous pouvez aisément animer une texture procédurale grâce à ses
courbes IPO, vous aurez parfois besoin de spécifier en arrière-plan
(World buttons) ou à la surface d’un objet une texture sur laquelle défi-
lera une vidéo, plutôt que de présenter une image statique. La mise en
place d’une vidéo se fait exactement comme celle d’une image : dans le
panneau Texture, choisissez Image en guise de Texture type ; puis, dans le
panneau Image, appuyez sur le bouton Load Image pour choisir votre
vidéo, activez le bouton Movie, mais désactivez les boutons Inter Pol et
Mip Map. Dans le panneau Anim and Movie, spécifiez la longueur (en
frames) de la vidéo grâce au bouton Frames, puis indiquez la frame de
votre animation à partir de laquelle votre vidéo sera jouée (StartFr) et
pendant combien de temps (Len). Vous pouvez charger des séquences
d’images ou des vidéos au format AVI (compressé ou non), bien que
sous Windows, toute vidéo dont vous disposez du codec idoine sera
acceptable.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008176

Les textures procédurales
Une texture procédurale est une texture dont l’apparence est définie à
l’aide de fonctions mathématiques plus ou moins complexes. Il est pos-
sible de l’attribuer à un canal ou à un autre, comme pour toute autre tex-
ture. En revanche, il n’est pas possible de spécifier le mode de projection
de ces textures car, de par leur nature mathématique, les textures procé-
durales sont définies dans l’espace, en trois dimensions. Ainsi, par
exemple, un objet avec une texture procédurale de type marbre (Marble)
révèle les veines du marbre en surface de l’objet, mais si l’on coupait
l’objet ainsi texturé en deux, on se rendrait compte que les veines obser-
vables en surface se propagent également au cœur de l’objet.

Les textures procédurales sont bien évidemment pratiques pour donner
rapidement couleur aux matériaux de vos objets, mais elles sont aussi et
surtout redoutables lorsqu’elles sont attribuées aux autres canaux de tex-
ture, afin d’apporter variété et irrégularité à des surfaces au rendu autre-
ment trop parfait.

Il existe différents types de textures procédurales : il faut choisir celle que
vous souhaitez insérer dans le menu déroulant Texture Type lorsque vous
souhaitez en insérer une. Chaque type de texture procédurale apparaît
avec ses propres paramètres, mais les trois plus fréquents sont les sui-
vants (toutes les textures n’y font toutefois pas appel).
• NoiseSize : ce paramètre définit la taille du motif de la texture procé-

durale. Il est également possible d’ajuster celle-ci grâce aux boutons
numériques SizeX, SizeY et SizeZ de l’onglet Map To.

• NoiseDepth : ce paramètre définit la profondeur du dégradé de la texture
procédurale ; plus cette valeur sera grande, plus le dégradé de couleur sera
fin. Au contraire, plus cette valeur sera faible, plus le dégradé sera abrupt.

• Turbulence : ce paramètre permet de déformer le motif de base de la
texture procédurale ; plus cette valeur sera élevée, plus le motif sera
chaotique et probablement plus naturel.

Usages par type de texture
Les possibilités sont très élevées : disposant de 10 champs de texture,
vous pouvez réaliser des empilements extrêmement conséquents de tex-
tures procédurales. Utilisées seules, celles-ci sont rarement satisfaisantes
et requièrent, au contraire, le mélange de deux ou trois textures diffé-
rentes, de même type ou non.

Gardez à l’esprit que les textures procédurales peuvent se voir doter des
couleurs et de la transparence au travers de l’option Colorband, dans
l’onglet Colors. Elles peuvent également être étirées dans certaines direc-
tions, dans le panneau Map Input, grâce aux boutons sizeX, sizeY et sizeZ.

Figure 5–51
Les textures procédurales 

sont définies dans les trois dimensions.
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• Clouds : très utile pour les nuages, la fumée ou même les flammes.
Également pratique en tant que carte de bosselage, dans le canal de
texture Nor.

• Marble : bien évidemment indispensable pour le marbre, mais aussi
pour les flammes.

• Stucci : généralement utilisée pour générer, après association au canal de
texture Nor, des surfaces granuleuses (pierre, goudron, orange, rouille). Il
est possible de spécifier si l’on souhaite obtenir des bosses ou des crevasses.

• Wood : indispensable pour... les textures de bois ! Les meilleurs résul-
tats seront obtenus après empilement de plusieurs couches paramé-
trées différemment.

• Magic : pour simuler les reflets irisés des bulles de savon (canal Col) ou
les mailles de tissus (canal Nor).

• Blend : texture qui permet de prendre le contrôle d’autres textures. Spé-
cialement utile pour la création de masques (voir ci-après) ou d’effets
spéciaux (simulation d’effet Fresnel ou d’épaisseur de verre, par
exemple, en activant l’option Nor dans le panneau Map Input).

• Noise : pour générer un parasitage type écran télé qui ne capte rien. Prévu
pour les animations, le bruit n’est jamais identique d’une image à l’autre.

• Musgrave : idéal pour les textures organiques (cerveaux, par exemple)
mais aussi pour la création de cuir tanné ou de pierres, en combinant
plusieurs textures différentes.

• Voronoi : pour le métal martelé ou ciselé, ou encore pour des textures
plus organiques (écailles, peau, réseaux de veines).

• Distorted Noise : vous pourrez obtenir de nombreux résultats plus ou
moins inattendus en mélangeant un bruit de base et une méthode de
distorsion ; très utiles en complément des autres textures procédu-
rales, pour casser leur aspect répétitif ou introduire des « accidents »
supplémentaires sur les surfaces.

LE SAVIEZ-VOUS ?   Textures et matériaux prêts à l’emploi

Vous trouverez sur le DVD-Rom d’installation, dans le répertoire bonus/material/ de
nombreux matériaux prêts à l’emploi. Certains reposent sur des textures procédurales mais,
globalement, ils sont anciens et ne tirent que peu ou pas parti des textures procédurales les
plus évoluées actuellement disponibles dans Blender. Il y a toutefois sur l’Internet une réfé-
rence à ne pas manquer, qui propose plus de 20 catégories différentes de matériaux, soit plus
de 500 références prêtes à l’emploi au total !
B http://www.blender-materials.org/
Pour réutiliser un matériau existant, utilisez [Maj]+[F1] et naviguez dans le fichier .blend
comme s’il s’agissait d’une suite de répertoires. Dans le répertoire Material/, sélectionnez celui
que vous souhaitez importer dans votre scène et validez. Une fois cela fait, vous pouvez attribuer le
matériau importé à n’importe lequel des objets de votre scène, grâce au bouton ascenseur qui figure
dans le panneau Links and Pipeline, dans les Material Buttons du menu Shading [F5].
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L’usage des masques
Blender accepte jusqu’à dix couches de texture pour un même matériau.
Normalement, la dernière texture (celle du bas) écrase les précédentes,
en fonction des canaux affectés. Mais il vous est possible d’insérer, entre
deux couches de la pile, une texture spéciale qui fera office de masque ou
de pochoir.

Cette texture spéciale, nommée Stencil, permet de déterminer la visibilité
des textures qui l’encadrent, selon des proportions définies par le
dégradé de gris de cette texture, sachant qu’un point parfaitement noir
révélera la texture la plus basse de la pile, un point parfaitement blanc la
texture la plus élevée de la pile, et une valeur de gris un mélange des deux
textures selon les proportions de noir et de blanc.

Par exemple, insérons une texture de type Image représentant du béton
dans le premier champ.

Dans le deuxième champ, mettons en place notre masque, également
une texture de type Image, et activons les boutons Stencil et No RGB dans
l’onglet Map To. Le bouton No RGB n’est utile que si le masque est une
image RGB au lieu d’une vraie image en dégradé de gris.

Enfin, dans le troisième champ, insérons une dernière texture de type Image.

Figure 5–54
L’image en dégradé de gris faisant

office de pochoir, occupant l’espace
intermédiaire entre les deux textures

Figure 5–55
La texture occupant le bas de la pile

Figure 5–52 Utilisation de plusieurs 
couches de texture

Figure 5–53
La texture occupant le haut de la pile
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Au rendu, les deux textures encadrant le masque se sont mariées confor-
mément aux instructions. Ces illustrations ont été réalisées avec des tex-
tures de type Image, mais il vous est bien sûr possible d’utiliser des
textures procédurales ou des greffons. Le fichier d’exemple est dispo-
nible dans le répertoire /exercices du DVD-Rom sous le nom
exercice-ch05.04-final.blend.

Les greffons de texture
D’autres textures procédurales (car faisant appel à des fonctions mathé-
matiques) sont disponibles sous forme de greffons à télécharger séparé-
ment. À l’instar des textures procédurales, les greffons de texture
disposent de leurs propres paramètres de réglage, qui peuvent fonc-
tionner ou non comme les paramètres de même nom des textures procé-
durales de base de Blender.

Pour utiliser un greffon de texture, choisissez simplement Plugin dans le
menu déroulant Texture Type.

Le dépliage UV
Parfois, vous souhaiterez pouvoir positionner très précisément une
image sur un maillage ; à d’autres occasions, vous ne désirerez absolu-
ment aucune distorsion de l’image plaquée, dont la projection devra
suivre précisément les circonvolutions de l’objet, quelle que soit sa com-
plexité. À ces problèmes, une seule solution : le dépliage UV.

La technique consiste « simplement » à déplier votre maillage pour le
poser « à plat ». Bien sûr, il faudra pratiquer ici et là des incisions afin de
rendre le dépliage possible. Ces incisions s’apparenteront, lors du rendu,
à des coutures.

Nous allons voir ici comment réaliser le dépliage d’un objet simple. Ouvrez
le fichier exercice-ch05.05-depart.blend, qui présente l’écran principal
scindé en deux : à gauche, la vue 3D et, à droite, l’éditeur UV/Image.

Figure 5–56
L’amalgame des deux textures, 
en fonction des informations 
apportées par le pochoir

ASTUCE   Animation 
des textures procédurales

Comme vous le verrez dans le chapitre 7, Techni-
ques d’animation fondamentales, il vous est
possible d’associer des courbes IPO aux paramè-
tres de votre texture procédurale, et ainsi créer très
facilement des textures animées.

BON À SAVOIR  
Où trouver des greffons de texture

De nombreux greffons sont disponibles sur Internet.
Un site a en revanche endossé la mission de les cen-
traliser et de les distribuer :
B http://www-users.cs.umn.edu/~mein/

blender/plugins/. 
Ils y sont disponibles sous format compressé ; il vous
faudra toutefois choisir la version propre à votre sys-
tème d’exploitation, car un greffon ne fonctionne
que pour le système pour lequel il a été compilé.
Le même site propose également une compilation
de greffons de séquence, ainsi que des scripts
Python. Vous trouverez sur le DVD-Rom d’accompa-
gnement, dans le répertoire /bonus/plugins/
les archives avec la compilation des greffons dispo-
nibles à ce jour, précompilés pour diverses plates-
formes.

BON À SAVOIR   Le dépliage UV et la confection

Le dépliage UV s’apparente, d’une certaine façon,
à la fabrication de vêtements. En confection, on
réalise la découpe des bouts de tissus selon des
patrons, à plat. Les vêtements sont alors assem-
blés grâce à des coutures, et enfin le modèle est
habillé du vêtement assemblé et cousu. En
dépliage UV, l’ordre des opérations est inverse :
l’objet est déjà habillé, on indique la position des
coutures pour une opération d’incision virtuelle, et
on déplie la « peau » de l’objet à plat, pour former
le patron que l’on pourra peindre, et ainsi lui
donner matière et texture.
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Dans la vue 3D, entrez en mode Edit et sélectionnez tous les points de con-
trôle (touche [A]). L’apparition d’un onglet UV Calculation ne vous échap-
pera pas dans les boutons du menu Editing [F9] ; passez dans ce dernier.

C’est, en effet, l’onglet le plus important que nous allons étudier mainte-
nant. Repérez le bouton Angle Based, et cliquez dessus : un menu dérou-
lant vous permet de choisir la méthode de dépliage, mais laissons-le sur
Angle Based. Avec le pointeur de la souris dans la vue 3D, utilisez la touche
[U] pour commander le dépliage, en essayant les diverses méthodes stan-
dards de dépliage : Project from View (de préférence, effectuez ce dernier
test depuis la vue de la caméra, touche [0] du pavé numérique) et Reset,
puis les boutons CubeProjection, SpherefromView et CylinderfromView. En
fait, chacune de ces options détermine une méthode de dépliage, mais ce

3DS MAX, MAYA   Dépliage UV

Les outils de dépliage de 3ds max sont très corrects, mais ne permettent
malheureusement pas de positionner des coutures avant dépliage (sauf
en cas d’utilisation du Pelt unwrapper).En revanche, ils permettent aisé-
ment de juxtaposer des arêtes adjacentes. De son côté, Maya offre plus
de fonctionnalités que 3ds max en matière de dépliage, mais selon cer-
tains utilisateurs, ces outils peuvent se révéler plus confus. Grâce au
script MEL, un nouvel outil Pelting est disponible, mais s’agissant d’un
processus totalement automatisé, il offre moins d’options à l’utilisateur.
Les outils de dépliage UV fournis par Blender font partie des meilleurs
outils sur le marché, avec un dépliage selon la méthode Conformal ou
Angle Based, la mise en place des coutures, le clouage des coordonnées,
la mise à jour interactive de la carte dépliée après déplacement de coor-
données clouées, etc. Dans la version 2.42 de Blender, de nouvelles fonc-
tionnalités ont encore été ajoutées, dont une révision de l’algorithme
de dépliage et des outils pour limiter la déformation du dépliage.
En revanche, alors que 3ds max et Maya supportent des cartes de
dépliage UV multiples pour un même maillage, Blender est limité à une
carte unique par maillage ; chez les concurrents, cela permet aux utilisa-
teurs d’utiliser des dépliages avec des coutures différentes, ou de tra-
vailler à des niveaux de détail différents lors de la peinture des textures.
Enfin, à noter que dans 3ds max, il s’agit d’un modificateur UVW tandis
que dans Blender, il s’agit d’un outil d’édition.

Figure 5–57
L’onglet UV Calculation

BON À SAVOIR   Au sujet de la méthode 
de dépliage Angle Based

Cette méthode de dépliage (Angle Based Flatte-
ning) favorise de faibles distorsions angulaires au
lieu de favoriser de faibles distorsions surfaciques,
un peu comme la méthode Conformal, à ceci
près que cette méthode n’a pas tendance à pro-
duire de cartes dépliées qui s’effondrent en pré-
sence de facettes très étirées. Cela permet de gérer
des cartes de dépliage particulièrement complexes
sans avoir recours au pinning (clouage).
Généralement, vous réserverez l’usage de Angle
Based aux dépliages de formes organiques, et
celui de Conformal aux formes mécaniques ou
architecturales.

ASTUCE   Usage des modes de projection 
autres que Conformal et Angle Based

Si Conformal et AngleBased sont les méthodes
de dépliage les plus avancées, les autres méthodes
ne sont pas à négliger pour autant. En effet, avant
même de définir des coutures, vous pouvez utiliser
un mode de projection particulier (Project-
fromView, par exemple) pour afficher dans l’édi-
teur UV/Image un groupe de sommets dont
l’arrangement est déjà relativement à plat. Vous
pouvez ensuite sélectionner (touche [B]) les som-
mets dont l’arrangement est satisfaisant et figer
leur position en les clouant (Pin, touche [P]).
Après avoir disposé des coutures de façon adé-
quate, ou en faisant varier successivement les
modes de projection (ou les angles dans la vue 3D
pour l’option Project from View), vous obtenez
un dépliage manuel satisfaisant, en prenant soin à
chaque fois de clouer les groupes de sommets qui
vous conviennent.
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ne sont que des points de départ à de nombreuses opérations de dépliage
qui devront être réalisées à la main par des utilisateurs avancés.

Pour notre part, nous allons nous contenter de la méthode Angle Based par
défaut, car c’est la plus naturelle, et parce qu’elle a été développée dans un
souci d’aisance. Comme nous l’avons déjà suggéré, cette méthode fonc-
tionne mieux lorsque des coutures ou des joints (seams) sont définis. La
méthode pour les ajouter consiste à sélectionner les arêtes de notre choix, et
à spécifier des jointures le long de celles-ci grâce à la combinaison de
touches [Ctrl]+[E], qui appelle un menu spécial. Celui-ci permet d’ajouter
des coutures (Mark Seam) ou, au contraire, d’en supprimer (Clear Seam).

Dans la vue 3D, toujours dans le mode Edit (touche [Tab]), choisissez dans
l’en-tête le mode de sélection des arêtes. Commencez par sélectionner l’une
des arêtes de la face supérieure (bouton droit de la souris), puis ajoutez à la
sélection (bouton droit de la souris pendant que la touche [Maj] est main-
tenue enfoncée) toutes les arêtes horizontales de la face supérieure.
Appuyez sur la combinaison de touches [Ctrl]+[E] pour définir les coutures
du maillage. Sélectionnez à nouveau tous les sommets (touche [A]).

ASTUCE  Clouage et déclouage

Avec les méthodes Conformal comme Angle Based, la position des sommets
dépliés est recalculée à chaque fois selon le même algorithme. Parfois, le
résultat ne sera pas conforme à vos attentes, ou vous viserez des résultats
particuliers non prévus par l’algorithme de dépliage. Dans l’éditeur UV/
Image, vous pouvez sélectionner (touche [B]) des sommets spécifiques, les
déplacer à l’endroit de votre choix, et les clouer sur place grâce à la
touche [P] (utilisez la combinaison de touches [Alt]+[P] pour déclouer la
sélection). Lorsque vous relancerez le dépliage (touche [E]), tous les som-
mets seront redistribués par l’algorithme, à l’exception des sommets cloués
qui resteront parfaitement statiques. Par exemple, dans l’image suivante,
le dépliage est réalisé en Project from View depuis la vue de la caméra.
Les sommets de la face avant ont été cloués, et si l’on relance maintenant
le dépliage, les positions de tous les autres sommets seront recalculées.

Figure 5–59

ASTUCE  Marquage rapide de coutures

La combinaison de touches [Alt]+bouton droit
de la souris sur une arête permet d’ajouter ou de
supprimer une couture sur celle-ci. De même,
[Maj]+[Alt] et bouton droit de la souris permet
de marquer/supprimer toutes les coutures entre la
dernière couture marquée et l’arête cliquée.

Figure 5–58
Le menu spécial des arêtes, invoqué grâce 

à la combinaison de touches [Ctrl]+[E]

Figure 5–60
Le mode de sélection des arêtes
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Avec le curseur de la souris dans l’éditeur UV/Image, appuyez sur la
touche [E]. Nous obtenons enfin quelque chose d’intéressant : une face
carrée et des faces effondrées.

Il va sans dire que la face parfaitement carrée est celle dont les arêtes ont
été déclarées comme coutures. De retour dans la vue 3D, sélectionnez
l’une des arêtes horizontales de cette face et supprimez-en la couture
(combinaison de touches [Ctrl]+[E] puis Clear Seam) ; en revanche, sélec-
tionnez les quatre arêtes verticales et ajoutez une couture (combinaison de
touches [Ctrl]+[E] et Mark Seam). Sélectionnez ensuite toutes les arêtes
(touche [A]) et, à nouveau avec le pointeur de la souris dans l’éditeur
UV/Image, appuyez sur la touche [E] pour ordonner un nouveau dépliage.

Figure 5–61
Les coutures apparaissent

 en orange (en mode Edit).

IMPORTANT  
Les limites d’application du dépliage

Quelle que soit la méthode de dépliage employée,
celle-ci ne s’applique qu’aux faces sélectionnées
de votre modèle.

Figure 5–62
Notre patron est encore loin d’être parfait,

malgré les premières coutures.
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Les coutures correctement définies, au dépliage, le cube donne un patron
cohérent et facile à colorier. Pour fignoler, vous pouvez utiliser dans l’édi-
teur UV/Image les mêmes touches d’édition que dans les vues 3D :
• la touche [A] sélectionne/désélectionne ;
• la touche [G] déplace la sélection ;
• la touche [R] fait tourner la sélection ;
• la touche [S] redimensionne la sélection.

Bien sûr, pour toutes les manipulations, vous pouvez régler les incréments
de transformation en maintenant la touche [Ctrl] appuyée (forçant, par
exemple, les rotations à des incréments de 5°). L’en-tête de l’éditeur
UV/Image présente une entrée UVs qui donne accès à de nombreuses
options d’édition qui vous sont déjà familières, comme l’édition propor-
tionnelle (touche [O]), la possibilité de masquer ou révéler des faces
(touches [H], [Alt]+[H], [Maj]+[H]) ou encore de retourner symétriquement
la sélection selon les directions horizontale et verticale (touche [M]).

Peindre la texture avec un outil de dessin externe
Si vous souhaitez peindre l’image qui sera plaquée sur l’objet dans un
logiciel de dessin tiers, comme Gimp (http://www.gimp.org), que nous
vous recommandons, il vous faut au préalable exporter le patron sous
forme d’image lisible par ce logiciel. Pour cela, utilisez le script Save UV
Face Layout qui se trouve dans le menu UVs.

Figure 5–63
Les nouvelles coutures sont définies, et la 
forme dépliée est cohérente, facile à peindre !

ASTUCE   Limiter l’étirement 
des facettes sur la carte de dépliage

Un outil est à votre disposition pour limiter l’étire-
ment excessif de certaines facettes lors du dépliage
de la carte UV. Une fois le dépliage réalisé, la combi-
naison de touches [Ctrl]+[V] permet de
« relaxer » le maillage aux endroits où il paraît trop
tendu ou étiré, sans toucher aux bords du maillage
déplié. Vous pouvez ensuite utiliser la molette de la
souris ou les touches [+] et [-] du pavé numérique
pour ajuster l’effet entre la version d’origine et la
version dont l’étirement est limité : le taux de
mélange est alors interactivement affiché au bas de
la vue de l’éditeur UV/Image.

Figure 5–64

Figure 5–65
Le script Save UV Face Layout en action
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En appuyant sur le bouton OK, ce script Python va enregistrer dans un
fichier l’image dépliée de l’objet sélectionné, qui portera le nom du
fichier .blend, mais associé à l’extension *.tga. Par défaut, l’image fait
1 024 × 1 024 pixels d’arête (ainsi que défini par le bouton numérique Size),
et les arêtes dépliées seront matérialisées par des lignes dont vous fixerez la
largeur à 1 pixel (bouton numérique Wire: 1). A priori, vous n’aurez pas à
toucher aux autres paramètres à moins de comprendre ce que vous faites.

L’image dépliée sauvegardée par le script est stockée par défaut dans le
même répertoire que le fichier *.blend sur lequel vous travaillez. Vous
pouvez alors l’ouvrir dans le programme de dessin de votre choix, et
peindre par-dessus ce gabarit les couleurs souhaitées. Nous n’aborderons
pas ici les techniques de peinture de cartes UV, et passerons directement
à ce qui est une image finale très basique.

Figure 5–66
L’image dépliée générée par le script

ASTUCE   Mise en place de calques pour les cartes UV

Il est possible d’attribuer à un maillage plusieurs calques distincts de dépliage UV. Cela
permet, par exemple, d’avoir un calque contenant les coordonnées UV pour les textures clas-
siques, un calque pour stocker le résultat d’une opération de Baking automatique, etc.
L’intérêt est que les coordonnées UV peuvent différer d’un calque à l’autre. Cela permet, par
exemple, d’avoir un calque englobant le corps entier d’un personnage, et un autre unique-
ment pour le visage, qui peut nécessiter des détails beaucoup plus fins (bosselage, carte nor-
male) que le reste du corps, tout en partageant une carte de couleur avec le reste du corps.
Les contrôles sont placés dans le menu Editing, touche [F9], dans le panneau Mesh. La
rubrique UV Texture contient un bouton New qui permet d’ajouter de nouveaux calques :
le bouton bleu-vert détermine le calque actif, le bouton avec la croix permet de le supprimer.
Le calque actif est affiché dans la vue 3D et est disponible pour édition dans la vue UV/
Image Editor. Certaines fonctions de Blender peuvent nécessiter de spécifier un nom de
calque UV lorsqu’elles en ont besoin, comme le modificateur Displace, par exemple ; elles
disposent alors d’un champ spécifique à cette information. Figure 5–67
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Peindre la texture directement dans Blender
Blender intégre un mini-studio de peinture, qui vous permet de peindre
ou retoucher des cartes UV. Ainsi, plutôt que d’exporter le patron du
cube déplié pour l’ouvrir dans Gimp et le rappeller ensuite dans Blender,
choisissez New dans le menu Image de l’éditeur UV/Image.

Outre le nom de la texture, un panneau flottant apparaît et vous invite à
spécifier les dimensions en largeur et en hauteur de la texture (respecti-
vement Width et Height). Vous pouvez désormais chercher à peindre vos
textures, soit directement à la surface de l’objet, dans la vue 3D, soit dans
l’éditeur UV/Image :
• Dans la vue 3D, choisissez le mode Texture Paint : dans le menu Editing,

touche [F9], un nouvel onglet Paint apparaît, très similaire à celui qui
permet la peinture sur sommet. L’image précédemment créée dans
l’éditeur UV/Image (par défaut, un fond noir) est automatiquement affi-
chée en temps réel dans la vue 3D.

• Dans l’en-tête de l’éditeur UV/Image, activez l’icône Texture Paint.
Avec le curseur de la souris dans cette même vue, appuyez sur [C] ou
passez par le menu View>Paint Tool pour afficher les outils de pein-
ture sous forme de panneau flottant.

• N’oubliez pas de sauvegarder l’image nouvellement créée, par
exemple Image>Pack Image as PNG.

Les outils à votre diposition pour peindre votre texture vous rappelleront
certainement ceux de Gimp. Vous pouvez définir différentes brosses, et
passer de l’une à l’autre grâce au bouton sélecteur devant le champ BR:.
Dans le même sélecteur, utilisez l’option Add New pour créer une nou-
velle brosse.

Figure 5–68
Un exemple de carte UV 
peinte à la main dans Gimp

Figure 5–69
L’option New Image du menu Image

ASTUCE   Sauvegarder les brosses inactives

Lorsqu’un bloc de données n’a pas d’utilisateurs, il
n’est pas enregistré et à la prochaine ouverture du
fichier, le bloc a disparu. Vous ne pouvez avoir qu’une
brosse active à la fois, mais vous ne souhaitez certai-
nement pas que toutes les brosses créées pour
détailler une texture soient perdues à chaque début
de session. Vous veillerez alors à ce que le bouton F à
droite du nom de la brosse soit actif. Si c’est le cas, le
bloc de données sera sauvegardé et à nouveau dispo-
nible pour la prochaine session.

Figure 5–70 L’icône Texture Paint 
de l’en-tête de l’éditeur UV/Image
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Une brosse est définie par différentes propriétés :
• Opacity : le taux de transparence de la couleur, ou la pression de la

brosse ;
• Size : la taille de la brosse ;
• Falloff : le taux d’atténuation de la brosse ; une valeur faible donne des

contours très flous, une valeur élevée des contours très durs ;
• Spacing : la finesse du tracé ; une valeur de 1 donne un tracé très con-

tinu, des valeurs plus élevées introduisent progressivement de la dis-
continuité.

Elle opère selon différents modes de fonctionnement :
• Draw : la brosse dépose effectivement la couleur sélectionnée sur la

texture ;
• Soften : la brosse agit comme une gomme pour cette couleur ;
• Smear : cette brosse estompe et étale la couleur sélectionnée ;
• Clone : permet de cloner depuis une image vers une autre. Il faut indi-

quer dans le sélecteur IM: l’image source, et l’appliquer avec le bouton
gauche sur la texture en cours de peinture. Le bouton B permet d’indi-
quer l’opacité de l’image source par rapport à l’image de destination.

Toutes les options n’ont pas encore été évoquées, mais il suffira de dire
que le sélecteur latéral Mix permet d’indiquer la méthode de mélange de
la couleur appliquée par la brosse à la texture déjà peinte, et que l’option
Airbrush permet d’envoyer en flux continu la peinture sur la texture : plus
vous stagnez à une position, plus celle-ci se charge en « peinture » dont
l’opacité augmente jusqu’à être totale.

Travailler avec des cartes UV
De retour à Blender, en mode Edit, prenez garde à ce que tous les som-
mets soient sélectionnés et que le dépliage soit visible dans l’éditeur
UV/Image : le patron précédemment obtenu refait normalement son
apparition. Dans l’en-tête de l’éditeur, dans le menu Image se trouve
l’entrée Open, qui ouvre le sélecteur de fichiers. Choisissez avec le bouton
gauche de la souris l’image dans laquelle vous avez enregistré vos travaux
de peinture et appuyez sur la touche [Entrée] pour valider.

Figure 5–71
Outils de peinture

des textures intégrés à Blender

BON À SAVOIR   Une texture en guise de brosse

Tout en bas de la fenêtre flottante se trouve un
sélecteur de textures. Vous pouvez choisir toute tex-
ture déjà existante, ou en créer une nouvelle (Add
New). La texture se définit normalement dans les
Textures Buttons, mais prenez garde à sélec-
tionner l’option Brush dans le panneau Preview.
La texture peut être procédurale ou bitmap. L’uti-
lisation d’une texture permet d’obtenir des brosses
aux formes très complexes. Les amateurs de logi-
ciels de dessin 2D apprécieront particulièrement
les richesses que de tels outils peuvent apporter à
la peinture des textures.
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Dans la vue 3D, revenez en mode Object, et appuyez sur la combinaison
de touches [Alt]+[Z] pour constater la prise en compte de la carte UV par
l’objet. En revanche, si vous effectuez un rendu de la scène
(touche [F12]), vous n’obtenez que le cube gris par défaut de la scène !
C’est parce que rien n’indique à Blender que le matériau du cube doit
prendre en compte les coordonnées UV du dépliage et l’image peinte.

Rendez-vous alors dans les Material buttons du menu Shading,
touche [F5] ; dans l’onglet Material, il faut activer le bouton TexFace ; la
carte UV remplacera désormais le Col du matériau. Le fichier de travail
final, nommé exercice-ch05.05-final.blend, est disponible dans le
répertoire /exercices du DVD-Rom d’accompagnement.

ASTUCE   Textures répétitives

Figure 5–72

Vous n’êtes pas fondamentalement
obligé de peindre une carte UV parfai-
tement adaptée à votre dépliage. Vous
pouvez en effet redimensionner votre
dépliage UV de sorte que son espace
déborde du canevas de l’image !
L’image est alors considérée comme se
répétant autant de fois que nécessaire
dans les deux directions, afin que tous
les sommets UV soient couverts par
celle-ci. L’avantage est que vous
pouvez ainsi utiliser des textures rac-
cordables de faibles dimensions pour
orner vos maillages.

ASTUCE  Live Unwrap Transform

Nous avons déjà vu que lorsque le bouton de
dépliage est activé grâce à la touche [E], les som-
mets sont redistribués, à l’exception des sommets
cloués. Mais, lorsqu’un sommet cloué est déplacé
(touche [G], par exemple), le dépliage ne se met pas
à jour automatiquement ; il faut relancer le dépliage.
Il existe toutefois un mode spécial dans le menu UVs
de l’éditeur UV/Image : Live Unwrap Trans-
form. Activez-le, et dans l’éditeur UV/Image,
clouez deux des points de la branche centrale du
patron, comme sur l’illustration suivante :

Figure 5–73

Maintenant, désélectionnez tous les sommets
(touche [A]) et sélectionnez seulement le sommet
cloué supérieur (touche [B]). Promenez ensuite ce
sommet (touche [G]) et observez comment le Live
Unwrap Transform opère : tous les sommets sont
recalculés en temps réels, tenant compte des cou-
tures, des sommets cloués et du déplacement imposé
interactivement à la sélection de sommets cloués.

Figure 5–74

Figure 5–75
Notre cube, enfin paré 
des couleurs de la carte UV
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Plusieurs cartes UV affectant différents canaux
Nous avons vu qu’il était possible d’associer des images à des canaux de
texture particuliers, comme une image en dégradés de gris associée au
canal Nor, pour simuler des bosses, des rayures ou des aspérités à la sur-
face de l’objet. Cela est également possible sous forme de cartes UV,
mais il faudra que toutes vos images respectent le même patron de
dépliage, car à un matériau ne peut être associé qu’un seul patron. Par
exemple, supposons que nous ayons l’image en noir et blanc ci-contre
pour illustrer des rayures à la surface de l’objet.

Rendez-vous dans les Texture buttons du matériau, et ajoutez une nou-
velle texture (Add New) s’il n’y en a pas (le cube par défaut présente une
texture vide que vous pouvez ici utiliser). Choisissez Image comme Tex-
ture type, et grâce au bouton Load Image, chargez l’image en noir et
blanc. Retournez alors dans les Material buttons ; dans l’onglet Map
Input, pour la texture courante, choisissez UV pour indiquer à Blender
qu’il doit appliquer à cette image les mêmes coordonnées UV que celles
déjà existantes. Enfin, dans l’onglet To, désactivez le canal Col pour
activer le canal Nor (attention : nous souhaitons faire apparaître nos
traits noirs sous forme de creux, il faut donc inverser le canal Nor, en cli-
quant deux fois dessus de façon à ce que son texte apparaisse en jaune).

Vous pouvez de cette façon ajouter autant de textures que vous le sou-
haitez, et même combiner texture UV et texture Orco (dans les boutons
de l’onglet Map Input), si cela présente un intérêt pour vous : par
exemple, lorsque vous souhaitez appliquer de façon uniforme, sur un
objet doté d’une carte UV, une texture procédurale.

Figure 5–76 Exemple d’image 
en noir et blanc permettant de contrôler

le « bosselage » de la surface

Figure 5–77
Une texture en noir et blanc dans le canal Nor

permet de rayer la surface de notre cube.
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Render Baking, ou la sauvegarde du résultat de rendu 
dans une texture UV
Cette technique permet d’effectuer un rendu d’un objet et d’en stocker le
résultat directement dans la carte UV de l’objet. Les avantages sont mul-
tiples, surtout que Blender, grâce à ses passes de rendu, peut stocker le
résultat d’une passe particulière dans la texture UV.

Le Render Baking n’est disponible que pour les maillages à l’exclusion de
tout autre type d’objet. Une image doit avoir été assignée à la texture,
dont les coordonnées UV ont été spécifiées, soit par calcul simple des
UV (en mode Edit : touche [U] puis choix d’une méthode de calcul), soit
par dépliage UV (vue UV/Image Editor : touche [E] avec les méthodes
Conformal ou Angle Based), soit par dépliage automatique (en mode Edit :
touche [U] puis option Unwrap (Small Projections)).

Le Render Baking s’effectue sur tous les objets sélectionnés et éligibles
(maillages dont les coordonnées UV ont été déterminées). La combi-
naison de touches [Ctrl]+[Alt]+[B] appelle un menu flottant qui permet
de choisir le type de passe à enregistrer dans la texture.

La même fonction est accessible (avec des options similaires) depuis le
menu principal : Render>Bake Render Meshes>... ou grâce à l’onglet Bake,
dans les Render buttons du menu Scene (touche [F10]).

Figure 5–78
Par exemple, les informations relatives 
à l’occlusion ambiante sont stockées dans 
la carte UV du modèle ; celui-ci peut alors
être rendu, par exemple, en mode Shadeless 
et avec l’occlusion ambiante désactivée : 
les ombres relatives à l’occlusion, enregistrées 
lors du Baking, sont alors restituées.

Figure 5–80
L’onglet Bake, qui donne accès 
aux options de baking

Figure 5–79
Menu de sélection du type de passe 

à enregistrer dans la texture
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C’est cet onglet qui permet de contrôler le plus finement l’opération de
sauvegarde du rendu dans les textures.
• Full Render : stocke le résultat complet du rendu (incluant les textures,

les reflets, les ombres, la passe d’occlusion ambiante, etc.) dans la tex-
ture UV de l’objet. Seule limitation : les reflets spéculaires ne sont pas
intégrés, car ils sont dépendants de la position de la caméra.

• AmbientOcclusion : la passe d’occlusion ambiante est stockée dans l’image
dépliée, pouvant ainsi affecter la couleur diffuse de l’objet, lors d’un pro-
chain rendu, tout en s’épargnant de recalculer à nouveau cet effet d’éclai-
rage. Peut être particulièrement utile dans le cadre du rendu d’animations.

• Textures : permet d’effectuer le rendu de toutes les textures appliquées
et d’en fondre le résultat en une seule. En particulier, cette option
permet de convertir sans se fatiguer le résultat d’une texture procédu-
rale en une image UV, qui pourra à loisir être modifiée, manipulée,
mélangée avec d’autres images dans un logiciel comme Gimp.

À noter le paramètre Margin, qui définit le nombre de pixels suivant lequel
l’image, dont le rendu a été sauvegardé dans les textures, doit être pro-
longée. Ceci permet de prévenir tout risque d’apparition de coutures
noires lors du placage de la texture sauvegardée au moment d’un rendu. Il
est déconseillé de l’abaisser en dessous de 1, sa valeur par défaut étant 2.
Pour sa part, le bouton Clear force la purge des images devant recevoir le
résultat du baking avant l’opération.

Carte normale et carte de déplacement
Dans l’industrie du jeu ou en complément de logiciels 3D spécialisés, il
est souvent utile d’extraire des informations très détaillées d’un modèle
haute résolution, de stocker celles-ci dans une carte UV et de l’appliquer
à un modèle basse résolution.

Figure 5–81
À partir d’un modèle 3D haute résolution

d’une caisse en bois (sans couleurs
pour faciliter la compréhension),

une carte normale est générée
en utilisant la fonction Bake
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Dans le cas des cartes normales, il s’agit de donner l’illusion qu’un
modèle basse résolution présente le même niveau de détails (plis,
rayures, rides, écailles et boutons, etc.) qu’un modèle haute résolution.
Le modèle conserve sa géométrie : il reste en basse résolution.

Dans le cas des cartes de déplacement, il s’agit plutôt de donner la possi-
bilité de reconstruire le modèle haute résolution à partir du modèle basse
résolution. Cela implique que le modèle basse résolution soit subdivisé
jusqu’à atteindre le même niveau de densité de maillage que l’original.
Contrairement au cas précédent, la géométrie est altérée.

À ces fins, les options suivantes sont également disponibles dans l’onglet
Bake : 
• Normals : calcule les valeurs normales à la surface, et les retranscrit

sous forme d’image RGB ; il s’agit en particulier de créer une carte
normale à partir d’un modèle haute résolution, puis de l’appliquer sur
un modèle basse résolution pour créer l’illusion de formes complexes
sur des maillages simples. Utile dans le cadre de la création de
modèles (personnages, décors ou accessoires) à destination de jeux
vidéo supportant les cartes normales.

• Displacement : calcule la distance entre le point d’un modèle sculpté
en haute résolution et la surface d’un modèle basse résolution ; il est
alors possible d’appliquer cette carte de déplacement au modèle basse
résolution, suffisamment subdivisé (modificateur Subsurf) et de le
déformer grâce au modificateur Displace.

Figure 5–82
Appliquée à un simple cube, la carte normale 
apporte alors un niveau appréciable de détails 
supplémentaires.

ASTUCE   Images au format 32 bits Float

Par défaut, la fonction Image>New permet de
créer des images 8 bits, suffisantes pour stocker
les couleurs et donc appropriées pour le baking
de textures, l’occlusion ambiante et même les
cartes normales.
Pour les cartes de déplacement, en revanche, 8 bits
sont insuffisants pour stocker les distances rela-
tives aux surfaces : avec de telles images, il est
possible d’observer des artefacts et des phéno-
mènes d’escalier sur les surfaces déplacées.
L’option 32 bits Float permet donc de générer
des images capables de stocker le supplément de
profondeur nécessaire à la restitution de déplace-
ments proches de la perfection !
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Selected to Active : pour la génération de cartes normales à partir de 
modèles distincts

Comme nous l’avons vu, il est nécessaire que l’objet basse résolution ait
été proprement déplié, en préalable à toute autre étape, et qu’une nou-
velle image lui soit attribuée dans l’éditeur UV/Image.

Il est ensuite possible de dériver une carte normale depuis l’objet haute
résolution vers l’objet basse résolution. Pour ce faire, il est nécessaire de
placer provisoirement (cela n’est nécessaire que pour la création de la carte)
les objets haute et basse résolution sur le même calque (ou de veiller à ce
que les différents calques sur lesquels ils sont placés soient bien actifs), et
de les sélectionner tous deux. L’objet actif doit être celui dont la carte UV
recevra la carte normale, c’est-à-dire l’objet basse résolution. Il devra donc
être sélectionné en dernier (sa silhouette sera rose pâle).

Dans le panneau Bake, activez le bouton Selected to Active : vous indiquez
que la sélection sera « bakée » sur l’objet actif. D’autres options peuvent
se révéler utiles, selon les cas :
• Dist : permet de spécifier la distance maximale entre le point de la

sélection et la surface correspondante de l’objet actif (exprimée en
unités de Blender). Les points et objets de la sélection au-delà de
cette distance n’influeront pas la carte générée.

• Bias : au lieu de prendre en considération le point le plus proche de la
sélection pour l’établissement de la carte, l’usage de ce paramètre
permet de prendre en considération un maillage situé un peu plus
loin, ce qui est pratique pour des badges, bijoux, petits sacs ou autres
accessoires que l’on veut prendre en compte sur le maillage haute
résolution, alors qu’ils ne sont pas du tout modélisés dans le maillage
basse résolution.

Lorsque vous choisissez Normals, un menu déroulant vous permet de
choisir le type de carte normale à générer. Blender autorise les cartes de
tous types.
• Camera : les normales sont déterminées en fonction des coordonnées

de la caméra ; si la caméra ou les objets de la scène bougent, les nor-
males deviennent fausses et les reliefs de la carte normale seront tota-
lement faussés, conduisant à des résultats plus ou moins désastreux,
en fonction des écarts entre les positions actuelles et celles à partir
desquelles la carte normale Camera a été calculée.

• World : les normales sont déterminées en fonction des coordonnées
du monde (World) ; la caméra peut bouger, mais pas les objets dotés
d’une carte normale World, sous peine, comme précédemment,
d’obtenir des reliefs faussés.

Figure 5–83 Le bouton Selected
to Active du panneau Bake
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• Object : les normales dépendent des coordonnées de l’objet ; à ce titre,
tous les objets peuvent être animés de façon conventionnelle : les
cartes normales Object les suivront dans toutes leurs transformations
usuelles (déplacement, rotation, mise à l’échelle). Les objets ne doi-
vent toutefois pas être déformés (notamment les armatures, formes
clés et modificateur Lattice – voir les chapitres 7, Techniques d’anima-
tion fondamentales et 8, Techniques d’animation avancées) car les cartes
normales Object ne se déformeront pas de façon appropriée, résultant
à nouveau en des aberrations visuelles.

• Tangent : les normales dépendent uniquement de la tangente à la
surface ; l’objet doté d’une carte normale Tangent peut être animé et
déformé à volonté. Ce type de carte est le plus complexe à calculer,
mais également le plus universel. C’est le choix par défaut, car il con-
vient à toutes les situations.

Il suffit ensuite de presser le bouton Bake pour que l’opération de géné-
ration de la carte ait lieu. 

Avec les maillages multirésolution

Il n’est pas forcément nécessaire d’avoir un maillage haute résolution et un
autre basse résolution pour la génération de cartes normales et de déplace-
ment. Grâce aux maillages multirésolution (voir chapitre 4, Techniques de
modélisation), il est possible de sculpter les maillages de façon fine.

La procédure la plus simple consiste alors à modéliser un maillage de
basse résolution, puis à le déplier et lui assigner une image de texture,
pour l’instant vide. Une fois ceci fait, ajoutez des niveaux successifs de
résolution, jusqu’à obtenir le niveau de détails souhaité à la surface de
l’objet. Pour le rendu, utilisez le plus haut niveau utile possible (para-

Figure 5–84
Exemple de pierre sculptée 
haute résolution, dont nous cherchons 
à extraire une carte normale Object



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008194

mètre Render du panneau Multires) et lancez l’opération Bake, sans avoir
activé le bouton Selected to Active, mais en ayant pris soin de sélectionner
l’objet haute résolution.

Au terme de l’opération, la carte normale a été générée à partir du
modèle haute résolution et l’ensemble des détails est désormais utilisable
directement par le modèle basse résolution.

Figure 5–85
La carte normale Object de notre pierre

ATTENTION  
Pensez à sauvegarder vos images !

Même si vous utilisez l’option de packing auto-
matique (Image>Pack Image), pensez à sau-
vegarder (Image>Save ou Save As) votre
texture après chaque tentative de génération,
car cette opération n’est pas réalisée automati-
quement lors de la sauvegarde [F2] du projet.

Figure 5–86
La pierre basse résolution avec la carte

normale dérivée des résolutions supérieures
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L’éditeur de nœuds matériaux
Blender propose différents shaders, c’est-à-dire des méthodes d’illumina-
tion des objets : par exemple, Lambert ou Minnaert pour les shaders
diffus, et Blinn ou CookTorr pour les shaders spéculaires. Chacun de ces
shaders repose sur des algorithmes et des réglages qui leur sont propres.
En passant par l’éditeur de nœuds matériaux, vous pouvez
« programmer » vous-même vos propres shaders, afin d’obtenir le
résultat le plus proche possible de vos choix personnels, sans forcément
être lié par des shaders préréglés. Cette création de shaders spécifiques se
réalise graphiquement, par connexion entre elles de boîtes d’effets.

Un shader nodal peut être aussi simple que deux nœuds reliés entre eux,
ou être constitué d’un réseau plus complexe.

Les étapes de la création d’un shader nodal sont résumées ci-dessous.
• Transformez l’une des vues en Node Editor en cliquant sur l’icône de

changement de type de vue, dans l’en-tête de la vue principale. Un
écran gris et quadrillé fait son apparition, mais il est pour l’instant vide.
Dans son en-tête se trouvent deux icônes : la première permet l’édition
de nœuds définissant des matériaux, la seconde des nœuds définissant
des effets de composition. Activez la première si elle ne l’est pas.

• Allez dans le menu Shading, touche [F5], et appuyez sur le bouton
Nodes qui se trouve dans le panneau Links and Pipeline (ou utilisez le
bouton Use Nodes dans l’en-tête de l’éditeur de nœuds) ; ce panneau se
transforme en onglet pour cohabiter avec un onglet Nodes. Dans l’un
ou l’autre apparaît un bouton Add New, en rouge : vous avez soit la pos-
sibilité d’ajouter un nouveau nœud matériau (en cliquant le bouton
Add New), soit de rappeler le précédent matériau, ou n’importe quel
matériau nodal de la scène (choisissez-le grâce au bouton ascenseur
devant le bouton Add New).

• Deux nœuds ont normalement fait leur apparition : un nœud de type
Color (permettant de régler entre autres les couleurs spéculaires et diffuses
du matériau, mais aussi sa réflectivité) et un autre de type Output (per-
mettant de visualiser en temps réel le résultat du réseau de nœuds). Vous
noterez que chaque nœud dispose de connecteurs d’entrée en bas à
gauche, et de connecteurs de sortie en haut à droite. Ces connecteurs sont
de couleurs différentes, en fonction du type de liaison qu’ils admettent :
jaune (une couleur), bleu (un vecteur), gris (une valeur numérique).

Vous pouvez insérer autant de nœuds que nécessaire grâce à la touche
[Espace] qui appelle le menu Add, en fonction des résultats visuels que
vous souhaitez obtenir. Rien ne vaut l’expérimentation, mais vous trou-
verez tout de même ci-après une courte description de la plupart des
nœuds matériaux disponibles.

Figure 5–87
Activation des Nœuds matériaux

Figure 5–88
Le panneau Links and Pipeline complété 

pour éditer des nœuds matériaux

Figure 5–89
Chaque nœud dispose de connecteurs d’entrée 

et de connecteurs de sortie.
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Les principaux types de nœuds disponibles sont brièvement décrits ci-
dessous, mais ne sont pas limités à ceux-ci.
• Material : ce nœud vous permet d’ajouter un matériau à votre maté-

riau nodal, et en particulier de contrôler les couleurs diffuses (Color),
spéculaires (Spec), ainsi que la réflectivité (Ref) du matériau.

• Geometry : ce nœud est à utiliser conjointement avec des textures pour
en spécifier les coordonnées spatiales, présentant quelques options
identiques à celles de l’onglet Map Input dans les Material buttons.

• Texture : ce nœud vous permet d’intégrer une texture à votre réseau
nodal. À noter que la création de la texture, ainsi que son paramé-
trage, s’opèrent, pour l’instant, à partir des Textures buttons plutôt que
de l’éditeur de nœuds, bien que cela soit susceptible d’évoluer. Le
nœud Texture nécessite un vecteur (typiquement un nœud de type
Geometry) en entrée pour fonctionner.

• Output : ce nœud permet de visualiser l’apparence du shader et
d’envoyer le résultat au moteur de rendu. À noter que vous pouvez
insérer des nœuds Output intermédiaires afin de visualiser le résultat
de nœuds en certains points du réseau nodal. Seul le premier nœud
créé (avec l’icône sphérique rouge en haut à droite) témoigne du
résultat final, les autres sont des résultats intermédiaires.

Bases sur l’usage de l’éditeur de nœuds

Les informations qui suivent sont valides aussi bien pour les éditeurs de
nœuds Material que Composite.
• Vous pouvez ajouter de nouveaux nœuds, soit en utilisant la combi-

naison de touches [Maj]+[A], soit la touche [Espace], et en choisissant
dans le menu déroulant Add le type de nœud souhaité. Vous pouvez
également dupliquer un nœud existant grâce à la combinaison de
touches [Maj]+[D].

• Vous pouvez déplacer la vue de l’éditeur ou zoomer, comme dans une
vue 3D normale : pour zoomer, utilisez les touches [+] et [-] du pavé
numérique, ou la molette de la souris ; pour déplacer la vue, déplacez
la souris en maintenant le bouton central de la souris pressé.

• Vous pouvez faire des sélections simples en cliquant sur un nœud avec
le bouton droit de la souris (son titre apparaît alors en blanc), et
ajouter/enlever à la sélection grâce à la touche [Maj] et toujours le
bouton droit. La touche [A] permet de sélectionner tous les nœuds.

• Pour supprimer un nœud, les touches [X] et [Del] fonctionnent. Pour
déplacer un nœud (ou un groupe de nœuds sélectionnés), vous
pouvez utiliser la touche [G].

• Pour supprimer la liaison entre deux nœuds, utilisez le bouton gauche
de la souris pour dessiner une boîte de suppression : toutes les liaisons
coupées par la boîte dessinée seront supprimées.

ASTUCE   Placez des nœuds Output 
intermédiaires

Des résultats très fins nécessiteront certainement
un réseau nodal très complexe, et vous aurez par-
fois du mal à juger de l’influence de telle ou telle
branche sur le résultat final. Pour y regarder de
plus près, vous pouvez toujours insérer des nœuds
Output intermédiaires pour isoler et observer
plus facilement les effets d’une branche particu-
lière du réseau nodal. Pour les réseaux les plus
complexes, il est donc commun d’avoir un nœud
Output en sortie de chaque branche principale et
après chaque nœud Mix, par exemple.
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• Mix : ce nœud permet de mélanger deux couleurs (ou la sortie couleur
d’une texture) proportionnellement au facteur spécifié. Plusieurs
méthodes de mélange sont disponibles, l’ordre des couleurs étant
important ; la couleur la plus haute est affectée par la couleur la plus
basse, suivant la méthode Mix et le facteur spécifiés. Avec Fac égal à 0.00,
rien ne se passe.

• Mapping : ce nœud permet de spécifier, dans chacune des trois direc-
tions de la texture X, Y et Z , des translations (Loc), des rotations (Rot)
ou un changement d’échelle (Size) de celle-ci.

• ColorRamp : ce nœud permet de transformer une Value en un gradient
de couleur RGB et éventuellement de transparence.

• RGB to BW : ce nœud permet de transformer une couleur (typique-
ment une texture) en son équivalent en noir et blanc (correspondant à
une valeur comprise entre 0.0, noir, à 1.0, blanc).

• Value : ce nœud permet de spécifier une valeur numérique, qui servira
la plupart du temps d’entrée à un autre nœud.

• RGB : ce nœud permet de spécifier une couleur, qui servira la plupart
du temps d’entrée à un autre nœud.

Quelques exemples d’usage des matériaux nodaux
Vous trouverez ci-après quelques exemples de mise en œuvre des nœuds
matériaux. Ils sont suffisamment simples pour être rapidement assimilés,
et suffisamment intéressants pour être utilisés fréquemment. Toutefois,
de bonnes connaissances du système « classique » de matériaux et de tex-
tures sont souhaitables pour en tirer le meilleur parti, ce qui réserve l’édi-
teur de nœuds matériaux aux utilisateurs avancés de Blender.

Figure 5–90
Jungle Troll, © 2006 
par Tommy Gard Helgevold : 
http://www.hamsterking.com/blender.htm
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Simulation de SubSurface Scattering
L’image qui précède est un excellent exemple de l’usage simple mais
ingénieux des nœuds matériaux : ici, ils ont été utilisés pour simuler un
effet de type SubSurface Scattering sur un sujet « humain ». L’astuce con-
siste simplement à connecter la sortie Color du nœud matériau à l’entrée
Color d’un nœud RGBCurve (Add>RGB Curves), et enfin la sortie Color de
celui-ci à l’entrée Color du nœud final Output. Cela ne s’arrête toutefois
pas là, car ce nœud est en fait un mini-éditeur des courbes de couleur : il
permet de retoucher la « température » de chaque couleur individuelle
(en activant les canaux R, G et B, grâce aux boutons appropriés, et en
modifiant l’allure de la courbe) ou la couleur entière elle-même (en acti-
vant le canal C). Prenons pour exemple une couleur chair légèrement
orangée (R 0.850, G 0.563, et B 0.505). Par défaut, le nœud RGB Curve
présente la courbe de la couleur finale (canal C activé).

Avec le bouton gauche de la souris, vous allez d’abord déplacer le point en
bas à gauche pour l’amener en haut à gauche, puis le point en haut à
droite pour l’amener en bas à droite. Au lieu d’avoir une droite crois-
sante, vous aurez donc une droite décroissante. À ce stade, vous avez
inversé la couleur et l’éclairage : les facettes exposées à la lumière appa-
raissent sombres, tandis que celles qui sont occultées apparaissent claires.

Ensuite, toujours avec le bouton gauche de la souris, vous allez cliquer sur
la courbe, pour faire apparaître un point de contrôle, et déplacerez ce
point pour créer une inflexion de la courbe. Vous rééditerez cette action
pour avoir une courbe décroissante bien régulière. Enfin, vous dépla-
cerez le point, désormais en bas à droite, un peu plus haut, afin de créer
une asymptote horizontale (afin de ne pas trop assombrir le matériau :
ainsi, il n’y a pas de zones totalement obscures).

Figure 5–91
Inversion de couleur

et d’éclairage du nœud RBG Curve

Figure 5–92 Modification 
de la courbe de couleur du canal C
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Maintenant, retouchez chacun des canaux R, puis B et enfin G, tout en
observant les modifications dans le nœud Output pour recomposer une
couleur douce, proche de l’originale.

Évidemment, l’effet de SubSurface Scattering obtenu n’a rien de réaliste,
surtout en comparaison de ce qu’il est possible d’obtenir avec les paramè-
tres de shading appropriés, mais nous venons de voir comment utiliser
un nœud RGB Curve pour tricher et modifier la propagation de la
lumière, tout en obtenant un effet Toon des plus plaisants. En particu-
lier, nous avons un effet d’éclairage par l’arrière très intéressant pour

REMARQUE   Inversion de la pente du canal C du nœud RGB Curve

Pour comprendre cette inversion, voici ce que don-
nerait le nœud RGB Curve avec une inversion de
la pente du canal C sur un matériau blanc.
Ce qu’il est surtout important de comprendre,
c’est que la luminosité n’est pas vraiment
inversée, c’est en fait la couleur qui l’est. En con-
séquence, si vous faites de même avec un maté-
riau orangé, la couleur observée dans le nœud
Output sera donc une couleur bleutée. Il con-
viendra alors de retoucher également les canaux
R, G et B jusqu’à réobtenir la couleur de base
souhaitée ! Mais attention : si vous vous con-
tentez d’inverser la pente de chacune des compo-
santes de couleur, vous obtiendrez exactement la
même couleur de base qu’à l’origine, et perdrez le
bénéfice de l’inversion des zones sombres et
claires du shader.

Figure 5–93
Exemple d’application d’une inversion

de pente du canal C du nœud RGB Curve

Figure 5–94
Modifications 
des courbes de couleur RGB
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simuler l’aspect velouté de la peau, mais également la translucidité des
feuilles d’arbre, du gazon, etc., sans pour autant recourir aux méthodes
lourdes de simulation.

Un effet de bois verni
Dans ce second exemple, nous allons voir comment créer un effet de
vernis sur un matériau texturé déjà existant. Le vernis va révéler le maté-
riau qu’il recouvre, lorsque la direction de la caméra et la normale à la
surface au pixel considéré sont colinéaires ; plus l’angle entre la direction
de la caméra et la normale à la surface croîtra, plus le vernis paraîtra
blanc et opaque. Ce comportement, assez proche de l’effet Fresnel, déjà
abordé dans ce chapitre, est facile à reproduire avec des rampes de cou-
leur (menu Shading, touche [F5], onglet Ramps) et avec les matériaux
classiques de Blender, mais nous allons voir que l’usage de l’éditeur de
nœuds apporte une souplesse non moins intéressante.

La première étape va consister à connecter la sortie Normal du nœud
matériau à l’entrée correspondante d’un nœud Normal (Add>Vector>
Normal). La sortie Dot de cette dernière sera pour sa part connectée à
l’entrée Fac d’un nœud ColorRamp (Add>Convertors>ColorRamp), ce qui
aura pour effet de colorer les bords du sujet avec la couleur du premier cur-
seur défini dans la rampe. Le mélange des couleurs sera réalisé par un

Figure 5–95
L’édition de la courbe RGB
peut à elle seule permettre

une simulation simple et
rapide du SSS (SubSurface

Scattering) et d’un éclairage
par l’arrière du sujet.
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nœud de type Mix (Add>Color>Mix) : la première Color d’entrée sera con-
nectée à la sortie Color du nœud ColorRamp, tandis que la seconde Color
d’entrée sera reliée à la sortie Color du nœud matériau initial. Bien sûr, la
sortie Color du nœud Mix sera reliée à l’entrée Color du nœud Output pour
boucler le shader matériau. Mais pour l’instant, c’est la couleur du premier
curseur (noir) qui s’impose sur les bords du sujet. Pour y remédier, dans le
nœud ColorRamp, changez la couleur du premier curseur à blanc, et celle
du second curseur à noir. Ensuite, modifiez le type de mélange du nœud
Mix, en remplaçant Mix par Add, et augmentez la valeur Fac à 1.00.

Bien sûr, vous pouvez faire varier la valeur Fac pour obtenir un résultat
plus satisfaisant, ainsi que contrôler plus précisément la rampe de cou-
leur en ajoutant et/ou déplaçant des curseurs de couleur.

Mélanger deux matériaux
Une facette ne peut se voir attribuer qu’un seul matériau, lui-même
composé, au plus, de l’empilement de 10 textures. Le maillage du sujet
peut, pour sa part, faire usage de 16 matériaux différents, au moyen de
l’usage des indices matériaux, mais une facette individuelle ne peut être

Figure 5–96 Grâce au nœud Normal et à une rampe de couleur, il est possible de simuler facilement 
l’opacité d’une surface sous certains angles d’observation, à l’instar de l’effet Fresnel.
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affectée exclusivement qu’à l’un ou l’autre de ces indices matériaux, ce
qui est une limitation sérieuse à la liberté artistique. L’éditeur de nœuds
a en particulier été développé pour pallier cette limitation, dans le cadre
du studio Orange, qui a réalisé le court métrage d’animation Elephants
Dream. Nous allons voir comment nous pouvons, assez simplement,
mêler deux matériaux distincts, pour créer un shader unique mêlant les
propriétés particulières de chacun.

Commencez par insérer deux nœuds matériaux (Add>Input>Material) ;
utilisez le bouton Add New pour en créer de nouveaux, ou utilisez le
sélecteur pour appeler des matériaux préexistants. Ceux-ci peuvent être
aussi complexes que souhaités, comme faire appel à des textures. Dans
notre exemple, nous utiliserons deux matériaux très simples, l’un de cou-

Figure 5–97 Grâce au nœud Mix et à une texture, il est possible de mélanger deux matériaux complexes selon le motif souhaité.
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leur rouge, l’autre de couleur verte. Reliez la sortie Color de chacun de
ces nœuds matériaux à l’une des entrées Color d’un nœud de type Mix
(Add>Color>Mix), et la sortie Color de celui-ci à l’entrée correspondante
du nœud Output. À ce stade, les deux couleurs ont été mélangées pour
donner un brun doré uniforme, mais il est possible d’obtenir des résul-
tats beaucoup plus subtils. Insérez maintenant un nœud Texture
(Add>Input>Texture, choisissez à l’aide du sélecteur une texture noir et
blanc existante, par exemple une texture procédurale de type Clouds), et
connectez sa sortie Value à l’entrée Fac d’un nœud ColorRamp (Add>Con-
vertors>ColorRamp). Ensuite, reliez sa sortie Color à l’entrée Fac du nœud
Mix : Blender insère automatiquement un nœud RGB pour transformer la
couleur de la rampe en une valeur exploitable par le nœud Mix. La magie
du nœud Mix opère alors : les deux matériaux se sont mélangés selon le
motif utilisé en guise de texture.

Bien sûr, il est possible de créer des transitions très intéressantes entre les
deux matériaux en exploitant diverses textures, aussi bien procédurales (de
type Blend, par exemple) ou image (en noir et blanc de préférence, quoi
qu’un nœud de type Convertors : RGB to BW puisse résoudre le problème).

Outils spéciaux de mise en couleurs : 
les modificateurs
Les modificateurs affectant les matériaux ne sont pas très nombreux. Il
est possible de les mettre en œuvre au travers du panneau Modifiers du
menu Editing (touche [F9]) : le bouton Add Modifier permet d’afficher une
liste déroulante des modificateurs disponibles. La plupart sont plus par-
ticulièrement étudiés dans les chapitres 4, Techniques de modélisation et 7,
Techniques d’animation fondamentales.

Le modificateur UV Project (projection UV)
Ce modificateur permet de projeter littéralement une texture UV sur un
maillage, depuis un objet défini comme étant le projecteur. Vous pouvez
alors déplacer ou faire tourner votre projecteur, et l’image projetée suit
les mêmes transformations. Au préalable, votre objet devra avoir été
déplié, car ce modificateur transforme les coordonnées UV, sans les
créer. Pour que la texture soit visible au rendu, le bouton TexFace doit être
actif, comme pour tout modèle utilisant une cartographie UV.

Les champs AspX et AspY permettent de modifier le ratio d’aspect de
l’image projetée. Le bouton numérique Projectors permet de définir le
nombre de projecteurs dont le modificateur doit tenir compte, un

Figure 5–98
Le modificateur UV Project
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champ Ob: permettant d’identifier nommément chacun d’eux (attention
à respecter la casse et l’orthographe du projecteur, comme d’habitude).
Le type de projection est automatiquement orthographique, sauf si le
projecteur est une caméra, auquel cas la projection n’est orthographique
que si l’option Orthographic est active dans le panneau Camera. Le
champ Image est très particulier :
• laissé vide, il indique que l’image du projecteur affecte toutes les

facettes de l’objet ;
• si un nom d’image y figure, cela signifie que seules les facettes associées

à cette image lors du dépliage sont affectées par l’image projetée.

Le bouton Override Image permet d’imposer à la facette l’image désignée par
le champ Image même si elle était normalement associée à une autre image.

ASTUCE   À quel usage réserver ce modificateur ?

De façon basique, vous pouvez très bien projeter une image à la surface
d’un objet en assignant simplement une texture à une lampe de type
Spot, par exemple. La principale différence est qu’avec le modificateur
UVProject, vous pouvez utiliser le bouton Apply pour enregistrer définiti-
vement le résultat dans la carte UV de l’objet déplié.
Cette méthode se révèle très pratique, par exemple, pour bâtir rapide-
ment des prototypes de cartes UV lorsque votre projet comprend de nom-
breuses parties planes, sans avoir à tout déplier d’emblée : vous pouvez
donc modéliser et texturer tout en progressant (en ajoutant des caméras
orientées perpendiculairement aux surfaces et dirigées vers celles-ci ; vous
ajoutez ensuite le modificateur UVProject et, interactivement, dans la vue
3D texturée, vous déplacez le projecteur jusqu’à obtenir l’échelle et le
positionnement souhaités de la texture sur l’objet, très facilement). Une
fois le prototype terminé, vous dépliez votre modèle normalement et
appliquez les derniers ajustements aux caméras. Une fois satisfait du
résultat, vous cliquez sur le bouton Apply du modificateur et la texture est
dès lors parfaitement plaquée sur votre objet.



5 
– 

M
aî

tr
ise

r l
es

 m
at

ér
ia

ux
 d

e 
Bl

en
de

r

© Groupe Eyrolles, 2008 205

Figure 5–99
Le mur de briques et le sol ont été texturés 
grâce au modificateur UV Project. Le banc, 
la poubelle et le journal sont des modèles 
téléchargés sur le site d’Andrew Kator : 
http://www.katorlegaz.com/3d_models/index.php
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chapitre 6

Bodie Island in the Outer Banks of North Carolina, © 2005 par D. Roland Hess
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Techniques d’illumination

Ce chapitre propose de découvrir les différentes formes 
d’illumination des scènes en trois dimensions. Les plus simples 
couvrent l’utilisation de diverses lampes, et les plus complexes 
font appel à des notions d’illumination globale (radiosité) ou 
simulent celle-ci (occlusion ambiante).

Utiliser des sources lumineuses pour éclairer une scène en trois 
dimensions est une démarche logique et naturelle. Idéalement, 
l’artiste placera de nombreuses lumières ici et là, afin de 
simuler le plus fidèlement possible un éclairage réaliste. Mais 
souvent, la pratique est toute autre : l’artiste débutant se 
contente d’une source lumineuse unique, celle par défaut la 
plupart du temps. S’il n’y a aucune contre-indication réelle à 
procéder de la sorte, la scène perd généralement en profondeur, 
en chaleur, en ambiance. Au même titre qu’une modélisation 
bâclée ou un texturage pauvre ou inexistant, un mauvais 
éclairage peut totalement ruiner une scène.

Nous allons aborder dans ce chapitre les techniques offertes 
par Blender pour produire des éclairages intéressants, ainsi que 
nombre d’astuces qui vous aideront à installer des ambiances 
particulières et à rehausser le réalisme de vos scènes.

SOMMAIRE

B Les différentes lampes 
proposées par Blender

B Éclairage par la méthode 
de l’occlusion ambiante

B Éclairage par la méthode 
de la radiosité

MOTS-CLÉS

B Lamp
B Spot
B Area
B Sun
B Hemi
B Ombres
B Ambient Occlusion
B Samples
B Carte angulaire
B Radiosity
B Global Illumination
B HDRI
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Utilisation des lampes
Contrairement aux objets peuplant vos scènes, dans Blender, les lampes
n’ont aucune limite géométrique définie (à l’exception des aires lumi-
neuses, comme nous le verrons plus loin) ; elles se contentent d’émettre
des rayons lumineux selon des règles propres au type de lampe. Si le
rayon de lumière intercepte une face, le pixel correspondant de l’image
rendue sera illuminé ; dans le cas contraire, il sera ombré.

Par conséquent, si vous braquez une caméra en direction d’une lampe,
celle-ci n’apparaîtra tout simplement pas au rendu. Seules les taches spé-
culaires sur les objets de la scène pourront trahir la présence d’une lampe.

Les ombres par le shadow buffering
En tant que moteur de rendu de type scanline, Blender repose sur la
technique des shadow buffers pour la génération des ombres, mais seule la
lampe de type Spot peut générer de telles ombres, ce qui peut être un
handicap dans le cas de scènes à l’éclairage complexe. Pour pouvoir
mettre en œuvre le shadow buffering, l’option Shadow du panneau
Render des Render buttons (menu Scene, touche [F10]) doit être actif ;
dans le panneau Shadow and Spot des Lamp buttons de la lampe de type
Spot, le bouton Buf.Shadow doit également être actif.

Étant propre au moteur de rendu de type scanline, les ombres produites
par la technique du shadow buffering ne seront visibles ni dans les
reflets, ni au travers des surfaces transparentes obtenues par lancer de
rayons (raytracing).

Deux méthodes de shadow buffering sont disponibles. Il en existe égale-
ment une troisième, qui est une variante de la première.

Le shadow buffer classique

Cette technique consiste à générer une image, dont le point de vue serait
la lampe, et qui stockerait la distance Z entre les surfaces et la lampe,
pour chaque pixel de l’image ainsi créée. Le moteur de rendu se sert
alors des valeurs Z ainsi relevées pour déterminer si, pour un pixel rendu,
il reçoit ou non de l’ombre. La génération du shadow buffer pouvant être
assimilée à un rendu, sa résolution revêt une importance particulière
puisque sans anti-crénelage spécifique, les frontières de l’ombre sont
toujours en dents de scie et il faut rééchantillonner l’ombre pour en
obtenir une suffisamment lisse pour être crédible. De même, les
paramètres ClipSta et ClipEnd peuvent avoir une influence directe sur la
qualité des ombres obtenues, et il est nécessaire de les régler le plus fine-
ment possible.
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La résolution du shadow buffer est tout simplement conditionnée par le
paramètre ShadowBufferSize disponible dans le panneau Shadow and Spot :
plus la valeur est élevée, plus les ombres paraîtront lisses. Il est également
possible d’appliquer un filtre aux échantillons d’ombre, parmi Box, Tent et
Gauss, ce dernier étant celui qui donnera les résultats les plus flous. Le
paramètre Soft permet d’adoucir les ombres, comme si elles étaient émises
par une lampe de type Area, le paramètre Samples permettant alors d’aug-
menter leur échantillonnage et donc de les rendre plus progressives.

Enfin, il est également possible d’augmenter artificiellement le nombre
de lampes utilisées pour l’échantillonnage grâce au bouton SampleBuffers.
Attention toutefois, car au-delà de la valeur par défaut (1 échantillon),
utiliser 4 ou 9 échantillons multiplie d’autant les temps de génération du
shadow buffer. Les améliorations sont particulièrement visibles avec les
lampes dotées de faibles ShadowBufferSize et Samples (par exemple, res-
pectivement 512 et 1) ou dans le cadre d’animations où les ombres ten-
daient à être irrégulières.

Une juste combinaison de ShadowBufferSize, Samples et SampleBuffers
associée à un filtre Gauss permet donc d’obtenir des ombres de qualité
acceptable tout en conservant une excellente vitesse de rendu, compara-
tivement aux autres méthodes de génération d’ombres. Cela est d’autant
plus vrai que le nombre de lampes dans la scène est important.

L’irregular shadow buffer

Il s’agit d’une méthode alternative à la précédente. Plutôt que de stocker
dans une image la distance entre la lampe et les surfaces visibles depuis
celle-ci, tous les pixels de l’image à rendre (depuis le point de vue de la
caméra) sont échantillonnés et stockés dans la mémoire de la lampe. Tous
les échantillons sont ensuite testés individuellement afin de savoir s’ils
reçoivent ou non de l’ombre, produisant au final des ombres de qualité
égale à celles obtenues par raytracing (voir ci-après). S’il est toujours
nécessaire de régler les paramètres ClipSta et ClipEnd pour définir la portée
du spot, ces paramètres n’ont désormais plus d’influence sur la qualité de
l’ombre produite. Toutefois, si les ombres obtenues sont de grande qualité,

ASTUCE   Réglage automatique de ClipSta et ClipEnd

Dans le panneau Shadow and Spot, les paramètres ClipSta et ClipEnd sont précédés par
un petit bouton représentant une automobile. En l’activant (individuellement pour chaque
paramètre), la valeur correspondante est automatiquement déterminée, sur la base des som-
mets visibles depuis la lampe.
Il convient normalement de régler ClipSta au plus proche de la surface du premier objet
émettant de l’ombre, et ClipEnd immédiatement après le dernier objet projetant de l’ombre.
De cette façon, les valeurs Z, qui sont stockées dans une image en dégradés de gris
(256 couleurs) occupent le maximum de la partie utile du dégradé.

Figure 6–1

Figure 6–2
Les boutons permettent de contrôler 

l’apparence des ombres du Buffer

Figure 6–3
Réglage de l’échantillonnage 

des ombres du Buffer

ASTUCE  Bias et LBias

La valeur Bias de la lampe est à augmenter
lorsque l’éclairage produit un effet moiré indési-
rable à la surface des objets. L’inconvénient est
qu’une valeur trop élevée peut « délaver » l’ombre
obtenue, et trouver le juste compromis pour tous
les objets de la scène peut se révéler être un vrai
casse-tête. 
Le paramètre LBias qui se trouve dans le panneau
Shaders (menu Shading>Material Buttons)
est justement un facteur multiplicatif permettant
de moduler les effets de la valeur Bias seulement
sur le matériau en question. Cela permet ainsi de
doser l’effet du Bias de la lampe en fonction des
besoins de la scène.
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il n’est pas possible de les adoucir, comme c’est le cas avec la méthode clas-
sique. En revanche, là où la méthode classique échoue à produire des
ombres transparentes (ombres tenant compte de la transparence de l’objet
émetteur), cet exploit devient possible avec la méthode irrégulière. Dans le
panneau Material, des Material buttons, menu Shading (touche [F5]) d’un
objet devant projeter des ombres transparentes se trouve un
paramètre Shad A pour lequel une valeur nulle indique une transparence
totale, tandis qu’une valeur de 1.000 indique une opacité totale.

La méthode classique dite « à mi-chemin »

Cette méthode permet de diminuer l’effet de biais (biasing) inhérent à la
première méthode, en prenant la moyenne entre la valeur Z la plus
proche et la deuxième valeur immédiatement la plus proche. Le biais est
un phénomène qui va produire, à la surface des objets ombrés, un effet
de moiré. En augmentant le paramètre Bias, vous diminuerez ce phéno-
mène, mais la méthode Classical Half-Way a déjà tendance à le limiter.

Les ombres par le raytracing
En tant que moteur de rendu de type raytracer, Blender offre la possibi-
lité de lancer, pour chaque lampe, un certain nombre de rayons supplé-

OMBRES   Quelle méthode choisir ?

Entre shadow buffering classique et raytracing, tout est affaire de com-
promis. En règle générale, on peut retenir les faits suivants au sujet du
shadow buffering :
• ombres imparfaites, nécessitant de nombreux réglages pour un

résultat fin ;
• peu gourmand en puissance de calcul, et donc rapide ;
• ombres douces faciles à obtenir, sans grand effort supplémentaire ;
• possibilité de générer des halos de lumière volumétrique ;
• limité aux lampes de type Spot.
Pour leur part, on peut retenir les choses suivantes au sujet des ombres
obtenues par raytracing :
• ombres parfaites, sans aucun réglage ;
• très gourmand en puissance de calcul, et donc lent ;
• ombres douces faciles à obtenir mais encore plus gourmandes en

puissance et en temps de calcul ;
• lumières volumétriques impossibles à mettre en place ;
• toutes les lampes (à l’exception d’Hemi) peuvent émettre des ombres.
Souvent, l’artiste 3D n’hésite pas à combiner ces deux méthodes d’éclai-
rage pour tirer le meilleur de chacune. Par exemple, dans une scène nor-
malement éclairée par la méthode du raytracing, un Spot (sans ombres !)
avec les options No Diffuse, No Specular et Halo actives, permettront
d’obtenir un effet de lumière volumétrique.

Figure 6–4
Le paramètre Shad A sert à régler 

l’opacité des ombres transparentes.



6 
– 

Te
ch

ni
qu

es
 d

’il
lu

m
in

at
io

n

© Groupe Eyrolles, 2008 211

mentaires. Les pixels correspondant à des faces interceptées par ces
rayons sont alors illuminés, et ceux correspondant à des faces non inter-
ceptées restent logiquement dans l’ombre. L’avantage est sans conteste la
simplicité de la mise en œuvre de cette méthode d’ombrage, et l’obten-
tion d’ombres toujours nettes et parfaites. En revanche, chaque rayon
lancé demande du temps de calcul supplémentaire, et plus grand sera le
nombre de lampes dans votre scène, plus grande sera la puissance de
calcul nécessaire pour venir à bout de toutes les ombres de celle-ci. Les
options Shadow et Ray du panneau Render des Render buttons (menu
Scene, touche [F10]) doivent être actives pour bénéficier de ces ombres-ci.
De plus, dans le panneau Shadow and Spot des Lamp buttons de la lampe
active, le bouton Ray Shadow doit également être actif.

Réglages des lampes
L’interface des lampes est très similaire d’un type de lampe à l’autre. En
fonction du type, des options supplémentaires apparaissent dans le
panneau Lamp (qui permet au sens propre de définir la source d’éclairage)
et le panneau Shadow and Spot (qui, comme son nom l’indique en anglais,
permet de paramétrer les ombres ou les options particulières de la lampe de
type Spot). Dans tout ce qui suit, l’accent est surtout mis sur l’usage de
lampes ayant l’option Ray Shadow active dans le panneau Shadow and Spot.

Le panneau Lamp
• R,G,B : notez tout d’abord la disponibilité de trois curseurs R, G et B,

qui permettent respectivement de déterminer la couleur de la lumière
émise par la lampe au travers des trois composantes fondamentales de
l’informatique Red (rouge), Green (vert) et Blue (bleu).

• Energy : le curseur Energy détermine l’intensité lumineuse à la source.
• Dist : à une distance égale au paramètre Dist (en unités de Blender),

l’intensité lumineuse n’est plus égale qu’à la moitié de l’énergie initiale.
• Quatre boutons optionnels sont également présents pour vous aider à

obtenir des réglages lumineux particuliers.
• Layer : en activant cette option, la lampe n’éclairera que les objets

situés sur le même calque qu’elle.
• Negative : l’énergie de la lampe est soustraite à la luminosité de la

scène plutôt que d’y contribuer.
• No Diffuse : la lampe produit des ombres (si l’option appropriée est

activée), des reflets spéculaires (pour peu que le matériau de l’objet
éclairé en spécifie) mais n’éclaire pas l’objet. Utile pour enrichir les
reflets spéculaires d’une scène sans pour autant compliquer la mise en
scène lumineuse.

Figure 6–5
Le panneau Lamp
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• No Specular : cette fois-ci, la lampe se contente d’éclairer les objets et
de produire des ombres si l’option appropriée est activée. En désacti-
vant les ombres, et en utilisant des valeurs Dist et Energy très faibles,
on parvient, par un placement judicieux de lampes colorées de ce
type, à simuler un effet de radiosité ou d’illumination globale.

Le panneau Shadow and Spot
• Ray Shadow : ce bouton (activé par défaut) indique que la lampe peut

projeter des ombres par la méthode du raytracing.
• Only Shadow : ce bouton indique que la lampe se contente de projeter

des ombres, mais ne contribue ni à l’éclairage de la scène, ni aux
reflets spéculaires de celle-ci.

Lorsque Ray Shadow est actif, il est possible de demander aux lampes de
simuler la projection d’ombres douces, comme si la lumière était émise à
partir d’une surface plutôt que d’un point : cette surface émettrice est
soit un disque (type Spot ou Sun), soit un rectangle (type Area), soit une
sphère (type Lamp).

L’échantillonnage des ombres douces est réalisé selon deux méthodes :
Adaptive QMC ou Constant QMC (voir chapitre 5, Maîtriser les matériaux
de Blender). La première est plus rapide à calculer, mais la seconde pro-
duit des ombres plus régulières et moins bruitées.
• Soft Size : ce paramètre détermine, en unités de Blender, la taille de

l’aire lumineuse générant les ombres douces. Plus cette valeur sera
grande, plus les ombres seront diffuses.

• Samples : plus l’échantillonnage est élevé, moins les ombres paraissent
bruitées. En revanche, elles en sont d’autant plus longues à calculer !
Les ombres dures sont obtenues avec une valeur d’échantillons égale
à 1, la valeur par défaut.

Figure 6–6
Le panneau Shadow and Spot

Figure 6–7
Le paramètre Soft Size

change radicalement l’allure
des ombres projetées ! Ici,
des valeurs respectivement

égale à 1.000 et 5.000.
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• Threshold : ce paramètre n’est utile que dans le cas de l’Adaptive QMC
et permet de déterminer le seuil en-dessous duquel l’échantillonnage
des ombres doit être stoppé. Par conséquent, plus cette valeur sera
élevée, plus le résultat paraîtra bruité.

Les différentes lampes : présentation et usage
Une lampe unique suffit pour éclairer une scène. Mais souvent, le
résultat sera sans relief et peu attrayant. Pour communiquer une
ambiance ou une atmosphère à vos scènes, pour les dynamiser ou encore
les rendre attrayantes ou plus réalistes, vous devrez la plupart du temps
combiner différents types de lampes pour parvenir au résultat recherché.
Cette partie va donc consister à présenter les différents types de lampes
existants, ainsi que leur usage.

Chaque type de lampe propose une courte description, des conseils sur
son usage, sa représentation dans les vues 3D, ainsi qu’un exemple d’uti-
lisation, où sa position et son orientation sont simulées par un objet res-
semblant.

La lampe (Lamp)
Il s’agit du type de lampe le plus classique ; la lumière irradie à partir
d’un point central, dans toutes les directions, et son intensité décroît
avec la distance. La lampe est utilisée pour la simulation de toutes les
lumières dites ponctuelles, comme les ampoules, les bougies, les étin-
celles, les diodes, etc.

3DS MAX   Les différents types de lampes

Les principales sources de lumière de 3ds max
existent également dans Blender, avec des noms
parfois légèrement différents : le projecteur est
l’équivalent de Spot ; la lumière directionnelle de
Sun ; l’éclairage omnidirectionnel de Lamp ; et
enfin, le dôme de lumière est l’équivalent de
Hemi. D’autres types de lampes existent dans
chacun des deux logiciels.

Figure 6–8
L’objet Lamp dans les vues 3D

Figure 6–9
La lampe distribue ses rayons lumineux uniformément, 
et leur intensité diminue avec la distance.
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Contrôler l’atténuation lumineuse des lampes

Il est possible de spécifier avec quelle intensité l’énergie lumineuse pro-
page depuis la lampe, en fonction de la distance parcourue (paramètre
Dist). Le menu déroulant Lamp falloff nous permet d’accéder aux diffé-
rentes options possibles.

• Constant : l’intensité lumineuse ne décroît pas avec la distance, ce qui est
pratique pour simuler l’éclairage du soleil, par exemple. C’est le type
d’atténuation dont bénéficient automatiquement les lampes de type Sun
et Hemi.

• Inverse Linear : la lumière s’atténue de façon linéaire, le long de son
parcours, en fonction de la valeur Dist qui a été spécifiée. Si l’option
Sphere n’est pas activée, elle perd la moitié de son intensité lorsqu’elle
parcourt une distance égale à Dist. C’est l’option par défaut.

• Inverse Square : l’intensité lumineuse est très sensible à la distance
parcourue. Elle s’atténue très rapidement, ce qui est idéal pour l’éclai-
rage fourni par une ampoule ou une lampe de bureau, par exemple.

• Lin/Quad Weighted : cette option est assez proche de la précédente,
sauf qu’il est possible de contrôler les parts respectives d’atténuation
linéaire et quadratique, exprimés par des valeurs comprises entre

Figure 6–10
Illustration de l’atténuation

de la lumière en fonction
des différentes options :
Constant, Inverse Linear,

Inverse Square
et Custom Curve
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0.000 et 1.000. Le paramètre Linear permet de définir le taux d’atté-
nuation linéaire de la lampe, tandis que Quad permet de définir le
taux d’atténuation quadratique de la lampe.

• Custom Curve : cette option permet d’invoquer un panneau supplé-
mentaire Falloff Curve pouvant contrôler précisément et graphique-
ment l’atténuation de la lampe. L’abscisse symbolise la distance, de 0
à la valeur Dist. L’ordonnée, pour sa part, représente l’intensité de la
lumière, depuis la valeur Energy jusqu’à 0. Il est ainsi possible de pro-
duire des éclairages totalement irréalistes en manipulant la courbe
d’atténuation, par exemple en lui donnant plusieurs pics et creux.

• Sphere : cette option modifie le comportement du paramètre Dist. À
une distance égale à Dist (en unités de Blender), l’intensité lumineuse
devient nulle au lieu d’être moitié moindre. Cela est particulièrement
utile lorsque vous souhaitez simuler une illumination globale au moyen
de lampes colorées avec des valeurs Dist et Energy très faibles. À noter
que dans les vues 3D, la lampe s’entoure d’un cercle de rayon égal à Dist
pour vous aider à matérialiser la zone d’effet de la lampe Sphere.

L’aire lumineuse (Area)
L’origine de la lumière n’est cette fois plus ponctuelle, mais surfacique,
d’où le nom de cette lampe : Area. De plus, son orientation impose la
direction de l’éclairage. Il est possible de spécifier les longueur et largeur
de l’aire, de sorte qu’elle puisse être carrée ou rectangulaire. L’aire est uti-
lisée pour la simulation de toutes les lumières surfaciques, comme celle
irradiant des fenêtres, des écrans ou des néons. En fonction des réglages,
elle permet d’obtenir des ombres très douces.

Paramétrages particuliers de la lampe Area

Il vous est possible de spécifier dans le panneau Lamp une forme carrée
(option Square) ou rectangulaire (option Rect) à votre Area ; Blender vous
propose alors de définir la longueur du côté du carré grâce à un bouton
numérique Size, ou les longueurs des deux côtés du rectangle grâce aux
boutons numériques SizeX et SizeY. L’éclairage sera d’autant plus réaliste

Figure 6–11
Exemple d’atténuation personnalisée, 
alternant surexpositions et sous-expositions !

Figure 6–12
L’objet Area dans les vues 3D
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que les dimensions de l’Area seront proches de la source « physique » de
votre scène, comme une large fenêtre rectangulaire.

Dans le panneau Shadow and Lamp, vous prêterez une attention particu-
lière aux boutons numériques SamplesX et SamplesY qui, dans le cas où
vous souhaiteriez produire des ombres douces, permettent de régler
l’échantillonnage de l’ombre. Bien sûr, plus vous augmenterez ces
valeurs, plus les ombres seront douces mais plus les temps de calcul
seront importants.

Enfin, l’usage conjoint des boutons Dither et Noise permet de tricher, en
suréchantillonnant artificiellement les ombres lorsque vous préférez privi-
légier le temps de calcul et en maintenant SamplesX et SamplesY assez fai-
bles. Quant au bouton Umbra, il permet de renforcer le cœur des zones
d’ombre pour un éclairage plus dur tout en conservant des ombres douces.

Le Spot
La lumière est émise à partir d’un point, mais de façon directionnelle et
dans un volume conscrit par un cône. Les résultats du Spot peuvent être
très théâtraux, et ce type de lampe est régulièrement utilisé pour attirer
l’attention du spectateur sur un objet ou un point précis de la scène. Le
Spot est utilisé pour la simulation des feux de voiture, des lampes torches,
ou tout autre type d’éclairage très directionnel. C’est le seul type de
lampe capable de produire des halos lumineux.

3DS MAX   Les effets de rendu d’éclairage

À l’instar de 3ds max, Blender permet également
une petite panoplie d’effets de rendu d’éclairage,
mais ils sont organisés très différemment. Par
exemple, l’effet Glow est le résultat d’un post-trai-
tement de l’image (discuté dans le chapitre 9, Le
rendu avec Blender). Les effets Ring, Ray et
Star sont des options de Halo (voir le chapitre 5,
Maîtriser les matériaux de Blender) et
s’appliquent donc à des maillages (ou pour le
moins, à des sommets uniques).

Figure 6–13
Les rayons lumineux sont émis
par une surface, et permettent

l’obtention d’ombres douces.

Figure 6–14
L’objet Spot dans les vues 3D
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Les paramètres propres au Spot

Ils sont définis dans le panneau Shadow and Spot. Pour un usage courant,
deux paramètres vous intéresseront particulièrement : le curseur Spot Si, qui
permet de déterminer, en degrés, l’angle d’ouverture du spot ; et le
curseur Spot Bl, qui détermine le gradient de transition entre la zone éclairée
par le spot et la zone d’ombre au-delà du cône de lumière. Une faible valeur
indique une transition très brutale, aux frontières très dures ; une valeur élevée
indique une zone de pénombre importante et une transition très progressive.

Figure 6–15
Le Spot émet un cône de lumière, 
autorisant des mises en scène très théâtrales.

ASTUCE   Projection d’ombres

Quel que soit le type de lampe (y compris Hemi), vous pouvez lui attribuer une texture, exac-
tement comme s’il s’agissait d’un objet. Pour ce faire, cliquez sur le bouton Add New de
l’onglet Texture and Input des Lamp buttons, puis définissez celle-ci normalement dans
les Texture buttons (touche [F6]). L’onglet Map to des Lamp buttons permet de régler le
comportement de la texture vis-à-vis de la lampe. Par exemple, l’image suivante sera projetée
sur la scène entière, vous évitant de modéliser la grille qui aurait dû projeter de telles ombres.

Figure 6–17 Exemple « bitmap » 
d’ombre à projeter

Figure 6–18 L’ombre « bitmap » 
est projetée sur la scène.

ASTUCE  Lumière volumétrique

Par souci de simplicité, nous n’avons abordé que la
technique du raytracing pour la production
d’ombres. Mais l’usage du Shadow Buffering (en
activant le bouton Buf. Shadow disponible pour
les spots dans le panneau Shadow and Spot)
permet un effet intéressant : matérialiser le cône de
lumière du spot, sous forme de halo. Cet effet est
intéressant pour simuler la lumière s’échappant des
combles d’un grenier ou de la frondaison d’une
voûte sylvestre. Il faut alors activer le bouton Halo
et déterminer la fréquence d’échantillonnage de
celui-ci grâce au bouton numérique Halo Step. En
plaçant ensuite des obstacles sur la course du ou
des spots émetteurs de halo, vous devriez obtenir de
jolis effets de lumière cascadant du ciel.

Figure 6–16 L’option Halo en action
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Le soleil (Sun)
Ce type de lampe n’est défini que par son orientation, et l’intensité lumi-
neuse de ses rayons est constante en fonction de la distance. Vous pouvez
donc placer un objet Sun rigoureusement n’importe où dans votre scène
(même sous le sol !), celle-ci sera éclairée de la même façon. Elle est bien
sûr prévue pour simuler le soleil, mais également toute source de lumière
située à une distance infinie. Ce type de lampe est idéal pour les scènes
d’extérieur simulant un temps très ensoleillé.

L’hémi (Hemi)
Ce type de lampe est très similaire au Sun dans le sens où sa position
n’influe pas sur l’éclairage de la scène ; mais au lieu de projeter des rayons
parallèles les uns aux autres depuis une origine « infiniment distante »,
les rayons sont tirés selon une distribution hémisphérique. Hemi est
idéale pour l’obtention d’un éclairage très diffus, parfaitement adapté à
l’illumination des scènes d’extérieur par temps couvert ou nuageux. Tou-
tefois, c’est le seul type de lampe qui soit totalement incapable de pro-
jeter des ombres, donc pour un plus grand réalisme, il devra être utilisé
conjointement à une ou plusieurs autres lampes.

Figure 6–19
L’objet Sun dans les vues 3D

Figure 6–20
Peu importe la position de la lampe de type

Sun : seule la direction de ses rayons importe à
l’éclairage de vos scènes.

3DS MAX   Exclusion d’objets

Dans 3ds max, vous pouvez exclure certains objets de la liste des objets éclairés par une lampe
grâce au bouton Exclure de la section Paramètres généraux. Dans Blender, la philosophie
est légèrement différente, puisque chaque lampe présente un bouton Layer qui, s’il est actif,
permet d’indiquer qu’elle n’éclaire que les objets présents sur le même calque qu’elle. Il est donc
également possible dans Blender d’exclure des objets de l’éclairage d’une lampe, mais au prix
d’une organisation rigoureuse et logique des objets de votre scène dans différents calques.

Figure 6–21
L’objet Hemi dans les vues 3D
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Occlusion ambiante par lancer de rayons
Cette méthode d’illumination a pour objet la simulation de l’éclairage
d’une scène obtenue par illumination globale, c’est-à-dire une lumière
qui remplit la scène et produit des ombres très douces. Le principe en est
relativement simple : pour chaque pixel de l’image finalement rendu, le
logiciel va lancer une poignée de rayons dans à peu près toutes les direc-
tions, et déterminer ainsi la proportion de rayons qui aboutissent
jusqu’au « ciel » ou qui terminent leur course contre un objet. Dans le
premier cas, le rayon indique que le pixel est éclairé, et dans le second,
qu’il est obscurci par un obstacle (la notion d’occlusion vient de ce
résultat). Le pixel est alors obscurci ou éclairé proportionnellement aux
indications des rayons, produisant des ombres plus ou moins douces.

Figure 6–22
L’hémi ne projette pas d’ombre, 
mais fonctionne comme un soleil 
hémisphérique plutôt qu’infiniment distant.

Figure 6–23
Éclairage d’une scène par la méthode de 
l’occlusion ambiante seule
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Ce type d’éclairage est idéal pour des scènes d’extérieur, par temps couvert
ou plafond nuageux particulièrement bas. Il peut toutefois être couplé à
l’usage d’une ou plusieurs lampes conventionnelles pour apporter à l’éclai-
rage de la scène une dimension supplémentaire. Par exemple, l’image qui
suit présente la même scène que précédemment, mais avec l’ajout d’une
simple lampe, parfaite pour simuler un extérieur ensoleillé !

Distribution des rayons
Bien sûr, le nombre de rayons lancés va être crucial pour la qualité ou la
densité des ombres obtenues, mais en contrepartie, plus il sera élevé, plus
les temps de calcul seront longs. Un menu déroulant permet toutefois de
choisir la méthode de distribution la plus appropriée à votre scène.
• Constant QMC : il s’agit de la méthode par défaut, les rayons étant émis

uniformément afin d’échantillonner l’environnement. Bien qu’étant la
méthode la plus longue, elle est celle qui produit les ombres de la
meilleure qualité. L’échantillonnage est en effet le plus progressif.

• Adaptive QMC : cette méthode est particulièrement adaptée aux
images présentant de forts contrastes lumineux.
– Threshold : ce paramètre permet de définir la sensibilité de détection des

zones éclairées et ombrées et, lorsque ce seuil est franchi, d’espacer
l’échantillonnage. Potentiellement, cette méthode permet donc de
lancer moins de rayons et, par conséquent, de gagner en temps de calcul.

– Adapt Vec : lors d’une animation, l’occlusion ambiante peut très signi-
ficativement pénaliser les temps de rendu. Qui plus est, l’usage du
Vector Blur rend floues les surfaces en mouvement rapide. Logique-

3DS MAX   Traceur de lumière

Blender utilise pour sa part la technique de l’occlu-
sion ambiante, en tant qu’option World, pour
parvenir à des résultats similaires à l’usage d’un
dôme de lumière et du traceur de lumière dans
3ds max. Il s’agit donc également de simuler une
illumination globale, et cette méthode n’est pas
non plus physiquement précise.

Figure 6–24
Éclairage d’une scène par occlusion ambiante

et une lampe conventionnelle

L’occlusion ambiante 
et le lancer de rayons

Cette méthode d’illumination relève du domaine
du raytracing, puisque pour chaque pixel de
l’image finale, un certain nombre de rayons sup-
plémentaires seront lancés pour déterminer son
exposition lumineuse. Par conséquent, le bouton
Ray du panneau Render (Render buttons du
menu Scene, touche [F10]) doit impérativement
être actif.
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ment, il n’est pas très utile de dépenser beaucoup d’échantillons sur ces
zones-ci. Plus la valeur de ce paramètre sera élevée (proche de 1.000),
plus l’Adaptive QMC aura tendance à espacer son échantillonnage sur
les surfaces en mouvement rapide, au profit des surfaces plus statiques.

• Constant Jittered : il s’agit de la plus ancienne méthode d’échantillonnage
offerte par Blender pour la détermination de l’occlusion ambiante, à
délaisser au profit de Constant QMC qui donne de meilleurs résultats.
– Bias : cette méthode d’occlusion ambiante peut faire apparaître les

facettes des objets, même lissés. Le problème n’est pas lié à la
fonction Set Smooth (panneau Link and Materials du menu Editing,
touche [F9]) mais bien à la méthode d’occlusion ambiante. Pour dimi-
nuer ce phénomène, il vous faudra agir sur ce curseur, des valeurs com-
prises entre 0.05 et 0.1 donnant généralement les résultats souhaités.

Réglages de base
La mise en place d’une solution d’occlusion ambiante pour l’éclairage se fait
dans l’onglet Amb Occ des World buttons du menu Shading (touche [F5]).
En appuyant sur le bouton Ambient Occlusion, de nouveaux réglages font
leur apparition.

Pour un usage basique, les deux paramètres les plus importants sont les
boutons numériques Samples et Energy. Le premier définit le nombre de
rayons qui sont lancés depuis chaque pixel de l’image, afin de connaître
son exposition à la lumière ambiante. Plus Samples sera élevé, plus les
ombres seront lisses mais le temps de calcul long. Plus il sera faible, plus
les ombres seront bruitées mais le calcul rapide. L’image qui suit propose
l’agrandissement d’une portion d’image rendue avec cette méthode
d’illumination et une valeur de Samples très faible : le rendu est manifes-
tement granuleux, comme si l’image était bruitée.

Figure 6–25
Les paramètres d’occlusion ambiante

Figure 6–26
Influence du paramètre Samples 
sur la qualité des ombres : de faibles 
valeurs induisent beaucoup de bruit !
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Pour sa part, le paramètre Energy présente moins de spécificités. Il
permet tout simplement de doser l’intensité lumineuse de l’illumination
par occlusion ambiante. Lorsque vous utiliserez celle-ci seule, vous sou-
haiterez sans doute augmenter Energy à des valeurs voisines de 2 ou 2.5 ;
au contraire, en utilisant l’occlusion ambiante conjointement aux
méthodes traditionnelles d’éclairage, la luminosité de vos scènes sera
peut-être trop élevée, auquel cas vous abaisserez sans doute graduelle-
ment Energy de façon à trouver le juste équilibre lumineux.

Méthodes d’illumination
Grâce à l’occlusion ambiante, il vous est possible de placer l’emphase sur
les zones éclairées ou au contraire sur les zones sombres, grâce aux
boutons Add et Sub. Grâce à l’option Add, seuls les rayons conduisant à
éclairer un pixel donné sont pris en compte, ce qui a pour effet d’éclaircir
la scène. Réciproquement, avec l’options Sub, seuls les rayons indiquant
l’occlusion de la lumière par un obstacle sont pris en compte, ce qui a
pour effet d’assombrir la scène.

Une troisième option Both permet de préserver l’équilibre lumineux
d’origine, en combinant les deux effets à la fois.

BON À SAVOIR   L’occlusion ambiante 
dans les grandes scènes

Le paramètre Max Dist détermine la distance
qu’un rayon a le droit de parcourir dans sa quête
d’un obstacle. S’il n’en rencontre pas avant d’avoir
franchi celle-ci, le point correspondant est consi-
déré comme recevant de la lumière.
Plus cette valeur est grande, plus l’espace à ana-
lyser pour déterminer la présence d’obstacles au
rayon sera important. En conséquence, maintenir
des valeurs de Max Dist aussi petites que pos-
sible permet d’optimiser les temps de rendu.

Figure 6–27 Les méthodes Add et Sub mettent respectivement l’emphase sur la lumière ou les ombres.
ASTUCE  

Atténuation de l’occlusion ambiante

En mode Plain d’occlusion ambiante, il est possible
d’activer le bouton Use Falloff, permettant d’atté-
nuer les ombres en fonction de la distance qui sépare
le point émetteur du rayon de la surface à l’origine
de cette ombre. Le taux d’atténuation est contrôlé
par le paramètre Strength. Plus sa valeur est
élevée, plus les ombres semblent être raccourcies.
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L’option Sky Texture
L’occlusion ambiante, telle que présentée jusqu’à présent, offre déjà des
résultats satisfaisants, mais des possibilités encore plus intéressantes vous
attendent. En particulier, en activant l’option Sky Texture, le moteur de
rendu ne se contente pas de rechercher si un rayon atteint le ciel ou s’il
rencontre un obstacle : s’il parvient jusqu’au ciel, il enregistre sa couleur à
l’endroit « d’impact » et teinte le pixel de l’image rendu avec cette cou-
leur. Par exemple, si vous utilisez comme ciel à votre scène un magni-
fique coucher de soleil, grâce à cette option d’occlusion ambiante, votre
scène entière sera baignée d’une chaleureuse couleur orangée.

Figure 6–28
La méthode Both offre 
une palette d’illumination plus profonde.

L’option Sky Color

Cette option fonctionne selon le même principe que
Sky Texture, à ceci près que la lumière sera teintée
par la couleur d’horizon (HoR, HoG, HoB) définies
dans le panneau World des World buttons du
menu Shading (touche [F5]). Cette option est sur-
tout utile pour créer une ambiance lumineuse dans
une scène où il n’y a pas ou peu d’objets réfléchis-
sants susceptibles de refléter le ciel.

Figure 6–29
Prise en compte de la texture du ciel 
pour teinter légèrement les objets de la scène
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Illumination HDR avec Blender
Vous pouvez bien sûr tirer parti de l’option Sky Texture avec n’importe
quelle image en arrière-plan, mais les meilleurs résultats seront obtenus
avec des images HDR utilisées en tant que cartes angulaires (angular
maps). Les cartes angulaires sont des images qui présentent sur 360° tout
l’environnement d’une scène. Elles sont notamment très utiles pour
donner à vos objets quelque chose à refléter, mais utilisées conjointement
avec l’occlusion ambiante, elles permettent un éclairage considérable-
ment plus réaliste de vos scènes grâce aux intensités lumineuses stockées
en même temps que les couleurs des pixels.

La mise en place d’une carte angulaire n’est pas complexe mais répond à
une démarche précise, dans les World buttons du menu Shading
(touche [F5]). Tout d’abord, rendez-vous dans les Texture buttons
(touche [F6]), et dans le panneau Preview, choisissez World pour signifier
à Blender que la texture qui sera ajoutée ne le sera pas à l’objet actif, mais
au ciel en arrière-plan de votre scène. Dans le panneau Texture, cliquez
sur le bouton Add New ; renommez si vous le souhaitez votre texture,
puis allez dans le menu déroulant Texture Type et choisissez Image. De
nouveaux panneaux apparaissent, mais nous ne nous intéresserons qu’au
panneau Image. En cliquant sur le bouton Load Image, vous appelez le
navigateur de fichiers. Sélectionnez la carte angulaire au format HDR de
votre choix (dans tous les cas, un fichier précédé d’un petit carré bleu
indiquant qu’il est utilisable ici) et validez votre choix.

ASTUCE   Où trouver des cartes angulaires ?

Sur l’Internet, en faisant une simple recherche sur les mots-clés light
probes angular map, vous devriez en particulier tomber sur le site de
référence :
Bhttp://www.debevec.org/Probes/
Les cartes angulaires présentées ici, notamment au format HDR, sont
d’une très grande qualité, mais également parmi les premières diffusées et
incontestablement les plus utilisées dans le monde de la 3D amateur ! Cer-
tains artistes 3D sont d’ailleurs capables de reconnaître la light probe uti-
lisée en examinant simplement l’ambiance lumineuse d’une image rendue
avec l’une d’elles. Vous trouverez d’autres light probes de qualité variable
aux URI suivants, des problèmes de droits évidents ne nous permettant pas
de les diffuser sur le DVD-Rom d’accompagnement de cet ouvrage :
Bhttp://www.hdrimaps.com/downloads.html
Bhttp://www.unparent.com/images_hdr/unparentProbes.zip
Bhttp://hdri.3dweave.com/library/
Bhttp://www.deviantart.com/deviation/9597501/
Bhttp://www.deviantart.com/deviation/10036562/
Bhttp://www.deviantart.com/deviation/10152791/
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Le plus dur est fait ; dans le panneau Preview, activez le bouton Real pour
faire correspondre l’image à la ligne d’horizon (le plan de coordonnée
z = 0) de la scène. Dans l’onglet Texture and Input, le premier canal tex-
ture doit être occupé par l’image HDR précédemment chargée, mais il
vous reste à activer le bouton AngMap ; enfin, dans l’onglet Map To,
activez l’option Hori pour que la texture puisse affecter la couleur de
l’horizon, et choisissez le mode de fondu Mix entre la couleur d’arrière-
plan et la texture (la couleur d’arrière-plan ne sera perceptible dans la
scène que si le bouton Blend est actif dans le panneau Preview ; ne
l’activez donc que si vous savez ce que vous faites, car vous allez fausser
les informations données par la carte angulaire).

Enfin, dans l’onglet Amb Occ, il ne vous reste plus qu’à activer l’option
Sky Texture, de préférence avec un niveau élevé de Samples et en mode
Add. Rien ne vous empêche toutefois d’expérimenter d’autres combinai-
sons de paramètres, en particulier les distributions Adaptive QMC et Cons-
tant QMC à la place du classique Constant Jittered.

L’avantage de l’illumination HDR est qu’elle se suffit à elle-même pour
éclairer une scène. Là où l’occlusion ambiante produit des ombres en
fonction des géométries environnantes, de véritables ombres peuvent
être générées grâce aux images HDR. Toutefois, cette technique d’illu-
mination manque cruellement de raffinement, telle qu’elle est à ce jour
intégrée à Blender : elle repose sur la force brute, tendant à produire des
images très bruitées (le nombre d’échantillons Samples est limité à 32, ce
qui est insuffisant pour ce type d’illumination). De plus, certaines zones

Figure 6–30 Ajout de la carte angulaire comme texture à l’environnement World

Figure 6–31
Les réglages de la carte 
angulaire dans 
les World buttons

ASTUCE  Qtpfsgui, 
pour la manipulation des fichiers HDR

Les logiciels libres, gratuits et multi-plates-formes
pour la manipulation des fichiers HDR sont rares.
Qtpfsgui est fonctionnel, permettant de fabriquer
vos propres images HDR, de les visualiser, de les
manipuler (Tone Mapping, opération qui consiste
à ramener les niveaux de luminosité dans le spectre
affichable sur les écrans) ou de les sauvegarder sous
différents formats LDR (JPEG, PNG, etc.).
Disponible aussi bien pour Linux que pour
Mac OS X et Windows, vous le retrouverez sur le
DVD-Rom ainsi qu’à l’adresse suivante :
B http://qtpfsgui.sourceforge.net/.
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lumineuses peuvent être largement surexposées, et des problèmes de cré-
nelage se révéler insolubles en raison des très forts contrastes lumineux.

Occlusion ambiante approximative
Cette méthode d’occlusion ambiante a été mise au point spécialement
pour la simulation de l’illumination globale lors des animations ; elle ne
produit pas de grains et est relativement rapide à calculer mais, en
revanche, elle n’offre pas une illumination exacte et produit parfois des
artéfacts indésirables.

Le principe ne repose pas sur le lancer de rayons, mais sur une toute autre
technique. Résumée à l’extrême, elle est la suivante : à chaque sommet de
la scène est positionné un disque (dont la taille dépend des surfaces des
facettes dont le sommet est à la frontière) qui émet de la lumière à partir de
sa face externe et de l’ombre à partir de sa face interne, proportionnelle-
ment à sa surface. On détermine à quel point un sommet est obscurci en
prenant en compte la quantité de lumière et d’ombre émise par tous les
disque voisins de celui-ci et on ombre le sommet proportionnellement.

S’il est possible d’obtenir des surfaces joliment ombrées par cette tech-
nique, elle crée l’illusion de l’occlusion ambiante, et non pas l’illumina-
tion globale en elle-même. C’est pour cela qu’elle est appelée « méthode
approximative d’occlusion ambiante ».

Figure 6–32
Les réglages de l’occlusion ambiante 

pour tenir compte de la carte angulaire

Figure 6–33
Exemple d’illumination HDR : les ombres sont
directement issues des intensités lumineuses

enregistrées dans l’image HDR ; aucune lampe
classique n’a été utilisée dans ce rendu, pas

même pour les ombres portées sur le sol.
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Réglages de base
Dans l’onglet Amb Occ, choisissez Approximate (menu déroulant Gather
Method) comme méthode d’occlusion ambiante.
• Passes : certains sommets peuvent se retrouver beaucoup trop assom-

bris (problème de surocclusion) par la géométrie environnante. Il est
possible de réduire ce phénomène en évaluant au préalable l’occlusion
attendue, en un certain nombre de passes successives.

• Error : définit la tolérance aux erreurs de calcul ; de faibles valeurs
produisent des résultats de meilleure qualité, mais au sacrifice de la
rapidité de calcul.

• Correction : ce paramètre permet d’atténuer la surocclusion de cer-
taines surfaces en rehaussant artificiellement le niveau de luminosité
des zones ombrées. Cela a pour principal effet de diminuer le con-
traste de l’occlusion ambiante approximative.

• Pixel Cache : cette option permet de réutiliser les résultats d’occlusion
ambiante obtenus sur un sommet pour interpoler l’illumination des
sommets voisins. L’occlusion devient encore plus approximative, mais
elle est comparativement encore plus rapide à calculer.

Les autres paramètres ne diffèrent guère de l’occlusion ambiante par
lancer de rayons, en particulier Energy, Use Falloff (et Strength) et les
méthodes d’illumination (Add, Sub, Both). En revanche, seules les
options Plain et Sky Color sont disponibles.

Figure 6–34
La méthode approximative d’occlusion ambiante 
est rapide à calculer et a l’avantage de ne pas être 
bruitée, ce qui la rend idéale pour les animations.

Limitations connues 
de l’Approximate Ambient Occlusion

Les problèmes de surocclusion apparaissent le plus
fréquemment lorsque deux facettes, placées l’une
derrière l’autre, pointent dans la même direction
(typiquement : lorsque des objets très fins sont
empilés les uns derrière les autres).
Les Strands (ou brins, utilisés pour la génération
d’herbes ou de cheveux grâce aux particules) ne
peuvent pas occlure les surfaces environnantes. De
même, ils ne sont pas directement occultés, mais
reçoivent le niveau d’ombrage de l’objet parent à
l’endroit considéré. En effet, l’occlusion de plusieurs
milliers de brins peut prendre un temps considérable,
quelle que soit la méthode d’occlusion ambiante
choisie (approximative ou par lancer de rayons).
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Radiosité
Dans la réalité, lorsqu’un rayon de lumière atteint la surface d’un objet, il
est reflété conformément à la longueur d’onde du matériau (sa couleur) ; le
rayon perd alors une partie de son énergie, mais rebondit contre l’objet (en
se teintant légèrement de la couleur dudit objet) et va rencontrer un
second objet, puis un troisième, et ainsi de suite. À chaque rebond, le
rayon lumineux perd autant d’énergie qu’il lui en a fallu pour éclairer
l’objet heurté, prend un peu de la couleur de l’objet rencontré, et rebondit
indéfiniment d’un objet à l’autre jusqu’à ce que son énergie devienne nulle.

Contrairement à ce que nous avons vu jusqu’à présent, le rayon lumineux
ne termine donc pas sa course sur la surface du premier objet rencontré,
mais par rebonds successifs, il va avoir tendance à « remplir » (même de
façon infinitésimale) la totalité de la scène. Le résultat en est un éclai-
rage très doux et très nuancé de la scène : les ombres ne sont pas forcé-
ment profondes, et les couleurs des objets s’influencent subtilement les
unes les autres. Par exemple, imaginons une sphère rouge posée sur le sol
d’une pièce d’un blanc immaculée ; sur l’un des murs, une source de
lumière dont les rayons viennent frapper la sphère rouge. Par rebond, les
rayons (légèrement teintés de rouge) vont venir frapper le sol d’un blanc
qui ne sera plus immaculé, mais, localement, légèrement rosé.

Cette méthode d’éclairage est particulièrement appréciée par les cabinets
d’architectes, car elle met parfaitement bien en valeur les volumes et la
lumière d’un appartement, par exemple. Elle demande toutefois des
temps de calcul plus élevés, et nécessite une compréhension du méca-
nisme interne à Blender pour en tirer un parti satisfaisant.

Principes de base
Tout d’abord, il faut savoir que dans Blender, le calcul d’une solution de
radiosité est purement artificiel et fait l’objet d’un pre-processing. En
fonction des objets émetteurs de lumière de la scène, la luminosité
propre de chaque objet va être calculée et « peinte » sur les sommets de
cet objet (méthode du vertex lighting), et interprétée comme un apport
de luminosité au moment du rendu. Il s’agit donc bien d’un processus
clairement détaché du rendu lui-même, mais qui souffre des limitations
propres au vertex painting classique de Blender : pour bénéficier d’une
illumination par radiosité bien continue et progressive, votre objet doit
être suffisamment subdivisé.

Ensuite, dans le cadre d’une solution de radiosité, vous n’avez pas besoin
de lampe. Il suffit d’un objet dont le paramètre Emit (panneau Shaders
des Material buttons) est supérieur à zéro. Bien sûr, plus ce paramètre sera

3DS MAX   La radiosité

La radiosité de Blender est assez proche de celle
de 3ds max en ce sens que les principes sont assez
proches (subdivision des surfaces en facettes trian-
gulaires, sauvegarde des résultats de radiosité
dans la géométrie des objets, etc.) même si les
techniques diffèrent largement. Pour l’utiliser,
veillez à ce que le bouton Radio (panneau Links
and Pipeline) de chaque objet soit actif, et que
l’option Radio soit également active dans le pan-
neau Render des Render buttons, dans le menu
Scene, touche [F10].

LE SAVIEZ-VOUS ?   Autres méthodes 
d’illumination globale

La radiosité est une méthode d’illumination globale,
parmi les plus anciennes, popularisée au début des
années 1990. Il existe toutefois des méthodes plus
modernes, à base de lancer de photons ou d’algo-
rithme de Monte-Carlo ; celles-ci feront peut-être un
jour, à leur tour, leur apparition dans Blender, mais
certains moteurs de rendu externes, comme YafRay,
par exemple, les supportent déjà.
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élevé, et plus il émettra de l’énergie qui sera prise en compte dans le
calcul de la solution de radiosité.

Enfin, notez que le moteur de calcul de radiosité ne tient compte que de
la couleur propre de Material des objets (c’est-à-dire la couleur telle que
définie par les curseur R, G et B du panneau Material, dans les Material
buttons du menu Shading, touche [F5]), et non pas celle des textures qui
lui sont appliquées. Pour que la solution de radiosité de la scène soit
cohérente avec les textures des objets la peuplant, il vous faudra donc
définir la couleur R, G, B de chaque matériau de sorte à ce qu’elle soit la
plus proche possible de la couleur moyenne de la texture.

Bien sûr, comme toute fonctionnalité optionnelle de Blender, si vous
souhaitez l’activer, il vous faut le faire en cochant le bouton Radio, dans
le panneau Render des Render buttons du menu Scene (touche [F10]).

Patches, éléments et subdivision automatique
Les patches sont des polygones capables d’émettre de l’énergie, tandis
que les éléments sont des polygones aptes à en recevoir. Les maillages
qui ont une émittance (paramètre Emit non nul) sont automatiquement
transformés en patches, tous les autres maillages étant transformés en
éléments. Les patches émettent de l’énergie ; un élément qui reçoit

LE SAVIEZ VOUS ?   La radiosité précalculée

Nous ne détaillerons pas dans cet ouvrage l’usage du panneau Radio Tool
des Radiosity buttons ; un aparté quelques pages plus loin vous en com-
muniquera les bases. Cette méthode offre un contrôle plus fin de la
solution de radiosité, avec les différences suivantes :
• Elle fonctionne aussi bien avec des maillages peu ou pas subdivisés,

car elle remplacera tous les objets de la scène par un objet global sur
lequel sera « peinte » la solution de radiosité, avec une densité de
maillage « suffisante » pour héberger la solution.

• Les objets étant tous fondus en un seul, il est impossible de les animer.
En particulier, déplacer a posteriori l’émetteur de lumière ne modi-
fiera pas la solution de radiosité, et déplacer un objet au travers de la
scène n’influera pas non plus sur la solution existante.

• Les textures éventuelles sont supprimées de l’objet global. Il vous
faudra donc soit les réattribuer à chaque groupe de points de con-
trôle du maillage global, en faisant usage des indices matériaux, soit
séparer les objets individuels d’origine de l’objet global.

Quel intérêt, en ce cas, à utiliser cette méthode si contraignante ? La
solution de radiosité est calculée une bonne fois pour toutes, le résultat
étant stocké dans la couleur des sommets des objets correspondants
(que vous pouvez séparer de l’objet global et texturer a posteriori). Uti-
lisée judicieusement, cette méthode raccourcira donc considérablement
les temps de rendu de vos scènes animées.

Figure 6–35
À activer : le bouton Radio 
dans le panneau Render
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celle-ci va donc en absorber une partie pour illuminer la surface de
l’objet correspondant. Puis, il se transforme en patches, pour pouvoir à
son tour émettre la part d’énergie qu’il n’aura pas absorbé lors de l’illumi-
nation de la surface, et ainsi de suite, tous les polygones devenant à la
fois patches émetteurs et éléments récepteurs. Le moteur détermine seul
les zones des maillages où les échanges d’énergie sont nuancés. Il subdi-
visera donc localement les patches et éléments de sorte que la densité des
maillages puisse restituer au mieux la richesse de l’illumination. Dans le
cadre de la radiosité précalculée, il est possible de paramétrer dans le
panneau Radiosity tool les tailles minimale et maximale tant des patches
que des éléments, le moteur se chargeant de subdiviser les maillages dans
les limites ainsi définies.

Rendu de radiosité
Tous les réglages se font dans le panneau Radio Render, dans les Radiosity
buttons du menu Shading (touche [F5]). Ils tiennent en trois paramètres
essentiels.
• Hemires : il s’agit ni plus ni moins de la qualité et de la finesse de la

solution de radiosité. Plus cette valeur est élevée, et plus le temps de
calcul de la solution sera long. Démarrer avec une valeur faible, de
l’ordre de 50-100, est un bon moyen de prévisualiser la solution de
radiosité finale. Attention, des valeurs trop élevées employées avec
des maillages trop finement subdivisés produiront un crénelage rap-
pelant l’effet moiré à la surface de vos objets. Une valeur élevée n’est
donc pas forcément synonyme de qualité supérieure.

• Max Iterations : la solution de radiosité est déterminée au moyen
d’une boucle itérative. Ce paramètre permet de spécifier le nombre
maximal d’itérations que devra réaliser le calculateur. Une valeur
nulle indique qu’il n’y a pas de maximum : le calculateur affinera son
résultat jusqu’à ce que le critère de convergence soit atteint. Il est sou-
vent prudent de fixer ce paramètre à un chiffre moyennement élevé :
100 pour les essais préliminaires, 200-300 pour le rendu final.

• Convergence : à n’utiliser que dans le cas où vous ne souhaitez pas spé-
cifier un nombre maximal d’itérations ; ce paramètre vous permet de
déterminer un seuil d’énergie restant en dessous duquel il ne sera pas
utile de poursuivre le calcul de la solution. Une valeur faible, de
l’ordre de 0.1, est souvent une bonne valeur.

Illumination d’un intérieur
Nous avons maintenant toutes les cartes en main pour illuminer notre pre-
mière scène grâce à la méthode de la radiosité. Ouvrez le fichier exercice-

Figure 6–36
Le panneau Radio Render

ASTUCE   Ajuster la solution de radiosité

Lorsque vous avez une solution de radiosité conve-
nable, vous n’êtes pas nécessairement obligé
d’affiner l’illumination de votre scène en modifiant
la (ou les) valeur(s) Emit de vos objets émetteurs
de lumière si vous souhaitez forcer ou diminuer
l’effet (au risque de casser l’équilibre lumineux de
la scène). En effet, le bouton numérique Mult
vous permet de jouer sur l’intensité lumineuse de
la scène en l’augmentant ou en la diminuant un
peu. Le bouton numérique Gamma vous permet
quant à lui de jouer, de la même manière, sur le
contraste de la solution.
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ch06.01-depart.blend situé dans le répertoire /exercices du DVD-Rom
d’accompagnement. La fenêtre principale est découpée en deux parties :
celle de gauche présente la scène en perspective et en mode fil de fer, pour
sélectionner facilement les éléments de la scène ; celle de droite montre
une vue ombrée de la scène depuis la caméra.

Le plan qui fait office de plafonnier (et donc de source de lumière) est nor-
malement présélectionné. Dans le panneau Shaders des Material buttons
du menu Shading, changez la valeur Emit : passez-la de 0.000 à 0.100.
Appuyez maintenant successivement sur la touche [F5] pour faire défiler
les boutons du menu Shading, jusqu’à afficher les Radiosity buttons. Dans
le panneau Radio Render, changez la valeur Hemires à 600 et Max iterations
à 300. Dans le panneau Render des Render buttons du menu Scene (touche
[F10]), activez le bouton Radio. Appuyez sur la touche [F12] ou sur le
bouton Render pour lancer le calcul de la solution de radiosité et le rendu
de la scène (voir figure 6–37).

L’équilibre lumineux de la scène est forcément correct (le moteur de calcul
y aura pourvu à notre place), mais l’intensité lumineuse est trop faible à
notre goût, et la scène pas assez contrastée : qu’à cela ne tienne ! Nous
pouvons renforcer la luminosité générale en augmentant la valeur Mult de
30.00 à 45.00, et augmenter le contraste en baissant la valeur Gamma de
2.000 à 1.750. La lumière est tout de suite plus vive ! Vous retrouverez le
fichier final dans le répertoire /exercices du DVD-Rom d’accompagne-
ment sous le nom exercice-ch06.01-final.blend (voir figure 6–38).

ASTUCE   La radiosité précalculée en très bref

Assurez-vous qu’au moins un maillage possède le paramètre Emit à une
valeur supérieure à 0.000 (des valeurs faibles conviennent générale-
ment assez bien). Sélectionnez tous les objets devant entrer dans la
simulation d’une solution de radiosité. Dans le menu Shading, touche
[F5], dans les Radiosity buttons, repérez le panneau Radio Tool et appuyez
sur le bouton Collect Meshes. Un nouveau panneau Calculation fait son
apparition, appuyez sur le bouton Go. Les échanges lumineux sont mis à
jour à mesure qu’ils sont évalués. Vous pouvez soit attendre que la
valeur Convergence ou Max Iterations soit atteinte, soit appuyer sur la
touche [Echap] pour geler la simulation au résultat affiché à l’écran.
Dans le panneau Radio Tool, cliquez sur Replace Meshes si vous ne sou-
haitez pas conserver les objets à l’origine de la simulation, ou sur Add
Meshes si vous voulez que la solution soit appliquée à un nouveau
maillage (il se superpose alors aux objets d’origine, il convient donc de
déplacer les uns ou les autres sur des calques différents pour ne pas
avoir de souci au rendu). Enfin, cliquez sur Free Radio Data pour
retourner dans le mode normal d’édition. Il ne vous reste plus qu’à
effectuer le rendu de la scène, touche [F12], tout en notant qu’il ne vous
est pas nécessaire d’activer les boutons Radio ou V Col Light.

MÉTHODE   Radiosité 
ou occlusion ambiante, que choisir ?

En règle générale, vous réserverez la radiosité au
rendu des scènes d’intérieur, et l’occlusion ambiante
à celle des scènes d’extérieur. Idéalement, une sub-
tile combinaison de ces deux techniques, alliée à la
mise en place stratégique de quelques lampes clas-
siques, vous aidera à obtenir la meilleure et la plus
réaliste illumination de vos scènes.
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Figure 6–37
Le résultat de notre premier

essai de radiosité. Pas mal
mais un peu sombre...

Figure 6–38
Le résultat de la solution de radiosité

est tout de suite plus lumineux !
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chapitre 7

Age of Steam, © 2004 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Techniques d’animation 
fondamentales

Ce chapitre aborde les techniques d’animation 
pour la réalisation de films avec Blender. 
Les notions présentées ici sont fondamentales.

SOMMAIRE

B Animation le long d’un chemin

B Apprentissage de l’éditeur 
de courbes IPO

B Formes clés et éditeur d’actions

B Usage des modificateurs

B Sytèmes de particules

MOTS-CLÉS

B Path
B IPO
B Interpolation
B Extrapolation
BModificateur
B Formes
B Clé
B Courbes
B Éditeur
B Timeline
B Frames
B Particules
B Fourrure, coiffure
B Intelligence artificielle
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Blender est une suite complète de modélisation et de rendu, mais aussi
d’animation. À la fois puissant et compact, le système permet d’animer
rapidement et simplement les scènes les plus simples comme les plus
complexes. Qui plus est, la consistance des outils mis en œuvre, très
similaires dans l’esprit et la pratique aux outils de modélisation ou d’édi-
tion de matériaux, assure à l’utilisateur une maîtrise rapide des techni-
ques encore inconnues.

Appréhender le système d’animation de Blender peut se faire par étapes
progressives, et c’est ce que propose ce chapitre, en commençant par expli-
quer comment imposer à un objet une trajectoire prédéfinie. Vient ensuite
la présentation de l’éditeur de courbes IPO, clé de voûte de tout le système
d’animation, avec la description de deux approches complémentaires. En
préliminaire à la découverte d’un système d’animation plus avancé, au tra-
vers de l’éditeur d’actions, vous apprendrez à mettre en place des clés de
forme (les formes intermédiaires intervenant dans les animations par mor-
phing), puis à les animer. Ensuite, vous découvrirez quelques modificateurs
supplémentaires, et réaliserez que ce sont autant des outils d’animation que
de modélisation. Enfin, vous découvrirez les utilisations quasi infinies des
systèmes de particules de Blender, qui permettent de tout simuler, des
flammes à la fumée, en passant par le gazon, la fourrure ou les cheveux, sans
oublier des systèmes dotés d’une intelligence artificielle.

Animation le long d’un chemin
Le type d’animation le plus simple consiste à faire se déplacer un objet le
long d’un chemin. Nous allons en faire la brève démonstration. Ouvrez
le fichier exercice-ch07.01-depart.blend présent dans le répertoire
/exercices du DVD-Rom d’accompagnement de ce livre. La scène
représente un simple couloir, éclairé par des néons rudimentaires. Le
curseur de Blender se trouve à peu près face à la caméra, au fond du cou-
loir, à mi-hauteur du sol.

3DS MAX   Animation avec trajectoire

Dans 3ds max, pour réaliser l’animation d’un objet le
long d’un chemin, il faut affecter un contrôleur Posi-
tion de type Contrainte trajectoire. Dans
Blender, il faut établir une relation parent-enfant
entre l’objet à animer et sa trajectoire, grâce à la
touche [P], qui appelera le menu Make Parent. Il
ne vous restera alors plus qu’à choisir Follow Path.

Figure 7–1
La scène de départ
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Appuyez sur la touche [Espace] pour appeler le menu Add, ou passez par
le menu déroulant Add du menu principal. Choisissez Add>Curve>Bezier
curve.

Sélectionnez la poignée la plus à gauche, et en maintenant pressée la
touche [Ctrl], cliquez à l’aide du bouton gauche de la souris pour placer de
nouvelles poignées dans la vue de dessus. À l’aide des touches [G] et [R]
sur les nœuds centraux, réorientez la courbe de façon à ce qu’elle soit
plus naturelle et moins saccadée.

Figure 7–2
L’ajout d’une courbe de Bézier, 
une entame de chemin

ASTUCE   Un chemin en 3D

Dans le panneau Curve and Surface du menu
Editing (touche [F9]), vous trouverez un bouton
3D. Activez-le : la courbe ne sera désormais plus
seulement éditable en deux dimensions, dans le
plan, mais en trois dimensions, dans l’espace.

Figure 7–3 En 3D, le chemin change d’allure.

Pour ce faire, placez-vous en vue de face ou de
côté, et à l’aide de la touche [G], ajustez l’altitude
des nœuds de votre choix.

Figure 7–4
Le chemin, tracé et lissé
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Désélectionnez tous les nœuds (touche [A] autant de fois que nécessaire
pour que plus aucun n’apparaisse en jaune) puis avec le bouton gauche de
la souris, sélectionnez le dernier nœud (la partie centrale, pas les poi-
gnées) que vous avez créé. Utilisez la combinaison de touches [Maj]+[S]
et choisissez Cursor->Selection pour positionner le curseur à l’endroit
de la sélection. Vous pouvez maintenant quitter le mode Edit
(touche [Tab]).

Ajoutez maintenant un simple cube : Add>Mesh>Cube et quittez le
mode Edit (touche [Tab]) dans lequel Blender vous a automatiquement
placé. Le cube se situe maintenant au début du chemin.

Le cube doit être sélectionné (en rose à l’écran) à l’exclusion de tout autre
objet. En maintenant la touche [Maj] pressée, utilisez le bouton droit de la
souris pour ajouter le chemin à la sélection. Utilisez maintenant la combi-
naison de touches [Ctrl]+[P] pour définir le cube comme étant le parent de
la courbe. Une fenêtre apparaîtra pour vous demander comment établir le
lien. Indiquez à Blender que le cube doit suivre le chemin : Follow Path.

NOTE IMPORTANTE   Où est le début de chemin ?

Lorsque vous utilisez une Bezier curve pour spéci-
fier un chemin, vous déroulez la courbe à partir de
la fin du chemin, pour remonter à son origine. Cela
veut dire que les premières poignées par défaut
posées par Blender sont situées à la fin du chemin.

Figure 7–5
Le cube, positionné au début du chemin

Dans le panneau Curve and Surface, au moment de la validation de cette
option, les boutons CurvePath et CurveFollow s’activent automatiquement.

Figure 7–7

Figure 7–6 Follow Path pour obliger 
le cube à suivre le chemin
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Normalement, un segment de droite en pointillés devrait apparaître
pour relier le centre du cube à l’origine du chemin. Si vous avez bien
suivi les instructions précédentes, le cube a été posé à l’origine du
chemin et ce segment en pointillés devrait logiquement être invisible.

Il ne vous reste maintenant plus qu’à jouer la prévisualisation de l’anima-
tion (de préférence dans la vue 3D représentant la vue depuis la caméra)
pour voir votre cube suivre le chemin : combinaison de touches [Alt]+[A]
ou [Maj]+[Alt]+[A].

ASTUCE  Prévisualisation d’une animation

Lorsque l’on met en place une animation, il est important de pouvoir la
prévisualiser sans effectuer le rendu entier de la vidéo elle-même ! Heu-
reusement, Blender propose plusieurs outils qui permettent des aperçus
plus ou moins fidèles de la future animation.
• Combinaison de touches [Alt]+[A] : à utiliser dans une vue 3D. Cette

combinaison de touches permet de jouer en temps réel l’animation,
dans la vue 3D dans laquelle se trouve le curseur de la souris. À noter
que la combinaison de touches [Ma]+[Alt]+[A] permet de jouer l’ani-
mation dans toutes les vues 3D en même temps.

• Timeline : ce type de vue est un enrichissement récent de Blender. La
Timeline permet de visualiser divers éléments en fonction du temps, de
jouer l’animation, de l’interrompre et d’éditer la scène à tout instant.
Par exemple, si vous avez spécifié des points clés, chacun apparaîtra
comme une barre verticale jaune dans la Timeline, la frame courante
étant quant à elle symbolisée par une barre verticale verte. L’affi-
chage de la Timeline est bien sûr différent pour chaque objet sélec-
tionné. Cet outil est idéal pour visualiser des instants précis de votre
animation, mais les boutons et menus de cette vue permettent aussi
de jouer les animations.

Figure 7–8 L’en-tête de la vue Timeline

Figure 7–9
La trajectoire du cube lors de l’animation 
suit parfaitement le chemin.
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Vous noterez que le cube met très exactement 100 frames pour parcourir
le chemin. Dans le cadre d’une animation personnalisée, vous souhai-
terez certainement que le parcours soit plus lent, ou plus rapide. Sélec-
tionnez le chemin et allez dans le menu Editing (touche [F9]) : dans le
panneau Curve and Surface, changez la valeur du bouton numérique
PathLen pour spécifier une nouvelle durée de parcours (en frames) du
chemin.

Vous trouverez le fichier final de cet exemple dans le répertoire
/exercices du DVD-Rom d’accompagnement, sous le nom exercice-
ch07.01-final.blend.

Figure 7–11 Le résultat du rendu de l’animation suivant un chemin

Figure 7–10
Le bouton numérique PathLen permet 

de régler la « durée » du chemin.

BON À SAVOIR  
Paramètre Speed des courbes IPO

Supposez que vous avez plusieurs chemins simi-
laires, à peu près parallèles. Par exemple, le pre-
mier chemin est suivi par le cube ; le deuxième est
suivi par la caméra, pour donner une vue subjec-
tive à une scène de type poursuite du cube ; le troi-
sième est suivi par un Empty, sur lequel la caméra
est braquée (contrainte de type Track To). Dans
l’en-tête de l’éditeur de courbes IPO, en choisis-
sant Path dans le menu déroulant, il est possible
de créer une courbe IPO de type Speed, afin de
contrôle la vitesse de déplacement des objets sur
leurs chemins respectifs. Cela permet ainsi d’avoir,
par exemple, la caméra qui accélère et décélère en
essayant de rattraper le cube, renforçant ainsi la
sensation de course-poursuite subjective.
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Approfondir : utiliser le Vector Blur pour simuler le flou 
de vitesse
Vous aimeriez sans doute que le cube en mouvement soit légèrement
flou lors de son déplacement. À partir du fichier final de l’exercice précé-
dent (exercice-ch07.01-final.blend), nous allons voir comment y par-
venir grâce aux nœuds Composite ; il faut toutefois bien comprendre que
cette astuce n’est possible que parce que le mouvement du cube a déjà été
défini, soit au travers d’un chemin, soit au travers de courbes IPO (voir
plus loin). Transformez la plus grande des vues 3D en Node Editor. Dans
l’en-tête de la vue, cliquez sur le bouton activant les nœuds Composite, et
cliquez sur le bouton Use Nodes.

Les deux premiers nœuds par défaut font leur apparition, et ils sont
reliés entre eux par leur entrée/sortie Image. En utilisant le bouton gauche
de la souris, dessinez une boîte chevauchant la liaison : celle-ci est
effacée. En gardant le curseur de la souris dans la vue de l’éditeur,
appuyez sur la touche [Espace] pour faire apparaître le menu d’insertion :
Add>Filter>Vector Blur. Un nouveau nœud Vector Blur vient de faire son
apparition. Reliez maintenant les sorties Image, Z et Speed du nœud
Render Layer aux entrées correspondantes du nœud Vector Blur. De
même, reliez la sortie Image du nœud Vector Blur à l’entrée correspon-
dante du nœud Composite.

Figure 7–12
L’en-tête du Node Editor

AU SECOURS !   Je n’ai pas de sortie Speed à mon nœud Render Layer

Inutile de paniquer ; si la sortie Speed n’est pas disponible, c’est certaine-
ment parce que la passe Vec n’est pas active dans l’onglet Render Layers,
bien évidemment pour le Render Layer en cours d’usage. Activez-la et la
sortie Speed sera disponible en sortie du nœud Composite.

Figure 7–13
Activation de l’option Vec 
dans le panneau Render Layers
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Enfin, dans le menu Scene, touche [F10], dans les Render buttons, activez
l’option Do Composite du panneau Anim. Vous pouvez maintenant soit
appuyer sur la touche [F12] soit cliquer sur la petite icône de rendu dans
le nœud Render Layer.

Explications sur les paramètres du nœud Vector Blur
• Samples est le nombre d’échantillons définissant l’effet de flou. Aug-

mentez ce nombre pour renforcer l’effet de flou.
• MinSpeed : utilisez cette valeur pour améliorer la séparation entre les

objets mobiles et immobiles dans votre scène ; particulièrement utile
lors des mouvements de caméra ou lorsque le décor bouge très légère-
ment.

Figure 7–14
Mise en place des nœuds

pour un effet de flou de vitesse

ASTUCE  
L’option Curved du nœud Vector Blur

Lorsque l’option Curved du nœud Vector Blur
est activée, la courbe d’interpolation entre les
frames n’est plus une droite mais une courbe de
Bézier, ce qui permet d’obtenir des traînées de flou
courbes.

Figure 7–15
Le Vector Blur en action :

un effet pouvant être vertigineux
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• MaxSpeed : utilisez cette valeur pour améliorer le flou sur les objets se
déplaçant très vite.

• BlurFac : utilisez ce facteur pour accélérer ou ralentir les vecteurs
Speed ; produit des résultats analogues à des « temps d’obturation »
plus ou moins longs avec une vraie caméra.

Animation linéaire par courbes IPO
Le principal système d’animation de Blender consiste à spécifier pour un
objet, à un moment donné, l’état de certains de ses paramètres, comme sa
position, sa couleur ou encore sa taille, et ce, parmi de très nombreuses pos-
sibilités. À un autre moment, on spécifie des valeurs différentes pour ces
mêmes paramètres, qui représentent un deuxième état. Blender va se
charger de mettre en place une courbe (dite courbe IPO) entre chaque état
consécutif de façon que la transition soit la plus progressive possible. Bien
sûr, il n’y a pas de limite conventionnelle au nombre d’états que vous pouvez
souhaiter intégrer, ce qui vous permet de générer des animations d’une
grande complexité, pour atteindre un degré de réalisme quasi parfait.

L’animation d’un objet va donc consister à lui associer un bloc de don-
nées IPO, chaque bloc IPO pouvant contenir une ou plusieurs courbes
IPO, chacune associée à un paramètre de l’objet animé. Bien sûr, chaque
type d’objet de Blender dispose d’une liste de paramètres qu’il est pos-
sible de faire varier dans le temps.

La courbe IPO est tracée sur un graphe présentant sur l’axe vertical la
valeur du paramètre animé, et sur l’axe horizontal, les frames (l’unité de
temps interne à Blender).

3DS MAX   Les outils d’animation

Les principaux outils d’animation disponibles dans 3ds max le sont égale-
ment dans Blender, parfois sous des formes et des appellations différentes.
• Vue piste : il s’agit de l’équivalent de l’éditeur de courbes IPO.
• Barre de piste : la Timeline de Blender permet de rendre les mêmes ser-

vices de visualisation.
• Panneaux d’animation et hiérarchie : il n’y a pas de panneau similaire

dans Blender, les mêmes informations, options et fonctions étant dis-
tribuées entre différents outils d’animation, notamment le menu
Insert Key accessible par la touche [I] et les panneaux du menu Object,
touche [F7].

• Commandes de temps : les commandes permettant de se déplacer dans
le temps sont également reprises dans la Timeline de Blender.

LE SAVIEZ-VOUS ?  IPO

Contrairement à ce que beaucoup de gens pen-
sent, IPO n’est pas un acronyme quelconque, mais
une abréviation. En fait, une IPO Curve signifie
courbe d’interpolation et fait référence aux
courbes interpolées par Blender entre plusieurs
points clés représentant l’état des objets animés à
des moments clés.

BON À SAVOIR  
La frame, unité de temps par défaut

Dans le cadre d’une animation, on parle souvent
d’un certain nombre d’images par seconde, ou
frames par seconde. Par exemple, pour le
cinéma moderne, la norme est à 25 images par
seconde. L’unité de temps, dans Blender, va donc
être la frame, ou image unitaire de l’animation.
Rendez-vous dans le menu Scene (touche [F10]),
Render buttons, panneau Format, bouton
numérique Frs/sec, pour fixer le nombre d’images
par seconde de votre animation.
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Changer la frame courante
Deux types de vue vous proposent un compteur de frames, qui permet
d’afficher l’état de la scène, à un instant donné, dans les vues 3D. Un
compteur se trouve dans l’en-tête de la fenêtre des boutons, un autre
dans l’en-tête de la vue Timeline.

Il existe plusieurs façons de faire évoluer ce compteur.
• Saisie numérique : en cliquant sur le compteur, vous pouvez saisir au

clavier la frame dont vous souhaitez afficher l’état de la scène.
• Souris : en cliquant sur les petites flèches pointant vers la gauche ou

la droite, vous faites reculer ou avancer le temps frame par frame. En
maintenant appuyé le bouton gauche et en déplaçant (lentement) la
souris vers la gauche ou vers la droite, vous diminuez ou augmentez le
compteur par incréments de 60 frames à partir de la valeur courante.

• Clavier : les touches directionnelles (pas celles du pavé numérique,
celles du clavier) sont peut-être les plus utiles ; les flèches gauche et
droite diminuent ou augmentent le compteur d’une frame. Les flèches
bas et haut diminuent ou augmentent le compteur de 10 frames.

Par exemple, un cube tournant à la fois sur lui-même, et oscillant de bas
en haut de façon cyclique se verra associer un bloc IPO comportant deux
courbes. La première sera une droite infinie, associée au paramètre RotZ
(angle de rotation autour de la direction Z) ; la seconde sera une courbe
pseudo-sinusoïdale ondulant entre deux positions, associée au
paramètre LocZ (position dans la direction Z).

Pour bâtir ces courbes IPO, il existe deux méthodes très utilisées. La
première est plus propre aux objets, et consiste à insérer des clés d’ani-
mation. La seconde est plus universelle et demande à construire les
courbes manuellement dans l’éditeur de courbes IPO. Nous allons briè-
vement explorer les deux méthodes.

Figure 7–16
Le compteur de frames, à droite de la capture

Figure 7–17
Exemple de vue sur l’éditeur de courbes IPO
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Dans les deux cas, vous lancerez Blender, ou ouvrirez une nouvelle session en
utilisant la combinaison de touches [Ctrl]+[X]. En cliquant avec le bouton
central de la souris sur le bord séparant la vue 3D de la fenêtre des boutons,
coupez la vue 3D en deux en choisissant Split Area dans le menu flottant qui
apparaît. Tout à fait à gauche de l’en-tête de l’une des deux vues, vous trou-
verez une icône représentant un repère sur une grille. En cliquant dessus vous
affichez la liste des types de vues disponibles. Choisissez IPO Curve Editor.

Dans l’en-tête de cette vue se trouve un bouton ascenseur définissant le
type d’IPO qu’il est possible de créer. Par défaut, c’est une IPO de type
Object qui est affichée, mais nous pouvons le modifier, pour créer des
IPO de type Material, World, Texture, Shape, Lamp, Constraint et
Sequence. Dans la partie droite de l’éditeur se trouve la liste complète des
paramètres pouvant être liés au temps par une courbe IPO. Lorsque vous
choisissez un type d’IPO différent, cette liste varie.

Insertion de clés d’animation
Préparez votre écran comme indiqué précédemment, ou ouvrez le fichier
exercice-ch07.02-depart.blend du répertoire /exercices du DVD-
Rom d’accompagnement. Dans la vue 3D, sélectionnez le cube central à
l’aide du bouton droit de la souris, s’il ne l’est pas déjà. Nous n’intervien-
drons pas dans l’IPO Curve Editor, mais nous conserverons un œil dessus
pour comprendre le fonctionnement des clés d’animation. En revanche,
nous allons fortement nous concentrer sur le compteur de frames.

Figure 7–18
L’en-tête de l’IPO Curve Editor

Figure 7–20
Le menu d’insertion de clés d’animation

Plusieurs types d’IPO en même temps ?

Bien sûr, vous pouvez associer à votre bloc de don-
nées IPO des types d’IPO différents. Par exemple,
pour une caméra, vous pouvez souhaiter animer le
paramètre Lens (type d’IPO Camera) mais aussi
son altitude au travers du paramètre LocZ (type
d’IPO Object). Il vous suffira d’utiliser le menu
déroulant permettant de choisir le type d’IPO pour
afficher toutes les courbes IPO définies pour
chacun d’eux.

ASTUCE   Dupliquez des IPO existantes

Dans le cadre d’animations très mécaniques, vous
allez devoir mettre en place des courbes IPO très
similaires, voire identiques, pour un grand nombre
d’objets. Pour vous simplifier la tâche, notez la pré-
sence de deux boutons qui permettent de copier et
coller un bloc IPO d’un objet à l’autre.

Figure 7–19 Boutons permettant 
de copier les blocs de données dans le buffer

3DS MAX   Animation à l’aide de clés

3ds max vous permet d’insérer des clés d’animation
de deux façons : la première consiste à cliquer sur le
bouton Clé auto, la seconde à éditer des valeurs
pour certains paramètres directement dans la vue
Piste. Deux méthodes rigoureusement équivalentes
de Blender sont décrites dans cette section.
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Changez la frame courante (si nécessaire) pour qu’il s’agisse de la frame n° 1.
Le cube est en position centrale dans la scène, nous n’avons touché à rien.
Appuyez sur la touche [I] pour insérer une clé d’animation et choisissez Rot.

L’éditeur de courbes IPO s’actualise avec trois courbes de couleur superpo-
sées (RotX, RotY et RotZ), mais nous ne nous arrêterons pas là. Grâce au
compteur de frames, déplacez-vous jusqu’à la frame n° 101 (soit 100 frames
plus loin). Dans la vue 3D, placez-vous en vue de dessus (touche [7] du
pavé numérique) et appuyez sur la touche [R] pour faire tourner le cube de
-90° (le maintien de la touche [Ctrl] pendant la rotation du cube con-
traindra celle-ci à des multiples entiers de 10°). Insérez une nouvelle clé
d’animation grâce à la touche [I] et choisissez à nouveau Rot.

Dans la colonne de droite, sélectionnez RotX et supprimez la clé en
appuyant sur les touches [X] ou [Suppr]. Une question apparaît à l’écran :
Erase selected keys. Confirmez et faites de même avec RotY, également
indésirable.

Positionnez maintenant le curseur de la souris dans la vue 3D et utilisez
la combinaison de touches [Alt]+[A] pour lancer la prévisualisation de
l’animation : vous devriez voir le cube tourner sur lui-même, conformé-
ment à la valeur imposée à RotZ dans l’éditeur, mais uniquement entre les
frames 1 et 101. La rotation s’arrête brutalement, mais nous verrons plus
tard comment la faire continuer sur sa lancée. Le fichier final de ce pre-
mier exemple se nomme exercice-ch07.02-final.blend et peut être
trouvé dans le répertoire /exercices du DVD-Rom d’accompagnement.

Insérer d’autres clés d’animation
Lorsque vous utilisez la touche [I] pour insérer des clés d’animation, plu-
sieurs options apparaissent.

Figure 7–21
La courbe IPO du paramètre RotZ
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• Loc : n’enregistre que la position de l’objet pour la frame courante.
• Rot : n’enregistre que l’angle de rotation de l’objet pour la frame cou-

rante.
• Scale : n’enregistre que l’échelle de l’objet pour la frame courante.
• LocRot : enregistre à la fois la position de l’objet et l’angle de rotation

de l’objet pour la frame courante.
• LocRotScale : enregistre à la fois la position, l’angle de rotation et

l’échelle de l’objet pour la frame courante.

Utilisation de l’éditeur de courbes IPO
Nous allons refaire manuellement ce que nous avons réalisé avec des clés
d’animation. Préparez votre écran comme indiqué précédemment, ou ouvrez
le fichier exercice-ch07.03-depart.blend du répertoire /exercices du
DVD-Rom d’accompagnement. Dans la vue 3D, sélectionnez le cube central
à l’aide du bouton droit de la souris, et portez à nouveau votre attention à
l’IPO Curve Editor. C’est ici que tout va se passer !

Juste à droite du sélecteur de type d’IPO se trouve un bouton ascenseur
qui permet d’afficher la liste des blocs IPO déjà créés. Si vous cliquez
dessus alors qu’aucun bloc de données IPO n’existe, Blender vous pro-
pose d’en créer un grâce à un menu flottant : Add New. Choisissez un
nom explicite, comme CubeAnim, dans le champ IP.

Nous allons chercher à faire tourner le cube sur lui-même, autour de
l’axe vertical Z. Dans la liste des variables dans la colonne de droite de
l’éditeur, sélectionnez RotZ (bouton gauche de la souris). Cliquez ensuite
dans le graphe avec le bouton gauche de la souris, tout en maintenant la
touche [Ctrl] pressée pour obtenir le point frame 1 et l’angle 0°. Répétez
l’opération pour obtenir un point frame 101 et l’angle 90°.

ERGONOMIE   S’y retrouver dans les IPO

Vous êtes invité à choisir des noms d’IPO explicites
lorsque vous créez une nouvelle IPO. En effet, si
vous animez plusieurs objets à la fois, en tant
qu’Object mais aussi en tant que Lamp ou
Camera, il est facile d’être rapidement perdu. Le
champ contenant les deux lettres IP: (indiquant un
bloc de données de type IPO) et un nom IPO par
défaut, proposé par Blender, peut facilement être
changé : il suffit de cliquer dessus et de saisir le
nouveau nom.

Figure 7–22
Les deux points du paramètre
RotZ dans l’IPO Curve Editor
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Positionner précisément les points
Les points ont été positionnés approximativement, mais il est possible
d’ajuster leur position très précisément. La courbe IPO étant sélec-
tionnée, entrez en mode Edit (touche [Tab]). Chaque point créé est
désormais constitué d’un nœud central et de deux poignées. Pour le pre-
mier point, sélectionnez le nœud central et appuyez sur la touche [N].
Un panneau flottant apparaît pour vous permettre de spécifier des
valeurs précises. Prêtez attention aux champs Vertex X et Vertex Y. Pour le
premier point saisissez 1 et 0 (frame 1 et angle 0°). Pour le second point,
saisissez 101 et 9 (frame 101 et 90°, car chaque unité dans la direction Y
est égale à 10° pour le paramètre RotZ).

Positionnez maintenant le curseur de la souris dans la vue 3D et utilisez
la combinaison de touches [Alt]+[A] pour lancer la prévisualisation de
l’animation : vous devriez voir votre cube tourner sur lui-même confor-
mément à la valeur imposée à RotZ dans l’éditeur, mais uniquement entre
les frames 1 et 101. Comme précédemment, la rotation s’arrête
brutalement ! Le fichier final de cet exemple se nomme exercice-
ch07.03-final.blend et peut être trouvé dans le répertoire /exercices
du DVD-Rom d’accompagnement.

Régler le comportement des courbes IPO au-delà de 
leur plage de définition
Que vous ayez utilisé des clés d’animation ou l’éditeur de courbes IPO,
vous avez obtenu un résultat identique (vous pouvez ouvrir l’un ou l’autre
des fichiers exercice-ch07.02-final.blend ou exercice-ch07.03-
final.blend du répertoire /exercices du DVD-Rom d’accompagne-
ment). Dans l’éditeur de courbes IPO, sélectionnez le paramètre RotZ et,
dans le menu Curve, choisissez Interpolation Mode : vous avez le choix
entre Constant, Linear et Bezier. Il s’agit ici de spécifier à Blender si les
points créés doivent être reliés par des plateaux horizontaux (Constant),
des segments de droite (Linear) ou des courbes de Bézier (Bezier), qui est
l’option par défaut. Nous souhaitons une rotation parfaitement continue,
choisissez donc l’option Linear.

Toujours dans le menu Curve, intéressez-vous maintenant à Extend Mode.
Ces options permettent de définir le comportement de l’animation en
dehors des bornes de définition de la courbe IPO. L’option Constant fige
l’objet dans sa dernière position angulaire ; l’option Extrapolation permet
de projeter la courbe à l’infini selon la pente de la courbe au dernier
point défini ; l’option Cyclic permet de répéter indéfiniment la portion
de courbe déjà décrite. Enfin, l’option Cyclic Extrapolation projette à
l’infini la tendance de la portion de courbe définie.

Figure 7–23 Positionnement précis 
des points formant la courbe IPO grâce 

à la touche [N]

Quel mode d’interpolation 
pour quelle animation ?

Généralement, vous choisissez l’option Constant
pour un mouvement très saccadé, l’option Linear
pour un mouvement mécanique parfaitement
asservi, et l’option Bezier pour un mouvement
souple, ou légèrement amorti.

MÉTHODE   Avec l’option Cyclic, 
l’animation est saccadée 

ou la courbe IPO discontinue...

La courbe IPO est forcément discontinue si la com-
posante Vertex Y du premier point et du dernier
point ne sont pas identiques (touche [N] pour affi-
cher le panneau flottant présentant les coordon-
nées Vertex X et Vertex Y des points de la
courbe). Notez les valeurs de l’une comme de
l’autre, et donnez-leur une valeur commune pour
éviter que votre animation ne saccade, patine,
saute, etc.
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Choisissez Extrapolation. La « courbe » finale est donc une droite infinie,
passant par deux couples de points définis par nos soins : {frame 1,
angle 0°} et {frame 101, angle 90°}.

Si maintenant vous jouez l’animation dans une vue 3D (combinaison des
touches [Alt]+[A]), vous aurez la satisfaction de voir votre cube tourner
indéfiniment. Le résultat final de cet exemple peut être examiné dans le
fichier exercice-ch07.04-final.blend.

Régler la durée de l’animation
Lorsque vous effectuez le rendu de votre animation, vous devez définir la
première frame de l’animation, ainsi que la dernière. Par défaut, ces deux
valeurs sont respectivement égales à 1 et 250, à une vitesse de 25 frames
par seconde. Cela correspond donc à une animation de 10 secondes.

Dans l’en-tête de la vue Timeline, vous avez deux boutons numériques (Start
et End) qui vous permettent de déterminer ces frames de départ et de fin.

Sinon, dans le panneau Anim des Render buttons dans le menu Scene
(touche [F10]) se trouvent également des boutons numériques Start et
End. De même, le bouton numérique Frs/sec permettant de régler la
vitesse de l’animation (en frames par seconde) se trouve dans le
panneau Format des Render buttons.

Autres types d’IPO
Nous savons maintenant travailler dans l’espace des objets grâce aux
courbes IPO. Mais comme nous l’avons aperçu, il existe d’autres types
de courbes IPO, parmi lesquels deux types très utiles : Camera et Lamp.
À part leur existence, vous n’apprendrez rien de plus, car le fonctionne-
ment de l’éditeur est consistant d’un type d’IPO à l’autre. Nous pourrons
toutefois illustrer deux exemples d’usage de ces autres types.

Figure 7–24
La courbe IPO après définition des points, 
et des modes d’interpolation et d’extrapolation
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IPO de type Camera
Pour une caméra, il est très facile d’associer une courbe IPO au
paramètre Lens, ce qui a pour effet de contrôler le facteur de zoom de la
caméra pendant l’animation.

IPO de type Lamp
L’animation de l’intensité lumineuse d’une lampe est souvent utile pour
simuler, par exemple, une nuit orageuse. Le but est simplement d’illu-
miner la scène sur des instants très courts (de une à quelques frames seu-
lement) et à des intensités diverses. On tirera aisément avantage du
mode d’interpolation Constant, dans ce cas de figure.

Figure 7–25
Une IPO de type Camera qui permet

de zoomer sur le sujet grâce
au paramètre animé Lens.

Figure 7–26
Une IPO particulièrement saccadée

et chaotique
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Autres types d’IPO ?
Il existe d’autres formes d’animation, plus spécialisées. En particulier, le
type Shape permet d’animer la transformation ou la déformation des
objets, à condition de définir des clés de forme spécifique. C’est l’objet
de la prochaine partie de ce chapitre.

Les formes clés (Shape keys)
De la même façon qu’il est possible, pour un objet, d’insérer une clé de
position (Loc), de rotation (Rot) ou d’échelle (Scale), il est possible, au
niveau interne de l’objet (c’est-à-dire au niveau du point de contrôle du
maillage, de la courbe, de la surface ou du treillis) d’insérer des formes
clés (shape keys en version originale). Chaque clé est alors représentative
d’un état de la position des points de contrôle. Cette démarche est à la
fois simple et brillante. Si vous avez passé des heures à modéliser un
visage, vous apprécierez de pouvoir l’animer facilement en créant une clé
pour représenter le maillage avec l’œil droit fermé, une clé pour repré-
senter la bouche grande ouverte, et ainsi de suite. Plus tard, dans l’édi-
teur d’actions, pour réaliser votre animation, il ne vous restera plus qu’à
préciser la mimique que vous souhaitez à chaque instant, et Blender se
chargera docilement d’interpoler les formes, en fonction du temps et des
formes clés que vous aurez choisies.

Démarrez une nouvelle session de Blender, ou réinitialisez la scène cou-
rante grâce à la combinaison de touches [Ctrl]+[X]. Séparez la vue 3D en
deux, en cliquant sur le bord entre la vue 3D et la fenêtre des boutons
grâce au bouton central de la souris. Laissez telle quelle l’une des vues,
mais transformez la seconde en éditeur d’actions (icône Action Editor).
Nous nous en servirons juste pour visualiser les effets de nos actions à
venir. Dans la vue 3D, sélectionnez le cube central par défaut, et effacez-
le (touche [X] ou [Suppr]). En utilisant la touche [Espace] ou le menu
Add, ajoutez un nouveau maillage : Add>Mesh>Monkey en validant les
paramètres par défaut. Rendez-vous dans le menu Editing (touche [F9])
et trouvez l’onglet Shapes. Cliquez sur le bouton Add Shape Key ; la pre-
mière clé insérée par défaut se nomme Basis, et sera la forme de base de
tous les morphings à venir.

En quelques mots, le bouton Add Shape Key permet d’ajouter une nou-
velle clé de forme pour le maillage actuel. Le bouton Relative, s’il est
activé, permet d’appliquer les déformations par rapport au maillage ;
autrement, les déformations seront appliquées par rapport au repère
absolu de la scène, ce qui pourra conduire à des résultats étonnants : ne
désactivez cette option que si vous savez ce que vous faites.

MAYA   Blend shapes

Les Blend shapes de Maya fonctionnent de façon
très similaire aux Shape Keys de Blender ; l’utili-
sateur de Maya ne sera donc pas perdu. En
revanche, il appréciera la possibilité qu’offre
Blender de corriger les déformations grâce au
Weight Painting.
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Viennent ensuite les différentes clés de forme que vous avez ajoutées :
une ligne par forme. Chaque ligne présente des icônes (de gauche à
droite) permettant de « figer » la forme de la vue 3D avec la clé courante,
d’ignorer la forme clé en question, de passer à la clé précédente, de navi-
guer dans la liste des clés existantes, de passer à la clé suivante, de visua-
liser (ou changer, il s’agit d’un champ de type texte) le nom de la forme
courante, et enfin de supprimer la forme courante.

Par exemple, nous allons nous amuser à créer quelques formes. Avec la
tête de singe sélectionnée, passer en mode Edit (touche [Tab]). De préfé-
rence, désactivez le Backface-Culling, et activez l’outil d’édition propor-
tionnelle PET (touche [O]). Maintenant, sélectionnez quelques points de
contrôle à la pointe de l’oreille droite du singe, pressez les touches [G]
puis [Z] pour les déplacer vers le bas, selon la direction Z. Au besoin,
réglez l’aire d’effet de l’outil PET pour n’affecter que les points de con-
trôle de l’oreille. Une fois la forme souhaitée obtenue, validez grâce à la
touche [Entrée] et cliquez sur le bouton Add Shape Key. Une nouvelle clé
est ajoutée (elle devient la clé active dans la vue 3D) et la liste des cur-
seurs possibles dans l’éditeur d’actions s’enrichit d’une clé.

Quittez le mode Edit (touche [Tab]) et utilisez les flèches pour revenir à
la clé intitulée Basis. Maintenant, nous allons arrondir la bouche du
singe, pour symboliser un « oh ! » de surprise. Commencez par insérer
une nouvelle clé en cliquant sur le bouton Add Shape Key ; la liste des
curseurs dans l’éditeur d’actions s’enrichit d’une nouvelle clé, la dernière
pour notre exemple. Revenez dans le mode Edit (touche [Tab] à nouveau)
et sélectionnez les points de contrôle au centre de la lèvre supérieure.
Grâce aux touches [G] puis [Z], déplacez les points de contrôle vers le
haut, dans la direction Z. Une fois les points placés selon vos souhaits,
validez grâce à la touche [Entrée] et cliquez sur le bouton Add Shape Key.

Figure 7–27
L’onglet Shapes

Figure 7–28 Nos trois formes clés, prêtes à être recyclées dans une animation
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Nous avons maintenant trois formes différentes : le maillage d’origine,
sous le nom Basis ; une variante avec l’oreille droite tombante, sous le
nom Key 1 ; et enfin une seconde variante du maillage d’origine, avec la
bouche arrondie, nommée Key 2.

Côté éditeur d’actions, la colonne de gauche s’est enrichie de deux nou-
velles clés, Key 1 et Key 2, qui correspondent à nos deux morphings.
Nous allons voir maintenant comment les mettre en œuvre.

L’éditeur d’actions
L’éditeur d’actions va se charger de régler, au cours d’une animation, le
passage d’une forme clé à une autre, ou d’une pose à l’autre (dans le cas,
par exemple, d’animations à base de formes clés ou d’armatures). Le pas-
sage sera réalisé conformément à des courbes IPO, qu’il sera possible de
mettre en place de deux façons différentes :
• dans l’IPO Curve Editor, en sélectionnant le type d’IPO Shape ; la

colonne de droite de l’éditeur est alors mise à jour pour montrer les
clés ou les poses disponibles pour l’objet en cours d’animation ;

• dans l’Action Editor ; c’est cette méthode que nous allons développer ici.

Figure 7–29
Les formes apparaissent dans l’éditeur d’actions.

ASTUCE  

Avant d’insérer une nouvelle clé de forme, revenez
toujours, hors mode Edit, à la forme Basis d’ori-
gine. Ajoutez alors une nouvelle clé de forme grâce
au bouton Add Shape Key avant de modifier
votre maillage. Sinon, c’est le maillage Basis que
vous retouchez !

Figure 7–30
L’éditeur de courbes IPO pour le type Shape

Figure 7–31
L’éditeur d’actions
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Découverte de l’éditeur
Ouvrez le fichier exercice-ch07.05-depart.blend, qui présente un envi-
ronnement de travail complet pour l’édition d’actions : une vue 3D pour
visualiser l’animation, et une Timeline pour passer aisément d’une clé à
l’autre tout en jouant ou arrêtant l’animation ; un éditeur d’actions pour
créer l’animation ; et un éditeur de courbes IPO pour visualiser et éven-
tuellement corriger ou affiner le travail réalisé dans l’éditeur d’actions.

Ce fichier présente un sujet prêt à animer : Suzanne, la mascotte de
Blender. Pour ce maillage, trois formes clés ont été définies dans la partie
précédente : Basis qui présente le maillage par défaut, Key 1 qui propose
une oreille droite pendante, et Key 2 qui offre une bouche plus arrondie.

Suzanne est déjà sélectionnée, et le menu Editing (touche [F9]) présente
les boutons relatifs à ce contexte, en particulier l’onglet Shapes.

Dans l’éditeur d’actions, vous noterez la première ligne Sliders, avec une
petite flèche qui permet de révéler des éléments masqués. Cliquez sur la
flèche pour révéler les curseurs relatifs à chaque forme clé. Par défaut,
ces curseurs vont de 0.00 à 1.00.

En cliquant (bouton gauche de la souris) sur le nom de n’importe quelle
clé (par exemple Key 1), une fenêtre flottante apparaît, permettant de
configurer la clé. En particulier, elle vous permet de changer son nom
(champ KB:), mais aussi la valeur minimale du curseur (Slider Min) ainsi
que sa valeur maximale (Slider Max).

La première clé (anciennement Key 1) sera renommée Oreille Basse, et
nous fixerons Slider Min à -1.00. En ce qui concerne la seconde clé
(anciennement Key 2), nous la renommerons Bouche Ronde, mais nous ne
changerons pas les bornes de son curseur. N’oubliez pas de cliquer sur
OK pour valider les changements relatifs à une clé. Si vous vérifiez dans
l’onglet Shapes en faisant défiler les formes clés, vous constaterez que les
noms de forme ont été mis à jour automatiquement.

Figure 7–32
Les curseurs relatifs aux formes clés

Figure 7–33
Paramétrage des formes clés
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Réalisation de l’animation
Planifions une animation de 10 secondes, soit 250 frames. Tout au long
de celle-ci, nous souhaitons que la forme de la bouche oscille entre sa
forme par défaut (clé Basis) et sa forme arrondie (clé Bouche Ronde) pour
simuler une communication orale. De même, l’oreille droite va osciller
légèrement, et s’abattre totalement à la fin de la discussion.

Animation de la première clé
Nous souhaitons que l’oreille oscille d’une position à une autre toutes les
deux secondes (soit toutes les 50 frames). Grâce au compteur de frames,
rendez-vous sur la frame n° 50, et déplacez le curseur de la clé Oreille Basse
sur une valeur de -0.25. Puis, rendez-vous alternativement aux
frames n° 100, 150, 200 et 250, et donnez au curseur les valeurs respectives
suivantes : 0.25, -0.25, 0.25 et 1.00. La courbe IPO associée à la forme
est automatiquement mise à jour, conformément aux valeurs saisies.

Figure 7–34
Après personnalisation de l’interface

Figure 7–35
Les éditeurs de courbes IPO 
et d’actions relatifs à la première clé
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Animation de la seconde clé
Nous allons procéder de la même façon avec la seconde clé, mais nous
souhaitons que la bouche s’anime sur un rythme plus soutenu que précé-
demment. À ce titre, nous allons modifier la valeur du curseur toutes les
secondes, soit toutes les 25 frames. Nous donnerons au curseur les
valeurs respectives suivantes, en commençant par 0.00 à la frame 1, 0.50
à la frame 25, puis à nouveau 0.00 à la frame 50, puis toutes les
25 frames jusqu’à atteindre 250 : 1.00, 0.00, 0.75, 0.00, 0.25, 0.00,
0.50, et enfin 1.00 en frame n°250. Comme précédemment, la courbe
IPO de la seconde forme est automatiquement mise à jour, conformé-
ment aux valeurs spécifiées dans l’éditeur d’actions.

Il ne nous reste plus qu’à voir comment combiner différentes transfor-
mations au cours d’une animation. C’est là le rôle du NLA Editor, qui per-
mettra de réaliser le montage de toutes les actions disponibles pour un
sujet. Mais son usage sera présenté dans le prochain chapitre, en conclu-
sion des explications sur l’animation squelettale.

Figure 7–36
Les éditeurs de courbes IPO

et d’actions relatifs à la deuxième clé
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Déformation d’objets : 
usage des modificateurs
Comme nous avons déjà eu l’occasion de le voir, les modificateurs trans-
forment (de façon réversible) vos maillages, courbes, surfaces et treillis.
La transformation dépend généralement d’un objet tiers, qui influencera
donc la forme de l’objet affecté par le modificateur. Utiliser les modifica-
teurs dans le cadre d’animations devient alors tentant : en animant, soit
l’objet affecté, soit l’objet tiers, vous assistez alors à des transformations
géométriques plus ou moins spectaculaires.

Pour rappel, les modificateurs sont créés et/ou accessibles depuis
l’onglet Modifier, du menu Editing (touche [F9]). Lorsqu’il existe, l’un des
champs les plus importants est le champ OB: qui doit contenir le nom de
l’objet tiers devant affecter l’objet.

Animation par l’usage des modificateurs

Il n’y a pas une façon unique de mettre en œuvre les modificateurs dans le cadre de vos
animations. C’est autant l’affaire de préférence personnelle, de niveau de compréhension
des outils de Blender, de but poursuivi, que de fibre artistique ou de créativité. Voici un
échantillon non exhaustif de méthodes à explorer pour tirer le juste parti des modifica-
teurs dans vos films d’animation.
• Animation de l’objet affecté : liez une courbe IPO de type Object à l’objet affecté

par le modificateur. Lorsque l’objet passera dans le champ d’action de l’objet, il sera
transformé conformément à la nature du modificateur.

• Animation de l’objet tiers : comme précédemment, liez une courbe IPO de type
Object, mais à l’objet tiers (celui qui est désigné par le modificateur), pas à l’objet
affecté par le modificateur. Lorsque l’objet tiers passera à proximité de l’objet affecté
par le modificateur, il le transformera conformément à sa nature.

• Utilisation d’un modificateur pour transformer l’objet tiers : l’objet affecté
comme l’objet tiers reste sur place, sans être animé par aucune courbe IPO de type
Object ou autre. L’objet tiers est toutefois lui-même affecté par un modificateur
secondaire qui le transforme. L’objet affecté par le modificateur principal est alors
transformé conformément à la nature du modificateur animé.

• Utilisation des clés de forme pour transformer l’objet tiers : l’objet tiers est
animé au travers de clés de forme et de l’éditeur d’actions. Les transformations de
l’objet tiers affectent alors l’objet affecté par le modificateur conformément à sa
nature.

Les quelques modificateurs présentés ici, comme tous les modificateurs, peuvent être des
outils d’animation ou de modélisation, selon l’usage que vous leur réservez. D’autres
modificateurs ont déjà été présentés dans d’autres chapitres, mais il est parfois utile de
les animer également. Votre créativité en matière d’animation ne doit donc pas se limiter
à ceux présentés ici !
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Déformation imposée par un treillis : 
le modificateur Lattice
Lattice est le terme anglais pour treillis. Il s’agit ni plus ni moins d’une cage
de déformation. Son usage n’est pas très complexe et permet des effets
intéressants. Le treillis va encadrer l’objet à déformer. En imprimant des
déformations au treillis, celles-ci vont se répercuter sur l’objet affecté.

Démarrez une nouvelle session de Blender, ou réinitialisez la scène cou-
rante grâce à la combinaison de touches [Ctrl]+[X]. Sélectionnez le cube
central par défaut, et effacez-le (touche [X] ou [Suppr]). En utilisant la
touche [Espace] ou le menu Add, ajoutez un nouveau maillage : Add>
Mesh>Uvsphere et acceptez les paramètres proposés par défaut.

Maintenant, en vue de face ou de côté (touche [1] ou [3] du pavé numé-
rique) ajoutez un treillis de la même façon : Add>Lattice. Relevez bien
son nom, dans le champ OB:. Il s’agit normalement du nom par défaut :
Lattice. Il nous sera utile un peu plus tard. Vous pouvez maintenant
déterminer la résolution de votre treillis, dans ses trois directions princi-
pales, grâce aux boutons numériques U, V et W du panneau Lattice, dans
le menu Editing (touche [F9]) : U: 2, V: 5, W: 2.

Redimensionnez le treillis de façon à ce qu’il englobe la sphère, et sélec-
tionnez à nouveau cette dernière. Dans l’onglet Modifier du menu Editing
(touche [F9]), cliquez sur le bouton Add Modifier et choisissez Lattice.
Dans le champ OB:, saisissez le nom du treillis : Lattice.

3DS MAX   Le modificateur FFD 
(Free Form Deformation)

Le modificateur Lattice de Blender est l’équiva-
lent du modificateur FFD de 3ds max. Le bouton
VGroup est une option intéressante qui permet
d’indiquer à Blender un groupe de sommets parti-
culier qui sera affecté par le treillis.

Figure 7–37
Définition géométrique du treillis

BON À SAVOIR   Usage alternatif 
d’un treillis pour déformer un objet

Procédez comme précédemment : créez une
sphère, puis un treillis (lattice). Sélectionnez la
sphère, puis le treillis. Utilisez la combinaison de
touches [Ctrl]+[P] pour créer un lien de parenté
entre la sphère et le treillis. Dans le menu qui
apparaît, choisissez Lattice Deform.

Figure 7–38
Le treillis en place autour de la sphère
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Le treillis peut à partir de maintenant déformer la sphère. Pour nous en
persuader, tentons simplement l’expérience : sélectionnez à nouveau le
treillis, et passez en mode Edit (touche [Tab]). En vue de face ou de côté,
sélectionnez les points de contrôle composant la tranche médiane du
treillis, et redimensionnez-là afin de la réduire de façon à ce que le treillis
ressemble à un sablier de section carrée.

Déformation imposée par une courbe : 
le modificateur Curve Deform
Il s’agit d’une méthode de déformation à la fois simple et très efficace : le
maillage va être déformé en fonction de la forme propre de la courbe. Si
vous déformez la courbe au cours d’une animation, l’objet sera égale-
ment déformé.

Démarrez une nouvelle session de Blender, ou réinitialisez la scène cou-
rante grâce à la combinaison de touches [Ctrl]+[X]. Sélectionnez le cube
central par défaut, et effacez-le (touche [X] ou [Suppr]). En utilisant la
touche [Espace] ou le menu Add, ajoutez un nouveau maillage : Add>
Mesh>Monkey.

Figure 7–39
Le modificateur Lattice

Figure 7–40
Le modificateur Lattice appliqué à la sphère
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Ajoutez maintenant une nouvelle courbe de Bézier : Add>Curve>Bezier
curve. Notez bien le nom de la courbe nouvellement créée : OB: Curve.

Sélectionnez à nouveau la tête de singe, et dans le menu Editing
(touche [F9]), trouvez l’onglet Modifiers. Cliquez sur le bouton Add Modi-
fier et choisissez Curve dans le menu déroulant. Le champ Ob: est vide.
Saisissez-y le nom d’objet de la courbe précédemment créée : Curve. La
tête de singe est instantanément déformée, et la forme suit désormais la
direction dans laquelle la courbe doit la déformer (déterminée par l’un
ou l’autre des boutons X, Y, Z ou -X, -Y et -Z).

Figure 7–41
Suzanne, le cobaye de bien

des expérimentations !

Figure 7–42
La courbe de Bézier par défaut

ALTERNATIVE   Usage des courbes 
pour déformer un objet

Procédez comme précédemment : créez une tête
de singe, puis une courbe. Sélectionnez la tête de
singe, puis la courbe. Utilisez la combinaison de
touches [Ctrl]+[P] pour créer un lien de parenté
entre la courbe et la tête. Dans le menu qui appa-
raît, choisissez Curve Deform. Et voilà, on
obtient le même résultat !

Figure 7–43
Le modificateur Curve
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Sélectionnez maintenant la courbe, et entrez en mode Edit (touche [Tab]).
Déplacez les nœuds et/ou les poignées de la courbe, ajoutez des nœuds
supplémentaires, faites ce que bon vous semble... Mais dans tous les cas,
observez bien les déformations infligées à la tête de singe !

Figure 7–44
Le modificateur Curve appliqué à Suzanne

Figure 7–45
La courbe précédente a été subdivisée 
et ses poignées déplacées et tournées.

Figure 7–46
La tête du singe s’est pliée 
à ces nouvelles contorsions de la courbe !
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Déformation imposée par un crochet : le modificateur Hook
Crochet est le terme français pour hook. Il s’agit ni plus ni moins d’une
fonction qui permet de manipuler la géométrie interne d’un objet en dehors
du mode Edit (touche [Tab]) en liant un groupe de points de contrôle (ver-
tice) à un objet de type Empty. L’avantage est que les crochets fonctionnent
tout aussi bien avec les maillages, les courbes, les surfaces ou les treillis.

Leur mise en œuvre est très simple, et une démonstration permet aisé-
ment de comprendre leur usage. Démarrez une nouvelle session de
Blender, ou réinitialisez la scène courante grâce à la combinaison de
touches [Ctrl]+[X]. Sélectionnez le cube central par défaut, et effacez-le
(touche [X] ou [Suppr]). En utilisant la touche [Espace] ou le menu Add,
ajoutez un nouveau maillage : Add>Mesh>Uvsphere et acceptez les para-
mètres proposés par défaut.

Avant de poursuivre, pensez à désactiver le Backface-Culling (voir l’aparté
À savoir : le Backface-Culling du chapitre 3). Vous êtes en effet normale-
ment toujours en mode Edit, et tous les points de contrôle sont sélec-
tionnés. Appuyez sur la touche [A] pour les désélectionner. Maintenant,
grâce à la touche [B], en vue de face (touche [1] du pavé numérique),
sélectionnez les points de contrôle de la calotte supérieure en dessinant
une boîte autour d’eux (si vous n’avez pas désactivé le Backface-Culling, la
sélection sera limitée aux points immédiatement visibles).

Utilisez la combinaison de touches [Ctrl]+[H] pour créer un crochet pour la
sélection. Une fenêtre apparaît, choisissez Add, New Empty. Cela a pour
effet de créer un groupe de points de contrôle et un objet de type Empty.
Quittez le mode Edit et allez dans l’onglet Modifier du menu Editing
(touche [F9]) pour observer la mise en place automatique d’un nouveau
modificateur.

Normalement, l’objet Empty qui pilote la sélection est présélectionné.
Déplacez-le, faites-le tourner ou redimensionnez-le pour observer son
influence sur l’objet affecté par le modificateur.

BON À SAVOIR   Plusieurs crochets 
affectant les mêmes points

Vous pouvez être amené à mettre en place plusieurs
crochets sur le même objet, chacun de ces crochets
pouvant chercher à influencer les mêmes points de
contrôle. Par défaut, les points seront influencés
équitablement par chacun des crochets. Mais vous
pouvez également jouer sur le curseur Force pour
déterminer l’influence relative d’un crochet, et sur le
bouton numérique Falloff pour diminuer (au sein
de la sélection affectée) son rayon d’effet, à partir
de l’objet Empty qui en est l’origine.

Figure 7–47
Le modificateur Hook
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Construction dynamique de maillage : le modificateur Build
Cette fonction, qui peut paraître d’usage très anecdotique, est très utile
dans le cadre de présentations techniques animées. Le modificateur Build
permet, par exemple, d’afficher progressivement un maillage.

Démarrez une nouvelle session de Blender, ou réinitialisez la scène cou-
rante grâce à la combinaison de touches [Ctrl]+[X]. Sélectionnez le cube
central par défaut, et effacez-le (touche [X] ou [Suppr]). En utilisant la
touche [Espace] ou le menu Add, ajoutez un nouveau maillage : Add>
Mesh>Monkey. Rendez-vous dans le menu Editing (touche [F9]) et
trouvez l’onglet Modifiers. Cliquez sur le bouton Add Modifier et choi-
sissez Build dans le menu déroulant.

Des contrôles supplémentaires apparaissent pour vous permettre de régler
l’effet. Si vous souhaitez que l’effet d’animation commence à la frame n° 5
et se termine au bout de 100 frames, saisissez 5.00 dans le bouton
numérique Start et 100.00 dans le bouton numérique Length. Si votre
compteur de frames est bien à 1, la tête de singe devrait avoir disparu de la
vue 3D. Lancez la prévisualisation de l’animation à l’aide de la combi-
naison de touches [Alt]+[A] : elle devrait réapparaître progressivement !

Figure 7–48
Le modificateur Hook en action, 
après déplacement et redimensionnement 
de l’objet Empty

Figure 7–49
Le modificateur Build

ASTUCE   La fonction Build et le hasard

Si vous trouvez la construction de l’objet affecté
par le modificateur trop prévisible ou trop
ordonnée, utilisez l’option Randomize, dans les
paramètres du modificateur. Le bouton
numérique Seed permet de fixer des graines
pseudo-aléatoires, de sorte que deux animations
consécutives avec le même paramètre Seed don-
neront exactement le même résultat.
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Génération d’ondes : le modificateur Wave
Vous pouvez également générer des ondes à la surface de divers objets,
grâce au modificateur Wave. Cette fonction est utile pour l’animation ou
la modélisation de plans d’eau agités.

Démarrez une nouvelle session de Blender, ou réinitialisez la scène cou-
rante grâce à la combinaison de touches [Ctrl]+[X]. Sélectionnez le cube
central par défaut, et effacez-le (touche [X] ou [Suppr]). En utilisant la
touche [Espace] ou le menu Add, ajoutez un nouveau maillage : Add>
Mesh>Grid en validant les paramètres par défaut. Rendez-vous dans le
menu Editing (touche [F9]) et trouvez l’onglet Modifiers. Cliquez sur le
bouton Add Modifier et choisissez Wave dans le menu déroulant.

Immédiatement, dans la vue 3D, l’objet Grid est affecté par le
modificateur : une onde circulaire centrale le déforme. Si vous lancez la

Figure 7–50 Le modificateur Build en action

3DS MAX   Déformations spatiales

Les modificateurs Curve, Hooks et Wave de
Blender peuvent être assimilés aux déformations
spatiales de 3ds max. Pour certains effets (basés
en particulier sur les forces et les déflecteurs), il
sera nécessaire de recourir aux corps souples (voir
chapitre suivant) ainsi qu’aux options Fields et
Deflection afin de les simuler correctement.
Blender a clairement du retard sur 3ds max, mais
rien qu’un peu d’astuce et une bonne connais-
sance du logiciel permettent de contrebalancer.

Figure 7–51
Le modificateur Wave
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prévisualisation de l’animation dans la même vue (combinaison de
touches [Alt]+[A]), vous verrez l’onde se propager et renaître.

Les paramètres du modificateur Wave se découpent en deux parties. Le
premier bloc de boutons permet de déterminer le sens de propagation (X,
Y ou les deux) et la réitération éventuelle de l’événement (Cycl). Les trois
boutons numériques suivants définissent la frame de naissance de l’onde
(Time sta), la durée de vie de celle-ci (Lifetime) et l’inertie de l’onde
(Damptime), c’est-à-dire le temps mis par l’onde pour mourir à partir du
moment où la durée de vie est atteinte.

Le second bloc de boutons permet de définir géométriquement l’onde,
en commençant par sa position de naissance (les boutons numériques
Sta x et Sta y), sa vitesse (Speed) et sa forme : Width définit la distance
entre deux ondes consécutives, Heigth la hauteur d’une onde, et enfin
Narrow la largeur de l’onde à la base (une faible valeur équivaut à une
onde large, une valeur élevée, à une onde étroite).

Pour finir, le champ Ob: permet de définir un objet (attention à la casse
du nom à saisir !) qui servira d’origine (Sta x et Sta y) à l’onde ; cela
permet d’animer de façon commode l’origine de l’onde (coque d’un
navire fendant la surface de la mer, par exemple). Le champ VGroup,
bien évidemment, permet de nommer un groupe de sommets auquel le
modificateur sera limité. Il est également possible d’utiliser une texture
(champ Texture:) qui permet de moduler l’intensité de l’effet ; il est alors
nécessaire de spécifier le système de coordonnées utilisé (Local, Global,
Object et UV, ces deux dernières options appelant l’utilisateur à nommer
ou choisir spécifiquement les objets et les UV).

ASTUCE   Appliquer les effets 
selon les normales de l’objet

Le modificateur Wave fonctionne très bien lorsqu’il
s’agit de donner un effet d’onde à des maillages
plutôt plans. En activant l’option Normals, le
déplacement dû à l’onde opère dans la direction des
normales aux facettes. Cela permet de transformer
aisément un objet en gelée tremblottante sans
nécessairement passer par les corps souples.

BON À SAVOIR  

Pour simuler une surface d’eau plutôt calme, il peut
être intéressant de recourir à ce modificateur. Il faut
alors utiliser plusieurs fois le modificateur Wave,
en spécifiant des origines différentes (Sta x et
Sta y), mais aussi peut-être des directions X ou Y
(non combinées dans le même modificateur).
Vous pouvez de la même façon simuler des
gouttes chutant dans un plan d’eau (en combinant
cette fois les directions X et Y), mais il vous faudra
probablement un grand nombre de modificateurs
pour obtenir quelque chose de réaliste, ainsi que
pas mal d’expérimentations au niveau de la durée
de vie et la géométrie des ondes.

Figure 7–52
Le modificateur Wave en action
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Le système de particules
Blender nous offre la possibilité d’utiliser des systèmes de particules,
pour simuler, par exemple, l’animation de phénomènes comme la neige,
les flammes ou la fumée. Le principe en est simple.
• Un objet est défini comme étant un émetteur de particules. Les parti-

cules sont émises selon des vitesses et des directions dépendantes des
réglages de l’émetteur. Cela se passe dans le menu Object (touche [F7]),
dans le panneau Particle System des Particle Buttons. Appuyez sur le
bouton Add New pour afficher les paramètres du système de particules
par défaut de Blender. Tous ces contrôles peuvent paraître intimidants,
mais il n’en est rien, nous y reviendrons dans les exemples d’application.

Vous noterez que les particules peuvent être mouvantes (ce qui est le cas
par défaut : les particules sont projetées par l’émetteur et sont indépen-
dantes les unes des autres ; le type de particules est alors Emitter dans le
premier panneau), statiques (les particules forment une chaîne continue,
évoquant par exemple, des fibres, des cheveux ou du gazon ; le type de
particules est alors Hair) ou alors réactives (elles répondent à leur envi-
ronnement, comme par exemple des bulles de savon devant éclater au
contact d’autres objets ; le type de particules est alors Reactor).

• D’autres objets peuvent être définis comme des déflecteurs : cela
implique que les particules rebondiront contre ces objets, ou perdront
de l’énergie cinétique à les traverser. Un objet non défini comme obs-
tacle sera traversé par les particules sans que celles-ci en soient affec-
tées. Pour définir un objet comme étant un obstacle, rendez-vous à
nouveau dans le menu Object (touche [F7]), dans les Physics buttons et
l’onglet Collision. Appuyez sur le bouton Collision pour afficher les
paramètres propres aux obstacles.

• Des « perturbations » ou des « phénomènes » peuvent affecter la tra-
jectoire des particules. En particulier, un générateur de vent ou un
vortex. À moins de modéliser la source de perturbation (par exemple,
un ventilateur pour générer du vent), vous pourrez vous contenter la
plupart du temps d’insérer des objets de type Empty dans vos scènes,

3DS MAX   Les systèmes de particules

Si les paramètres impliqués dans la gestion de sys-
tèmes de particules ont inévitablement des simili-
tudes entre 3ds max et Blender, avec notamment
des possibilités communes dans le cas de parti-
cules pilotées par événements, les deux systèmes
ont toutefois deux approches assez différentes.
Notamment, le module Particle Flow de
3ds max, ainsi que sa structure quasi-nodale, n’a à
ce jour pas d’équivalent dans Blender.

Figure 7–53 Une vue de l’impressionnante fenêtre de gestion des systèmes de particules

Figure 7–54
Le panneau Collision propose des paramètres 
déterminant le comportement d’une particule 

au moment de sa « collision » avec l’objet 
défini comme un obstacle.
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et d’activer des Fields pour ceux-ci : cela se passe à nouveau dans le
menu Object (touche [F7]), dans les Physics buttons du panneau Fields
and Deflection. Cette fois-ci, vous choisirez un type de Fields dans le
menu déroulant disponible.

Les particules sont adimensionnelles. Ce sont des points immatériels,
sans substance. Elles sont naturellement invisibles. Pour les rendre visi-
bles, il faut les « habiller », leur donner une substance. Deux méthodes
sont à notre disposition pour cela.
• Attribuer à chaque particule un matériau de type Halo. Pour cela,

rendez-vous dans le menu Shading (touche [F5]), Material buttons,
onglet Shaders. Activez l’option Halo pour accéder au panneau de
paramètres associé. Chaque particule sera dès lors remplacée par une
petite étincelle. Attention, ce halo est purement visuel : il n’éclairera
aucunement votre scène !

• Attribuer à chaque particule un objet particulier : cet objet rempla-
cera la particule au moment du rendu. Pour réaliser cette attribution,
sélectionnez l’objet de votre scène devant remplacer les particules ;
pressez la touche [Maj] et sélectionnez l’émetteur à l’aide du bouton
droit de la souris. Utilisez la combinaison de touches [Ctrl]+[P] pour
déclarer l’émetteur comme étant le parent de l’objet remplaçant les
particules. Maintenant, sélectionnez l’émetteur seul, et allez dans les
Object buttons du menu Object dans lequel vous êtes normalement
déjà. Appuyez sur le bouton DupliVerts pour valider la substitution.

Figure 7–55
Le panneau Fields and Deflection permet 
d’attribuer à un objet des propriétés qui 
feront qu’il sera capable d’infléchir la course 
des particules passant dans son aire d’effet.

Figure 7–56
Les options pour le halo 
dans l’onglet Shaders

REMARQUE   Halos et reflets 
et les options de raytracing

Les halos sont le résultat d’un post-traitement,
c’est-à-dire intervenant après le rendu de l’image.
En conséquence, ils ne sont pas pris en compte par
le moteur de rendu lorsqu’ils sont censés être vus
par transparence ou par réflexion. Il vous sera
donc impossible d’observer un halo au travers d’un
objet transparent, ou dans le reflet d’un miroir, si
vous avez utilisé les options de raytracing.

ATTENTION   Attribuer un objet à chaque 
particule peut nuire à la santé de 
votre ordinateur !

Si vous recourrez à cette option, gardez à
l’esprit que si vous avez 1 000 particules dans
votre système, c’est l’objet lui-même qui sera
dupliqué 1 000 fois. Cela peut bien évidemment
mettre en péril la mémoire de votre ordinateur,
si la géométrie de l’objet est complexe et com-
prend un grand nombre de points de contrôle.
De plus, les temps de rendu pourront être extrê-
mement longs pour autant que vous utilisiez
quelques options de raytracing, comme les
ombres tracées, la transparence ou les reflets !

ASTUCE   Cacher l’objet source 
et penser à le redimensionner

Si l’objet source est dans le champ de la caméra, il
apparaîtra sur les images au moment du rendu de
l’animation. Vous apprendrez vite à cacher cet
objet quelque part hors du champ de la caméra.
De plus, il vous faudra le redimensionner de sorte
qu’il ait le même volume que votre particule.

ASTUCE  Simulation de fluides

Si vous attribuez à chaque particule une métaballe
au lieu d’un maillage, lorsque deux particules se
rencontreront ou seront très voisines, elles pour-
ront fusionner comme deux gouttes de mercure.
Cette option est très utile pour la simulation de
geysers de pétrole, de sang, ou tout simplement
d’eau. Pour une simulation avancée et plus réaliste
des liquides, consultez le chapitre 8, Techniques
d’animation avancées.
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Simulation d’une combustion
Dans cet exemple, nous allons mettre en place un système de particules
qui simule la combustion d’un matériau générant des fumées lourdes et
épaisses. Le but n’est pas ici de faire particulièrement esthétique, mais
simplement d’illustrer la mise en œuvre des systèmes de particules. Il est
d’ores et déjà important de comprendre un point clé : la qualité d’une
simulation dépend pour moitié de la qualité des matériaux mis en œuvre,
et pas seulement de la justesse du réglage du système de particules.

Ouvrez le fichier exercice-ch07.06-depart.blend du répertoire
/exercices du DVD-Rom. Il contient un certain nombre d’éléments
prédéfinis : un sol, et au-dessus, un plafond massif et incliné. L’émetteur
de particules sera un simple demi-maillage de type Icosphere, et pour
plus de réalisme, la lampe a été placée au même niveau que l’émetteur.
En effet, nous vous rappelons que les particules, même si le matériau est
défini en tant que Halo, n’émettent aucune luminosité.

Vous noterez que grâce aux indices matériau, l’objet Sphere s’est vu doté
de trois matériaux différents ; le premier se nomme Etincelle, et est para-
métré comme dans la figure ci-dessous :

Vous remarquerez en premier lieu l’option Halo du panneau Links and
Pipeline qui est active. Les autres options actives, dans l’onglet Shaders,
sont simplement Lines et Star, qui façonnent différemment le halo, et
Soft, pour leur donner une apparence plus volumétrique. La couleur de
ce dernier est orangée, mais les lignes de l’option Line resteront blanches,
ainsi qu’en témoigne l’onglet Material. Le seul paramètre du halo qui a
été modifié est HaloSize : en effet, ce paramètre conditionne la taille des
particules rendues, et des valeurs importantes conviennent bien à des
flocons de neige, par exemple, mais assez peu à des étincelles ou de la
fumée. Il est important de jouer également sur la valeur Alpha du maté-
riau si l’on ne veut pas des particules trop précises ou solides. Ici, nous
avons choisi volontairement une valeur très faible : A 0.05.

Le second matériau se nomme FumeeNoire. Il s’agit également d’un Halo,
sans autre option, de couleur noire. Son paramètre HaloSize est légère-

Figure 7–57
Le matériau des étincelles
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ment plus grand que celui des étincelles, et son Alpha est de 0.15, car il
occulte la vision de façon plus conséquente.

Le troisième matériau, FumeeLegere, simule une fumée moins dense. Il
est très semblable à FumeeNoire, mais est à la fois plus transparent (A),
plus clair (RGB) et surtout, les particules sont légèrement plus grandes
(HaloSize). L’option Soft est également active.

L’émetteur de particules
Normalement, la demi-sphère émettrice est présélectionnée lorsque vous
ouvrez la scène. Si ce n’est pas le cas, sélectionnez-la avec le bouton droit
de la souris. Appuyez plusieurs fois sur la touche [F7], jusqu’à faire appa-
raître les Particle buttons du menu Object. Dans l’onglet Particle System,
appuyez sur le bouton Add New pour créer un nouveau système de parti-
cules et appelez-le Target.

Dans le groupe de contrôles Basic, vérifions que le type de système soit
Emitter (normalement par défaut), et définissons Amount (le nombre de
particules émises) comme étant égal à 10 000 particules. Les boutons
Sta et End définissent respectivement la frame de début d’émission des

Figure 7–58
Le matériau de la fumée noire

Figure 7–59
Le matériau de la fumée légère

Figure 7–60
Ajout d’un nouveau système 
de particules de type émetteur

ASTUCE   Le bouton numérique Disp

Si vous êtes amené à manipuler un très grand
nombre de particules à la fois, en particulier si
vous avez de nombreux émetteurs, l’interface gra-
phique de Blender en sera considérablement
ralentie. Vous pouvez donc, grâce au bouton Disp
du panneau Visualization, n’afficher dans les
vues 3D qu’un pourcentage des particules émises,
ce qui vous permettra d’alléger la scène et donc de
faciliter les manipulations. Bien sûr, lors du rendu,
toutes les particules apparaîtront normalement.
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particules, et la frame de fin d’émission. Nous spécifierons respective-
ment 1.0 et 250.0. Le bouton Life définit la durée de vie, en frames,
d’une particule. Nous ne souhaitons pas que les étincelles durent long-
temps (sinon ce seraient des flammes !), aussi nous allons spécifier une
valeur assez faible : 20.0. Bien sûr, une particule peut survivre au-delà de
la frame End si le paramètre Life est suffisamment grand.

Dans le groupe de contrôle Emit from, activez les options Random et Even,
pour avoir une émission à peu près homogène depuis toutes les facettes.
Les particules pourront être émises depuis n’importe quel point du Volume
défini par le maillage, de préférence selon une distribution Jittered.

Nous avons déjà introduit un peu de chaos dans la direction d’émission
des particules grâce au paramètre Random, mais pour l’instant, toutes
nos particules ont exactement la même durée de vie. Nous allons auto-
riser les particules à disparaître un peu plus tôt ou un peu plus tard grâce
au paramètre Rand ; le nombre entré ici sera la variation maximale de la
durée de vie d’une particule par rapport à sa durée de vie théorique. En
saisissant la valeur 0.2, nous spécifions donc que les particules auront
toutes une durée de vie Life de plus ou moins 20 %.

ASTUCE  Distribution des particules sur l’émetteur

Dans le cas d’un objet maillé (par exemple, le Cube de la scène par défaut), en activant
l’option Verts, l’émission se produirait seulement par les sommets de l’objet.
Lorsque l’option Faces est activée, l’émission des particules se fait également par les faces de
l’émetteur, et plus seulement par ses sommets. Enfin, l’option Volume permet d’émettre les
particules de n’importe quel point du volume défini par le maillage, et plus seulement depuis
sa surface. L’ordre d’émission des sommets peut soit suivre la liste interne des sommets du
maillage (par défaut) soit ne suivre aucun ordre précis (option Random active). Lorsque
l’option Even est activée, le nombre de particules émises est proportionnel à la surface d’une
face : les grandes faces émettront plus de particules que les petites facettes. Il est enfin pos-
sible de déterminer la distribution des particules sur un élément (distribution réglée selon une
grille Grid, non réglée mais régulière Jittered ou totalement aléatoire Random).

Figure 7–61 Émission par les points de contrôle seulement

ASTUCE  Modes d’affichage au rendu des particules

Figure 7–62

Par défaut, l’émetteur est invisible au moment du rendu, mais dans certains cas vous souhai-
terez qu’il apparaisse ; l’option Emitter du panneau Visualization est là pour cela. De
même, les options Unborn et Died permettent de montrer, respectivement, au moment du
rendu et à une frame donnée, les particules non encore émises (et donc « collées » à l’émet-
teur), et les particules dont la durée de vie a expiré.
La dernière option, Vect, est un peu plus complexe que les autres, dans le sens où, au lieu d’être
représentée par un point adimensionnel, la particule acquiert une longueur (partiellement con-
trôlée par le bouton numérique Size) et une orientation (sa direction d’émission) propres.
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Contrôler l’émission des particules

Tout se passe dans le panneau Physics, avec Newtonian pour type de loi
physique. Le paramètre Normal spécifie la proportion dans laquelle les
particules vont être projetées selon les normales de l’objet émetteur. Plus
cette valeur sera élevée, et plus la particule sera projetée « violemment ».
Dans notre cas, nous spécifierons une valeur plutôt faible ; nous cher-
chons à simuler une petite combustion, pas un lance-flammes : Normal:
0.010. Le paramètre Random du panneau Particle System permet de
rendre plus chaotique, plus aléatoire, et donc plus naturel le phénomène
d’émission ; au lieu de sortir selon des trajectoires très rectilignes, les
particules seront émises un peu n’importe comment : Random: 0.050.

Le groupe de contrôles Global effects permet de définir des forces exté-
rieures constantes agissant sur le déplacement des particules. La direc-
tion et l’intensité de cette force sont déterminées par les composantes
AccX, AccY et AccZ. Par exemple, pour simuler un effet de gravité pure
sur vos particules, donnez une valeur négative (comme -0.5) au
paramètre AccZ. Attention, ces paramètres sont très sensibles, évitez
donc d’employer des valeurs élevées. Dans notre cas, nous souhaitons
que la fumée de particules s’élève, nous choisirons donc une valeur de
AccZ positive : 0.75. Une valeur trop importante accélérerait excessive-
ment le flot de particules, mais la valeur Damp peut aider à équilibrer les
composantes Acc et Normal.

En effet, lorsqu’elle est émise, la particule peut être ralentie, par
exemple, par le frottement de l’air, ou par un environnement plus vis-
queux. Le paramètre Damping sert justement à freiner progressivement
la particule, lui faisant perdre régulièrement de la vitesse. Dans notre cas,
nous jouerons simplement avec la valeur Damping: 0.100.

Générer la fumée grâce au type Reactor

Nous allons maintenant greffer un deuxième système de particules. Dans
le panneau Particle System, vous avez noté un bouton intitulé 1 Part 1 qui
permet de basculer entre les sytèmes de particules liés à l’objet. Le pre-
mier numéro indique le nombre de systèmes de particules déjà liés, et le
second indique le numéro d’index du système affiché. Cliquez sur la

Figure 7–63
Cet onglet définit le flot de particules.

LE SAVIEZ-VOUS ?   Les systèmes pseudo-
aléatoires et la valeur Seed de Blender

Pour comprendre l’intérêt de cette notion de
pseudo-hasard, vulgarisons à l’extrême : si vous
choisissez une valeur véritablement aléatoire, à
chaque fois que vous allez faire le rendu d’un
paramètre utilisant une telle variable, vous allez
obtenir un résultat différent, ce qui peut être très
gênant pour la mise au point de vos scènes, le
résultat n’étant jamais reproductible. Une astuce
consiste alors à utiliser des valeurs pseudo-aléa-
toires, prises dans une table construite aléatoire-
ment, mais inscrites une fois pour toutes dans les
entrailles de Blender par ses développeurs. Par
exemple, la première valeur de la table est tou-
jours la même, ainsi que la deuxième, la troisième,
etc. Les paramètres Seed qui apparaissent parfois
dans l’interface de Blender permettent de déter-
miner la « graine aléatoire », c’est-à-dire la ligne
du tableau dans laquelle une valeur sera lue. Ainsi,
si pour un même effet vous choisissez la même
graine aléatoire, vous obtiendrez exactement le
même résultat.
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petite flèche pointant à droite du bouton : l’interface se vide, vous laissant
créer un nouveau système pour le même objet (1 Part 2). En cliquant sur
Add New, vous ajoutez donc un deuxième système de particules (2 Part 2),
que vous appelerez, par exemple, Reactor_01. Immédiatement, dans le
panneau Visualization, dans le champs Render, assignez Material: 2 à ce
nouveau système de particules, pour qu’il utilise le matériau FumeeNoire,
et actionnez éventuellement le bouton Col. Répétez la manipulation pour
ajouter un troisième système de particules (3 Part 3) appelé Reactor_02
auquel sera assigné Material: 3 dans le panneau Visualization, ce qui cor-
respond au matériau FumeeLegere.

Utilisez les flèches pour afficher le système PA: Reactor_01. Nous avons
déjà vu le fonctionnement des principaux réglages, nous nous contente-
rons de lister les changements à appliquer. Dans le panneau Particle
System, choisissez Reactor à la place d’Emitter dans la liste des types de
systèmes. Spécifiez Amount 200, Rand 1.5, et Life 200 dans les réglages
Basic. Activez le bouton Random des réglages Emit from. Les plus impor-
tants sont les réglages Target. Lorsque vous utilisez un système Reactor, il
vous faut spécifier à quoi le nouveau système réagit. En l’occurrence,
vous devez spécifier :
• OB: l’objet auquel est lié le système de particules en fonction duquel

celui que vous êtes en train de créer doit réagir. S’il s’agit du même
objet que celui du système en cours de création, laissez le champ
libre. Vous pouvez en effet faire réagir le système Reactor en cours de
création à n’importe quel système de particule, lié à n’importe quel
objet de votre scène ;

• Psys: il s’agit du numéro d’index correspondant au système de particules
lié à l’objet OB auquel le système Reactor doit réagir. En effet, tout objet
peut se voir lier différents systèmes de particules (bouton n Part n).

Ce nouveau système est de type Reactor ; en laissant OB vide et en spéci-
fiant Psys: 1, il réagit au premier système de particules de l’objet auquel il
est également lié. Mais il peut réagir à différents phénomènes, comme à
la mort des particules du système cible, à leur collision ou à leur proxi-
mité. Ici, nous souhaitons que les précédentes particules (Etincelle),
lorsqu’elles arrivent en fin de vie, se transforment en particules de la
deuxième génération (FumeeNoire). Nous choisirons donc Death dans le
menu déroulant des paramètres Basic.

Dans le panneau Physics, ne touchez à aucun des paramètres par défaut
mais spécifiez Random 0.500 et Reactor 1.000 pour inviter les nouvelles
particules à suivre la trajectoire initiale des particules qu’elles remplacent.
Choisissez AccZ 1.000 et Damp 0.100. Enfin, dans Visualization, pour
faciliter l’observation dans la vue 3D, n’hésitez pas à choisir un autre
type que Point, par exemple Cross : cela ne change pas vraiment la forme

BON À SAVOIR   Différents types de réactions

Le type Reactor permet de réagir à différents évé-
nements, qui peuvent être définis au nombre de
trois.
• Death : le système de particules se déclenche

lorsque les particules du système cible
meurent ; utile pour la simulation de feux
d’artifice, par exemple.

• Collision : le système de particules se
déclenche lorsque les particules du système
cible touchent un obstacle ; utile pour simuler
des éclaboussures de goutelettes lorsqu’une
particule ou goutte d’eau heurte le sol ou un
obstacle.

• Near : le système de particules se déclenche
lorsque les particules du système cible sont à
proximité ; utile pour simuler l’écume d’un
navire croisant en mer, par exemple.

Bien sûr, un paramétrage fin du système de parti-
cules sera nécessaire pour être réaliste. En particu-
lier, les particules Reactor devront parfois hériter
de la vitesse initiale des particules cibles (paramè-
tres Initial Velocity, en particulier Object, Par-
ticle et Reactor, en fonction des cas simulés).
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des particules mais permet, en plus de l’activation du bouton Col, de dis-
tinguer les différents systèmes de particules lorsque vous validez vos
simulations dans la vue 3D. Vérifiez au passage que Material soit bien à 2
(MA: FumeeNoire) comme spécifié au début de cette partie.

Affichons maintenant Reactor_02 (3 Part 3) qui correspond à une fumée
plus légère. Comme précédemment, dans l’onglet Particle System,
n’oublions pas de spécifier le type Reactor, puis modifions Amount 1500,
Life 250, Death et Rand 1.0 dans les réglages Basic ; Random dans Emit
from ; OB vide et Psys: 2 dans Target. Dans le panneau Physics, adoptez les
mêmes réglages que Reactor_01 pour avoir une bonne continuité phy-
sique, mais passant de la simulation d’une fumée épaisse et lourde à une
fumée plus légère, nous simulerons sa fluidité avec AccZ 1.35 et Damp
0.050. Enfin, dans Visualization, remplacez Point par Circle, Material doit
être à 3 (MA: FumeeLegere), et activez Col.

Vous noterez, dans les réglages Basic des deux systèmes Reactor, des valeurs
Rand plutôt extrêmes (1.5 pour Reactor_01 et 1.0 pour Reactor_02). Pour
le premier, il s’agit de permettre la mort prématurée d’un nombre impor-
tant de particules qui généreront plus vite des particules de la génération
suivante , fluidifiant ainsi l’effet de combustion et rendant le passage de la
FumeeNoire à la FumeeLegere plus progressif. Pour le second, il faut que la
dissipation de la FumeeLegere paraisse beaucoup plus naturelle.

Si nous effectuons maintenant un rendu de notre animation, nous ver-
rons un système de particules pas trop mal réglé, bien qu’encore large-
ment perfectible. Mais son principal inconvénient est que le flot de
particules traverse complètement l’obstacle en pente au-dessus de lui !

Figure 7–64
Le système de particules 
permettant la génération 
de fumée épaisse

ASTUCE  
Les IPO à la rescousse de vos particules

Vous pouvez utiliser des IPO de type Material pour
modifier, par exemple, la couleur, l’intensité ou la
taille des particules au cours de leur durée de vie. La
seule subtilité réside dans le fait que dans ce cadre,
l’intervalle de temps 0-100 de l’IPO se réfère à la
durée de vie d’une particule, et non pas au temps (en
frames) qui s’écoule dans votre animation.

Figure 7–65
Le système de particules 
permettant la génération 
de fumée légère
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L’obstacle
Ce problème est assez facile à régler, car Blender nous permet de déclarer
certains objets comme étant plus ou moins imperméables aux particules.
Dans une vue 3D, sélectionnez l’obstacle en pente au-dessus de l’émetteur
de particules. Appuyez sur la touche [F7] jusqu’à faire apparaître les Physics
buttons du menu Object. L’onglet Collision est celui qui va nous intéresser :
appuyez sur le bouton Collision pour afficher les paramètres qui lui sont
liés. Le paramètre Damping vous permet de déterminer l’amortissement
des particules au moment de la collision avec l’obstacle : si cette valeur est
faible, les particules vont avoir tendance à rebondir violemment sur l’obs-
tacle. Si elle est élevée, elles préféreront glisser le long de celui-ci. Dans
notre cas, s’agissant de fumée et non pas de particules solides, nous spéci-
fierons une valeur de Damping égale à 1.000. Nous utiliserons sa valeur
Rnd, qui permet d’imposer à l’amortissement une variation aléatoire à con-
currence du montant spécifié, avec une valeur de 1.000 pour forcer les par-
ticules à rebondir plus ou moins chaotiquement.

Nous n’utiliserons toutefois ni Friction ni son paramètre Rnd qui permet-
tent de déterminer la perte de vélocité des particules en glissant sur
l’obstacle. Nous n’utiliserons pas non plus Permeability, car nous ne sou-
haitons pas que les particules puissent traverser l’obstacle. En effet, en
jouant avec cette valeur, vous pouvez autoriser une certaine quantité de
particules à le traverser : Permeability 1.000 correspond à l’absence totale
d’obstacle, tandis que Permeability 0.000 indique un obstacle totalement
imperméable au flot de particules.

Figure 7–66
L’animation résultante en quelques images
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Le rendu final de l’animation donne des résultats globalement satisfai-
sants, comme l’indiquent les images qui précèdent. Du travail supplé-
mentaire peut être fourni pour assurer une transition moins brutale entre
les matériaux FumeeNoire et FumeeLegere, et pour définir des shaders un
petit peu plus réalistes, grâce à l’option HaloTex de l’onglet Shaders des
Material buttons, dans le menu Shading (touche [F5]). Le fichier final de
cet exemple se trouve dans le répertoire /exercices du DVD-Rom sous
le nom exercice-ch07.06-final.blend.

Simulation d’un gazon
Dans ce deuxième exemple, nous allons mettre en œuvre des particules
statiques afin de créer un parterre de gazon fraîchement tondu. Nous l’ani-
merons également grâce à la mise en place d’un Field. Maintenant que
nous sommes familiarisés avec les particules dynamiques, nous n’allons pas
rencontrer de difficulté particulière avec les particules statiques.

L’émetteur de particules
Ouvrez le fichier exercice-ch07.07-depart.blend du répertoire
/exercices du DVD-Rom. Celui-ci présente, outre la caméra et la lampe
par défaut de toute scène Blender, un maillage de type Plane occupant le
centre de la scène, et un objet de type Empty. L’objet Plane est particulier
dans le sens où il lui a été attribué deux indices matériaux ; le premier, Terre,
est un simple matériau marron, attribué à l’ensemble des faces de l’objet. Le
second, Herbe, est également un simple matériau vert, qui n’est toutefois
attribué à aucune face de l’objet. Tout s’expliquera prochainement.

Le bouton Strands

Cette option s’active dans le panneau Links and Pipeline : Material buttons, menu Shading (touche [F5]). En
cliquant dessus, vous faites apparaître un menu flottant qui n’a d’influence que sur les particules de type Hair.
• Use Tangent Shading : permet de capter la lumière de façon réaliste, simulant aisément les reflets sur une

coupe de cheveux, par exemple.
• Surface Diffuse : extrapole l’illumination diffuse des particules à partir des normales à la surface du maillage

émetteur ; particulièrement dédié au gazon ras ou aux poils courts.
• Dist : Permet de combiner les deux comportements précédents jusqu’à une longueur de brins spécifiée (en unités

de Blender).
• Use Blender Units : spécifie les dimensions des brins en unités de Blender plutôt qu’en pixels (voir Start et

End ci-après).
• Start : définit, en pixels, la largeur du brin à sa base.
• End : définit, en pixels, la largeur du brin à son extrémité.
• Shape : coefficient de forme déterminant dans quelle mesure le brin est arrondi.
• Width Fade : permet d’introduire une transparence croissante (de la base à l’extrémité) d’un brin sur sa lon-

gueur, pour le rendre encore plus doux et duveteux. Avec une valeur de 0.0, pas de transparence ; la transpa-
rence croît de façon linéaire, jusqu’à une valeur de 1.0 ; au-delà, la transparence croît de façon plus sensible.

• UV: spécifie la texture UV dont les brins hériteront la couleur.

Figure 7–67
Les options Strands
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Sélectionnez l’objet Plane s’il ne l’est pas ou plus (il l’est normalement
par défaut). Appuyez sur la touche [F7] jusqu’à afficher les Particle but-
tons du menu Object. Nous allons commencer par ajouter à l’objet un
système de particules en cliquant sur le bouton Add New. Juste en-des-
sous de celui-ci, spécifiez Hair comme type de particules. Vous noterez
immédiatement que les paramètres accessibles diffèrent à nouveau des
types Emitter et Reactor. Mais surtout, par défaut, le panneau Visualiza-
tion propose Path comme forme de présentation.

Dans le panneau Particle System, le paramètre Amount spécifie comme
précédemment le nombre de particules qui seront générées : choisissez
2000. Le paramètres Segments, pour sa part, indique le nombre de seg-
ments qui constitueront chaque brin : laissez-le à sa valeur par défaut de
5. Dans les paramètres Emit from, activez le bouton Random et la distri-
bution Faces, de même que le bouton Even et la distribution Random pour
donner un aspect beaucoup plus naturel à la répartition des brins.

Dans le panneau Physics, nous conservons un système de type Newtonian.
Spécifiez Normal 0.150 et Random 0.050 pour générer les brins dans la
vue 3D, régler leur longueur initiale et leur « rectitude ». Dans les para-
mètres Global Effects, donnez une valeur négative à AccZ, par exemple
-0.010 et donnez une part de mouvement brownien au tracé des parti-
cules, grâce au paramètre Brown à une valeur 0.20, par exemple, qui ren-
dront les particules un peu plus chaotiques.

Effectuez un premier rendu, grâce à la touche [F12] : les herbes sont de la
couleur marron du sol, et celui-ci n’apparaît tout simplement pas. Nous
allons corriger cela dans le panneau Visualization, dans les paramètres
Render. En activant le bouton Emitter, l’objet qui émet les particules
devient visible au rendu, comme le montre l’usage de la touche [F12].
Malheureusement, les particules marron sur le sol de même couleur ne
fait pas honneur à notre carré d’herbe. Le plan de base présente toutefois
un deuxième matériau, vert, plus approprié aux herbes : choisissez Mate-
rial: 2 à la place de 1 pour l’attribuer aux particules. Optionnellement,
vous pouvez également activer le bouton Col.

Figure 7–68
Les paramètres

de génération du gazon
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Pour l’instant, le gazon obtenu peut paraître clairsemé, en fonction des
objectifs de votre scène. Pour densifier la végétation, vous pouvez bien
évidemment augmenter la valeur du paramètre Amount, mais il existe
également d’autres façons de procéder.

Remarquez l’existence d’un onglet Children, qui présente pour l’instant
un simple menu déroulant. Dans celui-ci, choisissez Faces : immédiate-
ment, dans la vue 3D, l’herbe devient considérablement plus dense.
Toutefois, l’apparence du gazon est maintenant trop duveteuse, ressem-
blant plus à une fourrure qu’à une pelouse richement garnie.

Dans le panneau Children se trouvent plusieurs contrôles :
• Amount : spécifie le nombre de particules « enfants » pour chaque

particule parent initiale, visible dans la vue 3D, pour vos besoins de
mise au point ;

• Render Amount : spécifie le nombre de particules « enfants » pour
chaque particule parent initiale, visible au moment du rendu.

Pour un gazon déjà relativement dense, vous pouvez vous contenter
d’une valeur Render Amount de 5 ; si votre ordinateur ne supporte pas
cette même valeur dans la vue 3D (plantage, lenteur ou autre), vous
pouvez la diminuer pour le paramètre Amount.
• Clump : ce paramètre permet de générer des touffes, en spécifiant le

taux d’aggluttinement des particules enfants par rapport aux parti-
cules parents les plus proches.

• Shape : ce paramètre permet de contrôler le taux d’atténuation de
l’effet de touffes en fonction de la distance.

Figure 7–69
Un gazon bien facile à planter et à entretenir !
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Inutile d’essayer des valeurs extrêmes avec ces paramètres pour obtenir
des résultats intéressants ; essayez des valeurs de Clump comprises entre
0.50 et 0.75 pour vous en persuader, puis faites varier Shape entre 0.0 et
1.00. Des valeurs respectives de 0.70 et 0.25 paraissent générer des
touffes d’herbe satisfaisantes.

Un rendu à ce stade nous donnera un résultat plus qu’intéressant ! Il ne
nous reste plus qu’à voir comment on peut animer ce petit gazon.

Le champ d’action : Wind
Sélectionnez maintenant l’objet Empty de la scène, et appuyez sur la
touche [F7] pour afficher les Physics buttons du menu Object. Dans le
panneau Fields se trouve un menu déroulant portant la mention None. En

BON À SAVOIR   Les options Kink/Branch

Il est possible de spécifier des formes spécifiques de particules « enfants » aux systèmes de par-
ticules. Activez-le bouton Kink/Branch du panneau Children, et révélez le menu déroulant.
• Braid : permet de générer les particules enfants de façon à simuler tresses et nattes.
• Curl : permet de générer les particules enfants de façon à simuler boucles et frisettes.
• Radial : permet de générer les particules enfants de façon à ce qu’elles se courbent dans

une direction radiale.
• Wave : permet de générer les particules enfants de façon à simuler des ondulations.
Chaque option propose ses propres paramètres de contrôle ; en particulier, une direction pour
l’effet (X, Y ou Z), une fréquence (Freq : le nombre de fois que l’effet est appliqué sur la lon-
gueur de la particule), une Amplitude pour l’effet et un contrôle pour réguler la forme entre
la racine de la particule et son extrémité (Shape).

ASTUCE   Le bouton Use Seams

De la même façon que vous pouvez utiliser des
coutures pour le dépliage, vous pouvez spécifier
des coutures sur le maillage de l’émetteur ; celles-
ci n’influeront pas sur les particules parents, mais
lorsque l’option Use Seams est activée, les parti-
cules enfants seront générées uniquement du côté
de la couture de la particule parent correspon-
dante. Cela est tout à fait inutile pour la généra-
tion d’une pelouse, mais lorsque vous utilisez les
particules Hair pour créer une coiffure à un per-
sonnage, cela permet de réaliser des raies plus
facilement.

Figure 7–70
Le gazon est désormais

plus dense et accueillant !
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cliquant dessus, vous affichez les différents types de champs d’action
supportés par Blender : choisissez Wind. Normalement, l’objet Empty est
déjà orienté sur le carré de gazon, mais il faut toujours se rappeler que
l’effet Wind est directionnel, et que tant sa position que son orientation
peuvent influer sur l’animation de vos particules.

Plusieurs paramètres vont nous intéresser. Strength est l’intensité du Field,
et Fall-off est le facteur d’atténuation de celui-ci en fonction de la dis-
tance. L’option Use MaxDist permet de déterminer une distance (grâce au
bouton numérique MaxDist) au-delà de laquelle le Field n’agit plus. Pour
notre part, nous ne souhaitons pas piloter le Strength du Field par une
valeur numérique constante : comme nous souhaitons simuler l’effet de
petites bourrasques ou de coups de vent irréguliers, nous allons associer
une coupe IPO au field Wind.

Dans l’en-tête principal, affichez l’écran d’animation : SCR: 1 � Animation.
Dans la vue 3D, passez en vue de dessus (touche [7] du pavé numérique) et
sélectionnez l’Empty de la scène. Dans la vue des IPO, sélectionnez le para-
mètre FStrength dans la colonne de droite. En maintenant la touche [Ctrl]
appuyée, utilisez le bouton gauche de la souris pour ajouter aléatoirement
quelques points entre les valeurs 0.0 et 2.0 en ordonnée, entre les frames 1
et 150 en abscisse.

Figure 7–71
Le Field Wind dans la vue 3D

BON À SAVOIR   Les différents types de Fields

Il existe plusieurs types de Fields dans Blender,
chacun avec sa méthode d’interaction avec les
particules, mais aussi les corps souples.
• Spherical : il s’agit en fait d’un champ de force

qui va attirer ou repousser les particules pas-
sant dans sa zone d’effet.

• Wind : une force additionnelle vient accélérer,
contrarier, ou infléchir la course des particules
passant dans sa zone d’effet.

• Vortex : les particules passant dans sa zone
d’effet sont comme aspirées ; elles perdent de
l’énergie à se sortir du vortex, et sont parfois
déviées significativement.

• Magnetic : les particules sont attirées (ou
repoussées !) comme par un aimant
lorsqu’elles se trouvent dans sa zone d’effet.

• Harmonic : les particules essaient de s’aligner
en direction du Field, en fonction de la
Strength spécifiée.

• Texture : permet d’utiliser des textures pour
contrôler la distribution des particules ; une
texture animée permet d’animer les particules.

Figure 7–72
Le panneau Fields

Figure 7–73
L’éditeur de courbes IPO pour le Field Wind
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Il ne nous reste plus qu’à lancer le calcul de l’animation en appuyant sur
le bouton ANIM du panneau Anim, dans les Render buttons du menu
Scene. Si vous souhaitez l’étudier, vous trouverez le fichier final de cet
exemple dans le répertoire /exercices du DVD-Rom sous le nom
exercice-ch07.07-final.blend.

Contrôler le comportement des particules grâce au Weight Painting
Il est également possible de contrôler la distribution des particules en
utilisant les groupes de sommets. Par exemple, dans le menu Editing [F9],
dans le panneau Link and Materials, cliquez sur le bouton New du groupe
de paramètres Vertex Groups, et nommez le nouveau groupe Longueur.
En mode Weight Paint, sur un maillage suffisamment subdivisé, peignez
(panneau Paint du menu Editing [F9]) les zones dans lesquelles les brins
d’herbe auront la plus grande longueur.

Dans le panneau Extras du système de particules, dans le menu déroulant
du champ Vertex Group, choisissez l’option Length. À l’extrémité droite se
trouve un bouton ascenseur permettant de sélectionner un groupe de
sommets. Sélectionnez celui que nous venons de créer : Longueur. Si vous
effectuez le rendu, vous verrez que la longueur des brins prend en

Figure 7–74
Les couleurs chaudes produiront les brins
les plus longs (la couleur rouge indiquant

la longueur maximale), tandis que les couleurs
froides produiront des brins plus courts

(la couleur bleu indiquant une longueur nulle).
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compte le « poids » indiqué lors de l’opération de Weight Painting, les
zones les plus chaudes produisant les brins les plus longs.

Bien sûr, outre la longueur (Length) des particules, il est possible de
piloter avec le Weight Paint d’autres paramètres des systèmes de parti-
cules, parmi lesquels la densité (Density), la vitesse initiale (Velocity), la
taille (Size), la tendance à produire des touffes (Clump) ou l’influence des
Fields (Effector), par exemple.

Le même Vertex Group peut être réutilisé pour plusieurs paramètres, mais
il est également possible (et recommandé) d’utiliser des groupes diffé-
rents à chaque fois !

Figure 7–75
Avec le Weight Paint, il est possible 
de contrôler la longueur, la densité 
et bien d’autres paramètres des systèmes
de particules, pour un contrôle plus poussé 
de leur distribution ou de leur longueur.

Figure 7–76 Génération de fourrure sur un tigre par © Ay Muhammet : http://aslan.infographie.free.fr/
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Simulation d’une coiffure
Simuler une chevelure ou de la fourrure n’est guère différent que de faire
pousser du gazon. Pour vous en persuader, faites l’expérience en ouvrant
le fichier exercice-ch07.08 depart.blend. Il présente un modèle de
visage (issu du logiciel MakeHuman), pour lequel un Weight Paint a déjà
été appliqué sous le nom Chevelure : les zones d’émission des futures
particules sont clairement identifiées par les couleurs chaudes, mais vous
pourrez être amené à les corriger légèrement en cours d’exercice, si vous
l’estimez nécessaire.

Appuyez plusieurs fois sur la touche Object [F7] jusqu’à afficher les Par-
ticle Buttons. Dans le panneau Particle System, cliquez sur le bouton Add
New et choisissez Hair comme type de système. Choisissez Amount 5000
environ et dans la partie Emit from activez Random et l’option Faces, puis
Even avec l’option Jittered. Notez le bouton Set Editable, mais ne l’activez
pas encore : nous y reviendrons très prochainement.

Dans le panneau Physics, conservez Newtonian comme type de simula-
tion physique, et générez les premiers cheveux en spécifiant à Normal
une valeur faible. Plus la valeur sera élevée, plus les cheveux seront longs.
Nous optons pour une coupe courte et choisissons une valeur de l’ordre
de 0.050. Les cheveux apparaissent sur tout le visage, ce qui n’est pas
l’effet recherché ! Nous allons mettre à profit le Weight Paint, grâce à
l’onglet Extras : tout en bas, dans la partie Vertex group, choisissez Density
dans le menu déroulant et, grâce au bouton sélecteur situé sur la droite,
sélectionnez le groupe Chevelure. Les cheveux sont instantanément
redistribués en fonction du Weight Paint.

Figure 7–77
Le Weight Paint permet de contrôler

la distribution des cheveux...
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Enfin, dans le panneau Visualization, activez l’option Emitter, pour vous
assurer que le visage soit rendu en même temps que les cheveux et, dans
le panneau Children, activez Faces et spécifiez une valeur de 5, pour
Amount et Render Amount.

Nous allons maintenant commencer à coiffer notre personnage. Pour
cela, revenez au bouton Set Editable du panneau Particle System et activez-
le. De la même façon que des outils permettent de sculpter des terrains
ou des formes très organiques (Sculptmode), il existe un Particlemode
(accessible dans l’en-tête de la vue 3D ou grâce à la combinaison
[Ctrl]+[Maj]+[Tab]) que nous vous invitons à activer. La touche [N]
appelle un panneau flottant avec des outils de coiffure, que vous pouvez
également afficher grâce au menu Particle>Particle Edit Properties de l’en-
tête de la vue 3D.

Les options du groupe de paramètres Keep sont très intéressantes et sont
à garder à l’esprit lors des opérations de coiffure.
• Lengths : permet de garantir la constance de la longueur de chaque

cheveu individuellement.
• Root : permet de garantir que la racine de chaque cheveu est inamo-

vible, relativement au maillage émetteur.
• Deflect Emitter : permet d’assurer que, lors de la coiffure, les cheveux ne

pénètrent pas le maillage émetteur, mais restent, au contraire, à la
surface ; le paramètre supplémentaire Dist permet de définir la distance
minimale en-dessous de laquelle un cheveu ne peut pas s’approcher de
l’émetteur. Cette distance est exprimée en unités de Blender.

Figure 7–78
... ainsi qu’en témoigne cette capture de la vue 3D !

Figure 7–79
Les outils de coiffure de Blender
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Pour la plupart des travaux de coiffage courants, ces trois options doivent
être activées. En particulier, Root et Deflect Emitter doivent le rester, pour
éviter des catastrophes autrement très probables, comme des cheveux qui
se déplacent ou qui rentrent à l’intérieur du crâne.

Les options d’affichage peuvent également se révéler intéressantes :
• Steps : indique le nombre de subdivisions de chaque cheveu lors de

l’affichage, ce qui influe sur la précision de son tracé ;
• Show Children : lorsque cette option est active, elle affiche aussi bien

les particules enfants que les particules parents qui sont coiffées.

Cette dernière option est souvent utile pour visualiser l’allure générale de la
coiffure en temps réel, mais elle consomme plus de ressources. Il est con-
seillé de la désactiver pendant les opérations de coiffage, et de ne l’activer
que pour les retouches ou pour visualiser le résultat final de temps à autre.

Les outils de coiffure à disposition fonctionnent par défaut sur tous les
cheveux en même temps, sauf si une sélection existe (voir aparté Modes
de sélection, ci-contre), auquel cas ils ne s’appliquent qu’à cette sélection.
• Comb : il s’agit de l’outil « peigne », qui permet de déplacer les che-

veux le long de la trajectoire de la brosse.
• Smooth : permet de lisser la position des cheveux par rapport à leur

entourage immédiat.
• Weight : permet d’appliquer la technique du Weight Painting sur les

cheveux, en vue d’une simulation de corps souple.
• Add : permet d’ajouter des cheveux sous l’outil, éventuellement en les

interpolant à partir des cheveux déjà existants (bouton Interpolate, le
curseur Keys définissant le nombre de points constituants les nou-
veaux cheveux).

• Length : permet d’allonger (option Grow) ou de raccourcir (option
Shrink) la longueur des cheveux.

• Puff : permet de donner (Add) ou d’enlever (Sub) du volume à la coiffure.
• Cut : outil « ciseau », qui permet de couper les cheveux.

Commencez par sélectionner l’outil Comb, et ramenez les cheveux le
long du crâne. Faites-le grossièrement pour commencer (paramètre Size
50, par exemple), puis mèche par mèche quand nécessaire (Size 5-15). Si
certaines zones sont un peu trop dégarnies, utilisez l’outil Add pour
ajouter des cheveux sous l’outil.

Lorsque vous arrivez à un effet général satisfaisant, utilisez l’outil
Smooth, avec un Strength relativement bas (de l’ordre de 20-25), pour
lisser convenablement la chevelure. Enfin, utilisez l’outil Puff pour
ajouter un peu de volume à la coiffure là où elle en manque, puis l’outil
Cut pour la tailler convenablement. Cette opération est souvent plus
facile à réaliser lorsque les particules « enfants » sont affichées.

ASTUCE   Modes de sélection

Dans l’en-tête de la vue 3D, en Particle Mode, dif-
férents modes de sélection sont mis à disposition.
• Path edit mode : c’est le « chemin » entier du

cheveu qui est édité.
• Point select mode : il est possible d’éditer

individuellement chacun des sommets consti-
tuant le chemin du cheveu, le nombre de points
dépendant du nombre de segments spécifiés
dans le panneau Particle System.

• Tip select mode : dans ce mode, seules les
extrémités des pointes des cheveux sont édita-
bles.

À ce jour, ils partagent les mêmes icônes que les
modes de sélection de sommets, d’arêtes et de
facettes du mode Edit classique propre aux
maillages, mais cela pourrait évoluer dans le futur.

Figure 7–80

BON À SAVOIR   Les particules 
et les couleurs de l’émetteur

Les particules Hair héritent de la couleur de
l’émetteur à l’endroit d’émission de la particule,
alors qu’autrefois elles n’héritaient que de la cou-
leur diffuse Col. Cela veut dire que l’émetteur peut
être mis en couleur grâce à des textures UV, des
textures procédurales ou des textures bitmap
selon les modes de projection classiques.
Cela est particulièrement utile pour donner des
variations de couleur subtiles aux cheveux ou aux
herbes d’un paysage, grâce aux textures procédu-
rales. Mais dans le cas de pelage ou de fourrures,
la possibilité de conférer aux particules Hair la
couleur de la texture UV est également un plus
indéniable, comme par exemple pour le pelage
d’un zébre, d’une girafe ou d’un tigre.
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Simulation d’un système de proies et prédateurs avec 
les particules Boids
Les Boids sont un magnifique système d’intelligence artificielle, très
simple et facile à mettre en œuvre, qui permet de créer des scénarios
basés sur des comportements prédéterminés. En particulier, il permet de
reproduire des schémas de prédation, d’attroupements grégaires, de
foules évoluant autour d’obstacles et ce genre de choses.

Mise en place de la scène
Démarrez avec une nouvelle scène ([Ctrl]+[X]) et assurez-vous que le
cube par défaut est sélectionné. Dans le panneau Link and Materials du
menu Editing [F9], changez son nom dans le champ OB: pour obtenir
quelque chose de plus pertinent, comme Proies. Déplacez-le dans un
coin de votre scène (touche [G] dans la vue de votre choix).

Ajoutez alors un nouveau Cube grâce à la combinaison [Espace]>Add>
Mesh>Cube. De même que précédemment, renommez-le Predateurs et
déplacez-le à l’extrémité opposée de la scène. Utilisez la touche [S] pour
lui donner une taille plus grande que celle du cube Proies (SixeX = SizeY =
SizeZ = 3.0 par exemple).

Figure 7–81
Le résultat d’une petite dizaine de minutes 
de coiffage avec le Particle mode de Blender

ASTUCE   Le Spherical Field au secours 
des proies et des prédateurs

Dans de telles simultations, l’usage de Spherical
Fields avec des valeurs négatives de Strength
(force repoussante, propre aux prédateurs) ou
positives (force d’attraction, proies) sera facile
d’usage. De plus, l’usage des options Die on Hit
(dans l’onglet Extras) se révèlera également utile
lorsqu’un prédateur attrapera avec succès une par-
ticule proie.
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Mise en place des systèmes de particules

Les proies

Choisissez le cube Proies. Dans le menu Object [F7], dans les Particles but-
tons, cliquez sur le bouton Add New du panneau Particle System. Changez
quelques-unes des valeurs :
• Amount : 100 afin de définir un essaim de 100 particules proies ;
• Life : 1500 afin de donner à chaque particule une durée de vie suffi-

sante pour que la simulation proies-prédateurs soit fonctionnelle.

Décidons maintenant du nombre de particules proies qui apparaîtront :
dans le panneau Visualization, assurez-vous que chaque particule soit repré-
sentée comme un Point et donnez-lui une taille Draw Size de 3 (il s’agit seu-
lement de la taille de la particule dans la vue 3D). Nous voulons que les
proies soient petites, aussi, dans le panneau Extras, spécifions Size égal à 0.3
(il s’agit de la taille de la particule prise en compte dans la simulation ; ce
paramètre aide les proies à savoir à quelle distance elles sont les unes des
autres, et donc à rester le plus groupées possibles). Il est également temps
d’activer l’option Die on hit, car nous voulons que ces particules disparais-
sent lorsqu’elles sont rattrapées par des particules prédatrices.

Maintenant, nous devons donner des règles à suivre aux particules. Dans
le panneau Physics, choisissez Boids comme système de particules dans le
menu déroulant, et modifiez les paramètres Physics de sorte que les
proies soient un peu plus lentes que les prédateurs (afin de leur donner
l’avantage de la vitesse sur les proies) en diminuant MaxVelocity à 7.000.
Il n’est pas nécessaire de modifier les autres règles, car nous souhaitons
mettre en place une simulation très simple.

Les prédateurs

Maintenant, séléctionnez le cube Predateurs. Dans le menu Object [F7],
dans les Particles buttons, cliquez sur le bouton Add New du panneau Par-
ticle System. Changez quelques unes des valeurs :
• Amount : 10 afin d’avoir une meute composée de 10 particules

prédatrices ;
• Life : 1500 afin de donner à chaque particule une durée de vie suffi-

sante pour que la simulation proies-prédateurs soit fonctionnelle.

Pour faciliter la compréhension visuelle de la simulation, dans le pan-
neau Visualization, sélectionnez Cross à la place de Point et donnez aux
particules une Draw Size de 10. Comme nous souhaitons que les préda-
teurs puissent aisément « dévorer » les particules proies, définissez leur
taille Size à une valeur plus élevée, comme 1.5, ce qui signifie que dès
qu’une particule proie pénétrera le rayon d’action d’une particule préda-
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trice, elle sera dévorée. Parce que l’option Die on hit est activée pour la
particule proie, celle-ci disparaîtra alors, tout simplement.

Maintenant, intéressons-nous à la partie la plus intéressante de cette
simulation : dans le panneau Physics, choisissez Boids dans le menu
déroulant, comme type de sytème de particules, et réglez son comporte-
ment (paramètres Behaviour) comme suit :
• Goal : 1.500 afin de favoriser la recherche des proies (objectifs) ;
• Crowd : 1.00 afin de défavoriser l’attroupement des prédateurs ;
• Collision : 0.500 ;
• Avoid : 0.500 ;
• tous les autres : 0.100-0.250.

Déplacez ensuite les propriétés Goal et Crowd plus haut dans la liste, en
utilisant les petites flèches haut et bas en face de chaque règle, afin de les
rendre prioritaires par rapport aux autres règles de même valeur.

Logiquement, les prédateurs sont doués pour la chasse. Afin de refléter ce
fait, assurez-vous que leur vitesse maximale MaxVelocity (par défaut,
10.000) est plus grande que celle des proies (7.000 si vous avez suivi les
instructions précédentes) et spécifiez une vitesse moyenne AvVelocity éga-
lement plus élevée (par exemple, 0.500 alors que les proies ont une valeur
de 0.300). De plus, toujours afin de conférer aux prédateurs des avantages
stratégiques sur les proies, donnez-leur une meilleure accélération tangen-
tielle TangAcc (par exemple, 0.500 alors que les proies ont une valeur de
0.200). Enfin, diminuez la taille de la meute à quelque chose comme N 3,
de sorte que les prédateurs préfèrent chasser en petits groupes.

BON À SAVOIR   Les règles comportementales des Boids

Elles sont en nombre limité, mais permettent déjà de simuler un grand nombre de scénarios.
Elles poussent les Boids à :
• Collision : éviter les obstacles ;
• Avoid : éviter les prédateurs ;
• Crowd : éviter les autres boids ;
• Center : se placer au centre de l’essaim ;
• AvVel : maintenir la vitesse moyenne ;
• Velocity : calquer sa vitesse sur celle des boids voisins ;
• Goal : poursuivre son objectif ;
• Level : rester à la même altitude Z.
Des comportements normaux sont attendus avec des valeurs comprises entre 0.000 et
1.000. Mais les boids peuvent sur-réagir, conformément aux règles, avec des valeurs com-
prises entre 1.000 et 2.000. Réciproquement, avec des valeurs négatives comprises entre
-1.000 et 0.000, le boid agira contrairement à la règle.
Il est également important de noter que l’ordre des règles dans la pile est important ; en effet,
pour éviter un prédateur, un boid avec une forte valeur pour Avoid pourra accepter une colli-
sion malgré une forte valeur Collision, si Avoid est placée avant dans la pile.
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Les Fields : comment fonctionnent-ils ?
Nous en avons pratiquement fini. Sélectionnez l’émetteur Proies et, dans le
panneau Fields des Physics buttons, choisissez Psys à la place de Object et
spécifiez-lui un field Spherical avec une force positive Strength égale à
2.000. Sélectionnez maintenant l’émetteur Predateurs et, dans le même
panneau Fields, sélectionnez PSys.001 à la place d’Object. Comme précé-
demment, spécifiez-lui un field Spherical, mais cette fois avec une force
négative Strength égale à -10.000 et une atténuation Fall-off de 2.000.

Pour expliquer les choses simplement, une valeur positive va dire à toutes
les autres particules boids de la scène que ces particules sont des proies
que les prédateurs trouveront appétissantes et tenteront d’attraper, grâce
à la valeur Strength de 2.000 qui leur a été conférée. Dans le même ordre
d’idée, la valeur négative va dire à tous les autres boids de la scène que
ces particules sont très dangereuses, à cause de leur valeur Strength de
-10.000 et que toutes les proies potentielles qui sont dans le secteur
devraient absolument essayer de s’échapper de leurs griffes !

La valeur d’atténuation Fall-off fonctionne exactement comme pour les
autres Fields. Par exemple, lorsqu’un prédateur est éloigné, la particule
proie ne le remarquera pratiquement pas, car le Fall-off rendra le Field
trop faible, passée une certaine distance. Mais plus le prédateur va
s’approcher, plus l’effet du Field sera insistant, pressant la proie à fuir à
toute volée dès que le prédateur se sera approché. Le paramètre MaxDist
peut également être très utile ici, car grâce à lui, un prédateur peut
s’approcher très près d’une proie avant d’être détecté ; lorsque la distance
maximale spécifiée est atteinte, la proie devient alerte et tente de s’enfuir.

Jouer la simulation
La dernière étape consiste à déterminer la durée de la simulation. Cela se
passe simplement dans l’onglet Bake des Particle buttons : il faut unique-
ment spécifier une valeur suffisamment élevée pour le bouton End afin
que la simulation entière soit calculée ; une valeur de 1000-1500 paraît
cohérente vis à vis de la durée de vie Life spécifiée pour les particules,
mais quelques essais permettront de s’en assurer. Ajustez cette valeur
pour chaque système de boids mis en scène.

Si vous avez besoin d’ajuster la durée de vie Life des particules, pensez à
libérer la mémoire de la simulation courante, en cliquant sur le bouton
Free Cache de l’onglet Bake. Vous lancerez le calcul de la simulation grâce
au bouton Bake du même onglet, ou en lançant l’animation grâce à
[ALT]+[A] avec le curseur de la souris dans la vue 3D de votre choix. La
touche [ESC] mettra fin à la simulation.
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Vous retrouverez le résultat de cette simulation dans le fichier exercice-
ch07.09-final.blend.

Conclusion
Vous avez désormais toutes les cartes en main pour réaliser des anima-
tions assez sophistiquées, même si toutes les possibilités sont loin d’être
couvertes. En fait, grâce à ces outils, vous pouvez virtuellement animer
n’importe quoi, mais pour certaines animations particulièrement com-
plexes, Blender propose d’autres outils, plus avancés mais aussi plus spé-
cifiques. Cette spécialisation est le prix à payer pour obtenir des
animations particulièrement réalistes, et impose à l’utilisateur l’acquisi-
tion de compétences supplémentaires.

Figure 7–82 Les prédateurs (croix) fondent sur les proies (points) 
et les déciment en quelques secondes de course-poursuite désespérée.
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chapitre 8

Tree frog and dragonfly, © 2006 par Jason Pierce : http://cs.unm.edu/~sketch/gallery/
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Techniques d’animation 
avancées

Ce chapitre vous montrera les techniques d’animation les plus 
avancées de Blender. Elles n’en sont pas pour autant forcément 
les plus complexes, mais les plus diversifiées et différentes du 
reste des autres fonctionnalités de Blender.

SOMMAIRE

B Animation de corps souples

B Animation de corps rigides

B Simulation de systèmes fluides

B Animation squelettale

B Éditeur d’actions

B Éditeur d’actions non linéaires

MOTS-CLÉS

B Softbody
B Cloth
B Goal
B Bake
B Game Engine
B Bullet
B Fluides
B Armature
B Squelette
B Rig
B Action
B Bandes d’actions
B Composition
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Le système d’animation de Blender a complètement été revisité par ses
développeurs, au fil des mois, depuis la première édition de cet ouvrage.
L’existant a été réécrit et amélioré (en particulier l’animation de person-
nages, désormais presque une formalité), tandis que des domaines bien
plus avancés, tenant plus de la simulation physique que de l’animation,
ont été ajoutés et améliorés ; on notera notamment l’arrivée des corps
souples (idéaux pour l’animation de textiles ou de chevelures), celle plus
balbutiantes des corps rigides (tenant compte de la géométrie et de la
masse des objets de vos scènes), ou encore la simulation des fluides. Ce
chapitre vous propose de découvrir chacun de ces domaines.

Les corps souples
Les corps souples (Soft Bodies, en version originale) constituent un sys-
tème permettant de simuler la déformation d’objets en réponse à des sol-
licitations « extérieures ». Par exemple, un objet en acier écrasant un
autre en mousse, le vent déplaçant des rideaux, les cheveux d’un coureur,
etc. Outre la définition géométrique du corps souple à son état « au
repos », il nous faudra définir sa rigidité globale. Plutôt que de présenter
la théorie des corps souples, nous allons traiter deux exemples complets
qui nous permettront de saisir la logique de fonctionnement.

La nappe
Nous allons commencer par un exemple très simple de l’usage des corps
souples, qui va nous permettre d’appréhender les limites du système,
dans le cadre de l’animation de vêtements ou de textiles. Il va simple-
ment s’agir d’appliquer une nappe sur un objet anguleux.

3DS MAX   Module d’extension Reactor

Dans 3ds max, les animations physiques sont
introduites par un module d’extension spécifique
qui permet la simulation de corps rigides, de corps
souples, mais aussi de l’eau et du vent. Dans
Blender, la première est héritée du Game Engine,
la seconde d’un module de corps souples, la troi-
sième d’un simulateur de fluides spécifique, et la
dernière est un phénomène capable d’affecter
aussi bien particules que corps souples, le tout
sans avoir besoin de recourir à des extensions ou
des scripts externes.

COMPRENDRE   Théorie fondamentale 
des corps souples

Pour bien comprendre le fonctionnement d’un
corps souple et, plus tard, mieux interpréter les
paramètres permettant de régler la simulation, il
suffit de remplacer, mentalement, chaque arête de
votre maillage par un ressort et chaque point de
contrôle par une petite masse de plomb. Ainsi,
votre corps souple sera constitué d’une multitude
de ressorts, chacun présentant la même rigidité. Il
s’agit du paramètre E Stiff (rigidité de l’arête),
dans l’onglet Soft Body.

Figure 8–1
La scène de départ : prêts à passer à table ?



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 293

Ouvrez le fichier exercice-ch08.01-depart.blend du répertoire
/exercices du DVD-Rom. L’écran principal se divise en deux parties : à
gauche, une vue de face en mode fil de fer, et à droite, pour la visualisa-
tion de nos travaux, une vue depuis la caméra en mode ombré.

Normalement, la nappe est présélectionnée et l’on peut directement
visualiser, dans le menu Object (touche [F7]) les panneaux relatifs au Phy-
sics buttons. Repérez l’onglet Soft Body et cliquez sur le bouton Soft Body.

L’onglet Soft Body est actualisé immédiatement pour présenter une col-
lection de boutons qui peuvent paraître intimidants. Leurs fonctions
sont toutefois assez simples à saisir. Ces boutons sont regroupés en trois
blocs, de haut en bas : le premier permet de paramétrer les phénomènes
externes au corps souple.
• Mass : il s’agit de la masse du corps souple. Pour un vêtement ou un

textile, vous pouvez laisser à la valeur par défaut, égale à 1.000.
• Grav : il s’agit de la force de gravité qui s’exerce sur le corps souple ;

celui-ci peut alors être mis en mouvement si la valeur est non nulle.
Pour simuler la gravité terrestre, utilisez une valeur égale à 9.810.

• Speed : il s’agit d’un facteur de vitesse qui vous permet de corriger la
vitesse de déformation du corps souple, si celle-ci n’est pas conforme
à vos attentes. Pour démarrer, laissez la valeur initiale de 1.000, et
corrigez la valeur en fonction de vos besoins. Par exemple, 2.000 pour
doubler la vitesse, ou 0.500 pour la diminuer de moitié.

Le deuxième bloc de boutons permet de gérer les contraintes externes
appliquées au corps souple. Par exemple, notre nappe pourrait tenir par
un ou plusieurs coins, et il est assez simple de le simuler en utilisant
l’option Use Goal de ce bloc. Toutefois, nous verrons plus tard un
exemple d’utilisation de cette option. Dans l’immédiat, désactivez le
bouton Use Goal.

Le troisième bloc de boutons, enfin, est celui qui permet de gérer
l’essentiel du comportement du corps souple.
• Use Edges : en activant cette option, chaque arête du maillage est consi-

dérée comme un ressort, dont la rigidité est déterminée ci-après. Dans
notre cas, prenons garde à laisser ce bouton actif. Si nous le désacti-
vons, en cours de simulation, les arêtes pourront s’allonger à l’infini.

• Pull et Push : ces deux paramètres permettent de spécifier la raideur
des ressorts aux arêtes, lorsque leur longueur est respectivement plus
grande (Pull, force de rappel) ou plus courte (Push, force de poussée)
que celle au repos. En d’autres termes, il s’agit d’une indication de
l’effort fourni par le ressort de l’arête pour ramener celle-ci à sa lon-
gueur initiale. Des valeurs élevées induisent des systèmes très rigides
et très dynamiques. Essayez une valeur Pull 0.250 et une valeur

3DS MAX   Simulation de tissus

Dans 3ds max, il est fait usage d’assistants pour
définir les objets qui constitueront des obstacles, le
corps souple étant pour sa part défini sous forme
de modificateur. Dans Blender, tout se passe dans
les Physics buttons du menu Object,
touche [F7]. Les propriétés d’obstacle des objets
sont définies dans l’onglet Collision, tandis que
celles de corps souples sont activées et réglées
dans l’onglet Soft Body.

Le corps souple 
en tant que modificateur

Une fois créé, un effet de corps souple apparaît
automatiquement dans la liste des modificateurs
de l’objet : menu Editing (touche [F9]), onglet
Modifiers.
À ce titre, il profite des mêmes options que les
autres modificateurs, et peut être déplacé dans la
pile des modificateurs, activé ou non dans les vues
3D, activé ou non au moment du rendu, ou
appliqué de façon permanente et non plus comme
un modificateur.

Figure 8–2

BON À SAVOIR   Aérodynamisme

En activant le bouton N, vous prenez en compte,
pour les corps souples, un comportement aérody-
namique plus réaliste, le rendant plus sensible au
vent (field Wind) et permettant de le faire flotter
sous son influence. Commencez vos tests avec des
valeurs Aero de l’ordre de 30-50 environ.
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Push 0.650 pour avoir une nappe se déformant de façon assez satisfai-
sante. Des valeurs extrêmes induiront un comportement plutôt irréa-
liste avec des force de rappel ou de poussée chaotiques.

• Stiff Quads : activez ce bouton si vous constatez que le corps souple
s’écrase trop sur lui-même. L’effet produit aidera à maintenir la cohé-
sion de sa forme.

• Damp : permet de déterminer l’amortissement des ressorts. Plus la
valeur est faible, plus les arêtes oscilleront au cours de la simulation.
Au contraire, plus la valeur sera élevée, moins la longueur des arêtes
oscillera. Dans notre exercice, une valeur de 5.000 sera satisfaisante.

Le lancement de la simulation se fait grâce au bouton Bake de l’onglet
Collision ou lorsque vous utilisez la combinaison [Alt]+[A]. Les boutons
numériques Start et End déterminent les frames de départ et de fin de la
simulation de corps souple. Nous choisirons respectivement 1 et 40.

Il ne nous reste plus qu’à appuyer sur le bouton Bake et observer, dans la
vue ombrée, la nappe tomber sur notre cube et le traverser ! Appuyez sur
le bouton Free Bake pour rejeter cette solution.

En effet, aucune collision n’a été détectée. C’est parce qu’il faut définir le
cube de notre scène comme étant un obstacle. Sélectionnez-le (bouton
droit de la souris) et observez l’onglet Collision, toujours dans les Physics
buttons du menu Object (touche [F7]). Activez le bouton Collision, ne tou-
chez à aucun paramètre, et sélectionnez à nouveau notre nappe. Cliquez
sur Bake et observez la nappe tomber sur le cube et l’envelopper ! Vous
retrouverez, pour étude, le résultat de cette première partie de l’exemple
dans le fichier exercice-ch08.01-intermediaire.blend.

Figure 8–3
Le panneau Soft Body de notre nappe

Figure 8–4
Les paramètres de la simulation

ASTUCE   Gestion de l’autocollision

Les boutons CEdge et CFace permettent de véri-
fier, à chaque moment de la simulation, si les
arêtes et les facettes (respectivement) entrent en
collision. Si ces options sont idéales pour la simu-
lation de tissus ou de corps souples grâce à une
meilleure gestion des plis et des collisions, elles
sont malheureusement plus intensives en temps
de calcul et tendent à induire un « frissonnement »
quasi permanent − même en l’absence de
mouvements − qui ne peut être contré, pour
CEdge, que par le paramètre Damp.

COMPRENDRE   Simulation précalculée

Dans Blender on ne parle pas de créer la simula-
tion, mais de la calculer et de l’intégrer en tant
qu’élément précalculé de l’animation. Cela se fait
au travers du bouton Bake. Lorsque l’animation
sera jouée, le corps souple se déformera toujours
de la même façon, même si des éléments auront
été retirés ou ajoutés. Il faudra alors cliquer sur le
bouton Free Bake pour rejeter la simulation pré-
cédemment précalculée, et en relancer une nou-
velle, toujours grâce au bouton Bake.
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Au vu du résultat, il apparaît assez clairement que le simulateur de corps
souple a du mal avec les arêtes vives ! Nous allons essayer de voir com-
ment corriger ce problème. Une première méthode va consister à chan-
freiner le cube, de sorte qu’il ne présente plus d’arêtes aussi vives.
Sélectionnez le cube (bouton droit de la souris), entrez en mode Edit
(touche [Tab]), appuyez sur la touche [W] et, dans le menu flottant, choi-
sissez Bevel. Déplacez la souris dans la vue 3D, jusqu’à ce que le chan-
frein de la taille souhaitée apparaisse.

Figure 8–5
Le panneau Collision du cube

Figure 8–6
Une simulation imparfaite, 
mais encourageante

Figure 8–7
Le cube et ses arêtes chanfreinées
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Quittez le mode Edit et sélectionnez à nouveau la nappe en suspension,
cliquez sur Free Bake pour rejeter la simulation précédente, et cliquez à
nouveau sur Bake.

Non seulement le résultat n’est pas fondamentalement meilleur, mais en
plus vous ne souhaiterez pas toujours chanfreiner vos objets.

Figure 8–8
Le résultat est meilleur,

mais pas encore assez bon.

BON À SAVOIR   Les meilleurs maillages pour une bonne simulation

En règle générale, les formes progressives arrondies seront plus facilement recouvertes par
des corps souples, mais le seul moyen d’améliorer la qualité de la simulation consistera, mal-
heureusement, à subdiviser le maillage du corps souple de sorte que sa plus grande face soit
plus petite que la plus petite des faces de l’objet recouvert. Du point de vue temps de calcul,
cette approche (bien que correcte et rigoureuse) devient vite catastrophique !

Figure 8–9 Exemple avec un cube chanfreiné et une nappe très subdivisée !
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Heureusement, il y a au niveau de l’obstacle (le cube) des réglages qui
nous aideront à tricher : en n’y regardant pas de trop près, nous obtien-
drons le résultat visuel souhaité. Par exemple, augmentez le paramètre
Outer à 0.100.

Ce faisant, vous imposez à votre objet une surépaisseur virtuelle, qui va
aider le corps souple à l’envelopper proprement. Bien sûr, si vous
zoomez en mode fil de fer, vous apercevrez le corps souple flotter à 0.100
unités au-dessus du cube.

Mais le résultat est visuellement atteint, puisque avec notre angle de
caméra, ce décalage n’est pas observable. Vous pouvez jouer avec le fichier
final de cet exemple, qui se nomme exercice-ch08.01-final.blend et qui
se trouve dans le répertoire /exercices du DVD-Rom.

Figure 8–10
Le paramètre de déflexion Outer

Figure 8–11
Le corps souple 
ne repose pas 
sur le cube.

MÉTHODE   Le simulateur de corps souple : 
un outil de modélisation ?

Nous vous avons déjà fait remarquer que les corps
souples apparaissent dans la liste des modifica-
teurs sous le nom de Softbody. Si vous cliquez sur
le bouton Apply, la déformation est appliquée au
maillage de façon permanente. Il ne peut, dès lors,
plus être animé comme un corps souple, mais a sa
géométrie figée, comme si vous l’aviez modélisé
en l’état.

Figure 8–12
Notre nappe enfin posée !
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Fixer une partie du corps souple
Nous allons renforcer notre connaissance des corps souples en décou-
vrant une application possible des boutons Use Goal, grâce au Weight
Painting.

Qu’est-ce qu’un Goal ? Lorsque vous spécifiez un Goal, en particulier sur
un groupe de points de contrôle prédéfinis, c’est comme si vous les
clouiez sur place. Si la valeur Goal est égale à 1.0, l’objet se comportera
comme n’importe quel autre objet, sans effet de corps souple ; il est alors
normalement affecté par les courbes IPO, les modificateurs de déforma-
tion, les parents et autres. En revanche, si la valeur Goal est égale à 0.0,
l’objet n’est affecté que par les lois physiques du système de corps souple.

Le Goal permet aussi d’assurer la mémoire de forme. Il servira à vérifier
que l’objet ne se déformera pas trop, et représente en quelque sorte la
« mémoire de forme » de l’objet. Grâce au système de Weight Painting,
vous pouvez assigner des valeurs de Goal différentes pour les points de
contrôle de l’objet.

Figure 8–13
Notre scène de départ, déjà familière



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 299

Ouvrez le fichier exercice-ch08.02-depart.blend du répertoire
/exercices du DVD-Rom. Dans la vue 3D à gauche, passez en vue de
dessus (touche [7] du pavé numérique) et, avec la nappe sélectionnée,
cliquez sur le bouton Mode pour afficher les modes de représentation
possibles. Choisissez Weight Paint.

La nappe apparaît désormais en bleu uni, malgré que l’on soit en mode
fil de fer et que le matériau défini pour la nappe ne soit pas du tout bleu.
C’est parce que nous sommes entrés dans un menu spécial qui nous per-
mettra de pondérer les zones à déformer : les couleurs froides (le bleu
foncé étant à l’extrême) indiqueront les zones totalement libres d’être
déformées ; au contraire, les couleurs chaudes (le rouge étant à l’extrême)
indiqueront les zones qui ne se déformeront pas. Dans notre cas, nous
souhaitons que la nappe entière soit libre de bouger (bleu foncé, valeur
Weight 0.000) à l’exception de deux coins (rouge, valeur Weight 1.000)
qui pourraient être tendus par des mains. Nous allons donc essayer de
peindre notre nappe de façon à prendre en compte ces degrés de liberté.

Vous aurez noté, au passage, qu’en entrant dans le mode Weight Paint, le
curseur de la souris a changé de forme pour représenter un petit pinceau
et qu’un nouveau panneau, nommé Paint, a fait son apparition dans le
menu Editing (touche [F9]).

La valeur Weight est normalement déjà égale à 1.000. En revanche, Opa-
city est à 0.200. Réglez cette valeur à 1.000, directement avec le curseur
ou en cliquant sur le bouton intitulé 1, juste en dessous de ce paramètre.
Puis, avec le bouton gauche de la souris, peignez en rouge vif deux des
coins de la nappe. Le bouton X-Mirror permet de ne peindre qu’un seul
angle, et laissez Blender reproduire de façon symétrique les coups de
pinceau. Éventuellement, le bouton Wire peut être activé pour visualiser
le maillage en cours de peinture.

Figure 8–14
Choix du mode Weight Paint

Le mode Weight Paint

• Le curseur Weight permet de déterminer la couleur (ou chaleur) de la zone sous le
pinceau. Weight 0.000 correspond à la couleur la plus froide (le bleu foncé) et
Weight 1.000 à la couleur la plus chaude (le rouge vif). Vous noterez quelques
valeurs préréglées du curseur (il vous suffit de cliquer dessus pour régler le Weight à
la valeur indiquée) : 0, 1/4, 1/2, 3/4 et 1.

• Le curseur Opacity définit l’opacité de la « peinture » appliquée. Une valeur de
0.000 ne change pas la couleur du rideau tandis qu’une valeur de 1.000 applique
directement la couleur imposée par le curseur Weight. Toute valeur intermédiaire
permet de superposer la portion de Weight déterminée par l’Opacity à l’objet, selon
des règles prédéterminées (Mix, Add, Sub, Mul, Filter, Lighter, Darker). À noter
également des valeurs de curseur préréglées : 1/8, 1/4, 1/2, 3/4 et 1.

• Le curseur Size permet de définir la taille du pinceau utilisé.

Figure 8–15 Le panneau Paint
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Maintenant, l’ensemble de la nappe est sujette à déformation totale
(couleur bleue foncée) à l’exception deux coins (couleur rouge). Nous
pouvons maintenant nous intéresser à la simulation du corps souple à
proprement parler.

Revenez dans le mode Object Mode. Avec le bouton droit de la souris, sélec-
tionnez le cube sous la nappe. Allez ensuite dans le menu Object
(touche [F7]) puis dans le panneau Collision pour activer le bouton Collision.

Désormais, le cube est considéré comme un obstacle qui pourra stopper
la nappe au lieu de la laisser le traverser, comme un fantôme. Mais, pour
obtenir ce résultat, il nous reste encore à définir les propriétés de corps
souple de la nappe.

Sélectionnez la nappe et dans les Physics buttons du menu Object
(touche [F7]), activez le bouton Soft Body de l’onglet Soft Body. Dans le
premier bloc de boutons, spécifiez une valeur pour Grav de 9.810. Dans
le deuxième bloc, vérifiez que le bouton Use Goal est actif et choisissez
dans le menu déroulant le groupe de points de contrôle créé grâce au

Figure 8–16
La nappe en mode Weight Paint

ASTUCE  
Modifier le Weight par petites touches

Pour procéder progressivement (un peu comme si
vous peigniez à l’aérographe), il vous suffit de fixer
Weight à 0.000 (pour « refroidir » les couleurs)
ou à 1.000 (pour les « réchauffer ») et de jouer
sur la valeur Opacity. Vous pouvez également
activer l’option Spray pour augmenter progressi-
vement la valeur du Weight.

Figure 8–17
Le panneau Collision du cube



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 301

Weight Painting. Ces opérations sont incontournables pour prendre en
compte le Weight Painting réalisé précédemment. Spécifiez une valeur
G Stiff égale à 0.000 pour indiquer que la raideur globale de la nappe est
nulle. Dans le troisième bloc, vérifiez que Use Edges est actif et activez
l’option Stiff Quads ; changez les valeurs Pull à 0.250 et Push à 0.650. Spé-
cifiez également Damp 5.000 pour limiter les balancements de la nappe.

Affichez maintenant l’onglet Collision pour afficher les paramètres d’ani-
mation du corps souple. Spécifiez une simulation comprise entre les
frames 1 (Start) et 50 (End) et cliquez ensuite sur le bouton Bake pour
lancer la simulation et en enregistrer le résultat sur le disque.

Bien évidemment, la simulation est tout aussi imparfaite que précédem-
ment et requiert de chanfreiner le cube et de jouer sur son paramètre
Outer pour que tout soit parfait. Vous pouvez consulter le résultat final
dans le fichier exercice-ch08.02-final.blend du répertoire /exercices
du DVD-Rom.

Figure 8–18
Le panneau Soft Body

Les paramètres G Min et G Max

Ce sont deux paramètres qui permettent de
changer les bornes du Weight Painting en redé-
finissant la valeur de Goal des couleurs froides
(G Min, par défaut 0.000) et des couleurs
chaudes (G Max, par défaut 1.000). Par
exemple, avec G Min 0.400 et G Max 0.85,
la couleur la plus froide du Weight Painting sera
équivalente à un Goal de 0.40 et la couleur la
plus chaude à un Goal de 0.85. Aucun point du
corps souple n’est alors totalement inamovible,
mais aucun n’est non plus totalement soumis aux
lois de la physique.

Figure 8–19
Des mains invisibles maintiennent 
la nappe au-dessus du cube.
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Réglages du moteur de corps souple
Il est possible de régler individuellement, pour chaque corps souple, les
paramètres relatifs aux collisions dans l’onglet Collision. Les paramètres
proposés permettent de simuler l’autocollision des corps souples, ce qui
est idéal pour la simulation de vêtements ou de textiles, en permettant
d’obtenir des plis plus réalistes.

En activant le paramètre Self Collision, le solveur positionne à chaque
sommet une balle viscoélastique fictive qui permettra de prendre en
compte l’autocollision du corps souple, ce qui est particulièrement utile
pour la simulation de tissus ou de draps. Il est ainsi possible de spécifier
une dimension manuelle (option Man) au travers du paramètre Ball Size
ou de choisir un modèle de simulation parmi Av, Min, Max et AvMiMa
qui prenne en compte la longueur des arêtes/ressorts. L’option Min peut
contribuer à laisser passer un pli du corps souple au travers d’un autre,
tandis que Max se révèle plus fiable mais aussi plus long à calculer. B Stiff
détermine dans ce cadre la rigidité des balles viscoélastiques et B Damp
leur coefficient de frottement.

Il est également possible de régler les paramètres généraux de la simulation
de corps souple grâce à l’onglet Solver. Tout d’abord, il est possible de
choisir le solveur de la simulation : SOFT est la méthode à retenir, mais
RKCP produit des résultats plus conformes aux lois physiques ; il s’agit tou-
tefois d’une méthode bien plus difficile à paramétrer. Parmi les paramètres
disponibles, Error Lim est un critère de convergence (méthode Runge-
Kutta), des valeurs plus faibles que le défaut permettant une plus grande
précision de la simulation, au prix d’un temps de calcul supérieur. Si une
simulation ne paraît pas satisfaisante, il est possible d’imposer un nombre
minimal et maximal de pas de calcul pour chaque frame (MinS et MaxS).

En augmentant la valeur du paramètre Fuzzy, vous accélérez le calcul de
la simulation, mais au prix d’un calcul plus approximatif des collisions.
Au contraire, si les réactions du corps souple à la suite d’une collision
sont disproportionnées ou si le corps souple tend à passer à travers l’obs-
tacle au lieu de glisser sur lui, vous pouvez augmenter le paramètre Choke
pour améliorer la simulation.

ASTUCE   Correction de la simulation

Lorsque la simulation ne vous satisfait pas totale-
ment, vous pouvez activer l’option Bake Editing,
et vous positionner sur la frame dont le résultat
vous déplaît. Tout à fait normalement, passez en
mode Edit (touche [Tab]) et corrigez le maillage
du corps souple pour cet instant. Quittez le mode
Edit et appuyez sur le bouton Rebake From
Current Frame pour reprendre la simulation à
partir de la frame courante.

Figure 8–20
L’onglet Collision



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 303

Enfin, l’option Print Performance to Console permet d’afficher dans la
console de Blender quantité d’informations pertinentes quant à l’état de
la simulation. Notamment, le nombre d’étapes de calcul par frame est
précisé, de même que le temps moyen de calcul pour chacune d’elles.

La balle en mousse
L’animation physique est un domaine où l’on n’attend pas forcément le
simulateur de corps souple. Pourtant, grâce à la gravité et aux obstacles,
il est facile d’organiser une animation mettant en jeu une balle qui tombe
sur un plan incliné, puis frappe un obstacle avant de rouler au sol. C’est
ce type d’animation que nous allons maintenant, très simplement,
mettre en œuvre. Pour renforcer le lien avec le sujet des corps souples, la
balle sera en mousse, et se déformera à chaque impact.

Ouvrez le fichier exercice-ch08.03-depart.blend du répertoire
/exercices du DVD-Rom. Son écran principal est divisé en deux parties :
une vue de dessus en mode filaire, avec une sphère présélectionnée, à
gauche ; et une vue depuis la caméra, en mode ombré, sur la droite.

Figure 8–21
L’onglet Solver

Figure 8–22
Le parcours du combattant 
pour une balle en mousse
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Dans la vue de dessus, sélectionnez le plan incliné ; dans l’onglet Collision
des Physics buttons du menu Object (touche [F7]), activez le bouton Colli-
sion, mais ne touchez à aucun autre paramètre. Sélectionnez ensuite le
sol, puis la sphère qui fait obstacle, et à chaque fois, activez de la même
manière le bouton Collision.

Sélectionnez maintenant la balle en mousse. Dans l’onglet Soft Body,
activez le bouton Soft Body et réglez ses propriétés comme suit :
• Friction : 0.000 ; en raison de la dureté des surfaces et en considérant la

friction de l’air comme négligeable pour la simulation, on peut considérer
qu’aucun frottement ne viendra perturber les mouvements de la balle ;

• Mass : 0.010 (soit 10 g) est une valeur bien suffisante pour une balle
en mousse ;

• Grav : 9.810, comme dans les exercices précédents ;
• Speed : à vous de voir lors de vos simulations, mais une valeur de

2.000 semble donner le dynamisme souhaité pour ce genre de
simulation ;

• Use Goal : cette propriété est bien évidemment désactivée ;
• Use Edges et Stiff Quads : propriétés activées, pour que la géométrie de

la balle communique toute sa rigidité à la simulation ;
• Pull et Push : 0.65, afin d’avoir un matériau relativement élastique

répondant rapidement aux sollicitations externes (écrasement, etc.) ;
• Damp : 0.05 pour avoir un minimum de dissipation d’énergie au cœur

de la balle de mousse ; toute faible valeur peut également faire l’affaire ;
• Be : 0.65, pour que la balle ait une certaine rigidité et ne s’effondre

pas sur elle-même comme un ballon de baudruche dégonflé ;
• Sh : 0.65, car la mousse n’offre pas une grande résistance mécanique

au cisaillement.

Il ne nous reste maintenant plus qu’à configurer l’animation et lancer le
calcul de la simulation. Pour cela, affichez l’onglet Collision. Après quel-
ques tâtonnements, vous trouverez qu’un calcul entre la frame 1 (Start) et
la frame 60 (End) sera amplement suffisant (avec Speed égal à 2.000).
Cliquez alors sur le bouton Bake et observez, au fur et à mesure des cal-

BON À SAVOIR   Résistance des matériaux

Lorsqu’ils sont fortement étirés ou comprimés, les
matériaux sont généralement dégradés et subissent
des déformations permanentes dites « plastiques ».
De même, certains matériaux sont plus résistants à
certaines sollicitations que d’autres : par exemple,
plier une barre en fer pleine sera plus difficile que de
plier un tube creux de mêmes dimensions. Les ama-
teurs de simulations mécaniques apprécieront les
paramètres suivants qui facilitent la simulation de
caractéristiques mécaniques précises.
• Plas : plastic deformation suggère le taux

de déformation permanente.
• Be : bending stiffness suggère la rigidité en

flexion du corps souple.
• She : shearing stiffness suggère la résistance

au cisaillement du corps souple.

ASTUCE  L’option Stiff Quads

Parfois, un objet a tendance à s’écraser trop facile-
ment, en particulier sous l’effet de la gravité.
L’usage de l’option Stiff Quads permet d’ajouter
des ressorts supplémentaires virtuels sur la diago-
nale des faces quadrangulaires des maillages et
donc de les aider à conserver cette forme.

Figure 8–23
Les paramètres de corps souple

de la balle en mousse



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 305

culs, dans la vue depuis la caméra (en mode ombré), l’évolution de la
balle et de ses déformations. Comme d’habitude, vous pourrez directe-
ment passer aux conclusions et ouvrir le fichier exercice-ch08.03-
final.blend.

Les corps rigides
Le système d’animation des corps rigides s’appuie sur la physique pour
déterminer la trajectoire des objets, plutôt que sur des courbes IPO arti-
ficiellement imposées par l’utilisateur. C’est donc un système d’anima-
tion très réaliste, mais en même temps, un peu imprévisible.
Malheureusement, son usage n’est (pour l’instant) prévu que dans le
cadre du moteur de jeu en temps réel embarqué dans Blender. Toutefois,
Blender propose d’enregistrer, sous forme de courbes IPO, les déplace-
ment et rotations des objets impliqués dans la simulation de corps
rigides, et donc de recycler cette simulation de façon classique dans
Blender. Il est bien sûr alors possible d’éditer individuellement chaque
courbe IPO, et donc d’isoler un objet et de le contrôler plus précisément.

La démarche de la simulation de corps rigides fait appel à des notions
atypiques, car basées sur les mécanismes du moteur de jeu. Toutefois,
nous verrons rapidement les bases qui nous sont nécessaires pour la
mettre en œuvre dans des animations classiques.

Pourquoi utiliser l’option Bake ?

Vous pouvez très bien vous en passer, mais une
simulation qui l’a utilisée pourra être rejouée
beaucoup plus rapidement, n’étant plus simulée
en temps réel. De plus, si vous effectuez le rendu
de votre animation avec l’option Motion Blur (ou
Vector Blur) active, le résultat sera conforme à
vos attentes, ce qui ne sera pas le cas autrement.

Le bouton Apply Deformation

Grâce à ce bouton, Blender fige les déformations
éventuelles du corps souple (par exemple, Arma-
ture ou Lattice) avant d’y appliquer la simulation.

Figure 8–24
La balle chute seule, se déforme à l’impact, 
et rebondit grâce au système de simulation 
des corps souples.
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Ouvrez le fichier exercice-ch08.04-depart.blend du répertoire
/exercices du DVD-Rom. La scène vous est certainement familière,

MÉTHODE   Choisir entre corps souples et corps rigides

Ces deux systèmes d’animation peuvent tenir compte de la masse, de la
gravité et des collisions avec l’environnement, pour déterminer les mou-
vements des objets concernés. Toutefois, chacun présente des spécifi-
cités qui les réserveront à un usage plutôt qu’à un autre.
Le système de corps souples tient bien évidemment compte de la défor-
mation des objets impliqués. La géométrie de chaque corps souple étant
réévaluée à chaque instant, les calculs sont relativement lourds et longs.
Il est possible de faire interagir plusieurs corps souples entre eux, mais
au prix de temps de calcul d’autant plus longs. En revanche, les corps
souples ne sont pas pris en compte dans les simulations fluides.
Pour sa part, le système de corps rigides ne tient pas (par définition)
compte de la déformation des objets. Il excelle en revanche dans l’ani-
mation de nombreux corps rigides, lâchés en même temps dans une
simulation. Le calcul de l’animation est relativement rapide (le moteur
est prévu pour du temps réel) pour peu que le nombre de facettes ne
soit pas trop important. L’avantage est que les simulations fluides sont
capables de tenir compte du résultat d’une simulation de corps rigides,
mais a posteriori (pas en temps réel).
Enfin, les animations suivant ces trois systèmes de simulation (corps sou-
ples, corps rigides, fluides) ne sont malheureusement pas calculées lors
de la même passe, mais individuellement, chacun avec son propre sys-
tème de simulation. Si elles sont limitées par leur nature, les interactions
sont toutefois possibles, avec un peu d’inventivité.

Figure 8–25
Un terrain d’expérimentations

identique au précédent
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puisqu’il s’agit de la même que celle illustrant le système de corps sou-
ples. L’écran principal est séparé en deux parties : à gauche, l’éditeur de
courbes IPO (pour l’instant vide), et à droite, une vue de la scène depuis
la caméra, en mode fil de fer. La balle est sélectionnée.

Commençons par spécifier à Blender le système de simulation physique
que nous allons employer. Dans les World buttons du menu Shading
(touche [F5]), repérez l’onglet Mist/Stars/Physics. Par défaut, le système
employé doit être le Bullet, vérifiez que ce soit bien le cas. Sinon,
changez-le de Sumo à Bullet en cliquant simplement sur le menu dérou-
lant. Notez la présence d’un bouton Grav (valeur par défaut 9.80, qui
nous convient parfaitement), qui nous permet de déterminer la gravité
du système de simulation.

Dans le menu Logic (touche [F4]), activez le bouton Actor, indiquant que
le moteur de jeu va s’intéresser à l’objet sélectionné en particulier. Deux
nouveaux boutons apparaissent. Activez Dynamic pour indiquer que cet
objet devra être mis en mouvement par le moteur. Pour ce faire, tout un
bloc de nouveaux boutons est présenté à son tour. Nous ne chercherons
pas à produire une animation très sophistiquée, et nous laisserons donc
la plupart des paramètres à leur valeur par défaut. Activez toutefois les
boutons Rigid Body (c’est après tout le type d’animation que nous souhai-
tons pratiquer) et Bounds.

Cette méthode Bounds conditionne l’algorithme de détection des colli-
sions du système. Par défaut, grâce à la valeur Box, il prend en compte la
boîte minimale englobant l’objet animé, quelle que soit sa forme. Une
collision est décrétée lorsqu’un quelconque objet de la scène cherche à
pénétrer cette limite. Bien sûr, Box n’est peut-être pas le type de frontière
le plus adapté à la forme de votre objet animé, peut-être très complexe.
C’est pourquoi le système propose plusieurs types de primitives : Box,
Sphere, Cylinder, Cone, Convex Hull Polytope, Static triangle Mesh.

Figure 8–26
Les paramètres de la simulation 
dans l’onglet Physics

Figure 8–27
Les paramètres logiques de la balle à animer

Sumo contre Bullet

Ce sont deux systèmes de simulation physique
développés pour le moteur de jeu de Blender. Le sys-
tème le plus ancien est Sumo ; il intègre parfaite-
ment toutes les briques logiques nécessaires à la
création d’un jeu. Du point de vue de la détection de
collision, la frontière (Bound) de type Sphere est
la seule à fonctionner admirablement, ce qui limite
son utilisation pour des animations réalistes.
Le système Bullet est, pour sa part, en cours de
développement. De par sa jeunesse, il est moins
complet que son prédécesseur au niveau des bri-
ques logiques, mais offre une détection de colli-
sion supérieure avec les autres types de frontières. 
À moins d’être intéressé par la création de jeux
vidéos avec Blender, concentrez-vous sur le sys-
tème Bullet, le plus proche de nos besoins
d’apprentis animateurs.
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Bounds détermine l’espace inviolable de l’objet. Si un autre objet de la
scène doit pénétrer celui-ci, il y a collision, et le moteur de simulation
réagit, en fonction du mouvement initial, pour empêcher les objets de
pénétrer l’un à l’intérieur de l’autre. Il y a plusieurs formes de frontières,
mais l’une d’elles est tout indiquée en raison de la forme de notre balle :
Sphere ! Dans la vue 3D, si vous zoomez sur la balle, vous remarquerez
une sphère dont l’intérieur est dessiné en pointillés. Il s’agit de la fron-
tière « physique » et il faut essayer de l’ajuster au plus près des dimen-
sions de notre balle. Cela se fait grâce au bouton numérique Radius ;
essayez différentes valeurs, mais nous estimons qu’une valeur de 1.400
est suffisamment correcte dans notre cas.

Dans le menu Game de la barre de menus principale, tout en haut de
l’écran, activez l’option Record Game Physics to IPO. Cela aura pour effet
(et c’est là tout l’intérêt de ce chapitre) d’enregistrer tous les mouve-
ments (déplacements et rotations incluses) de notre balle dans des
courbes IPO liées aux paramètres appropriés (LocX à LocZ et RotX à RotZ).

Les courbes ne seront toutefois pas enregistrées à l’infini, mais unique-
ment sur la plage d’animation spécifiée dans le panneau Anim des Render
buttons du menu Scene (touche [F10]). Par défaut, ce sera donc enregistré
entre les frames 1 (Start) et 250 (End).

Mais il nous reste encore à lancer le « jeu » et donc le système de simula-
tion physique. Pour cela, vous pouvez, soit passer par le menu Game de la
barre de menus principale (en choisissant Start Game), soit presser la

OUPS !   Mauvaise détection des collisions

En raison d’un bogue connu de la version 2.40 de
Blender, vos objets entrant en collision peuvent
réagir de façon très brusque et totalement inat-
tendue. Si vous rencontrez ce problème, sélec-
tionnez un à un les objets devant entrer en
collision, et utilisez la combinaison de touches
[Alt]+[R] pour réinitialiser leur rotation (Clear
Rotation). Utilisez ensuite la combinaison de tou-
ches [Ctrl]+[A] pour appliquer les échelles et les
rotations, (Apply Scale and Rotation), puis
repositionnez les objets à la main. Ils sont enfin
prêts à être animés !

Figure 8–28
Activation de l’enregistrement

de l’animation du jeu dans des courbes IPO

Figure 8–29
Plage d’enregistrement dans les courbes IPO
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touche [P] avec le curseur de la souris, dans la vue de votre choix (de pré-
férence, celle affichant la vue depuis la caméra). Attendez patiemment
que la boule descende, rebondisse et finalement tombe hors du champ
de vision de la caméra, puis pressez la touche [Echap] pour mettre fin au
jeu. Immédiatement après la fin de la simulation, l’éditeur de courbes
IPO se met automatiquement à jour pour révéler les courbes IPO enre-
gistrées, pour l’objet balle, au cours de la simulation.

Il apparaît vite comme évident que la mise en place de telles courbes,
manuellement, dans le cadre d’une animation conventionnelle, aurait été
particulièrement délicate.

Les images qui suivent présentent quelques moments choisis de l’anima-
tion finalement obtenue, sans trop d’efforts de notre part ! Certes, la
démarche consistant à faire appel au moteur de jeu pour animer une
balle tombant dans notre scène n’est pas forcément la plus logique ; elle
n’est possible que depuis récemment dans Blender, et il n’est pas exclu,
dans le futur, qu’une animation conventionnelle, qui tienne compte des
lois de la physique, puisse être menée directement.

Figure 8–30
Les courbes IPO de la sphère, telles 
que construites par le simulateur physique

MÉTHODE   Animation trop longue à jouer !

Cela peut arriver très rapidement si vous utilisez
des modèles présentant un trop gros nombre de
points de contrôle. Pour jouer l’animation
(touche [P]) le plus vite possible :
• Préférez le mode fil de fer au mode ombré.
• Mettez les objets de la scène n’intervenant pas

dans l’animation (en particulier, ceux n’entrant
jamais en collision avec les objets animés) sur
un calque différent, que vous n’affichez pas.

• Choisissez la forme de la frontière Bounds pour
qu’elle corresponde au mieux à celle de l’objet
animé, tout en étant la plus simple possible.

Si vous avez besoin de contrôler la qualité des col-
lisions, par exemple, vérifiez votre animation en
vue de caméra en mode ombré en appuyant sur la
combinaison de touches [Alt]+[A].
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La simulation de fluides
Un autre domaine d’animation pour lequel Blender est doté d’un sys-
tème de simulation avancé est celui des fluides. Son usage n’est guère
plus compliqué que les autres, mais fait appel à des notions sensiblement
différentes, en particulier celle de « domaine ».

Du point de vue du simulateur, trois types d’objets sont pris en
considération :
• le domaine de calcul ;
• les obstacles ;
• les objets fluides.

Le domaine de calcul permet de circonscrire une zone physique pour
laquelle les calculs seront effectués. C’est par ailleurs dans les paramètres
du domaine que seront définies les propriétés des fluides simulés : la
résolution du fluide, sa viscosité, et la durée de la simulation.

Les obstacles sont des objets situés dans le domaine. Le système détec-
tera les éventuelles collisions entre les fluides en mouvement et les obsta-
cles, de sorte que les fluides pourront les contourner ou ruisseler sur eux.

Les objets fluides peuvent être de nature plus variée, et correspondre à
des volumes de liquide existants, à une source de liquide, ou enfin à une
évacuation de liquide.

Figure 8–31
Quelques images de l’animation

résultante de corps rigides
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Les principaux objets fluides : Fluid, Inflow, Outflow
• Fluid correspond à un volume de liquide existant au démarrage de la

simulation ; il peut s’agir d’une flaque, d’une simple goutte ou d’un
volume quelconque de liquide.

• Inflow est une « source » entrante de fluide (entrante dans le sens de
prise en compte dans la simulation) ; l’objet qui fait office d’Inflow est
généralement placé dans un robinet, à la naissance d’une cascade, ou
autre. Son débit est régulier et continu, depuis le début de la simula-
tion jusqu’à sa fin.

• Outflow est une « source » sortante de fluide (sortante dans le sens où
le fluide traversant cet objet disparaîtra purement et simplement de la
simulation) ; il s’agit généralement d’un siphon d’évier, d’un égout ou
de tout autre type de canalisation d’évacuation. Utilisé en conjonction
avec un Inflow, l’Outflow garantit qu’il n’y ait pas d’inondation indési-
rable lors de votre animation.

Nous ferons connaissance avec ces systèmes de simulation grâce à deux
exemples simples.

Exemple 1 : chute d’une goutte d’eau
Dans cet exemple, nous allons tout simplement travailler sur la base d’un
faible volume de liquide chutant dans un plus gros volume de fluide.
Cela va nous permettre de nous familiariser avec les options les plus cou-
rantes du simulateur de fluide.

Ouvrez le fichier exercice-ch08.05-depart.blend. Ce fichier ne propose
qu’une vue unique, depuis la caméra et en mode fil de fer. Nous avons mis
en place, à votre disposition, une icosphère (OB: Goutte) qui sera notre
« goutte » d’eau en chute libre ; une boîte (OB: Flaque) qui représente le
volume d’eau déjà existant au démarrage de la simulation ; une boîte
(OB: Domaine) de plus grande dimension et englobant les autres objets, qui
servira de domaine de calcul et donnera au liquide ses propriétés.

Figure 8–32
Notre scène avant lancement de la simulation
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Allez dans le menu Object (touche [F7]) et appelez les Physics buttons en
cliquant sur l’icône appropriée : repérez le panneau Fluid. Normalement,
la goutte est sélectionnée (si ce n’est pas le cas, un clic avec le bouton
droit de la souris sur la goutte devrait y remédier). Il ne vous reste plus
qu’à cliquer sur le bouton Enable pour inclure cet objet dans la simulation
de fluides. De nouveaux boutons apparaissent, vous demandant le rôle
que devra jouer l’objet dans la simulation : choisissez Fluid, car nous sou-
haitons considérer cette objet comme une goutte, soit un volume défini
d’eau. De nouveaux boutons numériques apparaissent pour vous per-
mettre de régler la vélocité de l’objet au début de l’animation ; nous
pourrions souhaiter que la goutte tombe verticalement, mais nous allons
lui donner une légère vitesse en diagonale, pour simuler une grosse
goutte de pluie tombant dans une flaque : X 0.10, Y -0.10, et Z -2.00.

Sélectionnez (bouton droit de la souris) la future flaque (la plus petite
boîte) et, comme précédemment, cliquez sur Enable pour l’inclure dans
la simulation. Choisissez également Fluid, comme type d’objet, mais ne
lui donnez aucune vélocité initiale : X 0.00, Y 0.00, et Z 0.00.

Sélectionnez maintenant le domaine de calcul (la plus grande boîte) et
cliquez sur Enable pour l’inclure dans la simulation. Cette fois, en
revanche, choisissez Domain comme type d’objet. Nous allons conserver
la résolution par défaut : Resolution 50. Blender nous informe que la
simulation, avec cette résolution, va nécessiter environ 15 Mo de
mémoire, ce qui devrait être largement accessible à n’importe quel ordi-
nateur moderne.

Nous ne changerons pas non plus les qualités d’affichage dans la vue 3D
(Preview) et lors du rendu (Final), car elles conviennent parfaitement à
nos besoins. Le dernier champ, tout en bas du panneau, concerne le
répertoire dans lequel seront stockés, frame par frame, les fichiers de
l’animation, contenant la géométrie du fluide à un instant donné. Par
défaut, Blender vous propose un répertoire pour y stocker le résultat de
ses calculs.

Figure 8–33
Les paramètres de la goutte

Intégration des simulations 
de fluides dans les IPO

Trois paramètres apparaissent dans la liste des IPO
disponibles lorsqu’un domaine est sélectionné :
Viscosity, Time et Gravity. Le paramètre Time
a un fonctionnement particulier : à une valeur
égale à 1.000, il n’a aucune influence sur la
simulation. Des valeurs inférieures ralentissent la
simulation, tandis que des valeurs supérieures
l’accélèrent. Le paramètre d’IPO Viscosity est
également un facteur agissant selon le même
principe : une valeur égale à 1.000 ne change
pas la viscosité du liquide.

Figure 8–34
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Particules fluides

Le moteur de simulation fluide génère des particules fluides en même
temps que le maillage du liquide en lui-même, ce qui permet de simuler
assez facilement de l’écume ou de petites éclaboussures. La procédure
est atypique mais simple.
• Pour l’objet Domain, déterminez le nombre de traceurs (des particules

qui vont suivre le flux du liquide) grâce au paramètre Tracer Particles
du panneau Bn (pour Boundary). Plus cette valeur sera élevée, plus un
grand nombre de particules feront leur apparition.

• Créez ensuite un objet quelconque, donnez-lui un matériau appro-
prié à l’effet recherché, puis activez (Enable) les particules pour cet
objet dans les Physic buttons. Vous ne chercherez pas à paramétrer ces
particules, car le simulateur le fera à votre place et leur attribuera le
matériau déterminé.

• Intégrez cet objet à la simulation fluide et sélectionnez Particle
comme type de fluide (Size Influence et Alpha Influence à 1.000) ; sélec-
tionnez le répertoire dans lequel seront stockées les particules fluides
(de préférence le même que celui dans lequel sera stocké le résultat
de la simulation).

• Il ne vous reste plus qu’à appuyer sur le bouton BAKE.
• Le simulateur de fluide s’occupe alors de tout le reste, de sorte que

vous n’avez pas à vous soucier ni de l’objet ni des particules émises.
Les particules peuvent être des traceurs (Tracer), mais aussi des goutte-
lettes (Drops) ou de l’écume (Floats).

Figure 8–35 Exemple de particules fluides en action au cours d'une simple simulation

Figure 8–36
Les paramètres de base du domaine de calcul
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Cliquez en revanche sur le bouton Ad (pour Advanced), afin d’explorer les
propriétés avancées du fluide simulé. Vérifiez simplement que la gravité
est bien celle que nous attendons : Gravity: X 0.00, Y 0.00 et Z -9.81. Le
menu déroulant permet de choisir entre différents types de liquides
prédéfinis ; l’eau (Water) est le liquide qui nous convient, ne le changez
pas. Enfin, Realworld-size indique la taille « réelle », en mètre, de la plus
grande dimension du domaine. S’agissant de faire tomber une goutte d’eau
dans une flaque, notre domaine ne doit pas faire beaucoup plus de 15 cm.
Modifiez donc cette valeur pour notre animation : Realworld-size 0.015.

Vous pouvez maintenant appuyer sur le bouton BAKE pour lancer le
calcul de la simulation. La simulation est désormais lancée, et il ne vous
reste plus qu’à patienter. À noter que nous n’avons pas changé (dans
l’onglet Anim des Render buttons dans le menu Scene, touche [F10]) la
longueur de l’animation qui débute toujours à la frame 1 (Start) et se ter-
mine à la frame 250 (End).

Vous constaterez que le domaine a disparu (il a été remplacé par le
résultat de la simulation), mais que les objets de type Fluid ont été
conservés ; comme ils peuvent gêner la prévisualisation, sélectionnez-les
(bouton droit de la souris) et supprimez-les (touche [X]), ou envoyez-les
sur un autre calque (touche [M] et cliquez sur l’un des carrés symbolisant
les calques disponibles). Vous pouvez maintenant sélectionner à nouveau
le fluide résultant, et lui donner des propriétés matériaux correspondant
au fluide simulé.

Utilisez la combinaison de touches [Alt]+[A] pour jouer la prévisualisa-
tion de l’animation dans la vue 3D ; vous constaterez que, en raison de
l’importante vélocité initiale de la goutte, l’impact de celle-ci dans notre
flaque est important. Cette impression est également renforcée par
l’effet d’échelle, puisque nous avons indiqué à notre domaine que sa
dimension « réelle » était de 15 cm sur sa plus grande dimension. Vous

Figure 8–37
Les paramètres avancés du domaine de calcul

Figure 8–38
La barre d’avancement de la simulation

Les fluides et les isosurfaces

Les maillages fluides peuvent se voir appliquer une
subdivision isosurfacique grâce au paramètre Sur-
face Subdiv dans le panneau Bn du Domain. Le
paramétrage est analogue à celui du modificateur
Subsurf appliqué au maillage fluide, à ceci près
que cette méthode de subdivision permet d’inté-
grer les particules fluides sous forme de géométrie
réelle dans la simulation.
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souhaiterez peut-être recommencer la simulation avec d’autres paramè-
tres, mais pensez à d’abord consulter la section Recommencer la simula-
tion, dans ce même chapitre.

Exemple 2 : flux d’eau continu
Cet exemple, plus complet mais pas plus complexe, va nous permettre de
mettre en œuvre les objets fluides de type Inflow et Outflow (représentés res-
pectivement par une source d’eau et une évacuation), ainsi qu’un obstacle.

Ouvrez le fichier exercice-ch08.06-depart.blend. Comme précédem-
ment, ce fichier propose une vue unique, depuis la caméra et en mode fil
de fer. La source du flux continu est un cylindre (OB: Source) qui est
présélectionné. L’évacuation est matérialisée par un autre cylindre, de
même dimension (OB: Evacuation), ce qui garantit le maintien d’un

Figure 8–39
Quelques images de la simulation

LE SAVIEZ-VOUS ?   Obstacles mobiles

Le simulateur de fluides permet la prise en compte
des obstacles animés. Il est donc possible de
simuler des objets solides chutant dans des masses
fluides, ou se déplaçant à travers celles-ci. Pour de
meilleures performances, il est préférable que l’obs-
tacle soit animé à l’aide de courbes IPO, mais il est
également possible d’animer vos obstacles grâce à
des armatures ou à des relations de parenté.
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volume constant de liquide à l’intérieur du domaine. Un plan incliné ser-
vira d’obstacle à notre expérimentation (OB: Obstacle), tandis qu’une
petite boîte (OB: Flaque) nous servira de réserve d’eau. Enfin, une boîte
(OB: Domaine) de plus grande dimension et englobant les autres objets,
servira de domaine de calcul et donnera au liquide ses propriétés.

Allez dans le menu Object (touche [F7]), appelez les Physics buttons en
cliquant sur l’icône appropriée et placez-vous immédiatement dans le
panneau Fluid. Pour raccourcir cet exercice, définissez les propriétés
fluides du domaine et de la flaque exactement comme dans l’exemple
précédent ; reportez-vous à la procédure décrite, si vous en éprouvez la
nécessité. Sélectionnez ensuite la source (OB: Source) et cliquez sur le
bouton Enable pour inclure cet objet dans la simulation. Choisissez
Inflow comme type d’objet, et réglez la vélocité initiale de sorte à ce que
la source émette son flux de façon verticale et modérément puissante :
X 0.00, Y 0.00, et Z -0.25.

Sélectionnez maintenant le cylindre d’évacuation (OB: Evacuation) et
cliquez sur le bouton Enable pour l’inclure dans la simulation. Choisissez
Outflow ; aucun autre réglage n’est disponible. Enfin, sélectionnez le plan
incliné (OB: Obstacle) et incluez-le à son tour dans la simulation en cli-
quant sur le bouton Enable ; parmi les boutons qui apparaissent, choi-
sissez Obstacle. Comme précédemment, aucun réglage supplémentaire
n’est proposé.

Sélectionnez à nouveau le domaine, et cliquez sur le bouton BAKE pour
lancer la simulation. Une fois le calcul terminé, supprimez (touche [X]) ou
déplacez sur un autre calque (touche [M]) les cylindres et la boîte de la
flaque, pour ne conserver que le domaine (le fluide résultant) et l’obstacle.
La combinaison de touches [Alt]+[A] dans la vue 3D permet alors de visua-

Figure 8–40
Expérimentation des différents

types d’objets fluides

APPROFONDIR   Différents types d’obstacles

Les obstacles peuvent désormais avoir trois com-
portements différents.
• No Slip : il s’agit de l’option par défaut, et de

la seule option possible pour les obstacles mou-
vants. À leur contact, les fluides ont des
vitesses normale et tangentielle nulles (corres-
pondant à des fluides « gluants »).

• Free : cette option n’est possible que pour les
obstacles immobiles. À leur contact, les fluides
ont une vitesse normale nulle (correspondant à
des liquides parfaitement fluides).

• Part : cette option permet de spécifier, pour les
obstacles immobiles, un comportement mixte
entre Free et No Slip, la proportion étant déte-
minée par le bouton numérique PartSlip
Amount.

Les parois du domaine, étant après tout des obsta-
cles, peuvent également adopter ces options, pro-
pres aux obstacles.
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liser l’animation. Comme précédemment, pour effectuer le rendu, vous
pouvez sélectionner le fluide et lui adjoindre un matériau approprié.

Vous noterez, lors de la visualisation, que dans l’angle le plus à gauche,
l’évacuation joue parfaitement son rôle, et que le niveau de fluide
diminue brusquement, jusqu’à être compensé par le fluide coulant de la
source. Au niveau de l’obstacle, le liquide se répand assez naturellement,
en coulant et en débordant à la fois. Vous noterez enfin la taille impor-
tante des gouttes, due à deux facteurs : la faible Resolution du domaine
d’une part, et la toute petite échelle de la scène, d’autre part, spécifiée par
le Realworld-size.

APPROFONDIR  Obstacles en mouvement

Le système de simulation des fluides prend en
compte des obstacles mobiles. Cela veut dire que
vous pouvez utiliser des courbes IPO pour déplacer
un obstacle sous un jet d’eau, ou laisser tomber un
obstacle dans une flaque de liquide. Dans les deux
cas, le simulateur tient compte de l’objet mobile,
s’il a correctement été déclaré comme un obstacle.
Si l’obstacle est un maillage animé (par des arma-
tures, par exemple, ou au moyen d’une relation
parent-enfant), activez le bouton Animated
Mesh : Export. Le calcul de la simulation sera
toutefois malheureusement allongé.

Figure 8–41

Figure 8–42
Quelques images de la simulation
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Quelques conseils méthodologiques

Plusieurs objets fluides et obstacles ?
Vous pouvez mettre en œuvre, dans votre simulation de fluides, autant
d’objets fluides et d’obstacles que souhaité. Les seules conditions sont
que ces objets ne doivent pas se chevaucher ou s’intercepter, et qu’ils doi-
vent tous être à l’intérieur du domaine pour être pris en considération.

Résolution et mémoire
Le domaine est découpé, dans sa plus grande dimension, en petits cubes
élémentaires dont le nombre est égal à la valeur de la résolution. Il en
résulte qu’il est facile d’associer une quantité de mémoire « consommée »
par la simulation, en fonction de la résolution spécifiée. Au-dessus du
bouton Resolution, Blender affiche à chaque fois la mémoire nécessaire à
la simulation. Si vous voulez éviter que votre ordinateur passe son temps
à faire des accès disque (swapping), consacrez toujours à la simulation
moins de mémoire que la quantité de mémoire physique dont dispose
votre ordinateur. Une fois la simulation passée, cela n’a plus trop
d’importance, puisqu’elle aura été convertie en géométrie dans des
fichiers distincts, que Blender réutilisera au moment des rendus.

Viscosité et taille réelle du domaine
La viscosité du liquide est critique pour déterminer sa facilité à « couler »
dans votre simulation. En cliquant sur le bouton Advanced, vous accédez
aux réglages physiques du simulateur ; ici, tout est préréglé pour l’artiste qui
n’a pas de culture technique. En particulier, vous choisissez la viscosité de
votre fluide dans un menu déroulant, l’eau (Water) étant le choix par défaut ;
les options disponibles sont l’huile (Oil) et le miel (Honey). La valeur de vis-
cosité de chaque option apparaît à côté de son nom, et l’option Manual vous
permet même de spécifier une viscosité totalement personnalisée.

À noter également le bouton numérique Realworld-size, qui permet de
définir la taille du plus grand côté du domaine, ce qui influera, bien évi-
demment, sur le réalisme de la simulation.

Recommencer la simulation
Par défaut, votre simulation est programmée de la frame Start 1 à la frame
End 250. Si vous recommencez la simulation en changeant un paramètre,
lors de l’opération de baking, tout semblera conforme à vos aspirations.
Mais, lorsque vous rejouerez votre animation grâce à la combinaison de
touches [Alt]+[A], seule la première simulation sera prise en compte.

Figure 8–43
Mémoire requise par la simulation

Figure 8–44 Les options Advanced 
de l’onglet Fluid Simulation
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Pour y remédier, deux options :
• supprimez le contenu du répertoire où Blender stocke les

simulations ; c’est la seule façon de vraiment remettre à zéro la
simulation ;

• réglez le début et la fin de l’animation sur d’autres frames, par
exemple Start 251 à End 500 ; l’avantage est que la première simula-
tion est toujours inscrite sur le disque, et que vous pouvez y revenir si
nécessaire.

D’autres méthodes plus « propres » verront peut-être le jour prochaine-
ment, en fonction de l’inventivité des utilisateurs ou des futurs dévelop-
pements de Blender.

Mes objets sont hermétiques !
Vous venez de modéliser une jolie coupe, un superbe verre, ou vous sou-
haitez remplir la carafe du chapitre 3 ? Mais lorsque le liquide se déverse
dans votre objet, il semble rebondir sur une surface virtuelle, alors que votre
récipient est bien ouvert ! Ou alors, le flux ne suit pas exactement les parois.

C’est peut-être que les normales de votre récipient ne sont pas toutes
orientées dans le même sens : en mode Edit (touche [Tab]) la combi-
naison de touches [Ctrl]+[N] devrait résoudre le problème. Vous avez
peut-être également des points superposés, surtout si vous avez utilisé la
fonction Spin pour créer votre récipient : toujours en mode Edit
(touche [Tab]), le bouton Rem Double du panneau Mesh Tools du menu
Editing (touche [F9]) permet de supprimer les points en double.

Éventuellement, votre récipient est peut-être sous le coup d’un modifi-
cateur de type Subsurf. Appliquer le modificateur grâce au bouton Apply
peut alors être une bonne idée, sinon le fluide suivra les contours de la
forme non modifiée !

Attention, malgré ces astuces, certaines géométries pourraient continuer à
causer problème. Il faut alors trouver de nouvelles astuces, ou une révision
du simulateur pour des performances supérieures en matière de collisions.

L’animation squelettale
Que vous soyez intéressé par les animations, ou que votre souhait soit
simplement de réaliser de belles images fixes, il est peu probable que
vous puissiez passer à côté de la mise en place de squelettes pour certains
sujets de vos images, comme les personnages ou les animaux. En effet,
modéliser un personnage directement dans sa pose finale est un exercice
extrêmement difficile, et il est souvent plus aisé de modéliser celui-ci

3DS MAX   Bipèdes

Depuis l’intégration de Character Studio en stan-
dard avec 3ds max, la création de hiérarchies de
squelettes bipèdes est très simple et permet de créer
des mouvements en fonction de la gravité, de
l’équilibre, et d’autres facteurs. Malheureusement,
Blender n’offre rien de comparable à ce jour, et il est
nécessaire d’animer les personnages soi-même.
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dans une pose « neutre », de lui donner une armature (un squelette), et
de le « poser » a posteriori. Bien sûr, une fois que l’on a un personnage
prêt à poser, on a parcouru plus de la moitié du chemin pour l’animer.

Création d’une armature
Dans un premier temps, nous allons apprendre à créer une armature (ou
squelette) à un sujet quelconque. Ouvrez le fichier nommé exercice-
ch08.07-depart.blend du répertoire /exercices du DVD-Rom d’accom-
pagnement. Vous trouverez là un sujet primitif, une sorte d’étoile de mer à
quatre branches.

Le curseur est au milieu de la scène, au centre du sujet. Ajoutez une arma-
ture, soit en utilisant la touche [Espace] puis en choisissant Add et Arma-
ture, soit en passant par la barre de menus principale, Add puis Armature.
Un premier « os » (bone en anglais) est apparu à partir du curseur. Entrons
dans le mode Edit grâce à la touche [Tab]. L’os a une longueur égale à une
unité de Blender, et son extrémité est jaune, indiquant qu’elle est sélec-
tionnée. Nous allons ajouter d’autres os à celui-ci ; l’extrémité étant sélec-
tionnée, appuyez sur la touche [E] pour extruder un nouvel os à partir du
précédent. Le nouvel os apparaît en jaune, et vous pouvez le dimensionner

Figure 8–45
FlamencoBot, © 2005 par Robert J. Tiess :

http://www.artofinterpretation.com/
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à la souris, de sorte qu’il fasse à peu près 3 unités de Blender (en mainte-
nant pressée la touche [Ctrl] pendant cette opération, l’os s’allonge auto-
matiquement par unités entières de Blender). Appuyez sur la touche
[Entrée] ou utilisez le bouton gauche de la souris pour valider le nouvel os.
Répétez une nouvelle fois cette opération pour créer le troisième os. En
appuyant sur la touche [Tab], vous quittez le mode d’édition de l’armature,
et vous pouvez aisément visualiser celle-ci.

Appuyez sur la touche [F9] pour passer dans le menu Editing, si d’aven-
ture vous n’y êtes plus (ce doit être le cas à l’ouverture du fichier
d’exemple). Vous devriez observer la présence de deux panneaux. Le
premier, Link and Materials, est vierge à l’exception de deux champs, AR:
et OB:, portant tous les deux le nom Armature. Le champ AR: est le nom
du bloc de données correspondant à cette armature, et OB: le nom de
l’armature en tant qu’objet Blender. Les deux s’appellent Armature, et
c’est là le détail qui va nous intéresser.

Dans le second panneau, Armature, se trouvent des options d’édition,
d’affichage et de déformation de l’armature. Nous y reviendrons très
prochainement, mais vous pouvez déjà activer l’option X-Ray (dans la vue
ombrée, les os deviennent visibles par transparence) et l’option Names
(dans les deux vues, les noms individuels de chaque os deviennent visi-
bles). Pour l’instant, conservez l’option d’affichage Octahedron active.
Nous nous intéresserons très prochainement à l’option Envelope, particu-
lièrement conviviale et intuitive.

Figure 8–46
Notre première armature !

ASTUCE   Joindre des armatures séparées

Vous pouvez doter un même modèle d’autant
d’armatures que souhaité : il suffit d’attribuer un
modificateur Armature à chacune d’elles. Mais
pour des raisons pratiques, vous souhaiterez sou-
vent que toutes les armatures n’en fassent qu’une.
Grâce à la sélection multiple, sélectionnez-les
toutes en terminant par celle qui donnera son nom
à l’armature résultante, et appuyez sur la combi-
naison de touches [Ctrl]+[ J] pour les réunir.

Figure 8–47
Les panneaux Link and Materials et Armature
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Entrez maintenant en mode d’édition, et sélectionnez le dernier os créé.
Dans ce mode, un nouveau panneau, intitulé Armature Bones, fait son
apparition. Les paramètres qui y sont présentés nous permettront de
définir la façon (ainsi que dans quelle mesure) chaque os de l’armature
peut déformer le maillage qui l’entoure. Nous notons en particulier le
champ BO: qui porte le nom de l’os sélectionné ou en cours d’édition ; s’il
fait partie d’une chaîne d’os, un champ numérique child of précise de quel
os il est l’enfant. Le paramètre Dist permet de définir jusqu’à quelle dis-
tance (en unités de Blender) l’os est en mesure de déformer le maillage
environnant. Ensuite sont disponibles diverses options, parmi lesquelles
Hinge et Deform. Par défaut, seule Deform est activée, signifiant que vous
autorisez l’os à déformer le maillage environnant à concurrence de la force
Weight spécifiée. Hinge (littéralement, charnière) permet de définir un os
qui n’hérite pas de l’angle de rotation des os placés avant lui dans la chaîne.
Pour bien comprendre ce que cela veut dire, tentons l’expérience.

Quittez le mode d’édition et entrez dans le mode Pose (combinaison
[Ctrl]+[Tab]). Sélectionnez l’os central, normalement nommé Bone.001.
Il apparaît désormais en bleu.

Figure 8–50
Le panneau Armature Bones

ERGONOMIE   Raccourcis clavier pour l’édition des os

Les raccourcis suivants se révéleront utiles lors de votre carrière d’animateur.
• Touche [L] : avec le pointeur de la souris positionné au-dessus d’un os, permet de sélec-

tionner la chaîne entière.
• Touche [X] : permet de supprimer un os sélectionné ; sélectionner une extrémité seule-

ment n’est pas suffisant pour procéder à la suppression.
• Touche [E] : à partir de l’extrémité sélectionnée, un nouvel os sera extrudé/ajouté.
• Touche [W] : pour subdiviser un os sélectionné. Les subdivisions multiples sont possibles.
• Combinaison [Alt]+[M]  pour fusionner des os.
• Touche [F]  pour ajouter un os entre deux articulations déjà existantes ou entre une articu-

lation existante et le curseur 3D.
• Combinaison [Ctrl]+[Alt]+[P] : pour séparer un os (ou une chaîne) de l’armature cou-

rante et les placer dans une nouvelle.
• Touche [Ctrl]+[P] : pour « parenter » un ou plusieurs os à l’os actif. Avec l’option X-

Mirror active, l’opération se réalise sur l’os symétrique plutôt que sur l'os l’actif, lorsque
cela est possible.

• Combinaison [Maj]+[D] : la duplication d’un os duplique également les contraintes, les
limitations de transformation et les réglages IK.

ASTUCE   Sélection sur les os

Vous pouvez sélectionner aussi bien une articula-
tion ou l’autre, en cliquant avec le bouton droit
de la souris sur les petits ronds à chaque bout d’un
os qui les symbolisent. Bien évidemment, vous
pouvez également sélectionner l’os entier en cli-
quant sur la partie centrale de l’os.

ERGONOMIE   Raccourcis clavier 
pour l’édition des poses

Les raccourcis suivants se révéleront utiles lors de
votre carrière d’animateur, en mode Pose (le
modèle suit les déformations de l’armature).
• Touche [R] : permet de faire tourner l’os autour

du point pivot spécifié ; la touche classique
pour poser un modèle.

Figure 8–48

• Touche [S] : permet de redimensionner l’os à
partir du point pivot spécifié ; une touche des-
tinée à certains effets spéciaux (dilatation, gon-
flement...).

Figure 8–49



8 
– 

Te
ch

ni
qu

es
 d

’a
ni

m
at

io
n 

av
an

cé
es

© Groupe Eyrolles, 2008 323

Appuyez sur la touche [R] pour faire tourner l’objet : vous constaterez
que l’os à l’origine de la chaîne (Bone) ne bouge pas, mais que l’os enfant
de l’os en cours de pose accompagne tous les mouvements. En effet, les
os enfants se voient appliqués les mêmes rotations que les os parents.

Sélectionnez maintenant le dernier os de la chaîne : Bone.002. Dans le
panneau Armature Bones, activez l’option Hinge. Sélectionnez à nouveau l’os
parent de celui-ci (Bone.001, au milieu de la chaîne) et faites-le à nouveau
tourner : cette fois-ci, le dernier os de la chaîne conserve ses rotations propres.

Figure 8–51
Notre armature dans sa position de repos

Figure 8–52
Par défaut, les os enfants 
suivent les rotations des os parents.

Figure 8–53
Avec l’option Hinge, les os enfants 
conservent leur orientation propre, 
malgré les rotations des os parents.
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L’option Hinge est très intéressante pour tout modèle articulé à tendance
mécanique : une porte s’ouvrant sur ses gonds, un bras robotisé, un sys-
tème bielle-manivelle. Pour la poursuite de vos expérimentations, désac-
tivez Hinge pour le dernier os ; vous avez désormais compris son
fonctionnement.

Appliquer les déformations de l’armature au modèle
Pour l’instant, nous avons réussi à créer une armature, mais celle-ci
n’étant pas encore liée au modèle, elle ne parvient pas à le déformer en
fonction de ses poses propres. Il existe plusieurs méthodes pour y par-
venir, mais la procédure générale est la suivante :
1 modélisation de la figure à animer : plus les maillages sont denses, plus

les opérations sont difficiles à paramétrer et lentes à mettre en place.
En particulier, il est important d’imaginer de quelle manière le maillage
en cours de modélisation va se plier ou se déformer en cours d’anima-
tion, en particulier au niveau des articulations des personnages ;

2 définition d’une armature : cette étape peut être extrêmement simple
(pour positionner grossièrement des personnages) ou sophistiquée (avec
des contrôleurs qui piloteront les os de l’armature pour simplifier au
maximum le travail de l’animateur). C’est ce que l’on appelle le rigging ;

3 lien de l’armature au maillage : soit par parentage direct, soit par
l’usage d’un modificateur Armature ;

4 spécification des sommets du modèle affectés par chaque os de
l’armature et en quelles proportions : c’est l’étape la plus importante
et la plus difficile. Traditionnellement, elle est réalisée manuellement
(technique du Weight Painting), mais des outils avancés permettent
de les réaliser semi-automatiquement (Envelopes, Bone Heat Wei-
ghting). C’est ce que l’on appelle le skinning.

Les différents modes d’une armature

Le mode Object est le mode classique de représentation d’un objet dans Blender. Dans ce mode,
c’est l’armature (ou squelette) que vous manipulez dans sa globalité. En appuyant sur la touche
[Tab], vous pouvez entrer dans le mode d’édition (Edit), ce qui vous permet de manipuler
chaque os individuellement. La position de chaque os est importante, car vous définissez ici la
pose au repos de l’armature, et elle doit correspondre, autant que possible, à la pose de modélisa-
tion du modèle. Le mode Pose (combinaison [Ctrl]+[Tab]) enfin, permet de changer la pose de
l’armature, et donc du modèle ; mais à chaque fois que vous entrerez à nouveau en mode d’édi-
tion, tant l’armature que le modèle reviendront provisoirement à la pose neutre de repos.

Figure 8–54

Mode miroir

Vous savez déjà qu’il est possible de modéliser vos
personnages en mode miroir grâce au modifica-
teur approprié. Pour faciliter la création des arma-
tures, il est également possible de les créer dans
un mode miroir particulier. Pour activer ce mode,
dans le panneau Armature, activez l’option X-
Axis Mirror Edit, puis utilisez la combinaison de
touches [Maj]+[E] pour insérer un premier os
symétrique en mode miroir. Vous continuerez à
insérer de nouveaux os normalement (touches [E]
ou [Ctrl] et bouton gauche de la souris). Pour
désactiver le mode miroir, désactivez l’option X-
Axis Mirror Edit.
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Par la méthode des enveloppes
La première étape est fondamentale : il faut spécifier à Blender quelle
armature utiliser pour les déformations du modèle. Sélectionnez l’étoile
de mer (bouton droit de la souris), rendez-vous dans le menu Editing
(touche [F9]) si vous l’avez quitté, et affichez l’onglet Modifiers. Si vous
utilisez le fichier de démonstration, il y a déjà un modificateur actif :
Subsurf ; cliquez alors sur le bouton Add Modifier et choisissez Armature
dans la liste déroulante. Désactivez l’option Vert.Groups et ne conservez
que l’option Envelopes. Dans le champ Ob: saisissez le nom de l’armature
(rappelez-vous, c’est le nom dans le champ OB: de l’onglet Link and Mate-
rials lorsque l’armature est sélectionnée). Il s’agit normalement, tout
simplement, de Armature (faites attention à respecter la casse du nom :
majuscules et minuscules comptent).

Nous allons maintenant faire quelques tests de déformation ; sélec-
tionnez à nouveau l’armature et entrez en mode Pose. Choisissez l’un ou
l’autre des os, et amusez-vous à le faire tourner grâce à la touche [R]. Le
résultat est probablement décevant, puisque le maillage du modèle ne
suit que peu ou pas les déplacements des os !

Le résultat est très mauvais, le rig doit absolument être affiné. C’est là
que la notion d’enveloppe va jouer un rôle clé dans le rigging de ce
modèle : grâce aux enveloppes des os, nous allons définir physiquement
et graphiquement la zone d’influence de chaque os.

Quittez le mode Pose pour entrer dans le mode d’édition de l’armature,
et assurez-vous que vous êtes toujours dans le menu Editing (touche [F9]).

Figure 8–55
Ajout d’un modificateur Armature au modèle

Figure 8–56
Les déformations du modèle 
ne sont pas du tout celles attendues.

REMARQUE   Importance de l’ordre 
des modificateurs !

Si vous souhaitez que le modificateur Subsurf
s’applique au maillage déformé par l’armature, et
non pas l’inverse, pour obtenir une parfaite conti-
nuité des branches de l’étoile de mer, il faut impé-
rativement que le modificateur Armature soit
tout en haut de la pile des modificateurs. Utilisez
les petites flèches verticales pour déplacer les
modificateurs dans la position souhaitée.

3DS MAX   Animation de foules

Le module Character Studio permet de créer des
foules de bipèdes à l’aide d’un système d’anima-
tion procédurale. Blender dispose également d’un
module permettant ce genre de tour de force ; il
s’agit d’un script Python, nommé Blender People
et écrit par Harkyman. Pour découvrir le projet :
B http://www.harkyman.com/bp.html
Blender People est en fait une suite de scripts
Python qui permettent, grâce à une base de don-
nées MySQL, de gérer le comportement d’une
foule importante, y compris des scénarios de
combat incluant des stratégies d’attaque, de
défense, de retraite, de marche, et encore bien
d’autres possibilités.

COMPRENDRE   Au sujet des os 
et des enveloppes

Lorsque la méthode des enveloppes est utilisée,
l’enveloppe est définie par un rayon à la base et un
rayon à l’extrémité. Tous les sommets du modèle
situés dans le volume ainsi délimité sont déformés
à 100 % par le mouvement de l’os. La zone d’effet
au-delà des os est définie par la valeur Dist ; les
sommets pris dans cette zone d’effet sont
déformés conformément à leur distance par rap-
port à l’os. Ce taux de déformation évolue selon
une loi quadratique jusqu’à s’annuler à la limite de
la zone d’influence.
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Dans le panneau Armature, choisissez l’option d’affichage Envelope. La
physionomie de chaque os change, pour admettre un rayon à la base et
un rayon à l’extrémité, la jonction entre ces rayons étant réalisée de façon
continue. Mais surtout, les aires d’influence sont matérialisées par une
zone gris clair très visuelle.

Commencez par sélectionner (bouton droit de la souris) le cercle à la base
du deuxième os (ou à l’extrémité du premier, puisqu’il s’agit d’une chaîne
d’os) : il doit s’afficher en jaune. Appuyez sur la touche [S] pour le redi-
mensionner, de sorte à ce qu’il tangente la base du bras vertical de l’étoile
de mer. Notez qu’il va totalement absorber l’os Bone, à la racine de la
chaîne, mais ce n’est pas grave.

Sélectionnez maintenant le cercle à l’extrémité du deuxième os (ou à la
base du troisième) et, de même, redimensionnez-le de sorte à ce qu’il
tangente les bords du bras de l’étoile de mer.

A priori, nous n’avons pas besoin de redimensionner le cercle constituant
l’extrémité du dernier os de la chaîne, mais nous pourrions très bien être
amenés à le faire sur d’autres modèles. L’essentiel ici est que les enveloppes
de chaque os englobent du mieux possible les volumes du maillage à
animer. Un petit coup d’œil sur une vue ombrée nous permet de constater
que les enveloppes englobent bien le bras vertical supérieur de l’étoile.

Figure 8–57
Visualisation des os sous forme d’enveloppes

Figure 8–58
Redimensionnement de la base

de l’enveloppe du premier os

ERGONOMIIE   Édition des enveloppes

En mode Pose, la touche [S] permet de redimen-
sionner le rayon de la base ou de l’extrémité de
l’os, selon ce qui est sélectionné. Lorsque l’os
entier est sélectionné, la combinaison de touches
[Alt]+[S] permet de redimensionner la zone
d’effet au-delà des os.

Figure 8–59
Vue des os avec toutes les enveloppes 

redimensionnées pour englober le modèle
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Vous pouvez quitter le mode d’édition de l’armature, et entrer à nouveau
dans le mode Pose ; prenez un instant garde à sélectionner le centre de
l’objet actif comme point pivot des rotations.

Puis, grâce à la touche [R], amusez-vous à faire tourner les différents os
de l’armature, et observez la réponse du modèle à ces rotations.

Figure 8–60
Vue ombrée des enveloppes

3DS MAX   Angles de renflement

Cette fonctionnalité de Character Studio permet de
modifier la forme des muscles en fonction de
l’angle d’une articulation. Si rien n’est automatisé
en la matière, Blender permet toutefois d’assujettir
des Shape Keys à la position d’un os, par
exemple, et d’obtenir des résultats analogues, au
prix de plus de travail, il est vrai.

Figure 8–61
Le centre de l’objet actif 

en guise de point pivot des rotations

Figure 8–62
La déformation du modèle est désormais 
à la hauteur de nos attentes.
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Par la méthode du Bone Heat Weighting
Cette méthode alternative est beaucoup plus simple à mettre en œuvre
dans la mesure où il n’y a pas besoin de spécifier de rayon d’effet à
chaque os : l’algorithme déduit automatiquement le poids à attribuer à
chaque sommet en fonction de sa proximité à un ou plusieurs os exis-
tants et en fonction de la géométrie à déformer.

En clair, il suffit de créer l’armature du personnage, de « parenter » le
maillage à celle-ci et ensuite de spécifier la méthode :
1 sélectionnez le maillage puis ajoutez l’armature à la sélection ;
2 utilisez la combinaison [Ctrl]+[P] pour parenter le maillage à l’armature ;
3 choisissez de parenter à l’Armature ;
4 choisissez de créer les groupes de sommets affectés (Create ) à partir

de la méthode Create From Bone Heat.

Cette méthode peut être également appliquée après avoir parenté ou uti-
lisé un modificateur Armature, dans les modes Weight Paint et Pose, grâce
à la touche [W] et à l’option Apply Bone Heat to Vertex Groups.

Dans la plupart des cas, cette méthode devrait offrir de meilleurs résul-
tats que la méthode des enveloppes, mais il se peut que le skinning ne
soit pas toujours parfait ; lorsqu’un os est pivoté d’une très grande valeur,
il se peut que l’articulation correspondante se contracte de façon peu
acceptable. De même, avec certains maillages très mal construits (en
particulier ceux présentant des arêtes de longueur nulle), il est possible
que cette méthode échoue tout simplement.

Dans la mesure où les autres branches de notre étoile n’ont pas d’os définis,
vous noterez que les premiers os de l’armature, lorsqu’ils sont tournés, défor-
ment plus ou moins sensiblement, en fonction de la distance, le reste du
maillage. Si l’armature était complète, il en serait bien évidemment autrement,
chaque branche étant parfaitement déformée par les os les plus proches.

Figure 8–63
Création des groupes de sommets 

partir de l’influence des os

ASTUCE   Testez votre skinning

Si vous souhaitez savoir comment se comporte
votre modèle, quelques astuces utiles sont à
connaître :
• en mode Pose, les os réagissent seulement à la

commande [R] ou [S]. Une commande [G] est
automatiquement convertie en [R] ;

• pour tester les déformations de façon plus libre,
essayez la suite de touches [R] [R] au lieu de
[R] et déplacez la souris pour constater que le
mouvement ne s’inscrit plus dans le plan de
l’écran mais dans l’espace ;

• activez le bouton Auto IK de l’onglet
Armature : déplacez un os (touche [G]) et
voyez comment les os en amont réagissent
automatiquement.

Figure 8–64
Exemple de groupes de sommets créés

par la méthode du Bone Heat Weighting
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Par la méthode du Weight Painting
En réalité, cette méthode est la plus ancienne ; elle est antérieure aux
outils Envelope et Bone Heat Weighting. En réalisant la procédure qui suit,
vous corrigez bien évidemment les Weights des groupes de sommets exis-
tants, mais vous les créez tout aussi bien.

Idéalement, pour faciliter la visualisation des opérations, dans l’onglet
Armature du menu Editing [F9], activez les options X-Ray et Stick. Ainsi,
l’armature sera toujours visible à l’écran, mais elle ne masquera pas de
façon flagrante le maillage.

Sélectionnez le maillage puis l’armature. Utilisez la combinaison
[Ctrl]+[P] et choisissez d’établir la relation de parent avec l’option Arma-
ture, en sélectionnant l’option Name Groups. Alternativement, vous
pouvez spécifier au maillage le modificateur Armature, en citant celle à
prendre en compte dans le champ Ob:, en cochant l’option Vert.Groups et
en désactivant Envelopes.

Avec le bouton droit de la souris, sélectionnez maintenant l’armature et
entrez dans le mode Pose ; cette étape est absolument indispensable !
Sélectionnez ensuite, toujours avec le bouton droit, le maillage à
déformer et passez en mode Weight Paint.

Sélectionnez, dans ce mode, le premier os dont vous allez spécifier
l’influence tel que celui qui constitue l’extrémité de la branche. Dans le
panneau Paint du menu Editing [F9], choisissez Weight 1.000 et Opacity
1.000 et coloriez à l’aide du petit pinceau l’extrémité du maillage suscep-
tible d’être affectée par l’os courant.

Bien évidemment, vous répéterez ces opérations pour chacun des os ; en
mode Weight Paint, n’hésitez pas à faire tourner le modèle dans tous les

ASTUCE   Armature parent deform

Si vous avez utilisé la combinaison [Ctrl]+[P] pour
réaliser le parentage du maillage à l’armature
(Bone Heat Weighting ou Weight Painting),
le modificateur Armature ne fait pas automati-
quement son apparition dans le panneau concerné.
À la place, vous retrouvez un bouton Make Real
en face d’un pseudo-modificateur intitulé Arma-
ture parent deform. En cliquant dessus, vous
transformez le parentage en un véritable modifica-
teur Armature dont les boutons Vert.Groups et
Envelopes sont par défaut activés.

Figure 8–65

Figure 8–66
Les couleurs chaudes (maxi : rouge) indiquent 
les portions de maillage totalement déformées 
par l’os sélectionné et les couleurs froides (mini : bleu) 
caractérisent les portions qui restent insensibles à son influence.
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sens, en changeant régulièrement l’os sélectionné, pour vous assurer que
tous les sommets sont bien colorés.

Il ne vous reste maintenant plus qu’à vérifier que le maillage se déforme
conformément à vos souhaits : il est en effet essentiel de garder un esprit
critique sur cette étape qui est traditionnellement la plus délicate de tout
le processus d’animation. En effet, elle met souvent en lumière des
défauts de conception/modélisation au niveau du maillage à déformer,
qui se prête parfois peu ou mal à l’animation. Mais, avec l’expérience,
bonne modélisation, bon rigging et bon skinning se combinent pour
permettre des modèles parfaitement animés. Dans l’immédiat, sans
quitter le mode Weight Paint, sélectionnez les os un à un, en les faisant
tourner jusqu’à mettre en évidence des défauts de skinning.

Figure 8–67 Les Weights de tous les sommets sont attribués pour chaque os disponible dans l’armature.

Figure 8–68
Le mode Pose étant actif, il est possible,

en faisant bouger un os, de repérer, durant
le Weight Painting, les zones à problèmes.
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Il est également possible de corriger de façon dynamique les déforma-
tions d’un os particulier, en faisant tourner celui-ci et en corrigeant son
Weight (ou celui de ses os adjacents) pour limiter les déformations non
sollicitées ou les pincements de maillage.

Compléter l’armature
Pour l’étape finale qui suit, nous considérerons que vous avez utilisé la
méthode des enveloppes (dans le cas contraire, attendez d’avoir terminé
le rigging et une armature complète avant de réaliser le parentage et le
skinning). Avec l’armature en mode édition, rendez-vous dans le pan-
neau Armature, dans les options d’affichage, et choisissez Octahedron
pour simplifier les opérations à venir. Si le curseur de Blender n’est plus
au centre de la scène, sélectionnez la base du premier os Bone, appelez le
menu d’aimantation (Snap), grâce à la combinaison de touches [Maj]+[S],
et choisissez Cursor>Selection. Enfin, utilisez le curseur 3D en guise de
pivot aux futures opérations de rotation.

Maintenant, sélectionnez les trois os de l’armature (touche [A] jusqu’à ce
qu’ils apparaissent tous en jaune, ou sélection multiple avec le bouton
droit de la souris et la touche [Maj] enfoncée), et appuyez sur la combi-
naison de touches [Maj]+[D] pour les copier. Vous êtes automatiquement
entré en mode déplacement ; aussi, sans toucher à votre souris, appuyez
sur la touche [R] pour passer en mode rotation ; maintenez appuyée la
touche [Ctrl] pour faire tourner la copie des os de 5° en 5°, jusqu’à -90°.
Renouvelez l’opération jusqu’à ce qu’une copie de la chaîne d’os initiale
occupe chacun des bras de l’étoile de mer.

ASTUCE   Mélanger les différentes méthodes

Vous pouvez, par exemple, réaliser le skinning de
votre modèle soit par la méthode des Enveloppes
ou celle du Bone Heat Weighting, et ensuite
corriger l’une ou l’autre en utilisant le traditionnel
Weight Painting. Il vous faut alors activer
l’option Vert.Groups (dans le modificateur
Armature) pour que les modifications soient
appliquées au maillage.

Figure 8–69
Le curseur 3D en guise 

de point pivot des rotations

Figure 8–70
Le modèle est désormais pourvu d’une armature complète.
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Normalement, les os ont été dupliqués avec les informations d’enveloppe
précédemment définies. Le modèle étant parfaitement symétrique, le rig
est théoriquement complet et satisfaisant, mais pour d’autres modèles, il
aurait peut-être fallu retoucher la taille des enveloppes. Quittez le mode
d’édition pour passer en mode Pose, et après avoir repris Active Object
comme point pivot, jouez avec la position des os pour donner à votre
étoile de mer des poses aussi complexes que souhaitées. Enfin, vous
pourrez toujours comparer votre rig avec celui du fichier exercice-
ch08.07-final.blend.

Cinématique inverse
Ce que nous avons appris jusqu’à présent peut se révéler suffisant pour la
création d’images fixes ; grâce aux armatures, nous sommes désormais
capables de faire prendre à nos modèles les poses que nous souhaitons, et
déplacer un à un chacun des os, jusqu’à obtenir la position parfaite, est
un sacrifice nécessaire mais qui porte sa propre récompense. Mais dans
le cadre d’animation, procéder ainsi os par os, pour chaque geste, néces-
sitera non seulement bien des tâtonnements, mais aussi une réserve de
temps et de patience considérables de la part de l’animateur.

Heureusement, les outils de cinématique inverse (Inverse Kinematics, ou IK)
lui viennent en renfort : par exemple, pour déplacer le pied d’un sujet, il lui
suffira de déplacer son contrôleur ; le pied suivra, ainsi que tous les os qui
ajusteront leurs positions angulaires pour que le pied suive le contrôleur.

Reprenez le modèle de notre étoile de mer à quatre branches, désormais
pourvue d’une armature complète, ou, si vous le souhaitez, ouvrez le
fichier exercice-ch08.07-final.blend. L’armature est déjà sélectionnée,
il vous reste à passer en mode Pose. Sélectionnez l’extrémité du dernier
os du bras vertical supérieur, par exemple. Appuyez sur la combinaison
de touches [Ctrl]+[I], et choisissez To New Empty Object lorsque Blender
vous demande sur quoi ajouter une nouvelle contrainte IK.

Figure 8–71
« Staying alive, staying alive ! »

La première étoile de mer
dansante est née...

ASTUCE   Les manipulateurs 
de transformation 3D

S’ils sont relativement peu commodes en mode
Edit, les manipulateurs de transformation 3D se
révèlent particulièrement adaptés à la manipula-
tion des objets en mode Object ou des os en
mode Pose. Plus encore, en orientation Local, ils
se montrent des alliés précieux des animateurs.
Sur une armature en mode Pose, utilisez le mani-
pulateur de rotation en orientation locale pour
vous en persuader.
• [Ctrl]+[Espace] : (dés)active le manipulateur

en appelant un menu déroulant ;
• [Ctrl]+[Alt]+[G] : affiche le manipulateur de

déplacement ;
• [Ctrl]+[Alt]+[R] : affiche le manipulateur de

rotation ;
• [Ctrl]+[Alt]+[S] : affiche le manipulateur de

mise à l’échelle ;
• [Alt]+[Espace] : appelle un menu déroulant

permettant de choisir l’orientation du
manipulateur : Global, Local, Normal, View.

Figure 8–72
Ajout d’une contrainte IK
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Un objet de type Empty est apparu au bout de la chaîne d’os, et le dernier
os apparaît peint en jaune. Sélectionnez l’Empty avec le bouton droit de la
souris, appuyez sur la touche [G] pour pouvoir le déplacer, puis pro-
menez-le autour de l’écran, tout en regardant comment les os de l’arma-
ture pivotent les uns par rapport aux autres pour suivre l’objet Empty.
Dans ce cadre, l’objet Empty nous sert de contrôleur.

Dans le menu Editing (touche [F9]), un nouveau panneau est proposé : il
se nomme Constraints et présente toutes les options relatives à la cinéma-
tique inverse.

Grâce à des contrôleurs de ce type, l’animation d’un personnage cons-
titué d’un nombre important d’os se trouve grandement simplifié,
puisque c’est le solveur de cinématique inverse qui va s’occuper de posi-
tionner correctement tous les os de la chaîne, en fonction de la position
du contrôleur. Mais il existe de nombreux autres types de contraintes
disponibles dans Blender.

Blender et les contraintes
Les contraintes sont des fonctions qui permettent d’établir certains liens
entre les objets. Il est possible, en particulier, d’établir des liens entre
deux os de sorte que, par exemple, lorsqu’un os pivote dans une certaine
direction, l’autre os suive la même transformation. On dit alors que le
deuxième os est contraint par le premier, qui est la cible (target) de la
contrainte (constraint) qui s’applique au second.

L’étude des contraintes et de l’animation en général est trop vaste et spé-
cifique pour cet ouvrage, mais nous allons toutefois brièvement voir
comment mettre en place une telle contrainte, outre la contrainte IK que
nous venons de découvrir.

Ouvrez le fichier exercice-ch08.07-final.blend. L’armature est déjà
sélectionnée, passez en mode Pose. Sélectionnez l’extrémité de la chaîne
verticale supérieure qui figure plus ou moins la tête de votre étoile. Notez

Figure 8–73
Création d’un objet Empty en bout de chaîne d’os

Figure 8–74
Le panneau Constraints
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qu’elle se nomme Bone.002, car elle sera la cible des contraintes que nous
allons mettre en place ; son nom nous sera donc utile. Sélectionnez mainte-
nant une autre extrémité, par exemple celle du bras gauche (à droite de
l’écran en supposant que l’étoile nous fasse face). Dans le panneau Cons-
traints du menu Editing [F9], cliquez sur le bouton Add Constraint et choi-
sissez Copy Rotation dans la liste déroulante. Dans le champ Target,
indiquez le nom de l’armature qui est la cible de la contrainte : spécifiez
donc OB: Armature. Mais cette armature dispose de plusieurs os, aussi un
champ BO: fait son apparition pour que vous notiez l’os concerné. Indiquez
Bone.002 que nous avons identifié plus tôt. Immédiatement, l’os qui subit
la contrainte change son orientation pour s’aligner sur celle de l’os cible !

Répétez l’ajout d’une contrainte Copy Rotation à chacune des autres
extrémités de l’étoile de mer. Pour vous y retrouver, pensez à renommer à
votre guise chaque contrainte. Par exemple, indiquez CopyRotBG (copier
la rotation sur le bras gauche) pour cette première contrainte.

Blender propose bien évidemment un grand nombre de contraintes, cer-
taines utiles aux objets, d’autres utiles aux os et aux armatures, d’autres
utiles aux deux. Voici une liste rapide et non exhaustive de quelques con-
traintes utiles.
• Child Of : cette contrainte sert à établir des parentages complexes et ani-

mables entre diverses cibles. Les différents canaux (channels) permet-
tent de déterminer de quelle façon le parent va transformer ses enfants.

• Copy Location, Copy Rotation, Copy Scale : permet respectivement de
copier la position, les angles de rotation ou les échelles d’une cible et
de les appliquer à l’identique à l’objet contraint.

Figure 8–75
L’ajout d’une contrainte de rotation 

ne pose guère de difficultés.

Figure 8–76
Grâce à cette contrainte, il suffit d’orienter l’os

de la tête pour que les os des autres extrémi-
tés s’orientent de la même manière.
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• Limit Location, Limit Rotation, Limit Scale, Limit Distance : servent à
limiter la position, les angles de rotation ou les échelles sur une plage
spécifique. Ces contraintes n’ont pas besoin de cible.

• Track To : cette contrainte permet de toujours orienter un objet (une
caméra, par exemple) en direction de sa cible (un objet de la scène ou
un Empty, par exemple).

• Floor : permet de spécifier des objets plans qui ne pourront être tra-
versés par l’objet contraint. On peut ainsi créer des sols, des murs ou
des plafonds virtuels pour les os du pieds, ces derniers ne pourront
pas disparaître sous le sol au cours de l’animation.

• Locked Track : l’objet contraint va pivoter pour suivre un chemin.
• Follow Path : l’objet contraint va se déplacer pour suivre un chemin.
• Stretch To : cette contrainte permet d’étirer l’objet en direction de la

cible ; si celle-ci se rapproche, l’objet contraint se comprime. Dans les
deux cas, le volume de l’objet contraint s’efforce d’être constant : cela
veut dire qu’en s’étirant, il va également devenir beaucoup plus fin !

• IK Solver : la chaîne entière de l’os contraint va être affectée par les
déplacements de la cible ; cela est idéal pour animer une main en
même temps que l’avant-bras et le bras !

• Action : permet d’appliquer préalablement une action basée sur la
rotation d’un autre os. Cette contrainte est typiquement utilisée pour
le gonflement du biceps lorsque l’on anime un bras.

L’ordre des contraintes sur les objets et les os est important. En particu-
lier, une contrainte sur un objet (l’armature) sera évaluée en premier,
avant les contraintes sur les os de cette armature. Dans la liste des con-
traintes, celles-ci sont évaluées et appliquées de haut en bas. Ainsi, des
contraintes situées en bas de liste peuvent imposer leur comportement
malgré des contraintes contradictoires placées plus haut dans la liste.

Vous pouvez spécifier plusieurs contraintes identiques l’une après l’autre,
formant un bloc continu, mais avec des cibles (Target) différentes.
Blender va alors évaluer le résultat du bloc en une seule fois, en considé-
rant une cible « moyenne ». Si vous avez véritablement besoin de faire
appliquer de façon séquentielle des contraintes identiques mais à des
cibles différentes, insérez systématiquement une contrainte de type Null
entre chacune ; cela forcera Blender à refaire des évaluations distinctes
entre chaque Null.

BON À SAVOIR   La glissière 
Influence des contraintes

Ce bouton glissière permet de régler l’influence de
la contrainte sur l’objet affecté. Lorsque plusieurs
contraintes s’appliquent à un objet, elles le feront
proportionnellement à leur Influence respective :
par exemple, si pour chacune Influence est égale à
1.000, les contraintes s’appliqueront à l’objet de
façon équilibrée.
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Quelques conseils méthodologiques

Degrés de liberté
Par défaut, un os peut pivoter librement autour des axes X et Z à partir de
sa base (l’activation de Axes dans les options d’affichage du panneau Arma-
ture pourra aider à visualiser ces axes), et tourner sur lui-même (son
axe Y). Après avoir rajouté une contrainte, le solveur IK propose de nou-
velles options dans le panneau Armature Bones ; en particulier, il permet de
choisir un ou plusieurs degrés de liberté et de les bloquer. Par exemple, en
activant Lock X Rot et Lock Z Rot, un os ne peut plus tourner que sur lui-
même (axe Y toujours libre). Ces options permettent de simuler aisément
certaines articulations, comme le coude ou le genou, par exemple.

Limitation des angles de rotation
De la même façon que des options existent pour restreindre les degrés de
liberté d’un os, après avoir ajouté une nouvelle contrainte, le solveur IK
propose d’autres options dans le panneau Armature Bones. En particulier,
pour chaque axe, il affiche des options Limit X, Limit Y et Limit Z ; en acti-
vant, par exemple, Limit X, vous pouvez spécifier l’angle minimal (Min X)
et l’angle maximal (Max X) entre lesquels devra évoluer l’os. Ces options
permettent de simuler aisément les plages de rotation de certaines arti-
culations, comme le coude ou le cou, par exemple.

L’éditeur d’actions non linéaires (NLA Editor)
En anglais, il s’agit du Non Linear Action Editor (ou NLA Editor). Il
permet tout simplement de réaliser un montage avec les actions disponi-
bles pour le sujet.

Création d’une action
Nous avons déjà commencé à nous frotter à l’éditeur d’actions dans le
chapitre précédent, mais nous allons ici être un peu plus concret, en
basant nos expérimentations sur l’armature mise en place dans la section
L’animation squelettale de ce même chapitre.

Ouvrez le fichier exercice-ch08.08-depart.blend du répertoire
/exercices. L’écran a déjà été préparé aux manipulations à venir. On
note une vue 3D, dans laquelle nous allons poser notre étoile de mer.
Immédiatement en dessous d’elle, une vue IPO, qui nous servira surtout
à contrôler notre travail. La majeure partie de l’écran est réservée à l’édi-
teur d’actions (en haut à droite), à l’éditeur d’actions non linéraires (juste
en dessous), et enfin à la Timeline (encore au-dessous).

Figure 8–77
Les degrés de liberté sont faciles à supprimer.

Figure 8–78
Chaque axe peut se voir limité à une rotation 

sur une certaine plage angulaire.
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Dans la vue 3D, l’armature est sélectionnée et apparaît en rose. Dans
l’éditeur d’actions, repérez le bouton ascenseur au centre de l’en-tête de
la vue. Cliquez dessus et choisissez ADD NEW pour créer une nouvelle
action. Elle prend par défaut le nom Action.001, mais dans le champ AC:
renommez celle-ci en BougeBrasGauche.

De retour dans la vue 3D, entrez en mode Pose. Vérifiez que vous êtes bien à
la frame 1 du système. Repérez les os nommés Bone.010 et Bone.011 ; ils
constituent le bras gauche de l’étoile (à droite de la vue 3D, l’étoile étant censée
vous faire face). Sélectionnez-les tous deux, et avec le pointeur de la souris tou-
jours dans la vue 3D, appuyez sur la touche [I] pour insérer une clé de type
LocRotScale. Dans l’éditeur d’actions, des losanges jaunes apparaissent en face
des noms des os, indiquant qu’une nouvelle clé vient d’être insérée.

Maintenant, avancez jusqu’à la frame 26 (soit une seconde plus tard, à
25 frames par seconde), sélectionnez l’os nommé Bone.010, appuyez sur
la touche [R] pour entrer en mode rotation (en maintenant la touche
[Ctrl] appuyée pour obliger la rotation à accomplir des incréments entiers
de 5°), et faites-le tourner de -15°. Sélectionnez maintenant l’os nommé
Bone.011 et de la même façon, faites-le tourner de -25°. Sélectionnez ces
deux os, et à nouveau, appuyez sur la touche [I] pour insérer une nouvelle
clé de type LocRotScale.

ERGONOMIE   Raccourcis clavier pour l’édition des actions

Les raccourcis suivants se révéleront utiles dans votre carrière d’animateur.
• Touche [B] : vous pouvez sélectionner une clé d’action grâce au bouton droit de la

souris, mais également utiliser la touche [B], qui permet de dessiner une boîte de
sélection autour d’un groupe entier ; les clés sélectionnées apparaissent en jaune,
celles qui ne le sont pas apparaissent en blanc.

• Touche [G] : vous pouvez sélectionner une clé d’action (ou un groupe de clés) grâce
à cette touche, et la déplacer à la souris. La touche [Ctrl] fonctionne comme dans une
vue 3D, en contraignant le déplacement à des fractions entières.

• Touche [S] : cette touche vous permet de redimensionner horizontalement un
groupe de clés ; si vous le diminuez, l’action accélère. Au contraire, si vous l’aug-
mentez, l’action ralentit.

• Combinaison de touches [Maj]+[D] : vous pouvez copier une action, et la posi-
tionner à la souris à l’endroit de votre choix, ce qui est très pratique lorsqu’une action
complexe ramène à plusieurs reprises à la même position.

• Touche [X] : supprime une clé d’action, ou un groupe de clés.
• Combinaison [Maj]+[G] : ajoute l’Action courante au Groupe d’Actions actif (un

nouveau groupe est créé s’il n’en existe pas).
• Combinaison [Ctrl]+[Maj]+[G] : ajoute l’Action courante à un nouveau Groupe

d’Actions.
• Combinaison [Alt]+[G] : enlève l’Action courante des Groupes d’Actions dans les-

quels elle figure.

Figure 8–79
La position de départ de notre première action
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Rendez-vous maintenant en frame 76 (soit 2 secondes plus tard), faites
tourner l’os Bone.010 de +30° et l’os Bone.011 de +50°, de sorte que la
nouvelle pose soit le miroir, par rapport à l’axe horizontal, de la précé-
dente. À nouveau, avec les deux os sélectionnés, appuyez sur la touche [I]
et choisissez LocRotScale pour enregistrer une nouvelle clé.

Enfin, avancez jusqu’à la frame 101 (une seconde supplémentaire plus
tard), conservez les deux os sélectionnés, et appuyez sur la combinaison
de touches [Alt]+[R] pour réinitialiser leurs rotations respectives : ils
reviennent tous deux en position horizontale. S’ils sont toujours sélec-
tionnés, insérez une dernière clé LocRotScale grâce à la touche [I].

Après ce travail laborieux, si nous jetons un œil au contenu des éditeurs
d’actions et d’actions non linéaires, nous constatons qu’ils se sont garnis
d’une clé d’animation (losange jaune), pour chaque os et chaque frame clé.

Nous allons maintenant créer une seconde action. Dans l’en-tête de
l’éditeur d’actions, cliquez sur le bouton X à droite du nom de l’action
courante. N’ayez pas peur, l’action précédente ne sera pas réellement

Figure 8–80
Notre étoile lève son bras gauche...

Figure 8–81
... puis le baisse...
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effacée, elle libérera seulement l’écran de l’éditeur d’actions ! Utilisez
ensuite le bouton ascenseur, et choisissez ADD NEW pour insérer une
nouvelle action. Renommez la nouvelle action en BougeBrasDroit dans
le champ AC:. Maintenant, dans la vue 3D, déselectionnez les os du bras
gauche, et recommencez les mêmes opérations pour le bras droit de
l’étoile de mer (à gauche de l’écran), constitué des os Bone.004 et
Bone.005. Nous avons donc maintenant deux actions parfaitement symé-
triques. Pour les tester, utilisez la combinaison de touches
[Maj]+[Alt]+[A] ou le curseur lecture de la Timeline : nous voyons les deux
bras de notre étoile de mer se lever de façon parfaitement synchronisée.

Figure 8–82
... avant de revenir à sa position de départ.

Figure 8–83
Les éditeurs ont précieusement consigné 
toutes les clés d’animation.
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Il est maintenant temps de passer à la découverte de l’éditeur d’actions
non linéaires pour voir comment composer ces deux mouvements.

Création d’une séquence
Pour la suite, gardons un œil sur l’éditeur d’actions en même temps que
l’éditeur d’actions non linéaires. Pour l’instant, l’action active est
BougeBrasDroit. Dans l’éditeur NLA, il y a deux lignes : sur la première
figure le nom de notre armature (Armature) et sur la seconde le nom de
l’action active (BougeBrasDroit), l’activité étant soulignée par le rond noir.
La combinaison de touches [Maj]+[Alt]+[A] lance l’animation, mais seul
le bras droit va bouger, car c’est l’action active. Pour composer l’anima-
tion, il va falloir réaliser un montage, sur lequel vous allez spécifier la
durée, en frames, de chaque geste, et le nombre éventuel de répétitions de
ce geste. Ainsi, dans l’éditeur NLA, chaque geste sera représenté par une
bande. Nous allons immédiatement ajouter une première bande pour
l’action active ; avec le pointeur de la souris sur le nom de l’armature, uti-
lisez la combinaison de touches [Maj]+[A] pour ajouter une bande.
Blender vous demande à quelle action doit correspondre cette bande :
choisissez BougeBrasDroit. Recommencez pour ajouter BougeBrasGauche.

Suppression d’une action

Le bouton suppression (l’icône de l’en-tête de l’éditeur d’actions ornée d’une croix X) n’efface
pas réellement les actions sélectionnées : il libère seulement l’espace de l’écran. Pour supprimer
une action, pas d’autre solution que de visiter les données internes de votre fichier Blend et de
supprimer manuellement les actions indésirables. La combinaison de touches [Maj]+[F4] vous
amènera directement dans le répertoire de sélection des données ; cliquez sur les deux points
blancs .. pour remonter d’un cran dans l’arborescence, puis cliquez sur le répertoire Action.
Avec le bouton droit de la souris, sélectionnez l’action à supprimer, puis appuyez sur la
touche [F]. Validez l’opération en cliquant sur Data Select, sauvegardez votre fichier, et réou-
vrez-le : l’action aura disparu. Il n’y a malheureusement pas plus direct à ce jour.

BON À SAVOIR   Les contraintes

Les contraintes ont une utilité générale et ne sont pas spécifiques à l’animation de
personnages ; elles permettent de résoudre les soucis de cinématique inverse ou encore de
verrouiller les objets les uns par rapport aux autres. Pour ajouter une contrainte, cliquez sur le
bouton Add Constraint, dans le panneau Constraint, dans les Object buttons du menu
Object (touche [F7]). Seul un os peut recevoir une contrainte de type IK Solver ou Action ;
quelques contraintes typiques : Track to pour qu’une caméra pointe vers un objet Empty ou
un autre objet ; IK Solver pour animer une chaîne complète d’os à partir d’un simple
contrôleur ; Action pour simuler la contraction d’un muscle lorsque le membre est animé.

ERGONOMIE   La Timeline pour passer 
d’une clé d’animation à l’autre

Puisque vous cherchez à reproduire les mêmes
mouvements, en symétrique, avec le bras droit
qu’avec le bras gauche, utilisez les boutons de
navigation de la Timeline, ou les raccourcis
clavier :
• [Ctrl]+[PageHaut] pour passer à la clé

suivante ;
• [Ctrl]+[PageBas] pour passer à la clé

précédente ;

Figure 8–84
Les boutons de navigation de la Timeline

ASTUCE   Remise à zéro des rotations 
et du redimensionnement d’un os

Lorsque vous entreprenez de créer une action,
après avoir enregistré une ou plusieurs clés à une
frame ou une autre, vous aurez peut-être besoin
de ramener un os à sa position et/ou dimension
d’origine, surtout lorsque vous cherchez à com-
pléter un cycle :
• [Alt]+[R] vous permet de réinitialiser les rota-

tions d’un os ;
• [Alt]+[S] vous permet de réinitialiser la

dimension d’un os.
Cela vous évite donc d’annuler manuellement les
rotations ou mises à échelle que vous avez pu
imposer précédemment à vos os.
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Vous noterez qu’un symbole est apparu devant le nom de l’armature, sur
la première ligne. S’il s’agit du symbole de l’éditeur NLA, lorsque vous
jouez l’animation avec la combinaison de touches [Maj]+[Alt]+[A] ou le
bouton Lecture de la Timeline, toutes les bandes sont prises en compte
pour l’animation des vues 3D. En cliquant sur ce symbole, vous le
changez en symbole de l’éditeur d’actions. Dans ce cas, seule l’action pré-
cédée d’un rond noir est jouée. Cette option est très pratique pour tester
une à une les actions, et voir comment elles interagissent ensemble.

Par défaut, les bandes sont de couleur rose, à l’exception de la bande
active qui est jaune. Vous pouvez éditer les propriétés de celles-ci en uti-
lisant le menu Strip>Strip Properties ou au travers du raccourci clavier
[N] ; les deux font apparaître une boîte de paramétrage de la bande.

Les principales options qui vous sont offertes concernent le chronométrage
de l’action de la bande : les boutons numériques Strip Start et Strip End
indiquent respectivement la frame de début et la frame de fin de l’action.
La durée de celle-ci sera donc dilatée ou contractée afin de tenir dans cet
intervalle de temps. Par défaut, la bande commence et termine en même
temps que l’action, telle que vous l’avez définie dans l’éditeur d’actions.

La seconde option très importante est le bouton numérique Repeat ; il
définit le nombre de fois où l’action sera répétée dans l’intervalle de
temps occupé par la bande. Des valeurs supérieures à 1.00 accéléreront
donc l’action qui sera répétée plusieurs fois dans le même intervalle, et
réciproquement, des valeurs inférieures à 1.00 la ralentiront.

Essayez de jouer avec les valeurs Strip Start, Strip End, et Repeat en éditant
les bandes de chacune des deux actions, et jouez les animations corres-
pondantes dans la vue 3D. Vous pouvez, si vous le souhaitez, vous référer
au fichier exercice-ch08.08-final.blend.

Figure 8–85
L’éditeur NLA, avec les bandes 
d’actions mises en place 
pour le montage

Figure 8–86
La fenêtre des propriétés d’une bande d’action

BON À SAVOIR  Blendin et Blendout

Les bandes sont évaluées par Blender du haut vers
le bas, les actions comprises dans des bandes pos-
térieures pouvant supplanter celles des bandes
antérieures, si vous avez, pour deux actions se
chevauchant sur la Timeline, spécifié des actions
agissant sur tout ou partie des mêmes os.
Blendin et Blendout définissent le nombre de
frames de transition entre l’action en cours d’édi-
tion et celle qui la précède dans la liste des bandes
d’actions.
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Animation avancée à l’aide des modificateurs
Quelques modificateurs peuvent se révéler utiles pour l’animation avancée
avec Blender. Nous les présentons ici, mais ils nécessitent une bonne com-
préhension des outils déjà présentés dans le chapitre 7, Techniques d’anima-
tion fondamentales, et le chapitre 8, Techniques d’animation avancées.

Déformation imposée par un maillage : le modificateur 
MeshDeform
Plutôt que d’utiliser un volume réglé avec des pas de grille dans les trois
directions de l’espace, ce modificateur permet, dans la lignée du modifi-
cateur Lattice, l’utilisation d’un maillage arbitraire en tant que « cage de
déformation » pour déformer un autre maillage. L’avantage par rapport
au treillis est que la cage de déformation peut être modélisée pour coller
au plus près au maillage à déformer, et qu’elle peut être très simple à
animer par le biais des armatures. L’autre avantage, par rapport à l’usage
classique des armatures, c’est qu’une montre, des bagues, une chemise
(ou n’importe quel accessoire également compris dans le volume de la
cage de déformation et bénéficiant du modificateur) serait également
automatiquement déformé pour prendre ses justes forme et position,
sans grand effort de la part de l’animateur.

La cage doit être un maillage classique, totalement clos, dont seuls les
sommets contenus dans la cage seront effectivement déplacés par le
modificateur. Idéalement, pour être facile à animer, cette cage aura une
structure simplifiée et un nombre de sommets bien plus réduit que le
maillage à déformer. La procédure est la suivante :

ERGONOMIE   Raccourcis clavier pour l’édition des bandes d’actions

Les raccourcis suivants se révéleront utiles dans votre carrière d’animateur.
• Bouton droit de la souris : ce bouton vous permet de sélectionner la bande d’action à

éditer.
• Touche [G] : cette touche vous permet de déplacer, sur sa ligne horizontale, une bande

d’action.
• Touche [S] : cette touche vous permet de redimensionner horizontalement une bande,

l’origine du redimensionnement étant la barre verticale verte symbolisant la frame cou-
rante. Diminuer l’échelle d’une bande condense l’action en cours, ce qui a pour effet de
l’accélérer. Inversement, agrandir l’échelle ralentit l’action en cours.

• Combinaison de touches [Maj]+[A] : le curseur de la souris doit être positionné sur le
nom de l’armature (ou le message d’erreur Object has not an action apparaîtra) ;
cette combinaison a pour effet d’ajouter une bande dans l’éditeur, une fenêtre apparaissant
pour vous demander l’action à lui associer.

• Touche [X] : supprime une bande.

Figure 8–87
Le modificateur MeshDeform

ASTUCE   Une cage en plusieurs parties

La cage n’est pas obligatoirement un maillage en
un seul tenant. Elle peut être constituée de plu-
sieurs volumes (petites sphères pour les yeux,
parallélépipèdes pour les doigts, etc.) qui peuvent
ou non se chevaucher, au gré des besoins, afin
d’offrir un degré de contrôle supplémentaire sur
les déformations.
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• modélisation de l’objet à déformer ;
• modélisation de la cage de déformation, par dessus l’objet à

déformer ;
• ajout d’un modificateur MeshDeform à l’objet à déformer ;
• saisie du nom de la cage de déformation dans le champ Ob: du

modificateur ;
• action sur le bouton Bind.

L’influence de déformation de la cage est alors calculée pour chaque
sommet du maillage à déformer, et cela peut prendre un temps variable
en fonction de la densité du maillage mais également de la valeur du
champ Precision. Des valeurs élevées conduisent à des déformations
beaucoup plus précises, mais l’influence peut être considérablement plus
longue à calculer.

ASTUCE   Distance de la cage 
au maillage à déformer

La distance entre la cage de déformation et le
maillage à déformer a son importance : si la cage
est serrée autour du maillage, les déformations
seront abruptes et prononcées ; au contraire, si
elle est éloignée du maillage, les déformations
seront plus douces, plus arrondies.

Figure 8–88 Exemple d’une cage de déformation encadrant un maillage de corps humain 
(issu du projet MakeHuman) : la cage, très primitive, peut être déformée par une très simple armature.

Figure 8–89 L’armature déforme la cage qui, elle-même, déforme le bras de l’objet.
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Le champ VGroup permet de limiter l’action du modificateur à certains
groupes de sommets particuliers (ou à la sélection inverse du groupe si le
bouton Inv est actif ). Pour sa part, le bouton Dynamic permet d’évaluer
l’amplitude de déformation apportée par la cage après que d’autres
déformations (imposées par des Shape Keys, par exemple) aient été appli-
quées. Cette option requiert toutefois des temps de calcul plus longs et
consomme plus de mémoire.

Enfin, le bouton Unbind permet de réinitialiser à zéro l’influence de la
cage sur le maillage. Des retouches peuvent alors être apportées à la
cage ; l’influence du modificateur sera alors réévaluée. Si la cage est
modifiée sans que le bouton Unbind ait été utilisé, le maillage sera
déformé proportionnellement.

Déformation d’un maillage pour simuler un vêtement ou 
un tissu : le modificateur Cloth
Nous avons déjà vu comment utiliser les corps souples, dans ce même
chapitre, pour simuler un tissu qui chute sur un objet. En parallèle de
cette solution, il existe un modificateur Cloth, beaucoup plus spécialisé,
pour parvenir au même type de résultat. Cette spécialisation permet
d’offrir un système moins versatile, mais plus robuste et plus fiable.

Sélectionnez le maillage de l’objet destiné à devenir un vêtement ou un
tissu. Dans le menu Object [F7]>Physical Buttons, activez le bouton Cloth
de l’onglet Cloth qui vous donnera accès à plus d’options. Dans le menu
déroulant, choisissez le tissu prédéfini de votre choix :
• Silk : soie ;
• Cotton : coton (valeur par défaut) ;
• Rubber : caoutchouc ;
• Denim : denim ;
• Leather : cuir ;
• Custom : défini par l’utilisateur.

Le tissu est défini par différents matériaux, dont vous n’aurez pratique-
ment pas à vous soucier si vous choisissez un tissu prédéfini.
• StructStiff : rigidité globale de la structure.
• BendStiff : coefficient mesurant la tendance à faire des plis. Des

valeurs élevées tendent à produire peu de plis, mais de plus grandes
dimensions.

• Spring Damp : dissipation de l’énergie par frottement. Plus la valeur est
grande, plus la dissipation sera importante et les oscillations faibles.

• Air Damp : spécifie la susceptibilité à la résistance de l’air, qui gonflera
un tissu tombant et le ralentira dans sa course.

Softbody ou Cloth ?

Pour simplifier les choses, disons que le modifica-
teur Cloth s’applique très bien à des maillages
ouverts (comme un rideau ou un vêtement) alors
que le Softbody est plus approprié pour les
maillages fermés (balle en mousse, bloc de gelée,
coussin rembourré). Chacun a ses avantages et
inconvénients, mais tous deux sont relativement
capables dans le domaine de prédilection de
l’autre, avec des résultats probablement différents.
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• Quality : détermine la qualité de la simulation. Des valeurs élevées
conduisent à de meilleurs résultats, au prix de temps toutefois de
calcul plus élevés.

• Mass : la masse de l’objet en tissu, exprimée en kilogrammes.

Classiquement, la gravité est définie par trois composantes Gravity X, Y
et Z, cette dernière étant par défaut égale à -9.81. Le bouton Pinning of
Cloth est beaucoup plus intéressant : si vous l’activez, vous avez la possi-
bilité de spécifier, pour le maillage Cloth, un groupe de sommets (Vertex
Group) qui sera cloué sur place et insensible à la simulation, avec une
rigidité égale à la valeur Pin Stiff (1.000 équivalent à des sommets totale-
ment inamovibles).

Dans l’onglet Collision, outre les boutons de baking identiques à ceux des
corps souples, vous retrouvez un bouton Enable Collisions qui, lorsqu’il est
actif, révèle quelques options.
• Min Distance : il s’agit de la distance minimale entre le cloth et un

obstacle, en dessous de laquelle une interaction est effectivement cal-
culée. Si vous rencontrez des problèmes de calcul de collision (tissu
traversé par l’obstacle, par exemple), augmentez ce paramètre.

• Collision Quality : le nombre d’itérations pour la détermination des colli-
sions est ici spécifié. Des valeurs plus élevées donnent de meilleurs résul-
tats, mais se révèlent plus longues à calculer. Si les collisions ne semblent
pas être déterminées comme il le faut, augmentez ce paramètre.

• Friction : représente la perte de vélocité due au frottement du cloth
contre l’obstacle. Une valeur de 100 indique que le cloth ne glisse pas
du tout à la surface considérée comme adhésive.

• Enable Selfcollisions : permet aux pans du cloth de se repousser les uns
les autres, générant des plis plus réalistes mais plus longs à calculer.
– Selfcoll Quality : cette option fonctionne selon la même logique que

Collision Quality déjà décrite, mais appliquée au cloth lui-même.
– Min Distance : comme précédemment, pour éviter que les plis issus

de l’autocollision ne se traversent.

Il est possible de définir, exactement comme pour les corps souples, des
obstacles qui seront pris en compte dans les simulations de collisions
avec les objets Cloth : cela se gère de la même manière dans le groupe
d’onglets Fields et en particulier Collision.

Ouvrez le fichier exercice-ch08.08-depart.blend du répertoire
/exercices du DVD-Rom, qui présente une scène de théâtre avec une
boule animée pour traverser le rideau. La sphère a été définie comme
obstacle dans l’onglet Collision. En ce qui concerne la partie Cloth, elle est
à répéter pour chaque rideau : la rangée horizontale supérieure de som-
mets est ajoutée dans un groupe (Vertex Group) nommé Tringlerie.

BON À SAVOIR  
Rigidité variable le long d’un cloth

Dans le panneau Advanced, vous pouvez activer
des options vous permettant de définir de façon
variable, en utilisant la technique du Weight
Painting, les valeurs StructStiff et BendStiff.



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008346

L’option Cloth est activée, le matériau Denim sélectionné et, enfin, le
bouton Pinning of Cloth pressé avec Tringlerie comme Vertex Group de
clouage. Tous les autres paramètres restent à leur valeur par défaut.

Dans l’onglet Collision, le bouton Enable collisions est actif avec tous les
autres paramètres par défaut. Start 1 et End 100 spécifient les bornes de la
simulation. Vous pouvez appuyer sur le bouton Bake de chaque rideau ou
simplement lancer la simulation grâce à la combinaison [Ctrl]+[A] avec le
pointeur de la souris dans la vue 3D à animer. Vous retrouverez de façon
plus complète le résultat de ce court exercice dans le fichier exercice-
ch08.08-final.blend du répertoire /exercices du DVD-Rom.

Explosion d’un maillage : le modificateur Explode
En conjonction avec un système de particules pour « sculpter » l’effet
spécial, le modificateur Explode est une solution intéressante pour faire
exploser des maillages. L’ordre des modificateurs dans la pile est

Figure 8–90
Notre scène de départ : très théâtrale !

Figure 8–91 Résultat de la simulation : le rideau s’écarte au passage de la sphère.
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important ; en particulier, le système de particules doit être défini avant
le modificateur Explode. Si ce n’est pas le cas, utilisez les petites flèches
verticales pour repositionner le modificateur Explode. Bien évidemment,
dans le panneau Extras du système de particules, pensez à activer le
bouton Emitter, sinon l’objet explosé n’apparaîtra pas sur le rendu.

Il est possible de spécifier les parties de l’objet qui exploseront effective-
ment grâce à un groupe de sommets (Vertex Group). Les autres contrôles
possibles sont :
• Refresh : permet de recalculer les facettes assignées aux particules ;
• Split Edges : pour avoir des éclats plus tranchants, en particulier quand

le modificateur Subsurf est également employé ;
• Unborn, Alive, Dead : permet de révéler ou de cacher respectivement les

particules non encore émises, émises ou dont la durée de vie est excédée.

Conclusion
Nous venons d’explorer, parfois brièvement, toutes les possibilités d’ani-
mation de Blender. Celles-ci sont nombreuses et variées, et reflètent
bien la volonté de ce logiciel de se tenir au niveau des autres applications
commerciales concurrentes. Les développements qui ont abouti aux der-
nières versions de Blender ont principalement porté sur la refonte du
système d’animation, afin qu’il soit à la fois puissant et versatile, tout en
étant aussi abordable que possible. Et au terme de ces deux chapitres,
vous conviendrez que Blender se place correctement dans ces domaines.

Figure 8–92
Le modificateur Explode

Figure 8–93
La carafe du chapitre 3 vole en éclats ! 
Bien évidemment, avec un système de particules mieux réglé, 
l’effet serait encore plus saisissant !
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chapitre 9

Scène tirée du film Elephants Dream, du Studio Orange | © 2006, Blender Foundation/Netherlands Media Art Institute |
www.elephantsdream.org | Creative Commons Attribution-NonCommercial-NoDerivs 2.5 
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Le rendu avec Blender

Ce chapitre a pour objectif de vous aider à réaliser le rendu de 
vos images fixes comme de vos animations. Dans le cadre de 
ces dernières, il vous initiera également aux possibilités, 
internes à Blender, de réalisation de montages vidéo. Préparer 
une scène en 3D n’est rien si vous ne pouvez pas transformer 
toutes ses données géométriques en une image de synthèse. 
Cette image peut être statique, ou animée. Dans les deux cas, 
vous apporterez beaucoup d’attention au produit de votre 
créativité, et ce chapitre vous aidera à ficeler celui-ci de la 
meilleure façon possible. Enfin, le montage vidéo, directement 
depuis Blender, sera succinctement évoqué, afin de compléter 
le tour d’horizon de cette suite à tout faire exceptionnelle 
qu’est ce logiciel.

SOMMAIRE

B Rendu d’images statiques

B Rendu d’animations

B Éditeur de séquences

MOTS-CLÉS

B Camera
B Lens
B Clipping
B Format
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B Anticrénelage
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B Glow
BWipe
B Composite Node Editor
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Quelques mots sur les caméras
Dans cet ouvrage, nous les avons employées mais sans chercher à en faire
un usage particulier. Pourtant, même si la caméra est l’un des objets les
plus simples de Blender, elle en est également l’un des plus importants :
un mauvais cadrage peut ruiner la meilleure des scènes.

Pour ajouter une caméra dans une scène, vous passerez soit par le menu
Add de l’en-tête de la vue 3D, soit par le raccourci [Espace]>Add, puis,
dans les deux cas, vous choisirez Camera. Vous pouvez avoir plusieurs
caméras dans votre scène, mais une seule est active et sera prise en
compte au moment du rendu.

Pour afficher la scène du point de vue de la caméra dans la vue 3D active,
utilisez la touche [0] du pavé numérique. Si vous souhaitez définir une
autre caméra comme étant la caméra active, sélectionnez la nouvelle
caméra, et utilisez la combinaison de touches [Ctrl]+[0] du pavé numérique.

Le panneau Camera, qui définit les propriétés d’une caméra dans le
menu Editing, touche [F9], est très simple.
• Lens : permet de définir l’objectif de la caméra. Par défaut, la valeur

est de 35 mm, mais vous pouvez l’augmenter pour zoomer, ou la
diminuer pour embrasser la scène d’un point de vue plus large.

• Clipping Start et Clipping End spécifient respectivement les distances
minimale et maximale entre lesquelles le rendu est effectué. Les
objets (ou portions d’objets) situés avant ou après ces distances
n’apparaîtront pas ou seront tronqués.

LE SAVIEZ-VOUS ?  
Chaque objet peut être une caméra

Vous pouvez faire le rendu de la scène du point de
vue de n’importe quel objet de votre scène en le
sélectionnant et en utilisant la combinaison de tou-
ches [Ctrl]+[0]. Le point de vue est alors défini par
l’origine de l’objet (son centre) et par son orienta-
tion (ses coordonnées RotX, RotY et RotZ).

3DS MAX   Les caméras cibles

Dans Blender, il n’y a pas de caméra cible à propre-
ment parler, mais il est très simple d’en mettre une
en place : insérez un objet de type Empty dans
votre scène ([Espace]>Add>Empty). Mainte-
nant, sélectionnez votre caméra et ajoutez (touche
[Maj] et bouton droit de la souris) l’objet
Empty à la sélection, dans cet ordre-là. Utilisez la
combinaison de touches [Ctrl]+[T] pour afficher
le menu Make Track et choisissez TrackTo
Constraint. Dans le panneau Constraints du
menu Object, touche [F7], de la caméra, vous
pouvez vérifier la contrainte de type Track To qui
a été mise en place par cette méthode.

ASTUCE   Perspective architecturale

La caméra de Blender vous permet, pour une position donnée de la caméra, de
déplacer le cadrage horizontalement ou verticalement grâce aux paramètres
Shift X et Y du panneau Camera. Cette fonction est particulièrement utile aux
utilisateurs de Blender spécialisés dans la visualisation architecturale ; elle leur
permet de spécifier un point de vue en déplaçant et en faisant tourner la caméra,
puis une fois trouvé le point de vue qui leur convient, de déterminer très facilement
le cadrage qui met le plus en valeur le projet architectural. Il s’agit également
d’une astuce utile pour un rendu classique, lorsque l’utilisateur souhaite faire sortir
du cadre un élément de premier plan indésirable.

Figure 9–1
Dans cette image, le cadrage a clairement été retouché (lignes en pointillé)

par rapport à la position de la caméra (ligne pleine) : normalement, les cadres
(pointillés et pleins) sont concentriques ; pour une position de caméra
donnée, l’architecte a ainsi la possibilité de recadrer le rendu pour une

meilleure visualisation de l’œuvre architecturale.
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• Orthographic : il s’agit d’un mode d’affichage particulier. Par défaut, la
caméra permet de visualiser la scène avec une perspective (les lignes
de fuite sont prises en compte). Avec cette option, il n’y a plus de
lignes de fuite et donc, plus de perspective.

Définir le format de vos œuvres
L’opération de rendu consiste à calculer une image ou une série
d’images. Si le contenu de l’image dépend de celui de la scène rendue, en
fonction de la géométrie des objets, de leurs matériaux et shaders, de
l’éclairage de la scène, et bien sûr de l’éventuelle animation de tout ou
partie des éléments précédents, le format de l’image (c’est-à-dire ses
dimensions et le type de fichier généré) relève de différents choix de
l’utilisateur, plus ou moins stratégiques. En règle générale, en fonction
de l’usage qui est prévu pour l’image ou l’animation rendue, vous aurez à
choisir tel ou tel autre format d’images, avec les dimensions appropriées.

Nous ne passerons pas en revue toutes les possibilités offertes par ce pan-
neau, trop nombreuses et souvent trop spécifiques. Nous nous attarde-
rons toutefois sur quelques options incontournables.

Dimensions de l’image rendue
Celles-ci sont définies par les deux boutons numériques SizeX et SizeY qui
représentent respectivement (en pixels) la largeur et la hauteur de l’image.
Sur le côté du panneau se trouvent toute une série de boutons qui permet-
tent d’accéder instantanément à des dimensions préréglées en fonction de
l’application future. Par exemple, Preview (640 × 512) convient à des tests
de rendu intermédiaires ; Default (720 × 576) et PC (640 × 480) sont des
formats dédiés aux images statiques ou à Internet. PAL (720 × 576, mais
avec un ratio d’image spécifique) et PAL 16:9 (720 × 576 avec encore un
autre ratio d’image) sont destinées à la production d’animations vidéo qui
seront aisément transférables sur DVD ; enfin, FULL (1280 × 1024)
permet d’effectuer un rendu très classique mais de grandes dimensions et
HD un rendu pour diffusion en haute définition (1920 × 1080).

Figure 9–2
Le panneau Format

ASTUCE   Le format Pano

Il s’agit d’un mode spécial prévu pour effectuer
des rendus panoramiques. Pour éviter des distor-
sions importantes de l’image, qui seraient dues à
une caméra incapable de réaliser des rendus dans
d’autres modes que Perspective et Orthogonal,
le rendu de l’image est réalisé par tranches de
faible largeur (16 tranches de 36 pixels par
défaut), qui sont assemblées bout à bout par
Blender, permettant au final l’obtention d’une
image panoramique de grande largeur. Idéal pour
les artistes dont la passion est la réalisation de
décors, à condition de ne pas oublier d’activer
l’option Pano dans le panneau Render.
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Format de l’image rendue
Un sélecteur de format (réglé par défaut sur JPEG) permet de choisir le format
informatique dans lequel sera enregistrée votre œuvre. Par exemple, pour le
rendu d’images statiques, les formats suivants sont supportés : TIFF, JPEG,
BMP, PNG, Targa et Targa Raw. Pour le rendu d’animations, les formats AVI
JPEG et AVI Raw sont les deux seuls formats disponibles en standard (sauf
pour la version Linux qui propose quantité d’autres formats ; les autres plates-
formes supporteront ces mêmes formats dans une version future). Dans cer-
tains cas, il est possible de sacrifier une partie de la qualité de l’image pour
alléger son « poids » en octets. C’est là le rôle du bouton numérique Quality,
par défaut réglé sur 90. À ce niveau de qualité, la compression des images de
format JPEG commence à être, par exemple, perceptible.

Le bouton numérique FPS (par défaut à 25) indique le nombre d’images
par seconde des animations rendues, sachant que 25 images par seconde
est le standard cinématographique de ces dernières années. Ce paramètre
est très important, car lorsque vous programmez une animation sous
Blender, votre échelle de temps est constituée de frames. Cela veut dire
que vous avez tout intérêt à choisir la valeur de ce paramètre au tout
début de vos travaux, car avec une vitesse d’animation de 10 images par
seconde, une animation déterminée sur 250 frames durera 25 secondes ;
de même, avec une vitesse de 25 images par seconde, la même animation
de 250 frames ne durera plus que 10 secondes. L’impact sur le rythme de
votre animation peut donc souffrir d’importants défauts de réalisation à
cause d’un mauvais paramétrage de ce bouton.

Se préparer à effectuer le rendu
Contrairement aux options de Format, les options présentées dans le
panneau Render vont avoir une influence sur le rendu de l’image ; la
scène est clairement définie, tant géométriquement qu’au niveau des
matériaux et de l’éclairage, mais au travers de ce panneau, il est possible
de passer des options supplémentaires au moteur de rendu, influant
directement sur ce qu’il va calculer, et donc, sur l’aspect visuel final.

ASTUCE   Les boutons BW et RGBA

Le bouton BW permet d’enregistrer l’image
rendue en noir et blanc (il serait plus juste de
parler de dégradés de gris). Il est important de
signaler que l’image est toujours rendue en cou-
leurs, et que seule la sortie est en noir et blanc.
Le bouton RGBA, pour sa part, permet d’enregis-
trer l’image en couleurs, tout à fait normalement.
La seule exception est que les éléments d’arrière-
plan (le World, en fait) seront ignorés à la sauve-
garde et remplacés par un fond transparent.

Figure 9–3
Le panneau Render
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Le plus gros bouton, intitulé RENDER, sert bien évidemment à effectuer
le rendu d’une image statique. Le même résultat peut être obtenu en uti-
lisant la touche raccourci [F12]. Juste en dessous se trouve un sélecteur
qui permet de choisir entre différents moteurs de rendu ; à ce jour, deux
options sont proposées : le moteur interne de Blender (Blender Internal)
et YafRay. D’autres moteurs viendront compléter cette liste dans le futur,
à mesure que Blender s’ouvre aux moteurs externes.

Les options de rendu
Choisir entre différentes options de rendu revient à faire des compromis
entre le réalisme d’une option et le temps de rendu. Si pour une image
statique, le temps de rendu peut ne pas être un critère contraignant, dans
le cadre d’une animation, de mauvais choix peuvent conduire à des ani-
mations impossibles à rendre sans faire appel à des moyens profession-
nels, comme les fermes de rendu. Plus vous activerez d’options, plus les
temps de rendu seront longs ; moins vous en activerez, moins les résul-
tats seront réalistes. Telle est la nature du compromis.
• Shadow : une scène sans ombre est souvent plate et totalement

irréaliste ; cette option, active par défaut, ne devrait pas être sup-
primée sans raison sérieuse.

• Env Map : il s’agit d’une méthode de tracé des objets à la surface réflé-
chissante, faisant appel au placage de textures précalculées pour
simuler la réflexion de l’environnement. Cette méthode est écono-
mique en temps de calcul par rapport au raytracing, mais terrible-
ment difficile à mettre en œuvre pour des utilisateurs débutants.
Cette méthode n’est pas couverte par le présent ouvrage, au profit du
raytracing que les performances des ordinateurs modernes rendent
accessible. À désactiver sauf si vous savez ce que vous faites.

• Ray : active les options de raytracing. À ce jour, permet au moteur
interne d’effectuer le tracé d’objets réfléchissants et/ou transparents
de façon réaliste. Les ombres des objets peuvent également faire
l’objet de raytracing, ajoutant à la simplicité du réglage des scènes.

ASTUCE   Prévisualisation du rendu dans la vue 3D

Il est possible de réaliser une prévisualisation du rendu dans la vue 3D en utilisant la combi-
naison de touches [Maj]+[P], qui appelle (et masque) un panneau flottant semi-transparent.
La scène 3D « masquée » par le panneau de prévisualisation est alors automatiquement
rendue, ce qui est très utile pour prévisualiser le résultat sur une partie seulement de la scène.
Il est possible de déplacer ou de redimensionner le panneau de prévisualisation grâce au
bouton gauche de la souris. Le rendu est mis à jour dès que la fenêtre est déplacée ou redi-
mensionnée, ou lorsque les propriétés des matériaux sont modifiées. Utilisez la combinaison
de touches [Maj]+[P] deux fois consécutives pour forcer un nouveau rendu.

ASTUCE   Rappeler la dernière image rendue

Même si vous avez (accidentellement ou volontai-
rement) fermé la fenêtre contenant l’image
rendue, elle est toujours disponible, que ce soit
pour consultation ou sauvegarde, dans la mémoire
de Blender. Pour la rappeler, il vous suffit
d’appuyer sur la touche [F11].

3DS MAX   Moteur de rendu Mental Ray 
pour le GI et les effets SSS

Mental Ray est un très bon moteur de rendu qui
supporte pleinement l’illumination globale et un
véritable effet de dispersion subsurfacique (Sub-
Surface Scattering, SSS). En ce qui concerne
Blender, il faut recourir à YafRay (ou un autre
moteur de rendu externe) pour bénéficier de l’illu-
mination globale, ou recourir au calcul d’une solu-
tion de radiosité. Le Surface Scattering, en
revanche, est mieux supporté par Blender, qui
intègre un panneau SSS dans les menus Material
buttons du menu Shading.
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Malheureusement, quelques petites fonctionnalités sont encore man-
quantes (caustiques, photons, illumination globale) et cette méthode
consomme énormément de temps de calcul. À activer de préférence,
sauf si vous savez ce que vous faites.

• Radio : active le calcul d’une solution de radiosité en guise de rendu
préliminaire. N’est utile que si vous avez choisi la radiosité comme
méthode d’illumination de vos scènes. Les temps de calcul peuvent
être considérablement allongés, en fonction de la finesse de la solu-
tion recherchée. À désactiver, sauf si vous recherchez explicitement
ce type d’éclairage.

• SSS : autorise le calcul des effets de Subsurface Scattering éventuelle-
ment spécifiés dans les Material Buttons du menu Shading [F5].

L’anticrénelage
Lorsqu’il effectue un rendu, le moteur détermine la couleur de chaque
pixel de l’image, mais un pixel donné ne pouvant avoir qu’une seule cou-
leur, on voit facilement apparaître des créneaux sur l’image, notamment
à la frontière des objets par rapport à l’arrière-plan. Par exemple, sur
l’image ci-dessous (grossissement × 2), le crénelage des arêtes est parti-
culièrement visible, surtout sur le fond blanc.

Mais Blender propose un mécanisme d’échantillonnage et de pondéra-
tion des couleurs par rapport aux pixels voisins, qui permet d’adoucir le
crénelage. Par exemple, sur l’image qui suit, l’anticrénelage a été poussé
au maximum des capacités de Blender (16 échantillons).

ASTUCE  Prévisualisations rapides

Vous pouvez réaliser des rendus intermédiaires de
vos scènes, au niveau de qualité souhaité, mais en
visant des images de dimensions inférieures. Pour
ne pas avoir à faire des allers-retours peut-être
néfastes dans le panneau Format, vous trouverez
dans le panneau Render des boutons déterminant
la taille de l’image rendue, en pourcentage de la
dimension spécifiée dans le panneau Format. Par
exemple, pour une prévisualisation rapide au format
timbre-poste, vous activerez le bouton 25 %.

Figure 9–4
Sans anticrénelage,

les arêtes sont très tranchées.

Figure 9–5
Avec l’anticrénelage,

les arêtes sont comme lissées.
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Pour bénéficier de l’anticrénelage, il faut activer le bouton OSA (Over-
SAmpling, ou suréchantillonnage) dans le panneau Render, et choisir le
nombre d’échantillons. Blender propose des valeurs préréglées : 5, 8, 11
et 16. Généralement, de bons résultats sont déjà obtenus avec la plus
basse valeur, mais il faut surtout signaler que les temps de rendu aug-
mentent considérablement à mesure que vous utilisez un plus grand
nombre d’échantillons !

Il existe plusieurs filtres pouvant s’appliquer à l’anticrénelage. Normale-
ment, lors d’une opération d’anticrénelage, chaque échantillon de cou-
leur, voisin du point rendu, a un poids identique par rapport aux autres,
et la combinaison de toutes les couleurs voisines donne au pixel rendu sa
couleur. Avec le filtre Gauss, chaque échantillon se voit attribuer un
poids variable (il s’agit du bouton numérique à droite du sélecteur de
filtre, par défaut 1.00) qui peut affecter les pixels voisins, produisant des
arêtes plus douces. Malheureusement, ce filtre a tendance à rendre floues
les textures des objets ; aussi d’autres filtres ont été ajoutés. En particu-
lier, Box donne de bons résultats. Il y a également la méthode CatRom, en
faveur auprès du studio d’animation Pixar, qui l’utilise dans son moteur
de rendu RenderMan.

Optimisation de l’espace de raytracing
Il est possible de modifier la quantité de mémoire réservée par le moteur
de rendu (Octree), en fonction de la taille de la scène, en unités de
Blender. Pour les scènes de dimensions très modestes, une résolution de
l’Octree de 64 (le minimum) conduira à de bonnes performances. Pour
des scènes de très grandes dimensions, une résolution de 512 (le
maximum) sera vraisemblablement nécessaire.

Augmenter la résolution de l’Octree conduit à une augmentation du
temps nécessaire au moteur pour préparer le rendu, mais cela lui permet
de l’optimiser et donc de l’accélérer. Toutefois, une valeur d’Octree trop
élevée, là où une petite résolution aurait suffit, peut conduire à un temps
de préparation de la scène supérieur au temps de rendu total avec une
faible valeur. De même, employer une faible résolution, là où une grande
résolution aurait été nécessaire, peut faire perdre un temps considérable
au moment du rendu. Trouver la bonne valeur d’Octree en fonction de la
taille de la scène est affaire d’expérience ; si cela n’a qu’une importance
limitée dans le cadre du rendu d’images statiques, pour le rendu d’ani-
mation, la diminution ou l’augmentation du temps de rendu global, en
fonction des valeurs de cette variable, peut s’avérer considérable.

ASTUCE   Option Full OSA

Cette option se cache dans les options de l’onglet
Material, et s’active individuellement pour
chaque matériau. Elle permet d’étendre l’anti-
aliasage au shading, aux textures et aux reflets
spéculaires. Bien entendu, les temps de rendu peu-
vent être augmentés de façon dramatique. Il con-
viendra donc de n’activer cette option que
parcimonieusement et que pour les objets en
ayant vraiment besoin.

Figure 9–6
Les options de filtrage de l’anticrénelage

Figure 9–7
Les différentes valeurs possibles 

pour la résolution de l’Octree
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Et pour enregistrer l’image rendue ?
Une fois l’image rendue, vous pouvez tranquillement la sauvegarder en
appuyant sur la touche [F3] ou, depuis le menu principal, en allant dans
File puis en choisissant Save Image... Notez bien que si vous n’avez pas
encore défini le format de fichier (JPEG, PNG, BMP...) ou sa qualité, par
exemple, il n’est pas trop tard : vous pouvez le définir a posteriori du
rendu. Inutile donc de recommencer celui-ci si vous vous apercevez ne
pas avoir spécifié le format souhaité.

Créer des animations
La longueur de l’animation est définie dans le panneau Anim grâce aux
boutons Sta et End, qui spécifient respectivement la frame de départ de
l’animation et la frame de fin. Comme nous l’avons déjà vu, lors de
l’encodage, il sera tenu compte de la vitesse d’animation, en frames par
seconde, spécifiée dans le panneau Format. En appuyant sur le bouton
ANIM, les images de l’animation seront calculées ; si le format défini est
celui d’une vidéo, celle-ci sera créée et encodée selon le format choisi
dans le répertoire défini par le premier champ du panneau Output (par
défaut /tmp/). Si le format défini correspond à un format d’image, les
images rendues seront numérotées selon la frame à laquelle elles corres-
pondent, puis également sauvées dans le répertoire /tmp/.

La dernière animation rendue peut être rejouée (entre les frames définies
par Sta et End) grâce au bouton PLAY.

Le bouton Do Sequence est à réserver au cas où vous avez inséré des tran-
sitions ou utilisé des greffons dans l’éditeur de séquences. Le bouton Do
Composite est à activer si vous souhaitez activer le post-traitement réalisé
au travers de l’éditeur de nœuds Composite.

ASTUCE   Une série d’images numérotées 
à la place d’une vidéo

Au lieu d’un format vidéo, Il est possible de choisir
un format (dans le panneau Format) propre aux
images statiques, comme JPEG ou PNG. Dans ce
cas, les images relatives à chaque frame de l’ani-
mation seront stockées dans le répertoire défini
par le premier champ du panneau Output (par
défaut /tmp/).

Figure 9–8
Le panneau Anim
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L’éditeur de séquences
L’éditeur de séquences est un outil très puissant, bien caché dans les
entrailles de Blender. Il est pourtant extrêmement polyvalent, et de par
ses capacités de post-traitement, il peut rendre de grands services aux
amateurs d’images statiques. Les animateurs l’apprécieront pour sa capa-
cité à pouvoir compiler des vidéos à partir d’images d’origine interne ou
externe, et à pouvoir assurer des transitions cinématiques d’une séquence
ou d’un plan à l’autre.

Blender propose en particulier un certain nombre d’effets incorporés,
ainsi que la possibilité d’utiliser des greffons (plug-ins) pour obtenir des
résultats particuliers ; les effets peuvent s’appliquer à un couple de
séquences ou une séquence seule, et aboutissent parfois à la création
d’une nouvelle séquence. Les effets disponibles sont très variés, et cer-
tains recoupent les fonctionnalités de l’éditeur de nœuds Composite, dont
l’éditeur de séquences est le digne et encore utile ancêtre. Si cela peut
amener certains à penser que cela rend l’éditeur de séquences obsolète, il
n’en est rien : la force de l’éditeur de nœuds Composite réside dans le
post-traitement et l’incrustation des images, tandis que celle de l’éditeur
de séquences réside dans le montage pur et dur, même si certaines fonc-
tions se retrouvent effectivement chez l’un comme chez l’autre.

Parmi les effets proposés par l’éditeur de séquences, on peut relever :
• Add, Substract, Multiply : ces effets permettent de prendre les couleurs

de deux séquences sélectionnées, et de respectivement ajouter, soustraire
ou multiplier les couleurs. Le second effet permet notamment de réa-
liser des effets d’inversion vidéo, tandis que le troisième, utilisé conjoin-
tement avec un masque noir et blanc, permet de réaliser un découpage
de type longue-vue ou jumelle sur l’image visualisée.

• Cross, Gamma Cross : ces effets très utiles permettent de réaliser le fondu
d’une séquence vers l’autre, basée sur le nombre d’images de recouvrement
des deux séquences sélectionnées. Gamma Cross produit une transition
plus douce à l’œil grâce à la correction de la couleur durant le processus.
Utilisés conjointement avec un effet de type Color Generator, ces effets
permettent de mettre aisément en place un fondu vers un écran noir.

• Alpha Over, Alpha Under, Alpha Over Drop : ces effets utilisent le canal
Alpha (transparence) des images pour produire des effets de compo-
sition. L’ordre de sélection des séquences est important : pour Alpha
Over, la deuxième séquence sélectionnée est positionnée par-dessus la
première ; de la même façon, pour Alpha Under, la deuxième
séquence est positionnée en dessous de la première. Alpha Over Drop
fonctionne de la même façon que l’effet Cross, à ceci près qu’il est
également en plus, capable de tenir compte du canal Alpha.
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• Wipe : permet la mise en place de transitions entre plusieurs
séquences, sachant qu’il existe plusieurs types de transition intégrés
en standard, ainsi qu’une quantité d’autres disponibles sous forme de
plug-ins.

• Glow : permet d’ajouter un effet de lueur à la séquence sélectionnée
en travaillant sur son canal de luminance.

• Transform : cet effet permet de redimensionner, décaler verticalement
ou horizontalement, ou faire pivoter l’image de la séquence. Il est
possible d’associer une courbe IPO à l’effet (bouton IPO Frame locked)
pour assurer une transition très douce.

• Color Generator : permet de créer une séquence d’une couleur donnée,
et de la redimensionner à votre guise.

• Speed Control : ce nœud sophistiqué permet de contrôler la vitesse
d’écoulement du temps au sein de la séquence, permettant donc de
l’accélérer ou de la ralentir.

Utilisation de l’effet Glow
Cet effet permet de rendre plus lumineuse une image rendue par Blender,
en magnifiant, dans certaines proportions (qui sont réglables), les zones
claires et en particulier les rehauts spéculaires. Nous allons voir comment
obtenir cet effet. Ouvrez le fichier exercice-ch09.01-depart.blend situé
dans les /exercices du DVD-Rom. L’écran principal est divisé en deux
parties : à gauche, la vue 3D et à droite, l’éditeur de séquences, vierge.
Effectuez immédiatement le rendu de la scène (touche [F12]).

Figure 9–9
Le rendu classique de la scène
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Nous allons concentrer toute notre attention sur l’éditeur de séquences.
Utilisez le menu Add pour ajouter un élément de type Scene. Une séquence
flottante verte apparaît : elle a une longueur égale à 250 frames, et il faut
que vous la déposiez à l’endroit de votre choix dans l’éditeur. Placez-la de
sorte à ce que sa première frame coïncide avec la frame n° 1.

Nous allons maintenant ajouter (toujours en utilisant le menu) un nouvel
effet de type Glow : Add>Effect>Glow. Une séquence flottante de couleur
vert kaki apparaît, qu’il vous faut également placer dans l’éditeur. Placez-
la au-dessus de la séquence de la scène, commençant aussi à la première
frame.

Sélectionnez la séquence de l’effet, et rendez-vous dans les Sequencer
Buttons, dans le menu Scene [F10]. Vous découvrez différents panneaux,
et en particulier le panneau Effect qui va nous intéresser.

Figure 9–10
Ajout d’une nouvelle scène grâce 
au menu Add>Scene

Figure 9–11
Un effet de type Glow se superpose 
à la scène, pour toute la durée 
de celle-ci.

Figure 9–12
Le panneau Effect montrant 
les paramètres de l’effet Glow
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Les propriétés de l’effet Glow
En quelques mots, voici la description des autres réglages de l’effet Glow.
• Threshold : l’intensité lumineuse à partir de laquelle l’effet Glow sera

mis en fonction ;
• Clamp : la limite d’intensité de la luminosité ;
• Boost factor : le multiplicateur de luminosité appliqué ;
• Blur distance : le rayon de l’effet Glow ;
• Quality : la précision de l’effet Glow ;
• Only boost : affiche la carte de luminosité composée avec l’image rendue.

L’effet est en place, mais nous ne savons pas encore si les réglages par
défaut nous apporteront satisfaction. Le seul moyen de s’en assurer est
d’effectuer le rendu de la scène : touche [F12]. Vous constaterez que le
rendu obtenu est strictement identique au rendu de base, comme si l’effet
n’avait pas été activé. C’est parce qu’il nous reste une dernière étape à
réaliser : valider les séquences et effets programmés dans l’éditeur de
séquences dans le panneau Anim des Render buttons, dans le menu Scene,
touche [F10] ; cela se fait simplement en activant le bouton Do Sequence.

Vous pouvez maintenant effectuer le rendu (touche [F12]) ; l’image qui
s’affiche en cours de calcul ne diffère en rien de celle rendue précédem-
ment, mais c’est normal : les effets sont ajoutés en phase de post-traite-
ment d’une image.

Figure 9–13
Activez le bouton Do Sequence

pour que la magie du séquenceur opère.

BON À SAVOIR  OpenEXR

Blender supporte le format OpenEXR. Les images
EXR sont des images HDR avec une plus grande pro-
fondeur de bits que les images HDR classiques ; le
format EXR a été développé par les célèbres studios
Industrial Light & Magic et est employé dans
toutes leurs productions actuelles. Avec ce format, il
est possible d’augmenter ou de diminuer considéra-
blement la luminosité des images, en minimisant la
perte de balance des couleurs initiales, par exemple
lors d’une manipulation de l’image au travers de
l’éditeur de nœuds Composite. Vous trouverez
plus d’informations sur le site officiel  :
B http://www.openexr.com/index.html

Figure 9–14
L’effet d’illumination est trop marqué,

mais il n’en demeure pas moins réussi !
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Tant que vous ne décocherez pas l’option Do Sequence, à chaque fois que
vous lancerez un rendu (touche [F12]), le moteur retiendra la dernière
image calculée, et se contentera d’effectuer un nouveau post-traitement.
Ainsi, pour diminuer l’intensité de l’effet, dans le panneau flottant des
propriétés de l’effet Glow, diminuez la valeur Boost factor à 0.200.
Appuyez sur la touche [F12], et constatez que l’image n’est pas
recalculée : seul le post-traitement, avec ses nouveaux paramètres, est à
nouveau appliqué. Cela vous permet de régler finement l’image finale
sans avoir à recommencer trop de fois le rendu complet.

Vous pouvez expérimenter les résultats obtenus dans le fichier exercice-
ch09.01-final.blend du DVD-Rom si vous le souhaitez.

Insertion d’une transition entre deux séquences
Un fichier Blender peut contenir différentes scènes, qui sont individuelle-
ment accessibles via la barre de menus principale, tout en haut de la
fenêtre. Un sélecteur de scènes permet de choisir parmi les scènes disponi-
bles du fichier, voire d’en créer de nouvelles ; la nouvelle scène peut être
totalement vierge ou contenir une scène basée sur une autre préexistante.

Si vous ouvrez le fichier exercice-ch09.02-depart.blend et que vous
cliquez sur le sélecteur de scènes, vous constaterez qu’il y a déjà deux
scènes existantes. Elles sont identiques, seul l’angle de la caméra diffère.
Pour apprendre le fonctionnement de l’éditeur de séquences, nous allons
rendre une animation du point de vue de chacune de ces deux scènes, et
les monter dans l’éditeur avec une transition progressive.

Figure 9–15
L’image finale ne manque pas de charme 
grâce à un effet très simple à mettre en place.

Figure 9–16
Le sélecteur de scènes de Blender
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L’écran principal est divisé en trois parties : à gauche, une vue 3D ; en
haut à droite, une vue IPO permettant de visualiser cette animation très
simple (la rotation du cube central de la scène) ; et enfin, en bas à droite,
l’éditeur de séquences.

Intéressons-nous tout de suite à celui-ci. Dans le menu Add de l’éditeur,
choisissez Scene et insérez la séquence correspondant à la première scène
Scene. La bande verte qui apparaît est pour l’instant flottante, et dotée
de flèches à chaque extrémité, portant respectivement la frame de début
de l’animation et la frame de fin. Déplacez la séquence jusqu’à ce que la
flèche de gauche indique un début d’animation en frame 1, et utilisez le
bouton gauche de la souris pour valider la position.

Recommencez avec la seconde scène nommée Scene-bis et déplacez-la
de sorte qu’elle commence à la frame 81.

Cliquez avec le bouton droit de la souris sur la flèche à droite de la
séquence Scene : le numéro de sa dernière frame apparaît. Déplacez la
souris pour amener la flèche à la frame 125, et validez l’opération grâce

BON À SAVOIR   Création d’une nouvelle scène

Pour créer une nouvelle scène, cliquez sur le sélecteur, et choisissez ADD NEW. Les options
qui s’offrent à vous sont les suivantes.
• Empty : la nouvelle scène est totalement vide, vous démarrez de zéro.
• Link Objects : la nouvelle scène est une copie de la scène d’origine. Si ultérieurement,

vous apportez des modifications à la scène d’origine (modification de la géométrie au
niveau du maillage, ou transformations géométriques au niveau de l’objet), ces modifica-
tions seront répercutées sur la copie de scène.

• Link ObData : la nouvelle scène est également une copie de la scène d’origine. Toutefois,
si vous modifiez la scène d’origine, seules les modifications apportées à la géométrie des
objets, au niveau du maillage, seront répercutées sur la copie de la scène. Les transforma-
tions géométriques au niveau de l’objet (rotation, translation ou mise à échelle hors du
mode Edit) ne seront pas répercutées.

• Full Copy : la nouvelle scène est une copie intégrale et indépendante de la scène d’ori-
gine. Vous pouvez modifier celle-ci de la façon qu’il vous plaira, aucune de ces modifica-
tions n’étant répercutées dans la copie.

BON À SAVOIR   Quelques raccourcis clavier 
pour l’édition des séquences

• [Maj]+[A] : permet d’ajouter un élément,
comme au travers du menu Add.

• [Maj]+[S] : permet d’aligner le début de la
séquence sur la frame courante (barre verticale
verte).

• [X] : supprime la séquence.
• [Maj]+[D] : copie une séquence et permet

de la positionner horizontalement et verticale-
ment.

• [B] : permet de tracer une boîte de sélection
(bouton gauche) ou de désélection (bouton
droit).

• [M] : crée une « métaséquence » à partir de
plusieurs séquences sélectionnées. Elles ne doi-
vent être liées à aucun effet pour pouvoir être
amalgamées. La combinaison de touches
[Alt]+[M] inverse l’opération.

Avec une extrémité fléchée sélectionnée, vous
pouvez utiliser les raccourcis clavier suivants.

• [C] : permet de déplacer la frame courante
(barre verticale verte) sur l’extrémité fléchée
sélectionnée.

• [G] : permet de déplacer horizontalement
l’extrémité fléchée sélectionnée.

Figure 9–17
Les deux scènes principales

ont été mises en place.
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au bouton gauche de la souris. Procédez de même avec la scène Scene-bis
en ramenant sa dernière frame à la frame 201. Dans les deux cas, l’espace
théorique de la séquence d’origine apparaît sous la forme d’une bande
légèrement transparente de la même couleur que la séquence.

Nous allons maintenant ajouter la transition. Sélectionnez les deux
scènes, soit en activant une boîte de sélection grâce à la touche [B], soit
en sélectionnant une scène (bouton droit de la souris) et en ajoutant
l’autre à la sélection (touche [Ctrl] et bouton droit de la souris). Dans le
menu Add, choisissez alors Effect puis Wipe. Une séquence flottante
brun-orangé fait son apparition. Vous ne pouvez la déplacer que vertica-
lement, car ses frames de départ de fin coïncident automatiquement avec
les frames de chevauchement entre les deux séquence Scene et Scene-
bis. Après avoir placé la séquence flottante, validez sa position grâce au
bouton gauche de la souris.

Avec la séquence Wipe sélectionnée, rendez-vous dans les Sequencer But-
tons du menu Scene [F10] pour afficher son panneau Effects. Vous pouvez
y choisir le type de transition (par défaut, Single Wipe, qui correspond à
un balayage simple) et la dimension de la zone floue lors de la transition
entre les deux séquences. En option, vous pouvez définir l’Angle du balai
de transition : 0.00 pour un balai horizontal (par défaut) et 90.00 pour
un balai vertical, par exemple. Enfin, l’option Wipe In permet d’inverser
la direction de balayage. Conservez tous les paramètres par défaut, à

Figure 9–18
Les deux scènes ont été amputées 
des séquences n’intéressant 
pas le metteur en scène.

BON À SAVOIR  
Les scènes et les paramètres de rendu

Chaque scène a ses propres paramètres de rendu,
indépendants. Prenez donc garde à les régler con-
formément à vos souhaits dans chaque scène. Une
remarque toutefois sur la dimension des images :
si elle n’est pas spécifiée de façon identique dans
les deux scènes, Blender ajustera les dimensions
de la plus grande à celles de la plus petite, pour
garantir un format unique pour la vidéo finale.

Figure 9–19
La séquence de transition 
est automatiquement dimensionnée 
en fonction du nombre de frames 
de recouvrement entre les deux séquences.
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l’exception de Blur que vous porterez à 0.35, afin que la frontière de tran-
sition soit légèrement floue.

Dans le panneau Anim des Render buttons, dans le menu Scene,
touche [F10], activez le bouton Do Sequence. Choisissez un répertoire où
seront stockées les images résultantes de l’animation (premier champ de
l’onglet Output, par défaut /tmp/). Dans l’onglet Format, choisissez JPEG
(Quality: 95) ou AVI JPEG, puis dans le panneau Anim, appuyez sur le
bouton ANIM. Lorsque le calcul de l’animation sera terminée, utilisez le
bouton PLAY pour la visualiser en boucle.

Vous pourrez observer le montage réalisé dans le cadre du fichier
exercice-ch09.02-final.blend.

Figure 9–20
Le panneau flottant

des propriétés de l’effet Wipe

ASTUCE   L’effet Glow sur une transition

L’effet Glow doit être ajouté individuellement à
chaque séquence : sélectionnez celle-ci, puis dans le
menu choisissez Add>Effect>Glow. Mais,
lorsque vous utilisez une transition (Add>Effect>
Wipe), celle-ci est en fait une troisième séquence
composée à partir des frames de recouvrement des
deux autres, ce qui veut dire que vous devez égale-
ment lui attribuer l’effet Glow. Sinon, vous obser-
verez la première séquence correctement illuminée,
puis une transition sans illumination supplémen-
taire, et enfin la seconde séquence, également cor-
rectement illuminée. Voir le fichier exercice-
ch09.02-glow.blend sur le DVD-Rom.

Figure 9–21
Le résultat de l’animation

avec la transition (horizontale)
en cours d’action
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Les calques de rendu (Render Layers)
Après une refonte en profondeur, le moteur de rendu de Blender est très
modulaire et facilite la création de greffons visant à l’intégration d’autres
moteurs de rendu. L’un des bénéfices immédiats de cette refonte réside
en la mise en place de calques de rendu, qui permettent notamment de
réaliser des rendus par passes (c’est-à-dire de n’effectuer le rendu que
d’un type d’information, comme la couleur, les ombres ou les reflets, par
exemple). Cette fonctionnalité passionne les puristes qui aiment com-
biner, parfois de façon très subtile, les différentes passes dans leur éditeur
d’images favori, tel que Gimp ou l’éditeur de nœuds Composite.

L’onglet Render Layers est disponible dans le menu Scene, touche [F10].

Les calques de rendu
En haut de l’onglet figure la catégorie Scene, qui permet de déterminer
les calques qui figureront sur le rendu final. Un clic gauche de la souris
permet d’activer un calque, tandis que la combinaison de touches
[Maj]+clic gauche permet d’ajouter ou d’enlever des calques à la sélection.
Les opérations réalisées ici se répercutent également sur les boutons de
calque affichés dans l’en-tête de la vue 3D.

ASTUCE   Compiler une série d’images en vidéo AVI

Si vous avez une série d’images (par exemple, suite au rendu d’une animation au format JPEG) et
que vous souhaitez compiler celles-ci en une vidéo, il vous suffit d’ouvrir une nouvelle session de
Blender ou d’initialiser celui-ci grâce à la combinaison de touches [Ctrl]+[X]. Ouvrez l’éditeur
de séquences. Dans le menu Add, choisissez Images. Le sélecteur de fichiers s’ouvre, naviguez
jusqu’à l’emplacement de vos images (par exemple, le répertoire /tmp/) et avec le bouton
droit de la souris, sélectionnez toutes les images à inclure dans la vidéo. Normalement, elles
sont numérotées en fonction de la frame qu’elles représentent. Une fois la sélection effectuée,
cliquez sur le bouton Select File pour revenir dans l’éditeur, avec une séquence bleue à posi-
tionner sur la frame 1. Dans le panneau Format, choisissez AVI JPEG et Quality: 95. Dans
le panneau Anim, activez Do Sequence et appuyez sur le bouton ANIM. Vous retrouverez la
vidéo « compilée » dans le répertoire défini par le panneau Output.

Figure 9–22
L’onglet Render Layers

BON À SAVOIR   Un peu perdu ?

Le moteur de rendu permet de mettre en place un
nombre illimité de calques de rendu, et pour chacun
de ces calques, de définir un certain nombre de
passes. Pour résumer, le calque de rendu va définir
les objets à prendre en considération, et les passes
vont enregistrer dans des images différentes le
résultat du rendu (shading de ces objets).
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Par défaut, un calque permettant l’obtention d’un rendu classique figure
déjà sous le nom RenderLayer, précédé du chiffre 1 (c’est le premier
calque de rendu). Nous vous suggérons de ne pas modifier ni supprimer
celui-ci, car il sera plus facile de revenir en arrière si vous ne parvenez pas
aux résultats escomptés et préférez, finalement, revenir aux rendus clas-
siques et annuler vos modifications.

En revanche, le bouton ascenseur situé sur la gauche permet de sélec-
tionner un autre calque de rendu déjà disponible, ou d’en ajouter un
nouveau grâce à l’option ADD NEW. Dans ce dernier cas, un deuxième
calque de rendu apparaît, précédé du chiffre 2. Par défaut, il se nomme
également RenderLayer, mais vous pouvez le renommer en cliquant sur
sur nom avec le bouton gauche de la souris. Toutes les options situées en
dessous (les calques de la section Layer, mais aussi les options de rendu et
les passes) se rapportent exclusivement à ce calque de rendu.

ASTUCE   Gestion des calques de rendu

Il est possible d’activer ou de désactiver un calque de rendu (déterminant sa disponibilité ou non
dans l’éditeur de nœuds Composite) grâce à la coche située à l’extrémité gauche du menu
déroulant des calques de rendu. À l’autre extrémité, un bouton présentant une croix permet de
supprimer le calque de rendu courant. Lors du rendu, tous les calques sont normalement com-
binés, éventuellement en se conformant aux manipulations réalisées dans l’éditeur de nœuds
Composite. Mais en cochant le bouton Single, seul le calque de rendu courant est calculé. Par
exemple, cela permet d’effectuer un rendu ne montrant que la passe d’occlusion ambiante.

Figure 9–23 Le bouton Single permet de ne rendre que le calque sélectionné ; ici la 
passe Combined a été désactivée, et AO activée, résultant en une image ne présentant 
que l’influence de l’occlusion ambiante.
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Les options des masques de rendu
Pour chaque calque de rendu, vous pouvez définir les calques de la scène à
prendre en compte. Par défaut, tous les calques sont actifs dans la section
Layer, mais vous pouvez activer ou désactiver tout ou partie des calques
comme d’habitude (clic gauche pour sélectionner, touche [Maj] et clic
gauche pour ajouter ou enlever à la sélection). Cela permet notamment de
définir aisément, lors d’un rendu, un calque de rendu pour les éléments de
premier plan (les personnages) et un autre pour les éléments d’arrière-
plan (le décor), mais cela n’est qu’un exemple parmi bien des stratégies.

Pour chaque calque de rendu, il est possible de déterminer ce qui sera
intégré au calcul de l’image, ou de forcer l’usage de groupes de lampes ou
de matériaux grâce aux champs Light et Mat.
• Solid : activer cette option permet d’effectuer le rendu des facettes.
• Halo : activer cette option permet d’effectuer le rendu des halos lumi-

neux (pour les matériaux utilisant l’option Halo du panneau Links and
Pipeline, dans les Material buttons du menu Shading, touche [F5]). Les
halos seront affichés par-dessus les facettes du mode Solid.

• ZTra : activer cette option permet d’effectuer le rendu des facettes
transparentes utilisant le tampon de profondeur (pour les matériaux
utilisant l’option ZTransp du panneau Links and Pipeline, dans les Mate-
rial buttons du menu Shading, touche [F5]). Les facettes transparentes
seront affichées par-dessus les facettes du mode Solid et les halos.

• Sky : activer cette option permet d’effectuer le rendu du ciel (défini dans
les World buttons, menu Shading, touche [F5]) ou de l’image tampon
d’arrière-plan (définie dans le champ //backbuf du panneau Output des
Render buttons, menu Scene, touche [F10], avec le bouton Backbuf actif ).

• Edge : activer cette option permet d’effectuer le rendu des arêtes dans
le cadre d’un rendu de type Toon.

Les passes
Nous savons désormais ce que nous allons inclure dans le calcul de nos
images, du point de vue des éléments constitutifs de nos scènes (objets,
matériaux, arrière-plans, lumières, etc.). Il ne nous reste plus qu’à voir les
différentes méthodes de shading que le rendu par passes permet d’isoler.
• Combined : c’est l’option par défaut, qui combine automatiquement

toutes les passes possibles, avec toutes les options Halo et Edges comprises.
Le résultat est une image RGBA (c’est-à-dire avec un fond transparent).

• Z : stocke dans chaque pixel de l’image la distance du point rendu par
rapport à la caméra, en unités internes de Blender. L’image résul-
tante, en dégradés de gris, n’est jamais anticrénelée.

ASTUCE   Forçage par un groupe 
de lumières ou un matériau

Pour un calque de rendu, il est possible de forcer la
scène à utiliser un groupe de lumières ou un maté-
riau spécifique. Il suffit alors de spécifier un nom
de groupe ou de matériau dans l’un et/ou l’autre
des champs Light et Material. Prenez garde à
saisir le nom exact (casse comprise) des éléments
utilisés pour le forçage, sinon votre saisie sera
rejetée.
• Light : permet de spécifier le nom d’un

Groupe ; ce calque de rendu ne prendra en
compte, lors du calcul de l’image, que des
lampes présentes dans ce groupe, ce qui est
utile pour rendre différents calques (chacun
avec ses passes) avec différentes lampes, en
vue de la réalisation d’un montage ultérieur
(Gimp ou éditeur de nœuds Composite).

• Material : permet de spécifier le nom d’un
matériau ; ce calque de rendu ne prendra en
compte, lors du calcul de l’image, que ce maté-
riau-là, en l’attribuant à toutes les facettes de
la scène, ce qui peut être utile pour la création
de masques, grâce à des textures en coordon-
nées globales.
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• Vec : donne accès aux vecteurs de vitesse pour la simulation du flou de
vitesse grâce au Vector Blur.

• Nor : effectue le rendu des normales.
• UV : pour les objets possédant des facettes pour lesquelles des coor-

données UV ont été communiquées, cette passe inscrit les valeurs UV
correspondantes.

• IndexOb : à chaque objet peut être attribué un numéro d’indice (pan-
neau Object and Links, Object buttons, menu Object, touche [F7]) grâce
au bouton numérique PassIndex. L’indice d’un objet peut être rendu
dans une passe, ce qui peut être utile pour la création de masques
pour les montages vidéo.

• Col : cette passe stocke la couleur RGB (définie par le matériau et/ou
la texture) des objets, sans tenir compte du shading (un peu comme
s’ils étaient rendus avec l’option Shadeless).

• Diff : comme précédemment, sauf que le shading des objets est pris en
compte, mais pas les ombres, les reflets spéculaires ou la couleur
ambiante. La couleur des rampes est également prise en compte.

• Spec : cette passe stocke les reflets spéculaires des objets, en tenant
compte des ombres éventuelles qui annuleraient ces reflets.

• Shad : cette passe stocke les ombres des objets. Attention : elle est
obtenue en divisant la couleur diffuse avec ombres par la couleur dif-
fuse sans ombres. Il est nécessaire de multiplier (Multiply) cette passe
avec la passe Diff pour les combiner.

• AO : cette passe stocke le résultat brut de la simulation d’occlusion
ambiante, sans tenir compte des ombres ou du shading propre des objets,
pas plus que de la méthode d’utilisation de l’AO (Add, Sub, Both).

• Refl : cette passe stocke les reflets (raytracing ou Envmap). Attention :
elle est obtenue par soustraction de la couleur diffuse avec et sans
reflets. En conséquence, lorsque l’on visualise cette passe seule, il est
possible d’observer des couleurs négatives ! Il est nécessaire d’addi-
tionner (Add) cette passe avec la passe Diff pour les combiner.

• Refr : comme précédemment, sauf que ce sont les réfractions (raytra-
cing) qui sont stockées. De même, cette passe est obtenue par sous-
traction de la couleur diffuse avec et sans réfraction, résultant aussi en
une passe pouvant présenter des couleurs négatives. Il est nécessaire
d’additionner (Add) cette passe avec la passe Diff pour les combiner.

Lorsque vous effectuez un rendu par passes, vous ne souhaitez peut-être
pas inclure toutes les passes dans l’image combinée (option Combined)
mais en réserver certaines à un usage spécifique, dans l’éditeur de nœuds
Composite, par exemple. Certaines passes (celles présentant un gros point
gris) peuvent être activées ou non pour l’option Combined, en cliquant
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dessus tout en maintenant appuyée la touche [Ctrl] ; lorsqu’une passe est
exclue de l’image combinée, elle présente un gros point noir à la place du
gros point gris.

Vous noterez que l’Outliner permet également de visualiser les calques de
rendu et les passes, de déterminer les calques actifs et de spécifier les
passes combinées ou non à l’aide d’un simple clic avec le bouton gauche
de la souris.

L’éditeur de nœuds Composite
L’éditeur de nœuds Composite permet de mettre en place des procédures
de post-traitement, de montage et d’effets spéciaux automatisées direc-
tement par Blender, immédiatement après le rendu de l’image. L’inté-
gration est telle que l’on pourrait croire le résultat comme étant le fruit
du rendu, mais il n’en est rien : il s’agit bel et bien d’effets à rapprocher
du traitement et de la retouche d’images.

Les étapes de la création de nœuds Composite sont résumées ci-dessous.
De façon générale, l’éditeur de nœuds Composite fonctionne de la même
façon que l’éditeur de nœuds matériaux.
1 Allez dans le menu Scene, touche [F10], et dans le panneau Anim,

activez le bouton Do Composite.
2 Transformez l’une des vues en Node Editor en cliquant sur l’icône de

changement de type de vue, dans l’en-tête de la vue principale. Un
écran gris et quadrillé fait son apparition, mais il est pour l’instant
vide. Dans son en-tête se trouvent deux icônes : la première permet
l’édition de nœuds définissant des matériaux, la seconde l’édition des
nœuds définissant des effets de composition. Activez la seconde puis
cliquez sur le bouton Use Nodes, également dans l’en-tête.

Figure 9–24
Visualisation des calques de rendu 
dans l’Outliner, avec possibilité d’activer 
ou désactiver passes et calques

Figure 9–25
Le panneau Anim

Figure 9–26
Activation des nœuds Composite
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Deux nœuds ont normalement fait leur apparition : un nœud de type
Render Layers (permettant de définir le masque de rendu à affecter à cette
branche du nœud Composite, mais aussi de lancer un rendu en cliquant
sur l’icône appropriée), et un autre de type Composite (permettant de
visualiser en temps réel le résultat du réseau de nœuds). Comme les
nœuds matériaux, les nœuds Composite disposent chacun de connecteurs
d’entrée en bas à gauche, et de sortie en haut à droite. Ces connecteurs
sont de couleurs différentes, en fonction du type de liaison qu’ils
admettent : jaune (une image), bleu (un vecteur, Normal ou Speed), gris
(une valeur numérique, Alpha ou Z).

Il n’y a guère de différence avec l’éditeur de nœuds matériaux : vous
pouvez insérer autant de nœuds que nécessaire grâce à la touche [Espace]
qui appelle le menu Add, en fonction des traitements que vous souhaitez
mettre en place. Ci-dessous sont décrits quelques-uns des principaux
nœuds disponibles pour l’éditeur, mais ils ne se limitent pas à ceux-ci,

ASTUCE   L’éditeur UV/Image 
à la rescousse des nœuds trop petits

Mettre en place une vue de type UV/Image Editor est souvent utile : dans
l’en-tête, utilisez le sélecteur de fichier pour faire apparaître la liste des
images disponibles, et sélectionnez Viewer Node. En plus d’apparaître
dans le nœud Viewer, la prévisualisation de la branche de nœuds se fera
également dans l’éditeur UV/Image, ce qui se révélera plus pratique. Seul le
Viewer actif (celui avec un point rouge) sera affiché dans cette vue.

Figure 9–27
Le résultat obtenu dans un quelconque Viewer
peut également être affiché, en grand format,

dans l’éditeur UV/Image.

Figure 9–28
Les connecteurs des nœuds Composite se

présentent comme ceux des nœuds matériaux.
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surtout dans les dernières versions de Blender qui en proposent de nom-
breux autres, parfois très spécialisés ; d’autres sont présentés plus longue-
ment dans ce même chapitre et ne sont pas repris ici (ceux de la
catégorie Matte, par exemple).
• Input :

– Image : ce nœud définit une image (aux formats habituellement
supportés) qui peut être réutilisée dans le réseau nodal. L’image
peut avoir n’importe quelle source et, typiquement, il peut s’agir
d’un arrière-plan de type matte-painting.

– Texture : ce nœud permet d’utiliser des textures, pour créer des
transitions, par exemple.

• Output :
– Viewer : ce nœud peut être placé n’importe où dans un réseau pour

observer le résultat d’une branche particulière. L’image du Viewer
actif peut être affichée dans l’éditeur UV/Image, le Viewer actif
étant marqué d’un point rouge.

– Composite : ce nœud définit la sortie finale du rendu, conformé-
ment aux paramètres précisés dans le menu Scene, touche [F10].

• Color :
– RGB Curves : ce nœud affiche une interface graphique permettant

d’ajuster la luminosité générale de la branche nodale, ainsi que les
canaux individuels de couleur R, G et B.

– Mix : ce nœud prend deux images et les mélange proportionnelle-
ment à la valeur Fac. L’image de base est celle connectée à la pre-
mière entrée (celle du haut), elle est modifiée par l’image
connectée à la seconde entrée (celle du bas). Une valeur Fac nulle
implique qu’aucune opération n’est réalisée. Outre Mix, plusieurs
opérations sont possibles et disponibles dans un menu déroulant.

– AlphaOver : la première image (entrée du haut) fonctionne comme
arrière-plan, et la seconde entrée correspond à l’image à fond
transparent qui lui est superposée. La valeur Fac indique dans
quelle proportion la seconde image est visible par-dessus la pre-
mière. Lorsqu’une image sur fond transparent présente une fron-
tière apparente, activer l’option ConvertPremul se révélera utile pour
en limiter les effets disgracieux.

– Z Combine : ce nœud permet de trier les pixels en provenance de
deux images sources, et de les combiner en une seule image tenant
compte de la profondeur Z de chaque pixel.

– Bright/Contrast : ce nœud permet de corriger la luminosité et le
contraste de l’image qu’il reçoit en entrée.
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– Tone Map : pour la conversion d’images HDR en images LDR,
tout en gardant le contrôle sur l’intensité lumineuse et le contraste.

• Vector :
– Mapvalue : ce nœud est utilisé pour borner, translater, ou redimen-

sionner une valeur.
• Filter :

– Filter : ce nœud permet d’appliquer des filtres à l’image d’entrée (en
particulier Sharpen et Soften, mais aussi divers filtres de détection
de contour comme Laplace ou Sobel).

– Blur : ce nœud permet d’appliquer du flou à l’image d’entrée, en
spécifiant l’échantillonnage dans les directions X et Y. L’option
Bokeh effectue pour chaque pixel la moyenne des pixels avoisi-
nants, mais cela requiert plus de temps de calcul (les meilleurs
résultats sont obtenus avec le filtre flat, d’autres filtres devant être
développés dans le futur).

– Defocus : ce nœud est spécifique à la mise en place d’un champ de
profondeur (flou focal) en fonction de la profondeur Z des pixels
d’une image. En guise de profondeur, il admet également toute
image externe en niveaux de gris, ce qui peut permettre la mise en
place d’un flou très localisé.

– Dilate/Erode : ce nœud permet de dilater ou d’éroder une image en
comparant chaque pixel à son environnement et en retenant les
valeurs minimale et maximale. Une valeur positive dilate l’image,
une valeur négative la rétrécit. Concrètement, ce nœud trouve une
application directe dans le nettoyage des images sources dans le cas
d’incrustation d’images sur fond vert.

– Glare : ce nœud peut être utilisé pour ajouter des effets lumineux
supplémentaires dans les scènes, afin de simuler les éclats lumi-
neux. Il fonctionne particulièrement bien sur des images HDR,
dont les taches spéculaires sont isolées grâce au seuil Threshold.
Différents modes sont disponibles, en fonction du type d’éclat
lumineux simulé.

– Bilateral Blur : ce nœud est employé pour produire des flous adapta-
tifs de grande qualité, idéal pour le lissage des rendus granuleux de
l’occlusion ambiante, la simulation des réflexions et réfractions
floues, ou encore les ombres floues sans passer par les fonctions
dédiées de Blender, lentes au rendu.

• Convertor :
– ColorRamp : ce nœud convertit une valeur en couleur RGBA au

moyen d’une rampe, pour laquelle la méthode d’édition ne diffère
pas des rampes classiques de Blender.
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– RGBtoBW : ce nœud permet de convertir une image couleur en
image « noir et blanc » (en niveaux de gris).

– SetAlpha : ce nœud sert à spécifier le taux de transparence d’une
image. Il fonctionne particulièrement bien avec des masques pour
en rendre transparentes des zones particulières (bords des objets).

– ID Mask : ce nœud convertit le paramètre PassIndex d’un objet sous
forme de masque.

• Distort :
– Displace : ce nœud déplace les pixels d’une image en fonction des

informations contenues dans une autre image. Il peut s’agir d’une
image en dégradés de gris (peinte ou procédurale), d’un canal
Vector, ou d’une image RGB, comme une passe Normal qui dépla-
cera les pixels dans la direction normale. Utile pour la simulation
de la distorsion du paysage derrière un rideau de chaleur (désert...)
ou de la réfraction des objets, en particulier lorsqu’un objet trans-
parent est placé en premier plan par rapport à une scène filmée sur
écran vert avec de vrais acteurs.

– UV Map : ce nœud utilise les coordonnées UV stockées dans une
passe de rendu pour replaquer des textures directement dans l’édi-
teur de nœuds Composite.

– Translate : ce nœud permet de translater verticalement ou horizon-
talement une image.

– Lens Distorsion : permet de simuler différents effets de distorsion
(effet de tonneau ou de coussin sur l’image, dispersion chroma-
tique) présentés par les lentilles de certains appareils photographi-
ques.

• Group : grâce à la combinaison de touches [Ctrl]+[G], vous pouvez ras-
sembler plusieurs nœuds au sein d’un même groupe ; celui-ci devient
alors accessible au travers du menu Add>Groups et peut être réutilisé à
volonté dans le réseau nodal.

Quelques exemples d’usage des nœuds Composite 
et des Render Layers
L’usage des Render Layers et de l’éditeur de nœuds Composite est à
réserver aux utilisateurs de Blender qui ont un minimum d’expérience et/
ou de solides notions de montage (compositing) d’images. Son usage est
quasiment illimité, allant de l’incrustation d’effets spéciaux à la réalisation
de montages complexes (animés ou non). Nous détaillerons ici quelques
applications utiles, accessibles à des utilisateurs compétents et ayant au
moins saisi les bases des Render Layers et de l’éditeur de nœuds matériaux.

BON À SAVOIR   Les nœuds et le crénelage

Lorsqu’il détermine un masque, une carte UV ou le
tampon de profondeur, entre autres, seul un
échantillon est stocké par Blender dans chaque
pixel. Il en résulte que ces informations ne sont
jamais anticrénelées (à l’exception des nœuds
Z Combine et ID Mask qui intègrent une rou-
tine de post-traitement qui interpole les informa-
tions manquantes). Le seul moyen d’obtenir des
bords anticrénelés est alors de rendre flous ceux-
ci. Diverses techniques existent ; l’une d’entre
elles, rapide à mettre en œuvre, consiste à utiliser
le nœud Dilate/Erode pour éroder le masque sur
une itération, puis le nœud Blur pour le rendre
légèrement flou.
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Mélanger rendu réaliste et rendu Toon dans la même image
Dans l’exercice qui suit, nous allons en rester à quelque chose de volon-
tairement très simple, afin de rendre accessibles les bases du rendu par
passes. En effet, nous allons voir comment mêler dans le même rendu un
style Toon et un style plus réaliste.

Ouvrez le fichier exercice-ch09.03-depart.blend du répertoire
/exercices et prenez connaissance de son contenu. La scène est très
simple : un cube constitue une pièce étroite, un autre cube, plus petit,
sert de présentoir à une tête de singe. Deux sphères occupent le premier
plan, tandis que l’éclairage est assuré par trois lampes identiques.

L’objectif de l’exercice est le suivant : effectuer de façon sélective un
rendu Toon sur la tête de singe à l’exclusion de tous les autres objets, qui
respecteront un style plus réaliste. La pièce aura donc un matériau avec
une texture de damier simple, le présentoir restera le matériau par défaut
de Blender, la tête de singe fera appel aux shaders diffus et spéculaires de
type Toon, et enfin, l’une des sphères sera une boule de verre tandis que
l’autre sera une boule réflective dorée.

Commencez par sélectionner la tête de singe avec le bouton droit de la
souris. Appuyez sur la touche [M] et sélectionnez (bouton gauche) le
deuxième calque avant de cliquer sur OK : la tête de singe est désormais
sur le deuxième calque et a logiquement disparu de la vue 3D. Dans l’en-
tête de celle-ci, activez ce deuxième calque en cliquant sur la deuxième

Figure 9–29 Notre terrain d’expérimentation, rendu avec le matériau par défaut de Blender
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case (bouton gauche) tout en maintenant la touche [Maj] appuyée : le
premier et le deuxième calques sont désormais affichés dans la vue 3D,
et la tête de singe a réapparu.

Normalement, les panneaux du menu Scene sont affichés dans la partie infé-
rieure de l’écran ; si ce n’est pas le cas, la touche [F10] y remédiera. Activez le
panneau Output en cliquant sur le titre de l’onglet. Activez le bouton Edge,
et cliquez sur Edge Settings : un panneau flottant apparaît. Saisissez une
valeur de 35 pour Eint ; cela détermine la proportion d’arêtes prises en
compte par Blender pour le tracé des silhouettes lors du rendu Toon.

Retournez maintenant dans le panneau Render Layers. Normalement, dans
la section Scene, les deux premiers calques doivent être actifs. Cliquez sur
le nom du premier calque de rendu (1 Render Layer) et remplacez-le par
quelque chose de plus explicite, comme 1 Arriere Plan. Juste en dessous
du nom, cliquez sur le premier calque, pour n’activer que celui-ci, car nous
souhaitons que le premier calque de rendu ne prenne en compte que les
éléments situés sur le premier calque de la scène. Parmi les options de
rendu, désactivez Edge, car nous ne souhaitons pas que le décor soit rendu
dans un style Toon, mais bien dans un style réaliste.

Cliquez maintenant sur le bouton ascenseur à gauche du nom du calque
de rendu, et choisissez ADD NEW pour en créer un nouveau. Modifiez tout
de suite son nom, par exemple : 2 Sujet Toon. Juste en dessous, dans la
section Layer, cliquez sur le deuxième calque, pour n’activer que celui-ci,
car nous souhaitons que ce deuxième calque de rendu ne prenne en
compte que les éléments situés sur le deuxième calque de la scène. Parmi
les options de rendu, veillez à ce que Edge soit bien activée, car la tête de
singe devra être rendue avec les contours caractéristiques du style Toon.

Choisissez maintenant l’une des deux vues 3D et transformez l’une
d’elles en vue de type Node Editor. Activez le mode Composite Nodes
grâce à l’icône en forme de visage ; activez également le bouton Use
Nodes (les premiers nœuds par défaut font automatiquement leur appari-
tion dans l’éditeur de nœuds) et, dans le panneau Anim, activez l’option
Do Composite pour que l’image finale rendue tienne bien compte des
manipulations réalisées dans l’éditeur de nœuds Composite. C’est main-
tenant que les choses sérieuses commencent.

Dans l’éditeur de nœuds, un premier nœud Render Layers est présent,
avec tout en bas un bouton ascenseur permettant de choisir le calque de
rendu du nœud. Normalement, c’est 1 Arriere Plan qui doit y figurer.
Ajoutez maintenant un deuxième nœud de type Render Layers
(Add>Input>Render Layers) et choisissez 2 Sujet Toon grâce au sélecteur.
Pour chacun d’eux, cliquez sur la petite icône de rendu pour prévisualiser
le contenu du calque de rendu. Nous remarquons que le sujet Toon n’est
pas éclairé du tout. En effet, les trois lampes sont toutes placées sur le
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premier calque, mais il est facile d’y remédier : en les sélectionnant une à
une (bouton droit de la souris pour la première, puis en maintenant la
touche [Maj] enfoncée pour les autres) puis en utilisant la touche [M], il
est possible de les faire apparaître sur le deuxième calque en plus du pre-
mier (pressez la touche [Maj] et cliquez avec le bouton gauche sur le
deuxième calque contenant déjà le sujet Toon, puis sur OK). Cliquez à
nouveau sur l’icône de rendu du nœud Render Layers 2 Sujet Toon :
désormais, la tête de singe apparaît bien !

De retour dans l’éditeur de nœuds, supprimez la liaison entre le premier
nœud Render Layers et le nœud Composite, qui présente l’image finale, en
dessinant une boîte (bouton gauche de la souris) sur le lien. Ajoutez
maintenant un nœud de type AlphaOver (Add>Color>AlphaOver) et reliez
la sortie Image du premier nœud Render Layers (1 Arriere Plan) à sa pre-
mière entrée Image ; de même, reliez la sortie Image du second nœud
Render Layers (2 Sujet Toon). Attention, l’ordre est important, puisque
la première image servira de fond à la seconde. Enfin, reliez la sortie
Image du nœud AlphaOver à l’entrée Image du nœud Composite. Pour une
meilleure incrustation du deuxième calque de rendu sur le premier,
n’hésitez pas à activer le bouton ConvertPremul.

Figure 9–30
Le réseau nodal de cette première étape

est excessivement simple.
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Il ne vous reste plus qu’à effectuer le rendu de la scène pour voir com-
ment les deux calques de rendu se conjuguent.

Ce n’est pas si compliqué, n’est-ce pas ? Envie d’aller plus loin ? Sélec-
tionnez le présentoir du sujet Toon, et basculez-le (touche [M]) sur le
deuxième calque de la scène. Un rendu à ce stade montre une anomalie
évidente : le présentoir, bien qu’en arrière-plan, se superpose aux deux
sphères du premier plan. S’il peut s’agir d’un résultat intéressant dans le
cadre d’un trompe-l’œil, ce n’est pas le cas ici.

Sélectionnez les deux sphères, et basculez-les (toujours avec la
touche [M]) sur le troisième calque (activez celui-ci en plus des deux pre-
miers dans l’en-tête de la vue 3D ou dans la section Scene du panneau
Layers) ; comme précédemment, les lampes devront figurer à la fois sur
les deux premiers calques, mais aussi sur le troisième. Puis dans le pan-
neau Render Layers, ajoutez un troisième calque de rendu (ADD NEW) que
vous nommerez, par exemple, 3 Premier Plan. Dans la section Layers,
activez le troisième calque seulement, et désactivez l’option Edge. Dans
l’éditeur de nœuds, ajoutez un troisième nœud de type Render Layers
(Add>Input>Render Layers) et sélectionnez le troisième calque de rendu.
Ajoutez un nouveau nœud AlphaOver (Add>Color>AlphaOver) et con-
nectez à sa deuxième entrée Image la sortie Image du Render Layers
3 Premier Plan. À sa première entrée Image, connectez la sortie Image
du précédent nœud AlphaOver (en supprimant le lien existant vers le
nœud Composite), et activez l’option ConvertPremul. Enfin, connectez sa
sortie Image à l’entrée Image du nœud Composite.

Figure 9–31
Le résultat de vos premières expérimentations 
avec les calques de rendu
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Effectuez maintenant un nouveau rendu, et voyez comment les deux
sphères ont effectivement reconquis le premier plan de la scène. Vous
retrouverez le corrigé de l’exercice, incluant les trois calques de rendu,
dans le fichier exercice-ch09.03-final.blend du répertoire /exercices
du DVD-Rom.

Figure 9–32
Le réseau nodal pour la mise en place des

3 calques de rendu reste tout à fait accessible.

Figure 9–33
Avec 3 calques de rendu,

il a été possible de séparer la scène
en trois parties : arrière-plan,

sujet principal et premier plan.
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Création d’un halo
La création d’un halo autour d’un objet particulier nécessite une mani-
pulation relativement simple, également basée sur les masques de rendu
dont vous devriez maintenant être familier : les sujets devant recevoir le
halo doivent tous figurer sur le même calque. Pour illustrer ce point,
supposons la scène suivante, très simple : la tête de singe se trouve sur le
premier calque de la scène, le décor en damier sur le second, et l’unique
lampe sur les deux calques à la fois. Bien sûr, c’est la tête de singe qui
doit émettre un halo.

Le nœud Z Combine

Voici un nœud qui peut être intéressant à connaître si
vous effectuez le rendu de deux Render Layers distincts
et que vous décidez de les combiner dans l’éditeur de
nœuds Composite en tenant compte de la distance res-
pective à la caméra de chaque objet (méthode plus fine
que celle reposant sur le nœud AlphaOver qui super-
pose bêtement les calques de rendu). Grâce au nœud
Z Combine, les deux images sont mélangées en fonc-
tion de la valeur Z de chaque pixel de chaque image.
Les valeurs Z étant échantillonnées une fois par pixel, une
fonction de post-traitement du masque est employée
pour interpoler les valeurs et limiter le crénelage du
masque. Des artefacts peuvent toutefois subsister. Voir le
fichier exercice-ch09.09-final.blend dans
le répertoire /exercices sur le DVD-Rom pour une
mise en pratique de la technique.

Figure 9–34

Figure 9–35
Une scène de départ très simple, 
l’objectif étant de donner au sujet principal 
un halo fantomatique
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Ouvrez le fichier exercice-ch09.04-depart.blend du répertoire
/exercices. Dans l’onglet Render Layers du menu Scene, modifiez la
définition du masque de rendu proposé par défaut, de sorte à ce qu’il
n’affiche que le premier calque. Ensuite, grâce au sélecteur de masque de
rendu, choisissez ADD NEW pour en créer un nouveau, qui n’affichera
pour sa part que le second calque.

Commencez par insérer un premier nœud Render Layers
(Add>Input>Render Layers) pour lequel vous sélectionnerez le premier
masque de rendu 1 Render Layer, qui ne contient que le sujet à doter
d’un halo. Connectez ensuite la sortie Image de ce nœud à l’entrée Image
d’un nœud Blur (Add>Filters>Blur) ; fixez l’échantillonnage dans les
directions X et Y à 80 pour chaque nœud. Éventuellement, activez les
boutons Bokeh et Gamma pour améliorer la qualité du flou, mais cela
allonge les temps de traitement. Insérez maintenant un nœud AlphaOver
(Add>Color>AlphaOver) ; vous connecterez sa première entrée Image à la
sortie Image du nœud Blur, et sa seconde entrée Image à la sortie Image
du nœud RenderLayers. En activant le bouton ConvertPremul et en don-
nant une valeur de 1.00 au bouton numérique Fac, vous venez de créer
une image superposant le premier masque de rendu, flou, à lui-même,
net. En connectant un nœud Viewer (Add>Output>Viewer), il vous est
possible d’observer le résultat intermédiaire ci-contre (figure 9–37).

Nous avons fait le plus dur : créer un effet de halo autour d’un sujet
précis, placé sur le premier calque de la scène. Nous allons maintenant
l’incruster dans le reste de la scène, placé sur le second calque. Pour cela,
insérez un second nœud Render Layers (Add>Input>Render Layers), et uti-
lisez le sélecteur pour choisir 2 Render Layers. Insérez également un
second nœud AlphaOver (Add>Color>AlphaOver) et connectez sa pre-
mière entrée Image à la sortie Image du masque de rendu 2 Render
Layer, et sa seconde entrée Image à la sortie Image du nœud AlphaOver
précédent. Activez le bouton ConvertPremul et utilisez une valeur de Fac
égale à 1.00. Il ne vous reste maintenant plus qu’à connecter la sortie
Image de ce deuxième nœud AlphaOver à l’entrée Image d’un nœud Com-
posite (Add>Output>Composite).

Figure 9–36
La définition des deux masques de rendu

ne pose pas de problème particulier.

Figure 9–37
Le sujet principal est désormais doté 
d’un halo basé sur sa propre couleur.
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Vous pouvez désormais vérifier que le bouton Do Composite est actif, et
enfin lancer un rendu grâce à la touche [F12]. L’exercice corrigé est pro-
posé dans le fichier exercice-ch09.04-final.blend.

Figure 9–38 Le réseau nodal complet pour la création d’un halo autour des sujets du premier calque

Figure 9–39
Le résultat final
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Un simple effet de flou focal
Le flou focal est un effet visuel très présent dans les productions cinéma-
tographiques ou télévisuelles. Lorsque la caméra est focalisée sur un
sujet, les autres éléments de la scène situés au premier plan ou à l’arrière-
plan de celui-ci apparaissent flous. C’est un effet tellement banalisé et
répandu que lorsqu’il observe un tel phénomène dans une image de syn-
thèse, l’esprit humain l’associe au photo-réalisme. De fait, beaucoup
d’artistes numériques cherchent à mettre en place de tels effets dans
leurs images. Jusqu’à présent, le flou focal n’était pas très évident dans
Blender, malgré l’existence de solutions plus ou moins simples d’accès,
mais pas toujours très efficaces. Avec l’éditeur de nœuds Composite,
mettre en place un effet de flou focal se révèle assez facile.

Ouvrez le fichier exercice-ch09.05-depart.blend du répertoire
/exercices. Pour commencer, connectez la sortie Z du nœud RenderLayer
par défaut à l’entrée Value d’un nœud Map Value (Add>Vector>Map Value).
Connectez ensuite la sortie Image du même nœud RenderLayer à l’entrée
Image d’un nœud Blur (Add>Filter>Blur). Connectez ensuite la sortie Value
du nœud MapValue à l’entrée Size du nœud Blur. Pour ce nœud Blur, spéci-
fiez 10 échantillons de flou sur X et autant sur Y. Connectez ensuite sa
sortie Image à l’entrée Image du nœud Composite par défaut.

Figure 9–40
Un exemple de scène élémentaire

qui profiterait bien d’un effet de flou focal.

ASTUCE   Préférez le flou Gaussien

Pour un flou focal, le flou Gaussien donne généra-
lement de très bons résultats. Dans le nœud Blur,
remplacez Flat par Gaussian et admirez l’amélio-
ration du flou focal.
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Vérifiez que le bouton Do Composite est actif dans le panneau Anim du
menu Scene, touche [F10], et appuyez sur la touche [F12] pour lancer le
rendu. La scène résultante est effectivement floue, mais ce n’est certaine-
ment pas le résultat que vous auriez souhaité.

Figure 9–41
Le réseau nodal à mettre en place 
pour obtenir un flou focal 
n’est pas très complexe.

Figure 9–42
Malheureusement, avec les paramètres 
par défaut, le flou est généralisé et mal dosé.
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Cela tient au fait que nous avons laissé tous les paramètres du nœud Map
Value à leur valeur par défaut. Par conséquent, celui-ci ne sert pour ainsi
dire à rien, et le flou commence dès la position de la caméra pour aller en
s’accentuant. Le premier sujet étant déjà à une certaine distance de la
caméra, il apparaît flou, malgré sa proximité. Le paramètre Offs du nœud
MapValue est là pour imposer un décalage à l’effet du nœud Blur. Par
exemple, si vous voulez que le flou commence à une distance de 7,5
unités de Blender depuis la caméra, spécifiez une valeur de -7.500 à Offs.
Au contraire, si vous voulez que le sujet au premier plan soit encore plus
flou, spécifiez une valeur positive de décalage au paramètre Offs. Vous
trouverez la correction de cet exercice dans le fichier 09-exercice-
ch09.05-final.blend.

Un effet de flou focal plus avancé
L’effet de flou présenté précédemment fonctionne à merveille mais reste
trop basique : il ne permet de simuler correctement que les scènes pour les-
quelles le point focal est en premier plan. La méthode qui suit détaille la
façon de créer un flou dont le point focal est à l’arrière-plan, à partir de ce
qui a été réalisé précédemment. 

Commencez par supprimer la connexion entre la sortie Value du nœud
MapValue et l’entrée Size du nœud Blur établie précédemment. Insérez
ensuite un nœud ColorRamp (Add>Convertor> ColorRamp) dont vous con-
necterez l’entrée Fac à la sortie Value du nœud MapValue, et la sortie Image à
l’entrée Size du nœud Blur. Cette même sortie Image sera également reliée à
l’entrée Image d’un nœud Viewer.

Figure 9–43
Grâce au paramètre Offs du nœud Map Value,

vous pouvez déplacer la distance au-delà
de laquelle commence effectivement le flou.
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Le réseau nodal n’est guère plus compliqué que celui obtenu
précédemment : la différence réside dans le fait que la profondeur de
champ Z s’est vue attribuer une couleur en dégradés de gris oscillant
entre le noir (dans la zone focale, nette) et le blanc (hors de la zone
focale, floue).

Ce dégradé de gris est alors interprété par le nœud Blur pour rendre floue
l’image en proportions. Il ne diffère en rien du résultat obtenu précé-
demment.

Figure 9–44 Un réseau nodal associant une rampe de couleur à la profondeur Z de la scène

Figure 9–45
Les éléments du premier plan héritent 
de la couleur du premier curseur.
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Mais il vous est également possible d’inverser la position du point focal sim-
plement en inversant les couleurs dans le nœud ColorRamp. Par exemple,
sélectionnez le premier curseur et donnez-lui une couleur blanche. De
même, sélectionnez le second curseur et donnez-lui une couleur noire.

La transition entre les zones nette et floue demeure à une distance de -10
unités de Blender de la caméra, sauf qu’elle reste nette au-delà (jusqu’à
l’horizon) et qu’elle devient floue en direction de la caméra (voir figure 9–48
ci-contre ; vous pouvez aussi expérimenter le fichier exercice-ch09.06-
interm.blend si vous le souhaitez).

Comment procéder si vous souhaitez avoir le point focal au milieu de
votre scène, avec votre premier plan et votre arrière-plan tous deux dans

Figure 9–46
Le premier plan est net,

tandis que l’arrière-plan se brouille.

Figure 9–47
Les couleurs de la rampe ont été inversées,

de même que l’attribution des couleurs
suivant la profondeur Z.
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le flou ? La mise en œuvre de la solution est légèrement plus complexe,
mais sa logique ne devrait pas vous échapper, si vous avez compris les
manipulations précédentes. Ce n’est toutefois pas la façon la plus simple
de résoudre ce type de cas, mais elle est très instructive sur la façon d’uti-
liser les nœuds. C’est pourquoi nous allons vous la proposer malgré tout.

Il va s’agir de créer deux branches parallèles à votre réseau nodal, l’une avec
une rampe de couleur allant du noir au blanc (pour rendre flou l’arrière-
plan), et une autre avec une rampe allant du blanc au noir (pour rendre
flou le premier plan). Les sorties Image des deux rampes se combinent
dans un nœud Difference (Add>Color>Mix) avec un Fac de 1.00. La sortie
Image de ce nœud est alors connectée à l’entrée Size d’un module Blur, qui
reçoit également dans son entrée Image la sortie Image du nœud Render-
Layer. Bien sûr, la sortie Image du nœud Blur est alors connectée à l’entrée
Image du nœud final Output. La seule subtilité consistera alors à trouver
pour chacune des deux branches la valeur Offs de son nœud MapValue,
mais cet exercice se révélera très simple si les sorties Image de chacun des
nœuds ColorRamp sont connectées à un nœud Viewer (voir figure 9–49).

Éventuellement, vous pouvez augmenter les valeurs X et Y du nœud Blur,
ainsi qu’activer l’option Bokeh. Bien sûr, au rendu, les résultats sont con-
formes aux espérances : tant le premier plan que l’arrière-plan sont flous,
tandis que le centre de la scène demeure parfaitement net (voir figure 9–50).
La correction de cet exercice vous est proposée dans le fichier exercice-
ch09.06-final.blend.

Figure 9–48
La focale étant désormais sur l’arrière-plan, 
c’est le premier plan qui devient flou.
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Figure 9–49 Le réseau nodal permettant d’avoir un flou focal aisément paramétrable est plus complexe mais reste abordable.

Figure 9–50
L’image finale, avec le flou du premier plan

et de l’arrière-plan parfaitement maîtrisé
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Le flou focal grâce au nœud Defocus
Venir à bout de l’exercice précédent n’est guère difficile si vous êtes un
utilisateur avancé de Blender, ou si vous travaillez couramment avec
l’éditeur de nœuds. Pourtant, une méthode simple et rapide à mettre en
œuvre serait bien utile, tant pour le débutant cherchant à mettre un peu
de flou focal dans ses rendus, que pour l’utilisateur chevronné qui aime-
rait gagner du temps. Le nœud Defocus est donc là pour répondre à ces
deux besoins. Son principe est simple : dans la vue 3D, nous définissons
un point focal puis, dans l’éditeur de nœuds Composite, nous définissons
le flou en fonction de ce point focal.

Pour cet exercice, nous allons à nouveau partir du fichier exercice-
ch09.07-depart.blend du répertoire /exercices. Dans la vue 3D de
dessus, à gauche, sélectionnez la caméra à l’aide du bouton droit de la
souris. Allez ensuite dans le menu Editing, touche [F9], et, dans le pan-
neau Camera, activez l’option Limits : une ligne de mire apparaît depuis
la caméra, le début et la fin de cette ligne pouvant être réglés par les
paramètres Start et End de la section Clipping. Mais ce n’est pas ce qui va
nous intéresser : prêtez attention à la section Lens et en particulier au
paramètre DoF Dist. Augmentez progressivement sa valeur, et observez la
vue 3D de dessus : un petit curseur jaune démarre à la position de la
caméra et s’éloigne de la distance spécifiée dans le bouton DoF Dist, en
suivant la ligne de mire. Il s’agit d’une matérialisation du point focal de
la caméra. Positionnez-le à l’endroit de votre choix, mais à une valeur
DoF Dist égale à 4.00 : le point focal tombe à peu près au début de la pre-
mière tête de singe.

Retournez aux Render buttons du menu Scene, touche [F10], et activez le
bouton Do Composite de l’onglet Anim, car nous allons nous attaquer à la
partie relative à l’éditeur de nœuds, qui occupe la seconde moitié de
l’écran. Dans l’en-tête de celui-ci, cliquez sur le bouton Use Nodes. Les
nœuds Composite par défaut font leur apparition ; supprimez le lien
unissant les nœuds Render Layer et Composite. Entre les deux, insérez un
nœud Defocus (Add>Filter>Defocus).

Sans vous laissez impressionner par la complexité apparente de ce nou-
veau nœud, reliez son entrée Image à la sortie Image du nœud Render
Layer et, de même, son entrée Z à la sortie Z du même nœud Render
Layer. Reliez ensuite sa sortie Image à l’entrée Image du nœud Composite.
Dans le nœud Render Layer, utilisez l’icône de rendu pour générer
l’image de base qui alimentera l’éditeur de nœuds.

Une première image, relativement brouillée, fait son apparition en prévi-
sualisation dans le nœud Composite, ainsi qu’en rendu réel (figure 9–52).
L’effort est méritoire, mais clairement insuffisant.

Figure 9–51
Le nœud Defocus, avec ses nombreux 

paramètres et ses options variées

BON À SAVOIR   Nœud Defocus et passe Z

Pensez à vérifier que pour le Render Layer con-
cerné, la passe Z est bien active. Sinon, vous ne
serez pas en mesure de tirer quoi que ce soit de la
méthode expliquée dans cet exercice. En revanche,
vous pouvez utiliser autre chose que le tampon de
profondeur Z pour rendre floue votre image. En
particulier, vous pouvez utiliser une image en
dégradés de gris, ou avec des masques, ou un
nœud Time pour rendre floue tout ou partie, pro-
gressivement ou uniformément, votre image
rendue. Pour utiliser le nœud Defocus de cette
façon, il vous faut activer le bouton No zbuffer et
spécifier une valeur Zscale à la main. Cette valeur
permet de contrôler manuellement le rayon de
l’effet flou, et donc son intensité.
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Dans un premier temps, puisque nous utilisons la carte de profondeur Z
de l’image rendue pour la détermination de la quantité de flou, nous
pouvons désactiver l’option No zbuffer. Le paramètre Zscale disparaît au
profit de fStop. Pour ce dernier, une valeur de 128.00 signifie que tout,
dans le champ de la caméra, est dans le focus, et donc parfaitement net ;
de façon générale, lorsque vous divisez cette valeur par deux, vous dou-
blez la quantité de flou. Dans notre cas, essayons une valeur de 64.00,
puis 32.00, 16.00, 8.00, etc., et observons à chaque fois les changements
dans le nœud Composite, ou dans une vue de type UV/Image Editor (en
sélectionnant IM: Render Result dans le menu déroulant).

Donnons à fStop une valeur de 8.00 et observons attentivement la prévi-
sualisation. Le résultat est manifestement trop bruité : c’est parce que
nous n’avons pas consacré suffisamment d’échantillons à la prévisualisa-
tion. Ce n’est toutefois pas un problème puisque celle-ci ne préjuge pas
de la qualité finale ; vous pouvez toutefois augmenter progressivement
Samples jusqu’à avoir une prévisualisation qui vous satisfasse. Lorsque ce
sera le cas, désactivez l’option Preview (le paramètre Samples, devenu
inutile, disparaît) et effectuez le rendu final grâce au bouton RENDER ou à
la touche [F12] (si vous effectuez le rendu sans décocher l’option Preview,
l’image sera rendue avec une qualité moindre, conditionnée par la valeur
Samples que vous avez spécifiée) pour profiter d’un flou focal discret
mais du plus bel effet !

Figure 9–52
Le flou de distance est plutôt bruité,

et mériterait d’être retravaillé !

ASTUCE  
La photographie au secours de la 3D

S’il est tentant de forcer le niveau de flou pour bien
marquer sa présence, essayez toutefois d’imaginer
la quantité observée lors d’une prise de vue
photographique : souvent, un flou très léger est
bien plus suggestif et efficace qu’un flou trop pro-
noncé. Une petite expérience dans les arts photo-
graphiques peut, dans ce cadre (ainsi que dans bien
d’autres domaines de l’imagerie de synthèse !),
vous être utile et vous aider à doser l’effet.
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Maintenant, il ne vous reste plus qu’à jouer avec les paramètres fStop du
nœud Defocus et DoFDist de la caméra pour bien saisir les subtilités de
cette méthode. En essayant une valeur fStop égale à 5.00 et un DoFDist
égal à 8.50, vous devriez obtenir un résultat relativement proche de
l’exercice précédent, à base de nœuds Blur, MapValue et RampColors, mais
avec une facilité sans commune mesure !

Figure 9–53 Le nœud Defocus à l’œuvre : un usage plutôt simple !

Figure 9–54
Le résultat du rendu final à l’aide du nœud 
Defocus se révèle d’une grande finesse.
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Les autres paramètres à connaître du nœud Defocus

Le nœud Defocus permet la création d’un flou de distance grâce à un
post-traitement 2D d’une image rendue au préalable ; cela rend cette
méthode beaucoup plus rapide que le véritable flou focal que d’autres
moteurs de rendu déterminent grâce au raytracing. Pour chaque pixel de
l’image, un nombre conséquent de rayons distincts (en fait, l’équivalent
du paramètre Samples de l’option Preview) sont lancés, ce qui peut aboutir
à des temps de rendu parfois rédhibitoires, surtout dans le cadre d’anima-
tions, ce qui est et doit rester le point fort de Blender. Malheureusement,
cette méthode est également plus empirique, moins physique, et il en
résulte parfois des rendus perfectibles.
• BThreshold : de par l’essence de ce nœud, il peut arriver qu’un arrière-

plan flou bave sur un objet net au premier plan, ou que d’autres
erreurs de représentation du flou du même type se produisent. Vous
pouvez modifier ce paramètre (il est par défaut égal à 1.00) lorsqu’un
objet normalement net n’est pas correctement représenté.

• Maxblur : il peut parfois être intéressant de limiter le niveau de flou
dans un rendu, car le calcul de celui-ci peut parfois prendre un certain
temps, en particulier lorsque l’arrière-plan World est visible ou qu’un
objet de premier plan est très proche de la caméra. Une valeur nulle
indique l’absence de limite maximale au niveau de flou.

Le nœud ID Mask

Dans Blender, il est possible de spécifier pour
chaque objet, un indice nommé PassIndex,
dans le panneau Object and Links, dans
les Object buttons du menu Object,
touche [F7]. Si la passe Index Ob dans
l’onglet Render Layers est active, le nœud
Image présente une nouvelle sortie
IndexOB à laquelle il est possible de greffer
un nœud ID Mask. Celui-ci permet de créer
un masque pour l’indice d’objet spécifié, et
de réaliser sur la partie non masquée un trai-
tement nodal quelconque.
Par exemple, il est possible de changer
uniformément la couleur des objets non
masqués. Voir le fichier exercice-
ch09.09-final.blend pour une
mise en pratique de la technique.

Figure 9–55
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Les nœuds pour l’incrustation d’image
Nous avons déjà vu (notamment grâce au nœud AlphaOver) comment super-
poser des éléments de rendu les uns aux autres, grâce aux passes de rendu. Il
peut naturellement vous venir à l’idée de superposer, de la même façon, des
éléments issus de vidéos filmées dans la vie réelle à des éléments en images de
synthèse, en remplaçant une passe de rendu par une image externe à Blender.

L’une des techniques permettant ce type d’incrustation repose sur la
prise de vue d’éléments ou de personnages filmés sur un fond de couleur
(généralement bleu ou vert) qui représenteront une première source
d’images. Lors du montage, cette couleur est considérée comme transpa-
rente, et va révéler l’arrière-plan constitué par une deuxième source
d’images. C’est une technique très courante dans le milieu audiovisuel,
comme en témoignent ces deux exemples :
• dans les films de science-fiction, les acteurs sont filmés sur écran vert

et, au montage, un décor grandiose, extraterrestre ou fantastique est
placé à l’arrière-plan ;

• dans certaines émissions télévisuelles, le présentateur est filmé sur écran
vert et un décor distant est substitué à l’arrière-plan ; c’est également le
cas des présentations des bulletins météorologiques, où une carte satel-
lite ou météorologique est placée à l’arrière-plan du présentateur.

Blender propose différents nœuds permettant la composition d’éléments
tournés sur des fonds variés. Le plus simple est le nœud Chroma Key, qui
détermine pour chaque pixel de l’entrée s’il s’agit d’un pixel de premier
plan (donc visible) ou d’un élément d’arrière-plan (donc transparent) en
fonction de sa couleur. Bien évidemment, il est possible de déterminer la
couleur de son choix comme représentative de l’arrière-plan, ce qui
permet de ne pas se limiter aux traditionnelles couleurs vert ou bleu en
vigueur dans les productions vidéo.

Pour comprendre le fonctionnement de ce nœud, supposons que nous vou-
lions utiliser comme fond l’image suivante (figure 9–56), tirée du répertoire
/exercices du DVD-Rom : exercice-ch09.08-scene-urbaine.png.

Pour le premier plan, nous aurons en guise d’acteur Suzanne, la tête de
singe. Bien sûr, elle a été filmée sur un fond vert (voir figure 9–57). Dans
le même répertoire du DVD-Rom, l’image porte le nom exercice-
ch09.08-suzanne-ecran_vert.png.

Ouvrez une nouvelle session de Blender, ou réinitialisez le travail en
cours grâce à la combinaison de touches [Ctrl]+[X]. Transformez la vue
3D par défaut en une vue de type Node Editor, puis dans son en-tête,
activez l’icône Composite Nodes (au lieu du Material Nodes par défaut)
ainsi que le bouton Use Nodes. Dans le menu Scene, touche [F10], activez
le bouton Do Composite de l’onglet Anim.

BON À SAVOIR  Écran vert

Habituellement, les séquences filmées sur fond
vert (ou bleu) sont tournées en studio, avec un
éclairage constant et parfaitement maîtrisé, ce qui
permet de simplifier les réglages de l’incrustation.
Il est possible de tourner de telles séquences en
extérieur, mais les variations de l’intensité lumi-
neuse (nuage passant devant le soleil) ou les con-
ditions atmosphériques (pluie, bien évidemment,
mais aussi vent faisant trembler l’écran vert) peu-
vent sérieusement compliquer les choses, et
demander bien plus de manipulations au niveau
des nœuds pour gommer l’influence de ces mau-
vaises conditions. Bien sûr, l’acteur au premier
plan ne doit pas porter de vêtements de la même
couleur que le fond utilisé, sinon à l’incrustation,
l’arrière-plan sera visible au niveau du vêtement.
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Commencez par supprimer le nœud Render Layers par défaut ; il est inu-
tile pour cet exercice. À la place, ajoutez deux nœuds Image
(Add>Input>Image) ; pour le premier, utilisez le bouton Load New pour
chercher dans le répertoire /exercices du DVD-Rom l’image exercice-
ch09.08-scene-urbaine.png, puis faites de même pour le second nœud
Image et le fichier exercice-ch09.08-suzanne-ecran_vert.png. Insérez
maintenant un nœud Chroma Key (Add>Matte>Chroma Key) ; à son
entrée Image, vous connecterez la sortie Image du nœud présentant le
sujet sur fond coloré à incruster (exercice-ch09.08-suzanne-
ecran_vert.png). Cliquez ensuite sur l’échantillon de couleur Key Color
pour afficher le nuancier, et choisissez une couleur verte identique au
fond (en l’occurrence, R 0.500 G 1.000 B 0.000). Nous venons de filtrer

Figure 9–56
Le fond de notre incrustation vidéo

Figure 9–57
Le sujet principal, filmé sur un fond vert,

qui sera incrusté sur l’image d’arrière-plan
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l’image en indiquant à l’éditeur que le fond vert de ce nœud doit être
considéré comme transparent.

Insérez ensuite un nœud AlphaOVer (Add>Color>Alpha Over) que vous
commencez maintenant à bien connaître, et connectez la sortie Image du
nœud Image exercice-ch09.08-scene-urbaine.png à sa première entrée
Image, puis la sortie Image du nœud Chroma Key à sa seconde entrée
Image. Activez son option ConvertPremul, puis connectez sa sortie Image
à l’entrée Image du nœud Composite.

La prévisualisation dans le nœud Composite montre immédiatement que
le résultat cherché a été atteint, de sorte que vous pouvez le confirmer
par un rendu, touche [F12], qui sera quasi instantané, car nous avons tra-
vaillé sur la base d’images externes. Toutefois, nous observons que le
fond de l’image finale est plus sombre que l’image source elle-même.
Pour compenser cet effet, abaissez le curseur Gain à 0.000. De même,
nous notons qu’un fin liseré vert (dû à l’anticrénelage de l’image sur le
fond vert) est visible autour de la tête de singe, ce qui trahit nettement la
technique d’incrustation employée : augmentez le curseur Acceptance
jusqu’à le faire disparaître, jusqu’au maximum 80.00 si nécessaire.

ASTUCE   Nœud Viewer connecté à une sortie Matte

Vous pouvez connecter la sortie Matte de tout nœud Key (et pas seulement Chroma Key)
pour voir dans un nœud de type Viewer l’allure du masque de transparence. Cela peut
notamment vous aider à déterminer si le type de nœud Key choisi fonctionne suffisamment
pour votre propre cas, et vous aider à maîtriser le chaînage de plusieurs nœuds Key dans le
but d’obtenir une incrustation parfaite.

Figure 9–58



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008396

Vous retrouverez la correction de cet exercice dans le répertoire approprié
du DVD-Rom sous le nom de fichier exercice-ch09.08-final.blend.

Figure 9–59 Le réseau nodal permettant de réussir l’incrustation du sujet sur fond vert

ASTUCE   Fond vert non uniforme

Parfois, même en studio, les conditions de prise de vue font qu’il
n’est pas toujours possible de disposer d’un fond exempt de
nuances de couleurs, dû à des ombres parasites ou des plis de la
toile verte. Un tel résultat pourrait être l’image exercice-
ch09.08-suzanne-ecran_vert-stries.png suivante.
Si vous retrouvez les motifs du fond vert sur l’image finale sous
forme plus ou moins transparente, jouez avec le curseur Cutoff du
nœud Chroma Key, qui servira à définir une sorte de tolérance de
variation de couleur.

Figure 9–60
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Et les autres nœuds Matte ?
En effet, Chroma Key n’est pas le seul nœud disponible. Aucun nœud uni-
versel ne fonctionne dans tous les cas et, souvent, c’est la mise en série de
plusieurs nœuds qui va permettre de réaliser une incrustation parfaite et
sans artefact des différentes images sources. Nous nous sommes ici concen-
trés sur le nœud le plus simple à appréhender, mais il y en a plusieurs autres,
chacun fonctionnant mieux que les autres dans un cadre précis.

Difference Key

Une image admet plusieurs espaces de couleur (par exemple, RGB,
HSV, etc.) et chaque espace dispose de ses propres canaux (rouge, vert et
bleu pour RGB, par exemple). Ce nœud détermine, pour chaque pixel,
la différence entre chaque canal et la couleur clé (Color Key) choisie. Il
permet également de définir un seuil pour chaque canal. Si la différence
entre le pixel et la couleur clé est inférieure au seuil, le pixel est considéré
comme transparent. Reprenez le fichier exercice-ch09.08-final.blend
en remplaçant le nœud Chroma Key par un nœud Difference Key
(Add>Matte>Difference Key) ; choisissez l’espace RGB et reprenez la
même Color Key que précédemment. En expérimentant, donner un seuil
de 0.180 au premier canal, 0.700 au second et enfin 0.500 au dernier
pour que la tête de Suzanne s’incruste parfaitement dans l’arrière-plan,
sans liseré autour d’elle, mais sans artefact non plus.

Luminance Key

Le critère de détermination du fond par rapport au sujet est ici basé sur la dif-
férence de luminosité entre le sujet et son arrière-plan. Traditionnellement,
dans l’industrie cinématographique, les explosions des effets spéciaux étaient
ainsi filmées sur fond noir (offrant ainsi un grand contraste) avant d’être inté-
grées à l’image du film. En particulier, le site http://www.detonationfilms.com
propose de nombreuses flammes, explosions, étincelles filmées de cette façon,
et certaines sont même téléchargeables gratuitement et conviennent parfaite-
ment à un usage avec le nœud Luminance Key.

Dans le fichier exercice-ch09.08-final.blend, il faut remplacer le nœud
Chroma Key par un nœud Luminance Key (Add>Matte>Luminance Key) et
jouer sur les curseurs High et Low jusqu’à faire apparaître dans un nœud
Viewer connecté à la sortie Matte un masque satisfaisant. Malheureuse-
ment, il est très probable (avec un fond lumineux, comme lorsqu’on utilise
l’image exercice-ch09.08-suzanne-ecran_vert.png) que vous obteniez
l’inverse du masque souhaité (noir correspondant à transparent, blanc à
opaque). Ajoutez alors un nœud ColorRamp (Add>Concertor> ColorRamp)
en inversant les couleurs aux deux extrémités de la rampe (transformez le
noir en blanc, et réciproquement). Connectez bien sûr son entrée Fac à la

Figure 9–61
Le nœud Difference Key
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sortie Matte du nœud Luminance Key, puis sa sortie Image à l’entrée Fac du
nœud AlphaOver. L’image ci-dessous montre le réseau nodal correspon-
dant.

Channel Key

Cette fois, ce sont les différences de niveau sur un canal donné qui vont
fournir le critère de séparation du sujet de l’arrière-plan. Vous noterez que
dans l’espace YUV, Y représentant la luminance, si vous utilisez ce canal
comme critère, vous retombez sur l’utilisation du nœud Luminance Key.

Reprenez le fichier exercice-ch09.08-final.blend en remplaçant le
nœud Chroma Key par un nœud Channel Key (Add>Matte>Channel Key) ;
choisissez l’espace RGB et augmentez progressivement le curseur High.
Arrivé à une valeur de 1.000, la tête de Suzanne est parfaitement incrustée
mais le fond est teinté de vert. Augmentez alors progressivement Low, à
son tour, jusqu’à ce que le masque soit parfaitement transparent (noir) et
l’image de fin, par conséquent, inaltérée par la couleur du fond.

Adoucir les bords de l’incrustation
Maintenant que vous avez réussi à incruster votre acteur sur l’arrière-
plan de votre choix, vous remarquerez certainement le crénelage qui

Figure 9–62 Le nouveau réseau nodal avec le nœud Luminance Key et un paramètre High égal à 0.735

Figure 9–63
Le nœud Channel Key
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l’entoure, dû soit à la résolution de votre rendu, soit à celle de votre
caméra. Ouvrez à nouveau le fichier exercice-ch09.08-final.blend.

Pour corriger ce problème, nous allons travailler sur la sortie Matte du nœud
Chroma Key, en ajoutant un nœud Dilate/Erode (Add>Filter>Dilate/Erode)
suivi d’un nœud Blur (Add>Filter>Blur). La sortie Matte du nœud Chroma
Key est connectée à l’entrée Mask du nœud Dilate/Erode, puis la sortie Mask
de celui-ci est connectée à l’entrée Image du nœud Blur. Enfin, la sortie
Image du nœud Blur est connectée à l’entrée Fac du nœud AlphaOver.

Nous allons maintenant donner une valeur de Distance égale à -1.00 à
notre nœud Dilate/Erode, ce qui permet de l’éroder légèrement, de sorte
que le masque soit désormais légèrement plus petit que l’image elle-
même. Dans le nœud Blur, sélectionnons une méthode de flou (Gauss) et
augmentons légèrement les paramètres X et Y (une valeur de 3 ou 4 est
un maximum dans notre cas) : en devenant flou, le masque retrouve sa
taille approximative précédant l’opération d’érosion. Dans vos manipula-
tions futures, il vous faudra toujours essayer de trouver le juste équilibre
entre la quantité d’érosion et la quantité de flou donnée au masque.

L’acteur du premier plan est désormais mieux incrusté, dans la mesure
où ses bords ont été rendus légèrement flous et où, par transparence, ils
se fondent légèrement dans l’image d’arrière-plan, ce qui les adoucit.
Bien sûr, cette technique fonctionne d’autant mieux que l’image finale
est grande ! Vous trouverez, à fin d’expérimentation, cette manipulation
dans le fichier exercice-ch09.08-blend_edges.blend du répertoire
/exercices du DVD-Rom.

Figure 9–64
Le réseau nodal correspondant 
à l’adoucissement des bords 
de l’acteur incrusté

ASTUCE   Compenser la lumière verte 
réfléchie par l’écran vert

Lors des prises de vue, il se peut qu’un surcroît
d’éclairage rebondisse sur l’écran vert et vienne
rétro-éclairer l’acteur. Il en résulte que sa sil-
houette est alors légèrement teintée de vert. Lors
du montage, le nœud Chroma Key (entre autres)
a alors du mal a distinguer l’arrière-plan des
limites de la silhouette de l’acteur et l’image
d’arrière-plan a ainsi tendance à baver sur l’acteur
du premier plan. Le nœud Color Spill a pour fonc-
tion de faire en sorte que la valeur du canal choisi
(en l’occurrence G, dans le cas d’un écran vert)
n’excède pas la moyenne des deux autres canaux,
supprimant théoriquement la bavure.
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annexe A

La liste des raccourcis clavier est rasoir, mais son étude vous aidera à progresser dans la maîtrise de Blender. 
Image © 2005, Adrien Lourdelle, http://adrien.3dvf.net/
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Les raccourcis clavier de Blender

L’apparente complexité de Blender est en partie due à la 
multiplicité des raccourcis clavier existants. Si des progrès ont 
été accomplis au niveau de l’interface, permettant de réaliser à 
la souris, au travers de boutons et de menus, la plupart des 
actions, force est de constater que l’utilisateur ne parvient à 
devenir réellement productif que par l’usage intensif des 
raccourcis clavier.
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Il est possible d’accéder à une liste assez complète (en anglais) des rac-
courcis clavier disponibles au travers du menu Help de la barre de menus
principale, en haut de la fenêtre de Blender : Hotkeys and MouseAction
reference. Il s’agit d’un script Python qui permet d’afficher, par catégorie,
tous les raccourcis clavier recensés par l’auteur du script. S’il vise l’exhaus-
tivité, il se peut qu’il subsiste quelques manques, ou quelques reliquats du
passé. N’hésitez pas à rapporter les écarts par rapport à votre version de
Blender : http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_hotkeyscript.htm.

Dans tous les cas, ne vous effrayez pas au survol de cette aide, et rassurez-
vous en vous disant que l’auteur de cet ouvrage ne doit en maîtriser au
quotidien que 15 à 20 %.

C’est pour cela que cette annexe a pour but d’attirer votre attention sur
les raccourcis les plus essentiels (du point de vue de l’auteur), et vous
suggère autant que possible des références mnémotechniques pour vous
aider à les retenir.

La souris
La souris est indissociable du fonctionnement de Blender. Un usage
approprié de celle-ci évite à l’utilisateur bien des allers-retours du poin-
teur à l’écran. En particulier, elle permet de contrôler la vue 3D, de
sélectionner et désélectionner des objets, de confirmer ou d’annuler des
opérations, ou encore d’appeler simplement le menu Add.

Manipulations de base

Raccourci Contexte Description Pense-bête

bouton gauche Positionne le curseur dans la vue 3D.

bouton central Fait tourner la vue autour d’un axe perpendiculaire à l’écran.

[Ctrl]+bouton central Zoome dans la vue (pratique en absence de molette.)

[Maj]+bouton central Déplace la vue.

bouton droit Sélectionne un objet ou un élément.

[Maj]+bouton droit Ajoute ou enlève à la sélection des objets ou des éléments 
supplémentaires.

molette Zoome dans la vue.
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Manipulations courantes

Transformations

Le clavier
Blender est un logiciel aux fonctionnalités très riches, dont les possibi-
lités peuvent aisément se dissimuler dans des strates diverses du menu.
Presque toutes les fonctions peuvent être appelées rapidement d’une
simple combinaison de touches au clavier. Certes, retenir toutes les com-
binaisons est une gageure, mais cette annexe est justement là pour vous
donner les clés essentielles.

Raccourci Contexte Description Pense-bête

pression continue sur bouton 
gauche ou droit

Invoque le menu flottant Add>...

[Ctrl]+bouton gauche En fonction du mode, permet d’ajouter un sommet (mode 
Edit), une clé (éditeur de courbe IPO), un os à l’armature 
(mode Edit d’armature).

[Maj]+[Ctrl]+bouton gauche Sculpt Dessine une boîte de sélection qui délimite une partie de 
maillage qui restera visible : le reste du maillage deviendra 
masqué.

[Alt]+bouton droit Edit Sélectionne une boucle d’arêtes (edge-loop).

[Ctrl]+[Alt]+bouton droit Edit Sélectionne une boucle de facettes (face-loop).

[Maj]+[Ctrl]+bouton droit Sculpt Dessine une boîte de sélection qui délimite une partie de 
maillage qui sera masquée : le reste du maillage sera visible.

Raccourci Contexte Description Pense-bête

[Ctrl], déplacement pointeur Transforme (déplacement, rotation, mise à échelle) 
par incréments réglés.

[Ctrl]+[Maj], déplacement 
pointeur

Transforme (déplacement, rotation, mise à échelle) 
par incréments plus fins.

bouton gauche Met fin à l’action en l’acceptant.

bouton central Bascule d’un axe de transformation à l’autre.

bouton droit Met fin à l’action en l’annulant.
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Touches de fonction
Elles permettent de réaliser les fonctions les plus courantes de Blender
(ouvrir un fichier ou l’enregistrer) ou encore de basculer rapidement dans
le menu de boutons de votre choix.

Les raccourcis clavier
Un même raccourci clavier peut servir à différentes fonctions, en fonc-
tion du type de vue (vue 3D, éditeur UV/Image, éditeur de courbes IPO,
etc.) ou du mode (Edit, Pose, Vertex paint, etc.). Généralement, une fonc-
tion particulière est attachée à une lettre, et les variantes de cette fonc-
tion attachées à une combinaison à base des touches [Maj], [Ctrl] ou [Alt].
Lorsque cela est possible ou pertinent, les tableaux ci-après précisent les
principaux modes (ou vues) de fonctionnement ainsi qu’une astuce mné-
motechnique pour aider à retenir le raccourci. Souvent, le raccourci est
baptisé d’une initiale ou d’une lettre significative de la fonction attachée.

Raccourci Contexte Description Pense-bête

[F1] Ouvre un fichier dans Blender.

[Maj]+[F1] Importe la librairie de données (Append).

[F2] Sauvegarde le fichier.

[F3] Sauvegarde l’image rendue.

[Ctrl]+[F3] Capture la vue 3D et la sauvegarde.

[Ctrl]+[Maj]+[F3] Capture l’écran et le sauvegarde.

[F5] Affiche les boutons du menu Shading.

[F6] Affiche les boutons du menu Texture.

[F7] Affiche les boutons du menu Object.

[F8] Affiche les boutons du menu World.

[F9] Affiche les boutons du menu Editing.

[F10] Affiche les boutons du menu Scene.
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Les touches d’usage général
Ce sont les raccourcis de base que vous gagnerez à maîtriser, tant ils sont
régulièrement invoqués.

Raccourci Contexte Description Pense-bête

[Espace] Tous Invoque le menu flottant Add>... et affiche ses options.

[Tab] Tous Entre/sort du mode Edit ; fonctionne pour divers modes et 
types de fenêtres.

[A] Tous Sélectionne/désélectionne tous les éléments de la vue 3D. [A]ll, tout

[Alt]+[A] Joue l’animation dans la vue 3D courante. [A]nimation

[Maj]+[Alt]+[A] Joue l’animation dans toutes les vues 3D. [A]nimation

[Ctrl]+[A] Object, Edit, Pose Applique l’échelle et les rotations de l’objet à son bloc de 
données.

[A]pplique

[B] Tous Sélection par boîte ; la boîte est tracée par la souris : il s’agit 
d’une boîte de sélection (bouton gauche) ou de désélection 
(bouton droite).

[B]oîte

[G] Object, Edit, Pose Déplace la sélection dans le plan de la vue 3D. [G]rab, attraper pour déplacer

[N] Tous Invoque/révoque le panneau flottant Properties adapté au 
type de vue.

Panneau flottant [N]umérique

[P] Vue 3D Démarre le moteur de jeu. [P]lay, jouer, moteur de jeu

[Alt]+[P] Éditeur de texte Exécute le script courant (script Python non distribué avec 
Blender ou ne pouvant intégrer le menu Scripts).

[P]lay script, jouer un script

[Ctrl]+[Q] Tous Quitte Blender. [Q]uitter

[R] Object, Edit, Pose Rotation de la sélection autour d’un axe perpendiculaire à 
l’écran.

[R]otation

[S] Object, Edit, Pose Redimensionne la sélection. [S]ize, dimension

[Maj]+[S] Vue 3D Invoque le menu Snap et affiche ses options. [S]nap, accrochage

[U] Weight Paint, 
Vertex Paint, Edit

Annule la dernière action effectuée. [U]ndo, défaire, ann[U]ler

[Ctrl]+[U] Tous Sauvegarde la scène/écran courant(e) comme étant la scène/
écran de démarrage par défaut.

[U]ser default settings, paramètres 
par défaut de l’[U]tilisateur

[X] Tous Supprime la sélection.

[Ctrl]+[X] Tous Réinitialise la scène ; elle est alors remplacée par la scène de 
démarrage par défaut.
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Les touches utiles en mode Object
Nous avons ici essayé de retenir les plus communes des fonctions asso-
ciées au mode Object, dans la vue 3D (certaines fonctionnent presque de
la même façon dans d’autres types de vue). En effet, le mode Object est
probablement celui auquel vous accorderez le plus de temps, avec le
mode Edit. Nous allons donc lui accorder une attention particulière.

Raccourci Contexte Description Pense-bête

[Maj]+[Ctrl]+[A] Object Applique les Lattice (treillis) et rend réels les DupliVerts/
Face/Group.

[A]pplique

[Alt]+[C] Object Invoque le menu Convert et affiche ses options. [C]onvertit

[Alt]+[D] Object Crée une nouvelle instance (clone) de la sélection. [D]uplique

[Maj]+[D] Object Crée une copie de la sélection. [D]uplicata

[Alt]+[G] Object Remet à zéro les déplacements de l’objet.

[Maj]+[Alt]+[G] Object Enlève les objets sélectionnés des groupes les contenant. [G]roupe

[Ctrl]+[G] Object Ajoute les objets sélectionnés à un groupe. [G]roupe

[I] Object, vue 3D Invoque le menu Insert Key et affiche ses options. [I]nsère

[Ctrl]+[ J] Object Joint les maillages des objets sélectionnés. [J]oint

[M] Object Déplace la sélection sur un autre calque. [M]ove to layer, déplacer sur un calque

[Ctrl]+[M] Object Invoque le menu Mirror Axis et affiche ses options. [M]iroir

[Maj]+[O] Object Ajoute un modificateur Subsurf à l’objet sélectionné.

[Alt]+[P] Object Supprime les relations parent existantes de la sélection. [P]arent

[Ctrl]+[P] Object, 
Armature

Fait de l’objet actif le parent d’un autre objet également 
sélectionné.

[P]arent

[Alt]+[R] Object Remet à zéro les rotations de la sélection. [R]otation

[Alt]+[S] Object, Pose Remet à zéro l’échelle de la sélection. [S]ize, dimension

[Alt]+[T] Object Remet à zéro le pistage d’un objet par la sélection. [T]racking, suivre, pister

[Ctrl]+[T] Object Oblige la sélection à pister l’objet actif, également sélec-
tionné.

[T]racking, suivre, pister

[U] Object Invoque le menu Make Single User et affiche ses options. [U]tilisateur unique

[Alt]+[U] Edit, Object Invoque le menu Global Undo History pour afficher 
l’historique des dernières actions.

[U]ndo, défaire, ann[U]ler

[W] Object Invoque le menu Boolean Tools pour opérations entre les 
maillages sélectionnés, et affiche ses options.

[Ctrl]+[Y] Object Restaure la dernière opération annulée.

[Ctrl]+[Z] Object Annule la dernière opération.
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Les touches utiles en mode Edit
À l’instar des raccourcis du mode Object, l’usage des touches suivantes,
en mode Edit, vous fera gagner un temps énorme en évitant les va-et-
vient incessants avec la souris depuis la vue 3D jusqu’aux divers menus et
boutons. Certaines de ces touches et combinaisons fonctionnent aussi
bien pour l’édition des maillages que pour celle d’autres objets, comme
les os et armatures - même si l’accent est mis sur les maillages.

Raccourci Contexte Description Pense-bête

[Alt]+[-] ou [Alt]+[+], 
[PageDown] ou [PageUp], 
molette de la souris

Edit Lors d’une transformation avec PET ou lors d’une sélection circu-
laire, diminue ou augmente le rayon.

[B][B] Edit Active la sélection circulaire.

[E] Edit Extrude la sélection. [E]xtrusion

[Ctrl]+[E] Edit Invoque le menu Edge Specials et affiche ses options. [E]dge, arête

[Maj]+[E] Edit Règle la dureté (Crease) des arêtes. [E]dge, arête

[F] Edit Crée une arête ou une facette à partir des sommets sélectionnés. [F]acette

[Maj]+[F] Edit Remplit avec des facettes à partir des sommets ou des arêtes 
sélectionnées.

[F]ill, remplit de 
[F]acettes

[H] Edit, Éditeur 
de courbes IPO

Définit le type de poignée d’une courbe. [H]andle, poignée

[H] Edit+Retopo Active/désactive les hotspots. [H]otspot

[Ctrl]+[H] Edit Invoque le menu Hooks pour ajouter un crochet aux sommets 
sélectionnés.

[H]ook, crochet

[ J] Edit Joint les triangles partageant une arête pour former des 
quadrangles.

[J]oint

[K] Edit Invoque le menu Loop/Cut et affiche ses options. [K]nife, couteau, coupe

[L] Edit Sélectionne tous les sommets liés situés sous le pointeur de la 
souris (ne pas cliquer avec la souris, seulement la positionner).

[L]iés

[M] Edit Invoque le menu Mirror Axis et affiche ses options. [M]iroir

[Alt]+[M] Edit Invoque le menu Merge et affiche ses options. [M]erge, fusionne

[Ctrl]+[N] Edit Recalcule les normales vers l’extérieur. [N]ormales

[Ctrl]+[Maj]+[N] Edit Recalcule les normales vers l’intérieur. [N]ormales

[O] Edit, éditeur 
UV/Image

Active/désactive l’outil d’édition proportionnelle (PET). Édition pr[O]portionnelle

[P] Edit Sépare les sommets sélectionnés du maillage courant et crée un 
nouvel objet à partir de ceux-ci.

Sé[P]are

[Maj]+[P] Edit Active l’outil Push-Pull. [P]ousse/Tire

[Ctrl]+[P] Edit Fait du sommet actif le parent de l’objet sélectionné. [P]arent



La
 3

D 
lib

re
 a

ve
c 

Bl
en

de
r

© Groupe Eyrolles, 2008408

Les touches utiles en mode Sculpt
Sans être essentiels, ces raccourcis simplifient considérablement la vie
des sculpteurs.

Les touches utiles en animation
L’animation est un domaine très vaste, regroupant des ensembles d’outils
très différents et parfois obscurs : courbes IPO, armatures, éditeurs
d’action, etc. S’il est possible de recenser tous les raccourcis claviers rela-
tifs, il est aussi très facile de s’y perdre. Nous n’avons sélectionné que
ceux qui sont vraiment très utiles.

[Ctrl]+[R] Edit Active l’outil Couteau (Knife).

[Alt]+[S] Edit Active l’outil Shrink/Flatten. [S]hrink/Flatten, 
rétrécir/aplatir

[Ctrl]+[T] Edit Transforme des quadrangles en triangles. [T]riangles

[Maj]+[U] Edit Restaure la dernière opération annulée. [U]ndo, défaire, 
ann[U]ler

[Maj]+[U] Edit Restaure la dernière opération annulée. [U]ndo, défaire, 
ann[U]ler

[W] Edit Invoque le menu Specials et affiche ses options.

[X] Edit Invoque le menu Erase et affiche ses options.

[Y] Edit Désolidarise la sélection du reste du maillage, mais la conserve à 
l’intérieur de celui-ci.

Raccourci Contexte Description Pense-bête

Raccourci Contexte Description Pense-bête

[Maj] Sculpt Maintenir pressée cette touche pour passer interactivement du 
mode Add au mode Sub.

[PageUp] ou [PageDown] Sculpt Affiche le niveau de résolution immédiatement supérieur ou 
immédiatement inférieur.

[A], [D], [G], [I], [L], [P], 
[S]

Sculpt Invoquent les différents types de brosse : Airbrush, Draw, 
Grab, Inflate, Layer, Pinch, Smooth.

[A]irbrush, [D]raw, 
[G]rab, [I]nflate, [L]ayer, 
[P]inch, [S]mooth

[F] Sculpt, vue 3D Redimensionne la brosse.

[Ctrl]+[F] Sculpt, vue 3D Fait tourner la brosse.

[Maj]+[F] Sculpt Modifie la valeur Strength de la brosse. [F]orce

[V] Sculpt Bascule du mode Add au mode Sub et réciproquement.
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Les touches utiles pour le dépliage UV
Il est possible de se passer du calcul des UV pour vos textures, mais
lorsque vous commencez à vous y intéresser, vous remarquez vite qu’un
bon dépliage autorise toujours un meilleur contrôle de la texture. Quel-
ques raccourcis de base aident alors à démarrer cette activité.

Raccourci Contexte Description Pense-bête

[Gauche] ou [Droite] Se déplace d’une frame en arrière ou en avant.

[Bas] ou [Haut] Se déplace de 10 frames en arrière ou en avant.

[Maj]+[Bas] ou 
[Maj]+[Haut]

Recule jusqu’à la première frame ou avance jusqu’à la dernière 
frame.

[Ctrl]+[Alt]+[C] Armature En mode Pose, ajoute une contrainte à un nouvel objet Empty. [C]ontrainte

[Alt]+[I] Pose Supprime une contraintre IK de l’armature. [I]K, cinématique 
[i]nverse

[Ctrl]+[I] Pose Ajoute une contrainte IK à l’armature. [I]K, cinématique 
[i]nverse

[K] Éditeur de 
courbe IPO

Montre les positions clés de l’objet. [K]ey, clé

[K] Vue 3D Affiche les positions clé de la sélection dans la vue 3D. [K]ey, clé

[T] Éditeur de 
courbe IPO

Change le type d’interpolation d’une courbe IPO. in[T]erpolation [T]ype, 
[T]ype d’in[T]erpolation

Raccourci Contexte Description Pense-bête

[E] Éditeur UV/
Image

Dépliage selon la méthode Conformal ou Angle Based. d[E]plie

[L] UV Face Select Sélectionne les facettes liées ensemble. [L]iées

[P] Éditeur UV/
Image

Cloue sur place les UV sélectionnées. [P]in, cloue

[Alt]+[P] Éditeur UV/
Image

Décloue les UV sélectionnées. un[P]in, décloue

[R] UV Face Select Invoque le menu Rotate et affiche ses options. [R]otation

[U] UV Face Select Invoque le menu UV Calculation et affiche ses options. [U]V

[W] Éditeur UV/
Image

Invoque le menu Weld/Align et affiche ses options. [W]eld, soude, fusionne
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Les touches relatives à l’affichage
Maîtriser l’affichage dans votre espace de travail est la première étape
vers la maîtrise de vos outils. Blender est fidèle à sa réputation de versa-
tilité. Les raccourcis qui suivent sont nombreux (il y en a pourtant bien
d’autres !) mais tous sont utiles au quotidien.

Raccourci Contexte Description Pense-bête

[Home] Affiche tous les éléments de la scène.

[Ctrl]+[Bas] ou 
[Ctrl]+[Haut]

Minimise/maximise la vue dans laquelle se trouve le pointeur de 
la souris.

[Alt]+[B] Object Définit une portion de l’espace 3D visible grâce à une boîte de 
sélection.

[B]oîte

[C] Centre la vue active sur le curseur. [C]entre

[Maj]+[C] Vue 3D Centre la vue active sur un objet sélectionné et zoome sur lui. [C]entre

[D] Tous sauf 
Sculpt

Invoque le menu Draw Mode et affiche ses options. [D]raw mode

[H] Object, Edit Masque les objets ou les sommets sélectionnés, en fonction du 
mode.

[H]ide, cache, dissimule, 
masque

[Alt]+[H] Object, Edit Révèle les objets ou les sommets masqués, en fonction du mode. [H]ide, cache, dissimule, 
masque

[Maj]+[H] Edit Masque les sommets et les faces désélectionnés. [H]ide, cache, dissimule, 
masque

[Maj]+[V] Edit Aligne la vue en fonction des sommets sélectionnés. [V]ertice, sommets

[Z] Vue 3D Passe de l’affichage solide à l’affichage fil de fer.

[Alt]+[Z] Vue 3D Passe de l’affichage solide à l’affichage texturé.

[Maj]+[Z] Vue 3D Passe de l’affichage ombré à l’affichage fil de fer.

[Suppr] Vue 3D Zoome sur l’objet sélectionné.

[/] Vue 3D Vue locale sur l’objet sélectionné (les autres objets sont masqués).

[+] ou [-] Vue 3D Zoome en avant ou en arrière.

[0] Vue 3D Vue de la caméra.

[Ctrl]+[0] Vue 3D Définit l’objet actif comme étant la caméra.

[Ctrl]+[Alt]+[0] Vue 3D Aligne la caméra active sur la vue.

[1] ou [Ctrl]+[1] Vue 3D Vue de face ou de derrière.

[3] ou [Ctrl]+[3] Vue 3D Vue de droite ou de gauche.

[7] ou [Ctrl]+[7] Vue 3D Vue de dessus ou de dessous.

[5] Vue 3D Bascule de la vue perspective à la vue orthogonale.

[4] ou [6] Vue 3D Fait tourner la vue à gauche ou à droite.

[8] ou [2] Vue 3D Fait tourner la vue vers le haut ou vers le bas.
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Les touches relatives au rendu
Le rendu est l’étape obligée de toute œuvre en image de synthèse.
L’essentiel des raccourcis se trouve ci-dessous, mais il y en a d’autres.

Raccourci Contexte Description Pense-bête

[F11] Rappelle la dernière image rendue.

[F12] Effectue le rendu de la scène courante.

[Maj]+[B] Définit les frontières du rendu (dans la vue de la caméra active). [B]ounding, frontière

[Maj]+[P] Vue 3D Affiche une fenêtre de prévisualisation de rendu dans la vue 3D. [P]révisualisation

[Z] Fenêtre de 
rendu

Fenêtre de rendu : zoome à 200 %, centré sur la position du poin-
teur de la souris.

[Z]oome



© Groupe Eyrolles, 2008

annexe B

Citroën Xsara, © 2005 par Adrien Lourdelle, http://adrien.3dvf.net/



© Groupe Eyrolles, 2008

Les scripts Python

Blender est livré en standard avec un certain nombre de scripts 
Python, permettant de rendre des services dans des domaines 
très variés, à l’instar des plug-ins d’autres applications 
commerciales, comme 3ds max ou Maya. La différence est que 
ces scripts sont livrés en standard avec Blender. Ils sont 
accessibles via le menu de n’importe quelle fenêtre de type 
Scripts Window. En cliquant sur le menu Scripts, vous affichez 
une liste déroulante de catégories, que vous pouvez à leur tour 
dérouler pour sélectionner un script. Cette annexe n’a pas pour 
intention d’expliquer l’usage de chacun de ces scripts, mais 
simplement de vous indiquer leur usage principal. Les 
catégories actuellement vides ne sont pas abordées. Les scripts 
livrés en standard avec Blender ne nécessitent pas l’installation 
de Python sur votre ordinateur. En revanche, certains scripts 
que l’on peut trouver sur Internet nécessitent que la version 
complète de Python soit installée (voir les paquetages proposés 
pour votre système d’exploitation dans le répertoire /install 
du DVD-Rom d’accompagnement). Lorsque ce sera le cas, un 
message d’erreur dans la console ou la fenêtre de commandes 
MS-DOS vous en informera, et l’installation de Python sera 
alors indispensable pour faire usage du script en question.
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Wizards
Tree from Curves : ce script, difficile à prendre en main, permet de créer
des arbres et des buissons détaillés. Des instructions d’utilisation ainsi
qu’un didacticiel vidéo sont disponibles sur le wiki de Blender :
http://wiki.blender.org/index.php/Scripts/Manual/Wizards/TreeFromCurves

Image
Ces scripts peuvent être activés dans le menu Scripts de la Script Window,
ou dans le menu Image de la vue UV/Image Editor.

Edit externally : ce script permet de lancer une application tierce pour
éditer l’image présente dans l’UV/Image Editor. Au premier lancement, le
script propose une application par défaut ; si cela ne fonctionne pas, vous
pourrez choisir l’application de votre choix en saisissant son chemin
complet, qui sera sauvegardé pour de futurs usages. À noter que pour
Windows et Mac OS, les images seront automatiquement ouvertes avec
les applications liées à l’extension de l’image.

Consolidate into one Image : ce script permet de compiler toutes les
images d’un objet au sein d’une seule image, en réassignant bien sûr les
coordonnées UV de la nouvelle image aux sommets de l’objet.

Billboard Render on Active : ce script permet de générer un rendu d’un objet
et de s’en servir comme texture sur un maillage plus simple, comme un
quadrangle (billboard). Pour s’en servir, il est important de sélectionner
l’objet, la ou les lumières l’éclairant et enfin le billboard lui-même, de sorte
que ce dernier soit l’objet actif. Cela permet d’afficher simplement des
objets dont la modélisation et le rendu sont autrement complexes.

UV
Ces scripts peuvent être activés dans le menu Scripts de la Script Window,
ou dans le menu UVs de l’UV/Image Editor.

Save UV Face Layout : ce script permet d’enregistrer au format TGA la
carte UV dépliée d’un objet, afin de permettre de peindre par-dessus
dans un logiciel externe, comme Gimp.

Seams from Islands : permet de placer automatiquement des coutures
autour des ilôts isolés, en vue de leur dépliage ultérieur.
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Lightmap UV Pack : ce script est accessible en mode Edit lorsque vous uti-
lisez la touche [U] pour afficher le menu de calcul des coordonnées UV.
Il permet de compacter les coordonnées UV pour limiter les espaces inu-
tiles dans les textures. Optionnellement, il permet de créer une nouvelle
image et un nouvel UV Layer par objet sélectionné. Cette fonction
s’annonce pratique lors du baking de cartes de luminosité (éclairage pré-
calculé et stocké dans les textures UV).

System
Interactive Python Console : il s’agit d’une console interactive, similaire à
l’interpréteur Python en ligne de commande. Intégrée à Blender, cette
console donne accès à tous les modules Python de Blender.

Scripts Config Editor : ce script peut être utilisé pour visualiser et éditer les
données de configuration stockées par les autres scripts.

Render
Save Render Layers : ce script permet de sauvegarder les calques de rendu
dans un fichier et de les appeler depuis d’autres fichiers .blend. Utile aux
artistes désireux d’appliquer à leurs différentes images ou animations la
même « patine » distinctive, grâce au post-traitement nodal.

Object
Ces scripts peuvent être activés dans le menu Scripts de la Script Window,
ou dans le menu Object>Scripts de la vue 3D courante.

Apply Deformation : ce script permet de créer des copies d’objets en
appliquant de façon définitive l’état de déformation de l’objet au
moment où le script est lancé. En effet, Blender peut déformer de façon
interactive les objets grâce à des armatures ou des treillis, par exemple.
Grâce à ce script, les données descriptives de l’objet sont figées en l’état.

Axis Orientation Copy : ce script copie l’orientation des axes (X, Y et Z) de
l’objet actif sur tous les objets sélectionnés. Il est utile pour aligner les
orientations de tous les maillages structures, comme l’armature d’un per-
sonnage, par exemple.
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Batch Object Name Edit : ce script permet de changer en une seule fois le
nom de plusieurs objets de Blender en même temps. Il fournit des
options pour remplacer le texte dans les noms courants, tronquer le
début ou la fin du nom, ou ajouter des préfixes ou des suffixes à ceux-ci.

Bone Weight Copy : ce script permet de copier le poids (weight) des os (bones)
d’une armature depuis un maillage source vers un ou plusieurs maillages dis-
tincts, en fonction de la distance séparant ces maillages du maillage source.
Cela permet, par exemple, de copier l’influence de l’armature d’un personnage
nu, et de « distribuer » celle-ci aux vêtements modélisés par-dessus. Ainsi,
lorsque l’armature est animée, le personnage et ses vêtements le sont aussi.

Cookie Cut from View : ce script est une sorte d’outil couteau avancé. Pour
fonctionner, il nécessite deux maillages. Le premier est le maillage à
découper ; le second est en fait une boucle d’arêtes, sans facettes ! Placez-
vous dans la vue de votre choix, et la forme de la boucle d’arêtes sera
découpée dans le premier maillage.

Data Copier : ce script permet de copier les attributs de l’objet actif vers les
objets sélectionnés du même type. Bien qu’à un stade peu avancé de déve-
loppement, ce script est déjà très utile pour la duplication des attributs
d’objets de type Lamp ou Camera. Plus d’informations sur le site de l’auteur : 
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_lampdatacopier.htm.

Drop Onto Ground : cet outil sympathique permet de faire chuter des
objets sur un sol prédéfini, ce qui le rend utile pour planter des arbres ou
disposer des cailloux sur un paysage, par exemple. Le sol doit être placé
sous les autres objets (du point de vue de la coordonnée Z) et être le der-
nier objet actif de la sélection.

Find by Data Use : ce script permet de trouver/sélectionner un objet de la
scène en fonction du nom connu d’un bloc de données auquel il serait lié
(par exemple, le nom de son Material).

Object Name Editor : ce script permet de renommer un groupe d’objets
sélectionnés selon des règles définissables.

Randomize Loc Size Rot : ce script permet de rendre aléatoires la position,
la taille et la rotation des objets sélectionnés. Il est possible de spécifier le
taux de changement aléatoire, ainsi que les axes (X, Y, Z) affectés, avec
possibilité d’imposer un taux identique sur les trois axes.

Selection to Dupli Group : transforme la sélection en un groupe, sauf si ce
groupe est lié ; les opérations de transformation, en particulier les déplace-
ments, rotations et redimensionnements, s’appliquent au groupe entier.
En fait, les plus curieux remarqueront que le script crée une scène supplé-
mentaire pour y coller les données géométriques des objets d’origine.
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TimeOffset follow Active : ce script permet de définir un décalage temporel
de tous les objets sélectionnés en utilisant le chemin d’animation d’un
objet actif. Idéal pour animer une ola dans un stade, par exemple.

UVCopy from Active : ce script permet simplement de copier les coordon-
nées UV d’un maillage sur un maillage identique.

Misc
FLT Palette Manager : ce script gère les couleurs dans les bases de données
OpenFlight.

FLT Toolbar : ce script fournit des outils permettant de travailler avec des
bases de données OpenFlight.

Mesh
Ces scripts peuvent être activés dans le menu Scripts de la Script Window,
ou dans le menu Mesh>Scripts de la vue 3D courante.

Bevel Center : ce script permet de chanfreiner les arêtes, à l’instar de la
fonction Bevel classique (accessible grâce à la touche [W] en mode Edit),
mais aussi de les rayonner.

Clean meshes : ce script permet de nettoyer les maillages, en éliminant
par exemple les sommets ou les arêtes isolés, ou encore les facettes
n’atteignant pas une surface suffisante.

Deformed mesh to Rvk : ce script permet de copier les déformations d’un
objet et de les coller sous forme de RVK (Relativer Vertex Keys, ou Shape
Keys) à un objet identique possédant le même nombre de sommets et la
même topologie. Plus d’informations sur ce script sur la page de
l’auteur : http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_rvk1versrvk2.htm

Discombobulator : ce script permet d’habiller et de détailler la surface
d’un objet par création de protubérances ou d’ajout de sous-géométrie
simple. Ce script est idéal pour l’habillage de murs de science-fiction ou
de coques de vaisseaux spatiaux, entre autres choses. Des informations
concernant son usage sont disponibles sur le site de l’auteur : 
http://www.nccn.net/~w_rosky/evan/evan/programs/discombobulator/tutorial.html.

Edges to Curve : ce script permet de transformer des boucles d’arêtes (edge-
loops) en polylignes (courbes de Bézier), qu’elles soient fermées ou ouvertes.
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Mirror Vertex Locations & Weight : ce script permet de rendre symétrique
la distribution des sommets et des poids (weight) de ceux-ci, depuis un
maillage initialement symétrique, mais qui a été retouché manuellement.

Poly Reducer: ce script permet de simplifier le maillage d’un objet ; il
permet de l’alléger, tout en préservant à la fois la forme de base de l’objet
initial, ses textures UV et ses poids (weight).

Solid Wireframe : ce script fait une copie du maillage de l’objet, et lui
donne une certaine épaisseur.

Solidify Selection : ce script permet de dupliquer le maillage et de le
décaler dans une direction ou l’autre, selon les normales, afin de donner
de l’épaisseur à un maillage. Facilite la modélisation de verres, de boîtes
en carton ou de récipients en général.

Unfold : ce script permet de déplier un maillage, comme s’il était en
papier, et de le mettre totalement à plat. Il permet également d’animer le
dépliage grâce à un objet de type Empty. Optionnellement, il permet
également d’enregistrer les coordonnées UV du maillage déplié. Non
seulement le script tiendra compte des coutures (seams) présentes, mais il
est également possible de guider le dépliage grâce au Vertex painting. Plus
d’informations sur ce script très intéressant à cette adresse : 
http://celeriac.net/unfolder/.

Unweld vertex/ices : permet de disjoindre des facettes au sommet de
sélection, permettant ainsi de créer des déchirures ou des ouvertures
dans un maillage sans avoir à supprimer des facettes et à reconstruire la
topologie. Offre plusieurs variantes intéressantes. Des exemples d’usage
sont proposés sur le site de l’auteur : 
http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_faces2vertex.htm#exemple.

Import
Grâce à ses différents filtres d’import, Blender est capable de lire les for-
mats de fichiers suivants, issus d’autres applications graphiques, 2D ou 3D :
• 3D Studio (.3ds)
• AC3D (.ac)
• Autodesk DXF (.dxf)
• COLLADA 1.3.1 (.dae)
• COLLADA 1.4 (.dae)
• DEC Object File Format (.off)
• DirectX (.x)
• LightWave (.lwo)
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• Lightwave Motion (.mot)
• Load MDD to Mesh RVKs
• MD2 (.md2)
• MilkShape3D (.ms3d)
• Motion Capture (.bvh)
• OpenFlight (.flt)
• Paths (.svg, .ps, .eps, .ai, Gimp)
• Pro Engineer (.slp)
• Raw Faces (.raw)
• Standford PLY (.ply)
• Wavefront (.obj)

Export
Grâce à ses différents filtres d’export, Blender est capable d’écrire dans
les formats de fichiers suivants, issus d’autres applications graphiques,
2D ou 3D :
• 3D Studio (.3ds)
• AC3D (.ac)
• Autodesk FBX (.fbx)
• COLLADA 1.3.1 (.dae)
• COLLADA 1.4 (.dae)
• DEC Object File Formal (.off)
• DirectX (.x)
• LightWave (.lwo)
• LightWave Motion (.mot)
• M3G (.m3g, .java)
• MD2 (.md2)
• OpenFlight (.flt)
• OpenInventor (.iv)
• Quake 3 (.map)
• Raw Faces (.raw)
• Save Current Theme
• SoftImage XSI (.xsi)
• Standford PLY (.ply)
• VRML 97 (.wrl)
• Vertex Keyframe Animation (.mdd)
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• Wavefront (.obj)
• X3D Extensible 3D (.x3d)
• xfig export (.fig)

Animation
BlenderLip Synchro : ce script importe des fichiers Voice Export produits
par des logiciels comme Papagayo ou JLipSync et synchronise ceux-ci
avec les Shape Keys de phonèmes correspondants. Plus d’informations
sur http://blenderlipsynchro.blogspot.com/.

Camera Changer : ce script permet de déterminer la caméra courante en
fonction de la frame d’animation, ce qui est très utile pour tous les chan-
gements de points de vue au cours d’une animation sans sauter d’une
scène à l’autre.

Envelop Symmetry : ce script permet de créer des enveloppes parfaitement
symétriques, avec les mêmes conventions que le script Armature Sym-
metry. Il fait partie d’un ensemble de scripts présentés sur :
http://www.mindfloaters.de/blender/.

Shape Widget Wizard : ce script permet de créer des objets qui vont
piloter les Shape Keys. En effet, il est parfois utile de réaliser des anima-
tions faciales, par exemple, avec une interface graphique interactive. Ce
script vous permet de définir différents types de contrôleurs permettant
de piloter chacun entre un et quatre Shape key. Des informations, des
exemples et des explications sur ce script à l’adresse : 
http://blenderartists.org/forum/showthread.php?t=52435.

Trajectory : ce script permet d’afficher en temps réel la trajectoire d’un
objet, et de modifier celle-ci soit en déplaçant l’objet (courbe rouge), soit
en insérant de nouvelles clés de positions (Insert Key, touche [I]) (courbe
bleue).
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CLes indices de réfraction

Vous trouverez ci-après les indices de réfraction pour des 
matériaux courants. À noter que cet indice est bien sûr 
utile aux matériaux transparents (paramètre IOR dans 
l’onglet Mirror Transp, Material buttons), au shader spéculaire 
Blinn (paramètre Refr dans le panneau Shaders, Material 
buttons, lorsque le shader Blinn est sélectionné), aux reflets 
caustiques avec les moteurs de rendu avancés, comme 
LuxRender ou YafRay, ou encore aux matériaux à base de 
SSS (SubSurface Scattering).
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Matériau Indice de réfraction

acétone 1.36

air 1.00029

alcool 1.329

alcool d’éthylène 1.36

ambre 1.54

Barrium Borosilicate 1.554

Chromium Oxyde 2.705

cristal 2.00

cristal iodé 3.34

diamant 2.417

dioxyde de carbone liquide 1.20

eau 1.333

émeraude 1.57

glace 3.309

lapis-lazuli 1.61

opaline 1.44 - 1.46

oxyde de chrome 2.705

oxyde de cuivre 2.705

plexiglass 1.51

plastique 1.2

porcelaine 1.504

quartz 11.644

rubis 1.77

saphir 1.77

sel 1.644

solution de sucre (30 %) 1.38

solution de sucre (80 %) 1.49

topaze 1.61

vide 1.000 

verre 1.5

verre blindé 1.89
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Sites informatifs
> http://www.blender.org

Le site officiel de Blender, en anglais. Outre des nouvelles génériques
sur Blender, il propose de télécharger les dernières versions, offre un
catalogue de didacticiels à découvrir, une galerie époustouflante à visiter,
ainsi que des liens vers de nombreuses communautés ou sites d’amateurs.
Il héberge aussi les forums consacrés aux développeurs de Blender.

> http://www.blendernation.com

Ce site en anglais a la vaste ambition d’offrir quotidiennement des nou-
velles fraîches de l’univers Blender. Maintenu par l’ancien responsable de
la communauté de Blender, il est une référence absolue pour tous les
amateurs de Blender en quête de nouveautés, d’articles ou de nouvelles
intéressantes, mais qui n’ont pas le temps de les glaner eux-mêmes.

Communautés
Blender a une communauté à la fois riche, vivante et passionnée.

> http://www.blenderartists.org

Le site officiel de la communauté anglophone des utilisateurs de
Blender, surtout connu pour animer les forums d’Elysiun, où tous les
utilisateurs de Blender se retrouvent (http://www.elysiun.com).

DRessources web
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> http://www.linuxgraphic.org

Il s’agit d’un site français consacré à la promotion des logiciels d’infogra-
phie libres (2D, 3D, vectoriel). Outre des nouvelles fraîches quant à
l’actualité infographique libre, il propose une collection impressionnante
de didacticiels pour un grand nombre de logiciels libres, des ressources,
des liens, ainsi que des forums accueillants où il fait bon flâner. Héberge
notamment Blender-Café, une sous-section exclusivement consacrée à
Blender, en cours de dépoussiérage.

> http://blenderclan.tuxfamily.org/html/

Un des piliers de la communauté française des utilisateurs de Blender.
Véritable portail consacré à Blender, il offre des nouvelles fraîches sur
l’actualité de ce logiciel ; il héberge également des forums très vivants.

> http://www.zoo-logique.org/3D.Blender/index.php3

Cette autre communauté française offre quantité de liens et de res-
sources, mais est surtout connue pour héberger le newsgroup français
consacré à Blender.

Ressources
> http://www.katorlegaz.com

Entre autres choses, ce site anglophone héberge une impressionnante
collection de modèles prêts à l’emploi dans Blender, couvrant de très
nombreux sujets : aéronautique, animaux, accessoires de cuisine, élé-
ments architecturaux, automobiles, charrettes, personnages, informa-
tique, effets spéciaux, électronique, fantastique, nourriture, mobilier,
vaisselle, insectes, décors, éclairages, plantes, mobilier de rue ou de parc,
scènes, science-fiction (Star Wars, Start Trek...), outils, camions, motos,
armes et d’autres catégories encore.

> http://www-users.cs.umn.edu/~mein/blender/plugins/

Ce site héberge la bibliothèque officielle des greffons de texturess et de
séquences de Blender. À visiter absolument, pour enrichir votre collec-
tion de textures procédurales ou d’effets spéciaux !

> http://www.blender-materials.org/

Ce site en anglais présente une collection de matériaux réutilisables
librement et gratuitement avec Blender. De nouveaux matériaux sont
mis à disposition chaque semaine, et plus de 500 sont à ce jour disponi-
bles dans 20 catégories différentes.
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Moteurs de rendu libres et gratuits
> http://www.yafray.org

Ce site en anglais héberge le projet de moteur de rendu YafRay (Yet ano-
ther free Raytracer), qui repousse les limites du moteur interne de Blender
en donnant accès aux utilisateurs à l’illumination globale, aux caustiques
et aux photons, ainsi qu’à d’autres fonctionnalités avancées. Il tend vers le
photoréalisme. Il est actuellement en cours de refonte (sous le nom de
Yafaray) pour offrir encore plus de fonctionnalités et de réalisme.

> http://www.luxrender.net/

Ce site, également en anglais, héberge le projet de moteur de rendu
LuxRender. Il fait usage d’équations respectant les lois de la physique
(non biaisées) et permet de faire une simulation parfaitement réaliste du
comportement de la lumière, permettant l’obtention d’images encore
plus photoréalistes.

Documentation
> http://mediawiki.blender.org/index.php/Main_Page

La documentation officielle est hébergée sur ce wiki, auquel l’auteur de cet
ouvrage contribue. Le développement de Blender étant très rapide, la
documentation accuse un certain retard ; toutes les bonnes volontés capa-
bles et désireuses d’aider les auteurs à tenir le rythme sont les bienvenues.

> http://www.blender-doc.fr

Ce site présente la version française de la documentation de Blender en
version 2.37. Même si l’interface de Blender a évolué depuis, de même que
ses fonctionnalités, cette documentation présente un grand nombre
d’exemples et de didacticiels qui, de par les méthodologies présentées, res-
tent d’actualité. La prise en main de Blender, au travers de la modélisation
et de l’animation de Gus, un petit bonhomme en pain d’épices, est par
ailleurs exemplaire et est fortement recommandée à tous les débutants.
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Introduction
This is an unofficial translation of the GNU General Public License into
French. It was not published by the Free Software Foundation, and does not
legally state the distribution terms for software that uses the GNU GPL--only
the original English text of the GNU GPL does that. However, we hope that
this translation will help French speakers understand the GNU GPL better. 

Voici une adaptation non officielle de la Licence Publique Générale du
projet GNU. Elle n’a pas été publiée par la Free Software Foundation et
son contenu n’a aucune portée légale car seule la version anglaise de ce
document détaille le mode de distribution des logiciels sous GNU GPL.
Nous espérons cependant qu’elle permettra aux francophones de mieux
comprendre la GPL.

Licence Publique Générale GNU, version du 
2 juin 1991
Copyright © Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307
États-Unis, 1989, 1991.
La copie et la distribution de copies exactes de ce document sont autori-
sées, mais aucune modification n’est permise.

ELicence GPL

Source

B http://www.linux-france.org/article/these/
gpl.html
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Préambule
Les licences d’utilisation de la plupart des programmes sont définies
pour limiter ou supprimer toute liberté à l’utilisateur. À l’inverse, la
Licence Publique Générale (General Public License) est destinée à vous
garantir la liberté de partager et de modifier les logiciels libres, et de
s’assurer que ces logiciels sont effectivement accessibles à tout utilisateur.

Cette Licence Publique Générale s’applique à la plupart des pro-
grammes de la Free Software Foundation, comme à tout autre pro-
gramme dont l’auteur l’aura décidé (d’autres logiciels de la FSF sont
couverts pour leur part par la Licence Publique Générale pour Biblio-
thèques GNU (LGPL)). Vous pouvez aussi appliquer les termes de cette
Licence à vos propres programmes, si vous le désirez.

Liberté des logiciels ne signifie pas nécessairement gratuité. Notre Licence
est conçue pour vous assurer la liberté de distribuer des copies des pro-
grammes, gratuitement ou non, de recevoir le code source ou de pouvoir
l’obtenir, de modifier les programmes ou d’en utiliser des éléments dans de
nouveaux programmes libres, en sachant que vous y êtes autorisé.

Afin de garantir ces droits, nous avons dû introduire des restrictions
interdisant à quiconque de vous les refuser ou de vous demander d’y
renoncer. Ces restrictions vous imposent en retour certaines obligations
si vous distribuez ou modifiez des copies de programmes protégés par la
Licence. En d’autre termes, il vous incombera en ce cas de :
• transmettre aux destinataires tous les droits que vous possédez,
• expédier aux destinataires le code source ou bien tenir celui-ci à leur

disposition,
• leur remettre cette Licence afin qu’ils prennent connaissance de leurs

droits.

Nous protégeons vos droits de deux façons : d’abord par le copyright du
logiciel, ensuite par la remise de cette Licence qui vous autorise légale-
ment à copier, distribuer et/ou modifier le logiciel.

En outre, pour protéger chaque auteur ainsi que la FSF, nous affirmons
solennellement que le programme concerné ne fait l’objet d’aucune
garantie. Si un tiers le modifie puis le redistribue, tous ceux qui en rece-
vront une copie doivent savoir qu’il ne s’agit pas de l’original afin qu’une
copie défectueuse n’entache pas la réputation de l’auteur du logiciel.

Enfin, tout programme libre est sans cesse menacé par des dépôts de
brevets. Nous souhaitons à tout prix éviter que des distributeurs puissent
déposer des brevets sur les Logiciels Libres pour leur propre compte.
Pour éviter cela, nous stipulons bien que tout dépôt éventuel de brevet
doit accorder expressément à tout un chacun le libre usage du produit.
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Les dispositions précises et les conditions de copie, de distribution et de
modification de nos logiciels sont les suivantes :

Stipulations et conditions relatives à la copie, 
la distribution et la modification

Article 0
La présente Licence s’applique à tout Programme (ou autre travail) où
figure une note, placée par le détenteur des droits, stipulant que ledit
Programme ou travail peut être distribué selon les termes de la présente
Licence. Le terme Programme désigne aussi bien le Programme lui-
même que tout travail qui en est dérivé selon la loi, c’est-à-dire tout
ouvrage reproduisant le Programme ou une partie de celui-ci, à l’iden-
tique ou bien modifié, et/ou traduit dans une autre langue (la traduction
est considérée comme une modification). Chaque personne concernée
par la Licence Publique Générale sera désignée par le terme Vous.

Les activités autres que copie, distribution et modification ne sont pas
couvertes par la présente Licence et sortent de son cadre. Rien ne res-
treint l’utilisation du Programme et les données issues de celui-ci ne sont
couvertes que si leur contenu constitue un travail basé sur le logiciel
(indépendemment du fait d’avoir été réalisé en lançant le Programme).
Tout dépend de ce que le Programme est censé produire.

Article 1
Vous pouvez copier et distribuer des copies conformes du code source du
Programme, tel que Vous l’avez reçu, sur n’importe quel support, à con-
dition de placer sur chaque copie un copyright approprié et une restric-
tion de garantie, de ne pas modifier ou omettre toutes les stipulations se
référant à la présente Licence et à la limitation de garantie, et de fournir
avec toute copie du Programme un exemplaire de la Licence.

Vous pouvez demander une rétribution financière pour la réalisation de
la copie et demeurez libre de proposer une garantie assurée par vos soins,
moyennant finances.

Article 2
Vous pouvez modifier votre copie ou vos copies du Programme ou partie
de celui-ci, ou d’un travail basé sur ce Programme, et copier et distribuer
ces modifications selon les termes de l’article 1, à condition de Vous con-
former également aux conditions suivantes :
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a) Ajouter aux fichiers modifiés l’indication très claire des modifica-
tions effectuées, ainsi que la date de chaque changement.
b) Distribuer sous les termes de la Licence Publique Générale
l’ensemble de toute réalisation contenant tout ou partie du Pro-
gramme, avec ou sans modifications.
c) Si le Programme modifié lit des commandes de manière interac-
tive lors de son exécution, faire en sorte qu’il affiche, lors d’une invo-
cation ordinaire, le copyright approprié en indiquant clairement la
limitation de garantie (ou la garantie que Vous Vous engagez à
fournir Vous-même), qu’il stipule que tout utilisateur peut librement
redistribuer le Programme selon les conditions de la Licence
Publique Générale GNU, et qu’il montre à tout utilisateur comment
lire une copie de celle-ci (exception : si le Programme original est
interactif mais n’affiche pas un tel message en temps normal, tout
travail dérivé de ce Programme ne sera pas non plus contraint de
l’afficher).

Toutes ces conditions s’appliquent à l’ensemble des modifications. Si des
éléments identifiables de ce travail ne sont pas dérivés du Programme et
peuvent être raisonnablement considérés comme indépendants, la pré-
sente Licence ne s’applique pas à ces éléments lorsque Vous les distri-
buez seuls. Mais, si Vous distribuez ces mêmes éléments comme partie
d’un ensemble cohérent dont le reste est basé sur un Programme soumis
à la Licence, ils lui sont également soumis, et la Licence s’étend ainsi à
l’ensemble du produit, quel qu’en soit l’auteur.

Cet article n’a pas pour but de s’approprier ou de contester vos droits sur
un travail entièrement réalisé par Vous, mais plutôt d’ouvrir droit à un
contrôle de la libre distribution de tout travail dérivé ou collectif basé sur
le Programme.

En outre, toute fusion d’un autre travail, non basé sur le Programme,
avec le Programme (ou avec un travail dérivé de ce dernier), effectuée sur
un support de stockage ou de distribution, ne fait pas tomber cet autre
travail sous le contrôle de la Licence.

Article 3
Vous pouvez copier et distribuer le Programme (ou tout travail dérivé
selon les conditions énoncées dans l’article 1) sous forme de code objet
ou exécutable, selon les termes des articles 0 et 1, à condition de res-
pecter l’une des clauses suivantes :

a) Fournir le code source complet du Programme, sous une forme
lisible par un ordinateur et selon les termes des articles 0 et 1, sur un
support habituellement utilisé pour l’échange de données ; ou,
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b) Faire une offre écrite, valable pendant au moins trois ans, pré-
voyant de donner à tout tiers qui en fera la demande une copie, sous
forme lisible par un ordinateur, du code source correspondant, pour
un tarif n’excédant pas le coût de la copie, selon les termes des articles
0 et 1, sur un support couramment utilisé pour l’échange de données
informatiques ; ou,
c) Informer le destinataire de l’endroit où le code source peut être
obtenu (cette solution n’est recevable que dans le cas d’une distribu-
tion non commerciale, et uniquement si Vous avez reçu le Pro-
gramme sous forme de code objet ou exécutable avec l’offre prévue à
l’alinéa b ci-dessus).

Le code source d’un travail désigne la forme de cet ouvrage sous laquelle
les modifications sont les plus aisées. Sont ainsi désignés la totalité du
code source de tous les modules composant un Programme exécutable,
de même que tout fichier de définition associé, ainsi que les scripts uti-
lisés pour effectuer la compilation et l’installation du Programme exécu-
table. Toutefois, l’environnement standard de développement du
système d’exploitation mis en œuvre (source ou binaire) -- compilateurs,
bibliothèques, noyau, etc. -- constitue une exception, sauf si ces élé-
ments sont diffusés en même temps que le Programme exécutable.

Si la distribution de l’exécutable ou du code objet consiste à offrir un
accès permettant de copier le Programme depuis un endroit particulier,
l’offre d’un accès équivalent pour se procurer le code source au même
endroit est considéré comme une distribution de ce code source, même si
l’utilisateur choisit de ne pas profiter de cette offre.

Article 4
Vous ne pouvez pas copier, modifier, céder, déposer ou distribuer le Pro-
gramme d’une autre manière que l’autorise la Licence Publique Géné-
rale. Toute tentative de ce type annule immédiatement vos droits
d’utilisation du Programme sous cette Licence. Toutefois, les tiers ayant
reçu de Vous des copies du Programme ou le droit d’utiliser ces copies
continueront à bénéficier de leur droit d’utilisation tant qu’ils respecte-
ront pleinement les conditions de la Licence.

Article 5
Ne l’ayant pas signée, Vous n’êtes pas obligé d’accepter cette Licence.
Cependant, rien d’autre ne Vous autorise à modifier ou distribuer le Pro-
gramme ou quelque travaux dérivés : la loi l’interdit tant que Vous
n’acceptez pas les termes de cette Licence. En conséquence, en modi-
fiant ou en distribuant le Programme (ou tout travail basé sur lui), Vous
acceptez implicitement tous les termes et conditions de cette Licence.
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Article 6
La diffusion d’un Programme (ou de tout travail dérivé) suppose l’envoi
simultané d’une licence autorisant la copie, la distribution ou la modifi-
cation du Programme, aux termes et conditions de la Licence. Vous
n’avez pas le droit d’imposer de restrictions supplémentaires aux droits
transmis au destinataire. Vous n’êtes pas responsable du respect de la
Licence par un tiers.

Article 7
Si, à la suite d’une décision de Justice, d’une plainte en contrefaçon ou
pour toute autre raison (liée ou non à la contrefaçon), des conditions
Vous sont imposées (que ce soit par ordonnance, accord amiable ou
autre) qui se révèlent incompatibles avec les termes de la présente
Licence, Vous n’êtes pas pour autant dégagé des obligations liées à celle-
ci : si Vous ne pouvez concilier vos obligations légales ou autres avec les
conditions de cette Licence, Vous ne devez pas distribuer le Programme.

Si une partie quelconque de cet article est invalidée ou inapplicable pour
quelque raison que ce soit, le reste de l’article continue de s’appliquer et
l’intégralité de l’article s’appliquera en toute autre circonstance.

Le présent article n’a pas pour but de Vous pousser à enfreindre des
droits ou des dispositions légales ni en contester la validité ; son seul
objectif est de protéger l’intégrité du système de distribution du Logiciel
Libre. De nombreuses personnes ont généreusement contribué à la large
gamme de Programmes distribuée de cette façon en toute confiance ; il
appartient à chaque auteur/donateur de décider de diffuser ses Pro-
grammes selon les critères de son choix.

Article 8
Si la distribution et/ou l’utilisation du Programme est limitée dans cer-
tains pays par des brevets ou des droits sur des interfaces, le détenteur
original des droits qui place le Programme sous la Licence Publique
Générale peut ajouter explicitement une clause de limitation géogra-
phique excluant ces pays. Dans ce cas, cette clause devient une partie
intégrante de la Licence.

Article 9
La Free Software Foundation se réserve le droit de publier périodique-
ment des mises à jour ou de nouvelles versions de la Licence. Rédigées
dans le même esprit que la présente version, elles seront cependant sus-
ceptibles d’en modifier certains détails à mesure que de nouveaux pro-
blèmes se font jour.
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Chaque version possède un numéro distinct. Si le Programme précise un
numéro de version de cette Licence et « toute version ultérieure », Vous
avez le choix de suivre les termes et conditions de cette version ou de toute
autre version plus récente publiée par la Free Software Foundation. Si le
Programme ne spécifie aucun numéro de version, Vous pouvez alors choisir
l’une quelconque des versions publiées par la Free Software Foundation.

Article 10
Si Vous désirez incorporer des éléments du Programme dans d’autres
Programmes libres dont les conditions de distribution diffèrent, Vous
devez écrire à l’auteur pour lui en demander la permission. Pour ce qui
est des Programmes directement déposés par la Free Software Founda-
tion, écrivez-nous : une exception est toujours envisageable. Notre déci-
sion sera basée sur notre volonté de préserver la liberté de notre
Programme ou de ses dérivés et celle de promouvoir le partage et la réu-
tilisation du logiciel en général.

LIMITATION DE GARANTIE

Article 11
Parce que l’utilisation de ce Programme est libre et gratuite, aucune
garantie n’est fournie, comme le permet la loi. Sauf mention écrite, les
détenteurs du copyright et/ou les tiers fournissent le Programme en
l’état, sans aucune sorte de garantie explicite ou implicite, y compris les
garanties de commercialisation ou d’adaptation dans un but particulier.
Vous assumez tous les risques quant à la qualité et aux effets du Pro-
gramme. Si le Programme est défectueux, Vous assumez le coût de tous
les services, corrections ou réparations nécessaires.

Article 12
Sauf lorsque explicitement prévu par la Loi ou accepté par écrit, ni le
détenteur des droits, ni quiconque autorisé à modifier et/ou redistribuer
le Programme comme il est permis ci-dessus ne pourra être tenu pour
responsable de tout dommage direct, indirect, secondaire ou accessoire
(pertes financières dues au manque à gagner, à l’interruption d’activités
ou à la perte de données, etc., découlant de l’utilisation du Programme
ou de l’impossibilité d’utiliser celui-ci).

FIN DES TERMES ET CONDITIONS
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Le DVD-Rom d’accompagnement de cet ouvrage est divisé en trois par-
ties.
• /install : contient trois sous-répertoires avec les fichiers d’installa-

tion de Blender v2.46, Python 2.5.2 et l’utilitaire Qtpfsgui pour
Windows, Mac OS X et Linux.

• /exercices : contient tous les fichiers des exercices présentés dans ce
livre. À chaque fois que cela est possible, un fichier de départ et un
fichier final sont fournis, afin de satisfaire autant le lecteur pressé que
celui désireux de décortiquer pas à pas chacun des exercices.

• /bonus : le répertoire nommé /Blender Texture Disk contient lui-
même trois sous-répertoires destinés à vous aider à démarrer avec
Blender :
– /material : contient quantité de matériaux de Blender prêts à

l’emploi ; à utiliser avec la fonction Append (combinaison de tou-
ches [Maj]+[F1]). Avec la permission spéciale de Ton Roosendaal.

– /texture : contient quantité de textures qui vont de l’utile à l’indis-
pensable, à utiliser avec des textures de type Image. Avec la permis-
sion spéciale de Ton Roosendaal.

– /plugins : contient la totalité des greffons de texture et de
séquence disponibles à ce jour pour Blender.

Vous trouverez également en bonus les deux films réalisés grâce à
Blender :
• Elephants Dream, du Studio Orange, sous licence Creative Commons

Attribution 2.5 (© copyright 2006, Blender Foundation, Nether-
lands Media Art Institute, www.elephantsdream.org), au format MOV ;

FContenu du DVD-Rom
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• Big Buck Bunny, du Studio Peach, sous licence Creative Commons
Attribution 3.0 (© copyright Blender Foundation, www.bigbuckbunny.org),
aux formats AVI et OGG, ainsi que de nombreux fichiers de production et
didacticiels issus du film.

Pour visualiser ces films, quel que soit le format, nous vous recommandons
VLC Media Player. Vous pouvez également utiliser Media Player Classic
(formats AVI et OGG) ou QuickTime  pour les formats MOV et AVI.

Configuration minimale
• Processeur 450 MHz ;
• 256 Mo de RAM ;
• une carte graphique avec accélération OpenGL ;
• 20 Mo d’espace disque ;
• Windows 98, Me, NT, 2000, XP, Vista, Linux, Mac OS X.

Nouvelles versions de Blender

Blender évoluant très vite, des mises à jour peuvent avoir fait leur appa-
rition depuis l’impression de ce livre et le pressage du DVD-Rom. Nous
vous invitons à visiter régulièrement http://www.blender.org et plus parti-
culièrement http://www.blender.org/download/get-blender/ pour vérifier les
dernières versions disponibles. Par exemple, une version 2.47 (version de
correction de bogues) est déjà en cours de préparation, à la date de
bouclage de l’ouvrage.

VLC Media Player

Vous pouvez télécharger ce lecteur multimedia
libre à l’adresse :
B http://www/videolan.org/vlc/
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Index
Symboles
3D Transform Manipulator 47
3D View (vue) 30

A
accrochage, outil 87
actif

calque 37
objet 37

action
ajouter 337
non linéaire, éditeur 336
supprimer 340

Action Editor 253
vue 30

Actor, corps rigide 307
Ad, simulation des fluides 314
Adaptive QMC 159
ajouter

couture 181
objet 35
poignée 117
sommet 89

alignée, poignée 116
alpha

opacité 148
ambient occlusion 219
angle de rotation, limite 336
angular map 224
Anim/Playback buttons 32
Animated Mesh

Export, simulation des fluides 317
animation

de texture procédurale 179
durée 249, 356
prévisualiser 239
rejouer 356
rendre 356
saccadée 248
squelettale 319

annuler une opération 48
antialiasage 354
anticrénelage 354
Append 40
appliquer un modificateur 52

corps souple 297

Apply Deformation
corps souple 305
script Python 415

Area (aire lumineuse) 215
arête, rigidité d’une 292
armature 320

ajouter 320
Bone Heat Weighting 328
child of 322
Deform 322
Dist 322
Envelope 321, 325
enveloppe 325

éditer 326
Hinge 322, 324
miroir, mode 324
Modifier (onglet) 325
Names 321
Object, mode 324
Octahedron 321
Pose, mode 324
rigging 324
skinning 324
Weight Painting 329
X-Axis Mirror Edit 324
X-Ray 321

Array (modificateur) 134
Audio Window (vue) 29
Auto Smooth 138
automatique, poignée 117
Av, corps souple 302
AVI, créer vidéo 365
AvMiMa, corps souple 302
Axis Orientation Copy, script Python 415

B
B Damp, corps souple 302
B Stiff, corps souple 302
Backface-Culling (type d’affichage) 53
Bake

intérêt de l’option 305
simulation des fluides 314

Ball Size, corps souple 302
barre

d’information 26
principale 23

Batch Object Name Edit, script 
Python 416

Bev Resol, courbe de Bézier 121
Bevel

menu Specials 93
modificateur 142

Bevel Center, script Python 417
Bevel Depth, courbe de Bézier 121
Bézier, courbes de 116
Billboard Render on Active, script 

Python 414
Blender People, animation 325
Blender, installer

GNU/Linux 16
Mac Os X 17
Windows 12

blender.org 423
blenderartists.org 423
blenderclan.org 424
blender-doc.fr 425
BlenderLip Synchro, script Python 420
blender-materials.org 424
blendernation.com 423
Blendin, séquence 341
Blendout, séquence 341
Body, Soft 292
boîte à outils, appeler 70
boîte de sélection 46
Bone Heat Weighting 328
Bone Weight Copy, script Python 416
Boolean (modificateur) 133
booléenne, opération 106
Border Select 46
boucles 94
bounding box (type d’affichage) 34
Bounds, corps rigide 307, 308
boutons

Anim/Playback 32
Lamp 30
Material 30
Object 31
Physic 31
Radiosity 31
Render 31
Sound block 32
Texture 30
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World 31
Build (modificateur) 263
Bullet, corps rigide 307
Buttons Window (vue) 28

C
calque 37, 62

actif 37
changer 38

caméra 350
active 350
changer 34
cible 350
objet quelconque 350

Camera Changer, script Python 420
canaux de texture 171
caractères spéciaux, texte 125
carte angulaire 224
Cast (modificateur) 141
Catmull-Clark, Subsurf 51
Centre (bouton) 74
Centre Cursor (bouton) 74
Centre New (bouton) 74
changer un calque 38
charger un fichier 39
chemin 236

3D 237
départ et fin 238
longueur/durée 240

chemin, extrusion le long d’un 121
child of, armature 322
Choke, corps souple 302
cinématique inverse 332
Circle (primitive) 71
clavier, raccourcis 401
clé

d’animation 245, 246
insérer 337

Clean meshes, script Python 417
Clear Seam 181
Clipping End, caméra 350
Clipping Start, caméra 350
clore une courbe 118
Cloth (modificateur) 344
Col (matériau) 147
Cone (primitive) 72
Config Editor, script Python 415
Connected 55

PET 85
Consolidate into one image, script 

Python 414

Constant QMC 159
Constant, No Falloff, PET 86
Constraints 333
construction dynamique de maillage 263
contrainte 340

Action 335
Child of 334
Copy Location 334
Copy Rotation 334
Copy Scale 334
Floor 335
Follow Path 335
IK Solver 335
Limit Distance 335
Limit Location 335
Limit Rotation 335
Limit Scale 335
Locked Track 335
Null 335
Stretch To 335
Track To 335

contrainte IK, ajouter 332
Cookie Cut from View, script Python 416
corps rigide 305

Actor 307
Bounds 307, 308
Bullet 307
Dynamic 307
Game 308
Grav 307
Mist/Stars/Physics 307
Record Game Physics to IPO 308
Start Game 308
Sumo 307

corps souple 292
Apply 297
Av 302
AvMiMa 302
B Damp 302
B Stiff 302
Bake 294
Ball Size 302
Choke 302
Collision 302
E Damp 294
Error Lim, 302
Free Bake 294
Fuzzy 302
G Max 301
G Min 301
Goal 298

Grav 293
Man 302
Mass 293
Max 302
MaxS 302
Min 302
MinS 302
modificateur 293
Outer, Deflection 297
RKCP 302
Self Collision 302
SOFT 302
Speed 293
Stiff Quads 294, 304
Use Edges 293
Use Goal 298
Weight Paint 299

couleur
changer 64
de base 147
de réflexion 147
des spéculaires 147
rampes de 155

courbe 259
3D 117
clore 118
d’interpolation 243
de Bézier 116
de variation 123
fermer 118
joindre 117
texte le long d’une courbe 126

couture
ajouter 181
marquage rapide 181

Crease 131
créer une face 48
crochet 262
Cube

primitive 70
projection 174

cubique, projection 174
curseur 3D 35
Curve Deform (modificateur) 259
Cylinder (primitive) 72
cylindrique, projection 174

D
Data Copier, script Python 416
Decimate (modificateur) 133
déflecteur 266
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Deflection 264
Deform, armature 322
déformation

courbe 259
crochet 262
maillage 342
treillis 258

Deformed mesh to Rvk, script Python 417
degrés de liberté, cinématique inverse 336
dépliage UV 179

canaux, plusieurs 188
déclouage 181
déplier 182
édition proportionnelle 183
exporter 183
facettes

masquer 183
miroir horizontal 183
miroir vertical 183
révéler 183

Live Unwrap Transform 187
louage 181
peindre image 185
Pin 181
relaxer dépliage 183
utiliser dépliage 187

désélection 47
boîte 47
tout désélectionner 46

Difference, opération booléenne 107
diffus, shader 150
Discombobulator, script Python 417
dispersion subsurfacique (SSS) 163
Displace (modificateur) 136
Dist, armature 322
Domain, simulation des fluides 312
Drop Onto Ground, script Python 416
DupliFaces (outil) 80
DupliVerts (outil) 80
durée animation 249
DVD-Rom, contenu 435
Dynamic, corps rigide 307

E
E Damp, corps souple 294
écran

prédéfini 35
vert 393

Edges to Curve, script Python 417
EdgeSplit (modificateur) 138
Edit externally, script Python 414

éditer un maillage 36
éditeur d’actions 253

non linéaires 336
Slider Max 254
Slider Min 254

éditeur de nœuds 195
Add New 195
ajouter matériau nodal 195
ajouter, nœud 195, 196
Alpha Over, nœud Composite 371
Blur, nœud Composite 372
bois verni, simulation 200
Bright/Contrast, nœud 

Composite 371
Channel Key, nœud Composite 398
Chroma Key, nœud Composite 394
Color Ramp

nœud Composite 372
nœud matériau 197

Composite 369
nœud Composite 371

connecteur
entrée 195
sortie 195

Defocus, nœud Composite 372, 389
Difference Key, nœud 

Composite 397
Dilate/Erode, nœud Composite 372, 

399
Displace, nœud Composite 373
Filter, nœud Composite 372
flou focal

avancé 384
effet 382

Geometry, nœud matériau 196
Group, nœud Composite 373
halo (effet) 379
ID Mask, nœud Composite 373, 392
Image, nœud Composite 371
Luminance Key, nœud 

Composite 397
Map value, nœud Composite 372
Mapping, nœud matériau 197
Material, nœud matériau 196
matériaux, mélanger 201
Mix

nœud Composite 371
nœud matériau 197

Output, nœud matériau 196
RGB Curve 198

nœud Composite 371

RGB to BW
nœud Composite 373
nœud matériau 197

RGB, nœud matériau 197
Set Alpha, nœud Composite 373
simulation bois verni 200
sortie 195
supprimer

liaison 196
nœud 196

Texture
nœud Composite 371
nœud matériau 196

Translate, nœud Composite 373
UV Map, nœud Composite 373
Value, nœud matériau 197
Viewer, nœud Composite 371
Z Combine, nœud Composite 371, 

379
Editing (menu) 31
édition proportionnelle, outil 54, 85
effet, rayon 55
émetteur de particules 266
Emit 154
émittance 154
Enable, simulation des fluides 312
enregistrer une image rendue 41
en-tête 23
Env (matériau) 149
Env Map (rendu) 353
Envelop Symmetry, script Python 420
Envelope 325

armature 321, 325
Error Lim, corps souple 302
Explode (modificateur) 346
Extrude, courbe de Bézier 120
extrusion

le long d’un chemin 121
mode 59

Extrusion (outil) 75

F
face, créer 48
fake gons 89
Fall-Off, transmissivité 162
Fatten (outil) 77
fenêtre des boutons 23
fermer une courbe 118
Fgons 89, 90
fichier

charger 39
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sauvegarder 38
Fields and Deflection 266
Fields, types 279
File Browser (vue) 28
Fill 90
Find by Data Use, script Python 416
Flat (projection) 174
Flip Normals, menu Specials 93
flou

focal avancé, effet de 384
vitesse 241

FLT Palette Manager, script Python 417
FLT Toolbar, script Python 417
Fluid, simulation des fluides 311
fluides, simulation des 310
Follow Path 238
fond transparent 41
forme clé 251

ajouter 252
éditeur d’action 253

frame 243
courante 244

Free Bake, corps souple 294
Free, simulation des fluides 316
Fresnel, effet 160
Full OSA, rendu 355
Fuzzy, corps souple 302

G
G Max, corps souple 301
G Min, corps souple 301
Game, corps rigide 308
génération d’ondes 264
global illumination 228
Goal, corps souple 298
GPL, licence 427
Grav, corps souple 293
Gravity, simulation des fluides 314
greffon, texture 179
Grid (primitive) 73
groupe

d’objets 38
de méta-éléments 129

H
halo

effet de 379
rendu 156

HDR
Illumination 224
Qtpfsgui 225
Tone Mapping 225

hélicoïdal, profil 79
Hemi 218
hermétique, objet, simulation des 

fluides 319
Hide, menu Specials 92
Hinge, armature 322, 324
Hook (modificateur) 262

I
Icosphere (primitive) 71
IK 332
illumination globale 228
image

afficher dernière image rendue 353
animée 175
dimensions 351
enregistrer 356
fond transparent 41
format supporté 174
formats 352
noir et blanc 352
OpenEXR 360
panoramique 351
rendu 40, 352
rendue, enregistrer 41
texture 173
transparence 173, 352

Image Browser (vue) 28
importer un objet 40
incrustation d’image 393
indice

de réfraction 161, 421
matériau 169

Individual Faces, Extrude 77
Inflow, simulation des fluides 311, 316
insérer une poignée 117
installer Blender

GNU/Linux 16
Mac Os X 17
Windows 12

installer Python
Linux 16
Windows 15

Interactive Console, script Python 415
interface 23

barre d’information 26
barre principale 23
boîte à outils 70
en-tête 23
fenêtre des boutons 23
menu principal 24

vue principale 23, 28
Interpolation curve 243
interpolation, mode 248
Intersection, opération booléenne 107
inverse, cinématique 332
IOR 161, 421
IPO 243

mode d’interpolation 248
multiples 245
simulation des fluides 312

IpoCurve Editor (vue) 30

J
Join Area 32
joindre

deux courbes 117
deux maillages 74

K
katorlegaz.com 424
key 245, 246
kinematics, inverse 332
Knife (outil) 96

L
Lamp buttons 30
lampe

Area 215
Constant 214
Custom Curve 215
Dist 211
Energy 211
Falloff Curve 215
Hemi 218
Inverse Linear 214
Inverse Square 214
lamp 213
Lamp falloff 214
Layer 211
Lin/Quad Weighted 214
lumière volumétrique 217
Negative 211
No Diffuse 211
No Specular 212
R,G,B 211
Rect 215
Samples 212
Soft Size 212
Sphere 215
Spot 216
Square 215
Sun 218



In
de

x

© Groupe Eyrolles, 2005 441

Threshold 213
Lattice (modificateur) 258
Lens 350
liberté, degrés de, cinématique inverse 336
libre, poignée 116
libstdc++5 (paquetage) 16
Lightmap UV Packfile, script Python 415
Limit, transmissivité 162
Linear Falloff, PET 86
linuxgraphic.org 424
lisser

lissage sélectif 51
objets 93
sélection 51
un objet 51

Live Unwrap Transform (dépliage 
UV) 187

Logic (menu) 30
lumière volumétrique 217
luxrender.net 425

M
maillage 342

Add Level, multi-résolution 100
Apply Multires, multi-résolution 100
déformation procédurale 84
Del Higher, multi-résolution 100
Del Lower, multi-résolution 100
Edges, multi-résolution 100
éditer 36
joindre 74
Level, multi-résolution 100
multi-résolution 99
Pin, multi-résolution 100
Render, multi-résolution 100
retopologie 101
séparer 75

Man, corps souple 302
Map Input 170
Map To 171
Mark Seam 181
Mark Sharp, menu Specials 139
Mark Smooth, menu Specials 139
masque 178

de rendu 365
masquer la géométrie 92
Mass, corps souple 293
Material buttons 30
matériau 146

Add New 146
ajouter un nouveau matériau 146

alpha 148
Col 147
couleur 64
Env 149
Full OSA 148
indices matériau 169
IOR 161
Mir 147
No Mist 149
Only Cast 149
prévisualisation, modes 147
réflectif 159
réfraction 421
Shadeless 149
shading 149
Spe 147
Strands 275
Tex Face 149
transparence 64, 148

mode 65
transparent 161
VCol Light 149
VCol Paint 149
verre 63
Wire 148

Max, corps souple 302
maximiser une vue 45
MaxS, corps souple 302
mediawiki.blender.org 425
menu

boîte à outils 70
Editing 31
Logic 30
Object 31
principal 24
Scene 31
Script 30
Shading 30
Spécials, modélisation 91

Merge, menu Specials 92
MeshDeform (modificateur) 342
Meta

Ball 127
Cube 127
Ellipsoid 127
Plane 127
Tube 127

méta-élément 126
ajouter 127
groupe 129

Min, corps souple 302

MinS, corps souple 302
Mir (matériau) 147
Mirror (modificateur) 132
Mirror Transp 159
Mirror Vertex Locations & Weight, script 

Python 418
Mist/Stars/Physics, corps rigide 307
mode

édition 36
extrusion 59
interpolation 248
Pose 324
sélection 57

modificateur 129, 203, 257, 342
animation 257
appliquer 52
Apply Modifier 52
armature 325
Array (arrangements) 134
Bevel (chanfrein) 142
Boolean (booléen) 133
Build 263
Cast (projection) 141
Cloth 344
corps souple 293
Curve Deform 259
Decimate (décimation) 133
Displace (déplacement) 136
Edge Split (séparation aux arêtes) 138
Explode 346
Hook 262
Lattice 258
MeshDeform 342
Mirror (miroir) 132
Smooth (lissage) 140
Subsurf (subdivision de surfaces) 130
Wave 264

Modifier (modificateur) 129, 203, 257, 
342

Monkey (primitive) 73
montrer la géométrie 92
multi-résolution, maillage 99

N
Names, armature 321
Ngons 89
NLA Editor 336

vue 29
No Header 33
No Mist (matériau) 149
No Slip, simulation des fluides 316
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Node Editor 241
nœuds matériaux, éditeur 195
Noise (outil) 84
normales, recalculer 78

O
Object

buttons 31
menu 31
Name Editor, script Python 416

objet
actif 37
de révolution 78
hermétique, simulation des 

fluides 319
importer 40
lisser 51, 93
sélectionné 36
texte 125

obstacle mobile, simulation des 
fluides 316, 317

occlusion ambiante 219
Adapt Vec 220
Adaptive QMC 220
Add 222
angular maps 224
Approximate 226, 227
Bias 221
Both 222
carte angulaire 224
Constant Jittered 221
Constant QMC 220
Correction 227
Energy 221
Error 227
HDR 224
Max Dist 222
Passes 227
Pixel Cache 227
Plain 222
Samples 221
Sky Color 223
Sky Texture 223
Strands 227
Strength 222
Sub 222
surocclusion 227
Threshold 220
Use Falloff 222

Octahedron, armature 321
Octree (rendu) 355

ombre
méthode, choix 210
projection 217
raytracing 210
TraShadow 66

onde 264
Only Cast (matériau) 149
Only Edges, Extrude 77
Only Vertices, extrude 78
OpenEXR 360
opération

annuler 48
booléenne 106

Orthographic 351
OSA (rendu) 354
Outer, Deflection, corps souple 297
Outflow, simulation des fluides 311, 316
outil

accrochage 87
arêtes

glissement 98
rotation 97

boucle d’arêtes
sélection 95
suppression 95

boucle de facettes
couper 95
sélection 95

boucle en région, sélection 94
boucles multiples, insérer 95
centre d’un objet, redéfinir 74
chemin, sélection 78
couteau 96
déchirer un maillage 99
DupliFaces 80
DupliVerts 80
édition proportionnelle 54
Exact, Knife 97
Extrusion 75
Fatten 77
glissement d’arêtes 98
Knife 96
maillage

déchirer 99
joindre 74

Midpoints, Knife 97
Multicut, Knife 97
Noise 84
normales, recalculer les 78
objet, duplication procédurale 80
Path Select 78

PET 85
Pull 77
Push 77
Rem Doubles 78
rotation d’arêtes 97
Screw 79
Select Linked Flat Faces 76
Select Sharp Edges 76
séparer un maillage 75
Shrink 77
Skin Faces/Edge-Loops 90
Solidify Selection 105
sommets

ajouter 89
doubles, supprimer 78
liés, sélection 74

Spin 78
supprimer une boucle d’arêtes 95
To Sphere 141

Outliner (vue) 29
oversampling 354

P
Paint, Weight 299
Part, simulation des fluides 316
Particle buttons 31
particule

Boids 285
Braid 278
collision 274
combustion 268
Curl 278
déflecteur 266
distribution 270
émetteur 266
Emitter 269
Fields 266
gazon 275
géométrie 267
Halo 267
IPO 273
Kink/Branch 278
mobile 266
mode d’affichage 270
obstacle 274
perturbation 266
Radial 278
Reactor 271
simulation de fluides 267
statique 266
taille 267
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Use Seams 278
Wave 278

passe
AO 368
Col 368
Combined 367
Diff 368
IndexOb 368
Nor 368
Outliner 369
PassIndex 368
Refl 368
Refr 368
rendu 365
Shad 368
Spec 368
UV 368
Vec 368
Z 367

PassIndex 368
Path Select (outil) 78
PathLen 240
peinture sur sommets 157
PET (outil) 85
Physic buttons 31
Plane

primitive 70
projection 174

Plugin, texture 179
poignée

ajouter 117
alignée 116
automatique 117
courbes de Bézier 116
insérer 117
libre 116
supprimer 118
vectorielle 116

Poly Reducer, script Python 418
Pose, mode 324
prévisualisation

modes 147
panneau 63

prévisualiser animation 239
primitive 70

Circle 71
Cone 72
Cube 70
Cylinder 72
Grid 73
Icosphere 71

Monkey 73
Plane 70
Torus 73
UVsphere 71

procédurale, texture 176
projection

cubique 174
cylindrique 174
sphérique 174

Proportional Editing Tool 54, 85
pseudo-aléatoire 271
Pull (outil) 77
Push (outil) 77
Python 413

installer 413
Linux 16
Windows 15

R
raccourcis clavier 401
Radio (rendu) 354
radiosité 228

Add Meshes 231
ajuster solution 230
Collect Meshes 231
Convergence 230
élément 229
Free Radio Data 231
Go 231
Hemires 230
Max Iterations 230
patch 229
radiosité précalculée 231
Replace Meshes 231

Radiosity buttons 31
rampes de couleur 155
Ramps 155
Random Falloff, PET 86
Randomize Loc Size Rot, script 

Python 416
Ray (rendu) 353
Ray Mirror 159
Ray Transp 161, 163
RayMir 159
rayon d’effet 55
raytracing 158
Realworld-size, simulation des fluides 314
recommencer, simulation des fluides 318
Record Game Physics to IPO, corps 

rigide 308
redéfinir le centre d’un objet 74

réflectivité 159
reflet 159
réfraction, indice de 161, 421
Region, Extrude 76
règle d’or 22
régler une valeur 56
Rem Doubles (outil) 78
Remove Doubles, menu Specials 92
Render Baking, texture 189
Render buttons 31
Render Layers 365
Rendersize, méta-élément 128
rendre une image 40
rendu 353

CatRom 355
Env Map 353
fond transparent 41
halos 156
moteur de rendu 353
Octree 355
OSA 355
par passes 365
prévisualisation rapide 354
prévisualisation vue 3D 353
Radio 354
Ray 353
Shadow 353
Toon 155

Repeat, séquence 341
résolution, courbe 118
retopologie 101

bouclage 103
EllDiv 103
Ellipse 103
Hotspot 102
Line 103
LineDiv 103
maillage 101
Paint 101, 102
Pen 102
Retopo 101
Retopo All 101

Reveal, menu Specials 92
révolution, objet de 78
rigging 324
rigide, corps 305
Root Falloff, PET 87

S
saccade 248
sauvegarder un fichier 38
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Save Render Layers, script Python 415
Save UV Face Layout 183

script Python 414
Scene (menu) 31
scène, créer nouvelle 362
Screenshot All 25
Screenshot Subwindow 25
Screw (outil) 79
Script (menu) 30
script Python 414

Apply Deformation 415, 417
Axis Orientation Copy 415
Batch Object Name Edit 416
Bevel Center 417
BlenderLip Synchro 420
Bone Weight Copy 416
Camera Changer 420
Clean meshes 417
Config Editor 415
Data Copier 416
Deformed mesh to Rvk 417
Discombobulator 417
Edges to Curve 417
Envelop Symmetry 420
FLT Palette Manager 417
FLT Toolbar 417
Interactive Python Console 415
Mirror Vertex Locations & 

Weight 418
Object Name Editor 416
Poly Reducer 418
Save Render Layers 415
Save UV Face Layout 414
Shape Widget Wizard 420
TimeOffset follow Active 417
Trajectory 420
Tree from Curves 414
Unweld 418
UVCopy 417

Script Window (vue) 28
Sculpt 108
Sculpt mode 111

3D 113
Add 110
Airbrush 110
Anchored 112
Angle 113
Drag 113
Draw 109
Flatten 110
Grab 110

Inflate 110
Layer 110
Pinch 110
Rake 113
Size 110
Smooth 110
Space 111
Strength 110
Sub 110
Tile 113
View 112

Seams from Islands, script Python 414
Seed 271
Select Linked Flat Faces (outil) 76
Select Sharp Edges (outil) 76
Select Swap, menu Specials 92
Select/Deselect All 46
sélection

boîte 46
mode 57
par chemin 78
sommets liés 74
tout sélectionner 46

Selection to Dupli Group, script 
Python 416

sélectionner un objet 36
Self Collision, corps souple 302
séquence 357

Add, effet 357
ajouter 340
Alpha Over Drop, effet 357
Alpha Over, effet 357
Alpha Under, effet 357
Color Generator, effet 358
Cross, effet 357
éditeur 357
Gamma Cross, effet 357
Glow, effet 358
Multiply, effet 357
Speed Control, effet 358
Substract, effet 357
Transform, effet 358
transition 361
Wipe, effet 358, 361

Set Smooth 51
menu Specials 93

Set Solid, menu Specials 93
shaded (type d’affichage) 35
Shadeless (matériau) 149
shader

Aniso 161

Bias 155
Blinn 152
CookTorr 152
Cubic 150
diffus 150
émittance 154
Fresnel 151
Gloss 160
halo 156
Lambert 150
Max Dist 161
Minnaert 150
Oren-Nayar 150
Phong 152
Ray end Fade-out 161
S Bias 155
Samples 161, 163
spéculaire 152
Tangent 153
Threshold 161, 163
Toon 155
translucidité 154
WardIso 152

Shading
matériau 149
menu 30

Shadow (rendu) 353
Shadow and Spot

Bias 209
ClipEnd 209
ClipSta 209
Dither 216
Halo 217
Halo Step 217
Noise 216
Only Shadow 212
Ray Shadow 212
SampleBuffers 209
SamplesX 216
SamplesY 216
shader LBias 209
Spot Bl 217
Spot Si 217
Umbra 216

shadow buffer 208
classical 208
half-way 210
irregular 209

Shape Key 251
ajouter 252
éditeur d’action 253
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Shape Widget Wizard, script Python 420
Shapes, onglet 251
Sharp Falloff, PET 87
Shrink (outil) 77
Simple Subdiv, Subsurf 51
simulation des fluides 310, 314

Ad 314
Animated Mesh

Export 317
Bake 314
Domain 312
Enable 312
Fluid 311
Free 316
hermétique, objet 319
Honey, viscosité 318
Inflow 311, 316
IPO 312
Manual, viscosité 318
No Slip 316
objet hermétique 319
obstacle mobile 317
Oil, viscosité 318
Outflow 311, 316
Part 316
PartSlip Amount 316
Realworld-size 314
recommencer 318
Resolution 318
viscosité 318
Water, viscosité 318

Simulation Subsurface Scattering 198
skinning 324
Smooth

menu Specials 93
modificateur 140

Smooth Falloff, PET 87
Snap 87

Active 88
Center 88
Closest 88
Median 88

Soft Body 292
solid (type d’affichage) 35
Solid Wireframe, script Python 418
Solidify Selection, script Python 418
sommet, peinture sur 157
Sound block buttons 32
souple, corps 292
Spe (matériau) 147
spéculaire, shader 152

Speed, corps souple 293
Sphere (projection) 174
Sphere Falloff, PET 87
sphérique, projection 174
Spin (outil) 78
Split Area 32
Spot 216
squelettale, animation 319
SSS 163
Start Game, corps rigide 308
Stencil (texture) 178
Stiff Quads, corps souple 294, 304
Strands 275
Strip End, séquence 341
Strip Properties 341
Strip Start, séquence 341
Subdivide Multi Fractal, menu Specials 91
Subdivide Multi, menu Specials 91
Subdivide Smooth, menu Specials 92
Subdivide, menu Specials 91
Subsurf (modificateur) 130
Subsurface Scattering (SSS) 163

simulation 198
Sumo, corps rigide 307
Sun 218
supprimer

couture 181
poignée 118
un objet 44

surface de Bézier 119
système de particules 266

T
Taper Curves 123
Terminator, problème 155
Tex Face (matériau) 149
TexFace (bouton) 187
Text Editor (vue) 29
texte

le long d’une courbe 126
objet 125

texture 170
32 bits Float 191
ajouter une nouvelle texture 170
anticrénelage 173
Blend 177
canal, affectation 171
canaux 171
Clouds 177
déplacement, carte 190
Distorted Noise 177

greffon 179
Image 173

extension 174
transparence 173

Magic 177
Marble 177
masque 178
Musgrave 177
Noise 177
normale, carte 190
placage 170
Plugin 179
projection

cubique 174
cylindrique 174
plane 174
sphérique 174

Render Baking 189
Selected to Active 192
Stencil 178
Stucci 177
Texture Paint 185
Voronoi 177
Wood 177

Texture buttons 30
Texture paint

Clone 186
Draw 186
Falloff 186
Opacity 186
Size 186
Smear 186
Soften 186
Spacing 186

texture procédurale 176
textured (type d’affichage) 35
Threshold, méta-élément 128
Timeline 239, 340

vue 29
TimeOffset follow Active, script 

Python 417
To Sphere (outil) 141
Toon, rendu 155
Torus (primitive) 73
Trajectory, script Python 420
transition entre séquences 361
TransLu 154
translucidité 154
transmissivité 162
transparence 161

alpha 162
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Fresnel 162
matériau 64
mode 65
ombre 66
Ray Transp 163
Ztransp 162

TraShadow (ombre) 66
Tree from Curves, script Python 414
treillis 258
Tube

projection 174
type d’affichage

Backface-Culling 53
bounding box 34
shaded 35
solid 35
textured 35
wire frame 34

type de lumière
Area light 215
Hemi light 218
Lamp light 213
Spot light 216
Sun light 218

U
Undo 48
Unfold, script Python 418
Union, opération booléenne 106
unité de temps 243
Unweld vertex/ices, script Python 418
Unwrap UV 179

Use Edges, corps souple 293
User Preferences (vue) 29
UV dépliage 179
UV/Image Editor 29
UVCopy from Active, script Python 417
UVsphere (primitive) 71

V
valeur réglée 56
variation, courbe de 123
VCol Light (matériau) 149
VCol Paint (matériau) 149
Vector Blur 241

BlurFac 243
MaxSpeed 243
MinSpeed 242
Samples 242

vectorielle, poignée 116
vertex painting 157
Video Sequence Editor 29
vidéo, charger 175
vitesse, flou 241
volumétrique, lumière 217
vue

3D View 30
Action Editor 30
active 33
Audio Window 29
Buttons Window 28
caméra 350
File Browser 28
Image Browser 28

IpoCurve Editor 30
maximiser 45
Node Editor 28
Outliner 29
prédéfinie 34, 46, 58
principale 23, 28
Script Window 28
Text Editor 29
Timeline 29
User Preferences 29
UV/Image Editor 29
Video Sequence Editor 29

W
Wave (modificateur) 264
Weight Paint, corps souple 299
Wire (matériau) 148
wire frame (type d’affichage) 34
Wiresize, méta-élément 128
World buttons 31

X
X-Ray 102

armature 321

Y
yafray.org 425

Z
Ztransp 162
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Scène tirée du film Big Buck Bunny, © copyright Blender Foundation | www.bigbuckbunny.org | Creative Commons Attribution 3.0

Scène tirée du film Elephants Dream, du Studio Orange | © 2006, Blender Foundation/Netherlands Media Art Institute |
 www.elephantsdream.org | Creative Commons Attribution-NonCommercial-NoDerivs 2.5
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Splash!, © 2005 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html

Seiko Chronograph, © 2004 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Venice Morning, © 2005 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html

Jungle Troll, © 2006 par Tommy Gard Helgevold : http://www.hamsterking.com/blender.htm
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Bodie Island in the Outer Banks of North Carolina, © 2005 par D. Roland Hess.

Scène tirée du film Elephants Dream, du Studio Orange | © 2006, Blender Foundation/Netherlands Media Art Institute |
 www.elephantsdream.org | Creative Commons Attribution-NonCommercial-NoDerivs 2.5
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Age of Steam, © 2004 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html

Image © 2005, Adrien Lourdelle, http://adrien.3dvf.net/
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Piano Corner, © 2005 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Tree frog and dragonfly, © 2006 par Jason Pierce : http://cs.unm.edu/~sketch/gallery/
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Scènes tirées du film Big Buck Bunny, © copyright Blender Foundation | www.bigbuckbunny.org | Creative Commons Attribution 3.0

Splash Screen de Blender 2.46, d’après le film Big Buck Bunny
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L’outil libre d’animation 
et de graphisme 3D
Logiciel libre de référence pour le  
 gra phisme et l’animation 3D, tant sous
MS-Windows et Linux que sous Mac OS X,
Blender 2.46 défie les ténors du  domaine
XSI, 3ds Max, Maya, ZBrush… Grâce à son
 interface intelligente et contextuelle,
il permet à l’artiste d’allier pro ductivité
et créativité. Très ouvert, il met à sa
 disposition de nombreux  moteurs de
rendu photoréalistes et  s’intègre, par sa
richesse et sa flexibilité, à la panoplie des
outils de  travail quotidiens du graphiste
professionnel.

Pour que l’informatique
soit un outil

et non un ennemi !

Libérez vos images et animations 3D !

�Modélisez de façon puissante les objets, les composants 
mécaniques, les formes organiques

�Maîtrisez la modélisation polygonale et les outils de sculpture 
interactive

� Simulez et animez des personnages, fluides et corps souples 
(vêtements, fourrure, chevelure…) que vous pouvez sculpter et coiffer

�Habillez-les par des matériaux et des textures peintes 
ou photographiées

� Jonglez avec l’éditeur de nœuds pour concevoir des shaders
complexes et créer des effets spéciaux

� Éclairez vos scènes avec réalisme et effectuez le rendu grâce 
aux meilleurs moteurs libres (interne, Yafaray, Sunflow, LuxRender)

� Profitez de l’un des meilleurs systèmes de particules dotés 
d’intelligence artificielle (boids) pour simuler des comportements
(bancs de poissons, proie et prédateur, éclaboussures…)

�Montez vos animations directement dans Blender

� Importez depuis des applications et exportez vers d’autres formats
image, vidéo ou moteurs de jeux (3D Studio, Collada, LightWave, XSI,
DirectX, VRML, Doom 3, Quake 3, PNG, JPEG, TARGA, AVI…)

En annexe : Raccourcis clavier • Indices de réfraction • Les scripts Python •
Webographie • Licence GPL.
Sur le DVD-Rom offert avec cet ouvrage : Blender 2.46 pour MS-Windows, Linux
et Mac OS X, avec Python 2.5.2.  Inclus : Les exercices corrigés • Plug-ins de Texture et
Séquence • Matériaux et textures prêts à l’emploi • Les films Elephants Dream et Big
Buck Bunny (formats .avi, .mov et .ogg) • De nombreux bonus.

Configuration minimale : MS-Windows 98, Me, NT, 2000, XP, Vista, Linux, Mac OS. Processeur
450 Mhz, 256 Mo de RAM, carte graphique avec accélération OpenGL, 20 Mo d’espace disque.

La série Blender 2.4x est le fruit des développements nécessaires à la réalisation des films
d’animation Elephants Dream et Big Buck Bunny (proposés librement sur le DVD-Rom
d’accompagnement).

À qui s’adresse cet ouvrage ?

■ Amateurs d’images de synthèse ou d’animation 3D,
sous MS-Windows, Linux et Mac OS X.

■ Utilisateurs de 3ds Max, Maya, ZBrush qui souhaitent
retrouver en gratuit et libre des outils de création 3D
avancés.

La 3D libre
avec

Blender
3e éditionpour Linux, Windows 

et Mac OS X

Blender 2.46
Python

Utilisateur de Blender depuis près de dix ans,
Olivier Saraja est l’un des animateurs  
de la communauté du graphisme libre –  
en particulier sous Linux – et l’auteur de
nombreux didacticiels pour Blender, POV-
Ray, KPovModeler ou Art of Illusion. Il a
contribué à la documentation officielle 
et aux Release Logs de Blender et œuvre
pour en faciliter l’accès au plus grand
nombre, dans les communautés françaises et
 anglophones.
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